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About This Tutorial

THIS tutorial is a beginner’s guide to developing enterprise applications
Java™ 2 Platform, Enterprise Edition (J2EE™) version 1.4. Here we cover all
the things you need to know to make the best use of this tutorial.

Who Should Use This Tutorial
This tutorial is intended for programmers interested in developing and deploying
J2EE applications on the J2EE 1.4 Application Server Developer Release.

How to Read This Tutorial
This tutorial is organized into six parts:

• Introduction

The first three chapters introduce basic J2EE concepts and technologies
and we suggest that you read these first in their entirety.

• Java XML technology

These chapters cover the technologies for developing applications that
process XML documents and provide Web services:

• The Java API for XML Processing (JAXP)

• The Java API for XML-based RPC (JAX-RPC)

• SOAP with Attachments API for Java (SAAJ)

• The Java API for XML Registries (JAXR)
xxvii
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• Web technology

These chapters cover the component technologies used in developing the
presentation layer of a J2EE application or a standalone Web application.

• Java Servlets

• JavaServer Pages

• JavaServer Pages Standard Tag Library

• Enterprise JavaBeans technology

These chapters cover the component technologies used in developing the
business logic of a J2EE application.

• Session beans

• Entity beans

• Enterprise JavaBeans Query Language

• Platform Services

These chapters cover the J2EE platform services used by all the J2EE
component technologies.

• Security

• Transactions

• Resources

• Connectors

• Java Message Service

• Case Studies

• The Coffee Break Application chapter describes an application that ties
together the Web application and Web services APIs.

• The Duke’s Bank Application chapter describes an application that uses
Web application technologies and enterprise beans.

• Appendixes

• Java encoding schemes

• HTTP overview



ABOUT THE EXAMPLES xxix
About the Examples
Prerequisites for the Examples
To understand the examples you will need a good knowledge of the Java pro-
gramming language, SQL, and relational database concepts. The topics in The
JavaTutorial listed in Table 1–1 are particularly relevant:

Building and Running the Examples
This section tells you everything you need to know to obtain, build, and run the
examples.

Required Software
If you are viewing this online, you need to download The J2EE™ 1.4 Tutorial
from:

http://java.sun.com/j2ee/1.4/download.html#tutorial

Once you have installed the tutorial bundle, the example source code is in the
<INSTALL>/j2eetutorial14/examples/ directory, with subdirectories for each
of the technologies discussed in tutorial.

This tutorial documents the J2EE 1.4 Application Server Developer Release. To
build, deploy, and run the examples you need a copy of the J2EE 1.4 Application
Server Developer Release and the Java 2 Software Development Kit, Standard

Table 1–1 Relevant Topics in The JavaTutorial

Topic Web Page

JDBC™ http://java.sun.com/docs/books/tutorial/jdbc

Threads http://java.sun.com/docs/books/tutorial/essential/threads

JavaBeans™ http://java.sun.com/docs/books/tutorial/javabeans

Security http://java.sun.com/docs/books/tutorial/security1.2

http://java.sun.com/docs/books/tutorial/jdbc
http://java.sun.com/docs/books/tutorial/essential/threads
http://java.sun.com/docs/books/tutorial/javabeans
http://java.sun.com/docs/books/tutorial/security1.2
http://java.sun.com/j2ee/1.4/download.html#tutorial
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Edition (J2SE™ SDK) 1.4.2_01 or higher. You download the J2EE 1.4 Applica-
tion Server from:

http://java.sun.com/j2ee/1.4/download.html#sdk

and the J2SE 1.4 SDK from

http://java.sun.com/j2se/1.4/

Building the Examples
Most of the tutorial examples are distributed with a configuration file for asant,
a portable build tool contained in the J2EE 1.4 Application Server, that is an
extension of the Ant tool developed by the Apache Software Foundation
(http://www.apache.org). asant contains additional tasks that interact with
the J2EE 1.4 Application Server adminstration utility asadmin. Directions for
building the examples are provided in each chapter.

In order to run the asant scripts, you must configure your environment and
properties files as follows:

• Add <JAVA_HOME>/bin to the front of your path.

• Add <J2EE_HOME>/bin and <J2EE_HOME>/share/bin to the front of your
path so that J2EE 1.4 Application Server scripts (asadmin, asant,
deploytool, and wscompile) override other installations.

• Set the j2ee.home property in the file
<INSTALL>/j2eetutorial14/examples/common/build.properties to
the location of your J2EE Application Server installation. The build pro-
cess uses the j2ee.home property to include the J2EE library archive,
<J2EE_HOME>/lib/j2ee.jar, in the classpath. If you wish to use an IDE
or the javac compiler to build J2EE applications, you must add this JAR
to your classpath.

Note: On Windows, you must escape any backslashes in the j2ee.home property
with another backslash or use forward slashes as a path separator. So, if your J2EE
1.4 Application Server installation is C:\Sun\AppServer, you must set j2ee.home
as follows:

j2ee.home = C:\\Sun\\AppServer

or

http://java.sun.com/webservices/downloads/webservicespack.html
http://java.sun.com/j2se/1.4/
http://java.sun.com/j2ee/1.4/download.html#sdk
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j2ee.home=C:/Sun/AppServer

Tutorial Example Directory Structure
To facilitate iterative development and keep application source separate from
compiled files, the source code for the tutorial examples is stored in the follow-
ing structure under each application directory:

• build.xml—asant build file

• src—Java source of servlets and JavaBeans components, and tag libraries

• web—JSP pages and HTML pages, tag files, images

The asant build files (build.xml) distributed with the examples contain targets
to create a build subdirectory and copy and compile files into that directory and
perform administrative functions on the application server. Build properties and
targets common to a particular technology are specified in the files
<INSTALL>/j2eetutorial14/examples/technology/common/build.propert

ies and
<INSTALL>/j2eetutorial14/examples/technology/common/targets.xml.

Further Information
For information on the tools distributed with the J2EE 1.4 Application Server,
see the man pages at http://java.sun.com/j2ee/1.4/docs/rel-

notes/cliref/index.html.

This tutorial includes the basic information that you need to deploy applications
on and administer the J2EE 1.4 Application Server.

See the J2EE 1.4 Application Server Developer’s Guide at
http://java.sun.com/j2ee/1.4/docs/devguide/index.html for informa-
tion about various developer features of the J2EE 1.4 Application Server.

See the J2EE 1.4 Application Server Administrator’s Guide at
http://java.sun.com/j2ee/1.4/docs/adminguide/index.html for infor-
mation about administering the J2EE 1.4 Application Server.

http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/index.html
http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/index.html
http://java.sun.com/j2ee/1.4/docs/devguide/index.html
http://java.sun.com/j2ee/1.4/docs/adminguide/index.html
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How to Print This Tutorial
To print this tutorial, follow these steps:

1. Ensure that Adobe Acrobat Reader is installed on your system.

2. Open the PDF version of this book.

3. Click the printer icon in Adobe Acrobat Reader.

Typographical Conventions
Table 1–2 lists the typographical conventions used in this tutorial.

Menu selections indicated with the right-arrow character →, for example,
First→Second, should be interpreted as: select the First menu, then choose Sec-
ond from the First submenu.

Table 1–2 Typographical Conventions

Font Style Uses

italic Emphasis, titles, first occurrence of terms

monospace
URLs, code examples, file names, path names,
command names, programming language key-
words, properties

italic monospace Variable names

<italic monospace>
Variable path names, environment variables in
paths

J2EETutorial.pdf
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Overview

TODAY, more and more developers want to write distributed transactional
applications for the enterprise and leverage the speed, security, and reliability of
server-side technology. If you are already working in this area, you know that in
today’s fast-moving and demanding world of e-commerce and information tech-
nology, enterprise applications have to be designed, built, and produced for less
money, with greater speed, and with fewer resources than ever before.

To reduce costs and fast-track application design and development, Java 2 Plat-
form, Enterprise Edition (J2EE) provides a component-based approach to the
design, development, assembly, and deployment of enterprise applications. The
J2EE platform offers a multitiered distributed application model, reusable com-
ponents, a unified security model, flexible transaction control, and Web services
support through integrated data interchange on Extensible Markup Language
(XML)-based open standards and protocols.

Not only can you deliver innovative business solutions to market faster than ever,
but your platform-independent J2EE component-based solutions are not tied to
the products and application programming interfaces (APIs) of any one vendor.
Vendors and customers enjoy the freedom to choose the products and compo-
nents that best meet their business and technological requirements.

This tutorial takes an examples-based approach to describing the features and
functionalities available in J2EE version 1.4 for developing enterprise applica-
tions. Whether you are a new or an experienced developer, you should find the
examples and accompanying text a valuable and accessible knowledge base for
creating your own solutions.
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If you are new to J2EE enterprise application development, this chapter is a good
place to start. Here you will learn development basics, be introduced to the J2EE
architecture and APIs, become acquainted with important terms and concepts,
and find out how to approach J2EE application programming, assembly, and
deployment.

Distributed Multitiered Applications
The J2EE platform uses a multitiered distributed application model for enter-
prise applications. Application logic is divided into components according to
function, and the various application components that make up a J2EE applica-
tion are installed on different machines depending on the tier in the multitiered
J2EE environment to which the application component belongs. Figure 1–1
shows two multitiered J2EE applications divided into the tiers described in the
following list. The J2EE application parts shown in Figure 1–1 are presented in
J2EE Components (page 3).

• Client-tier components run on the client machine.

• Web-tier components run on the J2EE server.

• Business-tier components run on the J2EE server.

• Enterprise information system (EIS)-tier software runs on the EIS server.

Although a J2EE application can consist of the three or four tiers shown in
Figure 1–1, J2EE multitiered applications are generally considered to be three-
tiered applications because they are distributed over three different locations: cli-
ent machines, the J2EE server machine, and the database or legacy machines at
the back end. Three-tiered applications that run in this way extend the standard
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two-tiered client and server model by placing a multithreaded application server
between the client application and back-end storage.

Figure 1–1 Multitiered Applications

J2EE Components
J2EE applications are made up of components. A J2EE component is a self-con-
tained functional software unit that is assembled into a J2EE application with its
related classes and files and that communicates with other components. The
J2EE specification defines the following J2EE components:

• Application clients and applets are components that run on the client.

• Java Servlet and JavaServer Pages™ (JSP™) technology components are
Web components that run on the server.

• Enterprise JavaBeans™ (EJB™) components (enterprise beans) are busi-
ness components that run on the server.

J2EE components are written in the Java programming language and are com-
piled in the same way as any program in the language. The difference between
J2EE components and “standard” Java classes is that J2EE components are
assembled into a J2EE application, verified to be well formed and in compliance
with the J2EE specification, and deployed to production, where they are run and
managed by the J2EE server.
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J2EE Clients
A J2EE client can be a Web client or an application client.

Web Clients
A Web client consists of two parts: dynamic Web pages containing various types
of markup language (HTML, XML, and so on), which are generated by Web
components running in the Web tier, and a Web browser, which renders the
pages received from the server.

A Web client is sometimes called a thin client. Thin clients usually do not do
things like query databases, execute complex business rules, or connect to legacy
applications. When you use a thin client, heavyweight operations like these are
off-loaded to enterprise beans executing on the J2EE server where they can
leverage the security, speed, services, and reliability of J2EE server-side technol-
ogies.

Applets
A Web page received from the Web tier can include an embedded applet. An
applet is a small client application written in the Java programming language
that executes in the Java virtual machine installed in the Web browser. However,
client systems will likely need the Java Plug-in and possibly a security policy file
in order for the applet to successfully execute in the Web browser.

Web components are the preferred API for creating a Web client program
because no plug-ins or security policy files are needed on the client systems.
Also, Web components enable cleaner and more modular application design
because they provide a way to separate applications programming from Web
page design. Personnel involved in Web page design thus do not need to under-
stand Java programming language syntax to do their jobs.

Application Clients
A J2EE application client runs on a client machine and provides a way for users
to handle tasks that require a richer user interface than can be provided by a
markup language. It typically has a graphical user interface (GUI) created from
Swing or Abstract Window Toolkit (AWT) APIs, but a command-line interface
is certainly possible.
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Application clients directly access enterprise beans running in the business tier.
However, if application requirements warrant it, a J2EE application client can
open an HTTP connection to establish communication with a servlet running in
the Web tier.

JavaBeans™ Component Architecture
The server and client tiers might also include components based on the Java-
Beans component architecture (JavaBeans component) to manage the data flow
between an application client or applet and components running on the J2EE
server or between server components and a database. JavaBeans components are
not considered J2EE components by the J2EE specification.

JavaBeans components have instance variables and get and set methods for
accessing the data in the instance variables. JavaBeans components used in this
way are typically simple in design and implementation, but should conform to
the naming and design conventions outlined in the JavaBeans component archi-
tecture.

J2EE Server Communications
Figure 1–2 shows the various elements that can make up the client tier. The cli-
ent communicates with the business tier running on the J2EE server either
directly or, as in the case of a client running in a browser, by going through JSP
pages or servlets running in the Web tier.

Your J2EE application uses a thin browser-based client or thick application cli-
ent. In deciding which one to use, you should be aware of the trade-offs between
keeping functionality on the client and close to the user (thick client) and off-
loading as much functionality as possible to the server (thin client). The more
functionality you off-load to the server, the easier it is to distribute, deploy, and
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manage the application; however, keeping more functionality on the client can
make for a better perceived user experience.

Figure 1–2 Server Communications

Web Components
J2EE Web components can be either servlets or JSP pages. Servlets are Java pro-
gramming language classes that dynamically process requests and construct
responses. JSP pages are text-based documents that execute as servlets but allow
a more natural approach to creating static content.

Static HTML pages and applets are bundled with Web components during appli-
cation assembly, but are not considered Web components by the J2EE specifica-
tion. Server-side utility classes can also be bundled with Web components and,
like HTML pages, are not considered Web components.

Like the client tier and as shown in Figure 1–3, the Web tier might include a
JavaBeans component to manage the user input and send that input to enterprise
beans running in the business tier for processing.

Business Components
Business code, which is logic that solves or meets the needs of a particular busi-
ness domain such as banking, retail, or finance, is handled by enterprise beans
running in the business tier. Figure 1–4 shows how an enterprise bean receives
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data from client programs, processes it (if necessary), and sends it to the enter-
prise information system tier for storage. An enterprise bean also retrieves data
from storage, processes it (if necessary), and sends it back to the client program.

Figure 1–3 Web Tier and J2EE Applications

Figure 1–4 Business and EIS Tiers

There are three kinds of enterprise beans: session beans, entity beans, and mes-
sage-driven beans. A session bean represents a transient conversation with a cli-
ent. When the client finishes executing, the session bean and its data are gone. In
contrast, an entity bean represents persistent data stored in one row of a database
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table. If the client terminates or if the server shuts down, the underlying services
ensure that the entity bean data is saved.

A message-driven bean combines features of a session bean and a Java Message
Service (JMS) message listener, allowing a business component to receive JMS
messages asynchronously.

Enterprise Information System Tier
The enterprise information system tier handles enterprise information system
software and includes enterprise infrastructure systems such as enterprise
resource planning (ERP), mainframe transaction processing, database systems,
and other legacy information systems. J2EE application components might need
access to enterprise information systems for database connectivity, for example.

J2EE Containers
Normally, thin-client multitiered applications are hard to write because they
involve many lines of intricate code to handle transaction and state management,
multithreading, resource pooling, and other complex low-level details. The com-
ponent-based and platform-independent J2EE architecture makes J2EE applica-
tions easy to write because business logic is organized into reusable components.
In addition, the J2EE server provides underlying services in the form of a con-
tainer for every component type. Because you do not have to develop these ser-
vices yourself, you are free to concentrate on solving the business problem at
hand.

Container Services
Containers are the interface between a component and the low-level platform-
specific functionality that supports the component. Before a Web, enterprise
bean, or application client component can be executed, it must be assembled into
a J2EE application and deployed into its container.

The assembly process involves specifying container settings for each component
in the J2EE application and for the J2EE application itself. Container settings
customize the underlying support provided by the J2EE server, which includes
services such as security, transaction management, Java Naming and Directory
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Interface™ (JNDI) lookups, and remote connectivity. Here are some of the high-
lights:

• The J2EE security model lets you configure a Web component or enter-
prise bean so that system resources are accessed only by authorized users.

• The J2EE transaction model lets you specify relationships among methods
that make up a single transaction so that all methods in one transaction are
treated as a single unit.

• JNDI lookup services provide a unified interface to multiple naming and
directory services in the enterprise so that application components can
access naming and directory services.

• The J2EE remote connectivity model manages low-level communications
between clients and enterprise beans. After an enterprise bean is created, a
client invokes methods on it as if it were in the same virtual machine.

The fact that the J2EE architecture provides configurable services means that
application components within the same J2EE application can behave differently
based on where they are deployed. For example, an enterprise bean can have
security settings that allow it a certain level of access to database data in one pro-
duction environment and another level of database access in another production
environment.

The container also manages non-configurable services such as enterprise bean
and servlet life cycles, database connection resource pooling, data persistence,
and access to the J2EE platform APIs described in the section J2EE
APIs (page 17). Although data persistence is a non-configurable service, the
J2EE architecture lets you override container-managed persistence by including
the appropriate code in your enterprise bean implementation when you want
more control than the default container-managed persistence provides. For
example, you might use bean-managed persistence to implement your own
finder (search) methods or to create a customized database cache.
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Container Types
The deployment process installs J2EE application components in the J2EE con-
tainers illustrated in Figure 1–5.

Figure 1–5 J2EE Server and Containers

J2EE server
The runtime portion of a J2EE product. A J2EE server provides EJB and
Web containers.

Enterprise JavaBeans (EJB) container
Manages the execution of enterprise beans for J2EE applications. Enterprise
beans and their container run on the J2EE server.

Web container
Manages the execution of JSP page and servlet components for J2EE appli-
cations. Web components and their container run on the J2EE server.

Application client container
Manages the execution of application client components. Application clients
and their container run on the client.

Applet container
Manages the execution of applets. Consists of a Web browser and Java Plug-
in running on the client together.
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Packaging
A J2EE application is delivered in an Enterprise Archive (EAR) file. An EAR
file is a standard Java Archive (JAR) file with an .ear extension. The EAR file
contains J2EE modules. Using EAR files and modules makes it possible to
assemble a number of different J2EE applications using some of the same com-
ponents. No extra coding is needed; it is just a matter of assembling various
J2EE modules into J2EE EAR files.

A J2EE module consists of one or more J2EE components for the same container
type and one component deployment descriptor of that type. A deployment
descriptor is an XML document with an .xml extension that describes a compo-
nent’s deployment settings. An enterprise bean module deployment descriptor,
for example, declares transaction attributes and security authorizations for an
enterprise bean. Because deployment descriptor information is declarative, it can
be changed without modifying the bean source code. At run time, the J2EE
server reads the deployment descriptor and acts upon the component accord-
ingly. A J2EE module without an application deployment descriptor can be
deployed as a stand-alone module. The four types of J2EE modules are:

• Enterprise JavaBeans modules contain class files for enterprise beans and
an EJB deployment descriptor. EJB modules are packaged as JAR files
with a .jar extension.

• Web modules contain JSP files, class files for servlets, GIF and HTML
files, and a Web deployment descriptor. Web modules are packaged as JAR
files with a .war (Web ARchive) extension.

• Resource adapter modules contain all Java interfaces, classes, native
libraries, and other documentation, along with the resource adapter
deployment descriptor. Together, these implement the Connector architec-
ture (see J2EE Connector Architecture, page 21) for a particular EIS.
Resource adapter modules are packages as JAR files with a .rar

(Resource adapter ARchive) extension.

• Application client modules contain class files and an application client
deployment descriptor. Application client modules are packaged as JAR
files with a .jar extension.



12 OVERVIEW
Web Services Support
Web services are Web-based enterprise applications that use open, Extensible
Markup Language (XML)-based standards and transport protocols to exchange
data with calling clients. The J2EE platform provides the XML APIs and tools
you need to quickly design, develop, test, and deploy Web services and clients
that fully interoperate with other Web services and clients running on Java-based
or non-Java-based platforms.

It is easy to write Web services and clients with the J2EE XML APIs. All you do
is pass parameter data to the method calls and process the data returned, or for
document-oriented web services, send documents containing the service data
back and forth. No low-level programming is needed because the XML API
implementations do the work of translating the application data to and from an
XML-based data stream that is sent over the standardized XML-based transport
protocols. These XML-based standards and protocols are introduced in the next
sections.

The translation of data to a standardized XML-based data stream is what makes
Web services and clients written with the J2EE XML APIs fully interoperable.
This does not necessarily mean the data being transported includes XML tags
because the transported data can itself be plain text, XML data, or any kind of
binary data such as audio, video, maps, program files, CAD documents or the
like. The next section, introduces XML and explains how parties doing business
can use XML tags and schemas to exchange data in a meaningful way.

Extensible Markup Language
Extensible Markup Language is a cross-platform, extensible, and text-based
standard for representing data. When XML data is exchanged between parties,
the parties are free to create their own tags to describe the data, set up schemas to
specify which tags can be used in a particular kind of XML document, and use
XML style sheets to manage the display and handling of the data.
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For example, a Web service can use XML and a schema to produce price lists,
and companies that receive the price lists and schema can have their own style
sheets to handle the data in a way that best suits their needs.

• One company might put the XML pricing information through a program
to translate the XML to HTML so it can post the price lists to its Intranet.

• A partner company might put the XML pricing information through a tool
to create a marketing presentation.

• Another company might read the XML pricing information into an appli-
cation for processing.

HTTP-SOAP Transport Protocol
Client requests and Web service responses are transmitted as Simple Object
Access Protocol (SOAP) messages over HTTP to enable a completely interoper-
able exchange between clients and Web services all running on different plat-
forms and at various locations on the Internet. HTTP is a familiar request and
response standard for sending messages over the Internet, and SOAP is an XML-
based protocol that follows the HTTP request and response model.

The SOAP portion of a transported message handles the following:

• Defines an XML-based envelope to describe what is in the message and
how to process the message.

• Includes XML-based encoding rules to express instances of application-
defined data types within the message.

• Defines an XML-based convention for representing the request to the
remote service and the resulting response.

WSDL Standard Format
The Web Services Description Language (WSDL) is a standardized XML format
for describing network services. The description includes the name of the ser-
vice, the location of the service, and how to communicate with the service.
WSDLs can be stored in UDDI registries and/or published on the Web. The J2EE
platform provides a tool for generating the WSDL for a Web service that uses
remote procedure calls to communicate with clients.
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UDDI and ebXML Standard Formats
Other XML-based standards such as Universal Description, Discovery, and Inte-
gration (UDDI) and ebXML make it possible for businesses to publish informa-
tion on the Internet about their products and Web services where the information
can be readily and globally accessed by clients who want to do business.

Development Roles
Reusable modules make it possible to divide the application development and
deployment process into distinct roles so that different people or companies can
perform different parts of the process.

The first two roles involve purchasing and installing the J2EE product and tools.
Once software is purchased and installed, J2EE components can be developed by
application component providers, assembled by application assemblers, and
deployed by application deployers. In a large organization, each of these roles
might be executed by different individuals or teams. This division of labor works
because each of the earlier roles outputs a portable file that is the input for a sub-
sequent role. For example, in the application component development phase, an
enterprise bean software developer delivers EJB JAR files. In the application
assembly role, another developer combines these EJB JAR files into a J2EE
application and saves it in an EAR file. In the application deployment role, a sys-
tem administrator at the customer site uses the EAR file to install the J2EE appli-
cation into a J2EE server.

The different roles are not always executed by different people. If you work for a
small company, for example, or if you are prototyping a sample application, you
might perform the tasks in every phase.

J2EE Product Provider
The J2EE product provider is the company that designs and makes available for
purchase the J2EE platform, APIs, and other features defined in the J2EE speci-
fication. Product providers are typically operating system, database system,
application server, or Web server vendors who implement the J2EE platform
according to the Java 2 Platform, Enterprise Edition Specification.
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Tool Provider
The tool provider is the company or person who creates development, assembly,
and packaging tools used by component providers, assemblers, and deployers.

Application Component Provider
The application component provider is the company or person who creates Web
components, enterprise beans, applets, or application clients for use in J2EE
applications.

Enterprise Bean Developer
An enterprise bean developer performs the following tasks to deliver an EJB
JAR file that contains the enterprise bean:

• Writes and compiles the source code

• Specifies the deployment descriptor

• Bundles the .class files and deployment descriptor into an EJB JAR file

Web Component Developer
A Web component developer performs the following tasks to deliver a WAR file
containing the Web component:

• Writes and compiles servlet source code

• Writes JSP and HTML files

• Specifies the deployment descriptor for the Web component

• Bundles the .class, .jsp, .html, and deployment descriptor files in the
WAR file

J2EE Application Client Developer
An application client developer performs the following tasks to deliver a JAR file
containing the J2EE application client:

• Writes and compiles the source code

• Specifies the deployment descriptor for the client

• Bundles the .class files and deployment descriptor into the JAR file
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Application Assembler
The application assembler is the company or person who receives application
component JAR files from component providers and assembles them into a J2EE
application EAR file. The assembler or deployer can edit the deployment
descriptor directly or use tools that correctly add XML tags according to
interactive selections. A software developer performs the following tasks to
deliver an EAR file containing the J2EE application:

• Assembles EJB JAR and WAR files created in the previous phases into a
J2EE application (EAR) file

• Specifies the deployment descriptor for the J2EE application

• Verifies that the contents of the EAR file are well formed and comply with
the J2EE specification

Application Deployer and Administrator
The application deployer and administrator is the company or person who con-
figures and deploys the J2EE application, administers the computing and net-
working infrastructure where J2EE applications run, and oversees the runtime
environment. Duties include such things as setting transaction controls and secu-
rity attributes and specifying connections to databases.

During configuration, the deployer follows instructions supplied by the applica-
tion component provider to resolve external dependencies, specify security set-
tings, and assign transaction attributes. During installation, the deployer moves
the application components to the server and generates the container-specific
classes and interfaces.

A deployer/system administrator performs the following tasks to install and con-
figure a J2EE application:

• Adds the J2EE application (EAR) file created in the preceding phase to the
J2EE server

• Configures the J2EE application for the operational environment by mod-
ifying the deployment descriptor of the J2EE application

• Verifies that the contents of the EAR file are well formed and comply with
the J2EE specification

• Deploys (installs) the J2EE application EAR file into the J2EE server
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J2EE APIs
Enterprise JavaBeans Technology
An Enterprise JavaBeans™ (EJB™) component or enterprise bean is a body of
code with fields and methods to implement modules of business logic. You can
think of an enterprise bean as a building block that can be used alone or with
other enterprise beans to execute business logic on the J2EE server.

There are three kinds of enterprise beans: session beans, entity beans, and mes-
sage-driven beans. Enterprise beans often interact with databases. One of the
benefits of entity beans is that you do not have to write any SQL code or use the
JDBC™ API directly to perform database access operations; the EJB container
handles this for you. However, if you override the default container-managed
persistence for any reason, you will need to use the JDBC API. Also, if you
choose to have a session bean access the database, you have to use the
JDBC API.

JDBC API
The JDBC™ API lets you invoke SQL commands from Java programing lan-
guage methods. You use the JDBC API in an enterprise bean when you override
the default container-managed persistence or have a session bean access the
database. With container-managed persistence, database access operations are
handled by the container, and your enterprise bean implementation contains no
JDBC code or SQL commands. You can also use the JDBC API from a servlet or
JSP page to access the database directly without going through an enterprise
bean.

The JDBC API has two parts: an application-level interface used by the applica-
tion components to access a database, and a service provider interface to attach a
JDBC driver to the J2EE platform.

Java Servlet Technology
Java Servlet technology lets you define HTTP-specific servlet classes. A servlet
class extends the capabilities of servers that host applications accessed by way of
a request-response programming model. Although servlets can respond to any
type of request, they are commonly used to extend the applications hosted by
Web servers.
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JavaServer Pages Technology
JavaServer Pages™ (JSP™) technology lets you put snippets of servlet code
directly into a text-based document. A JSP page is a text-based document that
contains two types of text: static template data, which can be expressed in any
text-based format such as HTML, WML, and XML, and JSP elements, which
determine how the page constructs dynamic content.

Java Message Service
The Java Message Service (JMS) is a messaging standard that allows J2EE
application components to create, send, receive, and read messages. It enables
distributed communication that is loosely coupled, reliable, and asynchronous.

Java Naming and Directory Interface
The Java Naming and Directory Interface™ (JNDI) provides naming and direc-
tory functionality. It provides applications with methods for performing standard
directory operations, such as associating attributes with objects and searching for
objects using their attributes. Using JNDI, a J2EE application can store and
retrieve any type of named Java object.

J2EE naming services provide application clients, enterprise beans, and Web
components with access to a JNDI naming environment. A naming environment
allows a component to be customized without the need to access or change the
component's source code. A container implements the component’s environment
and provides it to the component as a JNDI naming context.

A J2EE component locates its environment naming context using JNDI inter-
faces. A component creates a javax.naming.InitialContext object and looks
up the environment naming context in InitialContext under the name
java:comp/env. A component’s naming environment is stored directly in the
environment naming context or in any of its direct or indirect subcontexts.

A J2EE component can access named system-provided and user-defined objects.
The names of system-provided objects, such as JTA UserTransaction objects,
are stored in the environment naming context, java:comp/env. The J2EE plat-
form allows a component to name user-defined objects, such as enterprise beans,
environment entries, JDBC DataSource objects, and message connections. An
object should be named within a subcontext of the naming environment accord-
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ing to the type of the object. For example, enterprise beans are named within the
subcontext java:comp/env/ejb and JDBC DataSource references in the sub-
context java:comp/env/jdbc.

Because JNDI is independent of any specific implementations, applications can
use JNDI to access multiple naming and directory services, including existing
naming and directory services such as LDAP, NDS, DNS, and NIS. This allows
J2EE applications to coexist with legacy applications and systems. For more
information on JNDI, see the online JNDI Tutorial:

http://java.sun.com/products/jndi/tutorial/index.html

Java Transaction API
The Java Transaction API (JTA) provides a standard interface for demarcating
transactions. The J2EE architecture provides a default auto commit to handle
transaction commits and rollbacks. An auto commit means that any other appli-
cations viewing data will see the updated data after each database read or write
operation. However, if your application performs two separate database access
operations that depend on each other, you will want to use the JTA API to
demarcate where the entire transaction, including both operations, begins, rolls
back, and commits.

JavaMail API
J2EE applications can use the JavaMail™ API to send e-mail notifications. The
JavaMail API has two parts: an application-level interface used by the applica-
tion components to send mail, and a service provider interface. The J2EE plat-
form includes JavaMail with a service provider that allows application
components to send Internet mail.

JavaBeans Activation Framework
The JavaBeans Activation Framework (JAF) is included because JavaMail uses
it. It provides standard services to determine the type of an arbitrary piece of
data, encapsulate access to it, discover the operations available on it, and create
the appropriate JavaBeans component to perform those operations.

http://java.sun.com/products/jndi/tutorial/index.html
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Java API for XML Processing
The Java API for XML Processing (JAXP) supports the processing of XML doc-
uments using Document Object Model (DOM), Simple API for XML Parsing
(SAX), and XML Stylesheet Language Transformation (XSLT). JAXP enables
applications to parse and transform XML documents independent of a particular
XML processing implementation.

JAXP also provides namespace support, which lets you work with schemas that
might otherwise have naming conflicts. Designed to be flexible, JAXP lets you
use any XML-compliant parser of XSL processor from within your application
and supports the W3C schema. You can find information on the W3C schema at
this URL: http://www.w3.org/XML/Schema.

Java API for XML Registries
The Java API for XML Registries (JAXR) lets you access business and general-
purpose registries over the Web. JAXR supports the ebXML Registry/Repository
standards and the emerging UDDI specifications. By using JAXR, developers
can learn a single API and get access to both of these important registry technol-
ogies.

Additionally, businesses submit material to be shared and search for material
that others have submitted. Standards groups have developed schemas for partic-
ular kinds of XML documents, and two businesses might, for example, agree to
use the schema for their industry’s standard purchase order form. Because the
schema is stored in a standard business registry, both parties can use JAXR to
access it.

Java API for XML-Based RPC
The Java API for XML-based RPC (JAX-RPC) uses the SOAP standard and
HTTP so client programs can make XML-based remote procedure calls (RPCs)
over the Internet. JAX-RPC also supports WSDL so you can import and export
WSDL documents. With JAX-RPC and a WSDL, you can easily interoperate
with clients and services running on Java-based or non-Java-based platforms
such as .NET. For example, based on the WSDL document, a Visual Basic .NET
client can be configured to use a Web service implemented in Java technology or
a Web service can be configured to recognize a Visual Basic .NET client.
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JAX-RPC relies on the HTTP transport protocol. Taking that a step further, JAX-
RPC lets you create service applications that combine HTTP with a Java tech-
nology version of the Secure Socket Layer (SSL) and Transport Layer Security
(TLS) protocols to establish basic or mutual authentication. SSL and TLS ensure
message integrity by providing data encryption with client and server authentica-
tion capabilities.

Authentication is a measured way to verify whether a party is eligible and able to
access certain information as a way to protect against the fraudulent use of a sys-
tem and/or the fraudulent transmission of information. Information transported
across the Internet is especially vulnerable to being intercepted and misused, so
configuring a JAX-RPC Web service to protect data in transit is very important.

SOAP with Attachments API for Java
The SOAP with Attachments API for Java (SAAJ) is a low-level API upon
which JAX-RPC depends. It enables the production and consumption of mes-
sages that conform to the SOAP 1.1 specification and SOAP with Attachments
note. Most developers will not use the SAAJ API, but will use the higher-level
JAX-RPC API instead.

J2EE Connector Architecture
The J2EE Connector architecture is used by J2EE tools vendors and system inte-
grators to create resource adapters that support access to enterprise information
systems that can be plugged into any J2EE product. A resource adapter is a soft-
ware component that allows J2EE application components to access and interact
with the underlying resource manager. Because a resource adapter is specific to
its resource manager, there is typically a different resource adapter for each type
of database or enterprise information system.

JAX-RPC and the J2EE Connector Architecture are complementary technolo-
gies for enterprise application integration (EAI) and end-to-end business integra-
tion.

The J2EE Connector Architecture also provides a performance-oriented, secure,
scalable, and message-based transactional integration of J2EE-based Web ser-
vices with existing EISs that can be either synchronous or asynchronous. Exist-
ing applications and EISs integrated through the J2EE Connector Architecture
into the J2EE platform can be exposed as XML-based Web services using JAX-
RPC and J2EE component models.
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Java Authentication and Authorization
Service
The Java Authentication and Authorization Service (JAAS) provides a way for a
J2EE application to authenticate and authorize a specific user or group of users
to run it.

JAAS is a Java programing language version of the standard Pluggable Authenti-
cation Module (PAM) framework that extends the Java 2 Platform security archi-
tecture to support user-based authorization.

Simplified Systems Integration
The J2EE platform is a platform-independent, full systems integration solution
that creates an open marketplace in which every vendor can sell to every cus-
tomer. Such a marketplace encourages vendors to compete, not by trying to lock
customers into their technologies but by trying to outdo each other by providing
products and services that benefit customers, such as better performance, better
tools, or better customer support.

The J2EE APIs enable systems and applications integration through the follow-
ing:

• Unified application model across tiers with enterprise beans

• Simplified response and request mechanism with JSP pages and servlets

• Reliable security model with JAAS

• XML-based data interchange integration with JAXP

• Simplified interoperability with the J2EE Connector Architecture

• Easy database connectivity with the JDBC API

• Enterprise application integration with message-driven beans and JMS,
JTA, and JNDI

You can learn more about using the J2EE platform to build integrated business
systems by reading J2EE Technology in Practice:

http://java.sun.com/j2ee/inpractice/aboutthebook.html

http://java.sun.com/j2ee/inpractice/aboutthebook.html
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Understanding XML

THIS chapter describes the Extensible Markup Language (XML) and its
related specifications. It also gives you practice in writing XML data, so you
become comfortably familiar with XML syntax.

Note: The XML files mentioned in this chapter can be found in
<INSTALL>/j2eetutorial14/examples/xml/samples.

Introduction to XML
This section covers the basics of XML. The goal is to give you just enough infor-
mation to get started, so you understand what XML is all about. (You’ll learn
about XML in later sections of the tutorial.) We then outline the major features
that make XML great for information storage and interchange, and give you a
general idea of how XML can be used.

What Is XML?
XML is a text-based markup language that is fast becoming the standard for data
interchange on the Web. As with HTML, you identify data using tags (identifiers
enclosed in angle brackets, like this: <...>). Collectively, the tags are known as
“markup”.
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But unlike HTML, XML tags identify the data, rather than specifying how to dis-
play it. Where an HTML tag says something like “display this data in bold font”
(<b>...</b>), an XML tag acts like a field name in your program. It puts a label
on a piece of data that identifies it (for example: <message>...</message>).

Note: Since identifying the data gives you some sense of what means (how to inter-
pret it, what you should do with it), XML is sometimes described as a mechanism
for specifying the semantics (meaning) of the data.

In the same way that you define the field names for a data structure, you are free
to use any XML tags that make sense for a given application. Naturally, though,
for multiple applications to use the same XML data, they have to agree on the tag
names they intend to use.

Here is an example of some XML data you might use for a messaging applica-
tion:

<message>
<to>you@yourAddress.com</to>
<from>me@myAddress.com</from>
<subject>XML Is Really Cool</subject>
<text>

How many ways is XML cool? Let me count the ways...
</text>

</message>

Note: Throughout this tutorial, we use boldface text to highlight things we want to
bring to your attention. XML does not require anything to be in bold!

The tags in this example identify the message as a whole, the destination and
sender addresses, the subject, and the text of the message. As in HTML, the <to>
tag has a matching end tag: </to>. The data between the tag and its matching
end tag defines an element of the XML data. Note, too, that the content of the
<to> tag is entirely contained within the scope of the <message>..</message>

tag. It is this ability for one tag to contain others that gives XML its ability to
represent hierarchical data structures.

Once again, as with HTML, whitespace is essentially irrelevant, so you can for-
mat the data for readability and yet still process it easily with a program. Unlike
HTML, however, in XML you could easily search a data set for messages con-
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taining “cool” in the subject, because the XML tags identify the content of the
data, rather than specifying its representation.

Tags and Attributes
Tags can also contain attributes—additional information included as part of the
tag itself, within the tag’s angle brackets. The following example shows an email
message structure that uses attributes for the “to”, “from”, and “subject”

fields:

<message to="you@yourAddress.com" from="me@myAddress.com"
subject="XML Is Really Cool">

<text>
How many ways is XML cool? Let me count the ways...

</text>
</message>

As in HTML, the attribute name is followed by an equal sign and the attribute
value, and multiple attributes are separated by spaces. Unlike HTML, however,
in XML commas between attributes are not ignored—if present, they generate
an error.

Since you could design a data structure like <message> equally well using either
attributes or tags, it can take a considerable amount of thought to figure out
which design is best for your purposes. Designing an XML Data
Structure (page 78), includes ideas to help you decide when to use attributes and
when to use tags.

Empty Tags
One really big difference between XML and HTML is that an XML document is
always constrained to be well formed. There are several rules that determine
when a document is well-formed, but one of the most important is that every tag
has a closing tag. So, in XML, the </to> tag is not optional. The <to> element is
never terminated by any tag other than </to>.

Note: Another important aspect of a well-formed document is that all tags are com-
pletely nested. So you can have <message>..<to>..</to>..</message>, but never
<message>..<to>..</message>..</to>. A complete list of requirements is con-
tained in the list of XML Frequently Asked Questions (FAQ) at
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http://www.ucc.ie/xml/#FAQ-VALIDWF. (This FAQ is on the w3c “Recommended
Reading” list at http://www.w3.org/XML/.)

Sometimes, though, it makes sense to have a tag that stands by itself. For exam-
ple, you might want to add a “flag” tag that marks message as important. A tag
like that doesn’t enclose any content, so it’s known as an “empty tag”. You can
create an empty tag by ending it with /> instead of >. For example, the following
message contains such a tag:

<message to="you@yourAddress.com" from="me@myAddress.com"
subject="XML Is Really Cool">

<flag/>
<text>

How many ways is XML cool? Let me count the ways...
</text>

</message>

Note: The empty tag saves you from having to code <flag></flag> in order to have
a well-formed document. You can control which tags are allowed to be empty by
creating a Document Type Definition, or DTD. We’ll talk about that in a few
moments. If there is no DTD, then the document can contain any kinds of tags you
want, as long as the document is well-formed.

Comments in XML Files
XML comments look just like HTML comments:

<message to="you@yourAddress.com" from="me@myAddress.com"
subject="XML Is Really Cool">

<!-- This is a comment -->
<text>

How many ways is XML cool? Let me count the ways...
</text>

</message>

http://www.ucc.ie/xml/#FAQ-VALIDWF
http://www.w3.org/XML/
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The XML Prolog
To complete this journeyman’s introduction to XML, note that an XML file
always starts with a prolog. The minimal prolog contains a declaration that iden-
tifies the document as an XML document, like this:

<?xml version="1.0"?>

The declaration may also contain additional information, like this:

<?xml version="1.0" encoding="ISO-8859-1" standalone="yes"?>

The XML declaration is essentially the same as the HTML header, <html>,
except that it uses <?..?> and it may contain the following attributes:

version
Identifies the version of the XML markup language used in the data. This
attribute is not optional.

encoding
Identifies the character set used to encode the data. “ISO-8859-1” is “Latin-
1” the Western European and English language character set. (The default is
compressed Unicode: UTF-8.)

standalone
Tells whether or not this document references an external entity or an exter-
nal data type specification (see below). If there are no external references,
then “yes” is appropriate

The prolog can also contain definitions of entities (items that are inserted when
you reference them from within the document) and specifications that tell which
tags are valid in the document, both declared in a Document Type Definition
(DTD) that can be defined directly within the prolog, as well as with pointers to
external specification files. But those are the subject of later tutorials. For more
information on these and many other aspects of XML, see the Recommended
Reading list of the w3c XML page at http://www.w3.org/XML/.

Note: The declaration is actually optional. But it’s a good idea to include it when-
ever you create an XML file. The declaration should have the version number, at a
minimum, and ideally the encoding as well. That standard simplifies things if the
XML standard is extended in the future, and if the data ever needs to be localized
for different geographical regions.

Everything that comes after the XML prolog constitutes the document’s content.

http://www.w3.org/XML/
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Processing Instructions
An XML file can also contain processing instructions that give commands or
information to an application that is processing the XML data. Processing
instructions have the following format:

  <?target instructions?>

where the target is the name of the application that is expected to do the process-
ing, and instructions is a string of characters that embodies the information or
commands for the application to process.

Since the instructions are application specific, an XML file could have multiple
processing instructions that tell different applications to do similar things,
though in different ways. The XML file for a slideshow, for example, could have
processing instructions that let the speaker specify a technical or executive-level
version of the presentation. If multiple presentation programs were used, the pro-
gram might need multiple versions of the processing instructions (although it
would be nicer if such applications recognized standard instructions).

Note: The target name “xml” (in any combination of upper or lowercase letters) is
reserved for XML standards. In one sense, the declaration is a processing instruc-
tion that fits that standard. (However, when you’re working with the parser later,
you’ll see that the method for handling processing instructions never sees the dec-
laration.)

Why Is XML Important?
There are a number of reasons for XML’s surging acceptance. This section lists a
few of the most prominent.

Plain Text
Since XML is not a binary format, you can create and edit files with anything
from a standard text editor to a visual development environment. That makes it
easy to debug your programs, and makes it useful for storing small amounts of
data. At the other end of the spectrum, an XML front end to a database makes it
possible to efficiently store large amounts of XML data as well. So XML pro-
vides scalability for anything from small configuration files to a company-wide
data repository.
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Data Identification
XML tells you what kind of data you have, not how to display it. Because the
markup tags identify the information and break up the data into parts, an email
program can process it, a search program can look for messages sent to particu-
lar people, and an address book can extract the address information from the rest
of the message. In short, because the different parts of the information have been
identified, they can be used in different ways by different applications.

Stylability
When display is important, the stylesheet standard, XSL (page 37), lets you dic-
tate how to portray the data. For example, the stylesheet for:

<to>you@yourAddress.com</to>

can say:

1. Start a new line.

2. Display “To:” in bold, followed by a space

3. Display the destination data.

Which produces:

To: you@yourAddress

Of course, you could have done the same thing in HTML, but you wouldn’t be
able to process the data with search programs and address-extraction programs
and the like. More importantly, since XML is inherently style-free, you can use a
completely different stylesheet to produce output in postscript, TEX, PDF, or
some new format that hasn’t even been invented yet. That flexibility amounts to
what one author described as “future-proofing” your information. The XML
documents you author today can be used in future document-delivery systems
that haven’t even been imagined yet.

Inline Reusability
One of the nicer aspects of XML documents is that they can be composed from
separate entities. You can do that with HTML, but only by linking to other docu-
ments. Unlike HTML, XML entities can be included “in line” in a document.
The included sections look like a normal part of the document—you can search
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the whole document at one time or download it in one piece. That lets you mod-
ularize your documents without resorting to links. You can single-source a sec-
tion so that an edit to it is reflected everywhere the section is used, and yet a
document composed from such pieces looks for all the world like a one-piece
document.

Linkability
Thanks to HTML, the ability to define links between documents is now regarded
as a necessity. The next section of this tutorial, XML and Related Specs: Digest-
ing the Alphabet Soup (page 33), discusses the link-specification initiative. This
initiative lets you define two-way links, multiple-target links, “expanding” links
(where clicking a link causes the targeted information to appear inline), and links
between two existing documents that are defined in a third.

Easily Processed
As mentioned earlier, regular and consistent notation makes it easier to build a
program to process XML data. For example, in HTML a <dt> tag can be delim-
ited by </dt>, another <dt>, <dd>, or </dl>. That makes for some difficult pro-
gramming. But in XML, the <dt> tag must always have a </dt> terminator, or
else it will be defined as a <dt/> tag. That restriction is a critical part of the con-
straints that make an XML document well-formed. (Otherwise, the XML parser
won’t be able to read the data.) And since XML is a vendor-neutral standard, you
can choose among several XML parsers, any one of which takes the work out of
processing XML data.

Hierarchical
Finally, XML documents benefit from their hierarchical structure. Hierarchical
document structures are, in general, faster to access because you can drill down
to the part you need, like stepping through a table of contents. They are also eas-
ier to rearrange, because each piece is delimited. In a document, for example,
you could move a heading to a new location and drag everything under it along
with the heading, instead of having to page down to make a selection, cut, and
then paste the selection into a new location.
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How Can You Use XML?
 There are several basic ways to make use of XML:

• Traditional data processing, where XML encodes the data for a program to
process

• Document-driven programming, where XML documents are containers
that build interfaces and applications from existing components

• Archiving—the foundation for document-driven programming, where the
customized version of a component is saved (archived) so it can be used
later

• Binding, where the DTD or schema that defines an XML data structure is
used to automatically generate a significant portion of the application that
will eventually process that data

Traditional Data Processing
XML is fast becoming the data representation of choice for the Web. It’s terrific
when used in conjunction with network-centric Java-platform programs that
send and retrieve information. So a client/server application, for example, could
transmit XML-encoded data back and forth between the client and the server.

In the future, XML is potentially the answer for data interchange in all sorts of
transactions, as long as both sides agree on the markup to use. (For example,
should an e-mail program expect to see tags named <FIRST> and <LAST>, or
<FIRSTNAME> and <LASTNAME>) The need for common standards will generate a
lot of industry-specific standardization efforts in the years ahead. In the mean-
time, mechanisms that let you “translate” the tags in an XML document will be
important. Such mechanisms include projects like the RDF (page 42) initiative,
which defines “meta tags”, and the XSL (page 37) specification, which lets you
translate XML tags into other XML tags.

Document-Driven Programming
The newest approach to using XML is to construct a document that describes
how an application page should look. The document, rather than simply being
displayed, consists of references to user interface components and business-logic
components that are “hooked together” to create an application on the fly.

Of course, it makes sense to utilize the Java platform for such components. Both
Java Beans components for interfaces and Enterprise Java Beans components for
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business logic can be used to construct such applications. Although none of the
efforts undertaken so far are ready for commercial use, much preliminary work
has already been done.

Note: The Java programming language is also excellent for writing XML-process-
ing tools that are as portable as XML. Several Visual XML editors have been writ-
ten for the Java platform. For a listing of editors, processing tools, and other XML
resources, see the “Software” section of Robin Cover’s SGML/XML Web Page at
http://www.oasis-open.org/cover/.

Binding
Once you have defined the structure of XML data using either a DTD or the one
of the schema standards, a large part of the processing you need to do has
already been defined. For example, if the schema says that the text data in a
<date> element must follow one of the recognized date formats, then one aspect
of the validation criteria for the data has been defined—it only remains to write
the code. Although a DTD specification cannot go the same level of detail, a
DTD (like a schema) provides a grammar that tells which data structures can
occur, in what sequences. That specification tells you how to write the high-level
code that processes the data elements.

But when the data structure (and possibly format) is fully specified, the code you
need to process it can just as easily be generated automatically. That process is
known as binding—creating classes that recognize and process different data
elements by processing the specification that defines those elements. As time
goes on, you should find that you are using the data specification to generate sig-
nificant chunks of code, so you can focus on the programming that is unique to
your application.

Archiving
The Holy Grail of programming is the construction of reusable, modular compo-
nents. Ideally, you’d like to take them off the shelf, customize them, and plug
them together to construct an application, with a bare minimum of additional
coding and additional compilation.

The basic mechanism for saving information is called archiving. You archive a
component by writing it to an output stream in a form that you can reuse later.
You can then read it in and instantiate it using its saved parameters. (For exam-

http://www.oasis-open.org/cover/
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ple, if you saved a table component, its parameters might be the number of rows
and columns to display.) Archived components can also be shuffled around the
Web and used in a variety of ways.

When components are archived in binary form, however, there are some limita-
tions on the kinds of changes you can make to the underlying classes if you want
to retain compatibility with previously saved versions. If you could modify the
archived version to reflect the change, that would solve the problem. But that’s
hard to do with a binary object. Such considerations have prompted a number of
investigations into using XML for archiving. But if an object’s state were
archived in text form using XML, then anything and everything in it could be
changed as easily as you can say, “search and replace”.

XML’s text-based format could also make it easier to transfer objects between
applications written in different languages. For all of these reasons, XML-based
archiving is likely to become an important force in the not-too-distant future.

Summary
XML is pretty simple, and very flexible. It has many uses yet to be discovered—
we are just beginning to scratch the surface of its potential. It is the foundation
for a great many standards yet to come, providing a common language that dif-
ferent computer systems can use to exchange data with one another. As each
industry-group comes up with standards for what they want to say, computers
will begin to link to each other in ways previously unimaginable.

For more information on the background and motivation of XML, see this great
article in Scientific American at

http://www.sciam.com/1999/0599issue/0599bosak.html

XML and Related Specs: Digesting the
Alphabet Soup

Now that you have a basic understanding of XML, it makes sense to get a high-
level overview of the various XML-related acronyms and what they mean. There
is a lot of work going on around XML, so there is a lot to learn.

The current APIs for accessing XML documents either serially or in random
access mode are, respectively, SAX (page 35) and DOM (page 35). The specifi-
cations for ensuring the validity of XML documents are DTD (page 36) (the

http://www.sciam.com/1999/0599issue/0599bosak.html
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original mechanism, defined as part of the XML specification) and various
Schema Standards (page 38) proposals (newer mechanisms that use XML syntax
to do the job of describing validation criteria).

Other future standards that are nearing completion include the XSL (page 37)
standard—a mechanism for setting up translations of XML documents (for
example to HTML or other XML) and for dictating how the document is ren-
dered. The transformation part of that standard, XSLT (+XPATH) (page 37), is
completed and covered in this tutorial. Another effort nearing completion is the
XML Link Language specification (XML Linking, page 40), which enables
links between XML documents.

Those are the major initiatives you will want to be familiar with. This section
also surveys a number of other interesting proposals, including the HTML-
lookalike standard, XHTML (page 41), and the meta-standard for describing the
information an XML document contains, RDF (page 42). There are also stan-
dards efforts that extend XML’s capabilities, such as XLink and XPointer.

Finally, there are a number of interesting standards and standards-proposals that
build on XML, including Synchronized Multimedia Integration Language
(SMIL, page 43), Mathematical Markup Language (MathML, page 43), Scal-
able Vector Graphics (SVG, page 43), and DrawML (page 43), as well as a num-
ber of eCommerce standards.

The remainder of this section gives you a more detailed description of these ini-
tiatives. To help keep things straight, it’s divided into:

• Basic Standards (page 34)

• Schema Standards (page 38)

• Linking and Presentation Standards (page 40)

• Knowledge Standards (page 41)

• Standards That Build on XML (page 43)

Skim the terms once, so you know what’s here, and keep a copy of this document
handy so you can refer to it whenever you see one of these terms in something
you’re reading. Pretty soon, you’ll have them all committed to memory, and
you’ll be at least “conversant” with XML!

Basic Standards
These are the basic standards you need to be familiar with. They come up in
pretty much any discussion of XML.
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SAX
Simple API for XML

This API was actually a product of collaboration on the XML-DEV mailing list,
rather than a product of the W3C. It’s included here because it has the same
“final” characteristics as a W3C recommendation.

You can also think of this standard as the “serial access” protocol for XML. This
is the fast-to-execute mechanism you would use to read and write XML data in a
server, for example. This is also called an event-driven protocol, because the
technique is to register your handler with a SAX parser, after which the parser
invokes your callback methods whenever it sees a new XML tag (or encounters
an error, or wants to tell you anything else).

DOM
Document Object Model

The Document Object Model protocol converts an XML document into a collec-
tion of objects in your program. You can then manipulate the object model in any
way that makes sense. This mechanism is also known as the “random access”
protocol, because you can visit any part of the data at any time. You can then
modify the data, remove it, or insert new data.

JDOM and dom4j
While the Document Object Model (DOM) provides a lot of power for docu-
ment-oriented processing, it doesn’t provide much in the way of object-oriented
simplification. Java developers who are processing more data-oriented struc-
tures—rather than books, articles, and other full-fledged documents—frequently
find that object-oriented APIs like JDOM and dom4j are easier to use and more
suited to their needs.
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Here are the important differences to understand when choosing between the
two:

• JDOM is somewhat cleaner, smaller API. Where “coding style” is an
important consideration, JDOM is a good choice.

• JDOM is a Java Community Process (JCP) initiative. When completed, it
will be an endorsed standard.

• dom4j is a smaller, faster implementation that has been in wide use for a
number of years.

• dom4j is a factory-based implementation. That makes it easier to modify
for complex, special-purpose applications. At the time of this writing,
JDOM does not yet use a factory to instantiate an instance of the parser
(although the standard appears to be headed in that direction). So, with
JDOM, you always get the original parser. (That’s fine for the majority of
applications, but may not be appropriate if your application has special
needs.)

For more information on JDOM, see http://www.jdom.org/.

For more information on dom4j, see http://dom4j.org/.

DTD
Document Type Definition

The DTD specification is actually part of the XML specification, rather than a
separate entity. On the other hand, it is optional—you can write an XML docu-
ment without it. And there are a number of Schema Standards (page 38) propos-
als that offer more flexible alternatives. So it is treated here as though it were a
separate specification.

A DTD specifies the kinds of tags that can be included in your XML document,
and the valid arrangements of those tags. You can use the DTD to make sure you
don’t create an invalid XML structure. You can also use it to make sure that the
XML structure you are reading (or that got sent over the net) is indeed valid.

Unfortunately, it is difficult to specify a DTD for a complex document in such a
way that it prevents all invalid combinations and allows all the valid ones. So
constructing a DTD is something of an art. The DTD can exist at the front of the
document, as part of the prolog. It can also exist as a separate entity, or it can be
split between the document prolog and one or more additional entities.

http://www.jdom.org/
http://dom4j.org/
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However, while the DTD mechanism was the first method defined for specifying
valid document structure, it was not the last. Several newer schema specifica-
tions have been devised. You’ll learn about those momentarily.

Namespaces
The namespace standard lets you write an XML document that uses two or more
sets of XML tags in modular fashion. Suppose for example that you created an
XML-based parts list that uses XML descriptions of parts supplied by other
manufacturers (online!). The “price” data supplied by the subcomponents would
be amounts you want to total up, while the “price” data for the structure as a
whole would be something you want to display. The namespace specification
defines mechanisms for qualifying the names so as to eliminate ambiguity. That
lets you write programs that use information from other sources and do the right
things with it.

The latest information on namespaces can be found at
http://www.w3.org/TR/REC-xml-names.

XSL
Extensible Stylesheet Language

The XML standard specifies how to identify data, not how to display it. HTML,
on the other hand, told how things should be displayed without identifying what
they were. The XSL standard has two parts, XSLT (the transformation standard,
described next) and XSL-FO (the part that covers formatting objects, also known
as flow objects). XSL-FO gives you the ability to define multiple areas on a page
and then link them together. When a text stream is directed at the collection, it
fills the first area and then “flows” into the second when the first area is filled.
Such objects are used by newsletters, catalogs, and periodical publications.

The latest W3C work on XSL is at http://www.w3.org/TR/WD-xsl.

XSLT (+XPATH)
Extensible Stylesheet Language for Transformations

The XSLT transformation standard is essentially a translation mechanism that
lets you specify what to convert an XML tag into so that it can be displayed—for
example, in HTML. Different XSL formats can then be used to display the same
data in different ways, for different uses. (The XPATH standard is an addressing

http://www.w3.org/TR/REC-xml-names
http://www.w3.org/TR/WD-xsl
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mechanism that you use when constructing transformation instructions, in order
to specify the parts of the XML structure you want to transform.)

Schema Standards
A DTD makes it possible to validate the structure of relatively simple XML doc-
uments, but that’s as far as it goes.

A DTD can’t restrict the content of elements, and it can’t specify complex rela-
tionships. For example, it is impossible to specify that a <heading> for a <book>
must have both a <title> and an <author>, while a <heading> for a <chapter>
only needs a <title>. In a DTD, you only get to specify the structure of the
<heading> element one time. There is no context-sensitivity, because a DTD
specification is not hierarchical.

For example, for a mailing address that contains several “parsed character data”
(PCDATA) elements, the DTD might look something like this:

<!ELEMENT mailAddress (name, address, zipcode)>
<!ELEMENT name (#PCDATA)>
<!ELEMENT address (#PCDATA)>
<!ELEMENT zipcode (#PCDATA)>

As you can see, the specifications are linear. So if you need another “name” ele-
ment in the DTD, you need a different identifier for it. You could not simply call
it “name” without conflicting with the <name> element defined for use in a
<mailAddress>.

Another problem with the non hierarchical nature of DTD specifications is that it
is not clear what comments are meant to explain. A comment at the top like
might be intended to apply to the whole structure, or it might be intended only
for the first item. Finally, DTDs do not allow you to formally specify field-vali-
dation criteria, such as the 5-digit (or 5 and 4) limitation for the zipcode field.

Finally, a DTD uses syntax which is substantially different from XML, so it
can’t be processed with a standard XML parser. That means you can’t read a
DTD into a DOM, for example, modify it, and then write it back out again.

To remedy these shortcomings, a number of proposals have been made for a
more database-like, hierarchical “schema” that specifies validation criteria. The
major proposals are shown below.
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XML Schema
A large, complex standard that has two parts. One part specifies structure rela-
tionships. (This is the largest and most complex part.) The other part specifies
mechanisms for validating the content of XML elements by specifying a (poten-
tially very sophisticated) datatype for each element. The good news is that XML
Schema for Structures lets you specify virtually any relationship you can con-
ceive. The bad news is that it is very difficult to implement, and it’s hard to learn.
Most of the alternatives provide for simpler structure definitions, while incorpo-
rating XML Schema’s datatyping mechanisms.

For more information on XML Schema, see the W3C specs XML Schema
(Structures) and XML Schema (Datatypes), as well as other information accessi-
ble at http://www.w3c.org/XML/Schema.

RELAX NG
REgular LAnguage description for XML (Next Generation)

Simpler than XML Structure Schema, RELAX NG is an emerging standard
under the auspices of OASIS (Organization for the Advancement of Structured
Information Systems). It may become an ISO standard in the near future, as well.

RELAX NG uses regular expression patterns to express constraints on structure
relationships, and it is uses XML Schema datatyping mechanisms to express
content constraints. This standard also uses XML syntax, and it includes a DTD
to RELAX converter. (It’s “next generation” because it’s a newer version of the
RELAX schema mechanism that integrates TREX.)

For more information on RELAX NG, see http://www.oasis-open.org/com-

mittees/relax-ng/

TREX
Tree Regular Expressions for XML

A means of expressing validation criteria by describing a pattern for the struc-
ture and content of an XML document. Now part of the RELAX NG specifica-
tion.

For more information on TREX, see http://www.thaiopensource.com/trex/.

http://www.w3c.org/XML/Schema
http://www.oasis-open.org/committees/relax-ng/
http://www.oasis-open.org/committees/relax-ng/
http://www.thaiopensource.com/trex/
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SOX
Schema for Object-oriented XML

SOX is a schema proposal that includes extensible data types, namespaces, and
embedded documentation.

For more information on SOX, see http://www.w3.org/TR/NOTE-SOX.

Schematron
Schema for Object-oriented XML

An assertion-based schema mechanism that allows for sophisticated validation.

For more information on the Schematron validation mechanism, see
http://www.ascc.net/xml/resource/schematron/schematron.html.

Linking and Presentation Standards
Arguably the two greatest benefits provided by HTML were the ability to link
between documents, and the ability to create simple formatted documents (and,
eventually, very complex formatted documents). The following standards aim at
preserving the benefits of HTML in the XML arena, and to adding additional
functionality, as well.

XML Linking
These specifications provide a variety of powerful linking mechanisms, and are
sure to have a big impact on how XML documents are used.

 XLink
The XLink protocol is a specification for handling links between XML doc-
uments. This specification allows for some pretty sophisticated linking,
including two-way links, links to multiple documents, “expanding” links
that insert the linked information into your document rather than replacing
your document with a new page, links between two documents that are cre-
ated in a third, independent document, and indirect links (so you can point to
an “address book” rather than directly to the target document—updating the
address book then automatically changes any links that use it).

http://www.w3.org/TR/NOTE-SOX
http://www.ascc.net/xml/resource/schematron/schematron.html
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XML Base
This standard defines an attribute for XML documents that defines a “base”
address, that is used when evaluating a relative address specified in the docu-
ment. (So, for example, a simple file name would be found in the base-
address directory.)

XPointer
In general, the XLink specification targets a document or document-segment
using its ID. The XPointer specification defines mechanisms for “addressing
into the internal structures of XML documents”, without requiring the
author of the document to have defined an ID for that segment. To quote the
spec, it provides for “reference to elements, character strings, and other parts
of XML documents, whether or not they bear an explicit ID attribute”.

For more information on the XML Linking standards, see
http://www.w3.org/XML/Linking.

XHTML
The XHTML specification is a way of making XML documents that look and act
like HTML documents. Since an XML document can contain any tags you care
to define, why not define a set of tags that look like HTML? That’s the thinking
behind the XHTML specification, at any rate. The result of this specification is a
document that can be displayed in browsers and also treated as XML data. The
data may not be quite as identifiable as “pure” XML, but it will be a heck of a lot
easier to manipulate than standard HTML, because XML specifies a good deal
more regularity and consistency.

For example, every tag in a well-formed XML document must either have an
end-tag associated with it or it must end in />. So you might see <p>...</p>, or
you might see <p/>, but you will never see <p> standing by itself. The upshot of
that requirement is that you never have to program for the weird kinds of cases
you see in HTML where, for example, a <dt> tag might be terminated by </DT>,
by another <DT>, by <dd>, or by </dl>. That makes it a lot easier to write code!

The XHTML specification is a reformulation of HTML 4.0 into XML. The latest
information is at http://www.w3.org/TR/xhtml1.

Knowledge Standards
When you start looking down the road five or six years, and visualize how the
information on the Web will begin to turn into one huge knowledge base (the

http://www.w3.org/XML/Linking
http://www.w3.org/TR/xhtml1
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“semantic Web”). For the latest on the semantic Web, visit
http://www.w3.org/2001/sw/.

In the meantime, here are the fundamental standards you’ll want to know about:

RDF
Resource Description Framework

RDF is a standard for defining meta data—information that describes what a par-
ticular data item is, and specifies how it can be used. Used in conjunction with
the XHTML specification, for example, or with HTML pages, RDF could be
used to describe the content of the pages. For example, if your browser stored
your ID information as FIRSTNAME, LASTNAME, and EMAIL, an RDF description
could make it possible to transfer data to an application that wanted NAME and
EMAILADDRESS. Just think: One day you may not need to type your name and
address at every Web site you visit!

For the latest information on RDF, see http://www.w3.org/TR/REC-rdf-syn-

tax.

RDF Schema
RDF Schema allows the specification of consistency rules and additional infor-
mation that describe how the statements in a Resource Description Framework
(RDF) should be interpreted.

For more information on the RDF Schema recommendation, see
http://www.w3.org/TR/rdf-schema.

XTM
XML Topic Maps

In many ways a simpler, more readily usable knowledge-representation than
RDF, the topic maps standard is one worth watching. So far, RDF is the W3C
standard for knowledge representation, but topic maps could possibly become
the “developer’s choice” among knowledge representation standards.

For more information on XML Topic Maps, http://www.topic-

maps.org/xtm/index.html. For information on topic maps and the Web, see
http://www.topicmaps.org/.

http://www.w3.org/2001/sw/
http://www.w3.org/TR/REC-rdf-syntax
http://www.w3.org/TR/REC-rdf-syntax
http://www.w3.org/TR/rdf-schema
http://www.topicmaps.org/xtm/index.html
http://www.topicmaps.org/xtm/index.html
http://www.topicmaps.org/
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Standards That Build on XML
The following standards and proposals build on XML. Since XML is basically a
language-definition tool, these specifications use it to define standardized lan-
guages for specialized purposes.

Extended Document Standards
These standards define mechanisms for producing extremely complex docu-
ments—books, journals, magazines, and the like—using XML.

SMIL
Synchronized Multimedia Integration Language

SMIL is a W3C recommendation that covers audio, video, and animations. It
also addresses the difficult issue of synchronizing the playback of such elements.

For more information on SMIL, see http://www.w3.org/TR/REC-smil.

MathML
Mathematical Markup Language

MathML is a W3C recommendation that deals with the representation of mathe-
matical formulas.

For more information on MathML, see http://www.w3.org/TR/REC-MathML.

SVG
Scalable Vector Graphics

SVG is a W3C working draft that covers the representation of vector graphic
images. (Vector graphic images that are built from commands that say things like
“draw a line (square, circle) from point xi to point m,n” rather than encoding the
image as a series of bits. Such images are more easily scalable, although they
typically require more processing time to render.)

For more information on SVG, see http://www.w3.org/TR/WD-SVG.

DrawML
Drawing Meta Language

http://www.w3.org/TR/REC-smil
http://www.w3.org/TR/REC-MathML
http://www.w3.org/TR/WD-SVG
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DrawML is a W3C note that covers 2D images for technical illustrations. It also
addresses the problem of updating and refining such images.

For more information on DrawML, see http://www.w3.org/TR/NOTE-drawml.

eCommerce Standards
These standards are aimed at using XML in the world of business-to-business
(B2B) and business-to-consumer (B2C) commerce.

ICE
Information and Content Exchange

ICE is a protocol for use by content syndicators and their subscribers. It focuses
on “automating content exchange and reuse, both in traditional publishing con-
texts and in business-to-business relationships”.

For more information on ICE, see http://www.w3.org/TR/NOTE-ice.

ebXML
Electronic Business with XML

This standard aims at creating a modular electronic business framework using
XML. It is the product of a joint initiative by the United Nations (UN/CEFACT)
and the Organization for the Advancement of Structured Information Systems
(OASIS).

For more information on ebXML, see http://www.ebxml.org/.

cxml
Commerce XML

cxml is a RosettaNet (www.rosettanet.org) standard for setting up interactive
online catalogs for different buyers, where the pricing and product offerings are
company specific. Includes mechanisms to handle purchase orders, change
orders, status updates, and shipping notifications.

For more information on cxml, see http://www.cxml.org/

CBL
Common Business Library

http://www.w3.org/TR/NOTE-drawml
http://www.w3.org/TR/NOTE-ice
http://www.ebxml.org/
http://www.cxml.org/
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CBL is a library of element and attribute definitions maintained by Com-
merceNet (www.commerce.net).

For more information on CBL and a variety of other initiatives that work
together to enable eCommerce applications, see http://www.com-

merce.net/projects/current-

projects/eco/wg/eCo_Framework_Specifications.html.

UBL
Universal Business Language

An OASIS initiative aimed at compiling a standard library of XML business
documents (purchase orders, invoices, etc.) that are defined with XML Schema
definitions.

For more information on UBL, see http://www.oasis-open.org/commit-

tees/ubl.

Summary
XML is becoming a widely-adopted standard that is being used in a dizzying
variety of application areas.

Generating XML Data
This section also takes you step by step through the process of constructing an
XML document. Along the way, you’ll gain experience with the XML compo-
nents you’ll typically use to create your data structures.

Writing a Simple XML File
You’ll start by writing the kind of XML data you could use for a slide presenta-
tion. In this exercise, you’ll use your text editor to create the data in order to
become comfortable with the basic format of an XML file. You’ll be using this
file and extending it in later exercises.

http://www.commerce.net/projects/currentprojects/eco/wg/eCo_Framework_Specifications.html
http://www.commerce.net/projects/currentprojects/eco/wg/eCo_Framework_Specifications.html
http://www.commerce.net/projects/currentprojects/eco/wg/eCo_Framework_Specifications.html
http://www.oasis-open.org/committees/ubl
http://www.oasis-open.org/committees/ubl
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Creating the File
Using a standard text editor, create a file called slideSample.xml.

Note: Here is a version of it that already exists: slideSample01.xml. (The brows-
able version is slideSample01-xml.html.) You can use this version to compare
your work, or just review it as you read this guide.

Writing the Declaration
Next, write the declaration, which identifies the file as an XML document. The
declaration starts with the characters “<?”, which is the standard XML identifier
for a processing instruction. (You’ll see other processing instructions later on in
this tutorial.)

  <?xml version='1.0' encoding='utf-8'?>

This line identifies the document as an XML document that conforms to version
1.0 of the XML specification, and says that it uses the 8-bit Unicode character-
encoding scheme. (For information on encoding schemes, see Java Encoding
Schemes (page 1163).)

Since the document has not been specified as “standalone”, the parser assumes
that it may contain references to other documents. To see how to specify a docu-
ment as “standalone”, see The XML Prolog (page 27).

Adding a Comment
Comments are ignored by XML parsers. A program will never see them in fact,
unless you activate special settings in the parser. Add the text highlighted below
to put a comment into the file.

<?xml version='1.0' encoding='utf-8'?>

<!-- A SAMPLE set of slides -->

Defining the Root Element
After the declaration, every XML file defines exactly one element, known as the
root element. Any other elements in the file are contained within that element.

../examples/xml/samples/slideSample01.xml
../examples/xml/samples/slideSample01-xml.html
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Enter the text highlighted below to define the root element for this file, slide-
show:

<?xml version='1.0' encoding='utf-8'?>

<!-- A SAMPLE set of slides -->

<slideshow>

</slideshow>

Note: XML element names are case-sensitive. The end-tag must exactly match the
start-tag.

Adding Attributes to an Element
A slide presentation has a number of associated data items, none of which
require any structure. So it is natural to define them as attributes of the slide-

show element. Add the text highlighted below to set up some attributes:

...
<slideshow

title="Sample Slide Show"
date="Date of publication"
author="Yours Truly"
>

</slideshow>

When you create a name for a tag or an attribute, you can use hyphens (“-”),
underscores (“_”), colons (“:”), and periods (“.”) in addition to characters and
numbers. Unlike HTML, values for XML attributes are always in quotation
marks, and multiple attributes are never separated by commas.

Note: Colons should be used with care or avoided altogether, because they are used
when defining the namespace for an XML document.
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Adding Nested Elements
XML allows for hierarchically structured data, which means that an element can
contain other elements. Add the text highlighted below to define a slide element
and a title element contained within it:

<slideshow
...
>

 <!-- TITLE SLIDE -->
<slide type="all">

<title>Wake up to WonderWidgets!</title>
</slide>

</slideshow>

Here you have also added a type attribute to the slide. The idea of this attribute
is that slides could be earmarked for a mostly technical or mostly executive audi-
ence with type="tech" or type="exec", or identified as suitable for both with
type="all".

More importantly, though, this example illustrates the difference between things
that are more usefully defined as elements (the title element) and things that
are more suitable as attributes (the type attribute). The visibility heuristic is pri-
marily at work here. The title is something the audience will see. So it is an ele-
ment. The type, on the other hand, is something that never gets presented, so it is
an attribute. Another way to think about that distinction is that an element is a
container, like a bottle. The type is a characteristic of the container (is it tall or
short, wide or narrow). The title is a characteristic of the contents (water, milk, or
tea). These are not hard and fast rules, of course, but they can help when you
design your own XML structures.

Adding HTML-Style Text
Since XML lets you define any tags you want, it makes sense to define a set of
tags that look like HTML. The XHTML standard does exactly that, in fact.
You’ll see more about that towards the end of the SAX tutorial. For now, type the
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text highlighted below to define a slide with a couple of list item entries that use
an HTML-style <em> tag for emphasis (usually rendered as italicized text):

...
<!-- TITLE SLIDE -->
<slide type="all">

<title>Wake up to WonderWidgets!</title>
</slide>

<!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
<item>Why <em>WonderWidgets</em> are great</item>
<item>Who <em>buys</em> WonderWidgets</item>

</slide>

</slideshow>

Note that defining a title element conflicts with the XHTML element that uses
the same name. We’ll discuss the mechanism that produces the conflict (the
DTD), along with possible solutions, later on in this tutorial.

Adding an Empty Element
One major difference between HTML and XML, though, is that all XML must
be well-formed — which means that every tag must have an ending tag or be an
empty tag. You’re getting pretty comfortable with ending tags, by now. Add the
text highlighted below to define an empty list item element with no contents:

...
<!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
<item>Why <em>WonderWidgets</em> are great</item>
<item/>
<item>Who <em>buys</em> WonderWidgets</item>

</slide>

</slideshow>

Note that any element can be empty element. All it takes is ending the tag with
“/>” instead of “>”. You could do the same thing by entering <item></item>,
which is equivalent.
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Note: Another factor that makes an XML file well-formed is proper nesting. So
<b><i>some_text</i></b> is well-formed, because the <i>...</i> sequence is
completely nested within the <b>..</b> tag. This sequence, on the other hand, is
not well-formed: <b><i>some_text</b></i>.

The Finished Product
Here is the completed version of the XML file:

<?xml version='1.0' encoding='utf-8'?>

<!--  A SAMPLE set of slides  -->

<slideshow
title="Sample Slide Show"
date="Date of publication"
author="Yours Truly"
>

<!-- TITLE SLIDE -->
<slide type="all">

<title>Wake up to WonderWidgets!</title>
</slide>

<!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
<item>Why <em>WonderWidgets</em> are great</item>
<item/>
<item>Who <em>buys</em> WonderWidgets</item>

</slide
</slideshow>

Save a copy of this file as slideSample01.xml, so you can use it as the initial
data structure when experimenting with XML programming operations.

Writing Processing Instructions
It sometimes makes sense to code application-specific processing instructions in
the XML data. In this exercise, you’ll add a processing instruction to your
slideSample.xml file.
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Note: The file you’ll create in this section is slideSample02.xml. (The browsable
version is slideSample02-xml.html.)

As you saw in Processing Instructions (page 28), the format for a processing
instruction is <?target data?>, where “target” is the target application that is
expected to do the processing, and “data” is the instruction or information for it
to process. Add the text highlighted below to add a processing instruction for a
mythical slide presentation program that will query the user to find out which
slides to display (technical, executive-level, or all):

<slideshow
...
>

<!-- PROCESSING INSTRUCTION -->
<?my.presentation.Program QUERY="exec, tech, all"?>

<!-- TITLE SLIDE -->

Notes:

• The “data” portion of the processing instruction can contain spaces, or may
even be null. But there cannot be any space between the initial <? and the
target identifier.

• The data begins after the first space.

• Fully qualifying the target with the complete Web-unique package prefix
makes sense, so as to preclude any conflict with other programs that might
process the same data.

• For readability, it seems like a good idea to include a colon (:) after the
name of the application, like this:

<?my.presentation.Program: QUERY="..."?>

The colon makes the target name into a kind of “label” that identifies the
intended recipient of the instruction. However, while the w3c spec allows “:”
in a target name, some versions of IE5 consider it an error. For this tutorial,
then, we avoid using a colon in the target name.

Save a copy of this file as slideSample02.xml, so you can use it when experi-
menting with processing instructions.

../examples/xml/samples/slideSample02.xml
../examples/xml/samples/slideSample02-xml.html
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Introducing an Error
The parser can generate one of three kinds of errors: fatal error, error, and warn-
ing. In this exercise, you’ll make a simple modification to the XML file to intro-
duce a fatal error. Then you’ll see how it’s handled in the Echo app.

Note: The XML structure you’ll create in this exercise is in slideSampleBad1.xml.
(The browsable version is slideSampleBad1-xml.html.)

One easy way to introduce a fatal error is to remove the final “/” from the empty
item element to create a tag that does not have a corresponding end tag. That
constitutes a fatal error, because all XML documents must, by definition, be well
formed. Do the following:

1. Copy slideSample02.xml to slideSampleBad1.xml.

2. Edit slideSampleBad1.xml and remove the character shown below:

...
<!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
<item>Why <em>WonderWidgets</em> are great</item>
<item/>
<item>Who <em>buys</em> WonderWidgets</item>

</slide>
...

to produce:

...
<item>Why <em>WonderWidgets</em> are great</item>
<item>
<item>Who <em>buys</em> WonderWidgets</item>
...

Now you have a file that you can use to generate an error in any
parser, any time. (XML parsers are required to generate a fatal
error for this file, because the lack of an end-tag for the
<item> element means that the XML structure is no longer well-
formed.)

../examples/xml/samples/slideSampleBad1.xml
../examples/xml/samples/slideSampleBad1-xml.html
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Substituting and Inserting Text
In this section, you’ll learn about:

• Handling Special Characters (“<“, “&”, and so on)

• Handling Text with XML-style syntax

Handling Special Characters
In XML, an entity is an XML structure (or plain text) that has a name. Referenc-
ing the entity by name causes it to be inserted into the document in place of the
entity reference. To create an entity reference, the entity name is surrounded by
an ampersand and a semicolon, like this:

  &entityName;

Later, when you learn how to write a DTD, you’ll see that you can define your
own entities, so that &yourEntityName; expands to all the text you defined for
that entity. For now, though, we’ll focus on the predefined entities and character
references that don’t require any special definitions.

Predefined Entities
An entity reference like &amp; contains a name (in this case, “amp”) between the
start and end delimiters. The text it refers to (&) is substituted for the name, like
a macro in a programming language. Table 2–1 shows the predefined entities for
special characters.

Table 2–1 Predefined Entities

 Character Reference

 & &amp;

 < &lt;

 > &gt;

 " &quot;

 ' &apos;
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Character References
A character reference like &#147; contains a hash mark (#) followed by a num-
ber. The number is the Unicode value for a single character, such as 65 for the
letter “A”, 147 for the left-curly quote, or 148 for the right-curly quote. In this
case, the “name” of the entity is the hash mark followed by the digits that iden-
tify the character.

Note: XML expects values to be specified in decimal. However, the Unicode charts
at http://www.unicode.org/charts/ specify values in hexadecimal! So you’ll need to
do a conversion to get the right value to insert into your XML data set.

Using an Entity Reference in an XML
Document
Suppose you wanted to insert a line like this in your XML document:

 Market Size < predicted

The problem with putting that line into an XML file directly is that when the
parser sees the left-angle bracket (<), it starts looking for a tag name, which
throws off the parse. To get around that problem, you put &lt; in the file, instead
of “<”.

Note: The results of the modifications below are contained in slideSample03.xml.

http://www.unicode.org/charts/
../examples/xml/samples/slideSample03.xml
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Add the text highlighted below to your slideSample.xml file, and save a copy
of it for future use as slideSample03.xml:

<!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
...

</slide>

<slide type="exec">
<title>Financial Forecast</title>
<item>Market Size &lt; predicted</item>
<item>Anticipated Penetration</item>
<item>Expected Revenues</item>
<item>Profit Margin </item>

</slide>

</slideshow>

When you use an XML parser to echo this data, you will see the desired output:

Market Size < predicted

You see an angle bracket (“<“) where you coded “&lt;”, because the XML parser
converts the reference into the entity it represents, and passes that entity to the
application.

Handling Text with XML-Style Syntax
When you are handling large blocks of XML or HTML that include many of the
special characters, it would be inconvenient to replace each of them with the
appropriate entity reference. For those situations, you can use a CDATA section.

Note: The results of the modifications below are contained in slideSample04.xml.

A CDATA section works like <pre>...</pre> in HTML, only more so—all
whitespace in a CDATA section is significant, and characters in it are not inter-
preted as XML. A CDATA section starts with <![CDATA[ and ends with ]]>.

../examples/xml/samples/slideSample04.xml
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Add the text highlighted below to your slideSample.xml file to define a CDATA

section for a fictitious technical slide, and save a copy of the file as
slideSample04.xml:

 ...
<slide type="tech">

<title>How it Works</title>
<item>First we fozzle the frobmorten</item>
<item>Then we framboze the staten</item>
<item>Finally, we frenzle the fuznaten</item>
<item><![CDATA[Diagram:

frobmorten <--------------- fuznaten
|  <3>^
| <1>| <1> = fozzle
V | <2> = framboze
Staten--------------------+<3> = frenzle

 <2>
]]></item>

</slide>
</slideshow>

When you echo this file with an XML parser, you’ll see the following output:

Diagram:
frobmorten <--------------fuznaten

| <3> ^
 | <1> |   <1> = fozzle
V |   <2> = framboze

staten----------------------+   <3> = frenzle
<2>

The point here is that the text in the CDATA section will have arrived as it was
written. Since the parser doesn’t treat the angle brackets as XML, they don’t
generate the fatal errors they would otherwise cause. (Because, if the angle
brackets weren’t in a CDATA section, the document would not be well-formed.)

Creating a Document Type Definition
After the XML declaration, the document prolog can include a DTD, which lets
you specify the kinds of tags that can be included in your XML document. In
addition to telling a validating parser which tags are valid, and in what arrange-
ments, a DTD tells both validating and nonvalidating parsers where text is
expected, which lets the parser determine whether the whitespace it sees is sig-
nificant or ignorable.
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Basic DTD Definitions
To begin learning about DTD definitions, let’s start by telling the parser where
text is expected and where any text (other than whitespace) would be an error.
(Whitespace in such locations is ignorable.)

Note: The DTD defined in this section is contained in slideshow1a.dtd. (The
browsable version is slideshow1a-dtd.html.)

Start by creating a file named slideshow.dtd. Enter an XML declaration and a
comment to identify the file, as shown below:

<?xml version='1.0' encoding='utf-8'?>

<!--
DTD for a simple "slide show".

-->

Next, add the text highlighted below to specify that a slideshow element con-
tains slide elements and nothing else:

<!-- DTD for a simple "slide show". -->

<!ELEMENT slideshow (slide+)>

As you can see, the DTD tag starts with <! followed by the tag name (ELEMENT).
After the tag name comes the name of the element that is being defined (slide-
show) and, in parentheses, one or more items that indicate the valid contents for
that element. In this case, the notation says that a slideshow consists of one or
more slide elements.

Without the plus sign, the definition would be saying that a slideshow consists
of a single slide element. The qualifiers you can add to an element definition
are listed in Table 2–2.

Table 2–2 DTD Element Qualifiers

 Qualifier Name Meaning

? Question Mark Optional (zero or one)

../examples/xml/samples/slideshow1a.dtd
../examples/xml/samples/slideshow1a-dtd.html
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You can include multiple elements inside the parentheses in a comma separated
list, and use a qualifier on each element to indicate how many instances of that
element may occur. The comma-separated list tells which elements are valid and
the order they can occur in.

You can also nest parentheses to group multiple items. For an example, after
defining an image element (coming up shortly), you could declare that every
image element must be paired with a title element in a slide by specifying
((image, title)+). Here, the plus sign applies to the image/title pair to
indicate that one or more pairs of the specified items can occur.

Defining Text and Nested Elements
Now that you have told the parser something about where not to expect text, let’s
see how to tell it where text can occur. Add the text highlighted below to define
the slide, title, item, and list elements:

<!ELEMENT slideshow (slide+)>
<!ELEMENT slide (title, item*)>
<!ELEMENT title (#PCDATA)>
<!ELEMENT item (#PCDATA | item)* >

The first line you added says that a slide consists of a title followed by zero or
more item elements. Nothing new there. The next line says that a title consists
entirely of parsed character data (PCDATA). That’s known as “text” in most parts
of the country, but in XML-speak it’s called “parsed character data”. (That dis-
tinguishes it from CDATA sections, which contain character data that is not
parsed.) The “#” that precedes PCDATA indicates that what follows is a special
word, rather than an element name.

The last line introduces the vertical bar (|), which indicates an or condition. In
this case, either PCDATA or an item can occur. The asterisk at the end says that
either one can occur zero or more times in succession. The result of this specifi-
cation is known as a mixed-content model, because any number of item elements

 * Asterisk Zero or more

+ Plus Sign One or more

Table 2–2 DTD Element Qualifiers (Continued)

 Qualifier Name Meaning
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can be interspersed with the text. Such models must always be defined with
#PCDATA specified first, some number of alternate items divided by vertical bars
(|), and an asterisk (*) at the end.

Save a copy of this DTD as slideSample1a.dtd, for use when experimenting with
basic DTD processing.

Limitations of DTDs
It would be nice if we could specify that an item contains either text, or text fol-
lowed by one or more list items. But that kind of specification turns out to be
hard to achieve in a DTD. For example, you might be tempted to define an item

like this:

<!ELEMENT item (#PCDATA | (#PCDATA, item+)) >

That would certainly be accurate, but as soon as the parser sees #PCDATA and
the vertical bar, it requires the remaining definition to conform to the mixed-con-
tent model. This specification doesn’t, so you get can error that says: Illegal
mixed content model for 'item'. Found &#x28; ..., where the hex char-
acter 28 is the angle bracket the ends the definition.

Trying to double-define the item element doesn’t work, either. A specification
like this:

<!ELEMENT item (#PCDATA) >
<!ELEMENT item (#PCDATA, item+) >

produces a “duplicate definition” warning when the validating parser runs. The
second definition is, in fact, ignored. So it seems that defining a mixed content
model (which allows item elements to be interspersed in text) is about as good
as we can do.

In addition to the limitations of the mixed content model mentioned above, there
is no way to further qualify the kind of text that can occur where PCDATA has
been specified. Should it contain only numbers? Should be in a date format, or
possibly a monetary format? There is no way to say in the context of a DTD.

Finally, note that the DTD offers no sense of hierarchy. The definition for the
title element applies equally to a slide title and to an item title. When we
expand the DTD to allow HTML-style markup in addition to plain text, it would
make sense to restrict the size of an item title compared to a slide title, for
example. But the only way to do that would be to give one of them a different
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name, such as “item-title”. The bottom line is that the lack of hierarchy in the
DTD forces you to introduce a “hyphenation hierarchy” (or its equivalent) in
your namespace. All of these limitations are fundamental motivations behind the
development of schema-specification standards.

Special Element Values in the DTD
Rather than specifying a parenthesized list of elements, the element definition
could use one of two special values: ANY or EMPTY. The ANY specification says
that the element may contain any other defined element, or PCDATA. Such a spec-
ification is usually used for the root element of a general-purpose XML docu-
ment such as you might create with a word processor. Textual elements could
occur in any order in such a document, so specifying ANY makes sense.

The EMPTY specification says that the element contains no contents. So the DTD
for e-mail messages that let you “flag” the message with <flag/> might have a
line like this in the DTD:

<!ELEMENT flag EMPTY>

Referencing the DTD
In this case, the DTD definition is in a separate file from the XML document.
That means you have to reference it from the XML document, which makes the
DTD file part of the external subset of the full Document Type Definition (DTD)
for the XML file. As you’ll see later on, you can also include parts of the DTD
within the document. Such definitions constitute the local subset of the DTD.

Note: The XML written in this section is contained in slideSample05.xml. (The
browsable version is slideSample05-xml.html.)

To reference the DTD file you just created, add the line highlighted below to
your slideSample.xml file, and save a copy of the file as slideSample05.xml:

<!--  A SAMPLE set of slides  -->

<!DOCTYPE slideshow SYSTEM "slideshow.dtd">

<slideshow

../examples/xml/samples/slideSample05.xml
../examples/xml/samples/slideSample05-xml.html


DOCUMENTS AND DATA 61
Again, the DTD tag starts with “<!”. In this case, the tag name, DOCTYPE, says
that the document is a slideshow, which means that the document consists of
the slideshow element and everything within it:

<slideshow>
...
</slideshow>

This tag defines the slideshow element as the root element for the document.
An XML document must have exactly one root element. This is where that ele-
ment is specified. In other words, this tag identifies the document content as a
slideshow.

The DOCTYPE tag occurs after the XML declaration and before the root element.
The SYSTEM identifier specifies the location of the DTD file. Since it does not
start with a prefix like http:/ or file:/, the path is relative to the location of
the XML document. Remember the setDocumentLocator method? The parser
is using that information to find the DTD file, just as your application would to
find a file relative to the XML document. A PUBLIC identifier could also be used
to specify the DTD file using a unique name—but the parser would have to be
able to resolve it

The DOCTYPE specification could also contain DTD definitions within the XML
document, rather than referring to an external DTD file. Such definitions would
be contained in square brackets, like this:

<!DOCTYPE slideshow SYSTEM "slideshow1.dtd" [
...local subset definitions here...

]>

You’ll take advantage of that facility in a moment to define some entities that can
be used in the document.

Documents and Data
Earlier, you learned that one reason you hear about XML documents, on the one
hand, and XML data, on the other, is that XML handles both comfortably,
depending on whether text is or is not allowed between elements in the structure.

In the sample file you have been working with, the slideshow element is an
example of a data element—it contains only subelements with no intervening
text. The item element, on the other hand, might be termed a document element,
because it is defined to include both text and subelements.
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As you work through this tutorial, you will see how to expand the definition of
the title element to include HTML-style markup, which will turn it into a docu-
ment element as well.

Defining Attributes and Entities in the DTD
The DTD you’ve defined so far is fine for use with the nonvalidating parser. It
tells where text is expected and where it isn’t, which is all the nonvalidating
parser is going to pay attention to. But for use with the validating parser, the
DTD needs to specify the valid attributes for the different elements. You’ll do
that in this section, after which you’ll define one internal entity and one external
entity that you can reference in your XML file.

Defining Attributes in the DTD
Let’s start by defining the attributes for the elements in the slide presentation.

Note: The XML written in this section is contained in slideshow1b.dtd. (The
browsable version is slideshow1b-dtd.html.)

Add the text highlighted below to define the attributes for the slideshow ele-
ment:

<!ELEMENT slideshow (slide+)>
<!ATTLIST slideshow

title    CDATA    #REQUIRED
date     CDATA    #IMPLIED
author   CDATA    "unknown"

>
<!ELEMENT slide (title, item*)>

The DTD tag ATTLIST begins the series of attribute definitions. The name that
follows ATTLIST specifies the element for which the attributes are being defined.
In this case, the element is the slideshow element. (Note once again the lack of
hierarchy in DTD specifications.)

Each attribute is defined by a series of three space-separated values. Commas
and other separators are not allowed, so formatting the definitions as shown
above is helpful for readability. The first element in each line is the name of the
attribute: title, date, or author, in this case. The second element indicates the

../examples/xml/samples/slideshow1b.dtd
../examples/xml/samples/slideshow1b-dtd.html
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type of the data: CDATA is character data—unparsed data, once again, in which a
left-angle bracket (<) will never be construed as part of an XML tag. Table 2–3
presents the valid choices for the attribute type.

*This is a rapidly obsolescing specification which will be discussed in greater
length towards the end of this section.

When the attribute type consists of a parenthesized list of choices separated by
vertical bars, the attribute must use one of the specified values. For an example,
add the text highlighted below to the DTD:

<!ELEMENT slide (title, item*)>
<!ATTLIST slide

type   (tech | exec | all) #IMPLIED
>
<!ELEMENT title (#PCDATA)>
<!ELEMENT item (#PCDATA | item)* >

Table 2–3 Attribute Types

 Attribute Type Specifies...

(value1 | value2 | ...) A list of values separated by vertical bars. (Example below)

CDATA “Unparsed character data”. (For normal people, a text string.)

ID A name that no other ID attribute shares.

IDREF A reference to an ID defined elsewhere in the document.

IDREFS A space-separated list containing one or more ID references.

ENTITY The name of an entity defined in the DTD.

ENTITIES A space-separated list of entities.

NMTOKEN
A valid XML name composed of letters, numbers, hyphens,
underscores, and colons.

NMTOKENS A space-separated list of names.

NOTATION
The name of a DTD-specified notation, which describes a
non-XML data format, such as those used for image files.*



64 UNDERSTANDING XML
This specification says that the slide element’s type attribute must be given as
type="tech", type="exec", or type="all". No other values are acceptable.
(DTD-aware XML editors can use such specifications to present a pop-up list of
choices.)

The last entry in the attribute specification determines the attributes default
value, if any, and tells whether or not the attribute is required. Table 2–4 shows
the possible choices.

Finally, save a copy of the DTD as slideshow1b.dtd, for use when experiment-
ing with attribute definitions.

Defining Entities in the DTD
So far, you’ve seen predefined entities like &amp; and you’ve seen that an
attribute can reference an entity. It’s time now for you to learn how to define enti-
ties of your own.

Note: The XML you’ll create here is contained in slideSample06.xml. (The
browsable version is slideSample06-xml.html.)

Table 2–4 Attribute-Specification Parameters

    Specification Specifies...

 #REQUIRED The attribute value must be specified in the document.

 #IMPLIED
The value need not be specified in the document. If it isn’t, the
application will have a default value it uses.

 “defaultValue”
The default value to use, if a value is not specified in the docu-
ment.

#FIXED “fixedValue”
The value to use. If the document specifies any value at all, it
must be the same.

../examples/xml/samples/slideSample06.xml
../examples/xml/samples/slideSample06-xml.html
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Add the text highlighted below to the DOCTYPE tag in your XML file:

<!DOCTYPE slideshow SYSTEM "slideshow.dtd" [
<!ENTITY product  "WonderWidget">
<!ENTITY products "WonderWidgets">

]>

The ENTITY tag name says that you are defining an entity. Next comes the name
of the entity and its definition. In this case, you are defining an entity named
“product” that will take the place of the product name. Later when the product
name changes (as it most certainly will), you will only have to change the name
one place, and all your slides will reflect the new value.

The last part is the substitution string that replaces the entity name whenever it is
referenced in the XML document. The substitution string is defined in quotes,
which are not included when the text is inserted into the document.

Just for good measure, we defined two versions, one singular and one plural, so
that when the marketing mavens come up with “Wally” for a product name, you
will be prepared to enter the plural as “Wallies” and have it substituted correctly.

Note: Truth be told, this is the kind of thing that really belongs in an external DTD.
That way, all your documents can reference the new name when it changes. But,
hey, this is an example...

Now that you have the entities defined, the next step is to reference them in the
slide show. Make the changes highlighted below to do that:

<slideshow
title="WonderWidget&product; Slide Show"
...

<!-- TITLE SLIDE -->
<slide type="all">

<title>Wake up to WonderWidgets&products;!</title>
</slide>

 <!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
<item>Why <em>WonderWidgets&products;</em> are
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great</item>
<item/>
<item>Who <em>buys</em> WonderWidgets&products;</item>

</slide>

The points to notice here are that entities you define are referenced with the same
syntax (&entityName;) that you use for predefined entities, and that the entity
can be referenced in an attribute value as well as in an element’s contents.

When you echo this version of the file with an XML parser, here is the kind of
thing you’ll see:

Wake up to WonderWidgets!

Note that the product name has been substituted for the entity reference.

To finish, save a copy of the file as slideSample06.xml.

Additional Useful Entities
Here are several other examples for entity definitions that you might find useful
when you write an XML document:

<!ENTITY ldquo  "&#147;"> <!-- Left Double Quote -->
<!ENTITY rdquo  "&#148;"> <!-- Right Double Quote -->
<!ENTITY trade  "&#153;"> <!-- Trademark Symbol (TM) -->
<!ENTITY rtrade "&#174;"> <!-- Registered Trademark (R) -->
<!ENTITY copyr  "&#169;"> <!-- Copyright Symbol -->

Referencing External Entities
You can also use the SYSTEM or PUBLIC identifier to name an entity that is defined
in an external file. You’ll do that now.

Note: The XML defined here is contained in slideSample07.xml and in copy-

right.xml. (The browsable versions are slideSample07-xml.html and copy-

right-xml.html.)

../examples/xml/samples/slideSample07.xml
../examples/xml/samples/copyright.xml
../examples/xml/samples/copyright.xml
../examples/xml/samples/slideSample07-xml.html
../examples/xml/samples/copyright-xml.html
../examples/xml/samples/copyright-xml.html
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To reference an external entity, add the text highlighted below to the DOCTYPE

statement in your XML file:

<!DOCTYPE slideshow SYSTEM "slideshow.dtd" [
<!ENTITY product  "WonderWidget">
<!ENTITY products "WonderWidgets">
<!ENTITY copyright SYSTEM "copyright.xml">

]>

This definition references a copyright message contained in a file named copy-

right.xml. Create that file and put some interesting text in it, perhaps something
like this:

  <!--  A SAMPLE copyright  -->

This is the standard copyright message that our lawyers
make us put everywhere so we don't have to shell out a
million bucks every time someone spills hot coffee in their
lap...

Finally, add the text highlighted below to your slideSample.xml file to refer-
ence the external entity, and save a copy of the file as slideSample07.html:

<!-- TITLE SLIDE -->
...

</slide>

<!-- COPYRIGHT SLIDE -->
<slide type="all">

<item>&copyright;</item>
</slide>

You could also use an external entity declaration to access a servlet that produces
the current date using a definition something like this:

<!ENTITY currentDate SYSTEM
"http://www.example.com/servlet/CurrentDate?fmt=dd-MMM-

yyyy">

You would then reference that entity the same as any other entity:

  Today's date is &currentDate;.
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When you echo the latest version of the slide presentation with an XML parser,
here is what you’ll see:

...
<slide type="all">

<item>
This is the standard copyright message that our lawyers
make us put everywhere so we don't have to shell out a
million bucks every time someone spills hot coffee in their
lap...

</item>
</slide>
...

You’ll notice that the newline which follows the comment in the file is echoed as
a character, but that the comment itself is ignored. That is the reason that the
copyright message appears to start on the next line after the <item> element,
instead of on the same line—the first character echoed is actually the newline
that follows the comment.

Summarizing Entities
An entity that is referenced in the document content, whether internal or exter-
nal, is termed a general entity. An entity that contains DTD specifications that
are referenced from within the DTD is termed a parameter entity. (More on that
later.)

An entity which contains XML (text and markup), and which is therefore parsed,
is known as a parsed entity. An entity which contains binary data (like images) is
known as an unparsed entity. (By its very nature, it must be external.) We’ll be
discussing references to unparsed entities in the next section of this tutorial.

Referencing Binary Entities
This section discusses the options for referencing binary files like image files
and multimedia data files.

Using a MIME Data Type
There are two ways to go about referencing an unparsed entity like a binary
image file. One is to use the DTD’s NOTATION-specification mechanism. How-
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ever, that mechanism is a complex, non-intuitive holdover that mostly exists for
compatibility with SGML documents. We will have occasion to discuss it in a bit
more depth when we look at the DTDHandler API, but suffice it for now to say
that the combination of the recently defined XML namespaces standard, in con-
junction with the MIME data types defined for electronic messaging attach-
ments, together provide a much more useful, understandable, and extensible
mechanism for referencing unparsed external entities.

Note: The XML described here is in slideshow1b.dtd. It shows how binary refer-
ences can be made, assuming that the application which will be processing the
XML data knows how to handle such references.

To set up the slideshow to use image files, add the text highlighted below to your
slideshow1b.dtd file:

<!ELEMENT slide (image?, title, item*)>
<!ATTLIST slide

type   (tech | exec | all) #IMPLIED
>
<!ELEMENT title (#PCDATA)>
<!ELEMENT item (#PCDATA | item)* >
<!ELEMENT image EMPTY>
<!ATTLIST image

alt    CDATA    #IMPLIED
src    CDATA    #REQUIRED
type   CDATA    "image/gif"

>

These modifications declare image as an optional element in a slide, define it as
empty element, and define the attributes it requires. The image tag is patterned
after the HTML 4.0 tag, img, with the addition of an image-type specifier, type.
(The img tag is defined in the HTML 4.0 Specification.)

The image tag’s attributes are defined by the ATTLIST entry. The alt attribute,
which defines alternate text to display in case the image can’t be found, accepts
character data (CDATA). It has an “implied” value, which means that it is optional,
and that the program processing the data knows enough to substitute something
like “Image not found”. On the other hand, the src attribute, which names the
image to display, is required.

The type attribute is intended for the specification of a MIME data type, as
defined at http://www.iana.org/assignments/media-types/. It has a default
value: image/gif.

http://www.iana.org/assignments/media-types
../examples/xml/samples/slideshow1b.dtd
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Note: It is understood here that the character data (CDATA) used for the type attribute
will be one of the MIME data types. The two most common formats are:
image/gif, and image/jpeg. Given that fact, it might be nice to specify an attribute
list here, using something like:

type ("image/gif", "image/jpeg")

That won’t work, however, because attribute lists are restricted to name tokens. The
forward slash isn’t part of the valid set of name-token characters, so this declaration
fails. Besides that, creating an attribute list in the DTD would limit the valid MIME
types to those defined today. Leaving it as CDATA leaves things more open ended,
so that the declaration will continue to be valid as additional types are defined.

In the document, a reference to an image named “intro-pic” might look some-
thing like this:

<image src="image/intro-pic.gif", alt="Intro Pic",
type="image/gif" />

The Alternative: Using Entity References
Using a MIME data type as an attribute of an element is a mechanism that is
flexible and expandable. To create an external ENTITY reference using the nota-
tion mechanism, you need DTD NOTATION elements for jpeg and gif data. Those
can of course be obtained from some central repository. But then you need to
define a different ENTITY element for each image you intend to reference! In
other words, adding a new image to your document always requires both a new
entity definition in the DTD and a reference to it in the document. Given the
anticipated ubiquity of the HTML 4.0 specification, the newer standard is to use
the MIME data types and a declaration like image, which assumes the applica-
tion knows how to process such elements.

Defining Parameter Entities and
Conditional Sections
Just as a general entity lets you reuse XML data in multiple places, a parameter
entity lets you reuse parts of a DTD in multiple places. In this section of the tuto-
rial, you’ll see how to define and use parameter entities. You’ll also see how to
use parameter entities with conditional sections in a DTD.
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Creating and Referencing a Parameter Entity
Recall that the existing version of the slide presentation could not be validated
because the document used <em> tags, and those are not part of the DTD. In gen-
eral, we’d like to use a whole variety of HTML-style tags in the text of a slide,
not just one or two, so it makes more sense to use an existing DTD for XHTML
than it does to define all the tags we might ever need. A parameter entity is
intended for exactly that kind of purpose.

Note: The DTD specifications shown here are contained in slideshow2.dtd and
xhtml.dtd. The XML file that references it is slideSample08.xml. (The browsable
versions are slideshow2-dtd.html and slideSample08-xml.html.)

Open your DTD file for the slide presentation and add the text highlighted below
to define a parameter entity that references an external DTD file:

<!ELEMENT slide (image?, title?, item*)>
<!ATTLIST slide

...
>

<!ENTITY % xhtml SYSTEM "xhtml.dtd">
%xhtml;

<!ELEMENT title ...

Here, you used an <!ENTITY> tag to define a parameter entity, just as for a gen-
eral entity, but using a somewhat different syntax. You included a percent sign
(%) before the entity name when you defined the entity, and you used the percent
sign instead of an ampersand when you referenced it.

Also, note that there are always two steps for using a parameter entity. The first
is to define the entity name. The second is to reference the entity name, which
actually does the work of including the external definitions in the current DTD.
Since the URI for an external entity could contain slashes (/) or other characters
that are not valid in an XML name, the definition step allows a valid XML name
to be associated with an actual document. (This same technique is used in the
definition of namespaces, and anywhere else that XML constructs need to refer-
ence external documents.)

../examples/xml/samples/slideshow2.dtd
../examples/xml/samples/xhtml.dtd 
../examples/xml/samples/xhtml.dtd 
../examples/xml/samples/slideSample08.xml
../examples/xml/samples/slideshow2-dtd.html
../examples/xml/samples/slideSample08-xml.html
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Notes:

• The DTD file referenced by this definition is xhtml.dtd. You can either
copy that file to your system or modify the SYSTEM identifier in the
<!ENTITY> tag to point to the correct URL.

• This file is a small subset of the XHTML specification, loosely modeled
after the Modularized XHTML draft, which aims at breaking up the DTD
for XHTML into bite-sized chunks, which can then be combined to create
different XHTML subsets for different purposes. When work on the mod-
ularized XHTML draft has been completed, this version of the DTD
should be replaced with something better. For now, this version will suffice
for our purposes.

The whole point of using an XHTML-based DTD was to gain access to an entity
it defines that covers HTML-style tags like <em> and <b>. Looking through
xhtml.dtd reveals the following entity, which does exactly what we want:

  <!ENTITY % inline "#PCDATA|em|b|a|img|br">

This entity is a simpler version of those defined in the Modularized XHTML
draft. It defines the HTML-style tags we are most likely to want to use -- empha-
sis, bold, and break, plus a couple of others for images and anchors that we may
or may not use in a slide presentation. To use the inline entity, make the
changes highlighted below in your DTD file:

<!ELEMENT title (#PCDATA %inline;)*>
<!ELEMENT item (#PCDATA %inline; | item)* >

These changes replaced the simple #PCDATA item with the inline entity. It is
important to notice that #PCDATA is first in the inline entity, and that inline is
first wherever we use it. That is required by XML’s definition of a mixed-content
model. To be in accord with that model, you also had to add an asterisk at the
end of the title definition.

Save the DTD as slideshow2.dtd, for use when experimenting with parameter
entities.

Note: The Modularized XHTML DTD defines both inline and Inline entities,
and does so somewhat differently. Rather than specifying #PCDATA|em|b|a|img|Br,
their definitions are more like (#PCDATA|em|b|a|img|Br)*. Using one of those def-
initions, therefore, looks more like this:

../examples/xml/samples/xhtml.dtd 
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<!ELEMENT title %Inline; >

Conditional Sections
Before we proceed with the next programming exercise, it is worth mentioning
the use of parameter entities to control conditional sections. Although you can-
not conditionalize the content of an XML document, you can define conditional
sections in a DTD that become part of the DTD only if you specify include. If
you specify ignore, on the other hand, then the conditional section is not
included.

Suppose, for example, that you wanted to use slightly different versions of a
DTD, depending on whether you were treating the document as an XML docu-
ment or as a SGML document. You could do that with DTD definitions like the
following:

someExternal.dtd:
<![ INCLUDE [

... XML-only definitions
]]>
<![ IGNORE [

... SGML-only definitions
]]>
... common definitions

The conditional sections are introduced by “<![”, followed by the INCLUDE or
IGNORE keyword and another “[”. After that comes the contents of the condi-
tional section, followed by the terminator: “]]>”. In this case, the XML defini-
tions are included, and the SGML definitions are excluded. That’s fine for XML
documents, but you can’t use the DTD for SGML documents. You could change
the keywords, of course, but that only reverses the problem.

The solution is to use references to parameter entities in place of the INCLUDE

and IGNORE keywords:

someExternal.dtd:
<![ %XML; [

... XML-only definitions
]]>
<![ %SGML; [

... SGML-only definitions
]]>
... common definitions
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Then each document that uses the DTD can set up the appropriate entity defini-
tions:

<!DOCTYPE foo SYSTEM "someExternal.dtd" [
<!ENTITY % XML  "INCLUDE" >
<!ENTITY % SGML "IGNORE" >

]>
<foo>

...
</foo>

This procedure puts each document in control of the DTD. It also replaces the
INCLUDE and IGNORE keywords with variable names that more accurately reflect
the purpose of the conditional section, producing a more readable, self-docu-
menting version of the DTD.

Resolving A Naming Conflict
The XML structures you have created thus far have actually encountered a small
naming conflict. It seems that xhtml.dtd defines a title element which is
entirely different from the title element defined in the slideshow DTD.
Because there is no hierarchy in the DTD, these two definitions conflict.

Note: The Modularized XHTML DTD also defines a title element that is intended
to be the document title, so we can’t avoid the conflict by changing xhtml.dtd—
the problem would only come back to haunt us later.

You could use XML namespaces to resolve the conflict. You’ll take a look at that
approach in the next section. Alternatively, you could use one of the more hierar-
chical schema proposals described in Schema Standards (page 38). The simplest
way to solve the problem for now, though, is simply to rename the title ele-
ment in slideshow.dtd.

Note: The XML shown here is contained in slideshow3.dtd and
slideSample09.xml, which references copyright.xml and xhtml.dtd. (The
browsable versions are slideshow3-dtd.html, slideSample09-xml.html, copy-

right-xml.html, and xhtml-dtd.html.)

../examples/xml/samples/copyright-xml.html
../examples/xml/samples/copyright-xml.html
../examples/xml/samples/xhtml.dtd
../examples/xml/samples/slideshow3.dtd
../examples/xml/samples/slidesample09.xml
../examples/xml/samples/slidesample09.xml
../examples/xml/samples/copyright.xml
../examples/xml/samples/xhtml.dtd
../examples/xml/samples/slideshow3-dtd.html
../examples/xml/samples/slideSample09-xml.html
../examples/xml/samples/xhtml-dtd.html
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To keep the two title elements separate, you’ll create a “hyphenation hierarchy”.
Make the changes highlighted below to change the name of the title element in
slideshow.dtd to slide-title:

<!ELEMENT slide (image?, slide-title?, item*)>
<!ATTLIST slide

type   (tech | exec | all) #IMPLIED
>

<!-- Defines the %inline; declaration -->
<!ENTITY % xhtml SYSTEM "xhtml.dtd">
%xhtml;

<!ELEMENT slide-title (%inline;)*>

Save this DTD as slideshow3.dtd.

The next step is to modify the XML file to use the new element name. To do that,
make the changes highlighted below:

...
<slide type="all">
<slide-title>Wake up to ... </slide-title>
</slide>

...

<!-- OVERVIEW -->
<slide type="all">
<slide-title>Overview</slide-title>
<item>...

Save a copy of this file as slideSample09.xml.

Using Namespaces
As you saw earlier, one way or another it is necessary to resolve the conflict
between the title element defined in slideshow.dtd and the one defined in
xhtml.dtd when the same name is used for different purposes. In the previous
exercise, you hyphenated the name in order to put it into a different “name-
space”. In this section, you’ll see how to use the XML namespace standard to do
the same thing without renaming the element.



76 UNDERSTANDING XML
The primary goal of the namespace specification is to let the document author
tell the parser which DTD or schema to use when parsing a given element. The
parser can then consult the appropriate DTD or schema for an element definition.
Of course, it is also important to keep the parser from aborting when a “dupli-
cate” definition is found, and yet still generate an error if the document refer-
ences an element like title without qualifying it (identifying the DTD or
schema to use for the definition).

Note: Namespaces apply to attributes as well as to elements. In this section, we con-
sider only elements. For more information on attributes, consult the namespace
specification at http://www.w3.org/TR/REC-xml-names/.

Defining a Namespace in a DTD
In a DTD, you define a namespace that an element belongs to by adding an
attribute to the element’s definition, where the attribute name is xmlns (“xml
namespace”). For example, you could do that in slideshow.dtd by adding an
entry like the following in the title element’s attribute-list definition:

<!ELEMENT title (%inline;)*>
<!ATTLIST title

xmlns CDATA #FIXED "http://www.example.com/slideshow"
>

Declaring the attribute as FIXED has several important features:

• It prevents the document from specifying any non-matching value for the
xmlns attribute.

• The element defined in this DTD is made unique (because the parser
understands the xmlns attribute), so it does not conflict with an element
that has the same name in another DTD. That allows multiple DTDs to use
the same element name without generating a parser error.

• When a document specifies the xmlns attribute for a tag, the document
selects the element definition with a matching attribute.

To be thorough, every element name in your DTD would get the exact same
attribute, with the same value. (Here, though, we’re only concerned about the
title element.) Note, too, that you are using a CDATA string to supply the URI.
In this case, we’ve specified an URL. But you could also specify a URN, possi-
bly by specifying a prefix like urn: instead of http:. (URNs are currently being

http://www.w3.org/TR/REC-xml/names/
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researched. They’re not seeing a lot of action at the moment, but that could
change in the future.)

Referencing a Namespace
When a document uses an element name that exists in only one of the.DTDs or
schemas it references, the name does not need to be qualified. But when an ele-
ment name that has multiple definitions is used, some sort of qualification is a
necessity.

Note: In point of fact, an element name is always qualified by it’s default name-
space, as defined by name of the DTD file it resides in. As long as there as is only
one definition for the name, the qualification is implicit.

You qualify a reference to an element name by specifying the xmlns attribute, as
shown here:

<title xmlns="http://www.example.com/slideshow">
Overview

</title>

The specified namespace applies to that element, and to any elements contained
within it.

Defining a Namespace Prefix
When you only need one namespace reference, it’s not such a big deal. But when
you need to make the same reference several times, adding xmlns attributes
becomes unwieldy. It also makes it harder to change the name of the namespace
at a later date.

The alternative is to define a namespace prefix, which as simple as specifying
xmlns, a colon (:) and the prefix name before the attribute value, as shown here:

<SL:slideshow xmlns:SL='http:/www.example.com/slideshow'
...>

...
</SL:slideshow>

This definition sets up SL as a prefix that can be used to qualify the current ele-
ment name and any element within it. Since the prefix can be used on any of the
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contained elements, it makes the most sense to define it on the XML document’s
root element, as shown here.

Note: The namespace URI can contain characters which are not valid in an XML
name, so it cannot be used as a prefix directly. The prefix definition associates an
XML name with the URI, which allows the prefix name to be used instead. It also
makes it easier to change references to the URI in the future.

When the prefix is used to qualify an element name, the end-tag also includes the
prefix, as highlighted here:

<SL:slideshow xmlns:SL='http:/www.example.com/slideshow'
...>

...
<slide>
<SL:title>Overview</SL:title>

</slide>
...

</SL:slideshow>

Finally, note that multiple prefixes can be defined in the same element, as shown
here:

<SL:slideshow xmlns:SL='http:/www.example.com/slideshow'
xmlns:xhtml='urn:...'>

...
</SL:slideshow>

With this kind of arrangement, all of the prefix definitions are together in one
place, and you can use them anywhere they are needed in the document. This
example also suggests the use of URN to define the xhtml prefix, instead of an
URL. That definition would conceivably allow the application to reference a
local copy of the XHTML DTD or some mirrored version, with a potentially
beneficial impact on performance.

Designing an XML Data Structure
This section covers some heuristics you can use when making XML design deci-
sions.
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Saving Yourself Some Work
Whenever possible, use an existing schema definition. It’s usually a lot easier to
ignore the things you don’t need than to design your own from scratch. In addi-
tion, using a standard DTD makes data interchange possible, and may make it
possible to use data-aware tools developed by others.

So, if an industry standard exists, consider referencing that DTD with an external
parameter entity. One place to look for industry-standard DTDs is at the web site
created by the Organization for the Advancement of Structured Information
Standards (OASIS). You can find a list of technical committees at
http://www.oasis-open.org/, or check their repository of XML standards at
http://www.XML.org.

Note: Many more good thoughts on the design of XML structures are at the OASIS
page, http://www.oasis-open.org/cover/elementsAndAttrs.html.

Attributes and Elements
One of the issues you will encounter frequently when designing an XML struc-
ture is whether to model a given data item as a subelement or as an attribute of an
existing element. For example, you could model the title of a slide either as:

<slide>
<title>This is the title</title>

</slide>

or as:

<slide title="This is the title">...</slide>

In some cases, the different characteristics of attributes and elements make it
easy to choose. Let’s consider those cases first, and then move on to the cases
where the choice is more ambiguous.

Forced Choices
Sometimes, the choice between an attribute and an element is forced on you by
the nature of attributes and elements. Let’s look at a few of those considerations:

http://www.oasis-open.org/
http://www.XML.org
http://www.oasis-open.org/cover/elementsAndAttrs.html
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The data contains substructures
In this case, the data item must be modeled as an element. It can’t be mod-
eled as an attribute, because attributes take only simple strings. So if the title
can contain emphasized text like this: The <em>Best</em> Choice, then the
title must be an element.

The data contains multiple lines
Here, it also makes sense to use an element. Attributes need to be simple,
short strings or else they become unreadable, if not unusable.

Multiple occurrences are possible
Whenever an item can occur multiple times, like paragraphs in an article, it
must be modeled as an element. The element that contains it can only have
one attribute of a particular kind, but it can have many subelements of the
same type.

The data changes frequently
When the data will be frequently modified with an editor, it may make sense
to model it as an element. Many XML-aware editors make it easy modify
element data, while attributes can be somewhat harder to get to.

The data is a small, simple string that rarely if ever changes
This is data that can be modeled as an attribute. However, just because you
can does not mean that you should. Check the “Stylistic Choices” section
next, to be sure.

Using DTDs when the data is confined to a small number of fixed choices
Here is one time when it really makes sense to use an attribute. A DTD can
prevent an attribute from taking on any value that is not in the preapproved
list, but it cannot similarly restrict an element. (With a schema on the other
hand, both attributes and elements can be restricted.)

Stylistic Choices
As often as not, the choices are not as cut and dried as those shown above. When
the choice is not forced, you need a sense of “style” to guide your thinking. The
question to answer, then, is what makes good XML style, and why.

Defining a sense of style for XML is, unfortunately, as nebulous a business as
defining “style” when it comes to art or music. There are a few ways to approach
it, however. The goal of this section is to give you some useful thoughts on the
subject of “XML style”.
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Visibility
One heuristic for thinking about XML elements and attributes uses the con-
cept of visibility. If the data is intended to be shown—to be displayed to
some end user—then it should be modeled as an element. On the other hand,
if the information guides XML processing but is never seen by a user, then it
may be better to model it as an attribute. For example, in order-entry data for
shoes, shoe size would definitely be an element. On the other hand, a manu-
facturer’s code number would be reasonably modeled as an attribute.

Consumer / Provider
Another way of thinking about the visibility heuristic is to ask who is the
consumer and/or provider of the information. The shoe size is entered by a
human sales clerk, so it’s an element. The manufacturer’s code number for a
given shoe model, on the other hand, may be wired into the application or
stored in a database, so that would be an attribute. (If it were entered by the
clerk, though, it should perhaps be an element.)

Container vs. Contents
Perhaps the best way of thinking about elements and attributes is to think of
an element as a container. To reason by analogy, the contents of the con-
tainer (water or milk) correspond to XML data modeled as elements. Such
data is essentially variable. On the other hand, characteristics of the con-
tainer (blue or white pitcher) can be modeled as attributes. That kind of
information tends to be more immutable. Good XML style will, in some
consistent way, separate each container’s contents from its characteristics.

To show these heuristics at work: In a slideshow the type of the slide (executive
or technical) is best modeled as an attribute. It is a characteristic of the slide that
lets it be selected or rejected for a particular audience. The title of the slide, on
the other hand, is part of its contents. The visibility heuristic is also satisfied
here. When the slide is displayed, the title is shown but the type of the slide isn’t.
Finally, in this example, the consumer of the title information is the presentation
audience, while the consumer of the type information is the presentation pro-
gram.

Normalizing Data
In Saving Yourself Some Work (page 79), you saw that it is a good idea to define
an external entity that you can reference in an XML document. Such an entity
has all the advantages of a modularized routine—changing that one copy affects
every document that references it. The process of eliminating redundancies is
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known as normalizing, so defining entities is one good way to normalize your
data.

In an HTML file, the only way to achieve that kind of modularity is with HTML
links—but of course the document is then fragmented, rather than whole. XML
entities, on the other hand, suffer no such fragmentation. The entity reference
acts like a macro—the entity’s contents are expanded in place, producing a
whole document, rather than a fragmented one. And when the entity is defined in
an external file, multiple documents can reference it.

The considerations for defining an entity reference, then, are pretty much the
same as those you would apply to modularized program code:

• Whenever you find yourself writing the same thing more than once, think
entity. That lets you write it one place and reference it multiple places.

• If the information is likely to change, especially if it is used in more than
one place, definitely think in terms of defining an entity. An example is
defining productName as an entity so that you can easily change the docu-
ments when the product name changes.

• If the entity will never be referenced anywhere except in the current file,
define it in the local_subset of the document’s DTD, much as you would
define a method or inner class in a program.

• If the entity will be referenced from multiple documents, define it as an
external entity, the same way that would define any generally usable class
as an external class.

External entities produce modular XML that is smaller, easier to update and
maintain. They can also make the resulting document somewhat more difficult to
visualize, much as a good OO design can be easy to change, once you under-
stand it, but harder to wrap your head around at first.

You can also go overboard with entities. At an extreme, you could make an
entity reference for the word “the”—it wouldn’t buy you much, but you could do
it.

Note: The larger an entity is, the less likely it is that changing it will have unin-
tended effects. When you define an external entity that covers a whole section on
installation instructions, for example, making changes to the section is unlikely to
make any of the documents that depend on it come out wrong. Small inline substi-
tutions can be more problematic, though. For example, if productName is defined
as an entity, the name change can be to a different part of speech, and that can pro-
duce! Suppose the product name is something like “HtmlEdit”. That’s a verb. So
you write a sentence that becomes, “You can HtmlEdit your file...” after the entity-
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substitution occurs. That sentence reads fine, because the verb fits well in that con-
text. But if the name is eventually changed to “HtmlEditor”, the sentence becomes
“You can HtmlEditor your file...”, which clearly doesn’t work. Still, even if such
simple substitutions can sometimes get you in trouble, they can potentially save a
lot of time. (One alternative would be to set up entities named productNoun, pro-
ductVerb, productAdj, and productAdverb!)

Normalizing DTDs
Just as you can normalize your XML document, you can also normalize your
DTD declarations by factoring out common pieces and referencing them with a
parameter entity. Factoring out the DTDs (also known as modularizing or nor-
malizing) gives the same advantages and disadvantages as normalized XML—
easier to change, somewhat more difficult to follow.

You can also set up conditionalized DTDs. If the number and size of the condi-
tional sections is small relative to the size of the DTD as a whole, that can let you
“single source” a DTD that you can use for multiple purposes. If the number of
conditional sections gets large, though, the result can be a complex document
that is difficult to edit.

Summary
Congratulations! You have now created a number of XML files that you can use
for testing purposes. Here’s a table that describes the files you have constructed.

Table 2–5 Listing of Sample XML Files

    File Contents

 slideSample01.xml A basic file containing a few elements and attributes, as well
as comments.

 slideSample02.xml Includes a processing instruction.

 SlideSampleBad1.xml A file that is not well-formed.

 slideSample03.xml Includes a simple entity reference (&lt;).

 slideSample04.xml Contains a CDATA section.
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 slideSample05.xml References either a simple external DTD for elements
(slideshow1a.dtd), for use with a nonvalidating parser, or
else a DTD that defines attributes (slideshow1b.dtd) for
use with a validating parser.

 slideSample06.xml Defines two entities locally (product and products), and refer-
ences slideshow1b.dtd.

 slideSample07.xml References an external entity defined locally (copy-
right.xml), and references slideshow1b.dtd.

 slideSample08.xml References xhtml.dtd using a parameter entity in
slideshow2.dtd, producing a naming conflict, since title
is declared in both.

slideSample09.xml Changes the title element to slide-title, so it can refer-
ence xhtml.dtd using a parameter entity in
slideshow3.dtd without conflict.

Table 2–5 Listing of Sample XML Files

    File Contents
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Getting Started with
Web Applications

A Web application is a dynamic extension of a Web server. There are two
types of Web applications:

• Presentation-oriented. A presentation-oriented Web application generates
interactive Web pages containing various types of markup language
(HTML, XML, and so on) and dynamic content in response to requests.

• Service-oriented. A service-oriented Web application implements the end-
point of a Web service. Presentation-oriented applications are often clients
of service-oriented Web applications.

In the Java 2 platform, Web components provide the dynamic extension capabili-
ties for a Web server. Web components are either Java Servlets, JSP pages, or
Web service endpoints. Servlets are Java programming language classes that
dynamically process requests and construct responses. JSP pages are text-based
documents that execute as servlets but allow a more natural approach to creating
static content. Although servlets and JSP pages can be used interchangeably,
each has its own strengths. Servlets are best suited to service-oriented Web appli-
cations and managing the control functions of a presentation-oriented applica-
tion, such as dispatching requests and handling nontextual data. JSP pages are
more appropriate for generating text-based markup such as HTML, SVG, WML,
and XML.
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Web components are supported by the services of a runtime platform called a
Web container. The Web container provides services such as request dispatching,
security, concurrency, and life cycle management. It also gives Web components
access to APIs such as naming, transactions, and e-mail.

Certain aspects of Web application behavior can be configured when the applica-
tion is installed or deployed to the Web container. The configuration information
is maintained in a text file in XML format called a Web application deployment
descriptor. A Web application deployment descriptor (DD) must conform to the
schema described in the Java Servlet specification.

This chapter describes the organization, configuration, and installation and
deployment procedures for Web applications. Chapters 8 and 9 cover how to
develop Web components for service-oriented Web applications. Chapters 11
through 18 cover how to develop the Web components for presentation-oriented
Web applications.

Many features of JSP technology are determined by Java Servlet technology, so
you should familiarize yourself with that material even if you do not intend to
write servlets.

Most Web applications use the HTTP protocol, and support for HTTP is a major
aspect of Web components. For a brief summary of HTTP protocol features see
Appendix B.

Web Application Life Cycle
A Web application consists of Web components, static resource files such as
images, and helper classes and libraries. The Web container provides many sup-
porting services that enhance the capabilities of Web components and make
them easier to develop. However, because it must take these services into
account, the process for creating and running a Web application is different from
that of traditional stand-alone Java classes.The process for creating, deploying,
and executing a Web application can be summarized as follows:

1. Develop the Web component code.

2. Develop the Web application deployment descriptor.

3. Compile the Web application components and helper classes referenced by
the components.

4. Optionally package the application into a deployable unit.

5. Deploy the application into a Web container.

http://java.sun.com/products/servlet/download.html#specs
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6. Access a URL that references the Web application.

Developing Web component code is covered in the later chapters. Steps 2
through 4 are expanded on in the following sections and illustrated with a Hello,
World style presentation-oriented application. This application allows a user to
enter a name into an HTML form (Figure 3–1) and then displays a greeting after
the name is submitted (Figure 3–2):

Figure 3–1 Greeting Form
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Figure 3–2 Response

The Hello application contains two Web components that generate the greeting
and the response. This chapter discusses two versions of the application: a JSP
version called hello1, in which the components are implemented by two JSP
pages, index.jsp and response.jsp, and a servlet version called hello2, in
which the components are implemented by two servlet classes, GreetingServ-
let.java and ResponseServlet.java. The two versions are used to illustrate
tasks involved in packaging, deploying, configuring, and running an application
that contains Web components. If you are viewing this tutorial online, you must
download the tutorial bundle to get the source code for this example. See About
the Examples (page xxix).

J2EE 1.4 Application Server
This section contains a brief summary of the components comprising the J2EE
1.4 Application Server, the configuration steps required before using the compo-
nents to build and deploy the tutorial examples, and instructions for starting and
stopping the main components. The last section in this chapter discusses how to
run the PointBase database server; other chapters explain how to use the remain-
ing components.

../examples/web/hello1/web/index.txt
../examples/web/hello2/src/servlets/GreetingServlet.java
../examples/web/hello2/src/servlets/GreetingServlet.java
../examples/web/hello2/src/servlets/ResponseServlet.java
../examples/web/hello1/web/response.txt


COMPONENTS 89
Components
The J2EE 1.4 Application Server contains the components listed in Table 3–1.
Basic usage information for many of the components appears throughout the
tutorial. For detailed information, see the online help in the GUI tools and the
man pages at http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/

index.html for the command line tools.

Table 3–1 J2EE 1.4 Application Server Components

Component Description

Admin Console
A web-based GUI tool to run the application server administration
utility. Used to stop the application server and manage users,
resources, and applications.

asadmin
A command line tool to run the application server administration
utility. Used to start and stop the application server and manage
users, resources, and applications.

asant

A portable command line build tool that is an extension of the Ant
tool developed by the Apache Software Foundation (see http://
ant.apache.org/). asant contains additional tasks that interact
with the application server administration utility.

appclient
A command line tool that launches the application client container
and invokes the client application packaged in the application client
JAR file.

capture-schema
A command line tool to extract schema information from a database,
producing a schema file that the application server can use for con-
tainer-managed persistence.

deploytool
A standalone GUI tool to package applications, generate deployment
descriptors, and deploy applications on the application server.

package-appclient
A command line tool to package the application client container
libraries and JAR files.

PointBase database An evaluation copy of the PointBase database server.

verifier A command line tool that validates J2EE deployment descriptors.

wscompile
A command line tool that generates stubs, ties, serializers, and
WSDL files used in JAX-RPC clients and services.

http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/index.html
http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/index.html
http://ant.apache.org/
http://ant.apache.org/
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Setting Up To Build and Deploy Tutorial
Examples
You use asant to build the tutorial examples and configure the application
server. In order to run the asant scripts, you must configure your environment
and the tutorial properties files as follows:

• Add <JAVA_HOME>/bin/ to the front of your path.

• Add <J2EE_HOME>/bin/ and <J2EE_HOME>/share/bin/ to the front of
your path so that J2EE 1.4 Application Server components override other
installations.

• Set the j2ee.home property in the file <INSTALL>/j2eetutorial14/

examples/common/build.properties to the location of your J2EE 1.4
Application Server installation. The build process uses the j2ee.home

property to include the J2EE library archives in the classpath. The J2EE
library archive is the file <J2EE_HOME>/lib/j2ee.jar. If you wish to use
an IDE or the javac compiler to compile J2EE applications, you must add
this JAR to your classpath.

Note: On Windows, you must escape any backslashes in the j2ee.home property
with another backslash or use forward slashes as a path separator. So, if your J2EE
1.4 Application Server installation is C:\Sun\AppServer, you must set j2ee.home
as follows:

j2ee.home = C:\\Sun\\AppServer

or

j2ee.home=C:/Sun/AppServer

wsdeploy
A command line tool that generates implementation-specific, ready-
to-deploy WAR files for Web service applications that use JAX-RPC.

Table 3–1 J2EE 1.4 Application Server Components (Continued)

Component Description
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Starting and Stopping the J2EE
Application Server
To start and stop the J2EE application server, you use the asadmin utility. To
start the J2EE application server, open a terminal window or command prompt
and execute:

asadmin start-domain --verbose domain1

A domain is a set of one or more application server instances managed by one
administration server. Associated with a domain is:

• The application server’s port number. The default is 8080.

• The administration server’s port number. The default is 4848.

• An administration username and password. These passwords are required
when you access the administration server.

You specify these values when you install the J2EE 1.4 Application Server. The
examples in this tutorial assume that you chose the default ports.

With no arguments, the start-domain command initiates the default domain,
which is domain1. The --verbose flag causes all logging and debugging output
to appear on the terminal window or command prompt (it will also go into the
server log, which is located in <J2EE_HOME>/domains/domain1/logs/

server.log).

Or, on Windows, you can also choose

Programs→Sun Microsystems→J2EE 1.4 SDK→Start Default Domain

After the server has completed its startup sequence, you will see the following
output:

Domain domain1 started.

To stop the J2EE 1.4 Application Server, open a terminal window or command
prompt and execute:

asadmin stop-domain domain1

Or, on Windows, choose

Programs→Sun Microsystems→J2EE 1.4 SDK→Stop Default Domain
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When the server has stopped you will see the following output:

Domain domain1 stopped.

Starting the Admin Console
The Admin Console utility is a web-based GUI tool used to administer the J2EE
1.4 Application Server and manage users, resources, and J2EE applications. The
application server must be running before invoking the Admin Console.

To start the Admin Console, open a browser at the following URL:

http://localhost:4848/asadmin/

On Windows, from the Start menu, choose

Programs→Sun Microsystems→J2EE 1.4 SDK→Admin Console

Starting the deploytool Utility
The deploytool utility is a standalone GUI tool used to package J2EE applica-
tions, specify deployment descriptor elements, and deploy applications on the
J2EE 1.4 Application Server. To start deploytool, open a terminal window or
command prompt and execute:

deploytool

On Windows, from the Start menu, choose

Programs→Sun Microsystems→J2EE 1.4 SDK→Deploytool

Web Modules
In the J2EE architecture, Web components and static Web content files such as
images are called Web resources. A Web module is the smallest deployable and
usable unit of Web resources. A J2EE Web module corresponds to a Web appli-
cation as defined in the Java Servlet Specification.
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In addition to Web components and Web resources, a Web module can contain
other files including:

• Server-side utility classes (database beans, shopping carts, and so on).
Often these classes conform to the JavaBeans component architecture.

• Client-side classes (applets and utility classes).

A Web module has a specific structure. The top-level directory of a Web module
is the document root of the application. The document root is where JSP pages,
client-side classes and archives, and static Web resources, such as images, are
stored.

The document root contains a subdirectory named /WEB-INF/, which contains
the following files and directories:

• web.xml—The Web application deployment descriptor

• Tag library descriptor files (see Tag Library Descriptors, page 614)

• classes—A directory that contains server-side classes: servlets, utility
classes, and JavaBeans components

• tags—A directory that contains tag files, which are implementations of
tag libraries (see Tag File Location, page 600)

• lib—A directory that contains JAR archives of libraries called by server-
side classes

You can also create application-specific subdirectories (that is, package directo-
ries) in either the document root or the /WEB-INF/classes/ directory.

A Web module can be deployed as an unpacked file structure or packaged in a
JAR file known as a Web archive (WAR) file. Since the contents and use of WAR
files differ from JAR files, WAR file names use a .war extension. The Web mod-
ule just described is portable; you can deploy it into any Web container that con-
forms to the Java Servlet Specification.

In order to deploy a WAR on the J2EE 1.4 Application Server, it must also con-
tain a runtime deployment descriptor. The runtime deployment descriptor is an
XML file that contains information such as the context root, the JNDI names of
the application’s resources, and some J2EE 1.4 Application Server implementa-
tion-specific parameters. The J2EE Application Server Web application runtime
deployment descriptor is named sun-web_app.xml and is located in /WEB-INF/
along with the Web application deployment descriptor. The structure of a Web
module that can be deployed on the J2EE 1.4 Application Server is shown in
Figure 3–3.



94 GETTING STARTED WITH WEB APPLICATIONS
Figure 3–3 Web Module Structure

Packaging Web Modules
A Web module must be packaged into a WAR in certain deployment scenarios
and whenever you want to distribute the Web module. You package a Web mod-
ule into a WAR using the J2EE 1.4 Application Server deploytool utility. To
build and package the hello1 application into a WAR named hello1.war:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/hello1/.

2. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/hello1/

build/ directory.

3. Start deploytool.

4. Create a Web application called hello1 by running the New Web Compo-
nent Wizard. Select File→New→Web Component.

assembly
root

WEB-INF

JSPs, HTMLs, 
applet classes, etc.

web.xml
sub-web.xml

lib classes

Other
.jar files

All .class files for 
this web component
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5. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/web/hello1/hello1.war.

c. In the WAR Name field enter hello1.

d. Click Edit to add the content files.

e. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/hello1/build/. Select duke.waving.gif,
index.jsp, and response.jsp and click Add. Click OK.

f. Click Next.

g. Select the JSP radio button.

h. Select /index.jsp in the JSP Filename combo box.

i. Click Finish.

6. Select File→Save.

A sample hello1.war is provided in <INSTALL>/j2eetutorial14/examples/

web/provided-wars/. To open this WAR with deploytool:

1. Select File→Open.

2. Navigate to the provided-wars directory.

3. Select the WAR.

4. Click Open Module.

Deploying Web Modules
You can deploy a Web module to the J2EE 1.4 Application Server in several
ways:

• By pointing the J2EE 1.4 Application Server at an unpackaged Web mod-
ule directory structure using asadmin or the Admin Console.

• By packaging the Web module and

• Copying the WAR into the <J2EE_HOME>/domains/domain1/autode-

ploy/ directory.

• Using the application server Admin Console, asadmin, or deploytool
to deploy the WAR.

All of these methods will be described briefly in this chapter; however, packag-
ing and deploying using deploytool will be employed throughout the tutorial.
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Setting the Context Root
A context root identifies a Web application in a J2EE application server. You
specify the context root when you deploy a Web module. A context root must
start with a forward slash / and end with a string.

In a packaged Web module for deployment on the J2EE 1.4 Application Server,
the context root is stored in sun-web_app.xml. If you package the Web applica-
tion with deploytool, sun-web_app.xml is created automatically.

Deploying an Unpackaged Web Module
It is possible to deploy a Web module without packaging it into a WAR. The
advantage of this approach is that you do not need to rebuild the package every
time you update a file contained in the Web module. In addition, the J2EE 1.4
Application Server automatically detects updates to JSP pages, so you don’t
even have to redeploy the Web module when they change.

However, in order to deploy an unpackaged Web module, you must create the
Web module directory structure and provide the Web application deployment
descriptor web.xml. Since this tutorial uses deploytool for generating deploy-
ment descriptors, it does not document how to develop one from scratch. You
can view the structure of deployment descriptors in two ways:

• In deploytool, select Tools→Descriptor Viewer→Descriptor Viewer to
view web.xml and Tools→Descriptor Viewer→Application Server
Descriptor to view sun-web_app.xml.

• Unpackage one of the WARs in <INSTALL>/j2eetutorial14/examples/

web/provided-wars/ and extract the descriptor.

Since you explicitly specify the context root when you deploy and unpackaged
Web module, usually it is not necessary to provide sun-web_app.xml.

Deploying with the Admin Console
1. Expand the Applications node.

2. Select Web Applications node.

3. Click the Deploy button.

4. Select the No radio button next to Upload File.
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5. Type the full path to the Web module directory in the File or Directory
field. Although the GUI gives the choice to browse to the directory, this
option only applies to deploying a packaged WAR.

6. Click Next.

7. Type the application name.

8. Type the context root.

9. Select the Enabled box.

10.Click the OK button.

Deploying with asadmin
To deploy an unpackaged Web module with asadmin, open a terminal window
or command prompt and execute asadmin deploydir full-path-to-web-

module-directory.

The build task for the hello1 application creates a build directory (including
web.xml) in the structure of a Web module. To deploy hello1 using asadmin

deploydir, execute:

asadmin deploydir --contextroot /hello1
<INSTALL>/j2eetutorial14/examples/web/hello1/build

After you deploy the hello1 application, you can run the Web application by
pointing a browser at

http://localhost:8080/hello1

You should see the greeting form depicted in Figure 3–1.

A Web module is executed when a Web browser references a URL that contains
the Web module’s context root. Since no Web component appears in http://

localhost:8080/hello1/, the Web container executes the default component,
index.jsp. The section Mapping URLs to Web Components (page 104)
describes how to specify Web components in a URL.

Deploying a Packaged Web Module
If you have deployed the hello1 application, before proceeding with this sec-
tion, undeploy the application by following one of the procedures described in
Undeploying Web Modules (page 103).
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Deploying with deploytool
To deploy the hello1 Web module with deploytool:

1. Select the hello1 WAR you created in Packaging Web Modules (page 94).

2. Select the General tab.

3. Type /hello1 in the Context Root field.

4. Select File→Save.

5. Select Tools→Deploy.

6. Click OK.

You can use one of the following methods to deploy the WAR you packaged
with deploytool, or one of the WARs contained in <INSTALL>/

j2eetutorial14/examples/web/provided-wars/.

Deploying with the Admin Console
1. Expand the Applications node.

2. Select the Web Applications node.

3. Click the Deploy button.

4. Select the No radio button next to Upload File.

5. Type the full path to the WAR file (or click on Browse to find it), then click
the OK button.

6. Click Next.

7. Type the application name.

8. Type the context root.

9. Select the Enabled box.

10.Click the OK button.

Deploying with asadmin
To deploy a WAR with asadmin, open a terminal window or command prompt
and execute asadmin deploy full-path-to-war-file.
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Listing Deployed Web Modules
The J2EE 1.4 Application Server provides three ways to view the deployed Web
modules:

• deploytool

a. Select localhost:4848 from the Servers list.

b. View the Deployed Objects list in the General tab.

• Admin Console

a. Open the URL http://localhost:4848/asadmin in a browser.

b. Expand the nodes Applications→Web Applications.

• asadmin

a. Execute asadmin list-components.

Updating Web Modules
A typical iterative development cycle involves deploying a Web module and then
making changes to the application components. In order to update a deployed
Web module, you must:

1. Recompile any modified classes.

2. If you have deployed a packaged Web module, update any modified com-
ponents in the WAR.

3. Redeploy the module.

4. Reload the URL in the client.

Updating an Unpackaged Web Module
To update an unpackaged Web module using either of the methods discussed in
Deploying an Unpackaged Web Module (page 96), reexecute the deploy opera-
tion. If you have only changed JSP pages in the Web module directory, you do
not have to redeploy; simply reload the URL in the client.
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Updating a Packaged Web Module
This section describes how to update the hello1 Web module that you packaged
with deploytool.

First, change the greeting in the file <INSTALL>/j2eetutorial14/examples/

web/hello1/web/index.jsp to:

<h2>Hi, my name is Duke. What's yours?</h2>

Run asant build to copy the modified JSP page into the build directory. To
update the Web module using deploytool:

1. Select the hello1 WAR.

2. Select Tools→Update Module Files. A popup dialog will display the mod-
ified file. Click OK.

3. Select File→Save.

4. Select Tools→Deploy. A popup dialog will query whether you want to
redeploy. Click Yes.

5. Click OK.

To view the modified module, reload the URL in the browser.
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You should see the screen in Figure 3–4 in the browser:

Figure 3–4 New Greeting

Dynamic Reloading
If dynamic reloading is enabled, you do not have to redeploy an application or
module when you change its code or deployment descriptors. All you have to do
is copy the changed JSP or class files into the deployment directory for the appli-
cation or module. The deployment directory for a Web module named
context_root is <J2EE_HOME>/domains/domain1/applications/j2ee-mod-

ules/context_root. The server checks for changes periodically and redeploys
the application, automatically and dynamically, with the changes.

This is useful in a development environment, because it allows code changes to
be tested quickly. Dynamic reloading is not recommended for a production envi-
ronment, however, because it may degrade performance. In addition, whenever a
reload is done, the sessions at that time become invalid and the client must restart
the session.

To enable dynamic reloading, use the J2EE 1.4 Admin Console:

1. Select the Applications node.

2. Check the Reload Enabled box to enable dynamic reloading.
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3. Enter a number of seconds in the Reload Poll Interval field to set the inter-
val at which applications and modules are checked for code changes and
dynamically reloaded.

4. Click the Save button.

In addition, to load new servlet files or reload deployment descriptor changes,
you must do the following:

1. Create an empty file named .reload at the root of the module:
<J2EE_HOME>/domains/domain1/applications/j2ee-modules/
context_root/.reload

2. Explicitly update the .reload file’s timestamp each time you make the
above changes. On UNIX, execute touch .reload.

For JSP pages, changes are reloaded automatically at a frequency set in the
Reload Pool Interval. To disable dynamic reloading of JSP pages, set the reload-
interval property to -1.

Debugging Web Modules

Using the Server Log
One way to debug Web modules is to look at the server log in <J2EE_HOME>/

domains/domain1/logs/server.log. The log contains output from the appli-
cation server and your Web modules. You can log messages from any Java class
your Web modules with System.out.println and the Java Logging APIs (doc-
umented at http://java.sun.com/j2se/1.4.2/docs/guide/util/logging/

index.html) and from Web components with the ServletContext.log

method.

If you start the server with the --verbose flag, all logging and debugging output
will appear on the terminal window or command prompt and the server log. If
you start the server in the background, debugging information is only available
in the log. You can view the server log with a text editor or with the Admin Con-
sole log viewer. To use the log viewer:

1. Select the Application Server node.

2. Select the Logging tab.

3. Click the Open Log Viewer button.

4. Specify any constraints on the entries you want to see.

http://java.sun.com/j2se/1.4.2/docs/guide/util/logging/index.html
http://java.sun.com/j2se/1.4.2/docs/guide/util/logging/index.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContext.html#log(java.lang.String,java.lang.Throwable)
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5. Click the Search button.

Note that it’s not possible to see messages logged with System.out.println in
the Admin Console log viewer. If you prefer to use the Admin Console log
viewer, you will need to use the J2SE Logging API to log your messages.

Using a Debugger
The J2EE 1.4 Application Server supports the Java Platform Debugger Architec-
ture (JPDA). Using JPDA, you can configure the application server to communi-
cate debugging information via a socket. In order to debug a Web module using a
debugger:

1. Enable debugging in the application server with the Admin Console as fol-
lows:

a. Select the Application Server node.

b. Select the JVM Settings tab. The default debug options are set to:
-Xdebug -Xrunjdwp:transport=dt_socket,server=y,

suspend=n,address=1044

As you can see, the default debugger socket port is 1044, but you can
change it to anything not already used by the application server or another
service.

c. Check the Enabled box of the Debug field.

d. Click the Save button.

2. Stop the server and then start it.

3. Compile your Java source with the -g flag.

4. Deploy your Web module.

5. Start a debugger and connect to the debugger socket at whatever port you
set when you enabled debugging.

Undeploying Web Modules
You can undeploy Web modules in three ways:

• deploytool

a. Select localhost:4848 from the Servers list.

b. Select the Web module in the Deployed Objects list of the General tab.
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c. Click the Undeploy button.

• Admin Console

a. Open the URL http://localhost:4848/asadmin in a browser.

b. Expand the Applications node.

c. Select Web Applications.

d. Click the checkbox next to the module you wish to undeploy.

e. Click the Undeploy button.

• asadmin

a. Execute asadmin undeploy context_root.

Configuring Web Modules
Web applications are configured via elements contained in the Web application
deployment descriptor. The deploytool utility generates the descriptor when
you create a WAR and adds elements when you create Web components and
associated classes. You can modify the elements via the inspectors associated
with the WAR.

The following sections give a brief introduction to the Web application features
you will usually want to configure. A number of security parameters can be
specified; these are covered in Web-Tier Security (page 914).

In the following sections, some examples demonstrate procedures for configur-
ing the Hello, World application. If Hello, World does not use a specific configu-
ration feature, the section gives references to other examples that illustrate how
to specify the deployment descriptor element and describes generic procedures
for specifying the feature using deploytool. Extended examples that demon-
strate how to use deploytool are in The Example Servlets (page 456), The
Example JSP Pages (page 497), and The Example JSP Pages (page 559).

Mapping URLs to Web Components
When a request is received by the Web container it must determine which Web
component should handle the request. It does so by mapping the URL path con-
tained in the request to a Web application and a Web component. A URL path
contains the context root and an alias:

http://host:port/context_root/alias
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Setting the Component Alias
The alias identifies the Web component that should handle a request. The alias
path must start with a forward slash / and end with a string or a wildcard expres-
sion with an extension (*.jsp, for example). Since Web containers automati-
cally map an alias that ends with *.jsp, you do not have to specify an alias for a
JSP page unless you wish to refer to the page by a name other than its file name.
To set up the mappings for the servlet version of the hello application with
deploytool, first package it:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/hello2/.

2. Run asant build. This target will compile the servlets to the <INSTALL>/

j2eetutorial14/examples/web/hello2/build/ directory.

3. Start deploytool.

4. Create a Web application called hello2 by running the New Web Compo-
nent Wizard. Select File→New→Web Component.

5. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/web/hello2/hello2.war.

c. In the WAR Name field, enter hello2.

d. In the Context Root field, enter /hello2.

e. Click Edit to add the content files.

f. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/hello2/build/. Select duke.waving.gif and the
servlets package and click Add. Click OK.

g. Click Next.

h. Select the Servlet radio button.

i. Click Next.

j. Select GreetingServlet from the Servlet Class combo box.

k. Click Finish.

6. Select File→New→Web Component.

a. Click the Add to Existing WAR Module radio button and select hello2
from the combo box. Since the WAR contains all of the servlet classes,
you do not have to add any more content.

b. Click Next.
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c. Select the Servlet radio button.

d. Click Next.

e. Select ResponseServlet from the Servlet Class combo box.

f. Click Finish.

Then, to set the aliases,

1. Select the GreetingServlet Web component.

2. Select the Aliases tab.

3. Click Add to add a new mapping.

4. Type /greeting in the aliases list.

5. Select the ResponseServlet Web component.

6. Click Add.

7. Type /response in the aliases list.

8. Select File→Save.

Declaring Welcome Files
The welcome files mechanism allows you to specify a list of files that the Web
container will use for appending to a request for a URL (called a valid partial
request) that is not mapped to a Web component.

For example, suppose you define a welcome file welcome.html. When a client
requests a URL such as host:port/webapp/directory, where directory is
not mapped to a servlet or JSP page, the file host:port/webapp/directory/

welcome.html is returned to the client.

If a Web container receives a valid partial request, the Web container examines
the welcome file list and appends each welcome file in the order specified to the
partial request and checks whether a static resource or servlet in the WAR is
mapped to that request URL. The Web container then sends the request to the
first resource in the WAR that matches.

If no welcome file is specified, the J2EE 1.4 Application Server will use a file

named index.XXX, where XXX can be html or jsp, as the default welcome file. If
there is no welcome file and no file named index.XXX, the application server
returns a directory listing.

To specify welcome files with deploytool:

1. Select the WAR.
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2. Select the File Refs tab in the WAR inspector.

3. Click Add File in the Welcome Files pane.

4. Select the welcome file from the drop-down list.

The example discussed in Encapsulating Reusable Content using Tag
Files (page 598) has a welcome file.

Setting Initialization Parameters
The Web components in a Web module share an object that represents their
application context (see Accessing the Web Context, page 485). You can pass
initialization parameters to the context or to a Web component. To add a Web
component initialization parameter with deploytool:

1. Select the Web component.

2. Select the Init. Parameters tab in the Web component inspector.

3. Click Add.

To add a context parameter with deploytool:

1. Select the WAR.

2. Select the Context tab in the WAR inspector.

3. Click Add.

For an example context parameter, see the example discussed in The Example
JSP Pages (page 497).

Specifying Error Mappings
You can specify a mapping between the status code returned in an HTTP
response or a Java programming language exception returned by any Web com-
ponent and a Web resource (see Handling Errors, page 464). To set up the map-
ping with deploytool:

1. Select the WAR.

2. Select the File Refs tab in the WAR inspector.

3. Click Add Error in the Error Mapping pane.

4. Enter the HTTP status code (see HTTP Responses, page 1166) or fully-
qualified class name of an exception in the Error/Exception field.
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5. Enter the name of a resource to be invoked when the status code or excep-
tion is returned. The name should have a leading forward slash /.

Note: You can also define error pages for a JSP page contained in a WAR. If error
pages are defined for both the WAR and a JSP page, the JSP page’s error page takes
precedence. See Handling Errors (page 507).

For an example error page mapping, see the example discussed in The Example
Servlets (page 456).

Declaring References to Environment
Entries, Resource Environment Entries, or
Resources
If your Web components reference environment entries, resource environment
entries, or resources such as databases, you must declare the references in the
Web application deployment descriptor. To add a reference to a resource with
deploytool:

1. Select the WAR.

2. Select the Environment, Enterprise Bean Refs, Resource Env. Refs, or
Resource Refs tab in the WAR inspector.

3. Click Add to add a new reference.

4. Type a JNDI name for the resource.

5. Choose the type of the resource.

6. Choose whether the container or the application performs authentication
when the resource is accessed.

7. Choose whether the resource can be shared by more than one Web appli-
cation.

For an example resource reference, see Configuring the Web Application to Ref-
erence a Resource (page 112).
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Duke’s Bookstore Examples
In chapters 11 through 15, a common example—Duke’s Bookstore—is used to
illustrate the elements of Java Servlet technology, JavaServer Pages technology,
and the JSP Standard Tag Library. The example emulates a simple online shop-
ping application. It provides a book catalog from which users can select books
and add them to a shopping cart. Users can view and modify the shopping cart.
Once users are finished shopping, they can purchase the books in the cart.

The Duke’s Bookstore examples share common classes and a database schema.
These files are located in the directory <INSTALL>/j2eetutorial14/examples/

web/bookstore/. The common classes are packaged into a JAR. To create the
bookstore library JAR:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/bookstore/.

2. Run asant build to compile the bookstore files.

3. Run asant package-bookstore to create a library named bookstore.jar

in <INSTALL>/j2eetutorial14/examples/bookstore/dist/.

The next section describes how to create the bookstore database table and server
resources required to run the examples.

Accessing Databases from Web
Applications

Data that is shared between Web components and persistent between invocations
of a Web application is usually maintained in a database. Web applications use
the JDBC 2.0 API to access relational databases. For information on this API,
see

http://java.sun.com/docs/books/tutorial/jdbc

In the JDBC API, databases are accessed via DataSource objects. A Data-

Source has a set of properties that identify and describe the real world data
source that it represents. These properties include information like the location
of the database server, the name of the database, the network protocol to use to
communicate with the server, and so on.

http://java.sun.com/docs/books/tutorial/jdbc
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Applications access a data source using a connection, and a DataSource object
can be thought of as a factory for connections to the particular data source that
the DataSource instance represents. In a basic DataSource implementation, a
call to the method DataSource.getConnection returns a connection object that
is a physical connection to the data source.

If a DataSource object is registered with a JNDI naming service, an application
can use the JNDI API to access that DataSource object, which can then be used
to connect to the data source it represents.

The Duke’s Bookstore examples described in chapters 11 through 15 use the
PointBase evaluation database included with the J2EE 1.4 Application Server to
maintain the catalog of books. See the PointBase support site at

http://www.pointbase.com/node.shtml?navHier=Support/
Product+Docs&CF=support/docs/overview.html

for detailed information about the PointBase database.

This section describes how to:

• Start the PointBase database server

• Populate the database

• Define a data source in the application server

• Configure a Web application to reference the data source with a JNDI
name

• Map the JNDI name to the data source defined in the application server

Starting the PointBase Database Server
To start the PointBase database server:

1. In a terminal window, go to <J2EE_HOME>/pointbase/tools/serverop-

tion.

2. Execute the startserver script.

On Windows, from the Start menu, choose

      Programs→Sun Microsystems→J2EE 1.4 SDK→Start PointBase

http://www.pointbase.com/node.shtml?navHier=Support/Product+Docs&CF=support/docs/overview.html
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Populating the Example Database
To populate the database for the Duke’s Bookstore examples:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/bookstore/.

2. Run asant create-db_common. This task runs a PointBase commander
tool command to read the file books.sql and execute the SQL commands
contained in the file. The table named books is created for the user pbpub-
lic in the sun-appserv-samples PointBase database.

3. At the end of the processing, you should see the following output:

...
[java] SQL> INSERT INTO books VALUES('207', 'Thrilled', 'Ben',
[java]  'The Green Project: Programming for Consumer Devices',
[java]  30.00, false, 1998, 'What a cool book', 20);
[java] 1 row(s) affected

[java] SQL> INSERT INTO books VALUES('208', 'Tru', 'Itzal',
[java]  'Duke: A Biography of the Java Evangelist',
[java]  45.00, true, 2001, 'What a cool book.', 20);
[java] 1 row(s) affected

You can check that the table exists with the PointBase console tool as follows:

1. In a terminal window, go to <J2EE_HOME>/pointbase/tools/serverop-

tion/.

2. Execute startconsole.

3. In the Connect to Database dialog

a. Enter jdbc:pointbase:server://localhost/sun-appserv-sam-

ples in the URL field.

b. Enter PBPUBLIC in the password field.

4. Click OK.

5. Expand the SCHEMAS→PBPUBLIC→TABLES nodes. Notice that there
is a table named BOOKS.

6. To see the contents of the books table:

a. In the Enter SQL commands text area, enter select * from books;.

b. Click the Execute button.
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Defining a Data Source in the J2EE
Server
Data sources in the J2EE application server implement connection pooling. To
define the Duke’s Bookstore data source, you use the installed PointBase con-
nection pool named PointBasePool.

You create the data source with the J2EE 1.4 Application Server Admin Console,
by following this procedure:

1. Expand the JDBC node.

2. Select the JDBC Resources node.

3. Click the New... button.

4. Type jdbc/BookDB for the JNDI Name.

5. Choose PointBasePool for the Pool Name.

6. Choose user for the Resource Type.

7. Select the Enabled checkbox.

8. Click OK.

Configuring the Web Application to
Reference a Resource
In order to access a database from a Web application, you must declare resource
reference in the application’s Web application deployment descriptor (see
Declaring References to Environment Entries, Resource Environment Entries, or
Resources, page 108). The resource reference declares a JNDI name, the type of
the data resource, and the kind of authentication used when the resource is
accessed. The JNDI name is used to create a data source object in the database
helper class database.BookDB:

public BookDB () throws Exception {
try  {

Context initCtx = new InitialContext();
Context envCtx = (Context)

initCtx.lookup("java:comp/env");
DataSource ds = (DataSource) envCtx.lookup("jdbc/BookDB");
con =  ds.getConnection();
System.out.println("Created connection to database.");

} catch (Exception ex) {
System.out.println("Couldn't create connection." +
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ex.getMessage());
throw new

Exception("Couldn't open connection to database: "
+ex.getMessage());

}

To specify a resource reference to the bookstore data source with deploytool:

1. Select the WAR (created in chapters 11 through 15).

2. Select the Resource Refs tab.

3. Click Add.

4. Type jdbc/BookDB in the Coded Name field.

5. Accept the default type javax.sql.DataSource.

6. Accept the default authorization Container.

7. Accept the default Sharable selected.

Mapping the Web Application Resource
Reference to a Data Source
The Web application resource reference and the data source defined in the J2EE
1.4 Application server both have JNDI names. You connect the resource refer-
ence name to the data source name with deploytool as follows:

1. Select the Resource Reference Name, jdbc/BookDB, defined in the previ-
ous section.

2. In the Sun-specific Settings frame, enter the name of the data source that
you created in the application server, jdbc/BookDB, in the JNDI Name
field.

Further Information
For more information about Web applications, refer to the following:

• Java Servlet 2.4 Specification
http://java.sun.com/products/servlet/download.html#specs

• The Java Servlets Web site

http://java.sun.com/products/servlet

http://java.sun.com/products/servlet/download.html#specs
http://java.sun.com/products/servlet
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Java API for XML
Processing

THE Java API for XML Processing (JAXP) is for processing XML data using
applications written in the Java programming language. JAXP leverages the
parser standards SAX (Simple API for XML Parsing) and DOM (Document
Object Model) so that you can choose to parse your data as a stream of events or
to build an object representation of it. JAXP also supports the XSLT (XML
Stylesheet Language Transformations) standard, giving you control over the pre-
sentation of the data and enabling you to convert the data to other XML docu-
ments or to other formats, such as HTML. JAXP also provides namespace
support, allowing you to work with DTDs that might otherwise have naming
conflicts.

Designed to be flexible, JAXP allows you to use any XML-compliant parser
from within your application. It does this with what is called a “pluggability
layer”, which allows you to plug in an implementation of the SAX or DOM
APIs. The pluggability layer also allows you to plug in an XSL processor, letting
you control how your XML data is displayed.

The JAXP APIs
The main JAXP APIs are defined in the javax.xml.parsers package. That
package contains two vendor-neutral factory classes: SAXParserFactory and
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DocumentBuilderFactory that give you a SAXParser and a DocumentBuilder,
respectively. The DocumentBuilder, in turn, creates DOM-compliant Document
object.

The factory APIs give you the ability to plug in an XML implementation offered
by another vendor without changing your source code. The implementation you
get depends on the setting of the javax.xml.parsers.SAXParserFactory and
javax.xml.parsers.DocumentBuilderFactory system properties. The default
values (unless overridden at runtime) point to Sun’s implementation.

The remainder of this section shows how the different JAXP APIs work when
you write an application.

An Overview of the Packages
The SAX and DOM APIs are defined by XML-DEV group and by the W3C,
respectively. The libraries that define those APIs are:

javax.xml.parsers
The JAXP APIs, which provide a common interface for different vendors’
SAX and DOM parsers.

org.w3c.dom
Defines the Document class (a DOM), as well as classes for all of the compo-
nents of a DOM.

org.xml.sax
Defines the basic SAX APIs.

javax.xml.transform
Defines the XSLT APIs that let you transform XML into other forms.

The “Simple API” for XML (SAX) is the event-driven, serial-access mechanism
that does element-by-element processing. The API for this level reads and writes
XML to a data repository or the Web. For server-side and high-performance
apps, you will want to fully understand this level. But for many applications, a
minimal understanding will suffice.

The DOM API is generally an easier API to use. It provides a relatively familiar
tree structure of objects. You can use the DOM API to manipulate the hierarchy
of application objects it encapsulates. The DOM API is ideal for interactive
applications because the entire object model is present in memory, where it can
be accessed and manipulated by the user.

On the other hand, constructing the DOM requires reading the entire XML struc-
ture and holding the object tree in memory, so it is much more CPU and memory
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intensive. For that reason, the SAX API will tend to be preferred for server-side
applications and data filters that do not require an in-memory representation of
the data.

Finally, the XSLT APIs defined in javax.xml.transform let you write XML
data to a file or convert it into other forms. And, as you’ll see in the XSLT sec-
tion, of this tutorial, you can even use it in conjunction with the SAX APIs to
convert legacy data to XML.

The Simple API for XML (SAX) APIs
The basic outline of the SAX parsing APIs are shown at right. To start the pro-
cess, an instance of the SAXParserFactory class is used to generate an instance
of the parser.

Figure 4–1 SAX APIs

The parser wraps a SAXReader object. When the parser’s parse() method is
invoked, the reader invokes one of several callback methods implemented in the
application. Those methods are defined by the interfaces ContentHandler,
ErrorHandler, DTDHandler, and EntityResolver.

Here is a summary of the key SAX APIs:
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SAXParserFactory

A SAXParserFactory object creates an instance of the parser determined by
the system property, javax.xml.parsers.SAXParserFactory.

SAXParser
The SAXParser interface defines several kinds of parse() methods. In gen-
eral, you pass an XML data source and a DefaultHandler object to the
parser, which processes the XML and invokes the appropriate methods in the
handler object.

SAXReader
The SAXParser wraps a SAXReader. Typically, you don’t care about that, but
every once in a while you need to get hold of it using SAXParser’s getXML-
Reader(), so you can configure it. It is the SAXReader which carries on the
conversation with the SAX event handlers you define.

DefaultHandler
Not shown in the diagram, a DefaultHandler implements the Con-

tentHandler, ErrorHandler, DTDHandler, and EntityResolver interfaces
(with null methods), so you can override only the ones you’re interested in.

ContentHandler
Methods like startDocument, endDocument, startElement, and endEle-

ment are invoked when an XML tag is recognized. This interface also
defines methods characters and processingInstruction, which are
invoked when the parser encounters the text in an XML element or an inline
processing instruction, respectively.

ErrorHandler
Methods error, fatalError, and warning are invoked in response to vari-
ous parsing errors. The default error handler throws an exception for fatal
errors and ignores other errors (including validation errors). That’s one rea-
son you need to know something about the SAX parser, even if you are using
the DOM. Sometimes, the application may be able to recover from a valida-
tion error. Other times, it may need to generate an exception. To ensure the
correct handling, you’ll need to supply your own error handler to the parser.

DTDHandler
Defines methods you will generally never be called upon to use. Used when
processing a DTD to recognize and act on declarations for an unparsed
entity.

EntityResolver
The resolveEntity method is invoked when the parser must identify data
identified by a URI. In most cases, a URI is simply a URL, which specifies
the location of a document, but in some cases the document may be identi-
fied by a URN—a public identifier, or name, that is unique in the Web space.
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The public identifier may be specified in addition to the URL. The Entity-

Resolver can then use the public identifier instead of the URL to find the
document, for example to access a local copy of the document if one exists.

A typical application implements most of the ContentHandler methods, at a
minimum. Since the default implementations of the interfaces ignore all inputs
except for fatal errors, a robust implementation may want to implement the
ErrorHandler methods, as well.
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The SAX Packages
The SAX parser is defined in the following packages listed in Table 4–1.

The Document Object Model (DOM)
APIs

Figure 4–2 shows the JAXP APIs in action:

Table 4–1 SAX Packages

Package Description

 org.xml.sax
Defines the SAX interfaces. The name org.xml is the pack-
age prefix that was settled on by the group that defined the
SAX API.

 org.xml.sax.ext

Defines SAX extensions that are used when doing more
sophisticated SAX processing, for example, to process a doc-
ument type definitions (DTD) or to see the detailed syntax for
a file.

 org.xml.sax.helpers

 Contains helper classes that make it easier to use SAX—for
example, by defining a default handler that has null-methods
for all of the interfaces, so you only need to override the ones
you actually want to implement.

 javax.xml.parsers
Defines the SAXParserFactory class which returns the
SAXParser. Also defines exception classes for reporting
errors.
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Figure 4–2 DOM APIs

You use the javax.xml.parsers.DocumentBuilderFactory class to get a Doc-
umentBuilder instance, and use that to produce a Document (a DOM) that con-
forms to the DOM specification. The builder you get, in fact, is determined by
the System property, javax.xml.parsers.DocumentBuilderFactory, which
selects the factory implementation that is used to produce the builder. (The plat-
form’s default value can be overridden from the command line.)

You can also use the DocumentBuilder newDocument() method to create an
empty Document that implements the org.w3c.dom.Document interface. Alter-
natively, you can use one of the builder’s parse methods to create a Document

from existing XML data. The result is a DOM tree like that shown in the dia-
gram.

Note: Although they are called objects, the entries in the DOM tree are actually
fairly low-level data structures. For example, under every element node (which cor-
responds to an XML element) there is a text node which contains the name of the
element tag! This issue will be explored at length in the DOM section of the tutorial,
but users who are expecting objects are usually surprised to find that invoking the
text() method on an element object returns nothing! For a truly object-oriented
tree, see the JDOM API at http://www.jdom.org.
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The DOM Packages
The Document Object Model implementation is defined in the packages listed in
Table 4–2.:

Table 4–2 DOM Packages

Package Description

 org.w3c.dom
Defines the DOM programming interfaces for XML (and, option-
ally, HTML) documents, as specified by the W3C.

 javax.xml.parsers

Defines the DocumentBuilderFactory class and the Docu-
mentBuilder class, which returns an object that implements the
W3C Document interface. The factory that is used to create the
builder is determined by the javax.xml.parsers system prop-
erty, which can be set from the command line or overridden when
invoking the new Instance method. This package also defines
the ParserConfigurationException class for reporting
errors.
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The XML Stylesheet Language for
Transformation (XSLT) APIs

Figure 4–3 shows the XSLT APIs in action.

Figure 4–3 XSLT APIs

A TransformerFactory object is instantiated, and used to create a Trans-

former. The source object is the input to the transformation process. A source
object can be created from SAX reader, from a DOM, or from an input stream.

Similarly, the result object is the result of the transformation process. That object
can be a SAX event handler, a DOM, or an output stream.

When the transformer is created, it may be created from a set of transformation
instructions, in which case the specified transformations are carried out. If it is
created without any specific instructions, then the transformer object simply cop-
ies the source to the result.
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The XSLT Packages
The XSLT APIs are defined in the following packages:

Compiling and Running the Programs
In the J2EE 1.4 Application Server, the JAXP libraries are distributed in the
directory <J2EE_HOME>/lib/endorsed. To run the sample programs, you'll need
to used the Java 2 platform’s “endorsed standards” mechanism to access those
libraries. For details, see Compiling and Running the Program (page 139).

Where Do You Go from Here?
At this point, you have enough information to begin picking your own way
through the JAXP libraries. Your next step from here depends on what you want
to accomplish. You might want to go to:

Table 4–3 XSLT Packages

Package Description

javax.xml.transform

Defines the TransformerFactory and
Transformer classes, which you use to get a
object capable of doing transformations. After
creating a transformer object, you invoke its
transform() method, providing it with an
input (source) and output (result).

javax.xml.transform.dom
Classes to create input (source) and output
(result) objects from a DOM.

javax.xml.transform.sax
Classes to create input (source) from a SAX
parser and output (result) objects from a SAX
event handler.

javax.xml.transform.stream
Classes to create input (source) and output
(result) objects from an I/O stream.
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Simple API for XML (page 127)
If the data structures have already been determined, and you are writing a
server application or an XML filter that needs to do fast processing.

Document Object Model (page 187)
If you need to build an object tree from XML data so you can manipulate it
in an application, or convert an in-memory tree of objects to XML. This part
of the tutorial ends with a section on namespaces.

XML Stylesheet Language for Transformations (page 261)
If you need to transform XML tags into some other form, if you want to gen-
erate XML output, or (in combination with the SAX API) if you want to
convert legacy data structures to XML.
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Simple API for XML

IN this chapter we focus on the Simple API for XML (SAX), an event-driven,
serial-access mechanism for accessing XML documents. This is the protocol that
most servlets and network-oriented programs will want to use to transmit and
receive XML documents, because it’s the fastest and least memory-intensive
mechanism that is currently available for dealing with XML documents.

The SAX protocol requires a lot more programming than the Document Object
Model (DOM). It’s an event-driven model (you provide the callback methods,
and the parser invokes them as it reads the XML data), which makes it harder to
visualize. Finally, you can’t “back up” to an earlier part of the document, or rear-
range it, any more than you can back up a serial data stream or rearrange charac-
ters you have read from that stream.

For those reasons, developers who are writing a user-oriented application that
displays an XML document and possibly modifies it will want to use the DOM
mechanism described in the next part of the tutorial, Document Object
Model (page 187).

However, even if you plan to build with DOM apps exclusively, there are several
important reasons for familiarizing yourself with the SAX model:

• Same Error Handling

When parsing a document for a DOM, the same kinds of exceptions are
generated, so the error handling for JAXP SAX and DOM applications
are identical.

• Handling Validation Errors



128 SIMPLE API FOR XML
By default, the specifications require that validation errors (which you’ll
be learning more about in this part of the tutorial) are ignored. If you want
to throw an exception in the event of a validation error (and you probably
do) then you need to understand how the SAX error handling works.

• Converting Existing Data

As you’ll see in the DOM section of the tutorial, there is a mechanism you
can use to convert an existing data set to XML—however, taking advan-
tage of that mechanism requires an understanding of the SAX model.

Note: The XML files used in this chapter can be found in
<INSTALL>/j2eetutorial14/examples/xml/samples.
The programs and output listings can be found in
<INSTALL>/j2eetutorial14/examples/jaxp/sax/samples.

When to Use SAX
When it comes to fast, efficient reading of XML data, SAX is hard to beat. It
requires little memory, because it does not construct an internal representation
(tree structure) of the XML data. Instead, it simply sends data to the application
as it is read — your application can then do whatever it wants to do with the data
it sees.

In effect, the SAX API acts like a serial I/O stream. You see the data as it streams
in, but you can’t go back to an earlier position or leap ahead to a different posi-
tion. In general, it works well when you simply want to read data and have the
application act on it.

It is also helpful to understand the SAX event model when you want to convert
existing data to XML. As you’ll see in Generating XML from an Arbitrary Data
Structure (page 281), the key to the conversion process is modifying an existing
application to deliver the appropriate SAX events as it reads the data.

But when you need to modify an XML structure — especially when you need to
modify it interactively, an in-memory structure like the Document Object Model
(DOM) may make more sense.

However, while DOM provides many powerful capabilities for large-scale docu-
ments (like books and articles), it also requires a lot of complex coding. (The
details of that process are highlighted in When to Use DOM (page 188).)
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For simpler applications, that complexity may well be unnecessary. For faster
development and simpler applications, one of the object-oriented XML-pro-
gramming standards may make the most sense, as described in JDOM and
dom4j (page 35).

Echoing an XML File with the SAX
Parser

In real life, you are going to have little need to echo an XML file with a SAX
parser. Usually, you’ll want to process the data in some way in order to do some-
thing useful with it. (If you want to echo it, it’s easier to build a DOM tree and
use that for output.) But echoing an XML structure is a great way to see the SAX
parser in action, and it can be useful for debugging.

In this exercise, you’ll echo SAX parser events to System.out. Consider it the
“Hello World” version of an XML-processing program. It shows you how to use
the SAX parser to get at the data, and then echoes it to show you what you’ve
got.

Note: The code discussed in this section is in Echo01.java. The file it operates on
is slideSample01.xml, as described in Writing a Simple XML File (page 45). (The
browsable version is slideSample01-xml.html.)

Creating the Skeleton
Start by creating a file named Echo.java and enter the skeleton for the applica-
tion:

public class Echo
{

public static void main(String argv[])
{

}

}

Since we’re going to run it standalone, we need a main method. And we need
command-line arguments so we can tell the application which file to echo.

../examples/jaxp/sax/samples/Echo01.java
../examples/xml/samples/slideSample01.xml
../examples/xml/samples/slideSample01-xml.html
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Importing Classes
Next, add the import statements for the classes the application will use:

import java.io.*;
import org.xml.sax.*;
import org.xml.sax.helpers.DefaultHandler;
import javax.xml.parsers.SAXParserFactory;
import javax.xml.parsers.ParserConfigurationException;
import javax.xml.parsers.SAXParser;

public class Echo
{

...

The classes in java.io, of course, are needed to do output. The org.xml.sax

package defines all the interfaces we use for the SAX parser. The SAX-

ParserFactory class creates the instance we use. It throws a ParserConfigu-

rationException if it is unable to produce a parser that matches the specified
configuration of options. (You’ll see more about the configuration options later.)
The SAXParser is what the factory returns for parsing, and the DefaultHandler

defines the class that will handle the SAX events that the parser generates.

Setting up for I/O
The first order of business is to process the command line argument, get the
name of the file to echo, and set up the output stream. Add the text highlighted
below to take care of those tasks and do a bit of additional housekeeping:

public static void main(String argv[])

{
if (argv.length != 1) {

System.err.println("Usage: cmd filename");
System.exit(1);

}
try {

// Set up output stream
out = new OutputStreamWriter(System.out, "UTF8");

}
catch (Throwable t) {

t.printStackTrace();
}
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System.exit(0);
}

static private Writer out;

When we create the output stream writer, we are selecting the UTF-8 character
encoding. We could also have chosen US-ASCII, or UTF-16, which the Java
platform also supports. For more information on these character sets, see Java
Encoding Schemes (page 1163).

Implementing the ContentHandler
Interface
The most important interface for our current purposes is the ContentHandler

interface. That interface requires a number of methods that the SAX parser
invokes in response to different parsing events. The major event handling meth-
ods are: startDocument, endDocument, startElement, endElement, and char-

acters.

The easiest way to implement that interface is to extend the DefaultHandler

class, defined in the org.xml.sax.helpers package. That class provides do-
nothing methods for all of the ContentHandler events. Enter the code high-
lighted below to extend that class:

public class Echo extends DefaultHandler
{

...
}

Note: DefaultHandler also defines do-nothing methods for the other major events,
defined in the DTDHandler, EntityResolver, and ErrorHandler interfaces. You’ll
learn more about those methods as we go along.

Each of these methods is required by the interface to throw a SAXException. An
exception thrown here is sent back to the parser, which sends it on to the code
that invoked the parser. In the current program, that means it winds up back at
the Throwable exception handler at the bottom of the main method.

When a start tag or end tag is encountered, the name of the tag is passed as a
String to the startElement or endElement method, as appropriate. When a
start tag is encountered, any attributes it defines are also passed in an
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Attributes list. Characters found within the element are passed as an array of
characters, along with the number of characters (length) and an offset into the
array that points to the first character.

Setting up the Parser
Now (at last) you’re ready to set up the parser. Add the text highlighted below to
set it up and get it started:

public static void main(String argv[])
{

if (argv.length != 1) {
System.err.println("Usage: cmd filename");
System.exit(1);

}

// Use an instance of ourselves as the SAX event handler
DefaultHandler handler = new Echo();

        // Use the default (non-validating) parser
SAXParserFactory factory = SAXParserFactory.newInstance();
try {

// Set up output stream
out = new OutputStreamWriter(System.out, "UTF8");

 // Parse the input
SAXParser saxParser = factory.newSAXParser();
saxParser.parse( new File(argv[0]), handler );

        } catch (Throwable t) {
t.printStackTrace();

}
System.exit(0);

}

With these lines of code, you created a SAXParserFactory instance, as deter-
mined by the setting of the javax.xml.parsers.SAXParserFactory system
property. You then got a parser from the factory and gave the parser an instance
of this class to handle the parsing events, telling it which input file to process.

Note: The javax.xml.parsers.SAXParser class is a wrapper that defines a number
of convenience methods. It wraps the (somewhat-less friendly)
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org.xml.sax.Parser object. If needed, you can obtain that parser using the SAX-

Parser’s getParser() method.

For now, you are simply catching any exception that the parser might throw.
You’ll learn more about error processing in a later section of the tutorial, Han-
dling Errors with the Nonvalidating Parser (page 151).

Writing the Output
The ContentHandler methods throw SAXExceptions but not IOExceptions,
which can occur while writing. The SAXException can wrap another exception,
though, so it makes sense to do the output in a method that takes care of the
exception-handling details. Add the code highlighted below to define an emit

method that does that:

static private Writer out;

private void emit(String s)
throws SAXException
{

try {
out.write(s);
out.flush();

} catch (IOException e) {
throw new SAXException("I/O error", e);

}
}
...

When emit is called, any I/O error is wrapped in SAXException along with a
message that identifies it. That exception is then thrown back to the SAX parser.
You’ll learn more about SAX exceptions later on. For now, keep in mind that
emit is a small method that handles the string output. (You’ll see it called a lot in
the code ahead.)
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Spacing the Output
Here is another bit of infrastructure we need before doing some real processing.
Add the code highlighted below to define a nl() method that writes the kind of
line-ending character used by the current system:

private void emit(String s)
...

}

private void nl()
throws SAXException
{

String lineEnd = System.getProperty("line.separator");
try {

out.write(lineEnd);
} catch (IOException e) {

throw new SAXException("I/O error", e);
}

}

Note: Although it seems like a bit of a nuisance, you will be invoking nl() many
times in the code ahead. Defining it now will simplify the code later on. It also pro-
vides a place to indent the output when we get to that section of the tutorial.

Handling Content Events
Finally, let’s write some code that actually processes the ContentHandler

events.

Document Events
Add the code highlighted below to handle the start-document and end-document
events:

static private Writer out;

public void startDocument()
throws SAXException
{

emit("<?xml version='1.0' encoding='UTF-8'?>");
nl();
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}

public void endDocument()
throws SAXException
{

try {
nl();
out.flush();

} catch (IOException e) {
throw new SAXException("I/O error", e);

}
}

private void echoText()
...

Here, you are echoing an XML declaration when the parser encounters the start
of the document. Since you set up the OutputStreamWriter using the UTF-8
encoding, you include that specification as part of the declaration.

Note: However, the IO classes don’t understand the hyphenated encoding names,
so you specified “UTF8” rather than “UTF-8”.

At the end of the document, you simply put out a final newline and flush the out-
put stream. Not much going on there.

Element Events
Now for the interesting stuff. Add the code highlighted below to process the
start-element and end-element events:

public void startElement(String namespaceURI,
String sName, // simple name
String qName, // qualified name
Attributes attrs)

throws SAXException
{

String eName = sName; // element name
if ("".equals(eName)) eName = qName; // not namespaceAware
emit("<"+eName);
if (attrs != null) {

for (int i = 0; i < attrs.getLength(); i++) {
String aName = attrs.getLocalName(i); // Attr name
if ("".equals(aName)) aName = attrs.getQName(i);
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emit(" ");
emit(aName+"=\""+attrs.getValue(i)+"\"");

}
}
emit(">");

}

public void endElement(String namespaceURI,
String sName, // simple name
String qName  // qualified name
)

throws SAXException
{

String eName = sName; // element name
if ("".equals(eName)) eName = qName; // not namespaceAware
emit("<"+eName+">");

}

private void emit(String s)
...

With this code, you echoed the element tags, including any attributes defined in
the start tag. Note that when the startElement() method is invoked, the simple
name (“local name”) for elements and attributes could turn out to be the empty
string, if namespace processing was not enabled. The code handles that case by
using the qualified name whenever the simple name is the empty string.

Character Events
To finish handling the content events, you need to handle the characters that the
parser delivers to your application.

Parsers are not required to return any particular number of characters at one
time. A parser can return anything from a single character at a time up to several
thousand, and still be standard-conforming implementation. So, if your applica-
tion needs to process the characters it sees, it is wise to accumulate the characters
in a buffer, and operate on them only when you are sure they have all been found.
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Add the line highlighted below to define the text buffer:

public class Echo01 extends DefaultHandler
{

StringBuffer textBuffer;

public static void main(String argv[])
{

...

Then add the code highlighted below to accumulate the characters the parser
delivers in the buffer:

public void endElement(...)
throws SAXException
{

...
}

public void characters(char buf[], int offset, int len)
throws SAXException
{

String s = new String(buf, offset, len);
if (textBuffer == null) {

textBuffer = new StringBuffer(s);
} else {

textBuffer.append(s);
}

}

private void emit(String s)
...

Next, add this method highlighted below to send the contents of the buffer to the
output stream.

public void characters(char buf[], int offset, int len)
throws SAXException
{

...
}

private void echoText()
throws SAXException
{

if (textBuffer == null) return;
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String s = ""+textBuffer;
emit(s);
textBuffer = null;

}

private void emit(String s)
...

When this method is called twice in a row (which will happens at times, as we’ll
see next), the buffer will be null. So in that case, the method simply returns.
When the buffer is non-null, however, it’s contents are sent to the output stream.

Finally, add the code highlighted below to echo the contents of the buffer when-
ever an element starts or ends:

public void startElement(...)
throws SAXException
{

echoText();
String eName = sName; // element name
...

}

public void endElement(...)
throws SAXException
{

echoText();
String eName = sName; // element name
...

}

You’re done accumulating text when an element ends, of course. So you echo it
at that point, which clears the buffer before the next element starts.

But you also want to echo the accumulated text when an element starts! That’s
necessary for document-style data, which can contain XML elements that are
intermixed with text. For example, in this document fragment:

<para>This paragraph contains <bold>important</bold>
ideas.</para>

The initial text, “This paragraph contains” is terminated by the start of the
<bold> element. The text, “important” is terminated by the end tag, </bold>,
and the final text, “ideas.”, is terminated by the end tag, </para>.
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Note: Most of the time, though, the accumulated text will be echoed when an
endElement() event occurs. When a startElement() event occurs after that, the
buffer will be empty. The first line in the echoText() method checks for that case,
and simply returns.

Congratulations! At this point you have written a complete SAX parser applica-
tion. The next step is to compile and run it.

Note: To be strictly accurate, the character handler should scan the buffer for
ampersand characters ('&');and left-angle bracket characters ('<') and replace them
with the strings “&amp;” or “&lt;”, as appropriate. You’ll find out more about that
kind of processing when we discuss entity references in Displaying Special Char-
acters and CDATA (page 159).

Compiling and Running the Program
In the J2EE release, the JAXP libraries are in the directory
<J2EE_HOME>/share/lib/endorsed. These are newer versions of the standard
JAXP libraries that are part of the Java 2 platform.

The J2EE Application Server automatically uses the newer libraries when a pro-
gram runs. So you won’t have to be concerned with where they reside when you
deploy an application.

And since the JAXP APIs are identical in both versions, you won’t need to be
concerned at compile time either. So compiling the program you created is as
simple as issuing the command:

javac Echo.java

But to run the program outside of the server container, you need to make sure
that the java runtime finds the newer versions of the JAXP libraries. That situa-
tion can occur, for example, when unit-testing parts of your application outside
of the sever, as well as here, when running the XML tutorial examples.



140 SIMPLE API FOR XML
There are two ways to make sure that the program uses the latest version of the
JAXP libraries:

• Copy the <J2EE_HOME>/share/lib/endorsed diretory directory to
<J2EE_HOME>jdk/jre/lib/endorsed. You can then run the program with
this command:

<J2EE_HOME>/jdk/bin/java Echo slideSample.xml

The libraries will then be found in the endorsed standards directory,
<J2EE_HOME>/jdk/jre/lib/endorsed.

• Use the endorsed directories system property to specify the location of the
libraries, by specifying this option on the java command line: -

D”java.endorsed.dirs=<J2EE_HOME>/share/lib/endorsed”

Note: Since the JAXP APIs are already built into the Java 2 platform, they don’t
need to be specified at compile time. (In fact, the -D option is not even allowed at
compile time, because endorsed standards are required to maintain consistent
APIs.) However, when the JAXP factories instantiate an implementation, the
endorsed directories mechanism is employed to make sure that the desired imple-
mentation is instantiated.

Checking the Output
Here is part of the program’s output, showing some of its weird spacing:

...
<slideshow title="Sample Slide Show" date="Date of publication"
author="Yours Truly">

<slide type="all">
<title>Wake up to WonderWidgets!</title>

</slide>
...

Note: The program’s output is contained in Echo01-01.txt. (The browsable ver-
sion is Echo01-01.html.)

../examples/jaxp/sax/samples/Echo01-01.txt
../examples/jaxp/sax/samples/Echo01-01.html
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Looking at this output, a number of questions arise. Namely, where is the excess
vertical whitespace coming from? And why is it that the elements are indented
properly, when the code isn’t doing it? We’ll answer those questions in a
moment. First, though, there are a few points to note about the output:

• The comment defined at the top of the file

  <!-- A SAMPLE set of slides -->

does not appear in the listing. Comments are ignored, unless you implement
a LexicalHandler. You’ll see more about that later on in this tutorial.

• Element attributes are listed all together on a single line. If your window
isn’t really wide, you won’t see them all.

• The single-tag empty element you defined (<item/>) is treated exactly the
same as a two-tag empty element (<item></item>). It is, for all intents and
purposes, identical. (It’s just easier to type and consumes less space.)

Identifying the Events
This version of the echo program might be useful for displaying an XML file,
but it’s not telling you much about what’s going on in the parser. The next step is
to modify the program so that you see where the spaces and vertical lines are
coming from.

Note: The code discussed in this section is in Echo02.java. The output it produces
is shown in Echo02-01.txt. (The browsable version is Echo02-01.html)

 Make the changes highlighted below to identify the events as they occur:

public void startDocument()
throws SAXException
{

nl();
nl();
emit("START DOCUMENT");
nl();
emit("<?xml version='1.0' encoding='UTF-8'?>");
nl();

}

public void endDocument()

../examples/jaxp/sax/samples/Echo02.java
../examples/jaxp/sax/samples/Echo02-01.txt
../examples/jaxp/sax/samples/Echo02-01.html
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throws SAXException
{

nl();
emit("END DOCUMENT");
try {
...

}

public void startElement(...)
throws SAXException
{

echoText();
nl();
emit("ELEMENT: ");
String eName = sName; // element name
if ("".equals(eName)) eName = qName; // not namespaceAware
emit("<"+eName);
if (attrs != null) {

for (int i = 0; i < attrs.getLength(); i++) {
String aName = attrs.getLocalName(i); // Attr name
if ("".equals(aName)) aName = attrs.getQName(i);
emit(" ");
emit(aName+"=\""+attrs.getValue(i)+"\"");
nl();
emit("   ATTR: ");
emit(aName);
emit("\t\"");
emit(attrs.getValue(i));
emit("\"");

}
}
if (attrs.getLength() > 0) nl();
emit(">");

}

public void endElement(...)
throws SAXException
{

echoText();
nl();
emit("END_ELM: ");
String eName = sName; // element name
if ("".equals(eName)) eName = qName; // not namespaceAware
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emit("<"+eName+">");
}

...

private void echoText()
throws SAXException
{

if (textBuffer == null) return;
nl();
emit("CHARS: |");
String s = ""+textBuffer;
emit(s);
emit("|");
textBuffer = null;

}

Compile and run this version of the program to produce a more informative out-
put listing. The attributes are now shown one per line, which is nice. But, more
importantly, output lines like this one:

  CHARS: |

|

show that both the indentation space and the newlines that separate the attributes
come from the data that the parser passes to the characters() method.

Note: The XML specification requires all input line separators to be normalized to
a single newline. The newline character is specified as in Java, C, and UNIX sys-
tems, but goes by the alias “linefeed” in Windows systems.

Compressing the Output
To make the output more readable, modify the program so that it only outputs
characters containing something other than whitespace.

Note: The code discussed in this section is in Echo03.java.

../examples/jaxp/sax/samples/Echo03.java
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Make the changes shown below to suppress output of characters that are all
whitespace:

public void echoText()
throws SAXException
{

nl();
emit("CHARS: |");
emit("CHARS:   ");
String s = ""+textBuffer;
if (!s.trim().equals("")) emit(s);
emit("|");

}

Next, add the code highlighted below to echo each set of characters delivered by
the parser:

public void characters(char buf[], int offset, int len)
throws SAXException
{

if (textBuffer != null) {
echoText();
textBuffer = null;

}
String s = new String(buf, offset, len);
...

}

If you run the program now, you will see that you have eliminated the indenta-
tion as well, because the indent space is part of the whitespace that precedes the
start of an element. Add the code highlighted below to manage the indentation:

static private Writer out;

private String indentString = "    "; // Amount to indent
private int indentLevel = 0;

...

public void startElement(...)
throws SAXException
{

indentLevel++;
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nl();
emit("ELEMENT: ");
...

}

public void endElement(...)
throws SAXException
{

nl();
emit("END_ELM: ");
emit("</"+sName+">");
indentLevel--;

}
...
private void nl()
throws SAXException
{

...
try {

out.write(lineEnd);
for (int i=0; i < indentLevel; i++)

out.write(indentString);
} catch (IOException e) {
...

}

This code sets up an indent string, keeps track of the current indent level, and
outputs the indent string whenever the nl method is called. If you set the indent
string to "", the output will be un-indented (Try it. You’ll see why it’s worth the
work to add the indentation.)

You’ll be happy to know that you have reached the end of the “mechanical” code
you have to add to the Echo program. From here on, you’ll be doing things that
give you more insight into how the parser works. The steps you’ve taken so far,
though, have given you a lot of insight into how the parser sees the XML data it
processes. It’s also given you a helpful debugging tool you can use to see what
the parser sees.



146 SIMPLE API FOR XML
Inspecting the Output
There is part of the output from this version of the program:

ELEMENT: <slideshow
...
>
CHARS:
CHARS:

ELEMENT: <slide
...
END_ELM: </slide>

CHARS:
CHARS:

Note: The complete output is Echo03-01.txt. (The browsable version is
Echo03-01.html)

Note that the characters method was invoked twice in a row. Inspecting the
source file slideSample01.xml shows that there is a comment before the first
slide. The first call to characters comes before that comment. The second call
comes after. (Later on, you’ll see how to be notified when the parser encounters a
comment, although in most cases you won’t need such notifications.)

Note, too, that the characters method is invoked after the first slide element, as
well as before. When you are thinking in terms of hierarchically structured data,
that seems odd. After all, you intended for the slideshow element to contain
slide elements, not text. Later on, you’ll see how to restrict the slideshow ele-
ment using a DTD. When you do that, the characters method will no longer be
invoked.

In the absence of a DTD, though, the parser must assume that any element it sees
contains text like that in the first item element of the overview slide:

<item>Why <em>WonderWidgets</em> are great</item>

../examples/xml/samples/slideSample01.xml
../examples/jaxp/sax/samples/Echo03-01.txt
../examples/jaxp/sax/samples/Echo03-01.html
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Here, the hierarchical structure looks like this:

ELEMENT: <item>
CHARS: Why

ELEMENT: <em>
CHARS: WonderWidgets
END_ELM: </em>

CHARS: are great
END_ELM: </item>

Documents and Data
In this example, it’s clear that there are characters intermixed with the hierarchi-
cal structure of the elements. The fact that text can surround elements (or be pre-
vented from doing so with a DTD or schema) helps to explain why you
sometimes hear talk about “XML data” and other times hear about “XML docu-
ments”. XML comfortably handles both structured data and text documents that
include markup. The only difference between the two is whether or not text is
allowed between the elements.

Note: In an upcoming section of this tutorial, you will work with the ignorable-

Whitespace method in the ContentHandler interface. This method can only be
invoked when a DTD is present. If a DTD specifies that slideshow does not contain
text, then all of the whitespace surrounding the slide elements is by definition
ignorable. On the other hand, if slideshow can contain text (which must be
assumed to be true in the absence of a DTD), then the parser must assume that
spaces and lines it sees between the slide elements are significant parts of the doc-
ument.

Adding Additional Event Handlers
Besides ignorableWhitespace, there are two other ContentHandler methods
that can find uses in even simple applications: setDocumentLocator and pro-

cessingInstruction. In this section of the tutorial, you’ll implement those two
event handlers.
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Identifying the Document’s Location
A locator is an object that contains the information necessary to find the docu-
ment. The Locator class encapsulates a system ID (URL) or a public identifier
(URN), or both. You would need that information if you wanted to find some-
thing relative to the current document—in the same way, for example, that an
HTML browser processes an href="anotherFile" attribute in an anchor tag—
the browser uses the location of the current document to find anotherFile.

You could also use the locator to print out good diagnostic messages. In addition
to the document’s location and public identifier, the locator contains methods
that give the column and line number of the most recently-processed event. The
setDocumentLocator method is called only once at the beginning of the parse,
though. To get the current line or column number, you would save the locator
when setDocumentLocator is invoked and then use it in the other event-han-
dling methods.

Note: The code discussed in this section is in Echo04.java. Its output is in Echo04-

01.txt. (The browsable version is Echo04-01.html.)

Start by removing the extra character-echoing code you added for the last exam-
ple:

public void characters(char buf[], int offset, int len)
throws SAXException
{

if (textBuffer != null) {
echoText();
textBuffer = null;

}
String s = new String(buf, offset, len);
...

}

../examples/jaxp/sax/samples/Echo04.java
../examples/jaxp/sax/samples/Echo04-01.txt
../examples/jaxp/sax/samples/Echo04-01.txt
../examples/jaxp/sax/samples/Echo04-01.html
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Next. add the method highlighted below to the Echo program to get the docu-
ment locator and use it to echo the document’s system ID.

...
private String indentString = "    "; // Amount to indent
private int indentLevel = 0;

public void setDocumentLocator(Locator l)
{

try {
out.write("LOCATOR");
out.write("SYS ID: " + l.getSystemId() );
out.flush();

} catch (IOException e) {
// Ignore errors

}
}

public void startDocument()
...

Notes:

• This method, in contrast to every other ContentHandler method, does not
return a SAXException. So, rather than using emit for output, this code
writes directly to System.out. (This method is generally expected to sim-
ply save the Locator for later use, rather than do the kind of processing
that generates an exception, as here.)

• The spelling of these methods is “Id”, not “ID”. So you have getSystemId
and getPublicId.

When you compile and run the program on slideSample01.xml, here is the sig-
nificant part of the output:

LOCATOR
SYS ID: file:<path>/../samples/slideSample01.xml

START DOCUMENT
<?xml version='1.0' encoding='UTF-8'?>
...

Here, it is apparent that setDocumentLocator is called before startDocument.
That can make a difference if you do any initialization in the event handling
code.
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Handling Processing Instructions
It sometimes makes sense to code application-specific processing instructions in
the XML data. In this exercise, you’ll modify the Echo program to display a pro-
cessing instruction contained in slideSample02.xml.

Note: The code discussed in this section is in Echo05.java. The file it operates on
is slideSample02.xml, as described in Writing Processing Instructions (page 50). The
output is in Echo05-02.txt. (The browsable versions are slideSample02-

xml.html and Echo05-02.html.)

As you saw in Writing Processing Instructions (page 50), the format for a pro-
cessing instruction is <?target data?>, where “target” is the target application
that is expected to do the processing, and “data” is the instruction or information
for it to process. The sample file slideSample02.xml contains a processing
instruction for a mythical slide presentation program that queries the user to find
out which slides to display (technical, executive-level, or all):

<slideshow
...
>

<!-- PROCESSING INSTRUCTION -->
<?my.presentation.Program QUERY="exec, tech, all"?>

<!-- TITLE SLIDE -->

../examples/jaxp/sax/samples/Echo05.java
../examples/xml/samples/slideSample02.xml
../examples/jaxp/sax/samples/Echo05-02.txt
../examples/xml/samples/slideSample02-xml.html
../examples/xml/samples/slideSample02-xml.html
../examples/jaxp/sax/samples/Echo05-02.html
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To display that processing instruction, add the code highlighted below to the
Echo app:

public void characters(char buf[], int offset, int len)
...
}

public void processingInstruction(String target, String data)
throws SAXException
{

nl();
emit("PROCESS: ");
emit("<?"+target+" "+data+"?>");

}

private void echoText()
...

When your edits are complete, compile and run the program. The relevant part of
the output should look like this:

ELEMENT: <slideshow
...

>
PROCESS: <?my.presentation.Program QUERY="exec, tech, all"?>
CHARS:
...

Summary
With the minor exception of ignorableWhitespace, you have used most of the
ContentHandler methods that you need to handle the most commonly useful
SAX events. You’ll see ignorableWhitespace a little later on. Next, though,
you’ll get deeper insight into how you handle errors in the SAX parsing process.

Handling Errors with the Nonvalidating
Parser

The parser can generate one of three kinds of errors: fatal error, error, and warn-
ing. In this exercise, you’ll how the parser handles a fatal error.
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This version of the Echo program uses the nonvalidating parser. So it can’t tell if
the XML document contains the right tags, or if those tags are in the right
sequence. In other words, it can’t tell you if the document is valid. It can, how-
ever, tell whether or not the document is well-formed.

In this section of the tutorial, you’ll modify the slideshow file to generate differ-
ent kinds of errors and see how the parser handles them. You’ll also find out
which error conditions are ignored, by default, and see how to handle them.

Note: The XML file used in this exercise is slideSampleBad1.xml, as described in
Introducing an Error (page 52). The output is in Echo05-Bad1.txt. (The browsable
versions are slideSampleBad1-xml.html and Echo05-Bad1.html.)

When you created slideSampleBad1.xml, you deliberately created an XML file
that was not well-formed. Run the Echo program on that file now. The output
now gives you an error message that looks like this (after formatting for readabil-
ity):

org.xml.sax.SAXParseException:
The element type "item" must be terminated by the
matching end-tag “</item>”.

...
at org.apache.xerces.parsers.AbstractSAXParser...
...
at Echo.main(...)

Note: The message above was generated by the JAXP 1.2 libraries. If you are using
a different parser, the error message is likely to be somewhat different.

When a fatal error occurs, the parser is unable to continue. So, if the application
does not generate an exception (which you’ll see how to do a moment), then the
default error-event handler generates one. The stack trace is generated by the
Throwable exception handler in your main method:

    ...
} catch (Throwable t) {

t.printStackTrace();
}

That stack trace is not too useful, though. Next, you’ll see how to generate better
diagnostics when an error occurs.

../examples/xml/samples/slideSampleBad1.xml
../examples/xml/samples/slideSampleBad1-xml.html
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Handling a SAXParseException
When the error was encountered, the parser generated a SAXParseException—a
subclass of SAXException that identifies the file and location where the error
occurred.

Note: The code you’ll create in this exercise is in Echo06.java. The output is in
Echo06-Bad1.txt. (The browsable version is Echo06-Bad1.html.)

Add the code highlighted below to generate a better diagnostic message when
the exception occurs:

...
} catch (SAXParseException spe) {

// Error generated by the parser
System.out.println("\n** Parsing error"

+ ", line " + spe.getLineNumber()
+ ", uri " + spe.getSystemId());

System.out.println("   " + spe.getMessage() );

} catch (Throwable t) {
t.printStackTrace();

}

Running this version of the program on slideSampleBad1.xml generates an
error message which is a bit more helpful, like this:

** Parsing error, line 22, uri file:<path>/slideSampleBad1.xml
The element type "item" must be ...

Note: The text of the error message depends on the parser used. This message was
generated using JAXP 1.2.

Note: Catching all throwables like this is not generally a great idea for production
applications. We’re doing it now so we can build up to full error handling gradually.
In addition, it acts as a catch-all for null pointer exceptions that can be thrown when
the parser is passed a null value.

../examples/jaxp/sax/samples/Echo06.java
../examples/jaxp/sax/samples/Echo06-Bad1.txt
../examples/jaxp/sax/samples/Echo06-Bad1.html
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Handling a SAXException
A more general SAXException instance may sometimes be generated by the
parser, but it more frequently occurs when an error originates in one of applica-
tion’s event handling methods. For example, the signature of the startDocument
method in the ContentHandler interface is defined as returning a SAXExcep-

tion:

public void startDocument() throws SAXException

All of the ContentHandler methods (except for setDocumentLocator) have
that signature declaration.

A SAXException can be constructed using a message, another exception, or
both. So, for example, when Echo.startDocument outputs a string using the
emit method, any I/O exception that occurs is wrapped in a SAXException and
sent back to the parser:

private void emit(String s)
throws SAXException
{

try {
out.write(s);
out.flush();

} catch (IOException e) {
throw new SAXException("I/O error", e);

}
}

Note: If you saved the Locator object when setDocumentLocator was invoked,
you could use it to generate a SAXParseException, identifying the document and
location, instead of generating a SAXException.

When the parser delivers the exception back to the code that invoked the parser,
it makes sense to use the original exception to generate the stack trace. Add the
code highlighted below to do that:

   ...
} catch (SAXParseException err) {

System.out.println("\n** Parsing error"
+ ", line " + err.getLineNumber()
+ ", uri " + err.getSystemId());

System.out.println("   " + err.getMessage());
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} catch (SAXException sxe) {
// Error generated by this application
// (or a parser-initialization error)
Exception  x = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

} catch (Throwable t) {
t.printStackTrace();

}

This code tests to see if the SAXException is wrapping another exception. If so,
it generates a stack trace originating from where that exception occurred to make
it easier to pinpoint the code responsible for the error. If the exception contains
only a message, the code prints the stack trace starting from the location where
the exception was generated.

Improving the SAXParseException Handler
Since the SAXParseException can also wrap another exception, add the code
highlighted below to use the contained exception for the stack trace:

    ...
} catch (SAXParseException err) {

System.out.println("\n** Parsing error"
+ ", line " + err.getLineNumber()
+ ", uri " + err.getSystemId());

System.out.println("   " + err.getMessage());

// Use the contained exception, if any
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Exception  x = spe;
if (spe.getException() != null)

x = spe.getException();
x.printStackTrace();

} catch (SAXException sxe) {
// Error generated by this application
// (or a parser-initialization error)
Exceptionx = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

} catch (Throwable t) {
t.printStackTrace();

}

The program is now ready to handle any SAX parsing exceptions it sees. You’ve
seen that the parser generates exceptions for fatal errors. But for nonfatal errors
and warnings, exceptions are never generated by the default error handler, and
no messages are displayed. In a moment, you’ll learn more about errors and
warnings and find out how to supply an error handler to process them.

Handling a ParserConfigurationException
Finally, recall that the SAXParserFactory class could throw an exception if it
were for unable to create a parser. Such an error might occur if the factory could
not find the class needed to create the parser (class not found error), was not per-
mitted to access it (illegal access exception), or could not instantiate it (instantia-
tion error).

Add the code highlighted below to handle such errors:

} catch (SAXException sxe) {
Exceptionx = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

} catch (ParserConfigurationException pce) {
// Parser with specified options can't be built
pce.printStackTrace();

} catch (Throwable t) {
t.printStackTrace();
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Admittedly, there are quite a few error handlers here. But at least now you know
the kinds of exceptions that can occur.

Note: A javax.xml.parsers.FactoryConfigurationError could also be thrown
if the factory class specified by the system property cannot be found or instantiated.
That is a non-trappable error, since the program is not expected to be able to recover
from it.

Handling an IOException
Finally, while we’re at it, let’s add a handler for IOExceptions:

} catch (ParserConfigurationException pce) {
// Parser with specified options can't be built
pce.printStackTrace();

} catch (IOException ioe) {
// I/O error
ioe.printStackTrace();

}

} catch (Throwable t) {
...

We’ll leave the handler for Throwables to catch null pointer errors, but note that
at this point it is doing the same thing as the IOException handler. Here, we’re
merely illustrating the kinds of exceptions that can occur, in case there are some
that your application could recover from.

Handling NonFatal Errors
A nonfatal error occurs when an XML document fails a validity constraint. If the
parser finds that the document is not valid, then an error event is generated. Such
errors are generated by a validating parser, given a DTD or schema, when a doc-
ument has an invalid tag, or a tag is found where it is not allowed, or (in the case
of a schema) if the element contains invalid data.

You won’t actually dealing with validation issues until later in this tutorial. But
since we’re on the subject of error handling, you’ll write the error-handling code
now.
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The most important principle to understand about non-fatal errors is that they are
ignored, by default.

But if a validation error occurs in a document, you probably don’t want to con-
tinue processing it. You probably want to treat such errors as fatal. In the code
you write next, you’ll set up the error handler to do just that.

Note: The code for the program you’ll create in this exercise is in Echo07.java.

To take over error handling, you override the DefaultHandler methods that
handle fatal errors, nonfatal errors, and warnings as part of the ErrorHandler

interface. The SAX parser delivers a SAXParseException to each of these meth-
ods, so generating an exception when an error occurs is as simple as throwing it
back.

Add the code highlighted below to override the handler for errors:

public void processingInstruction(String target, String data)
throws SAXException
{

...
}

// treat validation errors as fatal
public void error(SAXParseException e)
throws SAXParseException
{

throw e;
}

Note: It can be instructive to examine the error-handling methods defined in
org.xml.sax.helpers.DefaultHandler. You’ll see that the error() and warn-

ing() methods do nothing, while fatalError() throws an exception. Of course,
you could always override the fatalError() method to throw a different exception.
But if your code doesn’t throw an exception when a fatal error occurs, then the SAX
parser will — the XML specification requires it.

Handling Warnings
Warnings, too, are ignored by default. Warnings are informative, and require a
DTD. For example, if an element is defined twice in a DTD, a warning is gener-

../examples/jaxp/sax/samples/Echo07.java
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ated—it’s not illegal, and it doesn’t cause problems, but it’s something you
might like to know about since it might not have been intentional.

Add the code highlighted below to generate a message when a warning occurs:

// treat validation errors as fatal
public void error(SAXParseException e)
throws SAXParseException
{

throw e;
}

// dump warnings too
public void warning(SAXParseException err)
throws SAXParseException
{

System.out.println("** Warning"
+ ", line " + err.getLineNumber()
+ ", uri " + err.getSystemId());

System.out.println("   " + err.getMessage());
}

Since there is no good way to generate a warning without a DTD or schema, you
won’t be seeing any just yet. But when one does occur, you’re ready!

Displaying Special Characters and
CDATA

The next thing we want to do with the parser is to customize it a bit, so you can
see how to get information it usually ignores. In this section, you’ll learn how the
parser handles:

• Special Characters ("<", “&”, and so on)

• Text with XML-style syntax

Handling Special Characters
In XML, an entity is an XML structure (or plain text) that has a name. Referenc-
ing the entity by name causes it to be inserted into the document in place of the
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entity reference. To create an entity reference, the entity name is surrounded by
an ampersand and a semicolon, like this:

  &entityName;

Earlier, you put an entity reference into your XML document by coding:

Market Size &lt; predicted

Note: The file containing this XML is slideSample03.xml, as described in Using
an Entity Reference in an XML Document (page 54). The results of processing it
are shown in Echo07-03.txt. (The browsable versions are slideSample03-

xml.html and Echo07-03.html.)

When you run the Echo program on slideSample03.xml, you see the following
output:

ELEMENT: <item>
CHARS: Market Size < predicted
END_ELM: </item>

The parser converted the reference into the entity it represents, and passed the
entity to the application.

Handling Text with XML-Style Syntax
When you are handling large blocks of XML or HTML that include many of the
special characters, you use a CDATA section.

Note: The XML file used in this example is slideSample04.xml, as described in
Handling Text with XML-Style Syntax (page 160). The results of processing it are
shown in Echo07-04.txt. (The browsable versions are slideSample04-xml.html

and Echo07-04.html.)

A CDATA section works like <pre>...</pre> in HTML, only more so—all
whitespace in a CDATA section is significant, and characters in it are not inter-
preted as XML. A CDATA section starts with <![CDATA[ and ends with ]]>. The

../examples/xml/samples/slideSample03.xml
../examples/jaxp/sax/samples/Echo07-03.txt
../examples/xml/samples/slideSample03-xml.html
../examples/xml/samples/slideSample03-xml.html
../examples/jaxp/sax/samples/Echo07-03.html
../examples/xml/samples/slideSample04.xml
../examples/jaxp/sax/samples/Echo07-04.txt
../examples/xml/samples/slideSample04-xml.html
../examples/jaxp/sax/samples/Echo07-04.html
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file slideSample04.xml contains this a CDATA section for a fictitious technical
slide:

 ...
<slide type="tech">

<title>How it Works</title>
<item>First we fozzle the frobmorten</item>
<item>Then we framboze the staten</item>
<item>Finally, we frenzle the fuznaten</item>
<item><![CDATA[Diagram:

frobmorten <--------------- fuznaten
 |  <3> ^
 | <1> | <1> = fozzle
 V | <2> = framboze

 Staten-------------------------+<3> = frenzle
 <2>

]]></item>
</slide>

</slideshow>

When you run the Echo program on the new file, you see the following output:

ELEMENT: <item>
CHARS:   Diagram:

frobmorten <--------------fuznaten
| <3>  ^

 | <1> |   <1> = fozzle
V |   <2> = framboze

staten---------------------+   <3> = frenzle
<2>

END_ELM: </item>

You can see here that the text in the CDATA section arrived as it was written. Since
the parser didn’t treat the angle brackets as XML, they didn’t generate the fatal
errors they would otherwise cause. (Because, if the angle brackets weren’t in a
CDATA section, the document would not be well-formed.)

Handling CDATA and Other Characters
The existence of CDATA makes the proper echoing of XML a bit tricky. If the
text to be output is not in a CDATA section, then any angle brackets, amper-
sands, and other special characters in the text should be replaced with the appro-
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priate entity reference. (Replacing left angle brackets and ampersands is most
important, other characters will be interpreted properly without misleading the
parser.)

But if the output text is in a CDATA section, then the substitutions should not
occur, to produce text like that in the example above. In a simple program like
our Echo application, it’s not a big deal. But many XML-filtering applications
will want to keep track of whether the text appears in a CDATA section, in order
to treat special characters properly. (Later in this tutorial, you will see how to use
a LexicalHandler to find out whether or not you are processing a CDATA sec-
tion.)

One other area to watch for is attributes. The text of an attribute value could also
contain angle brackets and semicolons that need to be replaced by entity refer-
ences. (Attribute text can never be in a CDATA section, though, so there is never
any question about doing that substitution.)

Parsing with a DTD
After the XML declaration, the document prolog can include a DTD, or refer-
ence an external DTD, or both. In this section, you’ll see the effect of the DTD
on the data that the parser delivers to your application.

DTD’s Effect on the Nonvalidating Parser
In this section, you’ll use the Echo program to see how the data appears to the
SAX parser when the data file references a DTD.

Note: The XML file used in this section is slideSample05.xml, which references
slideshow1a.dtd, as described in Parsing with a DTD (page 162). The output is
shown in Echo07-05.txt. (The browsable versions are slideshow1a-dtd.html,
slideSample05-xml.html, and Echo07-05.html.)

Running the Echo program on your latest version of slideSample.xml shows
that many of the superfluous calls to the characters method have now disap-
peared.

../examples/xml/samples/slideSample05.xml
../examples/xml/samples/slideshow1a.dtd
../examples/xml/samples/slideshow1a-dtd.html
../examples/xml/samples/slideSample05-xml.html
../examples/jaxp/sax/samples/Echo07-05.txt
../examples/jaxp/sax/samples/Echo07-05.html
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Where before you saw:

...
>
PROCESS: ...
CHARS:

ELEMENT: <slide
ATTR: ...

>
ELEMENT: <title>
CHARS: Wake up to ...
END_ELM: </title>

END_ELM: </slide>
CHARS:

ELEMENT: <slide
ATTR: ...

>
...

Now you see:

...
>
PROCESS: ...

ELEMENT: <slide
ATTR: ...

>
ELEMENT: <title>
CHARS: Wake up to ...
END_ELM: </title>

END_ELM: </slide>
ELEMENT: <slide

ATTR: ...
>
...

It is evident here that the whitespace characters which were formerly being ech-
oed around the slide elements are no longer being delivered by the parser,
because the DTD declares that slideshow consists solely of slide elements:

  <!ELEMENT slideshow (slide+)>
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Tracking Ignorable Whitespace
Now that the DTD is present, the parser is no longer calling the characters

method with whitespace that it knows to be irrelevant. From the standpoint of an
application that is only interested in processing the XML data, that is great. The
application is never bothered with whitespace that exists purely to make the
XML file readable.

On the other hand, if you were writing an application that was filtering an XML
data file, and you wanted to output an equally readable version of the file, then
that whitespace would no longer be irrelevant—it would be essential. To get
those characters, you need to add the ignorableWhitespace method to your
application. You’ll do that next.

Note: The code written in this section is contained in Echo08.java. The output is
in Echo08-05.txt. (The browsable version is Echo08-05.html.)

To process the (generally) ignorable whitespace that the parser is seeing, add the
code highlighted below to implement the ignorableWhitespace event handler
in your version of the Echo program:

public void characters (char buf[], int offset, int len)
...
}

public void ignorableWhitespace char buf[], int offset, int Len)
throws SAXException
{

nl();
emit("IGNORABLE");

}

public void processingInstruction(String target, String data)
...

This code simply generates a message to let you know that ignorable whitespace
was seen.

Note: Again, not all parsers are created equal. The SAX specification does not
require this method to be invoked. The Java XML implementation does so when-
ever the DTD makes it possible.

../examples/jaxp/sax/samples/Echo08.java
../examples/jaxp/sax/samples/Echo08-05.txt
../examples/jaxp/sax/samples/Echo08-05.html
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When you run the Echo application now, your output looks like this:

ELEMENT: <slideshow
ATTR: ...

>
IGNORABLE
IGNORABLE
PROCESS: ...
IGNORABLE
IGNORABLE

ELEMENT: <slide
ATTR: ...

>
IGNORABLE

ELEMENT: <title>
CHARS:   Wake up to ...
END_ELM: </title>

IGNORABLE
END_ELM: </slide>

IGNORABLE
IGNORABLE

ELEMENT: <slide
ATTR: ...

>
...

Here, it is apparent that the ignorableWhitespace is being invoked before and
after comments and slide elements, where characters was being invoked before
there was a DTD.

Cleanup
Now that you have seen ignorable whitespace echoed, remove that code from
your version of the Echo program—you won’t be needing it any more in the
exercises ahead.

Note: That change has been made in Echo09.java.

../examples/jaxp/sax/samples/Echo09.java
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Empty Elements, Revisited
Now that you understand how certain instances of whitespace can be ignorable,
it is time revise the definition of an “empty” element. That definition can now be
expanded to include

  <foo>   </foo>

where there is whitespace between the tags and the DTD says that whitespace as
ignorable.

Echoing Entity References
When you wrote slideSample06.xml, you defined entities for the product
name. Now it’s time to see how they’re echoed when you process them with the
SAX parser.

Note: The XML used here is contained in slideSample06.xml, which references
slideshow1b.dtd, as described in Defining Attributes and Entities in the
DTD (page 62). The output is shown in Echo09-06.txt. (The browsable versions
are slideSample06-xml.html, slideshow1b-dtd.html and Echo09-06.html.)

When you run the Echo program on slideSample06.xml, here is the kind of
thing you see:

ELEMENT: <title>
CHARS: Wake up to WonderWidgets!
END_ELM: </title>

Note that the product name has been substituted for the entity reference.

Echoing the External Entity
In slideSample07.xml, you defined an external entity to reference a copyright
file.

../examples/xml/samples/slideSample06.xml
../examples/xml/samples/slideshow1b.dtd
../examples/jaxp/sax/samples/Echo09-06.txt
../examples/xml/samples/slideSample06-xml.html
../examples/xml/samples/slideshow1b-dtd.html
../examples/jaxp/sax/samples/Echo09-06.html
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Note: The XML used here is contained in slideSample07.xml and in copy-

right.xml. The output is shown in Echo09-07.txt. (The browsable versions are
slideSample07-xml.html, copyright-xml.html and Echo09-07.html.)

When you run the Echo program on that version of the slide presentation, here is
what you see:

...
END_ELM: </slide>
ELEMENT: <slide

ATTR: type "all"
>

ELEMENT: <item>
CHARS:

This is the standard copyright message that our lawyers
make us put everywhere so we don't have to shell out a
million bucks every time someone spills hot coffee in their
lap...

END_ELM: </item>
END_ELM: </slide>
...

Note that the newline which follows the comment in the file is echoed as a char-
acter, but that the comment itself is ignored. That is the reason that the copyright
message appears to start on the next line after the CHARS: label, instead of imme-
diately after the label—the first character echoed is actually the newline that fol-
lows the comment.

Summarizing Entities
An entity that is referenced in the document content, whether internal or exter-
nal, is termed a general entity. An entity that contains DTD specifications that
are referenced from within the DTD is termed a parameter entity. (More on that
later.)

An entity which contains XML (text and markup), and which is therefore parsed,
is known as a parsed entity. An entity which contains binary data (like images) is
known as an unparsed entity. (By its very nature, it must be external.) We’ll be
discussing references to unparsed entities in the next section of this tutorial.

../examples/xml/samples/slideSample07.xml
../examples/jaxp/sax/samples/copyright.xml
../examples/jaxp/sax/samples/copyright.xml
../examples/jaxp/sax/samples/Echo09-07.txt
../examples/xml/samples/slideSample07-xml.html
../examples/jaxp/sax/samples/copyright-xml.html
../examples/jaxp/sax/samples/Echo09-07.html
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Choosing your Parser Implementation
If no other factory class is specified, the default SAXParserFactory class is
used. To use a different manufacturer’s parser, you can change the value of the
environment variable that points to it. You can do that from the command line,
like this:

java -Djavax.xml.parsers.SAXParserFactory=yourFactoryHere ...

The factory name you specify must be a fully qualified class name (all package
prefixes included). For more information, see the documentation in the newIn-

stance() method of the SAXParserFactory class.

Using the Validating Parser
By now, you have done a lot of experimenting with the nonvalidating parser. It’s
time to have a look at the validating parser and find out what happens when you
use it to parse the sample presentation.

Two things to understand about the validating parser at the outset are:

• A schema or Document Type Definition (DTD) is required.

• Since the schema/DTD is present, the ignorableWhitespace method is
invoked whenever possible.

Configuring the Factory
The first step is modify the Echo program so that it uses the validating parser
instead of the nonvalidating parser.

Note: The code in this section is contained in Echo10.java.

To use the validating parser, make the changes highlighted below:

public static void main(String argv[])
{

if (argv.length != 1) {
...

}

../examples/jaxp/sax/samples/Echo10.java
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// Use the default (non-validating) parser
// Use the validating parser
SAXParserFactory factory = SAXParserFactory.newInstance();
factory.setValidating(true);
try {

...

Here, you configured the factory so that it will produce a validating parser when
newSAXParser is invoked. You can also configure it to return a namespace-aware
parser using setNamespaceAware(true). Sun’s implementation supports any
combination of configuration options. (If a combination is not supported by any
particular implementation, it is required to generate a factory configuration
error.)

Validating with XML Schema
Although a full treatment of XML Schema is beyond the scope of this tutorial,
this section will show you the steps you need to take to validate an XML docu-
ment using an existing schema written in the XML Schema language. (To learn
more about XML Schema, you can review the online tutorial, XML Schema Part
0: Primer, at http://www.w3.org/TR/xmlschema-0/. You can also examine the
sample programs that are part of the JAXP download. They use a simple XML Schema
definition to validate personnel data stored in an XML file.)

Note: There are multiple schema-definition languages, including RELAX NG,
Schematron, and the W3C “XML Schema” standard. (Even a DTD qualifies as a
“schema”, although it is the only one that does not use XML syntax to describe
schema constraints.) However, “XML Schema” presents us with a terminology
challenge. While the phrase “XML Schema schema” would be precise, we’ll use the
phrase “XML Schema definition” to avoid the appearance of redundancy.

To be notified of validation errors in an XML document, the parser factory must
be configured to create a validating parser, as shown in the previous section. In
addition,

1. The appropriate properties must be set on the SAX parser.

2. The appropriate error handler must be set.

3. The document must be associated with a schema.

http://www.w3.org/TR/xmlschema-0/
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Setting the SAX Parser Properties
It’s helpful to start by defining the constants you’ll use when setting the proper-
ties:

static final String JAXP_SCHEMA_LANGUAGE =
"http://java.sun.com/xml/jaxp/properties/schemaLanguage";

static final String W3C_XML_SCHEMA =
"http://www.w3.org/2001/XMLSchema";

Next, you need to configure the parser factory to generate a parser that is
namespace-aware parser, as well as validating:

...
SAXParserFactory factory = SAXParserFactory.newInstance();
factory.setNamespaceAware(true);
factory.setValidating(true);

You’ll learn more about namespaces in Validating with XML
Schema (page 253). For now, understand that schema validation is a namespace-
oriented process. Since JAXP-compliant parsers are not namespace-aware by
default, it is necessary to set the property for schema validation to work.

The last step is to configure the parser to tell it which schema language to use.
Here, you will use the constants you defined earlier to specify the W3C’s XML
Schema language:

saxParser.setProperty(JAXP_SCHEMA_LANGUAGE, W3C_XML_SCHEMA);

In the process, however, there is an extra error to handle. You’ll take a look at
that error next.

Setting up the Appropriate Error Handling
In addition to the error handling you’ve already learned about, there is one error
that can occur when you are configuring the parser for schema-based validation.
If the parser is not 1.2 compliant, and therefore does not support XML Schema,
it could throw a SAXNotRecognizedException.
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To handle that case, you wrap the setProperty() statement in a try/catch
block, as shown in the code highlighted below.

...
SAXParser saxParser = factory.newSAXParser();
try {

saxParser.setProperty(JAXP_SCHEMA_LANGUAGE, W3C_XML_SCHEMA);
}
catch (SAXNotRecognizedException x) {

// Happens if the parser does not support JAXP 1.2
...

}
...

Associating a Document with A Schema
Now that the program is ready to validate the data using an XML Schema defini-
tion, it is only necessary to ensure that the XML document is associated with
one. There are two ways to do that:

• With a schema declaration in the XML document.

• By specifying the schema to use in the application.

Note: When the application specifies the schema to use, it overrides any schema
declaration in the document.

To specify the schema definition in the document, you would create XML like
this:

<documentRoot
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation='YourSchemaDefinition.xsd'

>
...

The first attribute defines the XML NameSpace (xmlns) prefix, “xsi”, where
“xsi” stands for “XML Schema Instance”. The second line specifies the schema
to use for elements in the document that do not have a namespace prefix — that
is, for the elements you typically define in any simple, uncomplicated XML doc-
ument.
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Note: You’ll be learning about namespaces in Validating with XML
Schema (page 253). For now, think of these attributes as the “magic incantation”
you use to validate a simple XML file that doesn’t use them. Once you’ve learned
more about namespaces, you’ll see how to use XML Schema to validate complex
documents that use them. Those ideas are discussed in Validating with Multiple
Namespaces (page 256).

You can also specify the schema file in the application, using code like this:

static final String JAXP_SCHEMA_SOURCE =
"http://java.sun.com/xml/jaxp/properties/schemaSource";

...
SAXParser saxParser = spf.newSAXParser();
...
saxParser.setProperty(JAXP_SCHEMA_SOURCE,

new File(schemaSource));

Now that you know how to make use of an XML Schema definition, we’ll turn
our attention to the kinds of errors you can see when the application is validating
its incoming data. To that, you’ll use a Document Type Definition (DTD) as you
experiment with validation.

Experimenting with Validation Errors
To see what happens when the XML document does not specify a DTD, remove
the DOCTYPE statement from the XML file and run the Echo program on it.

Note: The output shown here is contained in Echo10-01.txt. (The browsable ver-
sion is Echo10-01.html.)

The result you see looks like this:

<?xml version='1.0' encoding='UTF-8'?>
** Parsing error, line 9, uri .../slideSample01.xml

Document root element "slideshow", must match DOCTYPE root
"null"

../examples/jaxp/sax/samples/Echo10-01.txt
../examples/jaxp/sax/samples/Echo10-01.html
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Note: The message above was generated by the JAXP 1.2 libraries. If you are using
a different parser, the error message is likely to be somewhat different.

This message says that the root element of the document must match the element
specified in the DOCTYPE declaration. That declaration specifies the document’s
DTD. Since you don’t have one yet, it’s value is “null”. In other words, the mes-
sage is saying that you are trying to validate the document, but no DTD has been
declared, because no DOCTYPE declaration is present.

So now you know that a DTD is a requirement for a valid document. That makes
sense. What happens when you run the parser on your current version of the
slide presentation, with the DTD specified?

Note: The output shown here is produced using slideSample07.xml, as described
in Referencing Binary Entities (page 68). The output is contained in Echo10-

07.txt. (The browsable version is Echo10-07.html.)

This time, the parser gives a different error message:

  ** Parsing error, line 29, uri file:...
The content of element type "slide" must match

"(image?,title,item*)

Note: The message above was generated by the JAXP 1.2 libraries. If you are using
a different parser, the error message is likely to be somewhat different.

This message says that the element found at line 29 (<item>) does not match the
definition of the <slide> element in the DTD. The error occurs because the def-
inition says that the slide element requires a title. That element is not
optional, and the copyright slide does not have one. To fix the problem, add the
question mark highlighted below to make title an optional element:

<!ELEMENT slide (image?, title?, item*)>

Now what happens when you run the program?

../examples/xml/samples/slideSample07.xml
../examples/jaxp/sax/samples/Echo10-07.txt
../examples/jaxp/sax/samples/Echo10-07.txt
../examples/jaxp/sax/samples/Echo10-07.html
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Note: You could also remove the copyright slide, which produces the same result
shown below, as reflected in Echo10-06.txt. (The browsable version is Echo10-

06.html.)

The answer is that everything runs fine until the parser runs into the <em> tag
contained in the overview slide. Since that tag was not defined in the DTD, the
attempt to validate the document fails. The output looks like this:

  ...
ELEMENT: <title>
CHARS:   Overview
END_ELM: </title>
ELEMENT: <item>
CHARS:   Why ** Parsing error, line 28, uri: ...

Element "em" must be declared.
org.xml.sax.SAXParseException: ...
...

Note: The message above was generated by the JAXP 1.2 libraries. If you are using
a different parser, the error message is likely to be somewhat different.

The error message identifies the part of the DTD that caused validation to fail. In
this case it is the line that defines an item element as (#PCDATA | item).

Exercise: Make a copy of the file and remove all occurrences of <em> from
it. Can the file be validated now? (In the next section, you’ll learn how to
define parameter entries so that we can use XHTML in the elements we are
defining as part of the slide presentation.)

Error Handling in the Validating Parser
It is important to recognize that the only reason an exception is thrown when the
file fails validation is as a result of the error-handling code you entered in the
early stages of this tutorial. That code is reproduced below:

public void error(SAXParseException e)
throws SAXParseException
{

throw e;
}

../examples/jaxp/sax/samples/Echo10-06.txt
../examples/jaxp/sax/samples/Echo10-06.html
../examples/jaxp/sax/samples/Echo10-06.html
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If that exception is not thrown, the validation errors are simply ignored.

Exercise: Try commenting out the line that throws the exception. What hap-
pens when you run the parser now?

In general, a SAX parsing error is a validation error, although we have seen that
it can also be generated if the file specifies a version of XML that the parser is
not prepared to handle. The thing to remember is that your application will not
generate a validation exception unless you supply an error handler like the one
above.

Parsing a Parameterized DTD
This section uses the Echo program to see what happens when you reference
xhtml.dtd in slideshow2.dtd. It also covers the kinds of warnings that are
generated by the SAX parser when a DTD is present.

Note: The XML file used here is slideSample08.xml, which references
slideshow2.dtd. The output is contained in Echo10-08.txt. (The browsable ver-
sions are slideSample08-xml.html, slideshow2-dtd.html, and Echo10-

08.html.)

When you try to echo the slide presentation, you find that it now contains a new
error. The relevant part of the output is shown here (formatted for readability):

<?xml version='1.0' encoding='UTF-8'?>
** Parsing error, line 22, uri: .../slideshow.dtd
Element type "title" must not be declared more than once.

Note: The message above was generated by the JAXP 1.2 libraries. If you are using
a different parser, the error message is likely to be somewhat different.

The problem is that xhtml.dtd defines a title element which is entirely differ-
ent from the title element defined in the slideshow DTD. Because there is no
hierarchy in the DTD, these two definitions conflict.

The slideSample09.xml version solves the problem by changing the name of
the slide title. Run the Echo program on that version of the slide presentation. It
should run to completion and display output like that shown in Echo10-09.

../examples/xml/samples/slideshow2.dtd
../examples/xml/samples/slideSample08.xml
../examples/xml/samples/slideshow2-dtd.html
../examples/xml/samples/slideSample08-xml.html
../examples/jaxp/sax/samples/Echo10-08.txt
../examples/jaxp/sax/samples/Echo10-08.html
../examples/jaxp/sax/samples/Echo10-08.html
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Congratulations! You have now read a fully validated XML document. The
change in that version of the file had the effect of putting the DTD’s title ele-
ment into a slideshow “namespace” that you artificially constructed by hyphen-
ating the name, so the title element in the “slideshow namespace” (slide-
title, really) was no longer in conflict with the title element in xhtml.dtd.

Note: As mentioned in Using Namespaces (page 75), namespaces let you accom-
plish the same goal without having to rename any elements.

To finish off this section, we’ll take a look at the kinds of warnings that the vali-
dating parser can produce when processing the DTD.

DTD Warnings
As mentioned earlier in this tutorial, warnings are generated only when the SAX
parser is processing a DTD. Some warnings are generated only by the validating
parser. The nonvalidating parser’s main goal is operate as rapidly as possible, but
it too generates some warnings. (The explanations that follow tell which does
what.)

The XML specification suggests that warnings should be generated as result of:

• Providing additional declarations for entities, attributes, or notations.

(Such declarations are ignored. Only the first is used. Also, note that
duplicate definitions of elements always produce a fatal error when vali-
dating, as you saw earlier.)

• Referencing an undeclared element type.

(A validity error occurs only if the undeclared type is actually used in the
XML document. A warning results when the undeclared element is refer-
enced in the DTD.)

• Declaring attributes for undeclared element types.

The Java XML SAX parser also emits warnings in other cases, such as:

• No <!DOCTYPE ...> when validating.

• Referencing an undefined parameter entity when not validating.

(When validating, an error results. Although nonvalidating parsers are not
required to read parameter entities, the Java XML parser does so. Since it
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is not a requirement, the Java XML parser generates a warning, rather
than an error.)

• Certain cases where the character-encoding declaration does not look
right.

At this point, you have digested many XML concepts, including DTDs, external
entities. You have also learned your way around the SAX parser. The remainder
of the SAX tutorial covers advanced topics that you will only need to understand
if you are writing SAX-based applications. If your primary goal is to write
DOM-based applications, you can skip ahead to Document Object
Model (page 187).

Handling Lexical Events
You saw earlier that if you are writing text out as XML, you need to know if you
are in a CDATA section. If you are, then angle brackets (<) and ampersands (&)
should be output unchanged. But if you’re not in a CDATA section, they should be
replaced by the predefined entities &lt; and &amp;. But how do you know if
you’re processing a CDATA section?

Then again, if you are filtering XML in some way, you would want to pass com-
ments along. Normally the parser ignores comments. How can you get com-
ments so that you can echo them?

Finally, there are the parsed entity definitions. If an XML-filtering app sees
&myEntity; it needs to echo the same string—not the text that is inserted in its
place. How do you go about doing that?

This section of the tutorial answers those questions. It shows you how to use
org.xml.sax.ext.LexicalHandler to identify comments, CDATA sections, and ref-
erences to parsed entities.

Comments, CDATA tags, and references to parsed entities constitute lexical infor-
mation—that is, information that concerns the text of the XML itself, rather than
the XML’s information content. Most applications, of course, are concerned only
with the content of an XML document. Such apps will not use the LexicalEv-

entListener API. But apps that output XML text will find it invaluable.

Note: Lexical event handling is a optional parser feature. Parser implementations
are not required to support it. (The reference implementation does so.) This discus-
sion assumes that the parser you are using does so, as well.
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How the LexicalHandler Works
To be informed when the SAX parser sees lexical information, you configure the
XmlReader that underlies the parser with a LexicalHandler. The LexicalHan-

dler interface defines these even-handling methods:

comment(String comment)
Passes comments to the application.

startCDATA(), endCDATA()
Tells when a CDATA section is starting and ending, which tells your applica-
tion what kind of characters to expect the next time characters() is called.

startEntity(String name), endEntity(String name)
Gives the name of a parsed entity.

startDTD(String name, String publicId, String systemId), endDTD()
Tells when a DTD is being processed, and identifies it.

Working with a LexicalHandler
In the remainder of this section, you’ll convert the Echo app into a lexical han-
dler and play with its features.

Note: The code shown in this section is in Echo11.java. The output is shown in
Echo11-09.txt. (The browsable version is Echo11-09.html.)

To start, add the code highlighted below to implement the LexicalHandler

interface and add the appropriate methods.

import org.xml.sax.*;
import org.xml.sax.helpers.DefaultHandler;
import org.xml.sax.ext.LexicalHandler;
...
public class Echo extends HandlerBase

implements LexicalHandler
{

public static void main(String argv[])
{

...
// Use an instance of ourselves as the SAX event handler
DefaultHandler handler = new Echo();
Echo handler = new Echo();
...

../examples/jaxp/sax/samples/Echo11.java
../examples/jaxp/sax/samples/Echo11-09.txt
../examples/jaxp/sax/samples/Echo11-09.html
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At this point, the Echo class extends one class and implements an additional
interface. You changed the class of the handler variable accordingly, so you can
use the same instance as either a DefaultHandler or a LexicalHandler, as
appropriate.

Next, add the code highlighted below to get the XMLReader that the parser dele-
gates to, and configure it to send lexical events to your lexical handler:

public static void main(String argv[])
{

...
try {

...
// Parse the input
SAXParser saxParser = factory.newSAXParser();
XMLReader xmlReader = saxParser.getXMLReader();
xmlReader.setProperty(

"http://xml.org/sax/properties/lexical-handler",
handler
);

saxParser.parse( new File(argv[0]), handler);
} catch (SAXParseException spe) {

...

Here, you configured the XMLReader using the setProperty() method defined
in the XMLReader class. The property name, defined as part of the SAX standard,
is the URL, http://xml.org/sax/properties/lexical-handler.

Finally, add the code highlighted below to define the appropriate methods that
implement the interface.

public void warning(SAXParseException err)
...

}

public void comment(char[] ch, int start, int length)throws SAX-
Exception
{
}

public void startCDATA()
throws SAXException
{
}

pubic void endCDATA()
throws SAXException
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{
}

public void startEntity(String name)
throws SAXException
{
}

public void endEntity(String name)
throws SAXException
{
}

public void startDTD(
String name, String publicId, String systemId)

throws SAXException
{
}

public void endDTD()
throws SAXException
{
}

private void echoText()
...

You have now turned the Echo class into a lexical handler. In the next section,
you’ll start experimenting with lexical events.

Echoing Comments
The next step is to do something with one of the new methods. Add the code
highlighted below to echo comments in the XML file:

public void comment(char[] ch, int start, int length)
throws SAXException

{
String text = new String(ch, start, length);
nl();
emit("COMMENT: "+text);

}
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When you compile the Echo program and run it on your XML file, the result
looks something like this:

COMMENT:   A SAMPLE set of slides
COMMENT:  FOR WALLY / WALLIES
COMMENT:

DTD for a simple "slide show".

COMMENT:  Defines the %inline; declaration
COMMENT:  ...

The line endings in the comments are passed as part of the comment string, once
again normalized to newlines. You can also see that comments in the DTD are
echoed along with comments from the file. (That can pose problems when you
want to echo only comments that are in the data file. To get around that problem,
you can use the startDTD and endDTD methods.)

Echoing Other Lexical Information
To finish up this section, you’ll exercise the remaining LexicalHandler meth-
ods.

Note: The code shown in this section is in Echo12.java. The file it operates on is
slideSample09.xml. The results of processing are in Echo12-09.txt (The brows-
able versions are slideSample09-xml.html and Echo12-09.html.)

Make the changes highlighted below to remove the comment echo (you don’t
need that any more) and echo the other events, along with any characters that
have been accumulated when an event occurs:

public void comment(char[] ch, int start, int length)
throws SAXException
{

String text = new String(ch, start, length);
nl();
emit("COMMENT: "+text);

}

../examples/jaxp/sax/samples/Echo12-09.txt
../examples/xml/samples/slideSample09-xml.html
../examples/jaxp/sax/samples/Echo12-09.html
../examples/jaxp/sax/samples/Echo12.java
../examples/xml/samples/slideSample09.xml
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public void startCDATA()
throws SAXException
{

echoText();
nl();
emit("START CDATA SECTION");

}

public void endCDATA()
throws SAXException
{

echoText();
nl();
emit("END CDATA SECTION");

}

public void startEntity(String name)
throws SAXException
{

echoText();
nl();
emit("START ENTITY: "+name);

}

public void endEntity(String name)
throws SAXException
{

echoText();
nl();
emit("END ENTITY: "+name);

}

public void startDTD(String name, String publicId, String
systemId)
throws SAXException
{

nl();
emit("START DTD: "+name

+"          publicId=" + publicId
+"          systemId=" + systemId);

}

public void endDTD()
throws SAXException
{

nl();
emit("END DTD");

}
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Here is what you see when the DTD is processed:

START DTD: slideshow
publicId=null
systemId=slideshow3.dtd

START ENTITY: ...
...
END DTD

Note: To see events that occur while the DTD is being processed, use
org.xml.sax.ext.DeclHandler.

Here is some of the additional output you see when the internally defined prod-

ucts entity is processed with the latest version of the program:

START ENTITY: products
CHARS:   WonderWidgets
END ENTITY: products

And here is the additional output you see as a result of processing the external
copyright entity:

START ENTITY: copyright
CHARS:

This is the standard copyright message that our lawyers
make us put everywhere so we don't have to shell out a
million bucks every time someone spills hot coffee in their
lap...

END ENTITY: copyright

Finally, you get output that shows when the CDATA section was processed:

START CDATA SECTION
CHARS:   Diagram:

frobmorten <--------------fuznaten
| <3> ^
| <1> |   <1> = fozzle
V |   <2> = framboze

staten---------------------+   <3> = frenzle
<2>

END CDATA SECTION
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In summary, the LexicalHandler gives you the event-notifications you need to
produce an accurate reflection of the original XML text.

Note: To accurately echo the input, you would modify the characters() method to
echo the text it sees in the appropriate fashion, depending on whether or not the pro-
gram was in CDATA mode.

Using the DTDHandler and
EntityResolver

In this section of the tutorial, we’ll carry on a short discussion of the two remain-
ing SAX event handlers: DTDHandler and EntityResolver. The DTDHandler is
invoked when the DTD encounters an unparsed entity or a notation declaration.
The EntityResolver comes into play when a URN (public ID) must be
resolved to a URL (system ID).

The DTDHandler API
In the section Choosing your Parser Implementation (page 168) you saw a
method for referencing a file that contains binary data, like an image file, using
MIME data types. That is the simplest, most extensible mechanism to use. For
compatibility with older SGML-style data, though, it is also possible to define an
unparsed entity.

The NDATA keyword defines an unparsed entity, like this:

  <!ENTITY myEntity SYSTEM "..URL.." NDATA gif>

The NDATA keyword says that the data in this entity is not parsable XML data, but
is instead data that uses some other notation. In this case, the notation is named
“gif”. The DTD must then include a declaration for that notation, which would
look something like this:

  <!NOTATION gif SYSTEM "..URL..">



THE ENTITYRESOLVER API 185
When the parser sees an unparsed entity or a notation declaration, it does nothing
with the information except to pass it along to the application using the DTDHan-

dler interface. That interface defines two methods:

notationDecl(String name, String publicId, String systemId)

unparsedEntityDecl(String name, String publicId,
String systemId, String notationName)

The notationDecl method is passed the name of the notation and either the
public or system identifier, or both, depending on which is declared in the DTD.
The unparsedEntityDecl method is passed the name of the entity, the appropri-
ate identifiers, and the name of the notation it uses.

Note: The DTDHandler interface is implemented by the DefaultHandler class.

Notations can also be used in attribute declarations. For example, the following
declaration requires notations for the GIF and PNG image-file formats:

<!ENTITY image EMPTY>
<!ATTLIST image

...
type  NOTATION  (gif | png) "gif"

>

Here, the type is declared as being either gif, or png. The default, if neither is
specified, is gif.

Whether the notation reference is used to describe an unparsed entity or an
attribute, it is up to the application to do the appropriate processing. The parser
knows nothing at all about the semantics of the notations. It only passes on the
declarations.

The EntityResolver API
The EntityResolver API lets you convert a public ID (URN) into a system ID
(URL). Your application may need to do that, for example, to convert something
like href="urn:/someName" into "http://someURL".

The EntityResolver interface defines a single method:

resolveEntity(String publicId, String systemId)
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This method returns an InputSource object, which can be used to access the
entity’s contents. Converting an URL into an InputSource is easy enough. But
the URL that is passed as the system ID will be the location of the original docu-
ment which is, as likely as not, somewhere out on the Web. To access a local
copy, if there is one, you must maintain a catalog somewhere on the system that
maps names (public IDs) into local URLs.

Further Information
For further information on the Simple API for XML processing (SAX) standard,
see:

• The SAX standard page: http://www.saxproject.org/

For more information on schema-based validation mechanisms, see:

• The W3C standard validation mechanism, XML Schema:
http://www.w3c.org/XML/Schema

• RELAX NG’s regular-expression based validation mechanism:
http://www.oasis-open.org/committees/relax-ng/

• Schematron’s assertion-based validation mechanism:
http://www.ascc.net/xml/resource/schematron/schematron.html

http://www.saxproject.org/
http://www.w3c.org/XML/Schema
http://www.oasis-open.org/committees/relax-ng/
http://www.ascc.net/xml/resource/schematron/schematron.html


6

187
Document Object
Model

IN the SAX chapter, you wrote an XML file that contains slides for a presenta-
tion. You then used the SAX API to echo the XML to your display.

In this chapter, you’ll use the Document Object Model (DOM) to build a small
SlideShow application. You’ll start by constructing a DOM and inspecting it,
then see how to write a DOM as an XML structure, display it in a GUI, and
manipulate the tree structure.

A Document Object Model is a garden-variety tree structure, where each node
contains one of the components from an XML structure. The two most common
types of nodes are element nodes and text nodes. Using DOM functions lets you
create nodes, remove nodes, change their contents, and traverse the node hierar-
chy.

In this chapter, you’ll parse an existing XML file to construct a DOM, display
and inspect the DOM hierarchy, convert the DOM into a display-friendly JTree,
and explore the syntax of namespaces. You’ll also create a DOM from scratch,
and see how to use some of the implementation-specific features in Sun’s JAXP
implementation to convert an existing data set to XML.

First though, we’ll make sure that DOM is the most appropriate choice for your
application. We’ll do that in the next section, When to Use DOM.
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Note: The examples in this chapter can be found in <INSTALL>/
j2eetutorial14/examples/jaxp/dom/samples.

When to Use DOM
The Document Object Model (DOM) is a standard that is, above all, designed for
documents (for example, articles and books). In addition, the JAXP 1.2 imple-
mentation supports XML Schema, which may be an important consideration for
any given application.

On the other hand, if you are dealing with simple data structures, and if XML
Schema isn’t a big part of your plans, then you may find that one of the more
object-oriented standards like JDOM and dom4j (page 35) is better suited for
your purpose.

From the start, DOM was intended to be language neutral. Because it was
designed for use with languages like C or Perl, DOM does not take advantage of
Java's object-oriented features. That fact, in addition to the document/data dis-
tinction, also helps to account for the ways in which processing a DOM differs
from processing a JDOM or dom4j structure.

In this section, we'll examine the differences between the models underlying
those standards to give help you choose the one that is most appropriate for your
application.

Documents Versus Data
The major point of departure between the document model used in DOM and the
data model used in JDOM or dom4j lies in:

• The kind of node that exists in the hierarchy.

• The capacity for “mixed-content”.

It is the difference in what constitutes a “node” in the data hierarchy that prima-
rily accounts for the differences in programming with these two models. How-
ever, it is the capacity for mixed-content which, more than anything else,
accounts for the difference in how the standards define a “node”. So we'll start
by examining DOM's “mixed-content model”.
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Mixed Content Model
Recall from the discussion of Document-Driven Programming (page 31) that
text and elements can be freely intermixed in a DOM hierarchy. That kind of
structure is dubbed “mixed content” in the DOM model.

Mixed content occurs frequently in documents. For example, to represent this
structure:

<sentence>This is an <bold>important</bold> idea.</sentence>

The hierarchy of DOM nodes would look something like this, where each line
represents one node:

ELEMENT: sentence
+  TEXT: This is an
+  ELEMENT: bold

+ TEXT: important
+ TEXT: idea.

Note that the sentence element contains text, followed by a subelement, followed
by additional text. It is that intermixing of text and elements that defines the
“mixed-content model”.

Kinds of Nodes
In order to provide the capacity for mixed content, DOM nodes are inherently
very simple. In the example above, for instance, the “content” of the first element
(it’s value) simply identifies the kind of node it is.

First time users of a DOM are usually thrown by this fact. After navigating to the
<sentence> node, they ask for the node's “content”, and expect to get something
useful. Instead, all they get is the name of the element, “sentence”.

Note: The DOM Node API defines nodeValue(), node.nodeType(), and node-

Name() methods. For the first element node, nodeName() returns “sentence”, while
nodeValue() returns null. For the first text node, nodeName() returns “#text”, and
nodeValue() returns “This is an “. The important point is that the value of an ele-
ment is not the same as its content.
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Instead, obtaining the content you care about when processing a DOM means
inspecting the list of subelements the node contains, ignoring those you aren't
interested in, and processing the ones you do care about.

For example, in the example above, what does it mean if you ask for the “text” of
the sentence? Any of the following could be reasonable, depending on your
application:

• This is an

• This is an idea.

• This is an important idea.

• This is an <bold>important</bold> idea.

A Simpler Model
With DOM, you are free to create the semantics you need. However, you are also
required to do the processing necessary to implement those semantics. Standards
like JDOM and dom4j, on the other hand, make it a lot easier to do simple
things, because each node in the hierarchy is an object.

Although JDOM and dom4j make allowances for elements with mixed content,
they are not primarily designed for such situations. Instead, they are targeted for
applications where the XML structure contains data.

As described in Traditional Data Processing (page 31), the elements in a data
structure typically contain either text or other elements, but not both. For exam-
ple, here is some XML that represents a simple address book:

<addressbook>
<entry>

<name>Fred</name>
<email>fred@home</email>

</entry>
 ...

</addressbook>

Note: For very simple XML data structures like this one, you could also use the reg-
ular expression package (java.util.regex) built into version 1.4 of the Java platform.

In JDOM and dom4j, once you navigate to an element that contains text, you
invoke a method like text() to get it's content. When processing a DOM,
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though, you would have to inspect the list of subelements to “put together” the
text of the node, as you saw earlier -- even if that list only contained one item (a
TEXT node).

So for simple data structures like the address book above, you could save your-
self a bit of work by using JDOM or dom4j. It may make sense to use one of
those models even when the data is technically “mixed”, but when there is
always one (and only one) segment of text for a given node.

Here is an example of that kind of structure, which would also be easily pro-
cessed in JDOM or dom4j:

<addressbook>
<entry>Fred

<email>fred@home</email>
</entry>
...

</addressbook>

Here, each entry has a bit of identifying text, followed by other elements. With
this structure, the program could navigate to an entry, invoke text() to find out
who it belongs to, and process the <email> sub element if it is at the correct
node.

Increasing the Complexity
But to get a full understanding of the kind of processing you need to do when
searching or manipulating a DOM, it is important to know the kinds of nodes
that a DOM can conceivably contain.

Here is an example that tries to bring the point home. It is a representation of this
data:

<sentence>
The &projectName; <![CDATA[<i>project</i>]]> is
<?editor: red><bold>important</bold><?editor: normal>.

</sentence>

This sentence contains an entity reference — a pointer to an “entity” which is
defined elsewhere. In this case, the entity contains the name of the project. The
example also contains a CDATA section (uninterpreted data, like <pre> data in
HTML), as well as processing instructions (<?...?>) that in this case tell the
editor to which color to use when rendering the text.



192 DOCUMENT OBJECT MODEL
Here is the DOM structure for that data. It’s fairly representative of the kind of
structure that a robust application should be prepared to handle:

+ ELEMENT: sentence
+ TEXT: The
+ ENTITY REF: projectName

+ COMMENT: The latest name we're using
+ TEXT: Eagle

+ CDATA: <i>project</i>
+ TEXT: is
+ PI: editor: red
+ ELEMENT: bold

+ TEXT: important
+ PI: editor: normal

This example depicts the kinds of nodes that may occur in a DOM. Although
your application may be able to ignore most of them most of the time, a truly
robust implementation needs to recognize and deal with each of them.

Similarly, the process of navigating to a node involves processing subelements,
ignoring the ones you don't care about and inspecting the ones you do care
about, until you find the node you are interested in.

Often, in such cases, you are interested in finding a node that contains specific
text. For example, in The DOM API (page 10) you saw an example where you
wanted to find a <coffee> node whose <name> element contains the text,
“Mocha Java”. To carry out that search, the program needed to work through the
list of <coffee> elements and, for each one: a) get the <name> element under it
and, b) examine the TEXT node under that element.

That example made some simplifying assumptions, however. It assumed that
processing instructions, comments, CDATA nodes, and entity references would
not exist in the data structure. Many simple applications can get away with such
assumptions. Truly robust applications, on the other hand, need to be prepared to
deal with the all kinds of valid XML data.

(A “simple” application will work only so long as the input data contains the
simplified XML structures it expects. But there are no validation mechanisms to
ensure that more complex structures will not exist. After all, XML was specifi-
cally designed to allow them.)
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To be more robust, the sample code described in The DOM API (page 10),
would have to do these things:

1. When searching for the <name> element:

a. Ignore comments, attributes, and processing instructions.

b. Allow for the possibility that the <coffee> subelements do not occur in
the expected order.

c. Skip over TEXT nodes that contain ignorable whitespace, if not validat-
ing.

2. When extracting text for a node:

a. Extract text from CDATA nodes as well as text nodes.

b. Ignore comments, attributes, and processing instructions when gather-
ing the text.

c. If an entity reference node or another element node is encountered,
recurse. (That is, apply the text-extraction procedure to all subnodes.)

Note: The JAXP 1.2 parser does not insert entity reference nodes into the
DOM. Instead, it inserts a TEXT node containing the contents of the refer-
ence. The JAXP 1.1 parser which is built into the 1.4 platform, on the other
hand, does insert entity reference nodes. So a robust implementation which
is parser-independent needs to be prepared to handle entity reference nodes.

Many applications, of course, won’t have to worry about such things, because
the kind of data they see will be strictly controlled. But if the data can come from
a variety of external sources, then the application will probably need to take
these possibilities into account.

The code you need to carry out these functions is given near the end of the DOM
tutorial in Searching for Nodes (page 250) and Obtaining Node
Content (page 251). Right now, the goal is simply to determine whether DOM is
suitable for your application.

Choosing Your Model
As you can see, when you are using DOM, even a simple operation like getting
the text from a node can take a bit of programming. So if your programs will be
handling simple data structures, JDOM, dom4j, or even the 1.4 regular expres-
sion package (java.util.regex) may be more appropriate for your needs.
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For full-fledged documents and complex applications, on the other hand, DOM
gives you a lot of flexibility. And if you need to use XML Schema, then once
again DOM is the way to go for now, at least.

If you will be processing both documents and data in the applications you
develop, then DOM may still be your best choice. After all, once you have writ-
ten the code to examine and process a DOM structure, it is fairly easy to custom-
ize it for a specific purpose. So choosing to do everything in DOM means you'll
only have to deal with one set of APIs, rather than two.

Plus, the DOM standard is a standard. It is robust and complete, and it has many
implementations. That is a significant decision-making factor for many large
installations — particularly for production applications, to prevent doing large
rewrites in the event of an API change.

Finally, even though the text in an address book may not permit bold, italics, col-
ors, and font sizes today, someday you may want to handle things. Since DOM
will handle virtually anything you throw at it, choosing DOM makes it easier to
“future-proof” your application.

Reading XML Data into a DOM
In this section of the tutorial, you’ll construct a Document Object Model (DOM)
by reading in an existing XML file. In the following sections, you’ll see how to
display the XML in a Swing tree component and practice manipulating the
DOM.

Note: In the next part of the tutorial, XML Stylesheet Language for
Transformations (page 261), you’ll see how to write out a DOM as an XML file.
(You’ll also see how to convert an existing data file into XML with relative ease.)

Creating the Program
The Document Object Model (DOM) provides APIs that let you create nodes,
modify them, delete and rearrange them. So it is relatively easy to create a DOM,
as you’ll see in later in section 5 of this tutorial, Creating and Manipulating a
DOM (page 244).
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Before you try to create a DOM, however, it is helpful to understand how a
DOM is structured. This series of exercises will make DOM internals visible by
displaying them in a Swing JTree.

Create the Skeleton
Now that you’ve had a quick overview of how to create a DOM, let’s build a sim-
ple program to read an XML document into a DOM then write it back out again.

Note: The code discussed in this section is in DomEcho01.java. The file it operates
on is slideSample01.xml. (The browsable version is slideSample01-xml.html.)

Start with a normal basic logic for an app, and check to make sure that an argu-
ment has been supplied on the command line:

public class DomEcho {
public static void main(String argv[])
{

if (argv.length != 1) {
System.err.println(

"Usage: java DomEcho filename");
System.exit(1);

}
}// main

}// DomEcho

Import the Required Classes
In this section, you’re going to see all the classes individually named. That’s so
you can see where each class comes from when you want to reference the API
documentation. In your own apps, you may well want to replace import state-
ments like those below with the shorter form: javax.xml.parsers.*.

Add these lines to import the JAXP APIs you’ll be using:

import javax.xml.parsers.DocumentBuilder;
import javax.xml.parsers.DocumentBuilderFactory;
import javax.xml.parsers.FactoryConfigurationError;
import javax.xml.parsers.ParserConfigurationException;

../examples/jaxp/dom/samples/DomEcho01.java
../examples/jaxp/dom/samples/slideSample01.xml
../examples/jaxp/dom/samples/slideSample01-xml.html
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Add these lines for the exceptions that can be thrown when the XML document
is parsed:

import org.xml.sax.SAXException;
import org.xml.sax.SAXParseException;

Add these lines to read the sample XML file and identify errors:

import java.io.File;
import java.io.IOException;

Finally, import the W3C definition for a DOM and DOM exceptions:

import org.w3c.dom.Document;
import org.w3c.dom.DOMException;

Note: A DOMException is only thrown when traversing or manipulating a DOM.
Errors that occur during parsing are reporting using a different mechanism that is
covered below.

Declare the DOM
The org.w3c.dom.Document class is the W3C name for a Document Object
Model (DOM). Whether you parse an XML document or create one, a Docu-
ment instance will result. We’ll want to reference that object from another
method later on in the tutorial, so define it as a global object here:

public class DomEcho
{

static Document document;

public static void main(String argv[])
{

It needs to be static, because you’re going to generate its contents from the
main method in a few minutes.

Handle Errors
Next, put in the error handling logic. This logic is basically the same as the code
you saw in Handling Errors with the Nonvalidating Parser (page 151) in the
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SAX tutorial, so we won’t go into it in detail here. The major point worth noting
is that a JAXP-conformant document builder is required to report SAX excep-
tions when it has trouble parsing the XML document. The DOM parser does not
have to actually use a SAX parser internally, but since the SAX standard was
already there, it seemed to make sense to use it for reporting errors. As a result,
the error-handling code for DOM and SAX applications are very similar:

public static void main(String argv[])
{

if (argv.length != 1) {
...

}

try {

} catch (SAXParseException spe) {
// Error generated by the parser

System.out.println("\n** Parsing error"
+ ", line " + spe.getLineNumber()
+ ", uri " + spe.getSystemId());

System.out.println("   " + spe.getMessage() );

// Use the contained exception, if any
Exception  x = spe;
if (spe.getException() != null)

x = spe.getException();
x.printStackTrace();

} catch (SAXException sxe) {
// Error generated during parsing
Exception  x = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

 } catch (ParserConfigurationException pce) {
// Parser with specified options can't be built
pce.printStackTrace();

 } catch (IOException ioe) {
// I/O error
ioe.printStackTrace();

}

}// main
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Instantiate the Factory
Next, add the code highlighted below to obtain an instance of a factory that can
give us a document builder:

public static void main(String argv[])
{

if (argv.length != 1) {
...

}
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance();
try {

Get a Parser and Parse the File
Now, add the code highlighted below to get a instance of a builder, and use it to
parse the specified file:

try {
DocumentBuilder builder = factory.newDocumentBuilder();
document = builder.parse( new File(argv[0]) );

} catch (SAXParseException spe) {

Save This File!
By now, you should be getting the idea that every JAXP application starts
pretty much the same way. You’re right! Save this version of the file as a
template. You’ll use it later on as the basis for an XSLT transformation
application.

Run the Program
Throughout most of the DOM tutorial, you’ll be using the sample slideshows
you saw in the SAX section. In particular, you’ll use slideSample01.xml, a
simple XML file with nothing much in it, and slideSample10.xml, a more com-
plex example that includes a DTD, processing instructions, entity references,
and a CDATA section.

For instructions on how to compile and run your program, see Compiling and
Running the Program from the SAX tutorial. Substitute “DomEcho” for “Echo”
as the name of the program, and you’re ready to roll.
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For now, just run the program on slideSample01.xml. If it ran without error,
you have successfully parsed an XML document and constructed a DOM. Con-
gratulations!

Note: You’ll have to take my word for it, for the moment, because at this point you
don’t have any way to display the results. But that feature is coming shortly...

Additional Information
Now that you have successfully read in a DOM, there are one or two more things
you need to know in order to use DocumentBuilder effectively. Namely, you
need to know about:

• Configuring the Factory

• Handling Validation Errors

Configuring the Factory
By default, the factory returns a nonvalidating parser that knows nothing about
namespaces. To get a validating parser, and/or one that understands namespaces,
you configure the factory to set either or both of those options using the com-
mand(s) highlighted below:

public static void main(String argv[])
{

if (argv.length != 1) {
...

}
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance();
factory.setValidating(true);
factory.setNamespaceAware(true);
try {

...

Note: JAXP-conformant parsers are not required to support all combinations of
those options, even though the reference parser does. If you specify an invalid com-
bination of options, the factory generates a ParserConfigurationException when
you attempt to obtain a parser instance.
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You’ll be learning more about how to use namespaces in the last section of the
DOM tutorial, Validating with XML Schema (page 253). To complete this sec-
tion, though, you’ll want to learn something about...

Handling Validation Errors
Remember when you were wading through the SAX tutorial, and all you really
wanted to do was construct a DOM? Well, here’s when that information begins
to pay off.

Recall that the default response to a validation error, as dictated by the SAX
standard, is to do nothing. The JAXP standard requires throwing SAX excep-
tions, so you use exactly the same error handling mechanisms as you used for a
SAX application. In particular, you need to use the DocumentBuilder’s setEr-
rorHandler method to supply it with an object that implements the SAX
ErrorHandler interface.

Note: DocumentBuilder also has a setEntityResolver method you can use

The code below uses an anonymous inner class to define that ErrorHandler.
The highlighted code is the part that makes sure validation errors generate an
exception.

builder.setErrorHandler(
new org.xml.sax.ErrorHandler() {

// ignore fatal errors (an exception is guaranteed)
public void fatalError(SAXParseException exception)
throws SAXException {
}
// treat validation errors as fatal
public void error(SAXParseException e)
throws SAXParseException
{

throw e;
}

 // dump warnings too
public void warning(SAXParseException err)
throws SAXParseException
{

System.out.println("** Warning"
+ ", line " + err.getLineNumber()
+ ", uri " + err.getSystemId());
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System.out.println("   " + err.getMessage());
}

);

This code uses an anonymous inner class to generate an instance of an object
that implements the ErrorHandler interface. Since it has no class name, it’s
“anonymous”. You can think of it as an “ErrorHandler” instance, although tech-
nically it’s a no-name instance that implements the specified interface. The code
is substantially the same as that described in Handling Errors with the Nonvali-
dating Parser (page 151). For a more complete background on validation issues,
refer to Using the Validating Parser (page 168).

Looking Ahead
In the next section, you’ll display the DOM structure in a JTree and begin to
explore its structure. For example, you’ll see how entity references and CDATA
sections appear in the DOM. And perhaps most importantly, you’ll see how text
nodes (which contain the actual data) reside under element nodes in a DOM.

Displaying a DOM Hierarchy
To create a Document Object Hierarchy (DOM) or manipulate one, it helps to
have a clear idea of how the nodes in a DOM are structured. In this section of the
tutorial, you’ll expose the internal structure of a DOM.

Echoing Tree Nodes
What you need at this point is a way to expose the nodes in a DOM so you can
see what it contains. To do that, you’ll convert a DOM into a JTreeModel and
display the full DOM in a JTree. It’s going to take a bit of work, but the end
result will be a diagnostic tool you can use in the future, as well as something
you can use to learn about DOM structure now.

Convert DomEcho to a GUI App
Since the DOM is a tree, and the Swing JTree component is all about displaying
trees, it makes sense to stuff the DOM into a JTree, so you can look at it. The
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first step in that process is to hack up the DomEcho program so it becomes a GUI
application.

Note: The code discussed in this section is in DomEcho02.java.

Add Import Statements
Start by importing the GUI components you’re going to need to set up the appli-
cation and display a JTree:

// GUI components and layouts
import javax.swing.JFrame;
import javax.swing.JPanel;
import javax.swing.JScrollPane;
import javax.swing.JTree;

Later on in the DOM tutorial, we’ll tailor the DOM display to generate a user-
friendly version of the JTree display. When the user selects an element in that
tree, you’ll be displaying subelements in an adjacent editor pane. So, while we’re
doing the setup work here, import the components you need to set up a divided
view (JSplitPane) and to display the text of the subelements (JEditorPane):

import javax.swing.JSplitPane;
import javax.swing.JEditorPane;

Add a few support classes you’re going to need to get this thing off the ground:

// GUI support classes
import java.awt.BorderLayout;
import java.awt.Dimension;
import java.awt.Toolkit;
import java.awt.event.WindowEvent;
import java.awt.event.WindowAdapter;

Finally, import some classes to make a fancy border:

// For creating borders
import javax.swing.border.EmptyBorder;
import javax.swing.border.BevelBorder;
import javax.swing.border.CompoundBorder;

../examples/jaxp/dom/samples/DomEcho02.java
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(These are optional. You can skip them and the code that depends on them if you
want to simplify things.)

Create the GUI Framework
The next step is to convert the application into a GUI application. To do that, the
static main method will create an instance of the main class, which will have
become a GUI pane.

Start by converting the class into a GUI pane by extending the Swing JPanel

class:

public class DomEcho02 extends JPanel
{

// Global value so it can be ref'd by the tree-adapter
static Document document;
...

While you’re there, define a few constants you’ll use to control window sizes:

public class DomEcho02 extends JPanel
{

// Global value so it can be ref'd by the tree-adapter
static Document document;

static final int windowHeight = 460;
static final int leftWidth = 300;
static final int rightWidth = 340;
static final int windowWidth = leftWidth + rightWidth;

Now, in the main method, invoke a method that will create the outer frame that
the GUI pane will sit in:

public static void main(String argv[])
{

...
DocumentBuilderFactory factory ...
try {

DocumentBuilder builder = factory.newDocumentBuilder();
document = builder.parse( new File(argv[0]) );
makeFrame();

 } catch (SAXParseException spe) {
...
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Next, you’ll need to define the makeFrame method itself. It contains the standard
code to create a frame, handle the exit condition gracefully, give it an instance of
the main panel, size it, locate it on the screen, and make it visible:

 ...
} // main

public static void makeFrame()
{

// Set up a GUI framework
JFrame frame = new JFrame("DOM Echo");
frame.addWindowListener(new WindowAdapter() {

public void windowClosing(WindowEvent e)
{System.exit(0);}

});

// Set up the tree, the views, and display it all
final DomEcho02 echoPanel = new DomEcho02();
frame.getContentPane().add("Center", echoPanel );
frame.pack();
Dimension screenSize =

Toolkit.getDefaultToolkit().getScreenSize();
int w = windowWidth + 10;
int h = windowHeight + 10;
frame.setLocation(screenSize.width/3 - w/2,

screenSize.height/2 - h/2);
frame.setSize(w, h);
frame.setVisible(true)

} // makeFrame

Add the Display Components
The only thing left in the effort to convert the program to a GUI application is to
create the class constructor and make it create the panel’s contents. Here is the
constructor:

public class DomEcho02 extends JPanel
{

...
static final int windowWidth = leftWidth + rightWidth;

public DomEcho02()
{
} // Constructor
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Here, you make use of the border classes you imported earlier to make a regal
border (optional):

public DomEcho02()
{

// Make a nice border
EmptyBorder eb = new EmptyBorder(5,5,5,5);
BevelBorder bb = new BevelBorder(BevelBorder.LOWERED);
CompoundBorder cb = new CompoundBorder(eb,bb);
this.setBorder(new CompoundBorder(cb,eb));

} // Constructor

Next, create an empty tree and put it a JScrollPane so users can see its contents
as it gets large:

public DomEcho02(
{

...

// Set up the tree
JTree tree = new JTree();

// Build left-side view
JScrollPane treeView = new JScrollPane(tree);
treeView.setPreferredSize(

new Dimension( leftWidth, windowHeight ));

} // Constructor

Now create a non-editable JEditPane that will eventually hold the contents
pointed to by selected JTree nodes:

public DomEcho02(
{

....

// Build right-side view
JEditorPane htmlPane = new JEditorPane("text/html","");
htmlPane.setEditable(false);
JScrollPane htmlView = new JScrollPane(htmlPane);
htmlView.setPreferredSize(

new Dimension( rightWidth, windowHeight ));

}  // Constructor
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With the left-side JTree and the right-side JEditorPane constructed, create a
JSplitPane to hold them:

public DomEcho02()
{

....

// Build split-pane view
JSplitPane splitPane =

new JSplitPane(JSplitPane.HORIZONTAL_SPLIT,
treeView, htmlView );

splitPane.setContinuousLayout( true );
splitPane.setDividerLocation( leftWidth );
splitPane.setPreferredSize(

new Dimension( windowWidth + 10, windowHeight+10 ));

}  // Constructor

With this code, you set up the JSplitPane with a vertical divider. That produces
a “horizontal split” between the tree and the editor pane. (More of a horizontal
layout, really.) You also set the location of the divider so that the tree got the
width it prefers, with the remainder of the window width allocated to the editor
pane.

 Finally, specify the layout for the panel and add the split pane:

public DomEcho02()
{

...

// Add GUI components
this.setLayout(new BorderLayout());
this.add("Center", splitPane );

} // Constructor

Congratulations! The program is now a GUI application. You can run it now to
see what the general layout will look like on screen. For reference, here is the
completed constructor:

public DomEcho02()
{

// Make a nice border
EmptyBorder eb = new EmptyBorder(5,5,5,5);
BevelBorder bb = new BevelBorder(BevelBorder.LOWERED);
CompoundBorder CB = new CompoundBorder(eb,bb);
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this.setBorder(new CompoundBorder(CB,eb));

// Set up the tree
JTree tree = new JTree();

// Build left-side view
JScrollPane treeView = new JScrollPane(tree);
treeView.setPreferredSize(

new Dimension( leftWidth, windowHeight ));

// Build right-side view
JEditorPane htmlPane = new JEditorPane("text/html","");
htmlPane.setEditable(false);
JScrollPane htmlView = new JScrollPane(htmlPane);
htmlView.setPreferredSize(

new Dimension( rightWidth, windowHeight ));

// Build split-pane view
JSplitPane splitPane =

new JSplitPane(JSplitPane.HORIZONTAL_SPLIT,
treeView, htmlView )

splitPane.setContinuousLayout( true );
splitPane.setDividerLocation( leftWidth );
splitPane.setPreferredSize(

new Dimension( windowWidth + 10, windowHeight+10 ));

// Add GUI components
this.setLayout(new BorderLayout());
this.add("Center", splitPane );

} // Constructor

Create Adapters to Display the DOM in
a JTree
Now that you have a GUI framework to display a JTree in, the next step is get
the JTree to display the DOM. But a JTree wants to display a TreeModel. A
DOM is a tree, but it’s not a TreeModel. So you’ll need to create an adapter class
that makes the DOM look like a TreeModel to a JTree.

Now, when the TreeModel passes nodes to the JTree, JTree uses the toString

function of those nodes to get the text to display in the tree. The standard
toString function isn’t going to be very pretty, so you’ll need to wrap the DOM
nodes in an AdapterNode that returns the text we want. What the TreeModel
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gives to the JTree, then, will in fact be AdapterNode objects that wrap DOM
nodes.

Note: The classes that follow are defined as inner classes. If you are coding for the
1.1 platform, you will need to define these class as external classes.

Define the AdapterNode Class
Start by importing the tree, event, and utility classes you’re going to need to
make this work:

// For creating a TreeModel
import javax.swing.tree.*;
import javax.swing.event.*;
import java.util.*;

public class DomEcho extends JPanel
{

Moving back down to the end of the program, define a set of strings for the node
element types:

        ...
} // makeFrame

// An array of names for DOM node-types
// (Array indexes = nodeType() values.)
static final String[] typeName = {

"none",
"Element",
"Attr",
"Text",
"CDATA",
"EntityRef",
"Entity",
"ProcInstr",
"Comment",
"Document",
"DocType",
"DocFragment",
"Notation",

};

} // DomEcho
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These are the strings that will be displayed in the JTree. The specification of
these nodes types can be found in the Document Object Model (DOM) Level 2
Core Specification at http://www.w3.org/TR/2000/REC-DOM/Level-2-Core-
20001113, under the specification for Node. That table is reproduced below, with
the headings modified for clarity, and with the nodeType() column added:

Table 6–1 Node Types

Node nodeName() nodeValue() attributes nodeType()

 Attr
name of
attribute

value of
attribute

null  2

 CDATASection #cdata-section
content of
the CDATA
section

null  4

 Comment #comment
content of the
comment

null  8

 Document #document null null  9

 DocumentFragment
#document-
fragment

null null  11

 DocumentType
document
type name

null null  10

 Element tag name null NamedNodeMap  1

 Entity entity name null null  6

 EntityReference
name of entity
referenced

null null  5

 Notation notation name null null  12

 ProcessingInstruction target
entire content
excluding the
target

null  7

 Text #text
content of the
text node

null  3
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Suggestion:
Print this table and keep it handy. You need it when working with the DOM,
because all of these types are intermixed in a DOM tree. So your code is for-
ever asking, “Is this the kind of node I’m interested in?”.

Next, define the AdapterNode wrapper for DOM nodes as an inner class:

static final String[] typeName = {
...

};

public class AdapterNode
{

org.w3c.dom.Node domNode;

// Construct an Adapter node from a DOM node
public AdapterNode(org.w3c.dom.Node node) {

domNode = node;
}

// Return a string that identifies this node
// in the tree
public String toString() {

String s = typeName[domNode.getNodeType()];
String nodeName = domNode.getNodeName();
if (! nodeName.startsWith("#")) {

s += ": " + nodeName;
}
if (domNode.getNodeValue() != null) {

if (s.startsWith("ProcInstr"))
s += ", ";

else
s += ": ";

// Trim the value to get rid of NL's
// at the front
String t = domNode.getNodeValue().trim();
int x = t.indexOf(");
if (x >= 0) t = t.substring(0, x);
s += t;

}
return s;

}

} // AdapterNode

} // DomEcho
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This class declares a variable to hold the DOM node, and requires it to be speci-
fied as a constructor argument. It then defines the toString operation, which
returns the node type from the String array, and then adds to that additional
information from the node, to further identify it.

As you can see in the table of node types in org.w3c.dom.Node, every node has
a type, and name, and a value, which may or may not be empty. In those cases
where the node name starts with “#”, that field duplicates the node type, so there
is in point in including it. That explains the lines that read:

if (! nodeName.startsWith("#")) {
s += ": " + nodeName;

}

The remainder of the toString method deserves a couple of notes, as well. For
instance, these lines:

if (s.startsWith("ProcInstr"))
s += ", ";

else
s += ": ";

Merely provide a little “syntactic sugar”. The type field for a Processing Instruc-
tions end with a colon (:) anyway, so those codes keep from doubling the colon.

The other interesting lines are:

String t = domNode.getNodeValue().trim();
int x = t.indexOf(");
if (x >= 0) t = t.substring(0, x);
s += t;

Those lines trim the value field down to the first newline (linefeed) character in
the field. If you leave those lines out, you will see some funny characters (square
boxes, typically) in the JTree.

Note: Recall that XML stipulates that all line endings are normalized to newlines,
regardless of the system the data comes from. That makes programming quite a bit
simpler.

Wrapping a DomNode and returning the desired string are the AdapterNode’s
major functions. But since the TreeModel adapter will need to answer questions
like “How many children does this node have?” and satisfy commands like
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“Give me this node’s Nth child”, it will be helpful to define a few additional util-
ity methods. (The adapter could always access the DOM node and get that infor-
mation for itself, but this way things are more encapsulated.)

Next, add the code highlighted below to return the index of a specified child, the
child that corresponds to a given index, and the count of child nodes:

public class AdapterNode
{

...
public String toString() {

...
}

public int index(AdapterNode child) {
//System.err.println("Looking for index of " + child);
int count = childCount();
for (int i=0; i<count; i++) {

AdapterNode n = this.child(i);
if (child == n) return i;

}
return -1; // Should never get here.

}

public AdapterNode child(int searchIndex) {
//Note: JTree index is zero-based.
org.w3c.dom.Node node =

domNode.getChildNodes().item(searchIndex);
return new AdapterNode(node);

}

public int childCount() {
return domNode.getChildNodes().getLength();

}

} // AdapterNode

} // DomEcho

Note: During development, it was only after I started writing the TreeModel adapter
that I realized these were needed, and went back to add them. In just a moment,
you’ll see why.
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Define the TreeModel Adapter
Now, at last, you are ready to write the TreeModel adapter. One of the really nice
things about the JTree model is the relative ease with which you convert an
existing tree for display. One of the reasons for that is the clear separation
between the displayable view, which JTree uses, and the modifiable view, which
the application uses. For more on that separation, see Understanding the Tree-
Model at http://java.sun.com/products/jfc/tsc/articles/jtree/

index.html. For now, the important point is that to satisfy the TreeModel inter-
face we only need to (a) provide methods to access and report on children and
(b) register the appropriate JTree listener, so it knows to update its view when
the underlying model changes.

Add the code highlighted below to create the TreeModel adapter and specify the
child-processing methods:

...
} // AdapterNode

// This adapter converts the current Document (a DOM) into
// a JTree model.
public class DomToTreeModelAdapter implements
javax.swing.tree.TreeModel
{

// Basic TreeModel operations
public Object  getRoot() {

//System.err.println("Returning root: " +document);
return new AdapterNode(document);

}

public boolean isLeaf(Object aNode) {
// Determines whether the icon shows up to the left.
// Return true for any node with no children
AdapterNode node = (AdapterNode) aNode;
if (node.childCount() > 0) return false;
return true;

}

public int     getChildCount(Object parent)
AdapterNode node = (AdapterNode) parent;
return node.childCount();

}

public Object  getChild(Object parent, int index) {
AdapterNode node = (AdapterNode) parent;
return node.child(index);
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}

public int getIndexOfChild(Object parent, Object child) {
AdapterNode node = (AdapterNode) parent;
return node.index((AdapterNode) child);

}

public void valueForPathChanged(
TreePath path, Object newValue)

{
// Null. We won't be making changes in the GUI
// If we did, we would ensure the new value was
// really new and then fire a TreeNodesChanged event.

}

} // DomToTreeModelAdapter

} // DomEcho

In this code, the getRoot method returns the root node of the DOM, wrapped as
an AdapterNode object. From here on, all nodes returned by the adapter will be
AdapterNodes that wrap DOM nodes. By the same token, whenever the JTree

asks for the child of a given parent, the number of children that parent has, etc.,
the JTree will be passing us an AdapterNode. We know that, because we control
every node the JTree sees, starting with the root node.

JTree uses the isLeaf method to determine whether or not to display a clickable
expand/contract icon to the left of the node, so that method returns true only if
the node has children. In this method, we see the cast from the generic object
JTree sends us to the AdapterNode object we know it has to be. We know it is
sending us an adapter object, but the interface, to be general, defines objects, so
we have to do the casts.

The next three methods return the number of children for a given node, the child
that lives at a given index, and the index of a given child, respectively. That’s all
pretty straightforward.

The last method is invoked when the user changes a value stored in the JTree. In
this app, we won’t support that. But if we did, the application would have to
make the change to the underlying model and then inform any listeners that a
change had occurred. (The JTree might not be the only listener. In many an
application it isn’t, in fact.)
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To inform listeners that a change occurred, you’ll need the ability to register
them. That brings us to the last two methods required to implement the Tree-

Model interface. Add the code highlighted below to define them:

public class DomToTreeModelAdapter ...
{

...
public void valueForPathChanged(

TreePath path, Object newValue)
{

...
}
private Vector listenerList = new Vector();
public void addTreeModelListener(

TreeModelListener listener ) {
if ( listener != null
&& ! listenerList.contains(listener) ) {

listenerList.addElement( listener );
}

}

public void removeTreeModelListener(
TreeModelListener listener )

{
if ( listener != null ) {

listenerList.removeElement( listener );
}

}

} // DomToTreeModelAdapter

Since this application won’t be making changes to the tree, these methods will
go unused, for now. However, they’ll be there in the future, when you need them.

Note: This example uses Vector so it will work with 1.1 apps. If coding for 1.2 or
later, though, I’d use the excellent collections framework instead:

private LinkedList listenerList = new LinkedList();
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The operations on the List are then add and remove. To iterate over the list, as in
the operations below, you would use:

Iterator it = listenerList.iterator();
while ( it.hasNext() ) {

TreeModelListener listener = (TreeModelListener) it.next();
...

}

Here, too, are some optional methods you won’t be using in this application. At
this point, though, you have constructed a reasonable template for a TreeModel
adapter. In the interests of completeness, you might want to add the code high-
lighted below. You can then invoke them whenever you need to notify JTree lis-
teners of a change:

public void removeTreeModelListener(
TreeModelListener listener)

{
...

}

public void fireTreeNodesChanged( TreeModelEvent e ) {
Enumeration listeners = listenerList.elements();
while ( listeners.hasMoreElements() ) {

TreeModelListener listener =
(TreeModelListener) listeners.nextElement();

listener.treeNodesChanged( e );
}

}

public void fireTreeNodesInserted( TreeModelEvent e ) {
Enumeration listeners = listenerList.elements();
while ( listeners.hasMoreElements() ) {

TreeModelListener listener =
(TreeModelListener) listeners.nextElement();

listener.treeNodesInserted( e );
}

}

public void fireTreeNodesRemoved( TreeModelEvent e ) {
Enumeration listeners = listenerList.elements();
while ( listeners.hasMoreElements() ) {

TreeModelListener listener =
(TreeModelListener) listeners.nextElement();

listener.treeNodesRemoved( e );
}

}
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public void fireTreeStructureChanged( TreeModelEvent e ) {
Enumeration listeners = listenerList.elements();
while ( listeners.hasMoreElements() ) {

TreeModelListener listener =
(TreeModelListener) listeners.nextElement();

listener.treeStructureChanged( e );
}

}

} // DomToTreeModelAdapter

Note: These methods are taken from the TreeModelSupport class described in
Understanding the TreeModel. That architecture was produced by Tom Santos and
Steve Wilson, and is a lot more elegant than the quick hack going on here. It seemed
worthwhile to put them here, though, so they would be immediately at hand when
and if they’re needed.

Finishing Up
At this point, you are basically done. All you need to do is jump back to the con-
structor and add the code to construct an adapter and deliver it to the JTree as
the TreeModel:

// Set up the tree
JTree tree = new JTree(new DomToTreeModelAdapter());

You can now compile and run the code on an XML file. In the next section, you
will do that, and explore the DOM structures that result.

Examining the Structure of a DOM
In this section, you’ll use the GUI-fied DomEcho application you created in the
last section to visually examine a DOM. You’ll see what nodes make up the
DOM, and how they are arranged. With the understanding you acquire, you’ll be
well prepared to construct and modify Document Object Model structures in the
future.
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Displaying A Simple Tree
We’ll start out by displaying a simple file, so you get an idea of basic DOM
structure. Then we’ll look at the structure that results when you include some of
the more advanced XML elements.

Note: The code used to create the figures in this section is in DomEcho02.java. The
file displayed is slideSample01.xml. (The browsable version is slideSample01-

xml.html.)

Figure 6–1 shows the tree you see when you run the DomEcho program on the
first XML file you created in the DOM tutorial.

Figure 6–1 Document, Comment, and Element Nodes Displayed

Recall that the first bit of text displayed for each node is the element type. After
that comes the element name, if any, and then the element value. This view
shows three element types: Document, Comment, and Element. There is only one
node of Document type for the whole tree, the root node. The Comment node dis-
plays the value attribute, while the Element node displays the element name,
“slideshow”.

Compare Figure 6–1 with the code in the AdapterNode’s toString method to
see whether the name or value is being displayed for a particular node. If you
need to make it more clear, modify the program to indicate which property is
being displayed (for example, with N: name, V: value).

../examples/jaxp/dom/samples/DomEcho02.java
../examples/jaxp/dom/samples/slideSample01.xml
../examples/jaxp/dom/samples/slideSample01-xml.html
../examples/jaxp/dom/samples/slideSample01-xml.html
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Expanding the slideshow element brings up the display shown in Figure 6–2.

Figure 6–2 Element Node Expanded, No Attribute Nodes Showing

Here, you can see the Text nodes and Comment nodes that are interspersed
between Slide elements. The empty Text nodes exist because there is no DTD to
tell the parser that no text exists. (Generally, the vast majority of nodes in a
DOM tree will be Element and Text nodes.)

Important!
Text nodes exist under element nodes in a DOM, and data is always stored in
text nodes. Perhaps the most common error in DOM processing is to navigate to
an element node and expect it to contain the data that is stored in that element.
Not so! Even the simplest element node has a text node under it. For example,
given <size>12</size>, there is an element node (size), and a text node under
it which contains the actual data (12).

Notably absent from this picture are the Attribute nodes. An inspection of the
table in org.w3c.dom.Node shows that there is indeed an Attribute node type.
But they are not included as children in the DOM hierarchy. They are instead
obtained via the Node interface getAttributes method.
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Note: The display of the text nodes is the reason for including the lines below in the
AdapterNode’s toString method. If your remove them, you’ll see the funny char-
acters (typically square blocks) that are generated by the newline characters that are
in the text.

String t = domNode.getNodeValue().trim();
int x = t.indexOf(");
if (x >= 0) t = t.substring(0, x);
s += t;

Displaying a More Complex Tree
Here, you’ll display the example XML file you created at the end of the SAX
tutorial, to see how entity references, processing instructions, and CDATA sec-
tions appear in the DOM.

Note: The file displayed in this section is slideSample10.xml. The
slideSample10.xml file references slideshow3.dtd which, in turn, references
copyright.xml and a (very simplistic) xhtml.dtd. (The browsable versions are
slideSample10-xml.html, slideshow3-dtd.html, copyright-xml.html, and
xhtml-dtd.html.)

../examples/jaxp/dom/samples/slideSample10.xml
../examples/jaxp/dom/samples/slideSample10.xml
../examples/jaxp/dom/samples/slideshow3.dtd
../examples/jaxp/dom/samples/copyright.xml
../examples/jaxp/dom/samples/xhtml.dtd
../examples/jaxp/dom/samples/slideSample10-xml.html
../examples/jaxp/dom/samples/slideshow3-dtd.html
../examples/jaxp/dom/samples/copyright-xml.html
../examples/jaxp/dom/samples/xhtml-dtd.html
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Figure 6–3 shows the result of running the DomEcho application on
slideSample10.xml, which includes a DOCTYPE entry that identifies the docu-
ment’s DTD.

Figure 6–3 DocType Node Displayed

The DocType interface is actually an extension of w3c.org.dom.Node. It defines
a getEntities method that you would use to obtain Entity nodes—the nodes
that define entities like the product entity, which has the value “WonderWid-
gets”. Like Attribute nodes, Entity nodes do not appear as children of DOM
nodes.
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When you expand the slideshow node, you get the display shown in Figure 6–4.

Figure 6–4 Processing Instruction Node Displayed

Here, the processing instruction node is highlighted, showing that those nodes do
appear in the tree. The name property contains the target-specification, which
identifies the application that the instruction is directed to. The value property
contains the text of the instruction.

Note that empty text nodes are also shown here, even though the DTD specifies
that a slideshow can contain slide elements only, never text. Logically, then,
you might think that these nodes would not appear. (When this file was run
through the SAX parser, those elements generated ignorableWhitespace

events, rather than character events.)
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Moving down to the second slide element and opening the item element under
it brings up the display shown in Figure 6–5.

Figure 6–5 JAXP 1.2 DOM — Item Text Returned from an Entity Reference
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Here, you can see that a text node containing the copyright text was inserted into
the DOM, rather than the entity reference which pointed to it.

For most applications, the insertion of the text is exactly what you want. That
way, when you’re looking for the text under a node, you don’t have to worry
about an entity references it might contain.

For other applications, though, you may need the ability to reconstruct the origi-
nal XML. For example, an editor application would need to save the result of
user modifications without throwing away entity references in the process.

Various DocumentBuilderFactory APIs give you control over the kind of DOM
structure that is created. For example, add the highlighted line below to produce
the DOM structure shown in Figure 6–6.

public static void main(String argv[])
{

...
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance();
factory.setExpandEntityReferences(false);
...
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Figure 6–6 JAXP 1.1 in 1.4 Platform— Entity Reference Node Displayed

Here, the Entity Reference node is highlighted. Note that the entity reference
contains multiple nodes under it. This example shows only comment and a text
nodes, but the entity could conceivably contain other element nodes, as well.
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Finally, moving down to the last item element under the last slide brings up the
display shown in Figure 6–7.

Figure 6–7 CDATA Node Displayed

Here, the CDATA node is highlighted. Note that there are no nodes under it. Since
a CDATA section is entirely uninterpreted, all of its contents are contained in the
node’s value property.

Summary of Lexical Controls
Lexical information is the information you need to reconstruct the original syn-
tax of an XML document. As we discussed earlier, preserving lexical informa-
tion is important for editing applications, where you want to save a document
that is an accurate reflection of the original—complete with comments, entity
references, and any CDATA sections it may have included at the outset.

A majority of applications, however, are only concerned with the content of the
XML structures. They can afford to ignore comments, and they don’t care
whether data was coded in a CDATA section, as plain text, or whether it included
an entity reference. For such applications, a minimum of lexical information is
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desirable, because it simplifies the number and kind of DOM nodes that the
application has to be prepared to examine.

The following DocumentBuilderFactory methods give you control over the
lexical information you see in the DOM:

• setCoalescing()

To convert CDATA nodes to Text node and append to an adjacent Text
node (if any).

• setExpandEntityReferences()

To expand entity reference nodes.

• setIgnoringComments()

To ignore comments.

• setIgnoringElementContentWhitespace()

To ignore whitespace that is not a significant part of element content.

The default values for all of these properties is false, which preserves all the
lexical information necessary to reconstruct the incoming document in its origi-
nal form. Setting them to true lets you construct the simplest possible DOM, so
the application can focus on the data’s semantic content, without having to worry
about lexical syntax details. Table 6–2 summarizes the effect of the settings.

Finishing Up
At this point, you have seen most of the nodes you will ever encounter in a DOM
tree. There are one or two more that we’ll mention in the next section, but you

Table 6–2 Configuring DocumentBuilderFactory

API Preserve Lexical Info Focus on Content

setCoalescing() false true

setExpandEntityRefer-
ences()

false true

setIgnoringComments() false true

setIgnoringElement
ContentWhitespace()

false true
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now know what you need to know to create or modify a DOM structure. In the
next section, you’ll see how to convert a DOM into a JTree that is suitable for an
interactive GUI. Or, if you prefer, you can skip ahead to the 5th section of the
DOM tutorial, Creating and Manipulating a DOM (page 244), where you’ll learn
how to create a DOM from scratch.

Constructing a User-Friendly JTree from
a DOM

Now that you know what a DOM looks like internally, you’ll be better prepared
to modify a DOM or construct one from scratch. Before going on to that, though,
this section presents some modifications to the JTreeModel that let you produce
a more user-friendly version of the JTree suitable for use in a GUI.

Compressing the Tree View
Displaying the DOM in tree form is all very well for experimenting and to learn
how a DOM works. But it’s not the kind of “friendly” display that most users
want to see in a JTree. However, it turns out that very few modifications are
needed to turn the TreeModel adapter into something that will present a user-
friendly display. In this section, you’ll make those modifications.

Note: The code discussed in this section is in DomEcho03.java. The file it operates
on is slideSample01.xml. (The browsable version is slideSample01-xml.html.)

Make the Operation Selectable
When you modify the adapter, you’re going to compress the view of the DOM,
eliminating all but the nodes you really want to display. Start by defining a bool-
ean variable that controls whether you want the compressed or uncompressed
view of the DOM:

public class DomEcho extends JPanel
{

static Document document;
boolean compress = true;

 static final int windowHeight = 460;
 ...

../examples/jaxp/dom/samples/DomEcho03.java
../examples/jaxp/dom/samples/slideSample01.xml
../examples/jaxp/dom/samples/slideSample01-xml.html
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Identify Tree Nodes

The next step is to identify the nodes you want to show up in the tree. To do that,
add the code highlighted below:

...
import org.w3c.dom.Document;
import org.w3c.dom.DOMException;
import org.w3c.dom.Node;

public class DomEcho extends JPanel
{

...

public static void makeFrame() {
...

}

// An array of names for DOM node-type
static final String[] typeName = {

...
};

static final int ELEMENT_TYPE = Node.ELEMENT_NODE;

// The list of elements to display in the tree
static String[] treeElementNames = {

"slideshow",
"slide",
"title",         // For slideshow #1
"slide-title",   // For slideshow #10
"item",

};

boolean treeElement(String elementName) {
for (int i=0; i<treeElementNames.length; i++) {

if ( elementName.equals(treeElementNames[i]) )
return true;

}
return false;

}

With this code, you set up a constant you can use to identify the ELEMENT node
type, declared the names of the elements you want in the tree, and created a
method tells whether or not a given element name is a “tree element”. Since
slideSample01.xml has title elements and slideSample10.xml has slide-
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title elements, you set up the contents of this arrays so it would work with
either data file.

Note: The mechanism you are creating here depends on the fact that structure nodes
like slideshow and slide never contain text, while text usually does appear in con-
tent nodes like item. Although those “content” nodes may contain subelements in
slideShow10.xml, the DTD constrains those subelements to be XHTML nodes.
Because they are XHTML nodes (an XML version of HTML that is constrained to
be well-formed), the entire substructure under an item node can be combined into
a single string and displayed in the htmlPane that makes up the other half of the
application window. In the second part of this section, you’ll do that concatenation,
displaying the text and XHTML as content in the htmlPane.

Although you could simply reference the node types defined in the class,
org.w3c.dom.Node, defining the ELEMENT_TYPE constant keeps the code a little
more readable. Each node in the DOM has a name, a type, and (potentially) a list
of subnodes. The functions that return these values are getNodeName(), getNo-
deType, and getChildNodes(). Defining our own constants will let us write
code like this:

Node node = nodeList.item(i);
int type = node.getNodeType();
if (type == ELEMENT_TYPE) {

....

As a stylistic choice, the extra constants help us keep the reader (and ourselves!)
clear about what we’re doing. Here, it is fairly clear when we are dealing with a
node object, and when we are dealing with a type constant. Otherwise, it would
be fairly tempting to code something like, if (node == ELEMENT_NODE), which
of course would not work at all.

Control Node Visibility
The next step is to modify the AdapterNode’s childCount function so that it
only counts “tree element” nodes—nodes which are designated as displayable in
the JTree. Make the modifications highlighted below to do that:

public class DomEcho extends JPanel
{

...
public class AdapterNode
{
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...
public AdapterNode child(int searchIndex) {

...
}
public int childCount() {

if (!compress) {
// Indent this
return domNode.getChildNodes().getLength();

}
int count = 0;
for (int i=0;

i<domNode.getChildNodes().getLength(); i++)
{

org.w3c.dom.Node node =
domNode.getChildNodes().item(i);

if (node.getNodeType() == ELEMENT_TYPE
&& treeElement( node.getNodeName() ))
{

++count;
}

}
return count;

}
} // AdapterNode

The only tricky part about this code is checking to make sure the node is an ele-
ment node before comparing the node. The DocType node makes that necessary,
because it has the same name, “slideshow”, as the slideshow element.

Control Child Access
Finally, you need to modify the AdapterNode’s child function to return the Nth
item from the list of displayable nodes, rather than the Nth item from all nodes in
the list. Add the code highlighted below to do that:

public class DomEcho extends JPanel
{

...
public class AdapterNode
{

...
public int index(AdapterNode child) {

...
}
public AdapterNode child(int searchIndex) {
//Note: JTree index is zero-based.



232 DOCUMENT OBJECT MODEL
org.w3c.dom.Node node =
domNode.getChildNodes()Item(searchIndex);

if (compress) {
// Return Nth displayable node
int elementNodeIndex = 0;
for (int i=0;

i<domNode.getChildNodes().getLength(); i++)
{

node = domNode.getChildNodes()Item(i);
if (node.getNodeType() == ELEMENT_TYPE
&& treeElement( node.getNodeName() )
&& elementNodeIndex++ == searchIndex) {

break;
}

}
}
return new AdapterNode(node);

} // child
}  // AdapterNode

There’s nothing special going on here. It’s a slightly modified version the same
logic you used when returning the child count.

Check the Results
When you compile and run this version of the application on
slideSample01.xml, and then expand the nodes in the tree, you see the results
shown in Figure 6–8. The only nodes remaining in the tree are the high-level
“structure” nodes.
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Figure 6–8 Tree View with a Collapsed Hierarchy

Extra Credit
The way the application stands now, the information that tells the application
how to compress the tree for display is “hard-coded”. Here are some ways you
could consider extending the app:

Use a Command-Line Argument
Whether you compress or don’t compress the tree could be determined by a
command line argument, rather than being a hard-coded boolean variable.
On the other hand, the list the list of elements that goes into the tree is still
hard coded, so maybe that option doesn’t make much sense, unless...

Read the treeElement list from a file
If you read the list of elements to include in the tree from an external file,
that would make the whole application command driven. That would be
good. But wouldn’t it be really nice to derive that information from the DTD
or schema, instead? So you might want to consider...

Automatically Build the List
Watch out, though! As things stand right now, there are no standard DTD
parsers! If you use a DTD, then, you’ll need to write your parser to make
sense out of its somewhat arcane syntax. You’ll probably have better luck if
you use a schema, instead of a DTD. The nice thing about schemas is that
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use XML syntax, so you can use an XML parser to read the schema the same
way you use any other file.

As you analyze the schema, note that the JTree-displayable structure nodes
are those that have no text, while the content nodes may contain text and,
optionally, XHTML subnodes. That distinction works for this example, and
will likely work for a large body of real-world applications. It’s pretty easy
to construct cases that will create a problem, though, so you’ll have to be on
the lookout for schema/DTD specifications that embed non-XHTML ele-
ments in text-capable nodes, and take the appropriate action.

Acting on Tree Selections
Now that the tree is being displayed properly, the next step is to concatenate the
subtrees under selected nodes to display them in the htmlPane. While you’re at
it, you’ll use the concatenated text to put node-identifying information back in
the JTree.

Note: The code discussed in this section is in DomEcho04.java.

Identify Node Types
When you concatenate the subnodes under an element, the processing you do is
going to depend on the type of node. So the first thing to is to define constants
for the remaining node types. Add the code highlighted below to do that:

public class DomEcho extends JPanel
{

...
// An array of names for DOM node-types
static final String[] typeName = {

...
};
static final int ELEMENT_TYPE =   1;
static final int ATTR_TYPE =Node.ATTRIBUTE_NODE;
static final int TEXT_TYPE =Node.TEXT_NODE;
static final int CDATA_TYPE = Node.CDATA_SECTION_NODE;
static final int ENTITYREF_TYPE =

Node.ENTITY_REFERENCE_NODE;
static final int ENTITY_TYPE =Node.ENTITY_NODE;
static final int PROCINSTR_TYPE =

 Node.PROCESSING_INSTRUCTION_NODE;

../examples/jaxp/dom/samples/DomEcho04.java
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static final int COMMENT_TYPE = Node.COMMENT_NODE;
static final int DOCUMENT_TYPE =Node.DOCUMENT_NODE;
static final int DOCTYPE_TYPE =Node.DOCUMENT_TYPE_NODE;
static final int DOCFRAG_TYPE =Node.DOCUMENT_FRAGMENT_NODE;
static final int NOTATION_TYPE =Node.NOTATION_NODE;

Concatenate Subnodes to Define Element
Content
Next, you need to define add the method that concatenates the text and subnodes
for an element and returns it as the element’s “content”. To define the content

method, you’ll need to add the big chunk of code highlighted below, but this is
the last big chunk of code in the DOM tutorial!.

public class DomEcho extends JPanel
{

...
public class AdapterNode
{

...
public String toString() {
...
}
public String content() {

String s = "";
org.w3c.dom.NodeList nodeList =

domNode.getChildNodes();
for (int i=0; i<nodeList.getLength(); i++) {

org.w3c.dom.Node node = nodeList.item(i);
int type = node.getNodeType();
AdapterNode adpNode = new AdapterNode(node);
if (type == ELEMENT_TYPE) {

if ( treeElement(node.getNodeName()) )
continue;

s += "<" + node.getNodeName() + ">";
s += adpNode.content();
s += "</" + node.getNodeName() + ">";

} else if (type == TEXT_TYPE) {
s += node.getNodeValue();

} else if (type == ENTITYREF_TYPE) {
// The content is in the TEXT node under it
s += adpNode.content();

} else if (type == CDATA_TYPE) {
StringBuffer sb = new StringBuffer(

node.getNodeValue() );
for (int j=0; j<sb.length(); j++) {
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if (sb.charAt(j) == '<') {
sb.setCharAt(j, '&');
sb.insert(j+1, "lt;");
j += 3;

} else if (sb.charAt(j) == '&') {
sb.setCharAt(j, '&');
sb.insert(j+1, "amp;");
j += 4;

}
}
s += "<pre>" + sb + "</pre>";

}
}
return s;

}
...

} // AdapterNode

Note: This code collapses EntityRef nodes, as inserted by the JAXP 1.1 parser that
ins included in the 1.4 Java platform. With JAXP 1.2, that portion of the code is not
necessary because entity references are converted to text nodes by the parser. Other
parsers may well insert such nodes, however, so including this code “future proofs”
your application, should you use a different parser in the future.

Although this code is not the most efficient that anyone ever wrote, it works and
it will do fine for our purposes. In this code, you are recognizing and dealing
with the following data types:

Element
For elements with names like the XHTML “em” node, you return the node’s
content sandwiched between the appropriate <em> and </em> tags. However,
when processing the content for the slideshow element, for example, you
don’t include tags for the slide elements it contains so, when returning a
node’s content, you skip any subelements that are themselves displayed in
the tree.

Text
No surprise here. For a text node, you simply return the node’s value.

Entity Reference
Unlike CDATA nodes, Entity References can contain multiple subelements.
So the strategy here is to return the concatenation of those subelements.
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CDATA
Like a text node, you return the node’s value. However, since the text in this
case may contain angle brackets and ampersands, you need to convert them
to a form that displays properly in an HTML pane. Unlike the XML CDATA
tag, the HTML <pre> tag does not prevent the parsing of character-format
tags, break tags and the like. So you have to convert left-angle brackets (<)
and ampersands (&) to get them to display properly.

On the other hand, there are quite a few node types you are not processing with
the code above. It’s worth a moment to examine them and understand why:

Attribute
These nodes do not appear in the DOM, but are obtained by invoking
getAttributes on element nodes.

Entity
These nodes also do not appear in the DOM. They are obtained by invoking
getEntities on DocType nodes.

Processing Instruction
These nodes don’t contain displayable data.

Comment
Ditto. Nothing you want to display here.

Document
This is the root node for the DOM. There’s no data to display for that.

DocType
The DocType node contains the DTD specification, with or without external
pointers. It only appears under the root node, and has no data to display in
the tree.

Document Fragment
This node is equivalent to a document node. It’s a root node that the DOM
specification intends for holding intermediate results during cut/paste opera-
tions, for example. Like a document node, there’s no data to display.

Notation
We’re just flat out ignoring this one. These nodes are used to include binary
data in the DOM. As discussed earlier in Choosing your Parser Implementa-
tion and Using the DTDHandler and EntityResolver (page 184), the MIME
types (in conjunction with namespaces) make a better mechanism for that.
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Display the Content in the JTree
With the content-concatenation out of the way, only a few small programming
steps remain. The first is to modify toString so that it uses the first line of the
node’s content for identifying information. Add the code highlighted below to do
that:

public class DomEcho extends JPanel
{

...
public class AdapterNode
{

...
public String toString() {

...
if (! nodeName.startsWith("#")) {

s += ": " + nodeName;
}
if (compress) {

String t = content().trim();
int x = t.indexOf("\n”);
if (x >= 0) t = t.substring(0, x);
s += " " + t;
return s;

}
if (domNode.getNodeValue() != null) {

...
}
return s;

}

Wire the JTree to the JEditorPane
Returning now to the app’s constructor, create a tree selection listener and use to
wire the JTree to the JEditorPane:

public class DomEcho extends JPanel
{

...
public DomEcho()
{

...
// Build right-side view
JEditorPane htmlPane = new JEditorPane("text/html","");
htmlPane.setEditable(false);
JScrollPane htmlView = new JScrollPane(htmlPane);
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htmlView.setPreferredSize(
new Dimension( rightWidth, windowHeight ));

tree.addTreeSelectionListener(
new TreeSelectionListener() {

public void valueChanged(TreeSelectionEvent e)
{
TreePath p = e.getNewLeadSelectionPath();
if (p != null) {
AdapterNode adpNode =

(AdapterNode)
p.getLastPathComponent();

htmlPane.setText(adpNode.content());
}

}
}

);

Now, when a JTree node is selected, it’s contents are delivered to the htmlPane.

Note: The TreeSelectionListener in this example is created using an anonymous
inner-class adapter. If you are programming for the 1.1 version of the platform,
you’ll need to define an external class for this purpose.

If you compile this version of the app, you’ll discover immediately that the htm-

lPane needs to be specified as final to be referenced in an inner class, so add
the keyword highlighted below:

public DomEcho04()
{

...
// Build right-side view
final JEditorPane htmlPane = new

JEditorPane("text/html","");
htmlPane.setEditable(false);
JScrollPane htmlView = new JScrollPane(htmlPane);
htmlView.setPreferredSize(

new Dimension( rightWidth, windowHeight ));

Run the App
When you compile the application and run it on slideSample10.xml (the
browsable version is slideSample10-xml.html), you get a display like that

../examples/jaxp/dom/samples/slideSample10.xml
../examples/jaxp/dom/samples/slideSample10-xml.html
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shown in Figure 6–9. Expanding the hierarchy shows that the JTree now
includes identifying text for a node whenever possible.

Figure 6–9 Collapsed Hierarchy Showing Text in Nodes
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Selecting an item that includes XHTML subelements produces a display like
that shown in Figure 6–10:

Figure 6–10 Node with <em> Tag Selected
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Selecting a node that contains an entity reference causes the entity text to be
included, as shown in Figure 6–11:

Figure 6–11 Node with Entity Reference Selected
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Finally, selecting a node that includes a CDATA section produces results like those
shown in Figure 6–12:

Figure 6–12 Node with CDATA Component Selected

Extra Credit
Now that you have the application working, here are some ways you might think
about extending it in the future:

Use Title Text to Identify Slides
Special case the slide element so that the contents of the title node is
used as the identifying text. When selected, convert the title node’s contents
to a centered H1 tag, and ignore the title element when constructing the
tree.

Convert Item Elements to Lists
Remove item elements from the JTree and convert them to HTML lists
using <ul>, <li>, </ul> tags, including them in the slide’s content when the
slide is selected.
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Handling Modifications
A full discussion of the mechanisms for modifying the JTree’s underlying data
model is beyond the scope of this tutorial. However, a few words on the subject
are in order.

Most importantly, note that if you allow the user to modifying the structure by
manipulating the JTree, you have take the compression into account when you
figure out where to apply the change. For example, if you are displaying text in
the tree and the user modifies that, the changes would have to be applied to text
subelements, and perhaps require a rearrangement of the XHTML subtree.

When you make those changes, you’ll need to understand more about the inter-
actions between a JTree, it’s TreeModel, and an underlying data model. That
subject is covered in depth in the Swing Connection article, Understanding the
TreeModel at http://java.sun.com/products/jfc/tsc/articles/jtree/

index.html.

Finishing Up
You now understand pretty much what there is know about the structure of a
DOM, and you know how to adapt a DOM to create a user-friendly display in a
JTree. It has taken quite a bit of coding, but in return you have obtained valuable
tools for exposing a DOM’s structure and a template for GUI apps. In the next
section, you’ll make a couple of minor modifications to the code that turn the
application into a vehicle for experimentation, and then experiment with build-
ing and manipulating a DOM.

Creating and Manipulating a DOM
By now, you understand the structure of the nodes that make up a DOM. A DOM
is actually very easy to create. This section of the DOM tutorial is going to take
much less work than anything you’ve see up to now. All the foregoing work,
however, generated the basic understanding that will make this section a piece of
cake.

http://java.sun.com/products/jfc/tsc/articles/jtree/
http://java.sun.com/products/jfc/tsc/articles/jtree/
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Obtaining a DOM from the Factory
In this version of the application, you’re still going to create a document builder
factory, but this time you’re going to tell it create a new DOM instead of parsing
an existing XML document. You’ll keep all the existing functionality intact,
however, and add the new functionality in such a way that you can “flick a
switch” to get back the parsing behavior.

Note: The code discussed in this section is in DomEcho05.java.

Modify the Code
Start by turning off the compression feature. As you work with the DOM in this
section, you’re going to want to see all the nodes:

public class DomEcho05  extends JPanel
{

...
boolean compress = true;
boolean compress = false;

Next, you need to create a buildDom method that creates the document object.
The easiest way to do that is to create the method and then copy the DOM-con-
struction section from the main method to create the buildDom. The modifica-
tions shown below show you the changes you need to make to make that code
suitable for the buildDom method.

public class DomEcho05  extends JPanel
{

...
public static void makeFrame() {

...
}
public static void buildDom()
{

DocumentBuilderFactory factory =
DocumentBuilderFactory.newInstance();

try {
DocumentBuilder builder =

factory.newDocumentBuilder();
document = builder.parse( new File(argv[0]) );
document = builder.newDocument();

} catch (SAXException sxe) {

../examples/jaxp/dom/samples/DomEcho05.java
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...
 } catch (ParserConfigurationException pce) {

// Parser with specified options can't be built
pce.printStackTrace();

} catch (IOException ioe) {
...

}
}

In this code, you replaced the line that does the parsing with one that creates a
DOM. Then, since the code is no longer parsing an existing file, you removed
exceptions which are no longer thrown: SAXException and IOException.

And since you are going to be working with Element objects, add the statement
to import that class at the top of the program:

import org.w3c.dom.Document;
import org.w3c.dom.DOMException;
import org.w3c.dom.Element;

Create Element and Text Nodes
Now, for your first experiment, add the Document operations to create a root
node and several children:

public class DomEcho05  extends JPanel
{

...
public static void buildDom()
{

DocumentBuilderFactory factory =
DocumentBuilderFactory.newInstance();

try {
DocumentBuilder builder =

factory.newDocumentBuilder();
document = builder.newDocument();
// Create from whole cloth
 Element root =

(Element)
document.createElement("rootElement");

document.appendChild(root);
root.appendChild(

document.createTextNode("Some") );
root.appendChild(

document.createTextNode(" ")    );
root.appendChild(
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document.createTextNode("text") );
} catch (ParserConfigurationException pce) {

// Parser with specified options can't be built
pce.printStackTrace();

}
}

Finally, modify the argument-list checking code at the top of the main method so
you invoke buildDom and makeFrame instead of generating an error, as shown
below:

public class DomEcho05  extends JPanel
{

...
public static void main(String argv[])
{

if (argv.length != 1) {
System.err.println("...");
System.exit(1);
buildDom();
makeFrame();
return;

}

That’s all there is to it! Now, if you supply an argument the specified file is
parsed and, if you don’t, the experimental code that builds a DOM is executed.

Run the App
Compile and run the program with no arguments produces the result shown in
Figure 6–13:
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Figure 6–13 Element Node and Text Nodes Created

 Normalizing the DOM
In this experiment, you’ll manipulate the DOM you created by normalizing it
after it has been constructed.

Note: The code discussed in this section is in DomEcho06.java.

Add the code highlighted below to normalize the DOM:.

public static void buildDom()
{

DocumentBuilderFactory factory =
DocumentBuilderFactory.newInstance();

try {
...
root.appendChild( document.createTextNode("Some") );
root.appendChild( document.createTextNode(" ")    );
root.appendChild( document.createTextNode("text") );
document.getDocumentElement().normalize();

} catch (ParserConfigurationException pce) {
...

../examples/jaxp/dom/samples/DomEcho06.java
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In this code, getDocumentElement returns the document’s root node, and the
normalize operation manipulates the tree under it.

When you compile and run the application now, the result looks like Figure 6–
14:

Figure 6–14 Text Nodes Merged After Normalization

Here, you can see that the adjacent text nodes have been combined into a single
node. The normalize operation is one that you will typically want to use after
making modifications to a DOM, to ensure that the resulting DOM is as compact
as possible.

Note: Now that you have this program to experiment with, see what happens to
other combinations of CDATA, entity references, and text nodes when you normalize
the tree.



250 DOCUMENT OBJECT MODEL
Other Operations
To complete this section, we’ll take a quick look at some of the other operations
you might want to apply to a DOM, including:

• Traversing nodes

• Searching for nodes

• Obtaining node content

• Creating attributes

• Removing and changing nodes

• Inserting nodes

Traversing Nodes
The org.w3c.dom.Node interface defines a number of methods you can use to
traverse nodes, including getFirstChild, getLastChild, getNextSibling,
getPreviousSibling, and getParentNode. Those operations are sufficient to
get from anywhere in the tree to any other location in the tree.

Searching for Nodes
However, when you are searching for a node with a particular name, there is a bit
more to take into account. Although it is tempting to get the first child and
inspect it to see if it is the right one, the search has to account for the fact that the
first child in the sublist could be a comment or a processing instruction. If the
XML data wasn’t validated, it could even be a text node containing ignorable
whitespace.

In essence, you need to look through the list of child nodes, ignoring the ones
that are of no concern, and examining the ones you care about. Here is an exam-
ple of the kind of routine you need to write when searching for nodes in a DOM
hierarchy. It is presented here in its entirety (complete with comments) so you
can use it for a template in your applications.

/**
* Find the named subnode in a node's sublist.
 * <li>Ignores comments and processing instructions.
 * <li>Ignores TEXT nodes (likely to exist and contain

ignorable whitespace,
 *     if not validating.
 * <li>Ignores CDATA nodes and EntityRef nodes.
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 * <li>Examines element nodes to find one with the specified
name.
 * </ul>
 * @param name  the tag name for the element to find
 * @param node  the element node to start searching from
 * @return the Node found
 */

public Node findSubNode(String name, Node node) {
if (node.getNodeType() != Node.ELEMENT_NODE) {

System.err.println("Error: Search node not of element
type");

System.exit(22);
}

if (! node.hasChildNodes()) return null;

NodeList list = node.getChildNodes();
for (int i=0; i < list.getLength(); i++) {

Node subnode = list.item(i);
if (subnode.getNodeType() == Node.ELEMENT_NODE) {

if (subnode.getNodeName() == name) return subnode;
}

}
return null;

}

For a deeper explanation of this code, see Increasing the Complexity (page 191)
in When to Use DOM.

Note, too, that you can use APIs described in Summary of Lexical
Controls (page 226) to modify the kind of DOM the parser constructs. The nice
thing about this code, though, is that will work for most any DOM.

Obtaining Node Content
When you want to get the text that a node contains, you once again need to look
through the list of child nodes, ignoring entries that are of no concern, and accu-
mulating the text you find in TEXT nodes, CDATA nodes, and EntityRef nodes.

Here is an example of the kind of routine you need to use for that process:

/**
 * Return the text that a node contains. This routine:<ul>
 * <li>Ignores comments and processing instructions.
* <li>Concatenates TEXT nodes, CDATA nodes, and the results of
 *     recursively processing EntityRef nodes.
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 * <li>Ignores any element nodes in the sublist.
 *     (Other possible options are to recurse into element

sublists
 *      or throw an exception.)
 * </ul>
 * @param    node  a  DOM node
 * @return   a String representing its contents
 */

public String getText(Node node) {
StringBuffer result = new StringBuffer();
if (! node.hasChildNodes()) return "";

NodeList list = node.getChildNodes();
for (int i=0; i < list.getLength(); i++) {

Node subnode = list.item(i);
if (subnode.getNodeType() == Node.TEXT_NODE) {

result.append(subnode.getNodeValue());
}
else if (subnode.getNodeType() ==

Node.CDATA_SECTION_NODE)
{

result.append(subnode.getNodeValue());
}
else if (subnode.getNodeType() ==

Node.ENTITY_REFERENCE_NODE)
{

// Recurse into the subtree for text
// (and ignore comments)
result.append(getText(subnode));

}
}
return result.toString();

}

For a deeper explanation of this code, see Increasing the Complexity (page 191)
in When to Use DOM.

Again, you can simplify this code by using the APIs described in Summary of
Lexical Controls (page 226) to modify the kind of DOM the parser constructs.
But the nice thing about this code, once again, is that will work for most any
DOM.

Creating Attributes
The org.w3c.dom.Element interface, which extends Node, defines a setAt-

tribute operation, which adds an attribute to that node. (A better name from the
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Java platform standpoint would have been addAttribute, since the attribute is
not a property of the class, and since a new object is created.)

You can also use the Document’s createAttribute operation to create an
instance of Attribute, and use the setAttributeNode method to add it.

Removing and Changing Nodes
To remove a node, you use its parent Node’s removeChild method. To change it,
you can either use the parent node’s replaceChild operation or the node’s set-
NodeValue operation.

Inserting Nodes
The important thing to remember when creating new nodes is that when you cre-
ate an element node, the only data you specify is a name. In effect, that node
gives you a hook to hang things on. You “hang an item on the hook” by adding to
its list of child nodes. For example, you might add a text node, a CDATA node,
or an attribute node. As you build, keep in mind the structure you examined in
the exercises you’ve seen in this tutorial. Remember: Each node in the hierarchy
is extremely simple, containing only one data element.

Finishing Up
Congratulations! You’ve learned how a DOM is structured and how to manipu-
late it. And you now have a DomEcho application that you can use to display a
DOM’s structure, condense it down to GUI-compatible dimensions, and experi-
ment with to see how various operations affect the structure. Have fun with it!

Validating with XML Schema
You’re now ready to take a deeper look at the process of XML Schema valida-
tion. Although a full treatment of XML Schema is beyond the scope of this tuto-
rial, this section will show you the steps you need to take to validate an XML
document using an XML Schema definition. (To learn more about XML
Schema, you can review the online tutorial, XML Schema Part 0: Primer, at
http://www.w3.org/TR/xmlschema-0/. You can also examine the sample programs

http://www.w3.org/TR/xmlschema-0/
http://www.w3.org/TR/xmlschema-0/
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that are part of the JAXP download. They use a simple XML Schema definition to vali-
date personnel data stored in an XML file.)

Note: There are multiple schema-definition languages, including RELAX NG,
Schematron, and the W3C “XML Schema” standard. (Even a DTD qualifies as a
“schema”, although it is the only one that does not use XML syntax to describe
schema constraints.) However, “XML Schema” presents us with a terminology
challenge. While the phrase “XML Schema schema” would be precise, we’ll use the
phrase “XML Schema definition” to avoid the semblance of redundancy.

At the end of this section, you’ll also learn how to use an XML Schema defini-
tion to validate a document that contains elements from multiple namespaces.

Overview of the Validation Process
To be notified of validation errors in an XML document,

1. The factory must configured, and the appropriate error handler set.

2. The document must be associated with at least one schema, and possibly
more.

Configuring the DocumentBuilder
Factory
It’s helpful to start by defining the constants you’ll use when configuring the fac-
tory. (These are same constants you define when using XML Schema for SAX
parsing.)

static final String JAXP_SCHEMA_LANGUAGE =
"http://java.sun.com/xml/jaxp/properties/schemaLanguage";

static final String W3C_XML_SCHEMA =
"http://www.w3.org/2001/XMLSchema";
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Next, you need to configure DocumentBuilderFactory to generate a
namespace-aware, validating parser that uses XML Schema:

...
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance()
factory.setNamespaceAware(true);
factory.setValidating(true);

try {
factory.setAttribute(JAXP_SCHEMA_LANGUAGE, W3C_XML_SCHEMA);

}
catch (IllegalArgumentException x) {

// Happens if the parser does not support JAXP 1.2
...

}

Since JAXP-compliant parsers are not namespace-aware by default, it is neces-
sary to set the property for schema validation to work. You also set a factory
attribute specify the parser language to use. (For SAX parsing, on the other hand,
you set a property on the parser generated by the factory.)

Associating a Document with a Schema
Now that the program is ready to validate with an XML Schema definition, it is
only necessary to ensure that the XML document is associated with (at least)
one. There are two ways to do that:

1. With a schema declaration in the XML document.

2. By specifying the schema(s) to use in the application.

Note: When the application specifies the schema(s) to use, it overrides any schema
declarations in the document.

To specify the schema definition in the document, you would create XML like
this:

<documentRoot
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation='YourSchemaDefinition.xsd'

>
...



256 DOCUMENT OBJECT MODEL
The first attribute defines the XML NameSpace (xmlns) prefix, “xsi”, where
“xsi” stands for “XML Schema Instance”. The second line specifies the schema
to use for elements in the document that do not have a namespace prefix — that
is, for the elements you typically define in any simple, uncomplicated XML doc-
ument. (You’ll see how to deal with multiple namespaces in the next section.)

You can also specify the schema file in the application, like this:

static final String schemaSource = "YourSchemaDefinition.xsd";
static final String JAXP_SCHEMA_SOURCE =

"http://java.sun.com/xml/jaxp/properties/schemaSource";
...
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance()
...
factory.setAttribute(JAXP_SCHEMA_SOURCE,

new File(schemaSource));

Here, too, there are mechanisms at your disposal that will let you specify multi-
ple schemas. We’ll take a look at those next.

Validating with Multiple Namespaces
Namespaces let you combine elements that serve different purposes in the same
document, without having to worry about overlapping names.

Note: The material discussed in this section also applies to validating when using
the SAX parser. You’re seeing it here, because at this point you’ve learned enough
about namespaces for the discussion to make sense.

To contrive an example, consider an XML data set that keeps track of personnel
data. The data set may include information from the w2 tax form, as well as
information from the employee’s hiring form, with both elements named <form>

in their respective schemas.

If a prefix is defined for the “tax” namespace, and another prefix defined for the
“hiring” namespace, then the personnel data could include segments like this:

<employee id=”...”>
<name>....</name>
<tax:form>

...w2 tax form data...
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</tax:form>
<hiring:form>

...employment history, etc....
</hiring:form>

</employee>

The contents of the tax:form element would obviously be different from the
contents of the hiring:form, and would have to be validated differently.

Note, too, that there is a “default” namespace in this example, that the unquali-
fied element names employee and name belong to. For the document to be prop-
erly validated, the schema for that namespace must be declared, as well as the
schemas for the tax and hiring namespaces.

Note: The “default” namespace is actually a specific namespace. It is defined as the
“namespace that has no name”. So you can’t simply use one namespace as your
default this week, and another namespace as the default later on. This “unnamed
namespace” or “null namespace” is like the number zero. It doesn’t have any value,
to speak of (no name), but it is still precisely defined. So a namespace that does have
a name can never be used as the “default” namespace.

When parsed, each element in the data set will be validated against the appropri-
ate schema, as long as those schemas have been declared. Again, the schemas
can either be declared as part of the XML data set, or in the program. (It is also
possible to mix the declarations. In general, though, it is a good idea to keep all
of the declarations together in one place.)

Declaring the Schemas in the XML Data Set
To declare the schemas to use for the example above in the data set, the XML
code would look something like this:

<documentRoot
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="employeeDatabase.xsd"
xsi:schemaLocation=

”http://www.irs.gov/ fullpath/w2TaxForm.xsd
 http://www.ourcompany.com/ relpath/hiringForm.xsd“

xmlns:tax="http://www.irs.gov/"
xmlns:hiring="http://www.ourcompany.com/"

>
...
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The noNamespaceSchemaLocation declaration is something you’ve seen before,
as are the last two entries, which define the namespace prefixes tax and hiring.
What’s new is the entry in the middle, which defines the locations of the schemas
to use for each namespace referenced in the document.

The xsi:schemaLocation declaration consists of entry pairs, where the first
entry in each pair is a fully qualified URI that specifies the namespace, and the
second entry contains a full path or a relative path to the schema definition. (In
general, fully qualified paths are recommended. That way, only one copy of the
schema will tend to exist.)

Of particular note is the fact that the namespace prefixes cannot be used when
defining the schema locations. The xsi:schemaLocation declaration only
understands namespace names, not prefixes.

Declaring the Schemas in the Application
To declare the equivalent schemas in the application, the code would look some-
thing like this:

static final String employeeSchema = "employeeDatabase.xsd";
static final String taxSchema = "w2TaxForm.xsd";
static final String hiringSchema = "hiringForm.xsd";

static final String[] schemas = {
employeeSchema,
taxSchema,
hiringSchema,
};

static final String JAXP_SCHEMA_SOURCE =
"http://java.sun.com/xml/jaxp/properties/schemaSource";

...
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance()
...
factory.setAttribute(JAXP_SCHEMA_SOURCE, schemas);

Here, the array of strings that points to the schema definitions (.xsd files) is
passed as the argument to factory.setAttribute method. Note the differences from
when you were declaring the schemas to use as part of the XML data set:

• There is no special declaration for the “default” (unnamed) schema.
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• You don’t specify the namespace name. Instead, you only give pointers to
the .xsd files.

To make the namespace assignments, the parser reads the .xsd files, and finds in
them the name of the target namespace they apply to. Since the files are speci-
fied with URIs, the parser can use an EntityResolver (if one has been defined) to
find a local copy of the schema.

If the schema definition does not define a target namespace, then it applies to the
“default” (unnamed, or null) namespace. So, in the example above, you would
expect to see these target namespace declarations in the schemas:

• employeeDatabase.xsd — none

• w2TaxForm.xsd — http://www.irs.gov/

• hiringForm.xsd — http://www.ourcompany.com

At this point, you have seen two possible values for the schema source property
when invoking the factory.setAttribute() method, a File object in fac-

tory.setAttribute(JAXP_SCHEMA_SOURCE, new File(schemaSource)). and
an array of strings in factory.setAttribute(JAXP_SCHEMA_SOURCE, sche-

mas). Here is a complete list of the possible values for that argument:

• String that points to the URI of the schema

• InputStream with the contents of the schema

• SAX InputSource

• File

• an array of Objects, each of which is one of the types defined above.

Note: An array of Objects can be used only when the schema language (like http:/
/java.sun.com/xml/jaxp/properties/schemaLanguage) has the ability to
assemble a schema at runtime. Also: When an array of Objects is passed it is illegal
to have two schemas that share the same namespace.

Further Information
For further information on the TreeModel, see:

• Understanding the TreeModel: http://java.sun.com/products/jfc/

tsc/articles/jtree/index.html

For further information on the W3C Document Object Model (DOM), see:

http://java.sun.com/products/jfc/tsc/articles/jtree/index.html
http://java.sun.com/products/jfc/tsc/articles/jtree/index.html
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• The DOM standard page: http://www.w3.org/DOM/

For more information on schema-based validation mechanisms, see:

• The W3C standard validation mechanism, XML Schema: http://

www.w3.org/XML/Schema

• RELAX NG’s regular-expression based validation mechanism: http://
www.oasis-open.org/committees/relax-ng/

• Schematron’s assertion-based validation mechanism: http://

www.ascc.net/xml/resource/schematron/schematron.html

http://www.w3.org/DOM/
http://www.w3.org/XML/Schema
http://www.w3.org/XML/Schema
http://www.oasis-open.org/committees/relax-ng/
http://www.oasis-open.org/committees/relax-ng/
http://www.ascc.net/xml/resource/schematron/schematron.html
http://www.ascc.net/xml/resource/schematron/schematron.html
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XML Stylesheet
Language for

Transformations

THE XML Stylesheet Language for Transformations (XSLT) defines mecha-
nisms for addressing XML data (XPath) and for specifying transformations on
the data, in order to convert it into other forms. JAXP includes an interpreting
implementation of XSLT, called Xalan.

In this chapter, you’ll learn how to use Xalan. You’ll write out a Document
Object Model (DOM) as an XML file, and you’ll see how to generate a DOM
from an arbitrary data file in order to convert it to XML. Finally, you’ll convert
XML data into a different form, unlocking the mysteries of the XPath addressing
mechanism along the way.

Note: The examples in this chapter can be found in <INSTALL>/

j2eetutorial14/examples/jaxp/xslt/samples.

Introducing XSLT and XPath
The XML Stylesheet Language (XSL) has three major subcomponents:
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XSL-FO
The “flow object” standard. By far the largest subcomponent, this standard
gives mechanisms for describing font sizes, page layouts, and how informa-
tion “flows” from one page to another. This subcomponent is not covered by
JAXP, nor is it included in this tutorial.

XSLT
This is the transformation language, which lets you define a transformation
from XML into some other format. For example, you might use XSLT to
produce HTML, or a different XML structure. You could even use it to pro-
duce plain text or to put the information in some other document format.
(And as you’ll see in Generating XML from an Arbitrary Data
Structure (page 281), a clever application can press it into service to manipu-
late non-XML data, as well.)

XPath
At bottom, XSLT is a language that lets you specify what sorts of things to
do when a particular element is encountered. But to write a program for dif-
ferent parts of an XML data structure, you need to be able to specify the part
of the structure you are talking about at any given time. XPath is that specifi-
cation language. It is an addressing mechanism that lets you specify a path to
an element so that, for example, <article><title> can be distinguished
from <person><title>. That way, you can describe different kinds of trans-
lations for the different <title> elements.

The remainder of this section describes the packages that make up the JAXP
Transformation APIs.

The JAXP Transformation Packages
Here is a description of the packages that make up the JAXP Transformation
APIs:

javax.xml.transform
This package defines the factory class you use to get a Transformer object.
You then configure the transformer with input (Source) and output (Result)
objects, and invoke its transform() method to make the transformation
happen. The source and result objects are created using classes from one of
the other three packages.

javax.xml.transform.dom
Defines the DOMSource and DOMResult classes that let you use a DOM as an
input to or output from a transformation.
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javax.xml.transform.sax
Defines the SAXSource and SAXResult classes that let you use a SAX event
generator as input to a transformation, or deliver SAX events as output to a
SAX event processor.

javax.xml.transform.stream
Defines the StreamSource and StreamResult classes that let you use an I/O
stream as an input to or output from a transformation.

How XPath Works
The XPath specification is the foundation for a variety of specifications, includ-
ing XSLT and linking/addressing specifications like XPointer. So an understand-
ing of XPath is fundamental to a lot of advanced XML usage. This section
provides a thorough introduction to XPATH in the context of XSLT, so you can
refer to it as needed later on.

Note: In this tutorial, you won’t actually use XPath until you get to the end of this
section, Transforming XML Data with XSLT (page 295). So, if you like, you can
skip this section and go on ahead to the next section, Writing Out a DOM as an
XML File (page 274). (When you get to the end of that section, there will be a note
that refers you back here, so you don’t forget!)

XPATH Expressions
In general, an XPath expression specifies a pattern that selects a set of XML
nodes. XSLT templates then use those patterns when applying transformations.
(XPointer, on the other hand, adds mechanisms for defining a point or a range,
so that XPath expressions can be used for addressing.)
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The nodes in an XPath expression refer to more than just elements. They also
refer to text and attributes, among other things. In fact, the XPath specification
defines an abstract document model that defines seven different kinds of nodes:

• root

• element

• text

• attribute

• comment

• processing instruction

• namespace

Note: The root element of the XML data is modeled by an element node. The XPath
root node contains the document’s root element, as well as other information relat-
ing to the document.

The XSLT/XPath Data Model
Like the DOM, the XSLT/XPath data model consists of a tree containing a vari-
ety of nodes. Under any given element node, there are text nodes, attribute
nodes, element nodes, comment nodes, and processing instruction nodes.

In this abstract model, syntactic distinctions disappear, and you are left with a
normalized view of the data. In a text node, for example, it makes no difference
whether the text was defined in a CDATA section, or if it included entity refer-
ences. The text node will consist of normalized data, as it exists after all parsing
is complete. So the text will contain a < character, regardless of whether an entity
reference like &lt; or a CDATA section was used to include it. (Similarly, the
text will contain an & character, regardless of whether it was delivered using
&amp; or it was in a CDATA section.)

In this section of the tutorial, we’ll deal mostly with element nodes and text
nodes. For the other addressing mechanisms, see the XPath Specification.

http://www.w3.org/TR/xpath
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Templates and Contexts
An XSLT template is a set of formatting instructions that apply to the nodes
selected by an XPATH expression. In an stylesheet, a XSLT template would look
something like this:

<xsl:template match="//LIST">
...

</xsl:template>

The expression //LIST selects the set of LIST nodes from the input stream.
Additional instructions within the template tell the system what to do with them.

The set of nodes selected by such an expression defines the context in which
other expressions in the template are evaluated. That context can be considered
as the whole set — for example, when determining the number of the nodes it
contains.

The context can also be considered as a single member of the set, as each mem-
ber is processed one by one. For example, inside of the LIST-processing tem-
plate, the expression @type refers to the type attribute of the current LIST node.
(Similarly, the expression @* refers to all of attributes for the current LIST ele-
ment.)

Basic XPath Addressing
An XML document is a tree-structured (hierarchical) collection of nodes. As
with a hierarchical directory structure, it is useful to specify a path that points a
particular node in the hierarchy. (Hence the name of the specification: XPath.) In
fact, much of the notation of directory paths is carried over intact:

• The forward slash / is used as a path separator.

• An absolute path from the root of the document starts with a /.

• A relative path from a given location starts with anything else.

• A double period .. indicates the parent of the current node.

• A single period . indicates the current node.

For example, In an XHTML document (an XML document that looks like
HTML, but which is well-formed according to XML rules) the path /h1/h2/

would indicate an h2 element under an h1. (Recall that in XML, element names
are case sensitive, so this kind of specification works much better in XHTML
than it would in plain HTML, because HTML is case-insensitive.)
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In a pattern-matching specification like XSLT, the specification /h1/h2 selects
all h2 elements that lie under an h1 element. To select a specific h2 element,
square brackets [] are used for indexing (like those used for arrays). The path /

h1[4]/h2[5] would therefore select the fifth h2 element under the fourth h1 ele-
ment.

Note: In XHTML, all element names are in lowercase. That is a fairly common con-
vention for XML documents. However, uppercase names are easier to read in a tuto-
rial like this one. So, for the remainder of the XSLT tutorial, all XML element
names will be in uppercase. (Attribute names, on the other hand, will remain in low-
ercase.)

A name specified in an XPath expression refers to an element. For example, “h1”
in /h1/h2 refers to an h1 element. To refer to an attribute, you prefix the attribute
name with an @ sign. For example, @type refers to the type attribute of an ele-
ment. Assuming you have an XML document with LIST elements, for example,
the expression LIST/@type selects the type attribute of the LIST element.

Note: Since the expression does not begin with /, the reference specifies a list
node relative to the current context—whatever position in the document that hap-
pens to be.

Basic XPath Expressions
The full range of XPath expressions takes advantage of the wildcards, operators,
and functions that XPath defines. You’ll be learning more about those shortly.
Here, we’ll take a look at a couple of the most common XPath expressions, sim-
ply to introduce them.

The expression @type="unordered" specifies an attribute named type whose
value is “unordered”. And you already know that an expression like LIST/

@type specifies the type attribute of a LIST element.

You can combine those two notations to get something interesting! In XPath, the
square-bracket notation ([]) normally associated with indexing is extended to
specify selection criteria. So the expression LIST[@type="unordered"] selects
all LIST elements whose type value is “unordered”.

Similar expressions exist for elements, where each element has an associated
string-value. (You’ll see how the string-value is determined for a complicated
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element in a little while. For now, we’ll stick with simple elements that have a
single text string.)

Suppose you model what’s going on in your organization with an XML structure
that consists of PROJECT elements and ACTIVITY elements that have a text string
with the project name, multiple PERSON elements to list the people involved and,
optionally, a STATUS element that records the project status. Here are some more
examples that use the extended square-bracket notation:

• /PROJECT[.="MyProject"]—selects a PROJECT named "MyProject".

• /PROJECT[STATUS]—selects all projects that have a STATUS child element.

• /PROJECT[STATUS="Critical"]—selects all projects that have a STATUS

child element with the string-value “Critical”.

Combining Index Addresses
The XPath specification defines quite a few addressing mechanisms, and they
can be combined in many different ways. As a result, XPath delivers a lot of
expressive power for a relatively simple specification. This section illustrates
two more interesting combinations:

• LIST[@type="ordered"][3]—selects all LIST elements of type
“ordered”, and returns the third.

• LIST[3][@type="ordered"]—selects the third LIST element, but only if
it is of type “ordered”.

Note: Many more combinations of address operators are listed in section 2.5 of the
XPath Specification. This is arguably the most useful section of the spec for defin-
ing an XSLT transform.

Wildcards
By definition, an unqualified XPath expression selects a set of XML nodes that
matches that specified pattern. For example, /HEAD matches all top-level HEAD

http://www.w3.org/TR/xpath
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entries, while /HEAD[1] matches only the first. Table 7–1 lists the wildcards that
can be used in XPath expressions to broaden the scope of the pattern matching.

In the project database example, for instance, /*PERSON[.="Fred"] matches
any PROJECT or ACTIVITY element that names Fred.

Extended-Path Addressing
So far, all of the patterns we’ve seen have specified an exact number of levels in
the hierarchy. For example, /HEAD specifies any HEAD element at the first level in
the hierarchy, while /*/* specifies any element at the second level in the hierar-
chy. To specify an indeterminate level in the hierarchy, use a double forward
slash (//). For example, the XPath expression //PARA selects all paragraph ele-
ments in a document, wherever they may be found.

The // pattern can also be used within a path. So the expression /HEAD/LIST//

PARA indicates all paragraph elements in a subtree that begins from /HEAD/LIST.

Table 7–1 XPath Wildcards

Wildcard Meaning

* Matches any element node (not attributes or text).

node()
Matches any node of any kind: element node, text node, attribute node,
processing instruction node, namespace node, or comment node.

@* Matches any attribute node.
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XPath Data Types and Operators
XPath expressions yield either a set of nodes, a string, a boolean (true/false
value), or a number. Table 7–2 lists the operators that can be used in an Xpath
expression

Finally, expressions can be grouped in parentheses, so you don’t have to worry
about operator precedence.

Note: “Operator precedence” is a term that answers the question, “If you specify a

+ b * c, does that mean (a+b) * c or a + (b*c)?”. (The operator precedence is
roughly the same as that shown in the table.)

String-Value of an Element
Before continuing, it’s worthwhile to understand how the string-value of a more
complex element is determined. We’ll do that now.

The string-value of an element is the concatenation of all descendent text nodes,
no matter how deep. So, for a “mixed-model” XML data element like this:

<PARA>This paragraph contains a <B>bold</B> word</PARA>

Table 7–2 XPath Operators

Operator Meaning

|
Alternative. For example, PARA|LIST selects all PARA and LIST
elements.

or, and Returns the or/and of two boolean values.

=, != Equal or not equal, for booleans, strings, and numbers.

<, >, <=, >=
Less than, greater than, less than or equal to, greater than or equal
to—for numbers.

+, -, *, div, mod
Add, subtract, multiply, floating-point divide, and modulus
(remainder) operations (e.g. 6 mod 4 = 2)
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The string-value of <PARA> is “This paragraph contains a bold word”. In particu-
lar, note that <B> is a child of <PARA> and that the text contained in all children is
concatenated to form the string-value.

Also, it is worth understanding that the text in the abstract data model defined by
XPath is fully normalized. So whether the XML structure contains the entity ref-
erence &lt; or “<” in a CDATA section, the element’s string-value will contain
the “<” character. Therefore, when generating HTML or XML with an XSLT
stylesheet, occurrences of “<” will have to be converted to &lt; or enclosed in a
CDATA section. Similarly, occurrences of “&” will need to be converted to
&amp;.

XPath Functions
This section ends with an overview of the XPath functions. You can use XPath
functions to select a collection of nodes in the same way that you would use an
an element specification like those you have already seen. Other functions return
a string, a number, or a boolean value. For example, the expression /PROJECT/

text() gets the string-value of PROJECT nodes.

Many functions depend on the current context. In the example above, the context
for each invocation of the text() function is the PROJECT node that is currently
selected.

There are many XPath functions—too many to describe in detail here. This sec-
tion provides a quick listing that shows the available XPath functions, along with
a summary of what they do.

Note: Skim the list of functions to get an idea of what’s there. For more information,
see Section 4 of the XPath Specification.

Node-set functions
Many XPath expressions select a set of nodes. In essence, they return a node-set.
One function does that, too.

• id(...)—returns the node with the specified id.

(Elements only have an ID when the document has a DTD, which specifies
which attribute has the ID type.)

http://www.w3.org/TR/xpath
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Positional functions
These functions return positionally-based numeric values.

• last()—returns the index of the last element.

For example: /HEAD[last()] selects the last HEAD element.

• position()—returns the index position.

For example: /HEAD[position() <= 5] selects the first five HEAD ele-
ments

• count(...)—returns the count of elements.

For example: /HEAD[count(HEAD)=0] selects all HEAD elements that have
no subheads.

String functions
These functions operate on or return strings.

• concat(string, string, ...)—concatenates the string values

• starts-with(string1, string2)—returns true if string1 starts with
string2

• contains(string1, string2)—returns true if string1 contains
string2

• substring-before(string1, string2)—returns the start of string1

before string2 occurs in it

• substring-after(string1, string2)—returns the remainder of
string1 after string2 occurs in it

• substring(string, idx)—returns the substring from the index position
to the end, where the index of the first char = 1

• substring(string, idx, len)—returns the substring from the index
position, of the specified length

• string-length()—returns the size of the context-node’s string-value
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The context node is the currently selected node — the node that was
selected by an XPath expression in which a function like string-

length() is applied.

• string-length(string)—returns the size of the specified string

• normalize-space()—returns the normalized string-value of the current
node (no leading or trailing whitespace, and sequences of whitespace char-
acters converted to a single space)

• normalize-space(string)—returns the normalized string-value of the
specified string

• translate(string1, string2, string3)—converts string1, replac-
ing occurrences of characters in string2 with the corresponding character
from string3

Note: XPath defines 3 ways to get the text of an element: text(), string(object),
and the string-value implied by an element name in an expression like this: /

PROJECT[PERSON="Fred"].

Boolean functions
These functions operate on or return boolean values:

• not(...)—negates the specified boolean value

• true()—returns true

• false()—returns false

• lang(string)—returns true if the language of the context node (specified
by xml:Lang attributes) is the same as (or a sublanguage of) the specified
language. For example: Lang("en") is true for
<PARA_xml:Lang="en">...</PARA>

Numeric functions
These functions operate on or return numeric values.

• sum(...)—returns the sum of the numeric value of each node in the spec-
ified node-set

• floor(N)—returns the largest integer that is not greater than N

• ceiling(N)—returns the smallest integer that is greater than N
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• round(N)—returns the integer that is closest to N

Conversion functions
These functions convert one data type to another.

• string(...)—returns the string value of a number, boolean, or node-set

• boolean(...)—returns a boolean value for a number, string, or node-set
(a non-zero number, a non-empty node-set, and a non-empty string are all
true)

• number(...)—returns the numeric value of a boolean, string, or node-set
(true is 1, false is 0, a string containing a number becomes that number, the
string-value of a node-set is converted to a number)

Namespace functions
These functions let you determine the namespace characteristics of a node.

• local-name()—returns the name of the current node, minus the name-
space prefix

• local-name(...)—returns the name of the first node in the specified
node set, minus the namespace prefix

• namespace-uri()—returns the namespace URI from the current node

• namespace-uri(...)—returns the namespace URI from the first node in
the specified node set

• name()—returns the expanded name (URI plus local name) of the current
node

• name(...)—returns the expanded name (URI plus local name) of the first
node in the specified node set

Summary
XPath operators, functions, wildcards, and node-addressing mechanisms can be
combined in wide variety of ways. The introduction you’ve had so far should
give you a good head start at specifying the pattern you need for any particular
purpose.
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Writing Out a DOM as an XML File
Once you have constructed a DOM, either by parsing an XML file or building it
programmatically, you frequently want to save it as XML. This section shows
you how to do that using the Xalan transform package.

Using that package, you’ll create a transformer object to wire a DomSource to a
StreamResult. You’ll then invoke the transformer’s transform() method to
write out the DOM as XML data.

Reading the XML
The first step is to create a DOM in memory by parsing an XML file. By now,
you should be getting pretty comfortable with the process.

Note: The code discussed in this section is in TransformationApp01.java.

The code below provides a basic template to start from. (It should be familiar.
It’s basically the same code you wrote at the start of the DOM tutorial. If you
saved it then, that version should be pretty much the equivalent of what you see
below.)

import javax.xml.parsers.DocumentBuilder;
import javax.xml.parsers.DocumentBuilderFactory;
import javax.xml.parsers.FactoryConfigurationError;
import javax.xml.parsers.ParserConfigurationException;

import org.xml.sax.SAXException;
import org.xml.sax.SAXParseException;

import org.w3c.dom.Document;
import org.w3c.dom.DOMException;

import java.io.*;

public class TransformationApp
{

static Document document;

public static void main(String argv[])
{

if (argv.length != 1) {

../examples/jaxp/xslt/samples/TransformationApp01.java
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System.err.println (
"Usage: java TransformationApp filename");

System.exit (1);
}

DocumentBuilderFactory factory =
DocumentBuilderFactory.newInstance();

//factory.setNamespaceAware(true);
//factory.setValidating(true);

try {
File f = new File(argv[0]);
DocumentBuilder builder =

factory.newDocumentBuilder();
document = builder.parse(f);

} catch (SAXParseException spe) {
// Error generated by the parser
System.out.println("\n** Parsing error"

+ ", line " + spe.getLineNumber()
+ ", uri " + spe.getSystemId());

System.out.println("  " + spe.getMessage() );

// Use the contained exception, if any
Exception x = spe;
if (spe.getException() != null)

x = spe.getException();
x.printStackTrace();

} catch (SAXException sxe) {
// Error generated by this application
// (or a parser-initialization error)
Exception x = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

} catch (ParserConfigurationException pce) {
// Parser with specified options can't be built
pce.printStackTrace();

} catch (IOException ioe) {
// I/O error
ioe.printStackTrace();

}
} // main

}
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Creating a Transformer
The next step is to create a transformer you can use to transmit the XML to Sys-

tem.out.

Note: The code discussed in this section is in TransformationApp02.java. The file
it runs on is slideSample01.xml. The output is in TransformationLog02.txt.
(The browsable versions are slideSample01-xml.html and
TransformationLog02.html.)

 Start by adding the import statements highlighted below:

import javax.xml.transform.Transformer;
import javax.xml.transform.TransformerFactory;
import javax.xml.transform.TransformerException;
import javax.xml.transform.TransformerConfigurationException;

import javax.xml.transform.dom.DOMSource;

import javax.xml.transform.stream.StreamResult;

import java.io.*;

Here, you’ve added a series of classes which should now be forming a standard
pattern: an entity (Transformer), the factory to create it (TransformerFac-
tory), and the exceptions that can be generated by each. Since a transformation
always has a source and a result, you then imported the classes necessary to use
a DOM as a source (DomSource), and an output stream for the result (StreamRe-
sult).

Next, add the code to carry out the transformation:

try {
File f = new File(argv[0]);
DocumentBuilder builder = factory.newDocumentBuilder();
document = builder.parse(f);

 // Use a Transformer for output
TransformerFactory tFactory =

TransformerFactory.newInstance();
Transformer transformer = tFactory.newTransformer();

../examples/jaxp/xslt/samples/TransformationApp02.java
../examples/jaxp/xslt/samples/slideSample01.xml
../examples/jaxp/xslt/samples/TransformationLog02.txt
../examples/jaxp/xslt/samples/slideSample01-xml.html
../examples/jaxp/xslt/samples/TransformationLog02.html
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DOMSource source = new DOMSource(document);
StreamResult result = new StreamResult(System.out);
transformer.transform(source, result);

Here, you created a transformer object, used the DOM to construct a source
object, and used System.out to construct a result object. You then told the trans-
former to operate on the source object and output to the result object.

In this case, the “transformer” isn’t actually changing anything. In XSLT termi-
nology, you are using the identity transform, which means that the “transforma-
tion” generates a copy of the source, unchanged.

Note: You can specify a variety of output properties for transformer objects, as
defined in the W3C specification at http://www.w3.org/TR/xslt#output. For
example, to get indented output, you can invoke:

transformer.setOutputProperty("indent", "yes");

Finally, add the code highlighted below to catch the new errors that can be gener-
ated:

} catch (TransformerConfigurationException tce) {
// Error generated by the parser
System.out.println ("* Transformer Factory error");
System.out.println("  " + tce.getMessage() );

 // Use the contained exception, if any
Throwable x = tce;
if (tce.getException() != null)

x = tce.getException();
x.printStackTrace();

} catch (TransformerException te) {
// Error generated by the parser
System.out.println ("* Transformation error");
System.out.println("  " + te.getMessage() );

// Use the contained exception, if any
Throwable x = te;
if (te.getException() != null)

x = te.getException();
x.printStackTrace();

} catch (SAXParseException spe) {
...

http://www.w3.org/TR/xslt#output


278 XML STYLESHEET LANGUAGE FOR TRANSFORMATIONS
Notes:

• TransformerExceptions are thrown by the transformer object.

• TransformerConfigurationExceptions are thrown by the factory.

• To preserve the XML document’s DOCTYPE setting, it is also necessary to add the
following code:

import javax.xml.transform.OutputKeys;
...
if (document.getDoctype() != null){
String systemValue = (new

File(document.getDoctype().getSystemId())).getName();
transformer.setOutputProperty(
OutputKeys.DOCTYPE_SYSTEM, systemValue

);
}

Writing the XML
For instructions on how to compile and run the program, see Compiling and
Running the Program (page 139) from the SAX tutorial. (If you’re working
along, substitute “TransformationApp” for “Echo” as the name of the program.
If you are compiling the sample code, use “TransformationApp02”.) When you
run the program on slideSample01.xml, this is the output you see:

<?xml version="1.0" encoding="UTF-8"?>
<!-- A SAMPLE set of slides -->
<slideshow author="Yours Truly" date="Date of publication"
title="Sample Slide Show">

<!-- TITLE SLIDE -->
<slide type="all">

<title>Wake up to WonderWidgets!</title>
</slide>

<!-- OVERVIEW -->
<slide type="all">

<title>Overview</title>
<item>Why <em>WonderWidgets</em> are great</item>
<item/>
<item>Who <em>buys</em> WonderWidgets</item>

</slide>

</slideshow>
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Note: The order of the attributes may vary, depending on which parser you are
using.

To find out more about configuring the factory and handling validation errors, see Read-
ing XML Data into a DOM, Additional Information (page 199).

Writing Out a Subtree of the DOM
It is also possible to operate on a subtree of a DOM. In this section of the tuto-
rial, you’ll experiment with that option.

Note: The code discussed in this section is in TransformationApp03.java. The
output is in TransformationLog03.txt. (The browsable version is
TransformationLog03.html.)

The only difference in the process is that now you will create a DOMSource using
a node in the DOM, rather than the entire DOM. The first step will be to import
the classes you need to get the node you want. Add the code highlighted below
to do that:

import org.w3c.dom.Document;
import org.w3c.dom.DOMException;
import org.w3c.dom.Node;
import org.w3c.dom.NodeList;

The next step is to find a good node for the experiment. Add the code highlighted
below to select the first <slide> element:

try {
File f = new File(argv[0]);
DocumentBuilder builder = factory.newDocumentBuilder();
document = builder.parse(f);

// Get the first <slide> element in the DOM
NodeList list = document.getElementsByTagName("slide");
Node node = list.item(0);

../examples/jaxp/xslt/samples/TransformationApp03.java
../examples/jaxp/xslt/samples/TransformationLog03.txt
../examples/jaxp/xslt/samples/TransformationLog03.html
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Finally, make the changes shown below to construct a source object that consists
of the subtree rooted at that node:

DOMSource source = new DOMSource(document);
DOMSource source = new DOMSource(node);
StreamResult result = new StreamResult(System.out);
transformer.transform(source, result);

Now run the app. Your output should look like this:

<?xml version="1.0" encoding="UTF-8"?>
<slide type="all">

<title>Wake up to WonderWidgets!</title>
</slide>

Clean Up
Because it will be easiest to do now, make the changes shown below to back out
the additions you made in this section. (TransformationApp04.java contains
these changes.)

Import org.w3c.dom.DOMException;
import org.w3c.dom.Node;
import org.w3c.dom.NodeList;
...

try {
...
// Get the first <slide> element in the DOM
NodeList list = document.getElementsByTagName("slide");
Node node = list.item(0);
...
DOMSource source = new DOMSource(node);
StreamResult result = new StreamResult(System.out);
transformer.transform(source, result);

Summary
At this point, you’ve seen how to use a transformer to write out a DOM, and how
to use a subtree of a DOM as the source object in a transformation. In the next
section, you’ll see how to use a transformer to create XML from any data struc-
ture you are capable of parsing.

../examples/jaxp/xslt/samples/TransformationApp04.java
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Generating XML from an Arbitrary Data
Structure

In this section, you’ll use XSLT to convert an arbitrary data structure to XML.

In general outline, then:

1. You’ll modify an existing program that reads the data, in order to make it
generate SAX events. (Whether that program is a real parser or simply a
data filter of some kind is irrelevant for the moment.)

2. You’ll then use the SAX “parser” to construct a SAXSource for the trans-
formation.

3. You’ll use the same StreamResult object you created in the last exercise,
so you can see the results. (But note that you could just as easily create a
DOMResult object to create a DOM in memory.)

4. You’ll wire the source to the result, using the transformer object to make
the conversion.

For starters, you need a data set you want to convert and a program capable of
reading the data. In the next two sections, you’ll create a simple data file and a
program that reads it.

Creating a Simple File
We’ll start by creating a data set for an address book. You can duplicate the pro-
cess, if you like, or simply make use of the data stored in PersonalAddress-

Book.ldif.

The file shown below was produced by creating a new address book in Netscape
Messenger, giving it some dummy data (one address card) and then exporting it
in LDIF format.

Note: LDIF stands for LDAP Data Interchange Format. LDAP, turn, stands for
Lightweight Directory Access Protocol. I prefer to think of LDIF as the “Line
Delimited Interchange Format”, since that is pretty much what it is.

Figure 7–1 shows the address book entry that was created.
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Figure 7–1 Address Book Entry

Exporting the address book produces a file like the one shown below. The parts
of the file that we care about are shown in bold.

dn: cn=Fred Flintstone,mail=fred@barneys.house
modifytimestamp: 20010409210816Z
cn: Fred Flintstone
xmozillanickname: Fred
mail: Fred@barneys.house
xmozillausehtmlmail: TRUE
givenname: Fred
sn: Flintstone
telephonenumber: 999-Quarry
homephone: 999-BedrockLane
facsimiletelephonenumber: 888-Squawk
pagerphone: 777-pager
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cellphone: 555-cell
xmozillaanyphone: 999-Quarry
objectclass: top
objectclass: person

Note that each line of the file contains a variable name, a colon, and a space fol-
lowed by a value for the variable. The sn variable contains the person’s surname
(last name) and the variable cn contains the DisplayName field from the address
book entry.

Creating a Simple Parser
The next step is to create a program that parses the data.

Note: The code discussed in this section is in AddressBookReader01.java. The
output is in AddressBookReaderLog01.txt.

The text for the program is shown below. It’s an absurdly simple program that
doesn’t even loop for multiple entries because, after all, it’s just a demo!

import java.io.*;

public class AddressBookReader
{

public static void main(String argv[])
{

// Check the arguments
if (argv.length != 1) {

System.err.println (
"Usage: java AddressBookReader filename");

System.exit (1);
}
String filename = argv[0];
File f = new File(filename);
AddressBookReader01 reader = new AddressBookReader01();
reader.parse(f);

}

/** Parse the input */
public void parse(File f)
{

try {

../examples/jaxp/xslt/samples/AddressBookReader01.java
../examples/jaxp/xslt/samples/AddressBookReaderLog01.txt
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// Get an efficient reader for the file
FileReader r = new FileReader(f);
BufferedReader br = new BufferedReader(r);

 // Read the file and display it's contents.
String line = br.readLine();
while (null != (line = br.readLine())) {

if (line.startsWith("xmozillanickname: "))
break;

}
output("nickname", "xmozillanickname", line);
line = br.readLine();
output("email",    "mail",             line);
line = br.readLine();
output("html",     "xmozillausehtmlmail", line);
line = br.readLine();
output("firstname","givenname",        line);
line = br.readLine();
output("lastname", "sn",               line);
line = br.readLine();
output("work",     "telephonenumber",  line);
line = br.readLine();
output("home",     "homephone",        line);
line = br.readLine();
output("fax",      "facsimiletelephonenumber",

line);
line = br.readLine();
output("pager",    "pagerphone",       line);
line = br.readLine();
output("cell",     "cellphone",        line);

}
catch (Exception e) {

e.printStackTrace();
}

}

void output(String name, String prefix, String line)
{

int startIndex = prefix.length() + 2;
// 2=length of ": "

String text = line.substring(startIndex);
System.out.println(name + ": " + text);

}
}

This program contains three methods:
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main
The main method gets the name of the file from the command line, creates
an instance of the parser, and sets it to work parsing the file. This method
will be going away when we convert the program into a SAX parser. (That’s
one reason for putting the parsing code into a separate method.)

parse
This method operates on the File object sent to it by the main routine. As
you can see, it’s about as simple as it can get. The only nod to efficiency is
the use of a BufferedReader, which can become important when you start
operating on large files.

output
The output method contains the logic for the structure of a line. Starting
from the right It takes three arguments. The first argument gives the method
a name to display, so we can output “html” as a variable name, instead of
“xmozillausehtmlmail”. The second argument gives the variable name
stored in the file (xmozillausehtmlmail). The third argument gives the line
containing the data. The routine then strips off the variable name from the
start of the line and outputs the desired name, plus the data.

Running this program on PersonalAddressBook.ldif produces this output:

nickname: Fred
email: Fred@barneys.house
html: TRUE
firstname: Fred
lastname: Flintstone
work: 999-Quarry
home: 999-BedrockLane
fax: 888-Squawk
pager: 777-pager
cell: 555-cell

I think we can all agree that’s a bit more readable.

Modifying the Parser to Generate SAX
Events
The next step is to modify the parser to generate SAX events, so you can use it as
the basis for a SAXSource object in an XSLT transform.
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Note: The code discussed in this section is in AddressBookReader02.java.

 Start by importing the additional classes you’re going to need:

import java.io.*;

import org.xml.sax.*;
import org.xml.sax.helpers.AttributesImpl;

Next, modify the application so that it extends XmlReader. That change converts
the application into a parser that generates the appropriate SAX events.

public class AddressBookReader
implements XMLReader

{

Now, remove the main method. You won’t be needing that any more.

public static void main(String argv[])
{

// Check the arguments
if (argv.length != 1) {

System.err.println ("Usage: Java AddressBookReader
filename");

System.exit (1);
}
String filename = argv[0];
File f = new File(filename);
AddressBookReader02 reader = new AddressBookReader02();
reader.parse(f);

}

Add some global variables that will come in handy in a few minutes:

public class AddressBookReader
implements XMLReader

{
ContentHandler handler;

// We're not doing namespaces, and we have no
// attributes on our elements.
String nsu = "";  // NamespaceURI

../examples/jaxp/xslt/samples/AddressBookReader02.java
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Attributes atts = new AttributesImpl();
String rootElement = "addressbook";

String indent = "\n  "; // for readability!

The SAX ContentHandler is the object that is going to get the SAX events the
parser generates. To make the application into an XmlReader, you’ll be defining
a setContentHandler method. The handler variable will hold a reference to
the object that is sent when setContentHandler is invoked.

And, when the parser generates SAX element events, it will need to supply
namespace and attribute information. Since this is a simple application, you’re
defining null values for both of those.

You’re also defining a root element for the data structure (addressbook), and
setting up an indent string to improve the readability of the output.

Next, modify the parse method so that it takes an InputSource as an argument,
rather than a File, and account for the exceptions it can generate:

public void parse(File f)InputSource input)
throws IOException, SAXException

Now make the changes shown below to get the reader encapsulated by the
InputSource object:

try {
// Get an efficient reader for the file
FileReader r = new FileReader(f);
java.io.Reader r = input.getCharacterStream();
BufferedReader Br = new BufferedReader(r);

Note: In the next section, you’ll create the input source object and what you put in
it will, in fact, be a buffered reader. But the AddressBookReader could be used
by someone else, somewhere down the line. This step makes sure that the process-
ing will be efficient, regardless of the reader you are given.
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The next step is to modify the parse method to generate SAX events for the start
of the document and the root element. Add the code highlighted below to do
that:

/** Parse the input */
public void parse(InputSource input)
...
{

try {
...
// Read the file and display its contents.
String line = br.readLine();
while (null != (line = br.readLine())) {

if (line.startsWith("xmozillanickname: ")) break;
}

if (handler==null) {
throw new SAXException("No content handler");

}

handler.startDocument();
handler.startElement(nsu, rootElement,

rootElement, atts);

output("nickname", "xmozillanickname", line);
...
output("cell",     "cellphone",        line);

handler.ignorableWhitespace("\n".toCharArray(),
0, // start index
1  // length
);

handler.endElement(nsu, rootElement, rootElement);
handler.endDocument();

}
catch (Exception e) {
...

Here, you first checked to make sure that the parser was properly configured
with a ContentHandler. (For this app, we don’t care about anything else.) You
then generated the events for the start of the document and the root element, and
finished by sending the end-event for the root element and the end-event for the
document.
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A couple of items are noteworthy, at this point:

• We haven’t bothered to send the setDocumentLocator event, since that is
optional. Were it important, that event would be sent immediately before
the startDocument event.

• We’ve generated an ignorableWhitespace event before the end of the
root element. This, too, is optional, but it drastically improves the readabil-
ity of the output, as you’ll see in a few moments. (In this case, the
whitespace consists of a single newline, which is sent the same way that
characters are sent to the characters method: as a character array, a start-
ing index, and a length.)

Now that SAX events are being generated for the document and the root ele-
ment, the next step is to modify the output method to generate the appropriate
element events for each data item. Make the changes shown below to do that:

void output(String name, String prefix, String line)
throws SAXException
{

int startIndex = prefix.length() + 2; // 2=length of ": "
String text = line.substring(startIndex);
System.out.println(name + ": " + text);

int textLength = line.length() - startIndex;
handler.ignorableWhitespace(indent.toCharArray(),

0, // start index
indent.length()
);

handler.startElement(nsu, name, name /*"qName"*/, atts);
handler.characters(line.toCharArray(),

startIndex,
textLength);

handler.endElement(nsu, name, name);
}

Since the ContentHandler methods can send SAXExceptions back to the parser,
the parser has to be prepared to deal with them. In this case, we don’t expect any,
so we’ll simply allow the application to fail if any occur.

You then calculate the length of the data, and once again generate some ignor-
able whitespace for readability. In this case, there is only one level of data, so we
can use a fixed-indent string. (If the data were more structured, we would have to
calculate how much space to indent, depending on the nesting of the data.)
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Note: The indent string makes no difference to the data, but will make the output a
lot easier to read. Once everything is working, try generating the result without that
string! All of the elements will wind up concatenated end to end, like this:
<addressbook><nickname>Fred</nickname><email>...

Next, add the method that configures the parser with the ContentHandler that is
to receive the events it generates:

void output(String name, String prefix, String line)
throws SAXException

{
...

}

/** Allow an application to register a content event handler. */
public void setContentHandler(ContentHandler handler) {

this.handler = handler;
}

/** Return the current content handler. */
public ContentHandler getContentHandler() {

return this.handler;
}

There are several more methods that must be implemented in order to satisfy the
XmlReader interface. For the purpose of this exercise, we’ll generate null meth-
ods for all of them. For a production application, though, you may want to con-
sider implementing the error handler methods to produce a more robust app. For
now, though, add the code highlighted below to generate null methods for them:

/** Allow an application to register an error event handler. */
public void setErrorHandler(ErrorHandler handler)
{ }

/** Return the current error handler. */
public ErrorHandler getErrorHandler()
{ return null; }
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Finally, add the code highlighted below to generate null methods for the remain-
der of the XmlReader interface. (Most of them are of value to a real SAX parser,
but have little bearing on a data-conversion application like this one.)

/** Parse an XML document from a system identifier (URI). */
public void parse(String systemId)
throws IOException, SAXException
{ }

 /** Return the current DTD handler. */
public DTDHandler getDTDHandler()
{ return null; }

/** Return the current entity resolver. */
public EntityResolver getEntityResolver()
{ return null; }

/** Allow an application to register an entity resolver. */
public void setEntityResolver(EntityResolver resolver)
{ }

/** Allow an application to register a DTD event handler. */
public void setDTDHandler(DTDHandler handler)
{ }

/** Look up the value of a property. */
public Object getProperty(String name)
{ return null; }

/** Set the value of a property. */
public void setProperty(String name, Object value)
{ }

/** Set the state of a feature. */
public void setFeature(String name, boolean value)
{ }

/** Look up the value of a feature. */
public boolean getFeature(String name)
{ return false; }

Congratulations! You now have a parser you can use to generate SAX events. In
the next section, you’ll use it to construct a SAX source object that will let you
transform the data into XML.
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Using the Parser as a SAXSource
Given a SAX parser to use as an event source, you can (easily!) construct a trans-
former to produce a result. In this section, you’ll modify the TransformerApp

you’ve been working with to produce a stream output result, although you could
just as easily produce a DOM result.

Note: The code discussed in this section is in TransformationApp04.java. The
results of running it are in TransformationLog04.txt.

Important!

Make sure you put the AddressBookReader aside and open up the Transforma-

tionApp. The work you do in this section affects the TransformationApp! (The
look pretty similar, so it’s easy to start working on the wrong one.)

Start by making the changes shown below to import the classes you’ll need to
construct a SAXSource object. (You won’t be needing the DOM classes at this
point, so they are discarded here, although leaving them in doesn’t do any harm.)

import org.xml.sax.SAXException;
import org.xml.sax.SAXParseException;
import org.xml.sax.ContentHandler;
import org.xml.sax.InputSource;
import org.w3c.dom.Document;
import org.w3c.dom.DOMException;
...
import javax.xml.transform.dom.DOMSource;
import javax.xml.transform.sax.SAXSource;
import javax.xml.transform.stream.StreamResult;

Next, remove a few other holdovers from our DOM-processing days, and add the
code to create an instance of the AddressBookReader:

public class TransformationApp
{

// Global value so it can be ref'd by the tree-adapter
static Document document;

 public static void main(String argv[])
{

...
DocumentBuilderFactory factory =

DocumentBuilderFactory.newInstance();

../examples/jaxp/xslt/samples/TransformationApp04.java
../examples/jaxp/xslt/samples/TransformationLog04.txt
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//factory.setNamespaceAware(true);
//factory.setValidating(true);

// Create the sax "parser".
AddressBookReader saxReader = new AddressBookReader();

try {
File f = new File(argv[0]);
DocumentBuilder builder =

factory.newDocumentBuilder();
document = builder.parse(f);

Guess what! You’re almost done. Just a couple of steps to go. Add the code high-
lighted below to construct a SAXSource object:

// Use a Transformer for output
...
Transformer transformer = tFactory.newTransformer();

// Use the parser as a SAX source for input
FileReader fr = new FileReader(f);
BufferedReader br = new BufferedReader(fr);
InputSource inputSource = new InputSource(br);
SAXSource source = new SAXSource(saxReader, inputSource);

StreamResult result = new StreamResult(System.out);
transformer.transform(source, result);

Here, you constructed a buffered reader (as mentioned earlier) and encapsulated
it in an input source object. You then created a SAXSource object, passing it the
reader and the InputSource object, and passed that to the transformer.

When the application runs, the transformer will configure itself as the Con-

tentHandler for the SAX parser (the AddressBookReader) and tell the parser to
operate on the inputSource object. Events generated by the parser will then go
to the transformer, which will do the appropriate thing and pass the data on to the
result object.

Finally, remove the exceptions you no longer need to worry about, since the
TransformationApp no longer generates them:

catch (SAXParseException spe) {
// Error generated by the parser
System.out.println("\n** Parsing error"

+ ", line " + spe.getLineNumber()
+ ", uri " + spe.getSystemId());

System.out.println("   " + spe.getMessage() );
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// Use the contained exception, if any
Exception  x = spe;
if (spe.getException() != null)

x = spe.getException();
x.printStackTrace();

} catch (SAXException sxe) {
// Error generated by this application
// (or a parser-initialization error)
Exception  x = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

} catch (ParserConfigurationException pce) {
// Parser with specified options can't be built
pce.printStackTrace();

} catch (IOException ioe) {
...

You’re done! You have now created a transformer which will use a SAXSource as
input, and produce a StreamResult as output.

Doing the Conversion
Now run the application on the address book file. Your output should look like
this:

<?xml version="1.0" encoding="UTF-8"?>
<addressbook>

<nickname>Fred</nickname>
<email>fred@barneys.house</email>
<html>TRUE</html>
<firstname>Fred</firstname>
<lastname>Flintstone</lastname>
<work>999-Quarry</work>
<home>999-BedrockLane</home>
<fax>888-Squawk</fax>
<pager>777-pager</pager>
<cell>555-cell</cell>

</addressbook>
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You have now successfully converted an existing data structure to XML. And it
wasn’t even that hard. Congratulations!

Transforming XML Data with XSLT
The XML Stylesheet Language for Transformations (XSLT) can be used for
many purposes. For example, with a sufficiently intelligent stylesheet, you could
generate PDF or PostScript output from the XML data. But generally, XSLT is
used to generate formatted HTML output, or to create an alternative XML repre-
sentation of the data.

In this section of the tutorial, you’ll use an XSLT transform to translate XML
input data to HTML output.

Note: The XSLT specification is large and complex. So this tutorial can only scratch
the surface. It will give you enough of a background to get started, so you can under-
take simple XSLT processing tasks. It should also give you a head start when you
investigate XSLT further. For a more thorough grounding, consult a good reference
manual, such as Michael Kay's XSLT Programmer's Reference.

Defining a Simple <article> Document
Type
We’ll start by defining a very simple document type that could be used for writ-
ing articles. Our <article> documents will contain these structure tags:

• <TITLE> — The title of the article

• <SECT> — A section, consisting of a heading and a body

• <PARA> — A paragraph

• <LIST> — A list.

• <ITEM> — An entry in a list

• <NOTE> — An aside, which will be offset from the main text

The slightly unusual aspect of this structure is that we won’t create a separate
element tag for a section heading. Such elements are commonly created to dis-
tinguish the heading text (and any tags it contains) from the body of the section
(that is, any structure elements underneath the heading).
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Instead, we’ll allow the heading to merge seamlessly into the body of a section.
That arrangement adds some complexity to the stylesheet, but that will give us a
chance to explore XSLT’s template-selection mechanisms. It also matches our
intuitive expectations about document structure, where the text of a heading is
directly followed by structure elements, which can simplify outline-oriented
editing.

Note: However, that structure is not easily validated, because XML’s mixed-content
model allows text anywhere in a section, whereas we want to confine text and inline
elements so that they only appear before the first structure element in the body of
the section. The assertion-based validator (Schematron (page 40)) can do it, but
most other schema mechanisms can’t. So we’ll dispense with defining a DTD for
the document type.

In this structure, sections can be nested. The depth of the nesting will determine
what kind of HTML formatting to use for the section heading (for example, h1
or h2). Using a plain SECT tag (instead of numbered sections) is also useful with
outline-oriented editing, because it lets you move sections around at will without
having to worry about changing the numbering for that section or for any of the
other sections that might be affected by the move.

For lists, we’ll use a type attribute to specify whether the list entries are unor-

dered (bulleted), alpha (enumerated with lower case letters), ALPHA (enumer-
ated with uppercase letters), or numbered.

We’ll also allow for some inline tags that change the appearance of the text:

• <B> — bold

• <I> — italics

• <U> — underline

• <DEF> — definition

• <LINK> — link to a URL

Note: An inline tag does not generate a line break, so a style change caused by an
inline tag does not affect the flow of text on the page (although it will affect the
appearance of that text). A structure tag, on the other hand, demarcates a new seg-
ment of text, so at a minimum it always generates a line break, in addition to other
format changes.



CREATING A TEST DOCUMENT 297
The <DEF> tag will be used for terms that are defined in the text. Such terms will
be displayed in italics, the way they ordinarily are in a document. But using a
special tag in the XML will allow an index program to find such definitions and
add them to an index, along with keywords in headings. In the Note above, for
example, the definitions of inline tags and structure tags could have been marked
with <DEF> tags, for future indexing.

Finally, the LINK tag serves two purposes. First, it will let us create a link to a
URL without having to put the URL in twice — so we can code <link>http//

...</link> instead of <a href="http//...">http//...</a>. Of course,
we’ll also want to allow a form that looks like <link tar-

get="...">...name...</link>. That leads to the second reason for the
<link> tag—it will give us an opportunity to play with conditional expressions
in XSLT.

Note: Although the article structure is exceedingly simple (consisting of only 11
tags), it raises enough interesting problems to get a good view of XSLT’s basic
capabilities. But we’ll still leave large areas of the specification untouched. The last
part of this tutorial will point out the major features we skipped.

Creating a Test Document
Here, you’ll create a simple test document using nested <SECT> elements, a few
<PARA> elements, a <NOTE> element, a <LINK>, and a <LIST type="unor-

dered">. The idea is to create a document with one of everything, so we can
explore the more interesting translation mechanisms.

Note: The sample data described here is contained in article1.xml. (The brows-
able version is article1-xml.html.)

To make the test document, create a file called article.xml and enter the XML
data shown below.

<?xml version="1.0"?>
<ARTICLE>

<TITLE>A Sample Article</TITLE>
<SECT>The First Major Section

<PARA>This section will introduce a subsection.</PARA>
<SECT>The Subsection Heading

<PARA>This is the text of the subsection.

../examples/jaxp/xslt/samples/article1.xml
../examples/jaxp/xslt/samples/article1-xml.html
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</PARA>
</SECT>

</SECT>
</ARTICLE>

Note that in the XML file, the subsection is totally contained within the major
section. (In HTML, on the other hand, headings do not contain the body of a sec-
tion.) The result is an outline structure that is harder to edit in plain-text form,
like this, but is much easier to edit with an outline-oriented editor.

Someday, given an tree-oriented XML editor that understands inline tags like
<B> and <I>, it should be possible to edit an article of this kind in outline form,
without requiring a complicated stylesheet. (Such an editor would allow the
writer to focus on the structure of the article, leaving layout until much later in
the process.) In such an editor, the article-fragment above would look something
like this:

<ARTICLE>
<TITLE>A Sample Article
<SECT>The First Major Section

<PARA>This section will introduce a subsection.
<SECT>The Subheading

<PARA>This is the text of the subsection. Note that ...

Note: At the moment, tree-structured editors exist, but they treat inline tags like <B>
and <I> the same way that they treat other structure tags, which can make the “out-
line” a bit difficult to read.

Writing an XSLT Transform
In this part of the tutorial, you’ll begin writing an XSLT transform that will con-
vert the XML article and render it in HTML.

Note: The transform described in this section is contained in article1a.xsl. (The
browsable version is article1a-xsl.html.)

Start by creating a normal XML document:

<?xml version="1.0" encoding="ISO-8859-1"?>

../examples/jaxp/xslt/samples/article1a.xsl
../examples/jaxp/xslt/samples/article1a-xsl.html
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Then add the lines highlighted below to create an XSL stylesheet:

<?xml version="1.0" encoding="ISO-8859-1"?>
<xsl:stylesheet

xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
version="1.0"
>

</xsl:stylesheet>

Now, set it up to produce HTML-compatible output:

<xsl:stylesheet
...
>
<xsl:output method="html"/>

 ...

</xsl:stylesheet>

We’ll get into the detailed reasons for that entry later on in this section. But for
now, note that if you want to output anything besides well-formed XML, then
you’ll need an <xsl:output> tag like the one shown, specifying either “text”
or “html”. (The default value is “xml”.)

Note: When you specify XML output, you can add the indent attribute to produce
nicely indented XML output. The specification looks like this:
<xsl:output method="xml" indent="yes"/>.

Processing the Basic Structure Elements
You’ll start filling in the stylesheet by processing the elements that go into creat-
ing a table of contents — the root element, the title element, and headings. You’ll
also process the PARA element defined in the test document.

Note: If on first reading you skipped the section of this tutorial that discusses the
XPAth addressing mechanisms, How XPath Works (page 263), now is a good time
to go back and review that section.
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Begin by adding the main instruction that processes the root element:

<xsl:template match="/">
<html><body>

<xsl:apply-templates/>
</body></html>

</xsl:template>

</xsl:stylesheet>

The new XSL commands are shown in bold. (Note that they are defined in the
“xsl” namespace.) The instruction <xsl:apply-templates> processes the chil-
dren of the current node. In this case, the current node is the root node.

Despite its simplicity, this example illustrates a number of important ideas, so
it’s worth understanding thoroughly. The first concept is that a stylesheet con-
tains a number of templates, defined with the <xsl:template> tag. Each tem-
plate contains a match attribute, which selects the elements that the template will
be applied to, using the XPath addressing mechanisms described in How XPath
Works (page 263).

Within the template, tags that do not start with the xsl: namespace prefix are
simply copied. The newlines and whitespace that follow them are also copied,
which helps to make the resulting output readable.

Note: When a newline is not present, whitespace is generally ignored. To include
whitespace in the output in such cases, or to include other text, you can use the
<xsl:text> tag. Basically, an XSLT stylesheet expects to process tags. So every-
thing it sees needs to be either an <xsl:..> tag, some other tag, or whitespace.

In this case, the non-XSL tags are HTML tags. So when the root tag is matched,
XSLT outputs the HTML start-tags, processes any templates that apply to chil-
dren of the root, and then outputs the HTML end-tags.

Process the <TITLE> Element
Next, add a template to process the article title:

<xsl:template match="/ARTICLE/TITLE">
<h1 align="center"> <xsl:apply-templates/> </h1>

</xsl:template>

</xsl:stylesheet>
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In this case, you specified a complete path to the TITLE element, and output
some HTML to make the text of the title into a large, centered heading. In this
case, the apply-templates tag ensures that if the title contains any inline tags
like italics, links, or underlining, they will be processed as well.

More importantly, the apply-templates instruction causes the text of the title to
be processed. Like the DOM data model, the XSLT data model is based on the
concept of text nodes contained in element nodes (which, in turn, can be con-
tained in other element nodes, and so on). That hierarchical structure constitutes
the source tree. There is also a result tree, which contains the output.

XSLT works by transforming the source tree into the result tree. To visualize the
result of XSLT operations, it is helpful to understand the structure of those trees,
and their contents. (For more on this subject, see The XSLT/XPath Data
Model (page 264).)

Process Headings
To continue processing the basic structure elements, add a template to process
the top-level headings:

<xsl:template match="/ARTICLE/SECT">
<h2> <xsl:apply-templates

select="text()|B|I|U|DEF|LINK"/> </h2>
<xsl:apply-templates select="SECT|PARA|LIST|NOTE"/>

</xsl:template>

</xsl:stylesheet>

Here, you’ve specified the path to the topmost SECT elements. But this time,
you’ve applied templates in two stages, using the select attribute. For the first
stage, you selected text nodes using the XPath text() function, as well as inline
tags like bold and italics. (The vertical pipe (|) is used to match multiple items —
text, or a bold tag, or an italics tag, etc.) In the second stage, you selected the
other structure elements contained in the file, for sections, paragraphs, lists, and
notes.

Using the select attribute let you put the text and inline elements between the
<h2>...</h2> tags, while making sure that all of the structure tags in the section
are processed afterwards. In other words, you made sure that the nesting of the
headings in the XML document is not reflected in the HTML formatting, which
is important for HTML output.
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In general, using the select clause lets you apply all templates to a subset of the
information available in the current context. As another example, this template
selects all attributes of the current node:

<xsl:apply-templates select="@*"/></attributes>

Next, add the virtually identical template to process subheadings that are nested
one level deeper:

<xsl:template match="/ARTICLE/SECT/SECT">
<h3> <xsl:apply-templates

select="text()|B|I|U|DEF|LINK"/> </h3>
<xsl:apply-templates select="SECT|PARA|LIST|NOTE"/>

</xsl:template>

</xsl:stylesheet>

Generate a Runtime Message
You could add templates for deeper headings, too, but at some point you have to
stop, if only because HTML only goes down to five levels. But for this example,
you’ll stop at two levels of section headings. But if the XML input happens to
contain a third level, you’ll want to deliver an error message to the user. This sec-
tion shows you how to do that.

Note: We could continue processing SECT elements that are further down, by
selecting them with the expression /SECT/SECT//SECT. The // selects any SECT
elements, at any depth, as defined by the XPath addressing mechanism. But we’ll
take the opportunity to play with messaging, instead.

Add the following template to generate an error when a section is encountered
that is nested too deep:

<xsl:template match="/ARTICLE/SECT/SECT/SECT">
<xsl:message terminate="yes">

Error: Sections can only be nested 2 deep.
</xsl:message>

</xsl:template>

</xsl:stylesheet>
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The terminate="yes" clause causes the transformation process to stop after the
message is generated. Without it, processing could still go on with everything in
that section being ignored.

As an additional exercise, you could expand the stylesheet to handle sections
nested up to four sections deep, generating <h2>...<h5> tags. Generate an error
on any section nested five levels deep.

Finally, finish up the stylesheet by adding a template to process the PARA tag:

<xsl:template match="PARA">
<p><xsl:apply-templates/></p>

</xsl:template>

</xsl:stylesheet>

Writing the Basic Program
In this part of the tutorial, you’ll modify the program that used XSLT to echo an
XML file unchanged, changing it so it uses your stylesheet.

Note: The code shown in this section is contained in Stylizer.java. The result is
stylizer1a.html. (The browser-displayable version of the HTML source is
stylizer1a-src.html.)

Start by copying TransformationApp02, which parses an XML file and writes
to System.out. Save it as Stylizer.java.

Next, modify occurrences of the class name and the usage section of the pro-
gram:

public class TransformationAppStylizer
{

if (argv.length != 1 2) {
System.err.println (

"Usage: java TransformationApp filename");
"Usage: java Stylizer stylesheet xmlfile");

System.exit (1);
}
...

../examples/jaxp/xslt/samples/Stylizer.java
../examples/jaxp/xslt/samples/stylizer1a.html
../examples/jaxp/xslt/samples/stylizer1a-src.html
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Then modify the program to use the stylesheet when creating the Transformer

object.

...
import javax.xml.transform.dom.DOMSource;
import javax.xml.transform.stream.StreamSource;
import javax.xml.transform.stream.StreamResult;
...

public class Stylizer
{

...
public static void main (String argv[])
{

...
try {

File f = new File(argv[0]);
File stylesheet = new File(argv[0]);
File datafile  = new File(argv[1]);

DocumentBuilder builder =
factory.newDocumentBuilder();

document = builder.parse(f datafile);
...
StreamSource stylesource =

new StreamSource(stylesheet);
Transformer transformer =

Factory.newTransformer(stylesource);
...

This code uses the file to create a StreamSource object, and then passes the
source object to the factory class to get the transformer.

Note: You can simplify the code somewhat by eliminating the DOMSource class
entirely. Instead of creating a DOMSource object for the XML file, create a Stream-

Source object for it, as well as for the stylesheet.

Now compile and run the program using article1a.xsl on article1.xml. The
results should look like this:

<html>
<body>

<h1 align="center">A Sample Article</h1>
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<h2>The First Major Section

</h2>
<p>This section will introduce a subsection.</p>
<h3>The Subsection Heading

</h3>
<p>This is the text of the subsection.

</p>

</body>
</html>

At this point, there is quite a bit of excess whitespace in the output. You’ll see
how to eliminate most of it in the next section.

Trimming the Whitespace
If you recall, when you took a look at the structure of a DOM, there were many
text nodes that contained nothing but ignorable whitespace. Most of the excess
whitespace in the output came from these nodes. Fortunately, XSL gives you a
way to eliminate them. (For more about the node structure, see The XSLT/XPath
Data Model (page 264).)

Note: The stylesheet described here is article1b.xsl. The result is
stylizer1b.html. (The browser-displayable versions are article1b-xsl.html

and stylizer1b-src.html.)

To remove some of the excess whitespace, add the line highlighted below to the
stylesheet.

<xsl:stylesheet ...
>
<xsl:output method="html"/>
<xsl:strip-space elements="SECT"/>
...

This instruction tells XSL to remove any text nodes under SECT elements that
contain nothing but whitespace. Nodes that contain text other than whitespace
will not be affected, and other kinds of nodes are not affected.

../examples/jaxp/xslt/samples/article1b.xsl
../examples/jaxp/xslt/samples/stylizer1b.html
../examples/jaxp/xslt/samples/article1b-xsl.html
../examples/jaxp/xslt/samples/stylizer1b-src.html
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Now, when you run the program, the result looks like this:

<html>
<body>

<h1 align="center">A Sample Article</h1>

<h2>The First Major Section
</h2>

<p>This section will introduce a subsection.</p>
<h3>The Subsection Heading

</h3>
<p>This is the text of the subsection.

</p>

</body>
</html>

That’s quite an improvement. There are still newline characters and white space
after the headings, but those come from the way the XML is written:

<SECT>The First Major Section
____<PARA>This section will introduce a subsection.</PARA>
^^^^

Here, you can see that the section heading ends with a newline and indentation
space, before the PARA entry starts. That’s not a big worry, because the browsers
that will process the HTML routinely compress and ignore the excess space. But
there is still one more formatting tool at our disposal.

Note: The stylesheet described here is article1c.xsl. The result is
stylizer1c.html. (The browser-displayable versions are article1c-xsl.html

and stylizer1c-src.html.)

To get rid of that last little bit of whitespace, add this template to the stylesheet:

<xsl:template match="text()">
<xsl:value-of select="normalize-space()"/>

</xsl:template>

</xsl:stylesheet>

../examples/jaxp/xslt/samples/article1c.xsl
../examples/jaxp/xslt/samples/stylizer1c.html
../examples/jaxp/xslt/samples/article1c-xsl.html
../examples/jaxp/xslt/samples/stylizer1c-src.html
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The output now looks like this:

<html>
<body>
<h1 align="center">A Sample Article</h1>
<h2>The First Major Section</h2>
<p>This section will introduce a subsection.</p>
<h3>The Subsection Heading</h3>
<p>This is the text of the subsection.</p>
</body>
</html>

That is quite a bit better. Of course, it would be nicer if it were indented, but that
turns out to be somewhat harder than expected! Here are some possible avenues
of attack, along with the difficulties:

Indent option
Unfortunately, the indent="yes" option that can be applied to XML output
is not available for HTML output. Even if that option were available, it
wouldn’t help, because HTML elements are rarely nested! Although HTML
source is frequently indented to show the implied structure, the HTML tags
themselves are not nested in a way that creates a real structure.

Indent variables
The <xsl:text> function lets you add any text you want, including
whitespace. So, it could conceivably be used to output indentation space.
The problem is to vary the amount of indentation space. XSLT variables
seem like a good idea, but they don’t work here. The reason is that when you
assign a value to a variable in a template, the value is only known within that
template (statically, at compile time value). Even if the variable is defined
globally, the assigned value is not stored in a way that lets it be dynamically
known by other templates at runtime. Once <apply-templates/> invokes
other templates, they are unaware of any variable settings made in other tem-
plates.

Parameterized templates
Using a “parameterized template” is another way to modify a template’s
behavior. But determining the amount of indentation space to pass as the
parameter remains the crux of the problem!

At the moment, then, there does not appear to be any good way to control the
indentation of HTML-formatted output. That would be inconvenient if you
needed to display or edit the HTML as plain text. But it’s not a problem if you do
your editing on the XML form, only use the HTML version for display in a
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browser. (When you view stylizer1c.html, for example, you see the results you
expect.)

Processing the Remaining Structure
Elements
In this section, you’ll process the LIST and NOTE elements that add additional
structure to an article.

Note: The sample document described in this section is article2.xml, and the
stylesheet used to manipulate it is article2.xsl. The result is stylizer2.html.
(The browser-displayable versions are article2-xml.html, article2-xsl.html,
and stylizer2-src.html.)

Start by adding some test data to the sample document:

<?xml version="1.0"?>
<ARTICLE>

<TITLE>A Sample Article</TITLE>
<SECT>The First Major Section

...
</SECT>
<SECT>The Second Major Section

<PARA>This section adds a LIST and a NOTE.
<PARA>Here is the LIST:

<LIST type="ordered">
<ITEM>Pears</ITEM>
<ITEM>Grapes</ITEM>

</LIST>
</PARA>
<PARA>And here is the NOTE:

<NOTE>Don't forget to go to the hardware store
on your way to the grocery!

</NOTE>
</PARA>

</SECT>
</ARTICLE>

Note: Although the list and note in the XML file are contained in their respective
paragraphs, it really makes no difference whether they are contained or not—the

../examples/jaxp/xslt/samples/article2.xml
../examples/jaxp/xslt/samples/article2.xsl
../examples/jaxp/xslt/samples/stylizer2.html
../examples/jaxp/xslt/samples/article2-xml.html
../examples/jaxp/xslt/samples/article2-xsl.html
../examples/jaxp/xslt/samples/stylizer2-src.html
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generated HTML will be the same, either way. But having them contained will
make them easier to deal with in an outline-oriented editor.

Modify <PARA> handling
Next, modify the PARA template to account for the fact that we are now allowing
some of the structure elements to be embedded with a paragraph:

<xsl:template match="PARA">
<p><xsl:apply-templates/></p>
<p> <xsl:apply-templates select="text()|B|I|U|DEF|LINK"/>

</p>
<xsl:apply-templates select="PARA|LIST|NOTE"/>

</xsl:template>

This modification uses the same technique you used for section headings. The
only difference is that SECT elements are not expected within a paragraph. (How-
ever, a paragraph could easily exist inside another paragraph, as quoted material,
for example.)

Process <LIST> and <ITEM> elements
Now you’re ready to add a template to process LIST elements:

<xsl:template match="LIST">
<xsl:if test="@type='ordered'">

<ol>
<xsl:apply-templates/>
</ol>

</xsl:if>
<xsl:if test="@type='unordered'">

<ul>
<xsl:apply-templates/>
</ul>

</xsl:if>
</xsl:template>

</xsl:stylesheet>

The <xsl:if> tag uses the test="" attribute to specify a boolean condition. In
this case, the value of the type attribute is tested, and the list that is generated
changes depending on whether the value is ordered or unordered.
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The two important things to note for this example are:

• There is no else clause, nor is there a return or exit statement, so it takes
two <xsl:if> tags to cover the two options. (Or the <xsl:choose> tag
could have been used, which provides case-statement functionality.)

• Single quotes are required around the attribute values. Otherwise, the
XSLT processor attempts to interpret the word ordered as an XPath func-
tion, instead of as a string.

Now finish up LIST processing by handling ITEM elements:

<xsl:template match="ITEM">
<li><xsl:apply-templates/>
</li>

</xsl:template>

</xsl:stylesheet>

Ordering Templates in a Stylesheet
By now, you should have the idea that templates are independent of one another,
so it doesn’t generally matter where they occur in a file. So from here on, we’ll
just show the template you need to add. (For the sake of comparison, they’re
always added at the end of the example stylesheet.)

Order does make a difference when two templates can apply to the same node. In
that case, the one that is defined last is the one that is found and processed. For
example, to change the ordering of an indented list to use lowercase alphabetics,
you could specify a template pattern that looks like this: //LIST//LIST. In that
template, you would use the HTML option to generate an alphabetic enumera-
tion, instead of a numeric one.

But such an element could also be identified by the pattern //LIST. To make sure
the proper processing is done, the template that specifies //LIST would have to
appear before the template the specifies //LIST//LIST.



PROCESSING THE REMAINING STRUCTURE ELEMENTS 311
Process <NOTE> Elements
The last remaining structure element is the NOTE element. Add the template
shown below to handle that.

<xsl:template match="NOTE">
<blockquote><b>Note:</b><br/>

<xsl:apply-templates/>
</p></blockquote>

</xsl:template>

</xsl:stylesheet>

This code brings up an interesting issue that results from the inclusion of the
<br/> tag. To be well-formed XML, the tag must be specified in the stylesheet as
<br/>, but that tag is not recognized by many browsers. And while most brows-
ers recognize the sequence <br></br>, they all treat it like a paragraph break,
instead of a single line break.

In other words, the transformation must generate a <br> tag, but the stylesheet
must specify <br/>. That brings us to the major reason for that special output tag
we added early in the stylesheet:

<xsl:stylesheet ... >
<xsl:output method="html"/>
...

</xsl:stylesheet>

That output specification converts empty tags like <br/> to their HTML form,
<br>, on output. That conversion is important, because most browsers do not
recognize the empty tags. Here is a list of the affected tags:

area frame isindex
base hr link
basefont img meta
br input param
col

To summarize, by default XSLT produces well-formed XML on output. And
since an XSL stylesheet is well-formed XML to start with, you cannot easily put
a tag like <br> in the middle of it. The “<xsl:output method="html"/>”
solves the problem, so you can code <br/> in the stylesheet, but get <br> in the
output.
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The other major reason for specifying <xsl:output method="html"/> is that,
as with the specification <xsl:output method="text"/>, generated text is not
escaped. For example, if the stylesheet includes the &lt; entity reference, it will
appear as the < character in the generated text. When XML is generated, on the
other hand, the &lt; entity reference in the stylesheet would be unchanged, so it
would appear as &lt; in the generated text.

Note: If you actually want &lt; to be generated as part of the HTML output, you’ll
need to encode it as &amp;lt;—that sequence becomes &lt; on output, because
only the &amp; is converted to an & character.

Run the Program
Here is the HTML that is generated for the second section when you run the pro-
gram now:

...
<h2>The Second Major Section</h2>
<p>This section adds a LIST and a NOTE.</p>
<p>Here is the LIST:</p>
<ol>
<li>Pears</li>
<li>Grapes</li>
</ol>
<p>And here is the NOTE:</p>
<blockquote>
<b>Note:</b>
<br>Don't forget to go to the hardware store on your way to the
grocery!
</blockquote>

Process Inline (Content) Elements
The only remaining tags in the ARTICLE type are the inline tags — the ones that
don’t create a line break in the output, but which instead are integrated into the
stream of text they are part of.

Inline elements are different from structure elements, in that they are part of the
content of a tag. If you think of an element as a node in a document tree, then
each node has both content and structure. The content is composed of the text
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and inline tags it contains. The structure consists of the other elements (structure
elements) under the tag.

Note: The sample document described in this section is article3.xml, and the
stylesheet used to manipulate it is article3.xsl. The result is stylizer3.html.
(The browser-displayable versions are article3-xml.html, article3-xsl.html,
and stylizer3-src.html.)

Start by adding one more bit of test data to the sample document:

<?xml version="1.0"?>
<ARTICLE>

<TITLE>A Sample Article</TITLE>
<SECT>The First Major Section

...
</SECT>
<SECT>The Second Major Section

...
</SECT>
<SECT>The <I>Third</I> Major Section

<PARA>In addition to the inline tag in the heading,
this section defines the term <DEF>inline</DEF>,
which literally means "no line break". It also
adds a simple link to the main page for the Java
platform (<LINK>http://java.sun.com</LINK>),
as well as a link to the
<LINK target="http://java.sun.com/xml">XML</LINK>
page.

</PARA>
</SECT>

</ARTICLE>

Now, process the inline <DEF> elements in paragraphs, renaming them to HTML
italics tags:

<xsl:template match="DEF">
<i> <xsl:apply-templates/> </i>

</xsl:template>

../examples/jaxp/xslt/samples/article3.xml
../examples/jaxp/xslt/samples/article3.xsl
../examples/jaxp/xslt/samples/stylizer3.html
../examples/jaxp/xslt/samples/article3-xml.html
../examples/jaxp/xslt/samples/article3-xsl.html
../examples/jaxp/xslt/samples/stylizer3-src.html
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Next, comment out the text-node normalization. It has served its purpose, and
now you’re to the point that you need to preserve important spaces:

<!--
<xsl:template match="text()">

<xsl:value-of select="normalize-space()"/>
</xsl:template>

-->

This modification keeps us from losing spaces before tags like <I> and <DEF>.
(Try the program without this modification to see the result.)

Now, process basic inline HTML elements like <B>, <I>, <U> for bold, italics,
and underlining.

<xsl:template match="B|I|U">
<xsl:element name="{name()}">

<xsl:apply-templates/>
</xsl:element>

</xsl:template>

The <xsl:element> tag lets you compute the element you want to generate.
Here, you generate the appropriate inline tag using the name of the current ele-
ment. In particular, note the use of curly braces ({}) in the name=".." expres-
sion. Those curly braces cause the text inside the quotes to be processed as an
XPath expression, instead of being interpreted as a literal string. Here, they cause
the XPath name() function to return the name of the current node.

Curly braces are recognized anywhere that an attribute value template can occur.
(Attribute value templates are defined in section 7.6.2 of the XSLT specification,
and they appear several places in the template definitions.). In such expressions,
curly braces can also be used to refer to the value of an attribute, {@foo}, or to
the content of an element {foo}.

Note: You can also generate attributes using <xsl:attribute>. For more informa-
tion, see Section 7.1.3 of the XSLT Specification.

http://www.w3.org/TR/xslt
http://www.w3.org/TR/xslt
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The last remaining element is the LINK tag. The easiest way to process that tag
will be to set up a named template that we can drive with a parameter:

<xsl:template name="htmLink">
<xsl:param name="dest" select="UNDEFINED"/>
<xsl:element name="a">

<xsl:attribute name="href">
<xsl:value-of select="$dest"/>

</xsl:attribute>
<xsl:apply-templates/>

</xsl:element>
</xsl:template>

The major difference in this template is that, instead of specifying a match

clause, you gave the template a name with the name="" clause. So this template
only gets executed when you invoke it.

Within the template, you also specified a parameter named dest, using the
<xsl:param> tag. For a bit of error checking, you used the select clause to give
that parameter a default value of UNDEFINED. To reference the variable in the
<xsl:value-of> tag, you specified “$dest”.

Note: Recall that an entry in quotes is interpreted as an expression, unless it is fur-
ther enclosed in single quotes. That’s why the single quotes were needed earlier, in
"@type='ordered'"—to make sure that ordered was interpreted as a string.

The <xsl:element> tag generates an element. Previously, we have been able to
simply specify the element we want by coding something like <html>. But here
you are dynamically generating the content of the HTML anchor (<a>) in the
body of the <xsl:element> tag. And you are dynamically generating the href

attribute of the anchor using the <xsl:attribute> tag.

The last important part of the template is the <apply-templates> tag, which
inserts the text from the text node under the LINK element. Without it, there
would be no text in the generated HTML link.

Next, add the template for the LINK tag, and call the named template from within
it:

<xsl:template match="LINK">
<xsl:if test="@target">

<!--Target attribute specified.-->
<xsl:call-template name="htmLink">

<xsl:with-param name="dest" select="@target"/>
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</xsl:call-template>
</xsl:if>

</xsl:template>

<xsl:template name="htmLink">
...

The test="@target" clause returns true if the target attribute exists in the
LINK tag. So this <xsl-if> tag generates HTML links when the text of the link
and the target defined for it are different.

The <xsl:call-template> tag invokes the named template, while <xsl:with-

param> specifies a parameter using the name clause, and its value using the
select clause.

As the very last step in the stylesheet construction process, add the <xsl-if> tag
shown below to process LINK tags that do not have a target attribute.

<xsl:template match="LINK">
<xsl:if test="@target">

...
</xsl:if>

<xsl:if test="not(@target)">
<xsl:call-template name="htmLink">

<xsl:with-param name="dest">
<xsl:apply-templates/>

</xsl:with-param>
</xsl:call-template>

</xsl:if>
</xsl:template>

The not(...) clause inverts the previous test (remember, there is no else

clause). So this part of the template is interpreted when the target attribute is
not specified. This time, the parameter value comes not from a select clause,
but from the contents of the <xsl:with-param> element.

Note: Just to make it explicit: Parameters and variables (which are discussed in a
few moments in What Else Can XSLT Do? (page 317) can have their value speci-
fied either by a select clause, which lets you use XPath expressions, or by the con-
tent of the element, which lets you use XSLT tags.
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The content of the parameter, in this case, is generated by the <xsl:apply-tem-

plates/> tag, which inserts the contents of the text node under the LINK ele-
ment.

Run the Program
When you run the program now, the results should look something like this:

...
<h2>The <I>Third</I> Major Section

</h2>
<p>In addition to the inline tag in the heading, this section

defines the term <i>inline</i>, which literally means
"no line break". It also adds a simple link to the
main page for the Java platform (<a href="http://java.
sun.com">http://java.sun.com</a>),
as well as a link to the
<a href="http://java.sun.com/xml">XML</a> page.

</p>

Good work! You have now converted a rather complex XML file to HTML. (As
seemingly simple as it appear at first, it certainly provided a lot of opportunity
for exploration.)

Printing the HTML
You have now converted an XML file to HTML. One day, someone will produce
an HTML-aware printing engine that you’ll be able to find and use through the
Java Printing Service API. At that point, you’ll have ability to print an arbitrary
XML file by generating HTML—all you’ll have to do is set up a stylesheet and
use your browser.

What Else Can XSLT Do?
As lengthy as this section of the tutorial has been, it has still only scratched the
surface of XSLT’s capabilities. Many additional possibilities await you in the
XSLT Specification. Here are a few of the things to look for:

import (Section 2.6.2) and include (Section 2.6.1)
Use these statements to modularize and combine XSLT stylesheets. The
include statement simply inserts any definitions from the included file. The

http://www.w3.org/TR/xslt


318 XML STYLESHEET LANGUAGE FOR TRANSFORMATIONS
import statement lets you override definitions in the imported file with defi-
nitions in your own stylesheet.

for-each loops (Section 8)
Loop over a collection of items and process each one, in turn.

choose (case statement) for conditional processing (Section 9.2)
Branch to one of multiple processing paths depending on an input value.

generating numbers (Section 7.7)
Dynamically generate numbered sections, numbered elements, and numeric
literals. XSLT provides three numbering modes:

• single: Numbers items under a single heading, like an ordered list in
HTML.

• multiple: Produces multi-level numbering like “A.1.3”.

• any: Consecutively numbers items wherever they appear, as with foot-
notes in a chapter.

formatting numbers (Section 12.3)
Control enumeration formatting, so you get numerics (format="1"), upper-
case alphabetics (format="A"), lowercase alphabetics (format="a"), or
compound numbers, like “A.1”, as well as numbers and currency amounts
suited for a specific international locale.

sorting output (Section 10)
Produce output in some desired sorting order.

mode-based templates (Section 5.7)
Process an element multiple times, each time in a different “mode”. You add
a mode attribute to templates, and then specify <apply-templates

mode="..."> to apply only the templates with a matching mode. Combine
with the <apply-templates select="..."> attribute to apply mode-based
processing to a subset of the input data.

variables (Section 11)
Variables, like parameters, let you control a template’s behavior. But they are
not as valuable as you might think. The value of a variable is only known
within the scope of the current template or <xsl:if> tag (for example) in
which it is defined. You can’t pass a value from one template to another, or
even from an enclosed part of a template to another part of the same tem-
plate.

These statements are true even for a “global” variable. You can change its
value in a template, but the change only applies to that template. And when
the expression used to define the global variable is evaluated, that evaluation
takes place in the context of the structure’s root node. In other words, global
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variables are essentially runtime constants. Those constants can be useful for
changing the behavior of a template, especially when coupled with include

and import statements. But variables are not a general-purpose data-man-
agement mechanism.

The Trouble with Variables
It is tempting to create a single template and set a variable for the destination of
the link, rather than go to the trouble of setting up a parameterized template and
calling it two different ways. The idea would be to set the variable to a default
value (say, the text of the LINK tag) and then, if target attribute exists, set the
destination variable to the value of the target attribute.

That would be a good idea—if it worked. But once again, the issue is that vari-
ables are only known in the scope within which they are defined. So when you
code an <xsl:if> tag to change the value of the variable, the value is only
known within the context of the <xsl:if> tag. Once </xsl:if> is encountered,
any change to the variable’s setting is lost.

A similarly tempting idea is the possibility of replacing the
text()|B|I|U|DEF|LINK specification with a variable ($inline). But since the
value of the variable is determined by where it is defined, the value of a global
inline variable consists of text nodes, <B> nodes, and so on, that happen to exist
at the root level. In other words, the value of such a variable, in this case, is null.

Transforming from the Command Line
with Xalan

To run a transform from the command line, you initiate a Xalan Process using
the following command:

java org.apache.xalan.xslt.Process
-IN article3.xml -XSL article3.xsl

Note: Remember to use the endorsed directories mechanism to access the Xalan
libraries, as described in Compiling and Running the Program (page 139).

With this command, the output goes to System.out. The -OUT option can also
be used to output to a file.
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The Process command allows for a variety of other options, as well. For details,
see http://xml.apache.org/xalan-j/commandline.html.

Concatenating Transformations with a
Filter Chain

It is sometimes useful to create a filter chain — a concatenation of XSLT trans-
formations in which the output of one transformation becomes the input of the
next. This section of the tutorial shows you how to do that.

Writing the Program
Start by writing a program to do the filtering. This example will show the full
source code, but you can use one of the programs you’ve been working on as a
basis, to make things easier.

Note: The code described here is contained in FilterChain.java.

The sample program includes the import statements that identify the package
locations for each class:

import javax.xml.parsers.FactoryConfigurationError;
import javax.xml.parsers.ParserConfigurationException;
import javax.xml.parsers.SAXParser;
import javax.xml.parsers.SAXParserFactory;

import org.xml.sax.SAXException;
import org.xml.sax.SAXParseException;
import org.xml.sax.InputSource;
import org.xml.sax.XMLReader;
import org.xml.sax.XMLFilter;

import javax.xml.transform.Transformer;
import javax.xml.transform.TransformerException;
import javax.xml.transform.TransformerFactory;
import javax.xml.transform.TransformerConfigurationException;

import javax.xml.transform.sax.SAXTransformerFactory;
import javax.xml.transform.sax.SAXSource;
import javax.xml.transform.sax.SAXResult;

http://xml.apache.org/xalan-j/commandline.html
../examples/jaxp/xslt/samples/FilterChain.java
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import javax.xml.transform.stream.StreamSource;
import javax.xml.transform.stream.StreamResult;

import java.io.*;

The program also includes the standard error handlers you’re used to. They’re
listed here, just so they are all gathered together in one place:

}
catch (TransformerConfigurationException tce) {

// Error generated by the parser
System.out.println ("* Transformer Factory error");
System.out.println("   " + tce.getMessage() );

// Use the contained exception, if any
Throwable x = tce;
if (tce.getException() != null)

x = tce.getException();
x.printStackTrace();

}
catch (TransformerException te) {

// Error generated by the parser
System.out.println ("* Transformation error");
System.out.println("   " + te.getMessage() );

// Use the contained exception, if any
Throwable x = te;
if (te.getException() != null)

x = te.getException();
x.printStackTrace();

}
catch (SAXException sxe) {

// Error generated by this application
// (or a parser-initialization error)
Exception  x = sxe;
if (sxe.getException() != null)

x = sxe.getException();
x.printStackTrace();

}
catch (ParserConfigurationException pce) {

// Parser with specified options can't be built
pce.printStackTrace();

}
catch (IOException ioe) {

// I/O error
ioe.printStackTrace();

}
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In between the import statements and the error handling, the core of the program
consists of the code shown below.

public static void main (String argv[])
{

if (argv.length != 3) {
System.err.println (

"Usage: java FilterChain style1 style2 xmlfile");
System.exit (1);

}

 try {
// Read the arguments
File stylesheet1 = new File(argv[0]);
File stylesheet2 = new File(argv[1]);
File datafile = new File(argv[2]);

 // Set up the input stream
BufferedInputStream bis = new

BufferedInputStream(newFileInputStream(datafile));
InputSource input = new InputSource(bis);

 // Set up to read the input file (see Note #1)
SAXParserFactory spf = SAXParserFactory.newInstance();
spf.setNamespaceAware(true);
SAXParser parser = spf.newSAXParser();
XMLReader reader = parser.getXMLReader();

 // Create the filters (see Note #2)
SAXTransformerFactory stf =

(SAXTransformerFactory)
TransformerFactory.newInstance();

XMLFilter filter1 = stf.newXMLFilter(
new StreamSource(stylesheet1));

XMLFilter filter2 = stf.newXMLFilter(
new StreamSource(stylesheet2));

// Wire the output of the reader to filter1 (see Note #3)
// and the output of filter1 to filter2
filter1.setParent(reader);
filter2.setParent(filter1);

 // Set up the output stream
StreamResult result = new StreamResult(System.out);

// Set up the transformer to process the SAX events generated
// by the last filter in the chain

Transformer transformer = stf.newTransformer();



UNDERSTANDING HOW THE FILTER CHAIN WORKS 323
SAXSource transformSource = new SAXSource(
filter2, input);

transformer.transform(transformSource, result);
} catch (...) {

...

Notes:

1. The Xalan transformation engine currently requires a namespace-aware
SAX parser.

2. This weird bit of code is explained by the fact that SAXTransformerFac-
tory extends TransformerFactory, adding methods to obtain filter
objects. The newInstance() method is a static method defined in Trans-

formerFactory, which (naturally enough) returns a TransformerFactory
object. In reality, though, it returns a SAXTransformerFactory. So, to get
at the extra methods defined by SAXTransformerFactory, the return value
must be cast to the actual type.

3. An XMLFilter object is both a SAX reader and a SAX content handler. As
a SAX reader, it generates SAX events to whatever object has registered to
receive them. As a content handler, it consumes SAX events generated by
its “parent” object — which is, of necessity, a SAX reader, as well. (Call-
ing the event generator a “parent” must make sense when looking at the
internal architecture. From an external perspective, the name doesn’t
appear to be particularly fitting.) The fact that filters both generate and con-
sume SAX events allows them to be chained together.

Understanding How the Filter Chain
Works
The code listed above shows you how to set up the transformation. Figure 7–2
should help you understand what’s happening when it executes.
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Figure 7–2 Operation of Chained Filters

When you create the transformer, you pass it at a SAXSource object, which
encapsulates a reader (in this case, filter2) and an input stream. You also pass
it a pointer to the result stream, where it directs its output. The diagram shows
what happens when you invoke transform() on the transformer. Here is an
explanation of the steps:

1. The transformer sets up an internal object as the content handler for
filter2, and tells it to parse the input source.

2. filter2, in turn, sets itself up as the content handler for filter1, and tells
it to parse the input source.

3. filter1, in turn, tells the parser object to parse the input source.

4. The parser does so, generating SAX events which it passes to filter1.

5. filter1, acting in its capacity as a content handler, processes the events
and does its transformations. Then, acting in its capacity as a SAX reader
(XMLReader), it sends SAX events to filter2.

6. filter2 does the same, sending its events to the transformer’s content
handler, which generates the output stream.

Testing the Program
To try out the program, you’ll create an XML file based on a tiny fraction of the
XML DocBook format, and convert it to the ARTICLE format defined here. Then
you’ll apply the ARTICLE stylesheet to generate an HTML version.
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Note: This example processes small-docbook-article.xml using docbookToAr-

ticle.xsl and article1c.xsl. The result is filterout.html (The browser-dis-
playable versions are small-docbook-article-xml.html, docbookToArticle-

xsl.html, article1c-xsl.html, and filterout-src.html.) See the O’Reilly
Web pages for a good description of the DocBook article format.

Start by creating a small article that uses a minute subset of the XML DocBook
format:

<?xml version="1.0"?>
<Article>

<ArtHeader>
<Title>Title of my (Docbook) article</Title>

</ArtHeader>
<Sect1>

<Title>Title of Section 1.</Title>
<Para>This is a paragraph.</Para>

</Sect1>
</Article>

Next, create a stylesheet to convert it into the ARTICLE format:

<xsl:stylesheet
xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
version="1.0"
>
<xsl:output method="xml"/> (see Note #1)

 <xsl:template match="/">
<ARTICLE>

<xsl:apply-templates/>
</ARTICLE>

</xsl:template>

<!-- Lower level titles strip element tag --> (see Note #2)

<!-- Top-level title -->
<xsl:template match="/Article/ArtHeader/Title"> (Note #3)

<TITLE> <xsl:apply-templates/> </TITLE>
</xsl:template>

 <xsl:template match="//Sect1"> (see Note #4)
<SECT><xsl:apply-templates/></SECT>

</xsl:template>

../examples/jaxp/xslt/samples/small-docbook-article.xml
../examples/jaxp/xslt/samples/docbookToArticle.xsl
../examples/jaxp/xslt/samples/docbookToArticle.xsl
../examples/jaxp/xslt/samples/article1c.xsl
../examples/jaxp/xslt/samples/filterout.html
../examples/jaxp/xslt/samples/small-docbook-article-xml.html
../examples/jaxp/xslt/samples/docbookToArticle-xsl.html
../examples/jaxp/xslt/samples/docbookToArticle-xsl.html
../examples/jaxp/xslt/samples/article1c-xsl.html
../examples/jaxp/xslt/samples/filterout-src.html
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 <xsl:template match="Para">
<PARA><xsl:apply-templates/></PARA> (see Note #5)

</xsl:template>

</xsl:stylesheet>

Notes:

1. This time, the stylesheet is generating XML output.

2. The template that follows (for the top-level title element) matches only the
main title. For section titles, the TITLE tag gets stripped. (Since no template
conversion governs those title elements, they are ignored. The text nodes
they contain, however, are still echoed as a result of XSLT’s built in tem-
plate rules— so only the tag is ignored, not the text. More on that below.)

3. The title from the DocBook article header becomes the ARTICLE title.

4. Numbered section tags are converted to plain SECT tags.

5. This template carries out a case conversion, so Para becomes PARA.

Although it hasn’t been mentioned explicitly, XSLT defines a number of built-in
(default) template rules. The complete set is listed in Section 5.8 of the specifica-
tion. Mainly, they provide for the automatic copying of text and attribute nodes,
and for skipping comments and processing instructions. They also dictate that
inner elements are processed, even when their containing tags don’t have tem-
plates. That is the reason that the text node in the section title is processed, even
though the section title is not covered by any template.

Now, run the FilterChain program, passing it the stylesheet above (docbook-
ToArticle.xsl), the ARTICLE stylesheet (article1c.xsl), and the small Doc-
Book file (small-docbook-article.xml), in that order. The result should like
this:

<html>
<body>
<h1 align="center">Title of my (Docbook) article</h1>
<h2>Title of Section 1.</h2>
<p>This is a paragraph.</p>
</body>
</html>

Note: This output was generated using JAXP 1.0. However, the first filter in the
chain is not currently translating any of the tags in the input file. Until that defect
is fixed, the output you see will consist of concatenated plain text in the HTML

../examples/jaxp/xslt/samples/small-docbook-article.xml
../examples/jaxp/xslt/samples/article1c.xsl
../examples/jaxp/xslt/samples/docbookToArticle.xsl
../examples/jaxp/xslt/samples/docbookToArticle.xsl
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output, like this: “Title of my (Docbook) article Title of Section 1. This

is a paragraph.”.

Conclusion
Congratulations! You have completed the XSLT tutorial. There is a lot you can
do with XML and XSLT, and you are now prepared to explore the many exciting
possibilities that await.

Further Information
For more information on XSL stylesheets, XSLT, and transformation engines,
see:

• A great introduction to XSLT that starts with a simple HTML page and
uses XSLT to customize it, one step at a time: http://www.xfront.com/

rescuing-xslt.html

• Extensible Stylesheet Language (XSL): http://www.w3.org/Style/

XSL/

• The XML Path Language: http://www.w3.org/TR/xpath

• The Xalan transformation engine: http://xml.apache.org/xalan-j/

• Output properties that can be programmatically specified on transformer objects:
http://www.w3.org/TR/xslt#output.

• Using Xalan from the command line: http://xml.apache.org/xalan-
j/commandline.html

http://www.w3.org/Style/XSL/
http://www.w3.org/Style/XSL/
http://www.w3.org/TR/xpath
http://xml.apache.org/xalan-j/commandline.html
http://xml.apache.org/xalan-j/commandline.html
http://xml.apache.org/xalan-j/
http://www.xfront.com/rescuing-xslt.html
http://www.xfront.com/rescuing-xslt.html
http://www.w3.org/TR/xslt#output
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Building Web Services
With JAX-RPC

JAX-RPC stands for Java API for XML-based RPC. It’s an API for building
Web services and clients that use remote procedure calls (RPC) and XML. Often
used in a distributed client/server model, an RPC mechanism enables clients to
execute procedures on other systems.

In JAX-RPC, a remote procedure call is represented by an XML-based protocol
such as SOAP. The SOAP specification defines the envelope structure, encoding
rules, and convention for representing remote procedure calls and responses.
These calls and responses are transmitted as SOAP messages (XML files) over
HTTP.

Although SOAP messages are complex, the JAX-RPC API hides this complexity
from the application developer. On the server side, the developer specifies the
remote procedures by defining methods in an interface written in the Java pro-
gramming language. The developer also codes one or more classes that imple-
ment those methods. Client programs are also easy to code. A client creates a
proxy, a local object representing the service, and then simply invokes methods
on the proxy. With JAX-RPC, the developer does not generate or parse SOAP
messages. It is the JAX-RPC runtime system that converts the API calls and
responses to and from SOAP messages.

With JAX-RPC, clients and Web services have a big advantage—the platform
independence of the Java programming language. In addition, JAX-RPC is not
restrictive: a JAX-RPC client can access a Web service that is not running on the
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Java platform and vice versa. This flexibility is possible because JAX-RPC uses
technologies defined by the World Wide Web Consortium (W3C): HTTP, SOAP,
and the Web Service Description Language (WSDL). WSDL specifies an XML
format for describing a service as a set of endpoints operating on messages.

Types Supported By JAX-RPC
Behind the scenes, JAX-RPC maps types of the Java programming language to
XML/WSDL definitions. For example, JAX-RPC maps the java.lang.String

class to the xsd:string XML data type. Application developers don’t need to
know the details of these mappings, but they should be aware that not every class
in the Java 2 Platform, Standard Edition (J2SE) can be used as a method parame-
ter or return type in JAX-RPC.

J2SE SDK Classes
JAX-RPC supports the following J2SE SDK classes:

java.lang.Boolean
java.lang.Byte
java.lang.Double
java.lang.Float
java.lang.Integer
java.lang.Long
java.lang.Short
java.lang.String

java.math.BigDecimal
java.math.BigInteger

java.net.URI

java.util.Calendar
java.util.Date
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Primitives
JAX-RPC supports the following primitive types of the Java programming lan-
guage:

boolean
byte
double
float
int
long
short

Arrays
JAX-RPC also supports arrays with members of supported JAX-RPC types.
Examples of supported arrays are int[] and String[]. Multidimensional
arrays, such as BigDecimal[][], are also supported.

Value Types
A value type is a class whose state may be passed between a client and remote
service as a method parameter or return value. For example, in an application for
a university library, a client might call a remote procedure with a value type
parameter named Book, a class that contains the fields Title, Author, and Pub-

lisher.

To be supported by JAX-RPC, a value type must conform to the following rules:

• It must have a public default constructor.

• It must not implement (either directly or indirectly) the java.rmi.Remote
interface.

• Its fields must be supported JAX-RPC types.

The value type may contain public, private, or protected fields. The field of a
value type must meet these requirements:

• A public field cannot be final or transient.

• A non-public field must have corresponding getter and setter methods.
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JavaBeans Components
JAX-RPC also supports JavaBeans components, which must conform to the
same set of rules as application classes. In addition, a JavaBeans component
must have a getter and setter method for each bean property. The type of the bean
property must be a supported JAX-RPC type. For an example of a JavaBeans
component, see the section Service Implementation (page 1088).

Setting the Port
Several files in the JAX-RPC examples depend on the port that you specified
when you installed the J2EE Application Server. The tutorial examples assume
that the server runs on the default port, 8080. If you have changed the port, you
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must update the port number in the following files before building and running
the examples:

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/dii/conf/

config-client.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/dii/src/

client/hello/DIIClient.properties

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/dynamic/

conf/config-client.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/dynamic/

src/client/hello/ProxyClient.properties

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/handler/

conf/config.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/stubs/

conf/config-client.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/advanced/stubs/

conf/config-client-oneway.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/basicauthclient/

SecureHello.wsdl

• <INSTALL>/j2eetutorial14/examples/jaxrpc/dynamicproxy/con-

fig-wsdl.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/mutualauthclient/

SecureHello.wsdl

• <INSTALL>/j2eetutorial14/examples/jaxrpc/staticstub/config-

wsdl.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/webclient/config-

wsdl.xml

• <INSTALL>/j2eetutorial14/examples/jaxrpc/webclient/web/

response.jsp

Creating a Web Service with JAX-RPC
This section shows how to build and deploy a simple Web service called MyHel-

loService. A later section, Creating Web Service Clients with JAX-
RPC (page 339), provides examples of JAX-RPC clients that access this service.
The source code required by MyHelloService is in <INSTALL>/

j2eetutorial14/examples/jaxrpc/helloservice/.
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These are the basic steps for creating the service:

1. Code the service endpoint interface and implementation class.

2. Build and generate the files required by the service.

3. Use deploytool to package the service’s files into a WAR file.

4. Deploy the WAR file.

The sections that follow cover these steps in greater detail.

Note: Before proceeding, you should try out the examples in the Getting
Started with Web Applications chapter. Make sure that you’ve followed the
instructions in Setting Up To Build and Deploy Tutorial
Examples (page 90).

Coding the Service Endpoint Interface
and Implementation Class
A service endpoint interface declares the methods that a remote client may
invoke on the service. In this example, the interface declares a single method
named sayHello.

A service endpoint interface must conform to a few rules:

• It extends the java.rmi.Remote interface.

• It must not have constant declarations, such as public final static.

• The methods must throw the java.rmi.RemoteException or one of its
subclasses. (The methods may also throw service-specific exceptions.)

• Method parameters and return types must be supported JAX-RPC types.
See the section Types Supported By JAX-RPC (page 330).

In this example, the service endpoint interface is HelloIF.java:

package helloservice;

import java.rmi.Remote;
import java.rmi.RemoteException;

public interface HelloIF extends Remote {
    public String sayHello(String s) throws RemoteException;
}
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In addition to the interface, you’ll need the class that implements the interface. In
this example, the implementation class is called HelloImpl:

package helloservice;

public class HelloImpl implements HelloIF {

    public String message =“Hello“;

    public String sayHello(String s) {
        return message + s;
    }
}

Building the Service
To build MyHelloService, in a terminal window go to the <INSTALL>/

j2eetutorial14/examples/jaxrpc/helloservice/ directory and type the
following:

asant build

The preceding command executes these asant tasks:

• compile-service

• generate-wsdl

compile-service
This asant task compiles HelloIF.java and HelloImpl.java, writing the class
files to the build subdirectory.

generate-wsdl
The generate-wsdl task runs the wscompile tool, which creates the MyHelloS-

ervice.wsdl file and mapping.xml file in the build directory. The generate-

wsdl task runs wscompile as follows:

wscompile -define -mapping build/mapping.xml -d build -nd build
-classpath build config-interface.xml
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The -define flag instructs the tool to read the service endpoint interface and to
create a WSDL file. The -mapping flag specifies the mapping file. The -d and -

nd flags tell the tool to write output to the build subdirectory. The tool reads the
following config-interface.xml file:

<?xml version=”1.0” encoding=”UTF-8”?>
<configuration
  xmlns=”http://java.sun.com/xml/ns/jax-rpc/ri/config”>
  <service
      name=”MyHelloService”
      targetNamespace=”urn:Foo”
      typeNamespace=”urn:Foo”
      packageName=”helloservice”>
      <interface name=”helloservice.HelloIF”/>
  </service>
</configuration>

The config.xml-interface file tells wscompile to create a WSDL file with the
following information:

• The service name is MyHelloService.

• The WSDL namespace is urn:Foo. (To understand this namespace, you
need to be familiar with WSDL technology. See Types Supported By JAX-
RPC, page 330)

• The classes for the MyHelloService are in the helloservice package.

• The service endpoint interface is helloservice.HelloIF.

Packaging the Service
Behind the scenes, a JAX-RPC Web service is actually a servlet. Because a serv-
let is a Web component, to package the service you run the New Web Compo-
nent wizard of the deploytool utility. During this process the wizard performs
the following tasks.

• Creates the Web application deployment descriptor

• Creates a WAR file

• Adds the deployment descriptor and service files to the WAR file
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To start the New Web Component wizard, select File→New→Web Component.
The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2. WAR File dialog box

a. Select the button labelled Create New Stand-Alone WAR Module.

b. In the WAR Location field, navigate to <INSTALL>/j2eetutorial14/

examples/jaxrpc/helloservice/.

c. In the WAR Display Field, enter MyHelloService.

d. Click Edit.

e. In the tree under Available Files, locate the <INSTALL>/
j2eetutorial14/examples/jaxrpc/helloservice/ directory.

f. Select the build subdirectory.

g. Click Add.

h. Click OK.

i. Click Next.

3. Choose Component Type dialog box

a. Select the Web Services Endpoint button.

b. Click Next.

4. Choose Service dialog box

a. In the WSDL File combo box, select WEB-INF/wsdl/MyHelloSer-

vice.wsdl.

b. In the Mapping File combo box, select build/mapping.xml.

c. Click Next.

5. Component General Properties dialog box

a. In the Service Endpoint Implementation combo box, select helloser-
vice.HelloImpl.

b. Click Next.

6. Web Service Endpoint dialog box

a. In the Service Endpoint Interface combo box, select helloser-

vice.HelloIF.

b. In the Namespace field, select urn:Foo.
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c. In the Local Part field, select HelloIFPort.

d. deploytool will enter a default Endpoint Address URI HelloImpl in this
dialog. This endpoint address must be updated in the next section.

e. Click Next.

f. Click Finish.

Specifying the Endpoint Address
To access MyHelloService, the tutorial clients will specify this service endpoint
address URI:

http://localhost:8080/hello-jaxrpc/hello

The /hello-jaxrpc string is the context root of the servlet that implements
MyHelloService. The /hello string is the servlet alias. To specify the endpoint
address, you set the context root and alias as follows:

1. In deploytool, select MyHelloService in the tree.

2. Select the General tab.

3. In the Context Root field, enter /hello-jaxrpc.

4. In the tree, select HelloImpl.

5. Select the Aliases tab.

6. In the Component Aliases table, add /hello. (Don’t forget the forward
slash.)

7. In the Endpoint tab, select hello for the Endpoint Address in the Sun-spe-
cific Settings Frame.

8. Select File→Save.

Deploying the Service
In deploytool, perform these steps:

1. In the tree, select MyHelloService.

2. Select Tools→Deploy.

Now you are ready to create a client that accesses this service.
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Creating Web Service Clients with JAX-
RPC

This section shows how to create and run these types of clients:

• Static stub

• Dynamic proxy

• Dynamic invocation interface (DII)

• J2EE application client

When you run these client examples, they will access the MyHelloService that
you deployed in the preceding section.

Static Stub Client Example
This example resides in the <INSTALL>/j2eetutorial14/examples/jaxrpc/

staticstub/ directory.

HelloClient is a stand-alone program that calls the sayHello method of the
MyHelloService. It makes this call through a stub, a local object which acts as a
proxy for the remote service. Because the stub is created before runtime (by
wscompile), it is usually called a static stub.

Coding the Static Stub Client
Before it can invoke the remote methods on the stub the client performs these
steps:

1. Creates a Stub object:
(Stub)(new MyHelloService_Impl().getHelloIFPort())

The code in this method is implementation-specific because it relies on a
MyHelloService_Impl object, which is not defined in the specifications.
The MyHelloService_Impl class will be generated by wscompile in the
following section.

2. Sets the endpoint address that the stub uses to access the service:
stub._setProperty
(javax.xml.rpc.Stub.ENDPOINT_ADDRESS_PROPERTY, args[0]);
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At runtime, the endpoint address is passed to HelloClient in args[0] as
a command-line parameter, which asant gets from the end-

point.address property in the build.properties file. This address
must match the one you set for the service in Specifying the Endpoint
Address (page 338).

3. Casts stub to the service endpoint interface, HelloIF:

HelloIF hello = (HelloIF)stub;

Here is the full source code listing for the HelloClient.java file, which is
located in the directory <INSTALL>/j2eetutorial14/examples/jaxrpc/stat-

icstub/src/:

package staticstub;

import javax.xml.rpc.Stub;

public class HelloClient {

    private String endpointAddress;

    public static void main(String[] args) {

        System.out.println(“Endpoint address = “ + args[0]);
        try {
            Stub stub = createProxy();
            stub._setProperty
              (javax.xml.rpc.Stub.ENDPOINT_ADDRESS_PROPERTY,
               args[0]);
            HelloIF hello = (HelloIF)stub;
            System.out.println(hello.sayHello(“Duke!”));
        } catch (Exception ex) {
            ex.printStackTrace();
        }
    }

    private static Stub createProxy() {
// Note: MyHelloService_Impl is implementation-specific.

        return
        (Stub) (new MyHelloService_Impl().getHelloIFPort());
    }
}
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Building and Running the Static Stub Client
Before performing the steps in this section, you must first create and deploy
MyHelloService as described in Creating a Web Service with JAX-
RPC (page 333).

To build and package the client, go to the <INSTALL>/j2eetutorial14/exam-

ples/jaxrpc/staticstub/ directory and type the following:

asant build

The preceding command invokes three asant tasks:

• generate-stubs

• compile-client

• package-client

The generate-stubs task runs the wscompile tool as follows:

wscompile -gen:client -d build -classpath build config-wsdl.xml

This wscompile command reads the MyHelloService.wsdl file that was gener-
ated in Building the Service (page 335). The wscompile command generates
files based on the information in the WSDL file and on the command-line flags.
The -gen:client flag instructs wscompile to generate the stubs, other runtime
files such as serializers, and value types. The -d flag tells the tool to write the
output to the build/staticstub subdirectory. The tool reads the following con-

fig-wsdl.xml file, which specifies the location of the WSDL file:

<?xml version=”1.0” encoding=”UTF-8”?>
<configuration

xmlns=”http://java.sun.com/xml/ns/jax-rpc/ri/config”>
  <wsdl location=”build/MyHelloService.wsdl”
       packageName=”staticstub”/>
</configuration>

The compile-client task compiles src/HelloClient.java and writes the
class file to the build subdirectory.

The package-client task packages the files created by the generate-stubs
and compile-client tasks into the dist/client.jar file. Except for the Hel-

loClient.class, all of the files in client.jar were created by wscompile.
Note that wscompile generated the HelloIF.class based on the information it
read from the MyHelloService.wsdl file.
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To run the client, type the following:

asant run

The client should display the following line:

Hello Duke!

Dynamic Proxy Client Example
This example resides in the <INSTALL>/j2eetutorial14/examples/jaxrpc/

dynamicproxy/ directory.

The client in the preceding section used a static stub for the proxy. In contrast,
the client example in this section calls a remote procedure through a dynamic

proxy, a class that is created during runtime. Although the source code for the
static stub client relied on an implementation-specific class, the code for the
dynamic proxy client does not have this limitation.

Coding the Dynamic Proxy Client
The DynamicProxyHello program constructs the dynamic proxy as follows:

1. Creates a Service object named helloService:

Service helloService =
    serviceFactory.createService(helloWsdlUrl,
    new QName(nameSpaceUri, serviceName));

A Service object is a factory for proxies. To create the Service object
(helloService), the program calls the createService method on
another type of factory, a ServiceFactory object.

The createService method has two parameters, the URL of the WSDL
file and a QName object. At runtime, the client gets information about the
service by looking up its WSDL. In this example, the URL of the WSDL
file points to the WSDL that was deployed with MyHelloService:

http://localhost:8080/hello-jaxrpc/hello?WSDL

A QName object is a tuple that represents an XML qualified name. The
tuple is composed of a namespace URI and the local part of the qualified
name. In the QName parameter of the createService invocation, the local
part is the service name, MyHelloService.
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2. The program creates a proxy (myProxy) with a type of the service endpoint
interface (HelloIF):

dynamicproxy.HelloIF myProxy =
   (dynamicproxy.HelloIF)helloService.getPort(
   new QName(nameSpaceUri, portName),
   dynamicproxy.HelloIF.class);

The helloService object is a factory for dynamic proxies. To create
myProxy, the program calls the getPort method of helloService. This
method has two parameters: a QName object that specifies the port name
and a java.lang.Class object for the service endpoint interface (Hel-
loIF). The HelloIF class is generated by wscompile. The port name
(HelloIFPort) is specified by the WSDL file.

Here is the listing for the HelloClient.java file, located in the <INSTALL>/

j2eetutorial14/examples/jaxrpc/dynamicproxy/src/ directory:

package dynamicproxy;

import java.net.URL;
import javax.xml.rpc.Service;
import javax.xml.rpc.JAXRPCException;
import javax.xml.namespace.QName;
import javax.xml.rpc.ServiceFactory;
import dynamicproxy.HelloIF;

public class HelloClient {

    public static void main(String[] args) {
        try {

            String UrlString = args[0] + “?WSDL”;
            String nameSpaceUri = “urn:Foo”;
            String serviceName = “MyHelloService”;
            String portName = “HelloIFPort”;

            System.out.println(“UrlString = “ + UrlString);
            URL helloWsdlUrl = new URL(UrlString);

            ServiceFactory serviceFactory =
                ServiceFactory.newInstance();

            Service helloService =
                serviceFactory.createService(helloWsdlUrl,
                new QName(nameSpaceUri, serviceName));

            dynamicproxy.HelloIF myProxy =
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                (dynamicproxy.HelloIF)
                helloService.getPort(
                new QName(nameSpaceUri, portName),
                dynamicproxy.HelloIF.class);

            System.out.println(myProxy.sayHello(“Buzz”));

        } catch (Exception ex) {
            ex.printStackTrace();
        }
    }
}

Building and Running the Dynamic Proxy
Client
Before performing the steps in this section, you must first create and deploy
MyHelloService as described in Creating a Web Service with JAX-
RPC (page 333).

To build and package the client, go to the <INSTALL>/j2eetutorial14/exam-

ples/jaxrpc/dynamicproxy/ directory and type the following:

asant build

The preceding command runs these tasks:

• generate-interface

• compile-client

• package-dynamic

The generate-interface task runs wscompile with the -import option. The
wscompile command reads the MyHelloService.wsdl file and generates the
service endpoint interface class (HelloIF.class). Although this wscompile

invocation also creates stubs, the dynamic proxy client does not use these stubs,
which are required only by static stub clients.

The compile-client task compiles the src/HelloClient.java file.

The package-dynamic task creates the dist/client.jar file, which contains
HelloIF.class and HelloClient.class.

To run the client, type the following:

asant run
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The client should display the following line:

Hello Buzz

Dynamic Invocation Interface (DII)
Client Example
This example resides in the <INSTALL>/j2eetutorial14/examples/jaxrpc/

dii/ directory.

With the dynamic invocation interface (DII), a client can call a remote procedure
even if the signature of the remote procedure or the name of the service are
unknown until runtime. In contrast to a static stub or dynamic proxy client, a DII
client does not require runtime classes generated by wscompile. However, as
you’ll see in the following section, the source code for a DII client is more com-
plicated than the code of the other two types of clients.

This example is for advanced users who are familiar with WSDL documents.
(See Further Information, page 353.)

Coding the DII Client
The DIIHello program performs these steps:

1. Creates a Service object.
Service service =
    factory.createService(new QName(qnameService));

To get a Service object, the program invokes the createService method
of a ServiceFactory object. The parameter of the createService

method is a QName object that represents the name of the service, MyHel-
loService. The WSDL file specifies this name as follows:

 <service name=”MyHelloService”>

2. From the Service object, creates a Call object:
QName port = new QName(qnamePort);
Call call = service.createCall(port);

A Call object supports the dynamic invocation of the remote procedures
of a service. To get a Call object, the program invokes the Service

object’s createCall method. The parameter of createCall is a QName

object that represents the service endpoint interface, MyHelloService-
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RPC. In the WSDL file, the name of this interface is designated by the
portType element:

 <portType name=”HelloIF”>

3. Sets the service endpoint address on the Call object:
call.setTargetEndpointAddress(endpoint);

In the WSDL file, this address is specified by the <soap:address> ele-
ment.

4. Sets these properties on the Call object:
SOAPACTION_USE_PROPERTY
SOAPACTION_URI_PROPERTY
ENCODING_STYLE_PROPERTY

To learn more about these properties, refer to the SOAP and WSDL docu-
ments listed in Further Information (page 353).

5. Specifies the method’s return type, name, and parameter:
QName QNAME_TYPE_STRING = new QName(NS_XSD, “string”);
call.setReturnType(QNAME_TYPE_STRING);

call.setOperationName(new QName(BODY_NAMESPACE_VALUE,
    “sayHello”));

call.addParameter(“String_1”, QNAME_TYPE_STRING,
    ParameterMode.IN);

To specify the return type, the program invokes the setReturnType

method on the Call object. The parameter of setReturnType is a QName

object that represents an XML string type.

The program designates the method name by invoking the setOpera-

tionName method with a QName object that represents sayHello.

To indicate the method parameter, the program invokes the addParameter
method on the Call object. The addParameter method has three argu-
ments: a String for the parameter name (String_1), a QName object for
the XML type, and a ParameterMode object to indicate the passing mode
of the parameter (IN).

6. Invokes the remote method on the Call object:

String[] params = { “Murphy” };
String result = (String)call.invoke(params);
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The program assigns the parameter value (Murphy) to a String array
(params) and then executes the invoke method with the String array as
an argument.

Here is the listing for the HelloClient.java file, located in the <INSTALL>/

j2eetutorial14/examples/jaxrpc/dii/src/ directory:

package dii;

import javax.xml.rpc.Call;
import javax.xml.rpc.Service;
import javax.xml.rpc.JAXRPCException;
import javax.xml.namespace.QName;
import javax.xml.rpc.ServiceFactory;
import javax.xml.rpc.ParameterMode;

public class HelloClient {

    private static String qnameService = “MyHelloService”;
    private static String qnamePort = “HelloIF”;

    private static String BODY_NAMESPACE_VALUE =
        “urn:Foo”;
    private static String ENCODING_STYLE_PROPERTY =
         “javax.xml.rpc.encodingstyle.namespace.uri”;
    private static String NS_XSD =
        “http://www.w3.org/2001/XMLSchema”;
    private static String URI_ENCODING =
         “http://schemas.xmlsoap.org/soap/encoding/”;

    public static void main(String[] args) {

        System.out.println(“Endpoint address = “ + args[0]);

        try {
            ServiceFactory factory =
                ServiceFactory.newInstance();
            Service service =
                factory.createService(
                new QName(qnameService));

            QName port = new QName(qnamePort);

            Call call = service.createCall(port);
            call.setTargetEndpointAddress(args[0]);

            call.setProperty(Call.SOAPACTION_USE_PROPERTY,
                new Boolean(true));
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            call.setProperty(Call.SOAPACTION_URI_PROPERTY
                 ““);
            call.setProperty(ENCODING_STYLE_PROPERTY,
                URI_ENCODING);
            QName QNAME_TYPE_STRING =
                        new QName(NS_XSD, “string”);
            call.setReturnType(QNAME_TYPE_STRING);

            call.setOperationName(
                new QName(BODY_NAMESPACE_VALUE,“sayHello”));
            call.addParameter(“String_1”, QNAME_TYPE_STRING,
                ParameterMode.IN);
            String[] params = { “Murph!” };

            String result = (String)call.invoke(params);
            System.out.println(result);

        } catch (Exception ex) {
            ex.printStackTrace();
        }
    }
}

Building and Running the DII Client
Before performing the steps in this section, you must first create and deploy
MyHelloService as described in Creating a Web Service with JAX-
RPC (page 333).

To build and package the client, go to the <INSTALL>/j2eetutorial14/exam-

ples/jaxrpc/dii/ directory and type the following:

asant build

This build task compiles HelloClient and packages it into the dist/cli-

ent.jar file. Unlike the previous client examples, the DII client does not require
files generated by wscompile.

To run the client, type this command:

asant run

The client should display this line:

Hello Murph!
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J2EE Application Client Example
Unlike the stand-alone clients in the preceding sections, the client in this section
is a J2EE application client. Because it’s a J2EE component, a J2EE application
client can locate a local Web service by invoking the JNDI lookup method.

J2EE Application HelloClient Listing
Here is the listing for the HelloClient.java file, located in the <INSTALL>/

j2eetutorial14/examples/jaxrpc/appclient/src/ directory:

package appclient;

import javax.xml.rpc.Stub;
import javax.naming.*;

public class HelloClient {

    private String endpointAddress;

    public static void main(String[] args) {

        System.out.println(“Endpoint address = “ + args[0]);

        try {
            Context ic = new InitialContext();
            MyHelloService myHelloService = (MyHelloService)

ic.lookup(“java:comp/env/service/MyJAXRPCHello”);
            appclient.HelloIF helloPort =
                myHelloService.getHelloIFPort();
            ((Stub)helloPort)._setProperty
                (Stub.ENDPOINT_ADDRESS_PROPERTY,args[0]);

            System.out.println(helloPort.sayHello(“Jake!”));
            System.exit(0);

        } catch (Exception ex) {
            ex.printStackTrace();
            System.exit(1);
        }
    }
}
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Building the J2EE Application Client
In a terminal window, go to the <INSTALL>/j2eetutorial14/examples/
jaxrpc/appclient directory and type the following:

asant build

The preceding command compiles HelloClient.java and runs wscompile by
invoking the generate-mapping target.

This asant task also runs wscompile, this time to create a mapping.xml file and
a set of runtime classes. The mapping.xml file maps the package names of the
service classes to a namespace URI of the WSDL file. The set of runtime classes
is made up of serializers, deserializers, and ties. The generate-mapping task
runs wscompile as follows:

wscompile -gen -d build -nd build -mapping build/mapping.xml
-classpath build config-wsdl.xml

The -gen flag instructs the tool to read the WSDL file and to create the runtime
classes. The -d and -nd flags tell the tool to write output to the build subdirec-
tory, and the -mapping flag specifies the mapping file. The tool reads the follow-
ing config-wsdl.xml file:

<?xml version="1.0" encoding="UTF-8"?>
  <configuration
     xmlns="http://java.sun.com/xml/ns/jax-rpc/ri/config">
     <wsdl location="../build/MyHelloService.wsdl"
     packageName="helloservice"/>
  </configuration>

Packaging the J2EE Application Client
Packaging this client is a two-step process:

1. Create an EAR file for a J2EE application.

2. Create a JAR file for the application client and add it to the EAR file.

To create the EAR file, follow these steps:

1. In deploytool, select File→New→Application EAR.

2. Click Browse.

3. In the file chooser, navigate to <INSTALL>/j2eetutorial14/examples/
jaxrpc/appclient.
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4. In the File Name field, enter HelloServiceApp.

5. Click New Application.

6. Click OK.

To start the New Application Client wizard, select File→New→Application Client
JAR. The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2.  JAR File Contents dialog box

a. Select the button labelled Create New AppClient Module in Applica-
tion.

b. In the combo box below this button, select HelloServiceApp.

c. In the AppClient Display Name field, enter HelloClient.

d. Click Edit.

e. In the tree under Available Files, locate the <INSTALL>/

j2eetutorial14/examples/jaxrpc/appclient directory.

f. Select the build directory.

g. Click Add.

h. Click OK.

i. Click Next.

3. General dialog box

a. In the Main Class combo box, select appclient.HelloClient.

b. Click Next.

c. Click Finish.

Specifying the Web Reference
When it invokes the lookup method, the HelloClient refers to the Web service
as follows:

MyHelloService myHelloService = (MyHelloService)
ic.lookup("java:comp/env/service/MyJAXRPCHello");
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You specify this reference as follows.

1. In the tree, select HelloClient.

2. Select the Web Service Refs tab.

3. Click Add.

4. In the Coded Name field, enter service/MyJAXRPCHello.

5. In the Service Interface combo box, select appclient.MyHelloService.

6. In the WSDL File combo box, select MyHelloService.wsdl.

7. In the Namespace field, enter urn:Foo.

8. In the Local Part field, enter MyHelloService.

9. In the Mapping File combo box, select mapping.xml.

10.Click OK.

Deploying and Running the J2EE Application
Client
Before performing the steps in this section, you must first create and deploy the
MyHelloService as described in Creating a Web Service with JAX-
RPC (page 333).

To deploy the J2EE application client, follow these steps:

1. Select the HelloServiceApp application.

2. Select Tools→Deploy.

3. In the Deploy Module dialog select the checkbox labelled Return Client
JAR.

4. In the field below the checkbox, enter this directory:

<INSTALL>/j2eetutorial14/examples/jaxrpc/appclient

5. Click OK.

To run the client:

1. In a terminal window, go to the <INSTALL>/j2eetutorial14/examples/
jaxrpc/appclient/ directory.

2. Type the following on a single line:

appclient -client HelloServiceAppClient.jar
http://localhost:8080/hello-jaxrpc/hello
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The client should display this line:

Hello Jake!

More JAX-RPC Client Examples
Other chapters in this book also have JAX-RPC client examples:

• Chapter 27 includes a static stub client that demonstrates authentication.
See the section, Example: Basic Authentication with JAX-
RPC (page 943).

• Chapter 16 shows how a JSP page can be a static stub client that accesses
a remote Web service. See the section, The Example JSP
Pages (page 644).

Web Services Interoperability (WS-I)
and JAX-RPC

JAX-RPC 1.1 supports the WS-I Basic Profile Version 1.0, Working Group
Approval Draft. The WS-I Basic Profile is a document that clarifies the SOAP
1.1 and WSDL 1.1 specifications in order to promote SOAP interoperability.
(For links related to WS-I, see Further Information, page 353.)

To support WS-I, JAX-RPC has the following features:

• When run with the -f:wsi option, wscompile verifies that a WSDL is WS-
I compliant and/or generates classes needed by JAX-RPC services and cli-
ents that are WS-I compliant.

• The JAX-RPC runtime supports doc/literal and rpc/literal for services,
static stubs, dynamic proxies, and DII.

Further Information
For more information about JAX-RPC and related technologies, refer to the fol-
lowing:

• Java API for XML-based RPC 1.1 Specification
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http://java.sun.com/xml/downloads/jaxrpc.html

• JAX-RPC Home
http://java.sun.com/xml/jaxrpc/index.html

• Simple Object Access Protocol (SOAP) 1.1 W3C Note
http://www.w3.org/TR/SOAP/

• Web Services Description Language (WSDL) 1.1 W3C Note
http://www.w3.org/TR/wsdl

• WS-I Basic Profile 1.0
http://www.ws-i.org

http://java.sun.com/xml/downloads/jaxrpc.html
http://java.sun.com/xml/jaxrpc/index.html
http://www.w3.org/TR/SOAP/
http://www.w3.org/TR/wsdl
http://www.ws-i.org
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SOAP with
Attachments API for

Java

SOAP with Attachments API for Java (SAAJ) is used mainly for the SOAP
messaging that goes on behind the scenes in JAX-RPC and JAXR implementa-
tions. Secondarily, it is an API that developers can use when they choose to write
SOAP messaging applications directly rather than using JAX-RPC. The SAAJ
API allows you to do XML messaging from the Java platform: By simply mak-
ing method calls using the SAAJ API, you can create, send, and consume XML
messages over the Internet. This chapter will help you learn how to use the SAAJ
API.

The SAAJ API conforms to the Simple Object Access Protocol (SOAP) 1.1
specification and the SOAP with Attachments specification. The SOAP with
Attachments API for Java (SAAJ) 1.2 specification defines the javax.xml.soap

package, which contains the API for creating and populating a SOAP message.
This package has all the API necessary for sending request-response messages.
(Request-response messages are explained in SOAPConnection
Objects, page 360.)

Note: The javax.xml.messaging package, defined in the Java API for XML Mes-
saging (JAXM) 1.1 specification, is not part of the J2EE 1.4 platform and is not dis-
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cussed in this chapter. The JAXM API is available as a separate download
from http://java.sun.com/xml/jaxm/.

This chapter starts with an overview of messages and connections, which gives
some of the conceptual background behind the SAAJ API to help you under-
stand why certain things are done the way they are. Next the tutorial shows you
how to use the basic SAAJ API, giving examples and explanations of the more
commonly used features. The code examples in the last part of the tutorial show
you how to build an application, and the case study in The Coffee Break
Application (page 1085) includes SAAJ code for both sending and consuming a
SOAP message.

Overview of SAAJ
This overview presents a high level view of how SAAJ messaging works and
explains concepts in general terms. Its goal is to give you some terminology and
a framework for the explanations and code examples that are presented in the
tutorial section.

The overview looks at SAAJ from two perspectives:

• Messages

• Connections

Messages
SAAJ messages follow SOAP standards, which prescribe the format for mes-
sages and also specify some things that are required, optional, or not allowed.
With the SAAJ API, you can create XML messages that conform to the SOAP
1.1 and WS-I Basic Profile 1.0 specifications simply by making Java API calls.

The Structure of an XML Document

Note: For more complete information on XML documents, see Chapters 2 and 4.

An XML document has a hierarchical structure with elements, subelements, sub-
subelements, and so on. You will notice that many of the SAAJ classes and inter-

http://java.sun.com/xml/jaxm/
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faces represent XML elements in a SOAP message and have the word element or
SOAP or both in their names.

An element is also referred to as a node. Accordingly, the SAAJ API has the
interface Node, which is the base class for all the classes and interfaces that rep-
resent XML elements in a SOAP message. There are also methods such as
SOAPElement.addTextNode, Node.detachNode, and Node.getValue, which
you will see how to use in the tutorial section.

What Is in a Message?
The two main types of SOAP messages are those that have attachments and
those that do not.

Messages with No Attachments
The following outline shows the very high level structure of a SOAP message
with no attachments. Except for the SOAP header, all the parts listed are required
to be in every SOAP message.

I. SOAP message

A. SOAP part

1. SOAP envelope

a. SOAP header (optional)

b. SOAP body

The SAAJ API provides the SOAPMessage class to represent a SOAP message,
the SOAPPart class to represent the SOAP part, the SOAPEnvelope interface to
represent the SOAP envelope, and so on. Figure 9–1 illustrates the structure of a
SOAP message with no attachments.

When you create a new SOAPMessage object, it will automatically have the parts
that are required to be in a SOAP message. In other words, a new SOAPMessage

object has a SOAPPart object that contains a SOAPEnvelope object. The SOAPEn-

velope object in turn automatically contains an empty SOAPHeader object fol-
lowed by an empty SOAPBody object. If you do not need the SOAPHeader object,
which is optional, you can delete it. The rationale for having it automatically
included is that more often than not you will need it, so it is more convenient to
have it provided.
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The SOAPHeader object may contain one or more headers with information about
the sending and receiving parties. The SOAPBody object, which always follows
the SOAPHeader object if there is one, provides a simple way to send information
intended for the ultimate recipient. For example, if there is a SOAPFault object
(see Using SOAP Faults, page 383), it must be in the SOAPBody object.

Figure 9–1 SOAPMessage Object with No Attachments

Messages with Attachments
A SOAP message may include one or more attachment parts in addition to the
SOAP part. The SOAP part may contain only XML content; as a result, if any of
the content of a message is not in XML format, it must occur in an attachment
part. So, if for example, you want your message to contain a binary file, your
message must have an attachment part for it. Note that an attachment part can
contain any kind of content, so it can contain data in XML format as well. Figure
9–2 shows the high-level structure of a SOAP message that has two attachments.
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Figure 9–2 SOAPMessage Object with Two AttachmentPart Objects

The SAAJ API provides the AttachmentPart class to represent the attachment
part of a SOAP message. A SOAPMessage object automatically has a SOAPPart

object and its required subelements, but because AttachmentPart objects are
optional, you have to create and add them yourself. The tutorial section will walk
you through creating and populating messages with and without attachment
parts.

If a SOAPMessage object has one or more attachments, each AttachmentPart

object must have a MIME header to indicate the type of data it contains. It may
also have additional MIME headers to identify it or to give its location, which
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are optional but can be useful when there are multiple attachments. When a
SOAPMessage object has one or more AttachmentPart objects, its SOAPPart

object may or may not contain message content.

SAAJ and DOM
At SAAJ 1.2, the SAAJ APIs extend their counterparts in the org.w3c.dom

package:

• The Node interface extends the org.w3c.dom.Node interface.

• The SOAPElement interface extends both the Node interface and the
org.w3c.dom.Element interface.

• The SOAPPart class implements the org.w3c.dom.Document interface.

• The Text interface extends the org.w3c.dom.Text interface.

Moreover, the SOAPPart of a SOAPMessage is also a DOM Level 2 Document,
and can be manipulated as such by applications, tools and libraries that use
DOM. See Chapter 6 for details about DOM. See Adding Content to the SOAP-
Part Object (page 372) and Adding a Document to the SOAP Body (page 374)
for details on how to use DOM documents with the SAAJ API.

Connections
All SOAP messages are sent and received over a connection. With the SAAJ
API, the connection is represented by a SOAPConnection object, which goes
from the sender directly to its destination. This kind of connection is called a
point-to-point connection because it goes from one endpoint to another endpoint.
Messages sent using the SAAJ API are called request-response messages. They
are sent over a SOAPConnection object with the method call, which sends a
message (a request) and then blocks until it receives the reply (a response).

SOAPConnection Objects
The following code fragment creates the SOAPConnection object connection,
and then, after creating and populating the message, uses connection to send
the message. As stated previously, all messages sent over a SOAPConnection

object are sent with the method call, which both sends the message and blocks
until it receives the response. Thus, the return value for the method call is the
SOAPMessage object that is the response to the message that was sent. The
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parameter request is the message being sent; endpoint represents where it is
being sent.

SOAPConnectionFactory factory =
SOAPConnectionFactory.newInstance();

SOAPConnection connection = factory.createConnection();

. . .// create a request message and give it content

java.net.URL endpoint =
new URL("http://fabulous.com/gizmo/order");

SOAPMessage response = connection.call(request, endpoint);

Note that the second argument to the method call, which identifies where the
message is being sent, can be a String object or a URL object. Thus, the last two
lines of code from the preceding example could also have been the following:

String endpoint = "http://fabulous.com/gizmo/order";
SOAPMessage response = connection.call(request, endpoint);

A Web service implemented for request-response messaging must return a
response to any message it receives. The response is a SOAPMessage object, just
as the request is a SOAPMessage object. When the request message is an update,
the response is an acknowledgement that the update was received. Such an
acknowledgement implies that the update was successful. Some messages may
not require any response at all. The service that gets such a message is still
required to send back a response because one is needed to unblock the call

method. In this case, the response is not related to the content of the message; it
is simply a message to unblock the call method.

Now that you have some background on SOAP messages and SOAP connec-
tions, in the next section you will see how to use the SAAJ API.

Tutorial
This tutorial will walk you through how to use the SAAJ API. First, it covers the
basics of creating and sending a simple SOAP message. Then you will learn
more details about adding content to messages, including how to create SOAP
faults and attributes. Finally, you will learn how to send a message and retrieve



362 SOAP WITH ATTACHMENTS API FOR JAVA
the content of the response. After going through this tutorial, you will know how
to perform the following tasks:

• Creating and Sending a Simple Message

• Adding Content to the Header

• Adding Content to the SOAP Body

• Adding Content to the SOAPPart Object

• Adding a Document to the SOAP Body

• Manipulating Message Content Using SAAJ or DOM APIs

• Adding Attachments

• Adding Attributes

• Using SOAP Faults

In the section Code Examples (page 388), you will see the code fragments from
earlier parts of the tutorial in runnable applications, which you can test yourself.
To see how the SAAJ API can be used in server code, see the SAAJ part of the
case study (SAAJ Distributor Service, page 1095), which shows an example of
both the client and server code for a Web service application.

A SAAJ client can send request-response messages to Web services that are
implemented to do request-response messaging. This section demonstrates how
you can do this.

Creating and Sending a Simple
Message
This section covers the basics of creating and sending a simple message and
retrieving the content of the response. It includes the following topics:

• Creating a Message

• Parts of a Message

• Accessing Elements of a Message

• Adding Content to the Body

• Getting a SOAPConnection Object

• Sending a Message

• Getting the Content of a Message
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Creating a Message
The first step is to create a message, which you do using a MessageFactory

object. The SAAJ API provides a default implementation of the MessageFac-

tory class, thus making it easy to get an instance. The following code fragment
illustrates getting an instance of the default message factory and then using it to
create a message.

MessageFactory factory = MessageFactory.newInstance();
SOAPMessage message = factory.createMessage();

As is true of the newInstance method for SOAPConnectionFactory, the
newInstance method for MessageFactory is static, so you invoke it by calling
MessageFactory.newInstance.

Parts of a Message
A SOAPMessage object is required to have certain elements, and, as stated previ-
ously, the SAAJ API simplifies things for you by returning a new SOAPMessage

object that already contains these elements. So message, which was created in
the preceding line of code, automatically has the following:

I. A SOAPPart object that contains

A. A SOAPEnvelope object that contains

 1. An empty SOAPHeader object

 2. An empty SOAPBody object

The SOAPHeader object is optional and may be deleted if it is not needed. How-
ever, if there is one, it must precede the SOAPBody object. The SOAPBody object
can hold the content of the message and can also contain fault messages that
contain status information or details about a problem with the message. The sec-
tion Using SOAP Faults (page 383) walks you through how to use SOAPFault

objects.

Accessing Elements of a Message
The next step in creating a message is to access its parts so that content can be
added. There are two ways to do this. The SOAPMessage object message, created
in the previous code fragment, is the place to start.
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The first way to access the parts of the message is to work your way through the
structure of the message. The message contains a SOAPPart object, so you use
the getSOAPPart method of message to retrieve it:

SOAPPart soapPart = message.getSOAPPart();

Next you can use the getEnvelope method of soapPart to retrieve the SOAPEn-

velope object that it contains.

SOAPEnvelope envelope = soapPart.getEnvelope();

You can now use the getHeader and getBody methods of envelope to retrieve
its empty SOAPHeader and SOAPBody objects.

SOAPHeader header = envelope.getHeader();
SOAPBody body = envelope.getBody();

The second way to access the parts of the message is to retrieve the message
header and body directly, without retrieving the SOAPPart or SOAPEnvelope. To
do so, use the getSOAPHeader and getSOAPBody methods of SOAPMessage:

SOAPHeader header = message.getSOAPHeader();
SOAPBody body = message.getSOAPBody();

This example of a SAAJ client does not use a SOAP header, so you can delete it.
(You will see more about headers later.) Because all SOAPElement objects,
including SOAPHeader objects, are derived from the Node interface, you use the
method Node.detachNode to delete header.

header.detachNode();

Adding Content to the Body
To add content to the body, you need to create a SOAPBodyElement object to hold
the content. When you create any new element, you also need to create an asso-
ciated Name object so that it is uniquely identified.

One way to create Name objects is by using SOAPEnvelope methods, so you can
use the variable envelope from the previous code fragment to create the Name

object for your new element. Another way to create Name objects is to use SOAP-

Factory methods, which are useful if you do not have access to the SOAPEnve-

lope.



CREATING AND SENDING A SIMPLE MESSAGE 365
Note: The SOAPFactory class also lets you create XML elements when you are not
creating an entire message or do not have access to a complete SOAPMessage object.
For example, JAX-RPC implementations often work with XML fragments rather
than complete SOAPMessage objects. Consequently, they do not have access to a
SOAPEnvelope object, which makes using a SOAPFactory object to create Name

objects very useful. In addition to a method for creating Name objects, the SOAPFac-

tory class provides methods for creating Detail objects and SOAP fragments. You
will find an explanation of Detail objects in the SOAP Fault sections Overview of
SOAP Faults (page 383) and Creating and Populating a SOAPFault
Object (page 385).

Name objects associated with SOAPBodyElement or SOAPHeaderElement objects
must be fully qualified; that is, they must be created with a local name, a prefix
for the namespace being used, and a URI for the namespace. Specifying a name-
space for an element makes clear which one is meant if there is more than one
element with the same local name.

The code fragment that follows retrieves the SOAPBody object body from
message, uses a SOAPFactory to create a Name object for the element to be
added, and adds a new SOAPBodyElement object to body.

SOAPBody body = message.getSOAPBody();
SOAPFactory soapFactory = SOAPFactory.newInstance();
Name bodyName = soapFactory.createName("GetLastTradePrice",

"m", "http://wombat.ztrade.com");
SOAPBodyElement bodyElement = body.addBodyElement(bodyName);

At this point, body contains a SOAPBodyElement object identified by the Name

object bodyName, but there is still no content in bodyElement. Assuming that
you want to get a quote for the stock of Sun Microsystems, Inc., you need to cre-
ate a child element for the symbol using the method addChildElement. Then
you need to give it the stock symbol using the method addTextNode. The Name

object for the new SOAPElement object symbol is initialized with only a local
name because child elements inherit the prefix and URI from the parent element.

Name name = soapFactory.createName("symbol");
SOAPElement symbol = bodyElement.addChildElement(name);
symbol.addTextNode("SUNW");

You might recall that the headers and content in a SOAPPart object must be in
XML format. The SAAJ API takes care of this for you, building the appropriate
XML constructs automatically when you call methods such as addBodyElement,
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addChildElement, and addTextNode. Note that you can call the method
addTextNode only on an element such as bodyElement or any child elements
that are added to it. You cannot call addTextNode on a SOAPHeader or SOAPBody
object because they contain elements, not text.

The content that you have just added to your SOAPBody object will look like the
following when it is sent over the wire:

<SOAP-ENV:Envelope
 xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Body>
    <m:GetLastTradePrice xmlns:m="http://wombat.ztrade.com">
      <symbol>SUNW</symbol>
    </m:GetLastTradePrice>
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

Let’s examine this XML excerpt line by line to see how it relates to your SAAJ
code. Note that an XML parser does not care about indentations, but they are
generally used to indicate element levels and thereby make it easier for a human
reader to understand.

SAAJ code:

SOAPMessage message = messageFactory.createMessage();
SOAPHeader header = message.getSOAPHeader();
SOAPBody body = message.getSOAPBody();

XML it produces:

<SOAP-ENV:Envelope
 xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Header/>
  <SOAP-ENV:Body>
    . . .
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

The outermost element in this XML example is the SOAP envelope element,
indicated by SOAP-ENV:Envelope. Envelope is the name of the element, and
SOAP-ENV is the namespace prefix. The interface SOAPEnvelope represents a
SOAP envelope.

The first line signals the beginning of the SOAP envelope element, and the last
line signals the end of it; everything in between is part of the SOAP envelope.
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The second line is an example of an attribute for the SOAP envelope element.
Because a SOAP Envelope element always contains this attribute with this value,
a SOAPMessage object comes with it automatically included. xmlns stands for
“XML namespace,” and its value is the URI of the namespace associated with
Envelope.

The next line is an empty SOAP header. We could remove it by calling
header.detachNode after the getSOAPHeader call.

The next two lines mark the beginning and end of the SOAP body, represented in
SAAJ by a SOAPBody object. The next step is to add content to the body.

SAAJ code:

Name bodyName = soapFactory.createName("GetLastTradePrice",
"m", "http://wombat.ztrade.com");

SOAPBodyElement bodyElement = body.addBodyElement(bodyName);

XML it produces:

<m:GetLastTradePrice
 xmlns:m="http://wombat.ztrade.com">
 . . . .
</m:GetLastTradePrice>

These lines are what the SOAPBodyElement bodyElement in your code repre-
sents. GetLastTradePrice"is its local name, m is its namespace prefix, and
http://wombat.ztrade.com is its namespace URI.

SAAJ code:

Name name = soapFactory.createName("symbol");
SOAPElement symbol = bodyElement.addChildElement(name);
symbol.addTextNode("SUNW");

XML it produces:

<symbol>SUNW</symbol>

The String “SUNW” is the text node for the element <symbol>. This String

object is the message content that your recipient, the stock quote service,
receives.
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Getting a SOAPConnection Object
The SAAJ API is focused primarily on creating messages. Once you have a mes-
sage, you can send it using various mechanisms (JMS or JAXM, for example).
The SAAJ API does, however, provide a simple mechanism for request-response
messaging.

To send a message, a SAAJ client may use a SOAPConnection object. A SOAP-

Connection object is a point-to-point connection, meaning that it goes directly
from the sender to the destination (usually a URL) that the sender specifies.

The first step is to obtain a SOAPConnectionFactory object that you can use to
create your connection. The SAAJ API makes this easy by providing the SOAP-

ConnectionFactory class with a default implementation. You can get an
instance of this implementation with the following line of code.

SOAPConnectionFactory soapConnectionFactory =
SOAPConnectionFactory.newInstance();

Now you can use soapConnectionFactory to create a SOAPConnection object.

SOAPConnection connection =
soapConnectionFactory.createConnection();

You will use connection to send the message that you created.

Sending a Message
A SAAJ client calls the SOAPConnection method call on a SOAPConnection

object to send a message. The call method takes two arguments, the message
being sent and the destination to which the message should go. This message is
going to the stock quote service indicated by the URL object endpoint.

java.net.URL endpoint = new URL(
"http://wombat.ztrade.com/quotes”);

SOAPMessage response = connection.call(message, endpoint);

The content of the message you sent is the stock symbol SUNW; the SOAPMes-

sage object response should contain the last stock price for Sun Microsystems,
which you will retrieve in the next section.
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A connection uses a fair amount of resources, so it is a good idea to close a con-
nection as soon as you are through using it.

connection.close();

Getting the Content of a Message
The initial steps for retrieving a message’s content are the same as those for giv-
ing content to a message: Either you use the Message object to get the SOAPBody

object, or you access the SOAPBody object through the SOAPPart and SOAPEnve-

lope objects.

Then you access the SOAPBody object’s SOAPBodyElement object, because that is
the element to which content was added in the example. (In a later section you
will see how to add content directly to the SOAPPart object, in which case you
would not need to access the SOAPBodyElement object for adding content or for
retrieving it.)

To get the content, which was added with the method SOAPElement.addText-

Node, you call the method Node.getValue. Note that getValue returns the value
of the immediate child of the element that calls the method. Therefore, in the fol-
lowing code fragment, the method getValue is called on bodyElement, the ele-
ment on which the method addTextNode was called.

In order to access bodyElement, you need to call the method getChildElements

on soapBody. Passing bodyName to getChildElements returns a
java.util.Iterator object that contains all of the child elements identified by
the Name object bodyName. You already know that there is only one, so just call-
ing the method next on it will return the SOAPBodyElement you want. Note that
the method Iterator.next returns a Java Object, so it is necessary to cast the
Object it returns to a SOAPBodyElement object before assigning it to the variable
bodyElement.

SOAPBody soapBody = response.getSOAPBody();
java.util.Iterator iterator =

soapBody.getChildElements(bodyName);
SOAPBodyElement bodyElement =

(SOAPBodyElement)iterator.next();
String lastPrice = bodyElement.getValue();
System.out.print("The last price for SUNW is ");
System.out.println(lastPrice);
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If there were more than one element with the name bodyName, you would have
had to use a while loop using the method Iterator.hasNext to make sure that
you got all of them.

while (iterator.hasNext()) {
SOAPBodyElement bodyElement =

(SOAPBodyElement)iterator.next();
String lastPrice = bodyElement.getValue();
System.out.print("The last price for SUNW is ");
System.out.println(lastPrice);

}

At this point, you have seen how to send a very basic request-response message
and get the content from the response. The next sections provide more detail on
adding content to messages.

Adding Content to the Header
To add content to the header, you need to create a SOAPHeaderElement object.
As with all new elements, it must have an associated Name object, which you can
create using the message’s SOAPEnvelope object or a SOAPFactory object.

For example, suppose you want to add a conformance claim header to the mes-
sage to state that your message conforms to the WS-I Basic Profile.

The following code fragment retrieves the SOAPHeader object from message and
adds a new SOAPHeaderElement object to it. This SOAPHeaderElement object
contains the correct qualified name and attribute for a WS-I conformance claim
header.

SOAPHeader header = message.getSOAPHeader();
Name headerName = soapFactory.createName("Claim",

"wsi", "http://ws-i.org/schemas/conformanceClaim/");
SOAPHeaderElement headerElement =

header.addHeaderElement(headerName);
headerElement.addAttribute(soapFactory.createName(

"conformsTo"), "http://ws-i.org/profiles/basic1.0/");

At this point, header contains the SOAPHeaderElement object headerElement
identified by the Name object headerName. Note that the addHeaderElement

method both creates headerElement and adds it to header.
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A conformance claim header has no content. This code produces the following
XML header:

<SOAP-ENV:Header>
  <wsi:Claim conformsTo="http://ws-i.org/profiles/basic1.0/"
   xmlns:wsi="http://ws-i.org/schemas/conformanceClaim/"/>
</SOAP-ENV:Header>

For more information about creating SOAP messages that conform to WS-I, see
the Messaging section of the WS-I Basic Profile.

For a different kind of header, you might want to add content to headerElement.
The following line of code uses the method addTextNode to do this.

headerElement.addTextNode("order");

Now you have the SOAPHeader object header that contains a SOAPHeaderEle-

ment object whose content is "order".

Adding Content to the SOAP Body
The process for adding content to the SOAPBody object is the same as the process
for adding content to the SOAPHeader object. You access the SOAPBody object,
add a SOAPBodyElement object to it, and add text to the SOAPBodyElement

object. It is possible to add additional SOAPBodyElement objects, and it is possi-
ble to add subelements to the SOAPBodyElement objects with the method
addChildElement. For each element or child element, you add content with the
method addTextNode.

The following example shows adding multiple SOAPElement objects and adding
text to each of them. The code first creates the SOAPBodyElement object
purchaseLineItems, which has a fully qualified name associated with it. That
is, the Name object for it has a local name, a namespace prefix, and a namespace
URI. As you saw earlier, a SOAPBodyElement object is required to have a fully
qualified name, but child elements added to it, such as SOAPElement objects,
may have Name objects with only the local name.

SOAPBody body = soapFactory.getSOAPBody();
Name bodyName = soapFactory.createName("PurchaseLineItems",

"PO", "http://sonata.fruitsgalore.com");
SOAPBodyElement purchaseLineItems =

body.addBodyElement(bodyName);

http://www.ws-i.org/Profiles/Basic/2003-01/BasicProfile-1.0-WGAD.html#messaging
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Name childName = soapFactory.createName("Order");
SOAPElement order =

purchaseLineItems.addChildElement(childName);

childName = soapFactory.createName("Product");
SOAPElement product = order.addChildElement(childName);
product.addTextNode("Apple");

childName = soapFactory.createName("Price");
SOAPElement price = order.addChildElement(childName);
price.addTextNode("1.56");

childName = soapFactory.createName("Order");
SOAPElement order2 =

purchaseLineItems.addChildElement(childName);

childName = soapFactory.createName("Product");
SOAPElement product2 = order2.addChildElement(childName);
product2.addTextNode("Peach");

childName = soapFactory.createName("Price");
SOAPElement price2 = order2.addChildElement(childName);
price2.addTextNode("1.48");

The SAAJ code in the preceding example produces the following XML in the
SOAP body:

<PO:PurchaseLineItems
 xmlns:PO="http://www.sonata.fruitsgalore/order">
  <Order>
    <Product>Apple</Product>
    <Price>1.56</Price>
  </Order>

  <Order>
    <Product>Peach</Product>
    <Price>1.48</Price>
  </Order>
</PO:PurchaseLineItems>

Adding Content to the SOAPPart Object
If the content you want to send is in a file, SAAJ provides an easy way to add it
directly to the SOAPPart object. This means that you do not access the SOAPBody

object and build the XML content yourself, as you did in the previous section.
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To add a file directly to the SOAPPart object, you use a javax.xml.trans-

form.Source object from JAXP (the Java API for XML Processing). There are
three types of Source objects: SAXSource, DOMSource, and StreamSource. A
StreamSource object holds content as an XML document. SAXSource and DOM-

Source objects hold content along with the instructions for transforming the
content into an XML document.

The following code fragment uses the JAXP API to build a DOMSource object
that is passed to the SOAPPart.setContent method. The first three lines of code
get a DocumentBuilderFactory object and use it to create the Document-

Builder object builder. Because SOAP messages use namespaces, you should
set the NamespaceAware property for the factory to true. Then builder parses
the content file to produce a Document object.

DocumentBuilderFactory dbFactory =
DocumentBuilderFactory.newInstance();

dbFactory.setNamespaceAware(true);
DocumentBuilder builder = dbFactory.newDocumentBuilder();
Document document =

builder.parse("file:///music/order/soap.xml");
DOMSource domSource = new DOMSource(document);

The following two lines of code access the SOAPPart object (using the SOAPMes-

sage object message) and set the new Document object as its content. The
method SOAPPart.setContent not only sets content for the SOAPBody object but
also sets the appropriate header for the SOAPHeader object.

SOAPPart soapPart = message.getSOAPPart();
soapPart.setContent(domSource);

The XML file you use to set the content of the SOAPPart object must include
Envelope and Body elements, like this:

<SOAP-ENV:Envelope
xmlns="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Body>
  ...
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

You will see other ways to add content to a message in the sections Adding a
Document to the SOAP Body (page 374) and Adding Attachments (page 375).
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Adding a Document to the SOAP Body
In addition to setting the content of the entire SOAP message to that of a DOM-

Source object, you can add a DOM document directly to the body of the mes-
sage. This capability means that you do not have to create a
javax.xml.transform.Source object. After you parse the document, you can
add it directly to the message body:

SOAPBody body = message.getSOAPBody();
SOAPBodyElement docElement = body.addDocument(document);

Manipulating Message Content Using
SAAJ or DOM APIs
Because SAAJ nodes and elements implement the DOM Node and Element

interfaces, you have many options for adding or changing message content:

• Use only DOM APIs

• Use only SAAJ APIs

• Use SAAJ APIs and then switch to using DOM APIs

• Use DOM APIs and then switch to using SAAJ APIs

The first three of these cause no problems. Once you have created a message,
whether or not you have imported its content from another document, you can
start adding or changing nodes using either SAAJ or DOM APIs.

But if you use DOM APIs and then switch to using SAAJ APIs to manipulate the
document, any references to objects within the tree that were obtained using
DOM APIs are no longer valid. If you must use SAAJ APIs after using DOM
APIs, you should set all of your DOM typed references to null, because they can
become invalid. For more information about the exact cases in which references
become invalid, see the SAAJ API documentation.

The basic rule is that you can continue manipulating the message content using
SAAJ APIs as long as you want to, but once you start manipulating it using
DOM, you should not use SAAJ APIs after that.
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Adding Attachments
An AttachmentPart object can contain any type of content, including XML.
And because the SOAP part can contain only XML content, you must use an
AttachmentPart object for any content that is not in XML format.

Creating an AttachmentPart Object and
Adding Content
The SOAPMessage object creates an AttachmentPart object, and the message
also has to add the attachment to itself after content has been added. The SOAP-

Message class has three methods for creating an AttachmentPart object.

The first method creates an attachment with no content. In this case, an Attach-

mentPart method is used later to add content to the attachment.

AttachmentPart attachment = message.createAttachmentPart();

You add content to attachment with the AttachmentPart method setContent.
This method takes two parameters, a Java Object for the content, and a String

object that gives the content type. Content in the SOAPBody part of a message
automatically has a Content-Type header with the value "text/xml" because the
content has to be in XML. In contrast, the type of content in an AttachmentPart

object has to be specified because it can be any type.

Each AttachmentPart object has one or more headers associated with it. When
you specify a type to the method setContent, that type is used for the header
Content-Type. Content-Type is the only header that is required. You may set
other optional headers, such as Content-Id and Content-Location. For conve-
nience, SAAJ provides get and set methods for the headers Content-Type,
Content-Id, and Content-Location. These headers can be helpful in accessing
a particular attachment when a message has multiple attachments. For example,
to access the attachments that have particular headers, you call the SOAPMessage

method getAttachments and pass it the header or headers you are interested in.

The following code fragment shows one of the ways to use the method setCon-

tent. This method takes two parameters, the first being a Java Object contain-
ing the content and the second being a String giving the content type. The Java
Object may be a String, a stream, a javax.xml.transform.Source object, or a
javax.activation.DataHandler object. The Java Object being added in the
following code fragment is a String, which is plain text, so the second argument
must be "text/plain". The code also sets a content identifier, which can be
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used to identify this AttachmentPart object. After you have added content to
attachment, you need to add it to the SOAPMessage object, which is done in the
last line.

String stringContent = "Update address for Sunny Skies " +
"Inc., to 10 Upbeat Street, Pleasant Grove, CA 95439";

attachment.setContent(stringContent, "text/plain");
attachment.setContentId("update_address");

message.addAttachmentPart(attachment);

The variable attachment now represents an AttachmentPart object that con-
tains the string stringContent and has a header that contains the string
"text/plain". It also has a Content-Id header with "update_address" as its
value. And attachment is now part of message.

The other two SOAPMessage.createAttachment methods create an Attach-

mentPart object complete with content. One is very similar to the Attachment-

Part.setContent method in that it takes the same parameters and does
essentially the same thing. It takes a Java Object containing the content and a
String giving the content type. As with AttachmentPart.setContent, the
Object may be a String, a stream, a javax.xml.transform.Source object, or
a javax.activation.DataHandler object.

The other method for creating an AttachmentPart object with content takes a
DataHandler object, which is part of the JavaBeans Activation Framework
(JAF). Using a DataHandler object is fairly straightforward. First you create a
java.net.URL object for the file you want to add as content. Then you create a
DataHandler object initialized with the URL object:

URL url = new URL("http://greatproducts.com/gizmos/img.jpg");
DataHandler dataHandler = new DataHandler(url);
AttachmentPart attachment =

message.createAttachmentPart(dataHandler);
attachment.setContentId("attached_image");

message.addAttachmentPart(attachment);

You might note two things about the previous code fragment. First, it sets a
header for Content-ID with the method setContentId. This method takes a
String that can be whatever you like to identify the attachment. Second, unlike
the other methods for setting content, this one does not take a String for Con-
tent-Type. This method takes care of setting the Content-Type header for you,
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which is possible because one of the things a DataHandler object does is deter-
mine the data type of the file it contains.

Accessing an AttachmentPart Object
If you receive a message with attachments or want to change an attachment to a
message you are building, you will need to access the attachment. The SOAPMes-

sage class provides two versions of the method getAttachments for retrieving
its AttachmentPart objects. When it is given no argument, the method SOAP-

Message.getAttachments returns a java.util.Iterator object over all the
AttachmentPart objects in a message. When getAttachments is given a Mime-

Headers object, which is a list of MIME headers, it returns an iterator over the
AttachmentPart objects that have a header that matches one of the headers in
the list. The following code uses the getAttachments method that takes no argu-
ments and thus retrieves all of the AttachmentPart objects in the SOAPMessage

object message. Then it prints out the content ID, content type, and content of
each AttachmentPart object.

java.util.Iterator iterator = message.getAttachments();
while (iterator.hasNext()) {

AttachmentPart attachment =
(AttachmentPart)iterator.next();

String id = attachment.getContentId();
String type = attachment.getContentType();
System.out.print("Attachment " + id +

" has content type " + type);
if (type == "text/plain") {

Object content = attachment.getContent();
System.out.println("Attachment " +

"contains:\n" + content);
}

}

Adding Attributes
An XML element may have one or more attributes that give information about
that element. An attribute consists of a name for the attribute followed immedi-
ately by an equals sign (=) and its value.

The SOAPElement interface provides methods for adding an attribute, for getting
the value of an attribute, and for removing an attribute. For example, in the fol-
lowing code fragment, the attribute named id is added to the SOAPElement
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object person. Because person is a SOAPElement object rather than a SOAP-

BodyElement object or SOAPHeaderElement object, it is legal for its Name object
to contain only a local name.

Name attributeName = envelope.createName("id");
person.addAttribute(attributeName, "Person7");

These lines of code will generate the first line in the following XML fragment.

<person id="Person7">
  ...
</person>

The following line of code retrieves the value of the attribute whose name is id.

String attributeValue =
person.getAttributeValue(attributeName);

If you had added two or more attributes to person, the previous line of code
would have returned only the value for the attribute named id. If you wanted to
retrieve the values for all of the attributes for person, you would use the method
getAllAttributes, which returns an iterator over all of the values. The follow-
ing lines of code retrieve and print out each value on a separate line until there
are no more attribute values. Note that the method Iterator.next returns a Java
Object, which is cast to a Name object so that it can be assigned to the Name

object attributeName. (The examples in DOMExample.java and
DomSrcExample.java (page 398) use code similar to this.)

Iterator iterator = person.getAllAttributes();
while (iterator.hasNext()){

Name attributeName = (Name) iterator.next();
System.out.println("Attribute name is " +

attributeName.getQualifiedName());
System.out.println("Attribute value is " +

element.getAttributeValue(attributeName));
}

The following line of code removes the attribute named id from person. The
variable successful will be true if the attribute was removed successfully.

boolean successful = person.removeAttribute(attributeName);
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In this section you saw how to add, retrieve, and remove attributes. This informa-
tion is general in that it applies to any element. The next section discusses
attributes that may be added only to header elements.

Header Attributes
Attributes that appear in a SOAPHeaderElement object determine how a recipient
processes a message. You can think of header attributes as offering a way to
extend a message, giving information about such things as authentication, trans-
action management, payment, and so on. A header attribute refines the meaning
of the header, while the header refines the meaning of the message contained in
the SOAP Body.

The SOAP 1.1 specification defines two attributes that can appear only in SOAP-

HeaderElement objects: actor and mustUnderstand. The next two sections dis-
cuss these attributes.

See HeaderExample.java (page 397) for an example that uses the code shown in
this section.

The Actor Attribute
The attribute actor is optional, but if it is used, it must appear in a SOAPHeader-

Element object. Its purpose is to indicate the recipient of a header element. The
default actor is the message’s ultimate recipient; that is, if no actor attribute is
supplied, the message goes directly to the ultimate recipient.

An actor is an application that can both receive SOAP messages and forward
them to the next actor. The ability to specify one or more actors as intermediate
recipients makes it possible to route a message to multiple recipients and to sup-
ply header information that applies specifically to each of the recipients.

For example, suppose that a message is an incoming purchase order. Its SOAP-

Header object might have SOAPHeaderElement objects with actor attributes that
route the message to applications that function as the order desk, the shipping
desk, the confirmation desk, and the billing department. Each of these applica-
tions will take the appropriate action, remove the SOAPHeaderElement objects
relevant to it, and send the message on to the next actor.

Note: Although the SAAJ API provides the API for adding these attributes, it does
not supply the API for processing them. For example, the actor attribute requires



380 SOAP WITH ATTACHMENTS API FOR JAVA
that there be an implementation such as a messaging provider service to route the
message from one actor to the next.

An actor is identified by its URI. For example, the following line of code, in
which orderHeader is a SOAPHeaderElement object, sets the actor to the given
URI.

orderHeader.setActor("http://gizmos.com/orders");

Additional actors may be set in their own SOAPHeaderElement objects. The fol-
lowing code fragment first uses the SOAPMessage object message to get its SOAP-
Header object header. Then header creates four SOAPHeaderElement objects,
each of which sets its actor attribute.

SOAPHeader header = message.getSOAPHeader();
SOAPFactory soapFactory = SOAPFactory.newInstance();

String nameSpace = "ns";
String nameSpaceURI = "http://gizmos.com/NSURI";

Name order = soapFactory.createName("orderDesk",
nameSpace, nameSpaceURI);

SOAPHeaderElement orderHeader =
header.addHeaderElement(order);

orderHeader.setActor("http://gizmos.com/orders");

Name shipping =
soapFactory.createName("shippingDesk",

nameSpace, nameSpaceURI);
SOAPHeaderElement shippingHeader =

header.addHeaderElement(shipping);
shippingHeader.setActor("http://gizmos.com/shipping");

Name confirmation =
soapFactory.createName("confirmationDesk",

nameSpace, nameSpaceURI);
SOAPHeaderElement confirmationHeader =

header.addHeaderElement(confirmation);
confirmationHeader.setActor(

"http://gizmos.com/confirmations");

Name billing = soapFactory.createName("billingDesk",
nameSpace, nameSpaceURI);

SOAPHeaderElement billingHeader =
header.addHeaderElement(billing);

billingHeader.setActor("http://gizmos.com/billing");
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The SOAPHeader interface provides two methods that return a java.util.Iter-

ator object over all of the SOAPHeaderElement objects with an actor that
matches the specified actor. The first method, examineHeaderElements, returns
an iterator over all of the elements with the specified actor.

java.util.Iterator headerElements =
header.examineHeaderElements("http://gizmos.com/orders");

The second method, extractHeaderElements, not only returns an iterator over
all of the SOAPHeaderElement objects with the specified actor attribute but also
detaches them from the SOAPHeader object. So, for example, after the order desk
application has done its work, it would call extractHeaderElements to remove
all of the SOAPHeaderElement objects that applied to it.

java.util.Iterator headerElements =
header.extractHeaderElements("http://gizmos.com/orders");

Each SOAPHeaderElement object may have only one actor attribute, but the
same actor may be an attribute for multiple SOAPHeaderElement objects.

Two additional SOAPHeader methods, examineAllHeaderElements and
extractAllHeaderElements, allow you to examine or extract all the header ele-
ments, whether or not they have an actor attribute. For example, you could use
the following code to display the values of all the header elements:

Iterator allHeaders =
header.examineAllHeaderElements();

while (allHeaders.hasNext()) {
SOAPHeaderElement headerElement =

(SOAPHeaderElement)allHeaders.next();
Name headerName =

headerElement.getElementName();
System.out.println("\nHeader name is " +

headerName.getQualifiedName());
System.out.println("Actor is " +

headerElement.getActor());
}

The mustUnderstand Attribute
The other attribute that must be added only to a SOAPHeaderElement object is
mustUnderstand. This attribute says whether or not the recipient (indicated by
the actor attribute) is required to process a header entry. When the value of the
mustUnderstand attribute is true, the actor must understand the semantics of
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the header entry and must process it correctly to those semantics. If the value is
false, processing the header entry is optional. A SOAPHeaderElement object
with no mustUnderstand attribute is equivalent to one with a mustUnderstand

attribute whose value is false.

The mustUnderstand attribute is used to call attention to the fact that the seman-
tics in an element are different from the semantics in its parent or peer elements.
This allows for robust evolution, ensuring that the change in semantics will not
be silently ignored by those who may not fully understand it.

If the actor for a header that has a mustUnderstand attribute set to true cannot
process the header, it must send a SOAP fault back to the sender. (See the section
Using SOAP Faults, page 383 for information.) The actor must not change state
or cause any side-effects, so that to an outside observer, it appears that the fault
was sent before any header processing was done.

The following code fragment creates a SOAPHeader object with a SOAPHeader-

Element object that has a mustUnderstand attribute.

SOAPHeader header = message.getSOAPHeader();

Name name = soapFactory.createName("Transaction", "t",
"http://gizmos.com/orders");

SOAPHeaderElement transaction = header.addHeaderElement(name);
transaction.setMustUnderstand(true);
transaction.addTextNode("5");

This code produces the following XML:

<SOAP-ENV:Header>
  <t:Transaction
     xmlns:t="http://gizmos.com/orders"
     SOAP-ENV:mustUnderstand="1">
    5
  </t:Transaction>
</SOAP-ENV:Header>

You can use the getMustUnderstand method to retrieve the value of the Must-

Understand attribute. For example, you could add the following to the code
fragment at the end of the previous section:

System.out.println("MustUnderstand is " +
headerElement.getMustUnderstand());
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Using SOAP Faults
In this section, you will see how to use the API for creating and accessing a
SOAP Fault element in an XML message.

Overview of SOAP Faults
If you send a message that was not successful for some reason, you may get back
a response containing a SOAP Fault element that gives you status information,
error information, or both. There can be only one SOAP Fault element in a mes-
sage, and it must be an entry in the SOAP Body. Further, if there is a SOAP Fault
element in the SOAP Body, there can be no other elements in the SOAP Body.
This means that when you add a SOAP Fault element, you have effectively com-
pleted the construction of the SOAP Body. The SOAP 1.1 specification defines
only one Body entry, which is the SOAP Fault element. Of course, the SOAP
Body may contain other kinds of Body entries, but the SOAP Fault element is
the only one that has been defined.

A SOAPFault object, the representation of a SOAP Fault element in the SAAJ
API, is similar to an Exception object in that it conveys information about a
problem. However, a SOAPFault object is quite different in that it is an element
in a message’s SOAPBody object rather than part of the try/catch mechanism
used for Exception objects. Also, as part of the SOAPBody object, which pro-
vides a simple means for sending mandatory information intended for the ulti-
mate recipient, a SOAPFault object only reports status or error information. It
does not halt the execution of an application the way an Exception object can.

If you are a client using the SAAJ API and are sending point-to-point messages,
the recipient of your message may add a SOAPFault object to the response to
alert you to a problem. For example, if you sent an order with an incomplete
address for where to send the order, the service receiving the order might put a
SOAPFault object in the return message telling you that part of the address was
missing.

Another example of who might send a SOAP fault is an intermediate recipient,
or actor. As stated in the section Adding Attributes, page 377, an actor that can-
not process a header that has a mustUnderstand attribute with a value of true
must return a SOAP fault to the sender.
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A SOAPFault object contains the following elements:

• A fault code — always required

The fault code must be a fully qualified name, which means that it must
contain a prefix followed by a local name. The SOAP 1.1 specification
defines a set of fault code local name values in section 4.4.1, which a
developer may extend to cover other problems. The default fault code
local names defined in the specification relate to the SAAJ API as fol-
lows:

• VersionMismatch — the namespace for a SOAPEnvelope object was
invalid

• MustUnderstand — an immediate child element of a SOAPHeader

object had its mustUnderstand attribute set to true, and the processing
party did not understand the element or did not obey it

• Client — the SOAPMessage object was not formed correctly or did not
contain the information needed to succeed

• Server — the SOAPMessage object could not be processed because of a
processing error, not because of a problem with the message itself

• A fault string — always required

A human-readable explanation of the fault

• A fault actor — required if the SOAPHeader object contains one or more
actor attributes; optional if no actors are specified, meaning that the only
actor is the ultimate destination

The fault actor, which is specified as a URI, identifies who caused the
fault. For an explanation of what an actor is, see the section The Actor
Attribute, page 379.

• A Detail object — required if the fault is an error related to the SOAPBody
object

If, for example, the fault code is Client, indicating that the message
could not be processed because of a problem in the SOAPBody object, the
SOAPFault object must contain a Detail object that gives details about
the problem. If a SOAPFault object does not contain a Detail object, it
can be assumed that the SOAPBody object was processed successfully.
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Creating and Populating a SOAPFault Object
You have already seen how to add content to a SOAPBody object; this section will
walk you through adding a SOAPFault object to a SOAPBody object and then add-
ing its constituent parts.

As with adding content, the first step is to access the SOAPBody object.

SOAPBody body = message.getSOAPBody();

With the SOAPBody object body in hand, you can use it to create a SOAPFault

object. The following line of code both creates a SOAPFault object and adds it to
body.

SOAPFault fault = body.addFault();

The SOAPFault interface provides convenience methods that create an element,
add the new element to the SOAPFault object, and add a text node all in one
operation. For example, in the following lines of code, the method setFault-

Code creates a faultcode element, adds it to fault, and adds a Text node with
the value "SOAP-ENV:Server" by specifying a default prefix and the namespace
URI for a SOAP envelope.

Name faultName =
soapFactory.createName("Server",

"", SOAPConstants.URI_NS_SOAP_ENVELOPE);
fault.setFaultCode(faultName);
fault.setFaultActor("http://gizmos.com/orders");
fault.setFaultString("Server not responding");

The SOAPFault object fault, created in the previous lines of code, indicates that
the cause of the problem is an unavailable server and that the actor at
http://gizmos.com/orders is having the problem. If the message were being
routed only to its ultimate destination, there would have been no need for setting
a fault actor. Also note that fault does not have a Detail object because it does
not relate to the SOAPBody object.

The following code fragment creates a SOAPFault object that includes a Detail

object. Note that a SOAPFault object may have only one Detail object, which is
simply a container for DetailEntry objects, but the Detail object may have
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multiple DetailEntry objects. The Detail object in the following lines of code
has two DetailEntry objects added to it.

SOAPFault fault = body.addFault();

Name faultName = soapFactory.createName("Client",
"", SOAPConstants.URI_NS_SOAP_ENVELOPE);

fault.setFaultCode(faultName);
fault.setFaultString("Message does not have necessary info");

Detail detail = fault.addDetail();

Name entryName = soapFactory.createName("order",
"PO", "http://gizmos.com/orders/");

DetailEntry entry = detail.addDetailEntry(entryName);
entry.addTextNode("Quantity element does not have a value");

Name entryName2 = soapFactory.createName("confirmation",
"PO", "http://gizmos.com/confirm");

DetailEntry entry2 = detail.addDetailEntry(entryName2);
entry2.addTextNode("Incomplete address: no zip code");

See SOAPFaultTest.java (page 404) for an example that uses code like that
shown in this section.

Retrieving Fault Information
Just as the SOAPFault interface provides convenience methods for adding infor-
mation, it also provides convenience methods for retrieving that information.
The following code fragment shows what you might write to retrieve fault infor-
mation from a message you received. In the code fragment, newMessage is the
SOAPMessage object that has been sent to you. Because a SOAPFault object must
be part of the SOAPBody object, the first step is to access the SOAPBody object.
Then the code tests to see if the SOAPBody object contains a SOAPFault object. If
so, the code retrieves the SOAPFault object and uses it to retrieve its contents.
The convenience methods getFaultCode, getFaultString, and getFaultAc-

tor make retrieving the values very easy.

SOAPBody body = newMessage.getSOAPBody();
if ( body.hasFault() ) {

SOAPFault newFault = body.getFault();
Name code = newFault.getFaultCodeAsName();
String string = newFault.getFaultString();
String actor = newFault.getFaultActor();
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Next the code prints out the values it just retrieved. Not all messages are required
to have a fault actor, so the code tests to see if there is one. Testing whether the
variable actor is null works because the method getFaultActor returns null

if a fault actor has not been set.

System.out.println("SOAP fault contains: ");
System.out.println("  Fault code = " +

code.getQualifiedName());
System.out.println("  Fault string = " + string);

if ( actor != null ) {
System.out.println("  Fault actor = " + actor);

}

The final task is to retrieve the Detail object and get its DetailEntry objects.
The code uses the SOAPFault object newFault to retrieve the Detail object
newDetail, and then it uses newDetail to call the method getDetailEntries.
This method returns the java.util.Iterator object entries, which contains
all of the DetailEntry objects in newDetail. Not all SOAPFault objects are
required to have a Detail object, so the code tests to see whether newDetail is
null. If it is not, the code prints out the values of the DetailEntry objects as
long as there are any.

    Detail newDetail = newFault.getDetail();
    if ( newDetail != null) {
        Iterator entries = newDetail.getDetailEntries();
        while ( entries.hasNext() ) {
            DetailEntry newEntry =
                (DetailEntry)entries.next();
            String value = newEntry.getValue();
            System.out.println("  Detail entry = " + value);
        }
    }

In summary, you have seen how to add a SOAPFault object and its contents to a
message as well as how to retrieve the contents. A SOAPFault object, which is
optional, is added to the SOAPBody object to convey status or error information. It
must always have a fault code and a String explanation of the fault. A SOAP-

Fault object must indicate the actor that is the source of the fault only when
there are multiple actors; otherwise, it is optional. Similarly, the SOAPFault

object must contain a Detail object with one or more DetailEntry objects only
when the contents of the SOAPBody object could not be processed successfully.



388 SOAP WITH ATTACHMENTS API FOR JAVA
See SOAPFaultTest.java (page 404) for an example that uses code like that
shown in this section.

Code Examples
The first part of this tutorial used code fragments to walk you through the funda-
mentals of using the SAAJ API. In this section, you will use some of those code
fragments to create applications. First, you will see the program Request.java.
Then you will see how to run the programs MyUddiPing.java, HeaderExam-
ple.java, DOMExample.java, Attachments.java, and SOAPFaultTest.java.

You do not have to start the J2EE Application Server in order to run these exam-
ples.

You do not have to start the J2EE Application Server in order to run these
examples.

Request.java
The class Request.java puts together the code fragments used in
Tutorial (page 361) and adds what is needed to make it a complete example of a
client sending a request-response message. In addition to putting all the code
together, it adds import statements, a main method, and a try/catch block with
exception handling.

import javax.xml.soap.*;
import java.util.*;
import java.net.URL;

public class Request {
public static void main(String[] args){

try {
SOAPConnectionFactory soapConnectionFactory =

SOAPConnectionFactory.newInstance();
SOAPConnection connection =

soapConnectionFactory.createConnection();
SOAPFactory soapFactory =

SOAPFactory.newInstance();

MessageFactory factory =
MessageFactory.newInstance();

SOAPMessage message = factory.createMessage();
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SOAPHeader header = message.getSOAPHeader();
SOAPBody body = message.getSOAPBody();
header.detachNode();

Name bodyName = soapFactory.createName(
"GetLastTradePrice", "m",
"http://wombats.ztrade.com");

SOAPBodyElement bodyElement =
body.addBodyElement(bodyName);

Name name = soapFactory.createName("symbol");
SOAPElement symbol =

bodyElement.addChildElement(name);
symbol.addTextNode("SUNW");

URL endpoint = new URL
("http://wombat.ztrade.com/quotes");

SOAPMessage response =
connection.call(message, endpoint);

connection.close();

SOAPBody soapBody = response.getSOAPBody();

Iterator iterator =
soapBody.getChildElements(bodyName);

SOAPBodyElement bodyElement =
(SOAPBodyElement)iterator.next();

String lastPrice = bodyElement.getValue();

System.out.print("The last price for SUNW is ");
System.out.println(lastPrice);

} catch (Exception ex) {
ex.printStackTrace();

}
}

}

In order for Request.java to be runnable, the second argument supplied to the
method call would have to be a valid existing URI, which is not true in this
case. However, the application in the next section is one that you can run.
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MyUddiPing.java
The program MyUddiPing.java is another example of a SAAJ client applica-
tion. It sends a request to a Universal Description, Discovery and Integration
(UDDI) service and gets back the response. A UDDI service is a business regis-
try and repository from which you can get information about businesses that
have registered themselves with the registry service. For this example, the MyUd-

diPing application is not actually accessing a UDDI service registry but rather a
test (demo) version. Because of this, the number of businesses you can get infor-
mation about is limited. Nevertheless, MyUddiPing demonstrates a request being
sent and a response being received.

Setting Up
The myuddiping example is in the following directory:

<INSTALL>/j2eetutorial14/examples/saaj/myuddiping/

Note: <INSTALL> is the directory where you installed the tutorial bundle.

In the myuddiping directory, you will find two files and the src directory. The
src directory contains one source file, MyUddiPing.java.

The file uddi.properties contains the URL of the destination (a UDDI test reg-
istry) and the proxy host and proxy port of the sender. Edit this file to supply the
correct proxy host and proxy port if you access the Internet from behind a fire-
wall. If you are not sure what the values for these are, consult your system
administrator or another person with that information. The typical value of the
proxy port is 8080.

The file build.xml is the asant build file for this example. It includes the file
<INSTALL>/j2eetutorial14/examples/saaj/common/targets.xml, which
contains a set of targets common to all the SAAJ examples.

The prepare target creates a directory named build. To invoke the prepare tar-
get, you type the following at the command line:

asant prepare
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The target named build compiles the source file MyUddiPing.java and puts the
resulting .class file in the build directory. So to do these tasks, you type the
following at the command line:

asant build

Examining MyUddiPing
We will go through the file MyUddiPing.java a few lines at a time, concentrat-
ing on the last section. This is the part of the application that accesses only the
content you want from the XML message returned by the UDDI registry.

The first few lines of code import the packages used in the application.

import javax.xml.soap.*;
import java.net.*;
import java.util.*;
import java.io.*;

The next few lines begin the definition of the class MyUddiPing, which starts
with the definition of its main method. The first thing it does is check to see if
two arguments were supplied. If not, it prints a usage message and exits. The
usage message mentions only one argument; the other is supplied by the
build.xml target.

public class MyUddiPing {
public static void main(String[] args) {

try {
if (args.length != 2) {

System.err.println("Argument required: " +
"-Dbusiness-name=<name>");

System.exit(1);
}

The following lines create a java.util.Properties object that contains the
system properties and the properties from the file uddi.properties that is in the
myuddiping directory.

Properties myprops = new Properties();
myprops.load(new FileInputStream(args[0]));

Properties props = System.getProperties();

Enumeration enum = myprops.propertyNames();
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while (enum.hasMoreElements()) {
String s = (String)enum.nextElement();
props.put(s, myprops.getProperty(s));

}

The next four lines create a SOAPMessage object. First, the code gets an instance
of SOAPConnectionFactory and uses it to create a connection. Then it gets an
instance of MessageFactory and uses it to create a message.

SOAPConnectionFactory soapConnectionFactory =
SOAPConnectionFactory.newInstance();

SOAPConnection connection =
soapConnectionFactory.createConnection();

MessageFactory messageFactory =
MessageFactory.newInstance();

SOAPMessage message =
messageFactory.createMessage();

The next lines of code retrieve the SOAPHeader and SOAPBody objects from the
message and remove the header.

SOAPHeader header = message.getSOAPHeader();
SOAPBody body = message.getSOAPBody();
header.detachNode();

The following lines of code create the UDDI find_business message. The first
line gets a SOAPFactory instance that we will use to create names. The next line
adds the SOAPBodyElement with a fully qualified name, including the required
namespace for a UDDI version 2 message. The next lines add two attributes to
the new element: the required attribute generic, with the UDDI version number
2.0, and the optional attribute maxRows, with the value 100. Then the code adds a
child element with the Name object name and adds text to the element with the
method addTextNode. The text added is the business name you will supply at the
command line when you run the application.

SOAPFactory soapFactory =
SOAPFactory.newInstance();

SOAPBodyElement findBusiness =
body.addBodyElement(soapFactory.createName(

"find_business", "",
"urn:uddi-org:api_v2"));

findBusiness.addAttribute(soapFactory.createName(
"generic"), "2.0");

findBusiness.addAttribute(soapFactory.createName(
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"maxRows"), "100");
SOAPElement businessName =

findBusiness.addChildElement(
soapFactory.createName("name"));

businessName.addTextNode(args[1]);

The next line of code saves the changes that have been made to the message.
This method will be called automatically when the message is sent, but it does
not hurt to call it explicitly.

message.saveChanges();

The following lines display the message that will be sent:

System.out.println("\n--- Request Message ---\n");
message.writeTo(System.out);

The next line of code creates the java.net.URL object that represents the desti-
nation for this message. It gets the value of the property named URL from the sys-
tem property file.

URL endpoint = new URL(
System.getProperties().getProperty("URL"));

Next the message message is sent to the destination that endpoint represents,
which is the UDDI test registry. The call method will block until it gets a SOAP-
Message object back, at which point it returns the reply.

SOAPMessage reply =
connection.call(message, endpoint);

In the next lines of code, the first line prints out a line giving the URL of the
sender (the test registry), and the others display the returned message.

System.out.println("\n\nReceived reply from: " +
endpoint);

System.out.println("\n---- Reply Message ----\n");
reply.writeTo(System.out);

The returned message is the complete SOAP message, an XML document, as it
looks when it comes over the wire. It is a businessList that follows the format
specified in http://uddi.org/pubs/DataStructure-V2.03-Published-

20020719.htm#_Toc25130802.

http://uddi.org/pubs/DataStructure-V2.03-Published-20020719.htm#_Toc25130802
http://uddi.org/pubs/DataStructure-V2.03-Published-20020719.htm#_Toc25130802


394 SOAP WITH ATTACHMENTS API FOR JAVA
As interesting as it is to see the XML that is actually transmitted, the XML doc-
ument format does not make it easy to see the text that is the message’s content.
To remedy this, the last part of MyUddiPing.java contains code that prints out
just the text content of the response, making it much easier to see the information
you want.

Because the content is in the SOAPBody object, the first thing you need to do is
access it, as shown in the following line of code.

SOAPBody replyBody = reply.getSOAPBody();

Next the code displays a message describing the content:

System.out.println("\n\nContent extracted from " +
"the reply message:\n");

To display the content of the message, the code uses the known format of the
reply message. First it gets all the reply body’s child elements named business-

List:

Iterator businessListIterator =
replyBody.getChildElements(

soapFactory.createName("businessList",
"", "urn:uddi-org:api_v2"));

The method getChildElements returns the elements in the form of a
java.util.Iterator object. You access the child elements by calling the
method next on the Iterator object.

An immediate child of a SOAPBody object is a SOAPBodyElement object.

We know that the reply can contain only one businessList element, so the code
then retrieves this one element by calling the iterator’s next method. Note that
the method Iterator.next returns an Object, which has to be cast to the spe-
cific kind of object you are retrieving. Thus, the result of calling
businessListIterator.next is cast to a SOAPBodyElement object:

SOAPBodyElement businessList =
(SOAPBodyElement)businessListIterator.next();

The next element in the hierarchy is a single businessInfos element, so the
code retrieves this element the same way it retrieved the businessList. Chil-
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dren of SOAPBodyElement objects and all child elements from there down are
SOAPElement objects.

Iterator businessInfosIterator =
businessList.getChildElements(

soapFactory.createName("businessInfos",
"", "urn:uddi-org:api_v2"));

SOAPElement businessInfos =
(SOAPElement)businessInfosIterator.next();

The businessInfos element contains zero or more businessInfo elements. If
the query returned no businesses, the code prints a message saying that none
were found. If the query returned businesses, however, the code extracts the
name and optional description by retrieving the child elements with those names.
The method Iterator.hasNext can be used in a while loop because it returns
true as long as the next call to the method next will return a child element.
Accordingly, the loop ends when there are no more child elements to retrieve.

Iterator businessInfoIterator =
businessInfos.getChildElements(

soapFactory.createName("businessInfo",
"", "urn:uddi-org:api_v2"));

if (! businessInfoIterator.hasNext()) {
System.out.println("No businesses found " +

"matching the name '" + args[1] +
"'.");

} else {
while (businessInfoIterator.hasNext()) {

SOAPElement businessInfo = (SOAPElement)
businessInfoIterator.next();

// Extract name and description from the
// businessInfo
Iterator nameIterator =

businessInfo.getChildElements(
soapFactory.createName("name",

"", "urn:uddi-org:api_v2"));
while (nameIterator.hasNext()) {

businessName =
(SOAPElement)nameIterator.next();

System.out.println("Company name: " +
businessName.getValue());

}
Iterator descriptionIterator =

businessInfo.getChildElements(
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soapFactory.createName(
"description", "",
"urn:uddi-org:api_v2"));

while (descriptionIterator.hasNext()) {
SOAPElement businessDescription =

(SOAPElement)
descriptionIterator.next();

System.out.println("Description: " +
businessDescription.getValue());

}
System.out.println("");

}

Running MyUddiPing
Make sure you have edited the uddi.properties file and compiled MyUddi-

Ping.java as described in Setting Up (page 390).

With the code compiled, you are ready to run MyUddiPing. The run target takes
two arguments, but you need to supply only one of them. The first argument is
the file uddi.properties, which is supplied by a property set in build.xml.
The other argument is the name of the business for which you want to get a
description, and you need to supply this argument on the command line. Note
that any property set on the command line overrides any value set for that prop-
erty in the build.xml file.

Use the following command to run the example:

asant run -Dbusiness-name=food

Output similar to the following will appear after the full XML message:

Content extracted from the reply message:

Company name: Food
Description: Test Food

Company name: Food Manufacturing

Company name: foodCompanyA
Description: It is a food company sells biscuit
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If you want to run MyUddiPing again, you may want to start over by deleting the
build directory and the .class file it contains. You can do this by typing the fol-
lowing at the command line:

asant clean

HeaderExample.java
The example HeaderExample.java, based on the code fragments in the section
Adding Attributes (page 377), creates a message with several headers. It then
retrieves the contents of the headers and prints them out. You will find the code
for HeaderExample in the following directory:

<INSTALL>/j2eetutorial14/examples/saaj/headers/src/

Running HeaderExample
To run HeaderExample, you use the file build.xml that is in the directory
<INSTALL>/j2eetutorial14/examples/saaj/headers/.

To run HeaderExample, use the following command:

asant run

This command executes the prepare, build, and run targets in the build.xml

and targets.xml files.

When you run HeaderExample, you will see output similar to the following:

----- Request Message ----

<SOAP-ENV:Envelope
xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
<SOAP-ENV:Header>
<ns:orderDesk SOAP-ENV:actor="http://gizmos.com/orders"
xmlns:ns="http://gizmos.com/NSURI"/>
<ns:shippingDesk SOAP-ENV:actor="http://gizmos.com/shipping"
xmlns:ns="http://gizmos.com/NSURI"/>
<ns:confirmationDesk
SOAP-ENV:actor="http://gizmos.com/confirmations"
xmlns:ns="http://gizmos.com/NSURI"/>
<ns:billingDesk SOAP-ENV:actor="http://gizmos.com/billing"
xmlns:ns="http://gizmos.com/NSURI"/>
<t:Transaction SOAP-ENV:mustUnderstand="1"
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xmlns:t="http://gizmos.com/orders">5</t:Transaction>
</SOAP-ENV:Header><SOAP-ENV:Body/></SOAP-ENV:Envelope>
Header name is ns:orderDesk
Actor is http://gizmos.com/orders
MustUnderstand is false

Header name is ns:shippingDesk
Actor is http://gizmos.com/shipping
MustUnderstand is false

Header name is ns:confirmationDesk
Actor is http://gizmos.com/confirmations
MustUnderstand is false

Header name is ns:billingDesk
Actor is http://gizmos.com/billing
MustUnderstand is false

Header name is t:Transaction
Actor is null
MustUnderstand is true

DOMExample.java and
DomSrcExample.java
The examples DOMExample.java and DOMSrcExample.java show how to add a
DOM document to a message and then to traverse its contents. They show two
different ways to do this:

• DomExample.java creates a DOM document and adds it to the body of a
message.

• DomSrcExample.java creates the document, uses it to create a DOMSource
object, and then sets the DOMSource object as the content of the message’s
SOAP part.

You will find the code for DOMExample and DOMSrcExample in the following
directory:

<INSTALL>/j2eetutorial14/examples/saaj/dom/src/
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Examining DOMExample
DOMExample first creates a DOM document by parsing an XML document,
almost exactly like the JAXP example DomEcho01.java in the directory
<INSTALL>/j2eetutorial14/examples/jaxp/dom/samples/. The file it parses
is one that you specify on the command line.

static Document document;
...

DocumentBuilderFactory factory =
DocumentBuilderFactory.newInstance();

factory.setNamespaceAware(true);
try {

DocumentBuilder builder =
factory.newDocumentBuilder();

document = builder.parse( new File(args[0]) );
...

Next, the example creates a SOAP message in the usual way. Then it adds the
document to the message body:

SOAPBodyElement docElement =
body.addDocument(document);

This example does not change the content of the message. Instead, it displays the
message content and then uses a recursive method, getContents, to traverse the
element tree using SAAJ APIs and display the message contents in a readable
form.

public void getContents(Iterator iterator,
String indent) {

while (iterator.hasNext()) {
SOAPElement element =

(SOAPElement)iterator.next();
Name name = element.getElementName();
System.out.println(indent + "Name is " +

name.getQualifiedName());
String content = element.getValue();
if (content != null) {

System.out.println(indent + "Content is " +
content);

}
Iterator attrs = element.getAllAttributes();
while (attrs.hasNext()){

Name attrName = (Name)attrs.next();
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System.out.println(indent +
" Attribute name is " +
attrName.getQualifiedName());

System.out.println(indent +
" Attribute value is " +
element.getAttributeValue(attrName));

}
if (content == null) {

Iterator iter2 = element.getChildElements();
getContents(iter2, indent + " ");

}
}

}

Examining DOMSrcExample
DOMSrcExample differs from DomExample in only a few ways. First, after it
parses the document, it uses the document to create a DOMSource object. This
code is the same as that of DomExample except for the last line:

static DOMSource domSource;
...
try {

DocumentBuilder builder =
factory.newDocumentBuilder();

document = builder.parse( new File(args[0]) );
domSource = new DOMSource(document);
...

Then, after DomSrcExample creates the message, it does not get the header and
body and add the document to the body, as DOMExample does. Instead, it gets the
SOAP part and sets the DOMSource object as its content:

// Create a message
SOAPMessage message =

messageFactory.createMessage();

// Get the SOAP part and set its content to domSource
SOAPPart soapPart = message.getSOAPPart();
soapPart.setContent(domSource);

The example then uses the getContents method to obtain the contents of both
the header (if it exists) and the body of the message.
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The most important difference between these two examples is the kind of docu-
ment you can use to create the message. Because DOMExample adds the docu-
ment to the body of the SOAP message, you can use any valid XML file to create
the document. But because DOMSrcExample makes the document the entire con-
tent of the message, the document must already be in the form of a valid SOAP
message, not just any XML document.

Running DOMExample and DOMSrcExample
To run DOMExample and DOMSrcExample, you use the file build.xml that is in
the directory <INSTALL>/j2eetutorial14/examples/saaj/dom/. This direc-
tory also contains several sample XML files you can use:

• domsrc1.xml, an example that has a SOAP header (the contents of the
HeaderExample output) and the body of a UDDI query

• domsrc2.xml, an example of a reply to a UDDI query (specifically, some
sample output from the MyUddiPing example), but with spaces added for
readability

• uddimsg.xml, similar to domsrc2.xml except that it is only the body of the
message and contains no spaces

• slide.xml, similar to the slideSample01.xml file in
<INSTALL>/j2eetutorial14/examples/jaxp/dom/samples/

To run DOMExample, use a command like the following:

asant run-dom -Dxml-file=uddimsg.xml

After running DOMExample, you will see output something like the following:

Running DOMExample.
Name is businessList
Attribute name is generic
Attribute value is 2.0
Attribute name is operator
Attribute value is www.ibm.com/services/uddi
Attribute name is truncated
Attribute value is false
Attribute name is xmlns
Attribute value is urn:uddi-org:api_v2
...
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To run DOMSrcExample, use a command like the following:

asant run-domsrc -Dxml-file=domsrc2.xml

When you run DOMSrcExample, you will see output that begins like the follow-
ing:

run-domsrc:
Running DOMSrcExample.
Body contents:
Content is:

Name is businessList
 Attribute name is generic
 Attribute value is 2.0
 Attribute name is operator
 Attribute value is www.ibm.com/services/uddi
 Attribute name is truncated
 Attribute value is false
 Attribute name is xmlns
 Attribute value is urn:uddi-org:api_v2
 ...

If you run DOMSrcExample with the file uddimsg.xml or slide.xml, you will see
runtime errors.

Attachments.java
The example Attachments.java, based on the code fragments in the sections
Creating an AttachmentPart Object and Adding Content (page 375) and Access-
ing an AttachmentPart Object (page 377), creates a message with a text attach-
ment and an image attachment. It then retrieves the contents of the attachments
and prints out the contents of the text attachment. You will find the code for
Attachments in the following directory:

<INSTALL>/j2eetutorial14/examples/saaj/attachments/src/

Attachments first creates a message in the usual way. It then creates an Attach-

mentPart for the text attachment:

AttachmentPart attachment1 = message.createAttachmentPart();
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After it reads input from a file into a string named stringContent, it sets the
content of the attachment to the value of the string and the type to text-plain, and
also sets a content ID.

attachment1.setContent(stringContent, "text/plain");
attachment1.setContentId("attached_text");

It then adds the attachment to the message:

message.addAttachmentPart(attachment1);

The example uses a javax.activation.DataHandler object to hold a reference
to the graphic that constitutes the second attachment. It creates this attachment
using the form of the createAttachmentPart method that takes a DataHandler

argument.

// Create attachment part for image
URL url = new URL(“file:///./xml-pic.jpg");
DataHandler dataHandler = new DataHandler(url);
AttachmentPart attachment2 =

message.createAttachmentPart(dataHandler);
attachment2.setContentId("attached_image");

message.addAttachmentPart(attachment2);

The example then retrieves the attachments from the message. It displays the
contentId and contentType attributes of each attachment and the contents of
the text attachment. Because the example does not display the contents of the
graphic, the URL does not have to refer to an actual graphic, although in this
case it does.

Running Attachments
To run Attachments, you use the file build.xml that is in the directory
<INSTALL>/j2eetutorial14/examples/saaj/attachments/.

To run Attachments, use the following command:

asant run -Dfile=path_name

Specify any text file as the path_name argument. The attachments directory
contains a file named addr.txt that you can use:

asant run -Dfile=addr.txt
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When you run Attachments using this command line, you will see output like
the following:

Running Attachments.
Attachment attached_text has content type text/plain
Attachment contains:
Update address for Sunny Skies, Inc., to
10 Upbeat Street
Pleasant Grove, CA 95439

Attachment attached_image has content type image/jpeg

SOAPFaultTest.java
The example SOAPFaultTest.java, based on the code fragments in the sections
Creating and Populating a SOAPFault Object (page 385) and Retrieving Fault
Information (page 386), creates a message with a SOAPFault object. It then
retrieves the contents of the SOAPFault object and prints them out. You will find
the code for SOAPFaultTest in the following directory:

<INSTALL>/j2eetutorial14/examples/saaj/fault/src/

Running SOAPFaultTest
To run SOAPFaultTest, you use the file build.xml that is in the directory
<INSTALL>/j2eetutorial14/examples/saaj/fault/.

To run SOAPFaultTest, use the following command:

asant run

When you run SOAPFaultTest, you will see output like the following (line
breaks have been inserted in the message for readability):

Here is what the XML message looks like:

<SOAP-ENV:Envelope
xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
<SOAP-ENV:Header/><SOAP-ENV:Body>
<SOAP-ENV:Fault><faultcode>SOAP-ENV:Client</faultcode>
<faultstring>Message does not have necessary info</faultstring>
<faultactor>http://gizmos.com/order</faultactor>
<detail>
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<PO:order xmlns:PO="http://gizmos.com/orders/">
Quantity element does not have a value</PO:order>
<PO:confirmation xmlns:PO="http://gizmos.com/confirm">
Incomplete address: no zip code</PO:confirmation>
</detail></SOAP-ENV:Fault>
</SOAP-ENV:Body></SOAP-ENV:Envelope>

SOAP fault contains:
   Fault code = SOAP-ENV:Client
   Local name = Client
   Namespace prefix = SOAP-ENV, bound to
http://schemas.xmlsoap.org/soap/envelope/
   Fault string = Message does not have necessary info
   Fault actor = http://gizmos.com/order
   Detail entry = Quantity element does not have a value
   Detail entry = Incomplete address: no zip code

Further Information
For more information about SAAJ, SOAP, and WS-I, see the following:

• SAAJ 1.2 specification, available from
http://java.sun.com/xml/downloads/saaj.html

• SAAJ website:
http://java.sun.com/xml/saaj/

• Simple Object Access Protocol (SOAP) 1.1 Specification:
http://www.w3.org/TR/SOAP/

• WS-I Basic Profile:
http://www.ws-i.org/Profiles/Basic/2003-01/
BasicProfile-1.0-WGAD.html

• JAXM website:
http://java.sun.com/xml/jaxm/

http://www.w3.org/TR/SOAP/
http://java.sun.com/xml/saaj/
http://www.ws-i.org/Profiles/Basic/2003-01/BasicProfile-1.0-WGAD.html
http://java.sun.com/xml/jaxm/
http://java.sun.com/xml/downloads/saaj.html
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Java API for XML
Registries

THE Java API for XML Registries (JAXR) provides a uniform and standard
Java API for accessing different kinds of XML registries.

After providing a brief overview of JAXR, this chapter describes how to imple-
ment a JAXR client to publish an organization and its Web services to a registry
and to query a registry to find organizations and services. Finally, it explains how
to run the examples provided with this tutorial and offers links to more informa-
tion on JAXR.

Overview of JAXR
This section provides a brief overview of JAXR. It covers the following topics:

• What Is a Registry?

• What Is JAXR?

• JAXR Architecture

What Is a Registry?
An XML registry is an infrastructure that enables the building, deployment, and
discovery of Web services. It is a neutral third party that facilitates dynamic and
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loosely coupled business-to-business (B2B) interactions. A registry is available
to organizations as a shared resource, often in the form of a Web-based service.

Currently there are a variety of specifications for XML registries. These include

• The ebXML Registry and Repository standard, which is sponsored by the
Organization for the Advancement of Structured Information Standards
(OASIS) and the United Nations Centre for the Facilitation of Procedures
and Practices in Administration, Commerce and Transport
(U.N./CEFACT)

• The Universal Description, Discovery, and Integration (UDDI) project,
which is being developed by a vendor consortium

A registry provider is an implementation of a business registry that conforms to a
specification for XML registries.

What Is JAXR?
JAXR enables Java software programmers to use a single, easy-to-use abstrac-
tion API to access a variety of XML registries. A unified JAXR information
model describes content and metadata within XML registries.

JAXR gives developers the ability to write registry client programs that are por-
table across different target registries. JAXR also enables value-added capabili-
ties beyond those of the underlying registries.

The current version of the JAXR specification includes detailed bindings
between the JAXR information model and both the ebXML Registry and the
UDDI version 2 specifications. You can find the latest version of the specifica-
tion at

http://java.sun.com/xml/downloads/jaxr.html

At this release of the J2EE platform, JAXR implements the level 0 capability
profile defined by the JAXR specification. This level allows access to both UDDI
and ebXML registries at a basic level. At this release, JAXR supports access
only to UDDI version 2 registries.

Currently several public UDDI version 2 registries exist.

The Java Web Services Developer Pack (Java WSDP) Registry Server provides a
UDDI version 2 registry that you can use to test your JAXR applications in a pri-
vate environment. You can download the Java WSDP from

http://java.sun.com/xml/downloads/jaxr.html
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http://java.sun.com/webservices/download.html. The Registry Server
includes a database based on the native XML database Xindice, which is part of
the Apache XML project. This database provides the repository for registry data.
The Registry Server does not support messages defined in the UDDI Version 2.0
Replication Specification.

Note: If you use the Java WSDP Registry Server to test JAXR applications that you
develop using the J2EE 1.4 Application Server, make sure that in your PATH you
place the J2EE 1.4 Application Server bin directories before the Java WSDP bin

directories.

Several ebXML registries are under development, and one is available at the
Center for E-Commerce Infrastructure Development (CECID), Department of
Computer Science Information Systems, The University of Hong Kong (HKU).
For information, see
http://www.cecid.hku.hk/Release/PR09APR2002.html.

A JAXR provider for ebXML registries is available in open source at
http://ebxmlrr.sourceforge.net.

JAXR Architecture
The high-level architecture of JAXR consists of the following parts:

• A JAXR client: a client program that uses the JAXR API to access a busi-
ness registry via a JAXR provider.

• A JAXR provider: an implementation of the JAXR API that provides
access to a specific registry provider or to a class of registry providers that
are based on a common specification.

A JAXR provider implements two main packages:

• javax.xml.registry, which consists of the API interfaces and classes
that define the registry access interface.

• javax.xml.registry.infomodel, which consists of interfaces that define
the information model for JAXR. These interfaces define the types of
objects that reside in a registry and how they relate to each other. The basic
interface in this package is the RegistryObject interface. Its subinter-
faces include Organization, Service, and ServiceBinding.

http://java.sun.com/webservices/download.html
http://www.cecid.hku.hk/Release/PR09APR2002.html
http://ebxmlrr.sourceforge.net
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The most basic interfaces in the javax.xml.registry package are

• Connection. The Connection interface represents a client session with a
registry provider. The client must create a connection with the JAXR pro-
vider in order to use a registry.

• RegistryService. The client obtains a RegistryService object from its
connection. The RegistryService object in turn enables the client to
obtain the interfaces it uses to access the registry.

The primary interfaces, also part of the javax.xml.registry package, are

• BusinessQueryManager, which allows the client to search a registry for
information in accordance with the javax.xml.registry.infomodel

interfaces. An optional interface, DeclarativeQueryManager, allows the
client to use SQL syntax for queries. (The implementation of JAXR in the
J2EE Application Server does not implement DeclarativeQueryMan-

ager.)

• BusinessLifeCycleManager, which allows the client to modify the infor-
mation in a registry by either saving it (updating it) or deleting it.

When an error occurs, JAXR API methods throw a JAXRException or one of its
subclasses.

Many methods in the JAXR API use a Collection object as an argument or a
returned value. Using a Collection object allows operations on several registry
objects at a time.

Figure 10–1 illustrates the architecture of JAXR. In the J2EE Application Server,
a JAXR client uses the capability level 0 interfaces of the JAXR API to access
the JAXR provider. The JAXR provider in turn accesses a registry. The J2EE
Application Server supplies a JAXR provider for UDDI registries.
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Figure 10–1 JAXR Architecture

Implementing a JAXR Client
This section describes the basic steps to follow in order to implement a JAXR
client that can perform queries and updates to a UDDI registry. A JAXR client is
a client program that can access registries using the JAXR API. It covers the fol-
lowing topics:

• Establishing a Connection

• Querying a Registry

• Managing Registry Data

• Using Taxonomies in JAXR Clients

This tutorial does not describe how to implement a JAXR provider. A JAXR pro-
vider provides an implementation of the JAXR specification that allows access to
an existing registry provider, such as a UDDI or ebXML registry. The implemen-
tation of JAXR in the J2EE Application Server itself is an example of a JAXR
provider.

The J2EE 1.4 Application Server provides JAXR in the form of a resource
adapter using the J2EE Connector Architecture. The resource adapter is in the
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directory <J2EE_HOME>/lib/install/applications/jaxr-ra. (<J2EE_HOME>
is the directory where the J2EE Application Server is installed.)

This tutorial includes several client examples, which are described in Running
the Client Examples (page 435), and a J2EE application example, described in
Using JAXR Clients in J2EE Applications (page 445). The examples are in the
directory <INSTALL>/j2eetutorial14/examples/jaxr/. (<INSTALL> is the
directory where you installed the tutorial bundle.) Each example directory has a
build.xml file that refers to a targets.xml file and a build.properties file in
the directory <INSTALL>/j2eetutorial14/examples/jaxr/common/.

Establishing a Connection
The first task a JAXR client must complete is to establish a connection to a regis-
try. Establishing a connection involves the following tasks:

• Preliminaries: Getting Access to a Registry

• Creating or Looking Up a Connection Factory

• Creating a Connection

• Setting Connection Properties

• Obtaining and Using a RegistryService Object

Preliminaries: Getting Access to a Registry
Any user of a JAXR client may perform queries on a registry. In order to add
data to the registry or to update registry data, however, a user must obtain per-
mission from the registry to access it. To register with one of the public UDDI
version 2 registries, go to one of the following Web sites and follow the instruc-
tions:

• http://test.uddi.microsoft.com/ (Microsoft)

• http://uddi.ibm.com/testregistry/registry.html (IBM)

• http://udditest.sap.com/ (SAP)

These UDDI version 2 registries are intended for testing purposes. When you
register, you will obtain a user name and password. You will specify this user
name and password for some of the JAXR client example programs.

You do not have to register with the Java WSDP Registry Server in order to add
or update data. You can use the default user name and password, testuser and
testuser.

http://test.uddi.microsoft.com/
http://uddi.ibm.com/testregistry/registry.html
http://udditest.sap.com/
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Note: The JAXR API has been tested with the Microsoft and IBM registries and
with the Java WSDP Registry Server, but not with the SAP registry.

Creating or Looking Up a Connection Factory
A client creates a connection from a connection factory. A JAXR provider may
supply one or more preconfigured connection factories that clients can obtain by
looking them up using the Java Naming and Directory Interface (JNDI) API.

At this release of the J2EE Application Server, JAXR supplies a connection fac-
tory through the JAXR RA, but you need to create a connector resource whose
JNDI API name (“JNDI name”) is eis/JAXR to access this connection factory
from a J2EE application. To look up this connection factory in a J2EE compo-
nent, use code like the following:

import javax.xml.registry.*;
import javax.naming.*;
...

Context context = new InitialContext();
ConnectionFactory connFactory = (ConnectionFactory)

context.lookup("java:comp/env/eis/JAXR");

You will learn how to create this connector resource later in this chapter.

To use JAXR in a standalone client program, you must create an instance of the
abstract class ConnectionFactory:

import javax.xml.registry.*;
...
ConnectionFactory connFactory =

ConnectionFactory.newInstance();

Creating a Connection
To create a connection, a client first creates a set of properties that specify the
URL or URLs of the registry or registries being accessed. For example, the fol-
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lowing code provides the URLs of the query service and publishing service for
the IBM test registry. (There should be no line break in the strings.)

Properties props = new Properties();
props.setProperty("javax.xml.registry.queryManagerURL",

"http://uddi.ibm.com/testregistry/inquiryapi");
props.setProperty("javax.xml.registry.lifeCycleManagerURL",

"https://uddi.ibm.com/testregistry/publishapi");

With the J2EE Application Server implementation of JAXR, if the client is
accessing a registry that is outside a firewall, it must also specify proxy host and
port information for the network on which it is running. For queries it may need
to specify only the HTTP proxy host and port; for updates it must specify the
HTTPS proxy host and port.

props.setProperty("com.sun.xml.registry.http.proxyHost",
"myhost.mydomain");

props.setProperty("com.sun.xml.registry.http.proxyPort",
"8080");

props.setProperty("com.sun.xml.registry.https.proxyHost",
"myhost.mydomain");

props.setProperty("com.sun.xml.registry.https.proxyPort",
"8080");

The client then sets the properties for the connection factory and creates the con-
nection:

connFactory.setProperties(props);
Connection connection = connFactory.createConnection();

The makeConnection method in the sample programs shows the steps used to
create a JAXR connection.

Setting Connection Properties
The implementation of JAXR in the J2EE Application Server allows you to set a
number of properties on a JAXR connection. Some of these are standard proper-
ties defined in the JAXR specification. Other properties are specific to the imple-
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mentation of JAXR in the J2EE Application Server. Table 10–1 and Table 10–2
list and describe these properties.

Table 10–1 Standard JAXR Connection Properties

Property Name and Description
Data
Type Default Value

javax.xml.registry.queryManagerURL

Specifies the URL of the query manager service within the tar-
get registry provider

String None

javax.xml.registry.lifeCycleManagerURL

Specifies the URL of the life cycle manager service within the
target registry provider (for registry updates)

String
Same as the speci-
fied queryMan-
agerURL value

javax.xml.registry.semanticEquivalences

Specifies semantic equivalences of concepts as one or more
tuples of the ID values of two equivalent concepts separated
by a comma; the tuples are separated by vertical bars:
id1,id2|id3,id4

String None

javax.xml.registry.security.authentication-
Method

Provides a hint to the JAXR provider on the authentication
method to be used for authenticating with the registry provider

String

None;
UDDI_GET_AUTHT
OKEN is the only
supported value

javax.xml.registry.uddi.maxRows

The maximum number of rows to be returned by find opera-
tions. Specific to UDDI providers

Integer None

javax.xml.registry.postalAddressScheme

The ID of a ClassificationScheme to be used as the
default postal address scheme. See Specifying Postal
Addresses (page 433) for an example

String None
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You can set these properties as follows:

• Most of these properties must be set in a JAXR client program. For exam-
ple:
Properties props = new Properties();
props.setProperty("javax.xml.registry.queryManagerURL",

Table 10–2 Implementation-Specific JAXR Connection Properties

Property Name and Description
Data
Type Default Value

com.sun.xml.registry.http.proxyHost

Specifies the HTTP proxy host to be used for access-
ing external registries

String None

com.sun.xml.registry.http.proxyPort

Specifies the HTTP proxy port to be used for access-
ing external registries; usually 8080

String None

com.sun.xml.registry.https.proxyHost

Specifies the HTTPS proxy host to be used for
accessing external registries

String
Same as HTTP proxy
host value

com.sun.xml.registry.https.proxyPort

Specifies the HTTPS proxy port to be used for
accessing external registries; usually 8080

String
Same as HTTP proxy
port value

com.sun.xml.registry.http.proxyUserName

Specifies the user name for the proxy host for HTTP
proxy authentication, if one is required

String None

com.sun.xml.registry.http.proxyPassword

Specifies the password for the proxy host for HTTP
proxy authentication, if one is required

String None

com.sun.xml.registry.useCache

Tells the JAXR implementation to look for registry
objects in the cache first and then to look in the regis-
try if not found

Boolean,
passed in
as String

True
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"http://uddi.ibm.com/testregistry/inquiryapi");
props.setProperty("javax.xml.registry.lifeCycleManagerURL",

"https://uddi.ibm.com/testregistry/publishapi");
ConnectionFactory factory = (ConnectionFactory)

context.lookup("java:comp/env/eis/JAXR");
factory.setProperties(props);
connection = factory.createConnection();

• The postalAddressScheme and useCache properties may be set in a
<sysproperty> tag in a build.xml file for the asant tool. For example:
<sysproperty key="useCache" value="true"/>

These properties may also be set with the -D option on the java command
line.

An additional system property specific to the implementation of JAXR in the
J2EE Application Server is com.sun.xml.registry.userTaxonomyFilenames.
For details on using this property, see Defining a Taxonomy (page 430).

Obtaining and Using a RegistryService Object
After creating the connection, the client uses the connection to obtain a Regis-

tryService object and then the interface or interfaces it will use:

RegistryService rs = connection.getRegistryService();
BusinessQueryManager bqm = rs.getBusinessQueryManager();
BusinessLifeCycleManager blcm =

rs.getBusinessLifeCycleManager();

Typically, a client obtains both a BusinessQueryManager object and a Busi-

nessLifeCycleManager object from the RegistryService object. If it is using
the registry for simple queries only, it may need to obtain only a BusinessQue-

ryManager object.

Querying a Registry
The simplest way for a client to use a registry is to query it for information about
the organizations that have submitted data to it. The BusinessQueryManager

interface supports a number of find methods that allow clients to search for data
using the JAXR information model. Many of these methods return a Bulk-
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Response (a collection of objects) that meets a set of criteria specified in the
method arguments. The most useful of these methods are:

• findOrganizations, which returns a list of organizations that meet the
specified criteria—often a name pattern or a classification within a classi-
fication scheme

• findServices, which returns a set of services offered by a specified orga-
nization

• findServiceBindings, which returns the service bindings (information
about how to access the service) that are supported by a specified service

The JAXRQuery program illustrates how to query a registry by organization name
and display the data returned. The JAXRQueryByNAICSClassification and
JAXRQueryByWSDLClassification programs illustrate how to query a registry
using classifications. All JAXR providers support at least the following taxono-
mies for classifications:

• The North American Industry Classification System (NAICS). See
http://www.census.gov/epcd/www/naics.html for details.

• The Universal Standard Products and Services Classification (UNSPSC).
See http://www.eccma.org/unspsc/ for details.

• The ISO 3166 country codes classification system maintained by the Inter-
national Organization for Standardization (ISO). See
http://www.iso.org/iso/en/prods-ser-

vices/iso3166ma/index.html for details.

The following sections describe how to perform some common queries:

• Finding Organizations by Name

• Finding Organizations by Classification

• Finding Services and ServiceBindings

Finding Organizations by Name
To search for organizations by name, you normally use a combination of find
qualifiers (which affect sorting and pattern matching) and name patterns (which
specify the strings to be searched). The findOrganizations method takes a col-
lection of findQualifier objects as its first argument and a collection of name-
Pattern objects as its second argument. The following fragment shows how to

http://www.census.gov/epcd/www/naics.html
http://www.eccma.org/unspsc/
http://www.iso.org/iso/en/prods-services/iso3166ma/index.html
http://www.iso.org/iso/en/prods-services/iso3166ma/index.html


QUERYING A REGISTRY 419
find all the organizations in the registry whose names begin with a specified
string, qString, and to sort them in alphabetical order.

// Define find qualifiers and name patterns
Collection findQualifiers = new ArrayList();
findQualifiers.add(FindQualifier.SORT_BY_NAME_DESC);
Collection namePatterns = new ArrayList();
namePatterns.add(qString);

// Find using the name
BulkResponse response =

bqm.findOrganizations(findQualifiers,
namePatterns, null, null, null, null);

Collection orgs = response.getCollection();

A client can use percent signs (%) to specify that the query string can occur any-
where within the organization name. For example, the following code fragment
performs a case-sensitive search for organizations whose names contain
qString:

Collection findQualifiers = new ArrayList();
findQualifiers.add(FindQualifier.CASE_SENSITIVE_MATCH);
Collection namePatterns = new ArrayList();
namePatterns.add("%" + qString + "%");

// Find orgs with name containing qString
BulkResponse response =

bqm.findOrganizations(findQualifiers, namePatterns, null,
null, null, null);

Collection orgs = response.getCollection();

Finding Organizations by Classification
To find organizations by classification, you need to establish the classification
within a particular classification scheme and then specify the classification as an
argument to the findOrganizations method.

The following code fragment finds all organizations that correspond to a particu-
lar classification within the NAICS taxonomy. (You can find the NAICS codes at
http://www.census.gov/epcd/naics/naicscod.txt.)

ClassificationScheme cScheme =
bqm.findClassificationSchemeByName(null,

"ntis-gov:naics");
Classification classification =

http://www.census.gov/epcd/naics/naicscod.txt
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blcm.createClassification(cScheme,
"Snack and Nonalcoholic Beverage Bars", "722213");

Collection classifications = new ArrayList();
classifications.add(classification);
// make JAXR request
BulkResponse response = bqm.findOrganizations(null,

null, classifications, null, null, null);
Collection orgs = response.getCollection();

You can also use classifications to find organizations that offer services based on
technical specifications that take the form of WSDL (Web Services Description
Language) documents. In JAXR, a concept is used as a proxy to hold the infor-
mation about a specification. The steps are a little more complicated than in the
previous example, because the client must find the specification concepts first,
then the organizations that use those concepts.

The following code fragment finds all the WSDL specification instances used
within a given registry. You can see that the code is similar to the NAICS query
code except that it ends with a call to findConcepts instead of findOrganiza-
tions.

String schemeName = "uddi-org:types";
ClassificationScheme uddiOrgTypes =

bqm.findClassificationSchemeByName(null, schemeName);

/*
 * Create a classification, specifying the scheme
 *  and the taxonomy name and value defined for WSDL
 *  documents by the UDDI specification.
 */
Classification wsdlSpecClassification =
blcm.createClassification(uddiOrgTypes,

"wsdlSpec", "wsdlSpec");

Collection classifications = new ArrayList();
classifications.add(wsdlSpecClassification);

// Find concepts
BulkResponse br = bqm.findConcepts(null, null,

classifications, null, null);

To narrow the search, you could use other arguments of the findConcepts

method (search qualifiers, names, external identifiers, or external links).
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The next step is to go through the concepts, find the WSDL documents they cor-
respond to, and display the organizations that use each document:

// Display information about the concepts found
Collection specConcepts = br.getCollection();
Iterator iter = specConcepts.iterator();
if (!iter.hasNext()) {

System.out.println("No WSDL specification concepts found");
} else {

while (iter.hasNext()) {
Concept concept = (Concept) iter.next();

String name = getName(concept);

Collection links = concept.getExternalLinks();
System.out.println("\nSpecification Concept:\n\tName: " +

name + "\n\tKey: " +
concept.getKey().getId() +
"\n\tDescription: " +
getDescription(concept));

if (links.size() > 0) {
ExternalLink link =

(ExternalLink) links.iterator().next();
System.out.println("\tURL of WSDL document: '" +

link.getExternalURI() + "'");
}

// Find organizations that use this concept
Collection specConcepts1 = new ArrayList();
specConcepts1.add(concept);
br = bqm.findOrganizations(null, null, null,

specConcepts1, null, null);

// Display information about organizations
...

}

If you find an organization that offers a service you wish to use, you can invoke
the service using the JAX-RPC API.
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Finding Services and ServiceBindings
After a client has located an organization, it can find that organization’s services
and the service bindings associated with those services.

Iterator orgIter = orgs.iterator();
while (orgIter.hasNext()) {

Organization org = (Organization) orgIter.next();
Collection services = org.getServices();
Iterator svcIter = services.iterator();
while (svcIter.hasNext()) {

Service svc = (Service) svcIter.next();
Collection serviceBindings =

svc.getServiceBindings();
Iterator sbIter = serviceBindings.iterator();
while (sbIter.hasNext()) {

ServiceBinding sb =
(ServiceBinding) sbIter.next();

}
}

}

Managing Registry Data
If a client has authorization to do so, it can submit data to a registry, modify it,
and remove it. It uses the BusinessLifeCycleManager interface to perform
these tasks.

Registries usually allow a client to modify or remove data only if the data is
being modified or removed by the same user who first submitted the data.

Managing registry data involves the following tasks:

• Getting Authorization from the Registry

• Creating an Organization

• Adding Classifications

• Adding Services and Service Bindings to an Organization

• Publishing an Organization

• Publishing a Specification Concept

• Removing Data from the Registry
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Getting Authorization from the Registry
Before it can submit data, the client must send its user name and password to the
registry in a set of credentials. The following code fragment shows how to do
this.

String username = "myUserName";
String password = "myPassword";

// Get authorization from the registry
PasswordAuthentication passwdAuth =

new PasswordAuthentication(username,
password.toCharArray());

Set creds = new HashSet();
creds.add(passwdAuth);
connection.setCredentials(creds);

Creating an Organization
The client creates the organization and populates it with data before publishing
it.

An Organization object is one of the more complex data items in the JAXR
API. It normally includes the following:

• A Name object

• A Description object

• A Key object, representing the ID by which the organization is known to
the registry. This key is created by the registry, not by the user, and is
returned after the organization is submitted to the registry.

• A PrimaryContact object, which is a User object that refers to an autho-
rized user of the registry. A User object normally includes a PersonName

object and collections of TelephoneNumber, EmailAddress, and/or
PostalAddress objects.

• A collection of Classification objects

• Service objects and their associated ServiceBinding objects

For example, the following code fragment creates an organization and specifies
its name, description, and primary contact. When a client creates an organiza-
tion, it does not include a key; the registry returns the new key when it accepts
the newly created organization. The blcm object in this code fragment is the
BusinessLifeCycleManager object returned in Obtaining and Using a Registry-
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Service Object (page 417). An InternationalString object is used for string
values that may need to be localized.

// Create organization name and description
Organization org =

blcm.createOrganization("The Coffee Break");
InternationalString s =

blcm.createInternationalString("Purveyor of " +
"the finest coffees. Established 1914");

org.setDescription(s);

// Create primary contact, set name
User primaryContact = blcm.createUser();
PersonName pName = blcm.createPersonName("Jane Doe");
primaryContact.setPersonName(pName);

// Set primary contact phone number
TelephoneNumber tNum = blcm.createTelephoneNumber();
tNum.setNumber("(800) 555-1212");
Collection phoneNums = new ArrayList();
phoneNums.add(tNum);
primaryContact.setTelephoneNumbers(phoneNums);

// Set primary contact email address
EmailAddress emailAddress =

blcm.createEmailAddress("jane.doe@TheCoffeeBreak.com");
Collection emailAddresses = new ArrayList();
emailAddresses.add(emailAddress);
primaryContact.setEmailAddresses(emailAddresses);

// Set primary contact for organization
org.setPrimaryContact(primaryContact);

Adding Classifications
Organizations commonly belong to one or more classifications based on one or
more classification schemes (taxonomies). To establish a classification for an
organization using a taxonomy, the client first locates the taxonomy it wants to
use. It uses the BusinessQueryManager to find the taxonomy. The
findClassificationSchemeByName method takes a set of FindQualifier

objects as its first argument, but this argument can be null.

// Set classification scheme to NAICS
ClassificationScheme cScheme =

bqm.findClassificationSchemeByName(null, "ntis-gov:naics");
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The client then creates a classification using the classification scheme and a con-
cept (a taxonomy element) within the classification scheme. For example, the
following code sets up a classification for the organization within the NAICS
taxonomy. The second and third arguments of the createClassification

method are the name and value of the concept.

// Create and add classification
Classification classification =

blcm.createClassification(cScheme,
"Snack and Nonalcoholic Beverage Bars", "722213");

Collection classifications = new ArrayList();
classifications.add(classification);
org.addClassifications(classifications);

Services also use classifications, so you can use similar code to add a classifica-
tion to a Service object.

Adding Services and Service Bindings to an
Organization
Most organizations add themselves to a registry in order to offer services, so the
JAXR API has facilities to add services and service bindings to an organization.

Like an Organization object, a Service object has a name and a description.
Also like an Organization object, it has a unique key that is generated by the
registry when the service is registered. It may also have classifications associated
with it.

A service also commonly has service bindings, which provide information about
how to access the service. A ServiceBinding object normally has a description,
an access URI, and a specification link, which provides the linkage between a
service binding and a technical specification that describes how to use the ser-
vice using the service binding.

The following code fragment shows how to create a collection of services, add
service bindings to a service, then add the services to the organization. It speci-
fies an access URI but not a specification link. Because the access URI is not real
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and because JAXR by default checks for the validity of any published URI, the
binding sets its validateURI property to false.

// Create services and service
Collection services = new ArrayList();
Service service = blcm.createService("My Service Name");
InternationalString is =

blcm.createInternationalString("My Service Description");
service.setDescription(is);

// Create service bindings
Collection serviceBindings = new ArrayList();
ServiceBinding binding = blcm.createServiceBinding();
is = blcm.createInternationalString("My Service Binding " +

"Description");
binding.setDescription(is);
// allow us to publish a bogus URL without an error
binding.setValidateURI(false);
binding.setAccessURI("http://TheCoffeeBreak.com:8080/sb/");
serviceBindings.add(binding);

// Add service bindings to service
service.addServiceBindings(serviceBindings);

// Add service to services, then add services to organization
services.add(service);
org.addServices(services);

Publishing an Organization
The primary method a client uses to add or modify organization data is the
saveOrganizations method, which creates one or more new organizations in a
registry if they did not exist previously. If one of the organizations exists but
some of the data have changed, the saveOrganizations method updates and
replaces the data.

After a client populates an organization with the information it wants to make
public, it saves the organization. The registry returns the key in its response, and
the client retrieves it.

// Add organization and submit to registry
// Retrieve key if successful
Collection orgs = new ArrayList();
orgs.add(org);
BulkResponse response = blcm.saveOrganizations(orgs);
Collection exceptions = response.getException();
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if (exceptions == null) {
System.out.println("Organization saved");

Collection keys = response.getCollection();
Iterator keyIter = keys.iterator();
if (keyIter.hasNext()) {

javax.xml.registry.infomodel.Key orgKey =
(javax.xml.registry.infomodel.Key) keyIter.next();

String id = orgKey.getId();
System.out.println("Organization key is " + id);

}
}

Publishing a Specification Concept
A service binding may have a technical specification that describes how to
access the service. An example of such a specification is a WSDL document. To
publish the location of a service’s specification (if the specification is a WSDL
document), you create a Concept object and then add the URL of the WSDL
document to the Concept object as an ExternalLink object. The following code
fragment shows how to create a concept for the WSDL document associated
with the simple web service example in Creating a Web Service with JAX-
RPC (page 333). First, you call the createConcept method to create a concept
named HelloConcept. After setting the description of the concept, you create an
external link to the URL of the Hello service’s WSDL document, then add the
external link to the concept.

Concept specConcept =
blcm.createConcept(null, "HelloConcept", "");

InternationalString s =
blcm.createInternationalString(

"Concept for Hello Service");
specConcept.setDescription(s);
ExternalLink wsdlLink =

blcm.createExternalLink(
"http://localhost:8080/hello-jaxrpc/hello?WSDL",
"Hello WSDL document");

specConcept.addExternalLink(wsdlLink);

Next, you classify the Concept object as a WSDL document. To do this for a
UDDI registry, you search the registry for the well-known classification scheme
uddi-org:types. (The UDDI term for a classification scheme is tModel.) Then
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you create a classification using the name and value wsdlSpec. Finally, you add
the classification to the concept.

String schemeName = "uddi-org:types";
ClassificationScheme uddiOrgTypes =

bqm.findClassificationSchemeByName(null, schemeName);

Classification wsdlSpecClassification =
blcm.createClassification(uddiOrgTypes,
"wsdlSpec", "wsdlSpec");

specConcept.addClassification(wsdlSpecClassification);

Finally, you save the concept using the saveConcepts method, similarly to the
way you save an organization:

Collection concepts = new ArrayList();
concepts.add(specConcept);
BulkResponse concResponse = blcm.saveConcepts(concepts);

Once you have published the concept, you normally add the concept for the
WSDL document to a service binding. To do this, you could retrieve the key for
the concept from the response returned by the saveConcepts method, using a
code sequence very similar to that of finding the key for a saved organization.

String conceptKeyId = null;
Collection concExceptions = concResponse.getExceptions();
javax.xml.registry.infomodel.Key concKey = null;
if (concExceptions == null) {

System.out.println("WSDL Specification Concept saved");

Collection keys = concResponse.getCollection();
Iterator keyIter = keys.iterator();
if (keyIter.hasNext()) {

concKey =
(javax.xml.registry.infomodel.Key) keyIter.next();

conceptKeyId = concKey.getId();
System.out.println("Concept key is " + id);

}
}

Then you could call the getRegistryObject method to retrieve the concept
from the registry:

Concept specConcept =
(Concept) bqm.getRegistryObject(conceptKeyId,

LifeCycleManager.CONCEPT);
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Next, you create a SpecificationLink object for the service binding and set the
concept as the value of its SpecificationObject:

SpecificationLink specLink =
blcm.createSpecificationLink();

specLink.setSpecificationObject(specConcept);
binding.addSpecificationLink(specLink);

Now when you publish the organization with its service and service bindings,
you have also published a link to the WSDL document, so that the organization
can be found in queries like those described in Finding Organizations by
Classification (page 419).

If the concept was published by someone else and you don’t have access to the
key, you can find it using its name and classification. The code would look very
similar to the code used to search for a WSDL document in Finding Organiza-
tions by Classification (page 419), except that you would also create a collection
of name patterns and include that in your search. For example:

// Define name pattern
Collection namePatterns = new ArrayList();
namePatterns.add("HelloConcept");

BulkResponse br = bqm.findConcepts(null, namePatterns,
classifications, null, null);

Removing Data from the Registry
A registry allows you to remove from the registry any data that you have submit-
ted to it. You use the key returned by the registry as an argument to one of the
BusinessLifeCycleManager delete methods: deleteOrganizations, delete-
Services, deleteServiceBindings, deleteConcepts, and others.

The JAXRDelete sample program deletes the organization created by the JAXR-

Publish program. It deletes the organization that corresponds to a specified key
string and then displays the key again so that the user can confirm that it has
deleted the correct one.

String id = key.getId();
System.out.println("Deleting organization with id " + id);
Collection keys = new ArrayList();
keys.add(key);
BulkResponse response = blcm.deleteOrganizations(keys);
Collection exceptions = response.getException();
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if (exceptions == null) {
    System.out.println("Organization deleted");
    Collection retKeys = response.getCollection();
    Iterator keyIter = retKeys.iterator();
    javax.xml.registry.infomodel.Key orgKey = null;
    if (keyIter.hasNext()) {
        orgKey =
            (javax.xml.registry.infomodel.Key) keyIter.next();
        id = orgKey.getId();
        System.out.println("Organization key was " + id);
    }
}

A client can use a similar mechanism to delete concepts, services, and service
bindings.

Using Taxonomies in JAXR Clients
In the JAXR API, a taxonomy is represented by a ClassificationScheme

object.

This section describes how to use the implementation of JAXR in the J2EE
Application Server:

• To define your own taxonomies

• To specify postal addresses for an organization

Defining a Taxonomy
The JAXR specification requires a JAXR provider to be able to add user-defined
taxonomies for use by JAXR clients. The mechanisms clients use to add and
administer these taxonomies are implementation-specific.

The implementation of JAXR in the J2EE Application Server uses a simple file-
based approach to provide taxonomies to the JAXR client. These files are read at
run time, when the JAXR provider starts up.

The taxonomy structure for the J2EE Application Server is defined by the JAXR
Predefined Concepts DTD, which is declared both in the file jaxrconcepts.dtd

and, in XML schema form, in the file jaxrconcepts.xsd. The file jaxrcon-

cepts.xml contains the taxonomies for the implementation of JAXR in the J2EE
Application Server. All these files are contained in the
<J2EE_HOME>/share/lib/jaxr-impl.jar file. This JAR file also includes files
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that define the well-known taxonomies that the implementation of JAXR in the
J2EE Application Server uses: naics.xml, iso3166.xml, and unspsc.xml.

The entries in the jaxrconcepts.xml file look like this:

<PredefinedConcepts>
<JAXRClassificationScheme id="schId" name="schName">
<JAXRConcept id="schId/conCode" name="conName"
parent="parentId" code="conCode"></JAXRConcept>
...
</JAXRClassificationScheme>
</PredefinedConcepts>

The taxonomy structure is a containment-based structure. The element Pre-

definedConcepts is the root of the structure and must be present. The JAXR-

ClassificationScheme element is the parent of the structure, and the
JAXRConcept elements are children and grandchildren. A JAXRConcept element
may have children, but it is not required to do so.

In all element definitions, attribute order and case are significant.

To add a user-defined taxonomy, follow these steps.

1. Publish the JAXRClassificationScheme element for the taxonomy as a
ClassificationScheme object in the registry that you will be accessing.
For example, you can publish the ClassificationScheme object to the
Java WSDP Registry Server. In order to publish a ClassificationScheme
object, you must set its name. You also give the scheme a classification
within a known classification scheme such as uddi-org:types. In the fol-
lowing code fragment, the name is the first argument of the LifeCycle-

Manager.createClassificationScheme method call.
ClassificationScheme cScheme =

blcm.createClassificationScheme("MyScheme",
"A Classification Scheme");

ClassificationScheme uddiOrgTypes =
bqm.findClassificationSchemeByName(null,

"uddi-org:types");
if (uddiOrgTypes != null) {

Classification classification =
blcm.createClassification(uddiOrgTypes,

"postalAddress", "categorization" );
postalScheme.addClassification(classification);
ExternalLink externalLink =
blcm.createExternalLink(

"http://www.mycom.com/myscheme.html",
"My Scheme");
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postalScheme.addExternalLink(externalLink);
Collection schemes = new ArrayList();
schemes.add(cScheme);
BulkResponse br =

blcm.saveClassificationSchemes(schemes);
}

The BulkResponse object returned by the saveClassificationSchemes

method contains the key for the classification scheme, which you need to
retrieve:

if (br.getStatus() == JAXRResponse.STATUS_SUCCESS) {
System.out.println("Saved ClassificationScheme");
Collection schemeKeys = br.getCollection();
Iterator keysIter = schemeKeys.iterator();
while (keysIter.hasNext()) {

javax.xml.registry.infomodel.Key key =
(javax.xml.registry.infomodel.Key)

keysIter.next();
System.out.println("The postalScheme key is " +

key.getId());
System.out.println("Use this key as the scheme“ +

“ uuid in the taxonomy file");
}

}

2. In an XML file, define a taxonomy structure that is compliant with the
JAXR Predefined Concepts DTD. Enter the ClassificationScheme ele-
ment in your taxonomy XML file by specifying the returned key ID value
as the id attribute and the name as the name attribute. For the code frag-
ment above, for example, the opening tag for the JAXRClassification-

Scheme element looks something like this (all on one line):
<JAXRClassificationScheme
id="uuid:nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn"
name="MyScheme">

The ClassificationScheme id must be a UUID.

3. Enter each JAXRConcept element in your taxonomy XML file by specify-
ing the following four attributes, in this order:

a. id is the JAXRClassificationScheme id value, followed by a / sepa-
rator, followed by the code of the JAXRConcept element

b. name is the name of the JAXRConcept element

c. parent is the immediate parent id (either the ClassificationScheme

id or that of the parent JAXRConcept)

d. code is the JAXRConcept element code value
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The first JAXRConcept element in the naics.xml file looks like this (all
on one line):

<JAXRConcept
id="uuid:C0B9FE13-179F-413D-8A5B-5004DB8E5BB2/11"
name="Agriculture, Forestry, Fishing and Hunting"
parent="uuid:C0B9FE13-179F-413D-8A5B-5004DB8E5BB2"
code="11"></JAXRConcept>

4. To add the user-defined taxonomy structure to the JAXR provider, specify
the system property com.sun.xml.registry.userTaxonomyFilenames

when you run your client program. The command line (all on one line)
would look like this. A vertical bar (|) is the file separator.
java myProgram
-Dcom.sun.xml.registry.userTaxonomyFilena-
mes=c:\mydir\xxx.xml|c:\mydir\xxx2.xml

You can use a <sysproperty> tag to set this property in a build.xml file
for a client program. Or, in your program, you can set the property as fol-
lows:

System.setProperty
("com.sun.xml.registry.userTaxonomyFilenames",

"c:\mydir\xxx.xml|c:\mydir\xxx2.xml");

If your client will run in a J2EE application, you need to specify the sys-
tem property com.sun.xml.registry.userTaxonomyFilenames as one
of the JVM arguments when you start the J2EE server. Use the following
command (all on one line) to create a new JVM option in the file
<J2EE_HOME>/domains/domain1/config/domain.xml:

asadmin create-jvm-options -Dcom.sun.xml.registry.userTaxon-
omyFilenames=c:\\mydir\\xxx.xml|c:\\mydir\\xxx2.xml

Stop and restart the server to make this change take effect.

Specifying Postal Addresses
The JAXR specification defines a postal address as a structured interface with
attributes for street, city, country, and so on. The UDDI specification, on the
other hand, defines a postal address as a free-form collection of address lines,
each of which may also be assigned a meaning. To map the JAXR PostalAd-

dress format to a known UDDI address format, you specify the UDDI format as
a ClassificationScheme object and then specify the semantic equivalences
between the concepts in the UDDI format classification scheme and the com-
ments in the JAXR PostalAddress classification scheme. The JAXR Postal-
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Address classification scheme is provided by the implementation of JAXR in the
J2EE Application Server.

In the JAXR API, a PostalAddress object has the fields streetNumber, street,
city, state, postalCode and country. In the implementation of JAXR in the
J2EE Application Server, these are predefined concepts in the jaxrcon-

cepts.xml file, within the ClassificationScheme named PostalAddress-

Attributes.

To specify the mapping between the JAXR postal address format and another
format, you need to set two connection properties:

• The javax.xml.registry.postalAddressScheme property, which spec-
ifies a postal address classification scheme for the connection

• The javax.xml.registry.semanticEquivalences property, which
specifies the semantic equivalences between the JAXR format and the
other format

For example, suppose you want to use a scheme named MyPostalAddress-

Scheme, which you published to a registry with the UUID uuid:f7922839-

f1f7-9228-c97d-ce0b4594736c.

<JAXRClassificationScheme id="uuid:f7922839-f1f7-9228-c97d-
ce0b4594736c" name="MyPostalAddressScheme">

First, you specify the postal address scheme using the id value from the JAXR-

ClassificationScheme element (the UUID). Case does not matter:

props.setProperty("javax.xml.registry.postalAddressScheme",
"uuid:f7922839-f1f7-9228-c97d-ce0b4594736c");

Next, you specify the mapping from the id of each JAXRConcept element in the
default JAXR postal address scheme to the id of its counterpart in the IBM
scheme:

props.setProperty("javax.xml.registry.semanticEquivalences",
"urn:uuid:PostalAddressAttributes/StreetNumber," +
"uuid:f7922839-f1f7-9228-c97d-

ce0b4594736c/StreetAddressNumber|" +
"urn:uuid:PostalAddressAttributes/Street," +
"urn:uuid:f7922839-f1f7-9228-c97d-

ce0b4594736c/StreetAddress|" +
"urn:uuid:PostalAddressAttributes/City," +
"urn:uuid:f7922839-f1f7-9228-c97d-ce0b4594736c/City|" +
"urn:uuid:PostalAddressAttributes/State," +



RUNNING THE CLIENT EXAMPLES 435
"urn:uuid:f7922839-f1f7-9228-c97d-ce0b4594736c/State|" +
"urn:uuid:PostalAddressAttributes/PostalCode," +
"urn:uuid:f7922839-f1f7-9228-c97d-ce0b4594736c/ZipCode|" +
"urn:uuid:PostalAddressAttributes/Country," +
"urn:uuid:f7922839-f1f7-9228-c97d-ce0b4594736c/Country");

After you create the connection using these properties, you can create a postal
address and assign it to the primary contact of the organization before you pub-
lish the organization:

String streetNumber = "99";
String street = "Imaginary Ave. Suite 33";
String city = "Imaginary City";
String state = "NY";
String country = "USA";
String postalCode = "00000";
String type = "";
PostalAddress postAddr =

blcm.createPostalAddress(streetNumber, street, city, state,
country, postalCode, type);

Collection postalAddresses = new ArrayList();
postalAddresses.add(postAddr);
primaryContact.setPostalAddresses(postalAddresses);

A JAXR query can then retrieve the postal address using PostalAddress meth-
ods, if the postal address scheme and semantic equivalences for the query are the
same as those specified for the publication. To retrieve postal addresses when
you do not know what postal address scheme was used to publish them, you can
retrieve them as a collection of Slot objects. The JAXRQueryPostal.java sam-
ple program shows how to do this.

In general, you can create a user-defined postal address taxonomy for any
PostalAddress tModels that use the well-known categorization in the uddi-

org:types taxonomy, which has the tModel UUID uuid:c1acf26d-9672-

4404-9d70-39b756e62ab4 with a value of postalAddress. You can retrieve the
tModel overviewDoc, which points to the technical detail for the specification of
the scheme, where the taxonomy structure definition can be found. (The JAXR
equivalent of an overviewDoc is an ExternalLink.)

Running the Client Examples
The simple client programs provided with this tutorial can be run from the com-
mand line. You can modify them to suit your needs. They allow you to specify
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the IBM registry, the Microsoft registry, or the Java WSDP Registry Server for
queries and updates; you can specify any other UDDI version 2 registry.

The client examples, in the <INSTALL>/j2eetutorial14/exam-

ples/jaxr/simple/src/ directory, are as follows:

• JAXRQuery.java shows how to search a registry for organizations

• JAXRQueryByNAICSClassification.java shows how to search a registry
using a common classification scheme

• JAXRQueryByWSDLClassification.java shows how to search a registry
for Web services that describe themselves by means of a WSDL document

• JAXRPublish.java shows how to publish an organization to a registry

• JAXRDelete.java shows how to remove an organization from a registry

• JAXRSaveClassificationScheme.java shows how to publish a classifi-
cation scheme (specifically, a postal address scheme) to a registry

• JAXRPublishPostal.java shows how to publish an organization with a
postal address for its primary contact

• JAXRQueryPostal.java shows how to retrieve postal address data from an
organization

• JAXRDeleteScheme.java shows how to delete a classification scheme
from a registry

• JAXRPublishConcept.java shows how to publish a concept for a WSDL
document

• JAXRPublishHelloOrg.java shows how to publish an organization with
a service binding that refers to a WSDL document

• JAXRDeleteConcept.java shows how to delete a concept

• JAXRGetMyObjects.java lists all the objects that you own in a registry

The <INSTALL>/j2eetutorial14/examples/jaxr/simple/ directory also con-
tains:

• A build.xml file for the examples

• A JAXRExamples.properties file, in the src subdirectory, that supplies
string values used by the sample programs

• A file called postalconcepts.xml that you use with the postal address
examples

You do not have to have the J2EE Application Server running in order to run
these client examples. However, if you want to run the J2EE Application Server
and the Registry Server at the same time, you should be aware that they both use

../examples/jaxr/simple/src/JAXRQuery.java
../examples/jaxr/simple/src/JAXRPublishHelloOrg.java
../examples/jaxr/simple/src/JAXRQueryByNAICSClassification.java
../examples/jaxr/simple/src/JAXRQueryByWSDLClassification.java
../examples/jaxr/simple/src/JAXRPublish.java
../examples/jaxr/simple/src/JAXRPublishConcept.java
../examples/jaxr/simple/src/JAXRExamples.properties
../examples/jaxr/simple/src/JAXRDeleteConcept.java
../examples/jaxr/simple/src/JAXRDelete.java
../examples/jaxr/simple/src/JAXRSaveClassificationScheme.java
../examples/jaxr/simple/src/JAXRPublishPostal.java
../examples/jaxr/simple/src/JAXRQueryPostal.java
../examples/jaxr/simple/src/JAXRDeleteScheme.java
../examples/jaxr/simple/src/JAXRGetMyObjects.java
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the same port, 8080, to run the Web container. You need to change this port for
either the J2EE Application Server or for the Java WSDP.

You specified the Web container port for the J2EE Application Server (called the
HTTP listen port?) when you installed it. If you did not already specify a nonde-
fault port for the J2EE Application server, it is probably easier to change the Java
WSDP port. This involves two tasks:

1. Open the file <JWSDP_HOME>/conf/server.xml in a text editor. Find the
comment “Define a non-SSL Coyote HTTP/1.1 Connector on port 8080.”
In the Connector element that follows, change this attribute to some other
port value, such as 8082 or 8083:
port=”8080”

2. Open the file <JWSDP_HOME>/jwsdp-shared/bin/launcher.xml in a text
editor. Find the following lines (they are all on one line in the file):
<sysproperty key="org.apache.xindice.host"
value="desired Xindice host"/>
<sysproperty key="org.apache.xindice.port"
value="desired Xindice port"/>

Make the host and port values the same as those for the Web container (the host
is ordinarily localhost). Uncomment these properties before you save the file.

Now, when you start the Java WSDP Web container, Tomcat, as described in
Running the Examples (page 440), there will be no port conflict with the J2EE
Application Server.

Before You Compile the Examples
Before you compile the examples, edit the file
<INSTALL>/j2eetutorial14/examples/jaxr/simple/src/JAXR-

Examples.properties as follows.

1. Edit the following lines to specify the registry you wish to access. For both
the queryURL and the publishURL assignments, comment out all but the
registry you wish to access. The default is the Java WSDP Registry Server.

## Uncomment one pair of query and publish URLs.

## IBM:

#query.url=http://uddi.ibm.com/testregistry/inquiryapi

#publish.url=https://uddi.ibm.com/testregistry/publishapi

## Microsoft:

#query.url=http://test.uddi.microsoft.com/inquire
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#publish.url=https://test.uddi.microsoft.com/publish

## Registry Server:

query.url=http://localhost:8080/RegistryServer/

publish.url=http://localhost:8080/RegistryServer/

If you are using the Java WSDP Registry Server, and if it is running on a
system other than your own, specify the fully qualified host name instead
of localhost. Do not use https: for the publishURL. If Tomcat is using
a nondefault port, change 8080 to the correct value for your system.

The IBM and Microsoft registries both have a considerable amount of
data in them that you can perform queries on. Moreover, you do not have
to register if you are only going to perform queries.

We have not included the URLs of the SAP registry; feel free to add them.

If you want to publish to any of the public registries, the registration pro-
cess for obtaining access to them is not difficult (see Preliminaries: Get-
ting Access to a Registry, page 412). Each of them, however, allows you
to have only one organization registered at a time. If you publish an orga-
nization to one of them, you must delete it before you can publish another.
Since the organization that the JAXRPublish example publishes is ficti-
tious, you will want to delete it immediately anyway.

The Java WSDP Registry Server gives you more freedom to experiment
with JAXR. You can publish as many organizations, concepts, and classi-
fication schemes to it as you wish. However, this registry comes with an
empty database, so you must publish data to it yourself before you can
perform queries on the data.

2. Edit the following lines to specify the user name and password you
obtained when you registered with the registry. The defaults are the Regis-
try Server default username and password.
## Specify username and password if needed
## testuser/testuser are defaults for Registry Server
registry.username=testuser
registry.password=testuser

3. If you will be using a public registry, edit the following lines, which con-
tain empty strings for the proxy hosts, to specify your own proxy settings.
The proxy host is the system on your network through which you access
the Internet; you usually specify it in your Internet browser settings. You
can leave this value empty to use the Java WSDP Registry Server.

## HTTP and HTTPS proxy host and port;

##   ignored by Registry Server
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http.proxyHost=

http.proxyPort=8080

https.proxyHost=

https.proxyPort=8080

The proxy ports have the value 8080, which is the usual one; change this
string if your proxy uses a different port.

For a public registry, your entries usually follow this pattern:

http.proxyHost=proxyhost.mydomain

http.proxyPort=8080

https.proxyHost=proxyhost.mydomain

https.proxyPort=8080

4. If you are running the J2EE Application Server on a system other than your
own, or if it is running on a nondefault port, change the following lines:
link.uri=http://localhost:8080/hello-jaxrpc/hello?WSDL
...
wsdlorg.svcbnd.uri=http://localhost:8080/hello-jaxrpc/hello

Specify the fully qualified host name instead of localhost, or change
8080 to the correct value for your system.

5. Feel free to change any of the organization data in the remainder of the file.
This data is used by the publishing and postal address examples.

You can edit the src/JAXRExamples.properties file at any time. The asant

targets that run the client examples will use the latest version of the file.

Compiling the Examples
To compile the programs, go to the
<INSTALL>/j2eetutorial14/examples/jaxr/simple/ directory. A build.xml
file allows you to use the command

asant compile

to compile all the examples. The asant tool creates a subdirectory called build.

The runtime classpath setting in the build.xml file includes JAR files in several
directories in the J2EE Application Server installation. All JAXR client exam-
ples require this classpath setting.
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Running the Examples
If you are running the examples with the Java WSDP Registry Server, start the
Java WSDP Tomcat (<JWSDP_HOME> is the location of the Java WSDP on your
system).

On Windows, from the Start menu, choose Programs→Java Web Services
Developer Pack 1.x→Start Tomcat or use the following command:

<JWSDP_HOME>\bin\startup

On a UNIX system, use the following command:

<JWSDP_HOME>/bin/startup.sh

The Registry Server is a Web application that is loaded when Tomcat starts.

You do not need to start Tomcat in order to run the examples against public reg-
istries.

Running the JAXRPublish Example
To run the JAXRPublish program, use the run-publish target with no command
line arguments:

asant run-publish

The program output displays the string value of the key of the new organization,
which is named “The Coffee Break.”

After you run the JAXRPublish program but before you run JAXRDelete, you
can run JAXRQuery to look up the organization you published.

Running the JAXRQuery Example
To run the JAXRQuery example, use the asant target run-query. Specify a
query-string argument on the command line to search the registry for organi-
zations whose names contain that string. For example, the following command
line searches for organizations whose names contain the string “coff” (searching
is not case-sensitive):

asant -Dquery-string=coff run-query
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Running the JAXRQueryByNAICSClassification
Example
After you run the JAXRPublish program, you can also run the JAXRQueryBy-

NAICSClassification example, which looks for organizations that use the
“Snack and Nonalcoholic Beverage Bars” classification, the same one used for
the organization created by JAXRPublish. To do so, use the asant target run-
query-naics:

asant run-query-naics

Running the JAXRDelete Example
To run the JAXRDelete program, specify the key string displayed by the JAXR-

Publish program as input to the run-delete target:

asant -Dkey-string=keyString run-delete

Publishing a Classification Scheme
In order to publish organizations with postal addresses to public registries, you
must publish a classification scheme for the postal address first.

To run the JAXRSaveClassificationScheme program, use the target run-save-
scheme:

asant run-save-scheme

The program returns a UUID string, which you will use in the next section.

You do not have to run this program if you are using the Java WSDP Registry
Server, because it does not validate these objects.

The public registries allow you to own more than one classification scheme at a
time (the limit is usually a total of about 10 classification schemes and concepts
put together).

Running the Postal Address Examples
Before you run the postal address examples, open the file postalconcepts.xml

in an editor. Wherever you see the string uuid-from-save, replace it with the
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UUID string returned by the run-save-scheme target (including the uuid: pre-
fix). For the Java WSDP Registry Server, you may use any string that is format-
ted as a UUID.

For a given registry, you only need to publish the classification scheme and edit
postalconcepts.xml once. After you perform those two steps, you can run the
JAXRPublishPostal and JAXRQueryPostal programs multiple times.

1. Run the JAXRPublishPostal program. Notice that in the build.xml file,
the run-publish-postal target contains a <sysproperty> tag that sets
the userTaxonomyFilenames property to the location of the postalcon-

cepts.xml file in the current directory:
<sysproperty
key="com.sun.xml.registry.userTaxonomyFilenames"

value="postalconcepts.xml"/>

Specify the string you entered in the postalconcepts.xml file (including
the uuid: prefix) as input to the run-publish-postal target:

asant -Duuid-string=uuidstring run-publish-postal

The program output displays the string value of the key of the new organi-
zation.

2. Run the JAXRQueryPostal program. The run-query-postal target con-
tains the same <sysproperty> tag as the run-publish-postal target.

As input to the run-query-postal target, specify both a query-string

argument and a uuid-string argument on the command line to search
the registry for the organization published by the run-publish-postal

target:

asant -Dquery-string=coffee
-Duuid-string=uuidstring run-query-postal

The postal address for the primary contact will appear correctly with the
JAXR PostalAddress methods. Any postal addresses found that use
other postal address schemes will appear as Slot lines.

3. If you are using a public registry, make sure to follow the instructions in
Running the JAXRDelete Example (page 441) to delete the organization
you published.
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Deleting a Classification Scheme
To delete the classification scheme you published after you have finished using
it, run the JAXRDeleteScheme program using the run-delete-scheme target:

asant -Duuid-string=uuidstring run-delete-scheme

For the public UDDI registries, deleting a classification scheme removes it from
the registry logically but not physically. The classification scheme will still be
visible if, for example, you call the method QueryManager.getRegistered-

Objects. However, you can no longer use the classification scheme. Therefore,
you may prefer not to delete the classification scheme from the registry, in case
you want to use it again. The public registries normally allow you to own up to
10 of these objects.

Publishing a Concept for a WSDL Document
To publish the location of the WSDL document for the JAX-RPC Hello Service,
first deploy the service as described in Creating a Web Service with JAX-
RPC (page 333).

Then run the JAXRPublishConcept program using the run-publish-concept

target:

asant run-publish-concept

The program output displays the UUID string of the new concept, which is
named “Hello Concept.” You will use this string in the next section.

After you run the JAXRPublishConcept program, you can run JAXRPublish-

HelloOrg to publish an organization that uses this concept.

Publishing an Organization with a WSDL
Document in its Service Binding
To run the JAXRPublishHelloOrg example, use the asant target run-publish-
hello-org. Specify the string returned from JAXRPublishConcept (including
the uuid: prefix) as input to this target:

asant -Duuid-string=uuidstring run-publish-hello-org
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The program output displays the string value of the key of the new organization,
which is named “Hello Organization.”

After you publish the organization, run the JAXRQueryByWSDLClassification

example to search for it. To delete it, run JAXRDelete.

Running the JAXRQueryByWSDLClassification
Example
To run the JAXRQueryByWSDLClassification example, use the asant target
run-query-wsdl. Specify a query-string argument on the command line to
search the registry for specification concepts whose names contain that string.
For example, the following command line searches for concepts whose names
contain the string “helloconcept” (searching is not case-sensitive):

asant -Dquery-string=helloconcept run-query-wsdl

This example finds the concept and organization you published. A common
string like “hello” returns many results from the public registries and is likely to
run for several minutes.

Deleting a Concept
To run the JAXRDeleteConcept program, specify the UUID string displayed by
the JAXRPublishConcept program as input to the run-delete-concept target:

asant -Duuid-string=uuidString run-delete-concept

Deleting a concept from a public UDDI registry is similar to deleting a classifi-
cation scheme: the concept is removed logically but not physically. Do not delete
the concept until after you have deleted any organizations that refer to it.

Getting a List of Your Registry Objects
To get a list of the objects you own in the registry—organizations, classification
schemes, and concepts—run the JAXRGetMyObjects program by using the run-

get-objects target:

asant run-get-objects
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If you run this program with the Java WSDP Registry Server, it returns all the
standard UDDI taxonomies provided with the Registry Server, not just the
objects you have created.

Other Targets
To remove the build directory and class files, use the command

asant clean

To obtain a syntax reminder for the targets, use the command

asant -projecthelp

Using JAXR Clients in J2EE Applications
You can create J2EE applications that use JAXR clients to access registries. This
section explains how to write, compile, package, deploy, and run a J2EE applica-
tion that uses JAXR to publish an organization to a registry and then query the
registry for that organization. The application in this section uses two compo-
nents, an application client and a stateless session bean.

The section covers the following topics:

• Coding the Application Client: MyAppClient.java

• Coding the PubQuery Session Bean

• Compiling the Source Files

• Starting the J2EE Application Server

• Creating JAXR Resources

• Creating and Packaging the Application

• Deploying the Application

• Running the Application Client

You will find the source files for this section in the directory
<INSTALL>/j2eetutorial14/examples/jaxr/clientsession. Path names in
this section are relative to this directory.

The following directory contains a built version of this application:

<INSTALL>/j2eetutorial14/examples/jaxr/provided-ears
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If you run into difficulty at any time, you can open the EAR file in deploytool

and compare that file to your own version. You will probably have to add a new
version of the properties file that specifies a different Tomcat port.

Coding the Application Client:
MyAppClient.java
The application client class, src/MyAppClient.java, obtains a handle to the
PubQuery enterprise bean’s remote home interface, using the JNDI API naming
context java:comp/env. The program then creates an instance of the bean and
calls the bean’s two business methods, executePublish and executeQuery.

Before you compile the application, edit the PubQueryBeanExamples.proper-

ties file the same way you edited the JAXRExamples.properties file to run the
simple examples.

1. If you are using the Java WSDP Registry Server, specify the correct host
and port values for the queryManagerURL and lifeCycleManagerURL

entries. To use another registry, comment out the property that specifies the
Registry Server and remove the comment from the other registry.

2. If you are using a public registry, change the values for the
http.proxyHost and https.proxyHost entries so that they specify the
the system on your network through which you access the Internet.

Coding the PubQuery Session Bean
The PubQuery bean is a stateless session bean with one create method and two
business methods. The bean uses remote interfaces rather than local interfaces
because it is accessed from outside the EJB container.

The remote home interface source file is src/PubQueryHome.java.

The remote interface, src/PubQueryRemote.java, declares two business meth-
ods, executePublish and executeQuery. The bean class, src/PubQuery-

Bean.java, implements the executePublish and executeQuery methods and
their helper methods getName, getDescription, and getKey. These methods are
very similar to the methods of the same name in the simple examples JAXR-

Query.java and JAXRPublish.java. The executePublish method uses infor-
mation in the file PubQueryBeanExample.properties to create an organization

../examples/jaxr/clientsession/src/MyAppClient.java
../examples/jaxr/clientsession/src/PubQueryHome.java
../examples/jaxr/clientsession/src/PubQueryRemote.java
../examples/jaxr/clientsession/src/PubQueryBean.java
../examples/jaxr/clientsession/src/PubQueryBean.java
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named The Coffee Enterprise Bean Break. The executeQuery method uses the
string “Coff”, specified in the application client code, to locate this organization.

The bean class also implements the required methods ejbCreate, setSession-
Context, ejbRemove, ejbActivate, and ejbPassivate.

The ejbCreate method of the bean class allocates resources—in this case, by
looking up the ConnectionFactory and creating the Connection.

The ejbRemove method must deallocate the resources that were allocated by the
ejbCreate method. In this case, the ejbRemove method closes the Connection.

Compiling the Source Files
To compile the application source files, go to the directory
<INSTALL>/j2eetutorial14/examples/jaxr/clientsession. Use the fol-
lowing command:

asant compile

The compile target places the properties file and the class files in the build

directory.

Starting the J2EE Application Server
To run this example, you need to start the J2EE Application Server. Follow the
instructions in Starting and Stopping the J2EE Application Server (page 91).

Creating JAXR Resources
In order to use JAXR in a J2EE application that uses the J2EE 1.4 Application
Server, you need to access the JAXR resource adapter (see Implementing a
JAXR Client (page 411) through a connector connection pool and a connector
resource. You can create these resources in the Admin Console.

If you have not done so, start the Admin Console as described in Starting the
Admin Console (page 92).

To create the connector connection pool, perform the following steps:

1. Expand the Connectors node, then click Connector Connection Pools.
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2. Click New. The Create Connector Connection Pool wizard starts.

3. In the Select Connector Module screen:

a. Type jaxr-pool in the Name field.

b. Choose jaxr-ra from the Resource Adapter menu.

c. Click Next.

4. In the Select Connection Definition screen, choose javax.xml.regis-

try.ConnectionFactory (the only choice) from the menu and click Next.

5. In the next two screens, Specify Properties and Enter Pool Settings, click
Next.

6. In the Summary screen, click Finish.

To create the connector resource, perform the following steps:

1. Under the Connectors node, click Connector Resources.

2. Click New. The Create Connector Resource screen appears.

3. In the JNDI Name field, type eis/JAXR.

4. Choose jaxr-pool from the Pool Name menu.

5. Click OK.

If you are in a hurry, you can create these objects using the following asant tar-
get in the build.xml file for this example:

asant create-resource

Creating and Packaging the Application
Creating and packaging this application involve several steps:

1. Starting deploytool and Creating the Application

2. Packaging the Session Bean

3. Packaging the Application Client

4. Checking the JNDI Names
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Starting deploytool and Creating the
Application

1. Start deploytool. On Windows systems, choose Start→Programs→Sun
Microsystems→J2EE 1.4 SDK→Deploytool. On UNIX systems, use the
deploytool command.

2. Choose File→New→Application.

3. Click Browse next to the Application File Name field and use the file
chooser to locate the directory clientsession.

4. In the File Name field, type ClientSessionApp.

5. Click New Application.

6. Click OK.

Packaging the Session Bean
1. Choose File→New→Enterprise Bean to start the Enterprise Bean Wizard,

then click Next.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application and make sure that the
application is ClientSessionApp.

b. In the JAR Name field, type PubQueryJAR.

c. Click the Edit button next to the Contents text area.

d. In the dialog box, locate the clientsession/build directory. Select
PubQueryBean.class, PubQueryHome.class, PubQueryRe-

mote.class, and PubQueryBeanExample.properties from the Avail-
able Files tree area and click Add, then OK.

3. In the General screen:

a. From the Enterprise Bean Class menu, choose PubQueryBean.

b. In the Enterprise Bean Name field, type PubQuery.

c. Verify that the Enterprise Bean Type is Stateless Session.

d. In the Remote Interfaces area, choose PubQueryHome from the Remote
Home Interface menu and PubQueryRemote from the Remote Interface
menu.
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After you finish the wizard, perform the following steps:

1. Click the PubQuery node, then click the Transactions tab. In the inspector
pane, select the Container-Managed radio button.

2. Click the PubQuery node, then click the Resource Refs tab. In the inspector
pane:

a. Click Add.

b. In the Coded Name field, type eis/JAXR.

c. From the Type menu, choose javax.xml.registry.ConnectionFac-

tory.

d. In the Deployment Settings area, type eis/JAXR in the JNDI name field
and j2ee in both the User Name and Password fields.

Packaging the Application Client
1. Choose File→New→Application Client to start the Application Client

Wizard, then click Next.

2. In the JAR File Contents screen:

a. Make sure that Create New AppClient Module in Application is
selected and that the application is ClientSessionApp.

b. In the AppClient Name field, type MyAppClient.

c. Click the Edit button next to the Contents text area.

d. In the dialog box, locate the clientsession/build directory. Select
MyAppClient.class from the Available Files tree area and click Add,
then OK.

3. In the General screen, select MyAppClient in the Main Class combo box.

After you finish the wizard, click the EJB Refs tab, then click Add in the inspec-
tor pane. In the dialog box:

1. Type ejb/remote/PubQuery in the Coded Name field.

2. Choose Session from the EJB Type menu.

3. Choose Remote from the Interfaces menu.

4. Type PubQueryHome in the Home Interface field.

5. Type PubQueryRemote in the Local/Remote Interface field.

When you return to the EJB Refs inspector pane, select the bean. In the Sun-spe-
cific Settings area, select JNDI Name and type PubQuery in the field. The ses-
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sion bean uses remote interfaces, so the client accesses the bean through the
JNDI name rather than the bean name.

Checking the JNDI Names
Verify that the JNDI names for the application components are correct. They
should appear as shown in Table 10–3 and Table 10–4.

Deploying the Application
1. Save the application.

2. Choose Tools→Deploy.

3. In the dialog box, type your administrative user name and password (if
they are not already filled in) and click OK.

4. In the Application Client Stub Directory area, select the Return Client Jar
checkbox.

5. Click OK.

6. In the Distribute Module dialog box, click Close when the process com-
pletes. You will find a file named ClientSessionAppClient.jar in the
specified directory.

Table 10–3 Application Pane for ClientSessionApp

Component Type Component JNDI Name

EJB PubQuery PubQuery

Table 10–4 References Pane for ClientSessionApp

Ref. Type Referenced By Reference Name JNDI Name

EJB Ref MyAppClient ejb/remote/PubQuery PubQuery

Resource PubQuery eis/JAXR eis/JAXR
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Running the Application Client
1. If you are using the Java WSDP Registry Server, start it by starting Tomcat.

Windows systems: Choose Start→Programs→Java(TM) Web Services
Developer Pack 1.3→Start Tomcat.

UNIX systems:

<JWSDP_HOME>/bin/startup.sh

Starting Tomcat takes some time.

2. To run the client, use the following command:
appclient -client ClientSessionAppClient.jar

The program output in the terminal window looks like this:

Looking up EJB reference
Looked up home
Narrowed home
Got the EJB
See server log for bean output

In the server log, you will find the output from the executePublish and exe-

cuteQuery methods.

Further Information
For more information about JAXR, registries, and Web services, see the follow-
ing:

• Java Specification Request (JSR) 93: JAXR 1.0:
 http://jcp.org/jsr/detail/093.jsp

• JAXR home page:

http://java.sun.com/xml/jaxr/index.html

• Universal Description, Discovery, and Integration (UDDI) project:
http://www.uddi.org/

• ebXML:
 http://www.ebxml.org/

• Open Source JAXR Provider for ebXML Registries:
http://ebxmlrr.sourceforge.net/

http://jcp.org/jsr/detail/093.jsp
http://java.sun.com/xml/jaxr/index.html
http://www.uddi.org/
http://www.ebxml.org/
http://ebxmlrr.sourceforge.net/
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• Java 2 Platform, Enterprise Edition:
http://java.sun.com/j2ee/

• Java Technology and XML:
http://java.sun.com/xml/

• Java Technology & Web Services:
http://java.sun.com/webservices/index.html

http://java.sun.com/j2ee/
http://java.sun.com/xml/
http://java.sun.com/webservices/index.html
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455
Java Servlet
Technology

AS soon as the Web began to be used for delivering services, service providers
recognized the need for dynamic content. Applets, one of the earliest attempts
toward this goal, focused on using the client platform to deliver dynamic user
experiences. At the same time, developers also investigated using the server plat-
form for this purpose. Initially, Common Gateway Interface (CGI) scripts were
the main technology used to generate dynamic content. Though widely used,
CGI scripting technology has a number of shortcomings, including platform
dependence and lack of scalability. To address these limitations, Java Servlet
technology was created as a portable way to provide dynamic, user-oriented con-
tent.

What is a Servlet?
A servlet is a Java programming language class used to extend the capabilities of
servers that host applications accessed via a request-response programming
model. Although servlets can respond to any type of request, they are commonly
used to extend the applications hosted by Web servers. For such applications,
Java Servlet technology defines HTTP-specific servlet classes.
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The javax.servlet and javax.servlet.http packages provide interfaces and
classes for writing servlets. All servlets must implement the Servlet interface,
which defines life-cycle methods.

When implementing a generic service, you can use or extend the GenericServ-

let class provided with the Java Servlet API. The HttpServlet class provides
methods, such as doGet and doPost, for handling HTTP-specific services.

This chapter focuses on writing servlets that generate responses to HTTP
requests. Some knowledge of the HTTP protocol is assumed; if you are unfamil-
iar with this protocol, you can get a brief introduction to HTTP in HTTP
Overview (page 1165).

The Example Servlets
This chapter uses the Duke’s Bookstore application to illustrate the tasks
involved in programming servlets. Table 11–1 lists the servlets that handle each
bookstore function. Each programming task is illustrated by one or more serv-
lets. For example, BookDetailsServlet illustrates how to handle HTTP GET

requests, BookDetailsServlet and CatalogServlet show how to construct
responses, and CatalogServlet illustrates how to track session information.

Table 11–1 Duke’s Bookstore Example Servlets

Function Servlet

Enter the bookstore BookStoreServlet

Create the bookstore banner BannerServlet

Browse the bookstore catalog CatalogServlet

Put a book in a shopping cart CatalogServlet,
BookDetailsServlet

Get detailed information on a specific book BookDetailsServlet

Display the shopping cart ShowCartServlet

Remove one or more books from the shopping cart ShowCartServlet

Buy the books in the shopping cart CashierServlet

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/package-summary.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/package-summary.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/Servlet.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/GenericServlet.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/GenericServlet.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpServlet.html
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The data for the bookstore application is maintained in a database and accessed
through the helper class database.BookDB. The database package also contains
the class BookDetails, which represents a book. The shopping cart and shop-
ping cart items are represented by the classes cart.ShoppingCart and
cart.ShoppingCartItem, respectively.

The source code for the bookstore application is located in the <INSTALL>/

j2eetutorial14/examples/web/bookstore1/ directory created when you
unzip the tutorial bundle (see Building and Running the Examples, page xxix). A
sample bookstore1.war is provided in <INSTALL>/j2eetutorial14/

examples/web/provided-wars/. To build, package, deploy, and run the exam-
ple with deploytool:

1. Build and package the bookstore common files as described in Duke’s
Bookstore Examples (page 109).

2. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/bookstore1/.

3. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/

bookstore1/build/ directory.

4. Start the J2EE application server.

5. Perform all the operations described in Accessing Databases from Web
Applications, page 109.

6. Start deploytool.

7. Create a Web application called bookstore1 by running the New Web
Component Wizard. Select File→New→Web Component.

8. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. In the WAR Location field, enter <INSTALL>/docs/tutorial/

examples/web/bookstore1/build/bookstore1.war.

c. In the WAR Name field, enter bookstore1.

d. In the Context Root field, enter /bookstore1.

Receive an acknowledgement for the purchase ReceiptServlet

Table 11–1 Duke’s Bookstore Example Servlets (Continued)

Function Servlet
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e. Click Edit.

f. In the Edit Archive Contents dialog box, navigate to <INSTALL>/

j2eetutorial14/examples/web/bookstore1/build/. Select
errorpage.html, duke.books.gif, and the servlets, database,
filters, listeners, and util packages. Click Add.

g. Add the shared bookstore library. Navigate to <INSTALL>/

j2eetutorial14/examples/build/web/bookstore/dist/. Select
bookstore.jar and Click Add.

h. Click OK.

i. Click Next.

j. Select the Servlet radio button.

k. Click Next.

l. Select BannerServlet from the Servlet Class combo box.

m.Click Finish.

9. Add the rest of the Web components listed in Table 11–2. For each servlet:

a. Select File→New→Web Component.

b. Click the Add to Existing WAR Module radio button. Since the WAR
contains all of the servlet classes, you do not have to add any more con-
tent.

c. Click Next.

d. Select the Servlet radio button.

e. Click Next.

f. Select the servlet from the Servlet Class combo box.

g. Click Finish.

Table 11–2 Duke’s Bookstore Web Components

Web Component Name Servlet Class Alias

BannerServlet BannerServlet /banner

BookStoreServlet BookStoreServlet /bookstore

CatalogServlet CatalogServlet /bookcatalog

BookDetailsServlet BookDetailsServlet /bookdetails

ShowCartServlet ShowCartServlet /bookshowcart
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10.Set the alias for each Web component.

a. Select the component.

b. Select the Aliases tab.

c. Click the Add button.

d. Enter the alias.

11.Add the listener class listeners.ContextListener (described in Han-
dling Servlet Life Cycle Events, page 461).

a. Select the Event Listeners tab.

b. Click Add.

c. Select the listeners.ContextListener class from drop down field in
the Event Listener Classes panel.

12.Add an error page (described in Handling Errors, page 464).

a. Select the File Refs tab.

b. Click Add in the Error Mapping panel.

c. Enter exception.BookNotFoundException in the Error/Exception
field.

d. Enter /errorpage.html in the Resource to be Called field.

e. Repeat for exception.BooksNotFoundException and javax.serv-

let.UnavailableException.

13.Add the filters filters.HitCounterFilter and filters.OrderFilter

(described in Filtering Requests and Responses, page 474).

a. Select the Filter Mapping tab.

b. Click Edit Filter List.

c. Click Add.

d. Select filters.HitCounterFilter from the Filter Class column. The
deploytool will automatically enter HitCounterFilter in the Display
Name column.

CashierServlet CashierServlet /bookcashier

ReceiptServlet ReceiptServlet /bookreceipt

Table 11–2 Duke’s Bookstore Web Components (Continued)

Web Component Name Servlet Class Alias
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e. Click Add.

f. Select filters.OrderFilter from the Filter Class column. The
deploytool will automatically enter OrderFilter in the Display Name
column.

g. Click OK.

h. Click Add.

i. Select HitCounterFilter from the Filter Name column.

j. Select Servlet from the Target Type column.

k. Select BookStoreServlet from the Target column.

l. Repeat for OrderFilter. The target type is Servlet and the target is
ReceiptServlet.

14.Add a resource reference for the database.

a. Select the Resource Refs tab.

b. Click Add.

c. Enter jdbc/BookDB in the Coded Name field.

d. Accept the default type javax.sql.DataSource.

e. Accept the default authorization Container.

f. Accept the default selected Shareable.

g. Enter jdbc/BookDB in the JNDI name field of the Sun-specific Settings
frame.

15.Select File→Save.

16.Deploy the application.

a. Select Tools→Deploy.

b. In the Connection Settings frame, enter the user name and password you
specified when you installed the J2EE 1.4 Application Server.

c. Click OK.

17.To run the application, open the bookstore URL http://local-

host:8080/bookstore1/bookstore.

Troubleshooting
The Duke’s Bookstore database access object returns the following exceptions:

• BookNotFoundException—Returned if a book can’t be located in the
bookstore database. This will occur if you haven’t loaded the bookstore
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database with data by running asant create-db_common or if the database
server hasn’t been started or it has crashed.

• BooksNotFoundException—Returned if the bookstore data can’t be
retrieved. This will occur if you haven’t loaded the bookstore database
with data or if the database server hasn’t been started or it has crashed.

• UnavailableException—Returned if a servlet can’t retrieve the Web
context attribute representing the bookstore. This will occur if the database
server hasn’t been started.

Because we have specified an error page, you will see the message The appli-

cation is unavailable. Please try later. If you don’t specify an error
page, the Web container generates a default page containing the message A

Servlet Exception Has Occurred and a stack trace that can help diagnose the
cause of the exception. If you use errorpage.html, you will have to look in the
server log to determine the cause of the exception.

Servlet Life Cycle
The life cycle of a servlet is controlled by the container in which the servlet has
been deployed. When a request is mapped to a servlet, the container performs
the following steps.

1. If an instance of the servlet does not exist, the Web container

a. Loads the servlet class.

b. Creates an instance of the servlet class.

c. Initializes the servlet instance by calling the init method. Initialization
is covered in Initializing a Servlet (page 468).

2. Invokes the service method, passing a request and response object. Ser-
vice methods are discussed in Writing Service Methods (page 468).

If the container needs to remove the servlet, it finalizes the servlet by calling the
servlet’s destroy method. Finalization is discussed in Finalizing a
Servlet (page 489).

Handling Servlet Life Cycle Events
You can monitor and react to events in a servlet’s life cycle by defining listener
objects whose methods get invoked when life cycle events occur. To use these
listener objects you must define the listener class and specify the listener class.
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Defining The Listener Class
You define a listener class as an implementation of a listener interface. Servlet
Life Cycle Events (page 462) lists the events that can be monitored and the cor-
responding interface that must be implemented. When a listener method is
invoked, it is passed an event that contains information appropriate to the event.
For example, the methods in the HttpSessionListener interface are passed an
HttpSessionEvent, which contains an HttpSession.

The listeners.ContextListener class creates and removes the database
helper and counter objects used in the Duke’s Bookstore application. The meth-

Table 11–3 Servlet Life Cycle Events

Object Event Listener Interface and Event Class

Web context
(See Accessing the
Web
Context, page 485)

Initialization and
destruction

javax.servlet.
ServletContextListener and
ServletContextEvent

Attribute added,
removed, or
replaced

javax.servlet.
ServletContextAttributeListener and
ServletContextAttributeEvent

Session
(See Maintaining Cli-
ent State, page 486)

Creation,
invalidation,
activation,
passivation, and
timeout

javax.servlet.http.
HttpSessionListener,
javax.servlet.http.
HttpSessionActivationListener, and
HttpSessionEvent

Attribute added,
removed, or
replaced

javax.servlet.http.
HttpSessionAttributeListener and
HttpSessionBindingEvent

Request

A servlet request
has started being
processed by Web
components

javax.servlet.
ServletRequestListener and
ServletRequestEvent

Attribute added,
removed, or
replaced

javax.servlet.
ServletRequestAttributeListener and
ServletRequestAttributeEvent

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionActivationListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionActivationListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContextListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContextListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContextEvent.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContextAttributeListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContextAttributeListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContextAttributeEvent.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionEvent.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionAttributeListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionAttributeListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionBindingEvent.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestListener.html
../examples/web/bookstore1/src/listeners/ContextListener.java
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestEvent.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestAttributeListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestAttributeListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestAttributeEvent.html
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ods retrieve the Web context object from ServletContextEvent and then store
(and remove) the objects as servlet context attributes.

import database.BookDB;
import javax.servlet.*;
import util.Counter;

public final class ContextListener
implements ServletContextListener {
private ServletContext context = null;
public void contextInitialized(ServletContextEvent event) {

context = event.getServletContext();
try {

BookDB bookDB = new BookDB();
context.setAttribute("bookDB", bookDB);

} catch (Exception ex) {
System.out.println(

"Couldn't create database: " + ex.getMessage());
}
Counter counter = new Counter();
context.setAttribute("hitCounter", counter);
counter = new Counter();
context.setAttribute("orderCounter", counter);

}

public void contextDestroyed(ServletContextEvent event) {
context = event.getServletContext();
BookDB bookDB = context.getAttribute(

"bookDB");
bookDB.remove();
context.removeAttribute("bookDB");
context.removeAttribute("hitCounter");
context.removeAttribute("orderCounter");

}
}

Specifying Event Listener Classes
You specify an event listener class in the Event Listener tab of the WAR inspec-
tor. Review step 11. in The Example Servlets (page 456) for the deploytool

procedure for specifying the ContextListener listener class.
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Handling Errors
Any number of exceptions can occur when a servlet is executed. The Web con-
tainer will generate a default page containing the message A Servlet Excep-

tion Has Occurred when an exception occurs, but you can also specify that the
container should return a specific error page for a given exception. Review step
12. in The Example Servlets (page 456) for deploytool procedures for mapping
the exceptions exception.BookNotFound, exception.BooksNotFound, and
exception.OrderException returned by the Duke’s Bookstore application to
errorpage.html.

Sharing Information
Web components, like most objects, usually work with other objects to accom-
plish their tasks. There are several ways they can do this. They can use private
helper objects (for example, JavaBeans components), they can share objects that
are attributes of a public scope, they can use a database, and they can invoke
other Web resources. The Java Servlet technology mechanisms that allow a Web
component to invoke other Web resources are described in Invoking Other Web
Resources (page 481).

Using Scope Objects
Collaborating Web components share information via objects maintained as
attributes of four scope objects. These attributes are accessed with the
[get|set]Attribute methods of the class representing the scope. Table 11–4
lists the scope objects.

Table 11–4  Scope Objects

Scope
Object Class Accessible From

Web context
javax.servlet.
ServletContext

Web components within a Web context. See
Accessing the Web Context (page 485).

session
javax.servlet.
http.HttpSession

Web components handling a request that belongs to
the session. See Maintaining Client
State (page 486).

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContext.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSession.html
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Figure 11–1 shows the scoped attributes maintained by the Duke’s Bookstore
application.

Figure 11–1 Duke’s Bookstore Scoped Attributes

Controlling Concurrent Access to
Shared Resources
In a multithreaded server, it is possible for shared resources to be accessed con-
currently. Besides scope object attributes, shared resources include in-memory

request
subtype of
javax.servlet.
ServletRequest

Web components handling the request.

page
javax.servlet.
jsp.JspContext

The JSP page that creates the object. See Implicit
Objects (page 510).

Table 11–4  Scope Objects (Continued)

Scope
Object Class Accessible From

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequest.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/JspContext.html
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data such as instance or class variables, and external objects such as files, data-
base connections, and network connections. Concurrent access can arise in sev-
eral situations:

• Multiple Web components accessing objects stored in the Web context

• Multiple Web components accessing objects stored in a session

• Multiple threads within a Web component accessing instance variables. A
Web container will typically create a thread to handle each request. If you
want to ensure that a servlet instance handles only one request at a time, a
servlet can implement the SingleThreadModel interface. If a servlet
implements this interface, you are guaranteed that no two threads will exe-
cute concurrently in the servlet’s service method. A Web container can
implement this guarantee by synchronizing access to a single instance of
the servlet, or by maintaining a pool of Web component instances and dis-
patching each new request to a free instance. This interface does not pre-
vent synchronization problems that result from Web components
accessing shared resources such as static class variables or external
objects. In addition, the Servlet 2.4 specification deprecates SingleTh-

readModel.

When resources can be accessed concurrently, they can be used in an inconsis-
tent fashion. To prevent this, you must control the access using the synchroniza-
tion techniques described in the Threads lesson in The Java Tutorial.

In the previous section we showed five scoped attributes shared by more than
one servlet: bookDB, cart, currency, hitCounter, and orderCounter. The
bookDB attribute is discussed in the next section. The cart, currency, and counters
can be set and read by multiple multithreaded servlets. To prevent these objects
from being used inconsistently, access is controlled by synchronized methods.
For example, here is the util.Counter class:

public class Counter {
private int counter;
public Counter() {

counter = 0;
}
public synchronized int getCounter() {

return counter;
}
public synchronized int setCounter(int c) {

counter = c;
return counter;

}

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/SingleThreadModel.html
http://java.sun.com/docs/books/tutorial/essential/threads/index.html
http://java.sun.com/docs/books/tutorial
../examples/web/bookstore1/src/util/Counter.java
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public synchronized int incCounter() {
return(++counter);

}
}

Accessing Databases
Data that is shared between Web components and is persistent between invoca-
tions of a Web application is usually maintained by a database. Web components
use the JDBC 2.0 API to access relational databases. The data for the bookstore
application is maintained in a database and accessed through the helper class
database.BookDB. For example, ReceiptServlet invokes the BookDB.buy-

Books method to update the book inventory when a user makes a purchase. The
buyBooks method invokes buyBook for each book contained in the shopping
cart. To ensure the order is processed in its entirety, the calls to buyBook are
wrapped in a single JDBC transaction. The use of the shared database connec-
tion is synchronized via the [get|release]Connection methods.

public void buyBooks(ShoppingCart cart) throws OrderException {
Collection items = cart.getItems();
Iterator i = items.iterator();
try {

getConnection();
con.setAutoCommit(false);
while (i.hasNext()) {

ShoppingCartItem sci = (ShoppingCartItem)i.next();
BookDetails bd = (BookDetails)sci.getItem();
String id = bd.getBookId();
int quantity = sci.getQuantity();
buyBook(id, quantity);

}
con.commit();
con.setAutoCommit(true);
releaseConnection();

} catch (Exception ex) {
try {
con.rollback();
releaseConnection();
throw new OrderException("Transaction failed: " +

ex.getMessage());
} catch (SQLException sqx) {

releaseConnection();
throw new OrderException("Rollback failed: " +

../examples/web/bookstore1/src/database/BookDB.java
../examples/web/bookstore1/src/servlets/ReceiptServlet.java
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sqx.getMessage());
}

}
}

Initializing a Servlet
After the Web container loads and instantiates the servlet class and before it
delivers requests from clients, the Web container initializes the servlet. You can
customize this process to allow the servlet to read persistent configuration data,
initialize resources, and perform any other one-time activities by overriding the
init method of the Servlet interface. A servlet that cannot complete its initial-
ization process should throw UnavailableException.

All the servlets that access the bookstore database (BookStoreServlet, Cata-
logServlet, BookDetailsServlet, and ShowCartServlet) initialize a variable
in their init method that points to the database helper object created by the Web
context listener:

public class CatalogServlet extends HttpServlet {
private BookDB bookDB;
public void init() throws ServletException {

bookDB = (BookDB)getServletContext().
getAttribute("bookDB");

if (bookDB == null) throw new
UnavailableException("Couldn't get database.");

}
}

Writing Service Methods
The service provided by a servlet is implemented in the service method of a
GenericServlet, the doMethod methods (where Method can take the value Get,
Delete, Options, Post, Put, Trace) of an HttpServlet, or any other protocol-
specific methods defined by a class that implements the Servlet interface. In the
rest of this chapter, the term service method will be used for any method in a
servlet class that provides a service to a client.

The general pattern for a service method is to extract information from the
request, access external resources, and then populate the response based on that
information.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/Servlet.html
../examples/web/bookstore1/src/servlets/BookStoreServlet.java
../examples/web/bookstore1/src/servlets/CatalogServlet.java
../examples/web/bookstore1/src/servlets/CatalogServlet.java
../examples/web/bookstore1/src/servlets/BookDetailsServlet.java
../examples/web/bookstore1/src/servlets/ShowCartServlet.java
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For HTTP servlets, the correct procedure for populating the response is to first
retrieve an output stream from the response, then fill in the response headers, and
finally write any body content to the output stream. Response headers must
always be set before the response has been committed. Any attempt to set/add
headers after the response has been committed will be ignored by the Web con-
tainer. The next two sections describe how to get information from requests and
generate responses.

Getting Information from Requests
A request contains data passed between a client and the servlet. All requests
implement the ServletRequest interface. This interface defines methods for
accessing the following information:

• Parameters, which are typically used to convey information between cli-
ents and servlets

• Object-valued attributes, which are typically used to pass information
between the servlet container and a servlet or between collaborating serv-
lets

• Information about the protocol used to communicate the request and the
client and server involved in the request

• Information relevant to localization

For example, in CatalogServlet the identifier of the book that a customer
wishes to purchase is included as a parameter to the request. The following code
fragment illustrates how to use the getParameter method to extract the identi-
fier:

String bookId = request.getParameter("Add");
if (bookId != null) {

BookDetails book = bookDB.getBookDetails(bookId);

You can also retrieve an input stream from the request and manually parse the
data. To read character data, use the BufferedReader object returned by the
request’s getReader method. To read binary data, use the ServletInputStream

returned by getInputStream.

HTTP servlets are passed an HTTP request object, HttpServletRequest, which
contains the request URL, HTTP headers, query string, and so on.

An HTTP request URL contains the following parts:

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpServletRequest.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequest.html
../examples/web/bookstore1/src/servlets/CatalogServlet.java
http://java.sun.com/j2se/1.4/docs/api/java/io/BufferedReader.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletInputStream.html
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http://[host]:[port][request path]?[query string]

The request path is further composed of the following elements:

• Context path: A concatenation of a forward slash / with the context root
of the servlet’s Web application.

• Servlet path: The path section that corresponds to the component alias
that activated this request. This path starts with a forward slash /.

• Path info: The part of the request path that is not part of the context path
or the servlet path.

If the context path is /catalog and for the aliases listed in Table 11–5, Table 11–
6 gives some examples of how the URL will be parsed.

Query strings are composed of a set of parameters and values. Individual param-
eters are retrieved from a request with the getParameter method. There are two
ways to generate query strings:

• A query string can explicitly appear in a Web page. For example, an
HTML page generated by the CatalogServlet could contain the link
<a href="/bookstore1/catalog?Add=101">Add To Cart</a>. Cata-
logServlet extracts the parameter named Add as follows:

String bookId = request.getParameter("Add");

Table 11–5 Aliases

Pattern Servlet

/lawn/* LawnServlet

/*.jsp JSPServlet

Table 11–6 Request Path Elements

Request Path Servlet Path Path Info

/catalog/lawn/index.html /lawn /index.html

/catalog/help/feedback.jsp /help/feedback.jsp null

../examples/web/bookstore1/src/servlets/CatalogServlet.java


CONSTRUCTING RESPONSES 471
• A query string is appended to a URL when a form with a GET HTTP
method is submitted. In the Duke’s Bookstore application, CashierServ-
let generates a form, then a user name input to the form is appended to the
URL that maps to ReceiptServlet, and finally ReceiptServlet extracts
the user name using the getParameter method.

Constructing Responses
A response contains data passed between a server and the client. All responses
implement the ServletResponse interface. This interface defines methods that
allow you to do the following:

• Retrieve an output stream to use to send data to the client. To send charac-
ter data, use the PrintWriter returned by the response’s getWriter

method. To send binary data in a MIME body response, use the Serv-

letOutputStream returned by getOutputStream. To mix binary and text
data, for example, to create a multipart response, use a ServletOutput-

Stream and manage the character sections manually.

• Indicate the content type (for example, text/html), being returned by the
response with the setContentType(String) method. This method must
be called before the response is committed. A registry of content type
names is kept by the Internet Assigned Numbers Authority (IANA) at:
http://www.iana.org/assignments/media-types/

• Indicate whether to buffer output with the setBufferSize(int) method.
By default, any content written to the output stream is immediately sent to
the client. Buffering allows content to be written before anything is actu-
ally sent back to the client, thus providing the servlet with more time to set
appropriate status codes and headers or forward to another Web resource.
The method must be called before any content is written or the response is

committed.

• Set localization information such as locale and character encoding. See
Chapter 17 for details.

HTTP response objects, HttpServletResponse, have fields representing HTTP
headers such as

• Status codes, which are used to indicate the reason a request is not satisfied
or that a request has been redirected.

../examples/web/bookstore1/src/servlets/CashierServlet.java
../examples/web/bookstore1/src/servlets/CashierServlet.java
../examples/web/bookstore1/src/servlets/ReceiptServlet.java
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletResponse.html
http://java.sun.com/j2se/1.4/docs/api/java/io/PrintWriter.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletOutputStream.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletOutputStream.html
http://www.iana.org/assignments/media-types/
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpServletResponse.html
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• Cookies, which are used to store application-specific information at the cli-
ent. Sometimes cookies are used to maintain an identifier for tracking a
user’s session (see Session Tracking, page 488).

In Duke’s Bookstore, BookDetailsServlet generates an HTML page that dis-
plays information about a book that the servlet retrieves from a database. The
servlet first sets response headers: the content type of the response and the buffer
size. The servlet buffers the page content because the database access can gener-
ate an exception that would cause forwarding to an error page. By buffering the
response, the client will not see a concatenation of part of a Duke’s Bookstore
page with the error page should an error occur. The doGet method then retrieves
a PrintWriter from the response.

For filling in the response, the servlet first dispatches the request to BannerServ-

let, which generates a common banner for all the servlets in the application.
This process is discussed in Including Other Resources in the
Response (page 482). Then the servlet retrieves the book identifier from a
request parameter and uses the identifier to retrieve information about the book
from the bookstore database. Finally, the servlet generates HTML markup that
describes the book information and commits the response to the client by calling
the close method on the PrintWriter.

public class BookDetailsServlet extends HttpServlet {
 public void doGet (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

// set headers before accessing the Writer
response.setContentType("text/html");
response.setBufferSize(8192);
PrintWriter out = response.getWriter();

// then write the response
out.println("<html>" +

"<head><title>+
messages.getString("TitleBookDescription")
+</title></head>");

// Get the dispatcher; it gets the banner to the user
RequestDispatcher dispatcher =

getServletContext().
getRequestDispatcher("/banner");

if (dispatcher != null)
dispatcher.include(request, response);

//Get the identifier of the book to display
String bookId = request.getParameter("bookId");

../examples/web/bookstore1/src/servlets/BookDetailsServlet.java
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if (bookId != null) {
// and the information about the book
try {

BookDetails bd =
bookDB.getBookDetails(bookId);

...
//Print out the information obtained
out.println("<h2>" + bd.getTitle() + "</h2>" +
...

} catch (BookNotFoundException ex) {
response.resetBuffer();
throw new ServletException(ex);

}
}
out.println("</body></html>");
out.close();

}
}
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BookDetailsServlet generates a page that looks like:

Figure 11–2 Book Details

Filtering Requests and Responses
A filter is an object that can transform the header and content (or both) of a
request or response. Filters differ from Web components in that they usually do
not themselves create a response. Instead, a filter provides functionality that can
be “attached” to any kind of Web resource. As a consequence, a filter should not
have any dependencies on a Web resource for which it is acting as a filter, so that
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it can be composable with more than one type of Web resource. The main tasks
that a filter can perform are as follows:

• Query the request and act accordingly.

• Block the request and response pair from passing any further.

• Modify the request headers and data. You do this by providing a custom-
ized version of the request.

• Modify the response headers and data. You do this by providing a custom-
ized version of the response.

• Interact with external resources.

Applications of filters include authentication, logging, image conversion, data
compression, encryption, tokenizing streams, and XML transformations, and so
on.

You can configure a Web resource to be filtered by a chain of zero, one, or more
filters in a specific order. This chain is specified when the Web application con-
taining the component is deployed and is instantiated when a Web container
loads the component.

In summary, the tasks involved in using filters include

• Programming the filter

• Programming customized requests and responses

• Specifying the filter chain for each Web resource

Programming Filters
The filtering API is defined by the Filter, FilterChain, and FilterConfig

interfaces in the javax.servlet package. You define a filter by implementing
the Filter interface. The most important method in this interface is the doFil-

ter method, which is passed request, response, and filter chain objects. This
method can perform the following actions:

• Examine the request headers.

• Customize the request object if it wishes to modify request headers or data.

• Customize the response object if it wishes to modify response headers or
data.

• Invoke the next entity in the filter chain. If the current filter is the last filter
in the chain that ends with the target Web component or static resource, the
next entity is the resource at the end of the chain; otherwise, it is the next

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/Filter.html
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filter that was configured in the WAR. It invokes the next entity by calling
the doFilter method on the chain object (passing in the request and
response it was called with, or the wrapped versions it may have created).
Alternatively, it can choose to block the request by not making the call to
invoke the next entity. In the latter case, the filter is responsible for filling
out the response.

• Examine response headers after it has invoked the next filter in the chain

• Throw an exception to indicate an error in processing

In addition to doFilter, you must implement the init and destroy methods.
The init method is called by the container when the filter is instantiated. If you
wish to pass initialization parameters to the filter, you retrieve them from the
FilterConfig object passed to init.

The Duke’s Bookstore application uses the filters HitCounterFilter and
OrderFilter to increment and log the value of a counter when the entry and
receipt servlets are accessed.

In the doFilter method, both filters retrieve the servlet context from the filter
configuration object so that they can access the counters stored as context
attributes. After the filters have completed application-specific processing, they
invoke doFilter on the filter chain object passed into the original doFilter
method. The elided code is discussed in the next section.

public final class HitCounterFilter implements Filter {
private FilterConfig filterConfig = null;

public void init(FilterConfig filterConfig)
throws ServletException {
this.filterConfig = filterConfig;

}
public void destroy() {

this.filterConfig = null;
}
public void doFilter(ServletRequest request,

ServletResponse response, FilterChain chain)
throws IOException, ServletException {
if (filterConfig == null)

return;
StringWriter sw = new StringWriter();
PrintWriter writer = new PrintWriter(sw);
Counter counter = (Counter)filterConfig.

getServletContext().
getAttribute("hitCounter");

writer.println();

../examples/web/bookstore1/src/filters/HitCounterFilter.java
../examples/web/bookstore1/src/filters/OrderFilter.java
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writer.println("===============");
writer.println("The number of hits is: " +

counter.incCounter());
writer.println("===============");
// Log the resulting string
writer.flush();
System.out.println(sw.getBuffer().toString());
...
chain.doFilter(request, wrapper);
...

}
}

Programming Customized Requests and
Responses
There are many ways for a filter to modify a request or response. For example, a
filter could add an attribute to the request or insert data in the response. In the
Duke’s Bookstore example, HitCounterFilter inserts the value of the counter
into the response.

A filter that modifies a response must usually capture the response before it is
returned to the client. The way to do this is to pass a stand-in stream to the
servlet that generates the response. The stand-in stream prevents the servlet from
closing the original response stream when it completes and allows the filter to
modify the servlet’s response.

To pass this stand-in stream to the servlet, the filter creates a response wrapper
that overrides the getWriter or getOutputStream method to return this stand-in
stream. The wrapper is passed to the doFilter method of the filter chain. Wrap-
per methods default to calling through to the wrapped request or response object.
This approach follows the well-known Wrapper or Decorator pattern described
in Design Patterns, Elements of Reusable Object-Oriented Software (Addison-
Wesley, 1995). The following sections describe how the hit counter filter
described earlier and other types of filters use wrappers.

To override request methods, you wrap the request in an object that extends
ServletRequestWrapper or HttpServletRequestWrapper. To override
response methods, you wrap the response in an object that extends ServletRe-
sponseWrapper or HttpServletResponseWrapper.

HitCounterFilter wraps the response in a CharResponseWrapper. The
wrapped response is passed to the next object in the filter chain, which is Book-

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequestWrapper.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpServletRequestWrapper.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletResponseWrapper.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletResponseWrapper.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpServletResponseWrapper.html
../examples/web/bookstore1/src/filters/CharResponseWrapper.java
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StoreServlet. BookStoreServlet writes its response into the stream created
by CharResponseWrapper. When chain.doFilter returns, HitCounterFilter
retrieves the servlet’s response from PrintWriter and writes it to a buffer. The
filter inserts the value of the counter into the buffer, resets the content length
header of the response, and finally writes the contents of the buffer to the
response stream.

PrintWriter out = response.getWriter();
CharResponseWrapper wrapper = new CharResponseWrapper(

(HttpServletResponse)response);
chain.doFilter(request, wrapper);
CharArrayWriter caw = new CharArrayWriter();
caw.write(wrapper.toString().substring(0,

wrapper.toString().indexOf("</body>")-1));
caw.write("<p>\n<center>" +

messages.getString("Visitor") + "<font color='red'>" +
counter.getCounter() + "</font></center>");

caw.write("\n</body></html>");
response.setContentLength(caw.toString().getBytes().length);
out.write(caw.toString());
out.close();

public class CharResponseWrapper extends
HttpServletResponseWrapper {
private CharArrayWriter output;
public String toString() {

return output.toString();
}
public CharResponseWrapper(HttpServletResponse response){

super(response);
output = new CharArrayWriter();

}
public PrintWriter getWriter(){

return new PrintWriter(output);
}

}
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Figure 11–3 shows the entry page for Duke’s Bookstore with the hit counter.

Figure 11–3 Duke’s Bookstore

Specifying Filter Mappings
A Web container uses filter mappings to decide how to apply filters to Web
resources. A filter mapping matches a filter to a Web component by name or to
Web resources by URL pattern. The filters are invoked in the order in which fil-
ter mappings appear in the filter mapping list of a WAR. You specify a filter
mapping list for a WAR using a deploytool or by coding them directly in the
Web application deployment descriptor as follows
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• Declare the filter. This element creates a name for the filter and declares
the filter’s implementation class and initialization parameters.

• Map the filter to a Web resource by name or by URL pattern.

• Constrain how the filter will be applied to requests by choosing one of the
enumerated dispatcher options:

• REQUEST-Only when the request come directly from the client.

• FORWARD-Only when the request has been forwarded to a component
(see Transferring Control to Another Web Component, page 484).

• INCLUDE-Only when the request is being processed by a component that
has been included (see Including Other Resources in the
Response, page 482).

• ERROR-Only when the request is being processed with the error page
mechanism (see Handling Errors, page 464).

You can direct the filter to be applied in any combination of the preceding
situations by including multiple dispatcher elements. If no elements are
specified, the default option is REQUEST.

If you want to log every request to a Web application, you would map the hit
counter filter to the URL pattern /*. Step 13. in The Example
Servlets (page 456) shows how to create and map the filters for the Duke’s
Bookstore application. Table 11–7 summarizes the filter definition and mapping
list for the Duke’s Bookstore application. The filters are matched by servlet
name and each filter chain contains only one filter.

You can map a filter to one or more Web resources and you can map more than
one filter to a Web resource. This is illustrated in Figure 11–4, where filter F1 is

Table 11–7 Duke’s Bookstore Filter Definition and Mapping List

Filter Class Servlet

HitCounterFilter filters.HitCounterFilter BookStoreServlet

OrderFilter filters.OrderFilter ReceiptServlet
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mapped to servlets S1, S2, and S3, filter F2 is mapped to servlet S2, and filter F3
is mapped to servlets S1 and S2.

Figure 11–4 Filter to Servlet Mapping

Recall that a filter chain is one of the objects passed to the doFilter method of a
filter. This chain is formed indirectly via filter mappings. The order of the filters
in the chain is the same as the order in which filter mappings appear in the Web
application deployment descriptor.

When a filter is mapped to servlet S1, the Web container invokes the doFilter

method of F1. The doFilter method of each filter in S1’s filter chain is invoked
by the preceding filter in the chain via the chain.doFilter method. Since S1’s
filter chain contains filters F1 and F3, F1’s call to chain.doFilter invokes the
doFilter method of filter F3. When F3’s doFilter method completes, control
returns to F1’s doFilter method.

Invoking Other Web Resources
Web components can invoke other Web resources in two ways: indirectly and
directly. A Web component indirectly invokes another Web resource when it
embeds a URL that points to another Web component in content returned to a
client. In the Duke’s Bookstore application, most Web components contain
embedded URLs that point to other Web components. For example, ShowCart-
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Servlet indirectly invokes the CatalogServlet through the embedded URL /

bookstore1/catalog.

A Web component can also directly invoke another resource while it is execut-
ing. There are two possibilities: it can include the content of another resource, or
it can forward a request to another resource.

To invoke a resource available on the server that is running a Web component,
you must first obtain a RequestDispatcher object using the getRequestDis-

patcher("URL") method.

You can get a RequestDispatcher object from either a request or the Web con-
text, however, the two methods have slightly different behavior. The method
takes the path to the requested resource as an argument. A request can take a rel-
ative path (that is, one that does not begin with a /), but the Web context requires
an absolute path. If the resource is not available, or if the server has not imple-
mented a RequestDispatcher object for that type of resource, getRequestDis-
patcher will return null. Your servlet should be prepared to deal with this
condition.

Including Other Resources in the
Response
It is often useful to include another Web resource, for example, banner content or
copyright information, in the response returned from a Web component. To
include another resource, invoke the include method of a RequestDispatcher

object:

include(request, response);

If the resource is static, the include method enables programmatic server-side
includes. If the resource is a Web component, the effect of the method is to send
the request to the included Web component, execute the Web component, and
then include the result of the execution in the response from the containing serv-
let. An included Web component has access to the request object, but it is limited
in what it can do with the response object:

• It can write to the body of the response and commit a response.

• It cannot set headers or call any method (for example, setCookie) that
affects the headers of the response.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/RequestDispatcher.html
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The banner for the Duke’s Bookstore application is generated by BannerServ-

let. Note that both the doGet and doPost methods are implemented because
BannerServlet can be dispatched from either method in a calling servlet.

public class BannerServlet extends HttpServlet {
public void doGet (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

PrintWriter out = response.getWriter();
out.println("<body bgcolor=\"#ffffff\">" +
"<center>" + "<hr> <br> &nbsp;" + "<h1>" +
"<font size=\"+3\" color=\"#CC0066\">Duke's </font>" +
<img src=\"" + request.getContextPath() +
"/duke.books.gif\">" +
"<font size=\"+3\" color=\"black\">Bookstore</font>" +
"</h1>" + "</center>" + "<br> &nbsp; <hr> <br> ");

}
public void doPost (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

PrintWriter out = response.getWriter();
out.println("<body bgcolor=\"#ffffff\">" +
"<center>" + "<hr> <br> &nbsp;" + "<h1>" +
"<font size=\"+3\" color=\"#CC0066\">Duke's </font>" +
<img src=\"" + request.getContextPath() +
"/duke.books.gif\">" +
"<font size=\"+3\" color=\"black\">Bookstore</font>" +
"</h1>" + "</center>" + "<br> &nbsp; <hr> <br> ");

}
}

Each servlet in the Duke’s Bookstore application includes the result from Ban-

nerServlet with the following code:

RequestDispatcher dispatcher =
getServletContext().getRequestDispatcher("/banner");

if (dispatcher != null)
dispatcher.include(request, response);

}

../examples/web/bookstore1/src/servlets/BannerServlet.java
../examples/web/bookstore1/src/servlets/BannerServlet.java
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Transferring Control to Another Web
Component
In some applications, you might want to have one Web component do prelimi-
nary processing of a request and have another component generate the response.
For example, you might want to partially process a request and then transfer to
another component depending on the nature of the request.

To transfer control to another Web component, you invoke the forward method
of a RequestDispatcher. When a request is forwarded, the request URI is set to
the path of the forwarded page. The original URI and its constituent parts are
saved as a request attributes javax.servlet.forward.[request_uri|con-

text-path|servlet_path|path_info|query_string]. The Dispatcher serv-
let, used by a version of the Duke’s Bookstore application described in The
Example JSP Pages (page 588), saves the path information from the original
URL, retrieves a RequestDispatcher from the request, and then forwards to the
JSP page template.jsp.

public class Dispatcher extends HttpServlet {
public void doGet(HttpServletRequest request,

HttpServletResponse response) {
RequestDispatcher dispatcher = request.

getRequestDispatcher("/template.jsp");
if (dispatcher != null)

dispatcher.forward(request, response);
}
public void doPost(HttpServletRequest request,
...

}

The forward method should be used to give another resource responsibility for
replying to the user. If you have already accessed a ServletOutputStream or
PrintWriter object within the servlet, you cannot use this method; it throws an
IllegalStateException.

../examples/web/bookstore2/src/Dispatcher.java
../examples/web/bookstore3/web/template/template.txt
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Accessing the Web Context
The context in which Web components execute is an object that implements the
ServletContext interface. You retrieve the Web context with the getServlet-

Context method. The Web context provides methods for accessing:

• Initialization parameters

• Resources associated with the Web context

• Object-valued attributes

• Logging capabilities

The Web context is used by the Duke’s Bookstore filters filters.HitCounter-
Filter and OrderFilter, which were discussed in Filtering Requests and
Responses (page 474). The filters store a counter as a context attribute. Recall
from Controlling Concurrent Access to Shared Resources (page 465) that the
counter’s access methods are synchronized to prevent incompatible operations
by servlets that are running concurrently. A filter retrieves the counter object
with the context’s getAttribute method. The incremented value of the counter
is recorded in the log.

public final class HitCounterFilter implements Filter {
private FilterConfig filterConfig = null;
public void doFilter(ServletRequest request,

ServletResponse response, FilterChain chain)
throws IOException, ServletException {
...
StringWriter sw = new StringWriter();
PrintWriter writer = new PrintWriter(sw);
ServletContext context = filterConfig.

getServletContext();
Counter counter = (Counter)context.

getAttribute("hitCounter");
...
writer.println("The number of hits is: " +

counter.incCounter());
...
System.out.println(sw.getBuffer().toString());
...

}
}

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletContext.html
../examples/web/bookstore1/src/filters/HitCounterFilter.java
../examples/web/bookstore1/src/filters/HitCounterFilter.java


486 JAVA SERVLET TECHNOLOGY
Maintaining Client State
Many applications require a series of requests from a client to be associated with
one another. For example, the Duke’s Bookstore application saves the state of a
user’s shopping cart across requests. Web-based applications are responsible for
maintaining such state, called a session, because the HTTP protocol is stateless.
To support applications that need to maintain state, Java Servlet technology pro-
vides an API for managing sessions and allows several mechanisms for imple-
menting sessions.

Accessing a Session
Sessions are represented by an HttpSession object. You access a session by
calling the getSession method of a request object. This method returns the cur-
rent session associated with this request, or, if the request does not have a ses-
sion, it creates one.

Associating Attributes with a Session
You can associate object-valued attributes with a session by name. Such
attributes are accessible by any Web component that belongs to the same Web
context and is handling a request that is part of the same session.

The Duke’s Bookstore application stores a customer’s shopping cart as a session
attribute. This allows the shopping cart to be saved between requests and also
allows cooperating servlets to access the cart. CatalogServlet adds items to the
cart; ShowCartServlet displays, deletes items from, and clears the cart; and
CashierServlet retrieves the total cost of the books in the cart.

public class CashierServlet extends HttpServlet {
public void doGet (HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

// Get the user's session and shopping cart
HttpSession session = request.getSession();
ShoppingCart cart =

(ShoppingCart)session.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSession.html
../examples/web/bookstore1/src/servlets/CatalogServlet.java
../examples/web/bookstore1/src/servlets/ShowCartServlet.java
../examples/web/bookstore1/src/servlets/CashierServlet.java
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getAttribute("cart");
...
// Determine the total price of the user's books
double total = cart.getTotal();

Notifying Objects That Are Associated with a
Session
Recall that your application can notify Web context and session listener objects
of servlet life cycle events (Handling Servlet Life Cycle Events, page 461). You
can also notify objects of certain events related to their association with a session
such as the following:

• When the object is added to or removed from a session. To receive this
notification, your object must implement the javax.http.HttpSession-

BindingListener interface.

• When the session to which the object is attached will be passivated or acti-
vated. A session will be passivated or activated when it is moved between
virtual machines or saved to and restored from persistent storage. To
receive this notification, your object must implement the
javax.http.HttpSessionActivationListener interface.

Session Management
Since there is no way for an HTTP client to signal that it no longer needs a ses-
sion, each session has an associated timeout so that its resources can be
reclaimed. The timeout period can be accessed with a session’s [get|set]MaxI-
nactiveInterval methods. You can also set the time-out period with deploy-

tool:

1. Select the WAR.

2. Select the General tab.

3. Click the Advanced Setting button.

4. Enter the time-out period in the Session timeout field.

To ensure that an active session is not timed out, you should periodically access
the session via service methods because this resets the session’s time-to-live
counter.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionBindingListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionBindingListener.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/http/HttpSessionActivationListener.html


488 JAVA SERVLET TECHNOLOGY
When a particular client interaction is finished, you use the session’s invali-

date method to invalidate a session on the server side and remove any session
data.

The bookstore application’s ReceiptServlet is the last servlet to access a cli-
ent’s session, so it has responsibility for invalidating the session:

public class ReceiptServlet extends HttpServlet {
public void doPost(HttpServletRequest request,

HttpServletResponse response)
throws ServletException, IOException {

// Get the user's session and shopping cart
HttpSession session = request.getSession();
// Payment received -- invalidate the session
session.invalidate();
...

Session Tracking
A Web container can use several methods to associate a session with a user, all of
which involve passing an identifier between the client and server. The identifier
can be maintained on the client as a cookie or the Web component can include
the identifier in every URL that is returned to the client.

If your application makes use of session objects, you must ensure that session
tracking is enabled by having the application rewrite URLs whenever the client
turns off cookies. You do this by calling the response’s encodeURL(URL) method
on all URLs returned by a servlet. This method includes the session ID in the
URL only if cookies are disabled; otherwise, it returns the URL unchanged.

The doGet method of ShowCartServlet encodes the three URLs at the bottom
of the shopping cart display page as follows:

out.println("<p> &nbsp; <p><strong><a href=\"" +
response.encodeURL(request.getContextPath() +

"/bookcatalog") +
"\">" + messages.getString("ContinueShopping") +
"</a> &nbsp; &nbsp; &nbsp;" +
"<a href=\"" +

response.encodeURL(request.getContextPath() +
"/bookcashier") +
"\">" + messages.getString("Checkout") +
"</a> &nbsp; &nbsp; &nbsp;" +
"<a href=\"" +

../examples/web/bookstore1/src/servlets/ReceiptServlet.java
../examples/web/bookstore1/src/servlets/ShowCartServlet.java
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response.encodeURL(request.getContextPath() +
"/bookshowcart?Clear=clear") +
"\">" + messages.getString("ClearCart") +
"</a></strong>");

If cookies are turned off, the session is encoded in the Check Out URL as fol-
lows:

http://localhost:8080/bookstore1/cashier;
jsessionid=c0o7fszeb1

If cookies are turned on, the URL is simply

http://localhost:8080/bookstore1/cashier

Finalizing a Servlet
When a servlet container determines that a servlet should be removed from ser-
vice (for example, when a container wants to reclaim memory resources, or
when it is being shut down), it calls the destroy method of the Servlet inter-
face. In this method, you release any resources the servlet is using and save any
persistent state. The following destroy method releases the database object cre-
ated in the init method described in Initializing a Servlet (page 468):

public void destroy() {
bookDB = null;

}

All of a servlet’s service methods should be complete when a servlet is removed.
The server tries to ensure this by calling the destroy method only after all ser-
vice requests have returned, or after a server-specific grace period, whichever
comes first. If your servlet has operations that take a long time to run (that is,
operations that may run longer than the server’s grace period), the operations
could still be running when destroy is called. You must make sure that any
threads still handling client requests complete; the remainder of this section
describes how to:

• Keep track of how many threads are currently running the service method

• Provide a clean shutdown by having the destroy method notify long-run-
ning threads of the shutdown and wait for them to complete

• Have the long-running methods poll periodically to check for shutdown
and, if necessary, stop working, clean up, and return
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Tracking Service Requests
To track service requests, include in your servlet class a field that counts the
number of service methods that are running. The field should have synchronized
access methods to increment, decrement, and return its value.

public class ShutdownExample extends HttpServlet {
private int serviceCounter = 0;
...
//Access methods for serviceCounter
protected synchronized void enteringServiceMethod() {

serviceCounter++;
}
protected synchronized void leavingServiceMethod() {

serviceCounter--;
}
protected synchronized int numServices() {

return serviceCounter;
}

}

The service method should increment the service counter each time the method
is entered and should decrement the counter each time the method returns. This
is one of the few times that your HttpServlet subclass should override the ser-

vice method. The new method should call super.service to preserve all of the
original service method’s functionality:

protected void service(HttpServletRequest req,
HttpServletResponse resp)
throws ServletException,IOException {

enteringServiceMethod();
try {

super.service(req, resp);
} finally {

leavingServiceMethod();
}

}

Notifying Methods to Shut Down
To ensure a clean shutdown, your destroy method should not release any shared
resources until all of the service requests have completed. One part of doing this
is to check the service counter. Another part is to notify the long-running meth-
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ods that it is time to shut down. For this notification another field is required. The
field should have the usual access methods:

public class ShutdownExample extends HttpServlet {
private boolean shuttingDown;
...
//Access methods for shuttingDown
protected synchronized void setShuttingDown(boolean flag) {

shuttingDown = flag;
}
protected synchronized boolean isShuttingDown() {

return shuttingDown;
}

}

An example of the destroy method using these fields to provide a clean shut-
down follows:

public void destroy() {
/* Check to see whether there are still service methods /*
/* running, and if there are, tell them to stop. */
if (numServices() > 0) {

setShuttingDown(true);
}

/* Wait for the service methods to stop. */
while(numServices() > 0) {

try {
Thread.sleep(interval);

} catch (InterruptedException e) {
}

}
}

Creating Polite Long-Running Methods
The final step in providing a clean shutdown is to make any long-running meth-
ods behave politely. Methods that might run for a long time should check the
value of the field that notifies them of shutdowns and should interrupt their work,
if necessary.

public void doPost(...) {
...
for(i = 0; ((i < lotsOfStuffToDo) &&

!isShuttingDown()); i++) {
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try {
partOfLongRunningOperation(i);

} catch (InterruptedException e) {
...

}
}

}

Further Information
For further information on Java Servlet technology see:

• Java Servlet 2.4 Specification
http://java.sun.com/products/servlet/download.html#specs

• The Java Servlets Web site
http://java.sun.com/products/servlet

http://java.sun.com/products/servlet/download.html#specs
http://java.sun.com/products/servlet
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JavaServer Pages
Technology

JAVASERVER Pages (JSP) technology allows you to easily create Web content
that has both static and dynamic components. JSP technology makes available
all the dynamic capabilities of Java Servlet technology but provides a more natu-
ral approach to creating static content. The main features of JSP technology are

• A language for developing JSP pages, which are text-based documents that
describe how to process a request and construct a response

• An expression language for accessing server-side objects

• Mechanisms for defining extensions to the JSP language

JSP technology also contains an API that is used by developers of Web contain-
ers, but this API is not covered in this tutorial.

What Is a JSP Page?
A JSP page is a text document that contains two types of text: static template
data, which can be expressed in any text-based format, such as HTML, SVG,
WML, and XML, and JSP elements, which construct dynamic content.

The recommended file extension for the source file of a JSP page is .jsp. The
page may be composed of a top file that includes other files that contain either a

http://www.w3.org/MarkUp
http://www.w3.org/TR/SVG
http://www.oasis-open.org/cover/wap-wml.html
http://www.w3.org/TR/REC-xml
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complete JSP page or a fragment of a JSP page. The recommended extension for
the source file of a fragment of a JSP page is .jspf.

The JSP elements in a JSP page can be expressed in two syntaxes—standard and
XML—though any given file can only use one syntax. A JSP page in XML syn-
tax is an XML document and can be manipulated by tools and APIs for XML
documents. This chapter and chapters through 16 document only the standard
syntax. The JSP XML syntax is covered in Chapter 13. A syntax card and refer-
ence that summarizes both syntaxes is available at

http://java.sun.com/products/jsp/docs.html#syntax

Example
The Web page in Figure 12–1 is a form that allows you to select a locale and dis-
plays the date in a manner appropriate to the locale.

Figure 12–1 Localized Date Form

The source code for this example is in the <INSTALL>/j2eetutorial14/

examples/web/date/ directory. The JSP page, index.jsp, used to create the
form appears below; it is a typical mixture of static HTML markup and JSP ele-
ments. If you have developed Web pages, you are probably familiar with the
HTML document structure statements (<head>, <body>, and so on) and the
HTML statements that create a form (<form>) and a menu (<select>).

http://java.sun.com/products/jsp/docs.html#syntax
../examples/web/date/web/index.txt
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The lines in bold in the example code contain the following types of JSP con-
structs:

• A page directive (<%@page ... %>) sets the content type returned by the
page.

• Tag library directives (<%@taglib ... %>) import custom tag libraries.

• jsp:useBean creates an object containing a collection of locales and ini-
tializes an identifier that points to that object.

• JSP expression language expressions (${ }) retrieve the value of object
properties. The value of an are used to set tag attribute values.

• Custom tags set a variable (c:set), iterate over a collection of locale
names (c:forEach), and conditionally insert HTML text into the response
(c:if, c:choose, c:when, c:otherwise).

• jsp:setProperty sets the value of an object property.

• A function (f:equals) tests the equality of an attribute and the current
item of a collection. (Note: a built-in == operator is usually used to test
equality).

<%@ page contentType="text/html; charset=UTF-8" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core"

prefix="c" %>
<%@ taglib uri="/functions" prefix="f" %>
<html>
<head><title>Localized Dates</title></head>
<body bgcolor="white">
<jsp:useBean id="locales" scope="application"

class="mypkg.MyLocales"/>

<form name="localeForm" action="index.jsp" method="post">
<c:set var="selectedLocaleString" value="${param.locale}" />
<c:set var="selectedFlag"

value="${!empty selectedLocaleString}" />
<b>Locale:</b>
<select name=locale>
<c:forEach var="localeString" items="${locales.localeNames}" >
<c:choose>

<c:when test="${selectedFlag}">
<c:choose>

<c:when
test="${f:equals(selectedLocaleString,

localeString)}" >
<option selected>${localeString}</option>

</c:when>
<c:otherwise>
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<option>${localeString}</option>
</c:otherwise>

</c:choose>
</c:when>
<c:otherwise>

<option>${localeString}</option>
</c:otherwise>

</c:choose>
</c:forEach>
</select>
<input type="submit" name="Submit" value="Get Date">
</form>

<c:if test="${selectedFlag}" >
<jsp:setProperty name="locales"

property="selectedLocaleString"
value="${selectedLocaleString}" />

<jsp:useBean id="date" class="mypkg.MyDate"/>
<jsp:setProperty name="date" property="locale"

value="${locales.selectedLocale}"/>
<b>Date: </b>${date.date}

</c:if>
</body>
</html>

A sample date.war is provided in <INSTALL>/j2eetutorial14/examples/

web/provided-wars/. To build, package, deploy, and execute this example:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/date/.

2. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/date/

build/ directory.

3. Start the J2EE application server.

4. Start deploytool.

5. Create a Web application called date by running the New Web Component
Wizard. Select File→New→Web Component.

6. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. In the WAR Location field, enter <INSTALL>/docs/tutorial/

examples/web/date/date.war.

c. In the WAR Name field, enter date.

d. In the Context Root field, enter /date.
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e. Click Edit.

f. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/date/build/. Select the index.jsp JSP page and the
mypkg package and click Add, then click OK.

g. Click Next.

h. Select the JSP radio button.

i. Click Next.

j. Select index.jsp from the JSP file combo box.

k. Click Finish.

7. Select File→Save.

8. Deploy the application.

a. Select Tools→Deploy.

b. In the Connection Settings frame, enter the user name and password you
specified when you installed the J2EE 1.4 Application Server.

c. Click OK.

d. A popup dialog will display the results of the deployment. Click Close.

9. Set the character encoding in your browser to UTF-8.

10.Open the URL http://localhost:8080/date in a browser.

You will see a combo box whose entries are locales. Select a locale and click Get
Date. You will see the date expressed in a manner appropriate for that locale.

The Example JSP Pages
To illustrate JSP technology, this chapter rewrites each servlet in the Duke’s
Bookstore application introduced in The Example Servlets (page 456) as a JSP
page:

Table 12–1 Duke’s Bookstore Example JSP Pages

Function JSP Pages

Enter the bookstore bookstore.jsp

Create the bookstore banner banner.jsp



498 JAVASERVER PAGES TECHNOLOGY
The data for the bookstore application is still maintained in a database. However,
two changes are made to the database helper object database.BookDB:

• The database helper object is rewritten to conform to JavaBeans compo-
nent design patterns as described in JavaBeans Component Design
Conventions (page 519). This change is made so that JSP pages can access
the helper object using JSP language elements specific to JavaBeans com-
ponents.

• Instead of accessing the bookstore database directly, the helper object goes
through a data access object database.BookDBAO.

The implementation of the database helper object follows. The bean has two
instance variables: the current book and the data access object.

package database;
public class BookDB {

private String bookId = "0";
private BookDBAO database = null;

public BookDB () throws Exception {
}
public void setBookId(String bookId) {

this.bookId = bookId;
}

Browse the books offered for sale bookcatalog.jsp

Add a book to the shopping cart bookcatalog.jsp and bookdetails.jsp

Get detailed information on a specific
book

bookdetails.jsp

Display the shopping cart bookshowcart.jsp

Remove one or more books from the
shopping cart

bookshowcart.jsp

Buy the books in the shopping cart bookcashier.jsp

Receive an acknowledgement for the
purchase

bookreceipt.jsp

Table 12–1 Duke’s Bookstore Example JSP Pages (Continued)

Function JSP Pages

../examples/web/bookstore2/src/database/BookDB.java
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public void setDatabase(BookDAO database) {
this.database = database;

}
public BookDetails getBookDetails()

throws Exception {
return (BookDetails)database.getBookDetails(bookId);

}
...

}

This version of the Duke’s Bookstore application is organized along the Model-
View-Controller (MVC) architecture. The MVC architecture is a widely-used
architectural approach for interactive applications that separates functionality
among application objects so as to minimize the degree of coupling between the
objects. To achieve this, it divides applications into three layers: model, view,
and controller. Each layer handles specific tasks and has responsibilities to the
other layers:

• The model represents business data and business logic or operations that
govern access and modification of this business data. The model notifies
views when it changes and provides the ability for the view to query the
model about its state. It also provides the ability for the controller to access
application functionality encapsulated by the model. In the Duke’s Book-
store application, the shopping cart and database helper object contain the
business logic for the application.

• The view renders the contents of a model. It gets data from the model and
specifies how that data should be presented. It updates data presentation
when the model changes. A view also forwards user input to a controller.
The Duke’s Bookstore JSP pages format the data stored in the session-
scoped shopping cart and the page-scoped database helper object.

• The controller defines application behavior. It dispatches user requests and
15selects views for presentation. It interprets user inputs and maps them
into actions to be performed by the model. In a Web application, user
inputs are HTTP GET and POST requests. A controller selects the next
view to display based on the user interactions and the outcome of the
model operations. In the Duke’s Bookstore application, the Dispatcher

servlet is the controller. It examines the request URL, creates and initial-
izes a session-scoped JavaBeans component—the shopping cart—and dis-
patches requests to view JSP pages.

Note: When employed in a Web application, the MVC architecture is often referred
to as a Model-2 architecture. The bookstore example discussed in the previous
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chapter, which intermixes presentation and business logic, follows what is known
as a Model-1 architecture. The Model-2 architecture is the recommended approach
to designing Web applications.

In addition, this version of the application uses several custom tags from the Jav-
aServer Pages Standard Tag Library (JSTL) (see Chapter ):

• c:if and c:choose, c:when, and c:otherwise for flow control

• c:set for setting scoped variables

• c:url for encoding URLs

• fmt:message, fmt:formatNumber, and fmt:formatDate for providing
locale-sensitive messages, numbers, and dates

Custom tags are the preferred mechanism for performing a wide variety of
dynamic processing tasks, including accessing databases, using enterprise ser-
vices such as e-mail and directories, and flow control. In earlier versions of JSP
technology, such tasks were performed with JavaBeans components in conjunc-
tion with scripting elements (discussed in Chapter 16). Though still available in
JSP 2.0, scripting elements tend to make JSP pages more difficult to maintain
because they mix presentation and logic, which is discouraged in page design.
Custom tags are introduced in Using Custom Tags (page 525) and described in
detail in Chapter 15.

Finally, this version of the example contains an applet to generate a dynamic dig-
ital clock in the banner. See Including an Applet (page 531) for a description of
the JSP element that generates HTML for downloading the applet.

1. The source code for the application is located in the <INSTALL>/

j2eetutorial14/examples/web/bookstore2/ directory (see Building
and Running the Examples, page xxix). A sample bookstore2.war is pro-
vided in <INSTALL>/j2eetutorial14/examples/web/provided-wars/.
To build, package, deploy, and run the example:

1. Build and package the bookstore common files as described in Duke’s
Bookstore Examples (page 109).

2. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/bookstore2/.

3. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/

bookstore2/build/ directory.

4. Start the J2EE application server.
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5. Perform all the operations described in Accessing Databases from Web
Applications, page 109.

6. Start deploytool.

7. Create a Web application called bookstore2 by running the New Web
Component Wizard. Select File→New→Web Component.

8. New Web Component Wizard

e. Select the Create New Stand-Alone WAR Module radio button.

f. Click Browse.

g. In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/web/bookstore2/bookstore2.war.

h. In the WAR Name field, enter bookstore2.

i. In the Context Root field, enter /bookstore2.

j. Click Edit.

k. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/bookstore2/build/. Select the JSP pages book-

store.jsp, bookdetails.jsp, bookcatalog.jsp, bookshow-

cart.jsp, bookcashier.jsp, bookordererror.jsp,
bookreceipt.jsp, duke.books.gif, and the clock, dispatcher,
database, listeners, and template directories and click Add.

l. Move /WEB-INF/classes/clock/ to the root directory of the WAR. By
default, deploytool packages all classes in /WEB-INF/classes/. Since
clock/DigitalClock.class is a client-side class, it must be packaged
in the root directory. To do this, simply drag the clock directory from /

WEB-INF/classes/ to the root directory in the pane labeled Contents of
bookstore2.

m.Add the shared bookstore library. Navigate to <INSTALL>/

j2eetutorial14/examples/build/web/bookstore/dist/. Select
bookstore.jar and Click Add.

n. Click OK.

o. Click Next.

p. Select the Servlet radio button.

q. Click Next.

r. Select dispatcher.Dispatcher from the Servlet class combo box.

s. Click Finish.
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9. Add the listener class listeners.ContextListener (described in Handling Servlet
Life Cycle Events, page 461).

a. Select the Event Listeners tab.

b. Click Add.

c. Select the listeners.ContextListener class from drop down field in the Event
Listener Classes panel.

10.Add the aliases.

a. Select the Dispatcher Web component.

b. Select the Aliases tab.

c. Click Add and then type /bookstore in the Aliases field. Repeat to add the aliases
/bookcatalog, /bookdetails, /bookshowcart, /bookcashier, /bookorderer-

ror, and /bookreceipt.

11.Add the JSTL resource bundle basename context parameter.

a. Select the Web module.

b. Select the Context tab.

c. Click Add.

d. Enter javax.servlet.jsp.jstl.fmt.localizationContext for the Coded
Parameter.

e. Enter messages.BookstoreMessages for the Value.

12.Set prelude and codas for all JSP pages.

a. Select the JSP Properties tab.

b. Click the Add button next to the Name list.

c. Enter bookstore2.

d. Click the Add button next to the URL Pattern list.

e. Enter *.jsp.

f. Click the Edit button next to the Include Preludes list.

g. Click Add.

h. Enter /template/prelude.jspf.

i. Click OK.

j. Click the Edit button next to the Include Codas list.

k. Click Add.

l. Enter /template/coda.jspf.

m.Click OK.
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13.Add a resource reference for the database.

a. Select the Resource Refs tab.

b. Click Add.

c. Enter jdbc/BookDB in the Coded Name field.

d. Accept the default type javax.sql.DataSource.

e. Accept the default authorization Container.

f. Accept the default selected Shareable.

g. Enter jdbc/BookDB in the JNDI name field of the Sun-specific Settings
frame.

14.Select File→Save.

15.Deploy the application.

a. Select Tools→Deploy.

b. Click OK.



504 JAVASERVER PAGES TECHNOLOGY
16.Open the bookstore URL http://localhost:8080/bookstore2/bookstore. Click
on the Start Shopping link and you will see the screen in Figure 12–2:

Figure 12–2 Book Catalog

See Troubleshooting (page 460) for help with diagnosing common problems related to the
database server. If the messages in your pages appear as strings of the form ??? Key ???, the
likely cause is that you have not provided the correct resource bundle basename as a context
parameter.
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The Life Cycle of a JSP Page
A JSP page services requests as a servlet. Thus, the life cycle and many of the
capabilities of JSP pages (in particular the dynamic aspects) are determined by
Java Servlet technology. You will notice that many sections in this chapter refer
to classes and methods described in Chapter 11.

When a request is mapped to a JSP page, the Web container first checks whether
the JSP page’s servlet is older than the JSP page. If the servlet is older, the Web
container translates the JSP page into a servlet class and compiles the class. Dur-
ing development, one of the advantages of JSP pages over servlets is that the
build process is performed automatically.

Translation and Compilation
During the translation phase each type of data in a JSP page is treated differently.
Template data is transformed into code that will emit the data into the response
stream. JSP elements are treated as follows:

• Directives are used to control how the Web container translates and exe-
cutes the JSP page.

• Scripting elements are inserted into the JSP page’s servlet class. See
Chapter 16 for details.

• Expression language expressions are passed as parameters to calls to the
JSP expression evaluator.

• jsp:[set|get]Property elements are converted into method calls to
JavaBeans components.

• jsp:[include|forward] elements are converted to invocations of the
Java Servlet API.

• The jsp:plugin element is converted to browser-specific markup for acti-
vating an applet.

• Custom tags are converted into calls to the tag handler that implements the
custom tag.

If you would like the J2EE 1.4 Application Server to keep the generated servlets,
for a Web module in deploytool,

1. Select the WAR.

2. Select the General tab.

3. Click the Sun-specific Setting button.
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4. Select the JSP option from the View combo box.

5. Click the Add button in the JSP Configuration frame.

6. Select keepgenerated from the Name column.

7. Select true from the Value column.

8. Click Close.

In the J2EE application server, the source for the servlet created from a JSP page
named pageName is in the file:

<J2EE_HOME>/domains/domain1/generated/
jsp/WAR_NAME/pageName_jsp.java

For example, the source for the index page (named index.jsp) for the date

localization example discussed at the beginning of the chapter would be named:

<J2EE_HOME>/domains/domain1/generated/
jsp/date/index_jsp.java

Both the translation and compilation phases can yield errors that are only
observed when the page is requested for the first time. If an error is encountered
during either phase, the server will return JasperException and a message that
includes the name of the JSP page and the line where the error occurred.

Once the page has been translated and compiled, the JSP page’s servlet for the
most part follows the servlet life cycle described in Servlet Life
Cycle (page 461):

1. If an instance of the JSP page’s servlet does not exist, the container

a. Loads the JSP page’s servlet class

b. Instantiates an instance of the servlet class

c. Initializes the servlet instance by calling the jspInit method

2. The container invokes the _jspService method, passing a request and
response object.

If the container needs to remove the JSP page’s servlet, it calls the jspDestroy

method.

Execution
You can control various JSP page execution parameters by using page directives.
The directives that pertain to buffering output and handling errors are discussed
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here. Other directives are covered in the context of specific page authoring tasks
throughout the chapter.

Buffering
When a JSP page is executed, output written to the response object is automati-
cally buffered. You can set the size of the buffer with the following page direc-
tive:

<%@ page buffer="none|xxxkb" %>

A larger buffer allows more content to be written before anything is actually sent
back to the client, thus providing the JSP page with more time to set appropriate
status codes and headers or to forward to another Web resource. A smaller buffer
decreases server memory load and allows the client to start receiving data more
quickly.

Handling Errors
Any number of exceptions can arise when a JSP page is executed. To specify that
the Web container should forward control to an error page if an exception occurs,
include the following page directive at the beginning of your JSP page:

<%@ page errorPage="file_name" %>

The Duke’s Bookstore application page prelude.jsp contains the directive

<%@ page errorPage="errorpage.jsp"%>

The beginning of errorpage.jsp indicates that it is serving as an error page
with the following page directive:

<%@ page isErrorPage="true" %>

This directive makes an object of type javax.servlet.jsp.ErrorData avail-
able to the error page, so that you can retrieve, interpret, and possibly display
information about the cause of the exception in the error page. You access the
error data object in an EL expression via the page context. Thus, ${pageCon-
text.errorData.statusCode} is used to retrieve the status code and ${page-

Context.errorData.throwable} retrieves the exception. If the exception is
generated during the evaluation of an EL expression, you can retrieve the root

../examples/web/bookstore2/web/template/prelude.txt
../examples/web/bookstore2/web/template/errorpage.txt
http://java.sun.com/j2ee/1.4/docs/api/index.htmlapi/javax/servlet/jsp/ErrorData.html
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cause of the exception with the expression
${pageContext.errorData.throwable.rootCause}. For example, the error
page for the Duke’s Bookstore is:

<%@ page isErrorPage="true" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core"

prefix="c" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/fmt"

prefix="fmt" %>
<html>
<head>
<title><fmt:message key="ServerError"/></title>
</head>
<body bgcolor="white">
<h3>
<fmt:message key="ServerError"/>
</h3>
<p>
${pageContext.errorData.throwable}
<c:choose>

<c:when test="${!empty
pageContext.errorData.throwable.cause}">
: ${pageContext.errorData.throwable.cause}

</c:when>
<c:when test="${!empty

pageContext.errorData.throwable.rootCause}">
: ${pageContext.errorData.throwable.rootCause}

</c:when>
</c:choose>
</body>
</html>

Note: You can also define error pages for the WAR that contains a JSP page. If error
pages are defined for both the WAR and a JSP page, the JSP page’s error page takes
precedence.

Creating Static Content
You create static content in a JSP page by simply writing it as if you were creat-
ing a page that consisted only of that content. Static content can be expressed in
any text-based format, such as HTML, WML, and XML. The default format is
HTML. If you want to use a format other than HTML, you include a page direc-
tive with the contentType attribute set to the content type at the beginning of
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your JSP page. The purpose of the contentType directive is to allow the browser
to correctly interpret the resulting content. So, if you want a page to contain data
expressed in the wireless markup language (WML), you need to include the fol-
lowing directive:

<%@ page contentType="text/vnd.wap.wml"%>

A registry of content type names is kept by the IANA at:

http://www.iana.org/assignments/media-types/

Response and Page Encoding
You also use the contentType attribute to specify the encoding of the response.
For example, the date application specifies that the page should be encoded
using UTF-8, an encoding that supports almost all locales, with the following
page directive:

<%@ page contentType="text/html; charset=UTF-8" %>

If the response encoding weren’t set, the localized dates would not be rendered
correctly.

To set the source encoding of the page itself, you would use the following page

directive.

<%@ page pageEncoding="UTF-8" %>

You can also set the page encoding of a set of JSP pages. The value of the page
encoding varies depending on the configuration specified in the JSP configura-
tion section of the Web application deployment descriptor (see Declaring Page
Encodings, page 535).

Creating Dynamic Content
You create dynamic content by accessing Java programming language object
properties.

http://www.iana.org/assignments/media-types/
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Using Objects within JSP Pages
You can access a variety of objects, including enterprise beans and JavaBeans
components, within a JSP page. JSP technology automatically makes some
objects available, and you can also create and access application-specific objects.

Implicit Objects
Implicit objects are created by the Web container and contain information related
to a particular request, page, session, or application. Many of the objects are
defined by the Java Servlet technology underlying JSP technology and are dis-
cussed at length in Chapter 11. The section Implicit Objects (page 514) explains
how you access implicit objects using the JSP expression language.

Application-Specific Objects
When possible, application behavior should be encapsulated in objects so that
page designers can focus on presentation issues. Objects can be created by devel-
opers who are proficient in the Java programming language and in accessing
databases and other services. The main way to create and use application-spe-
cific objects within a JSP page is to use JSP standard tags discussed in JavaBeans
Components (page 519) to create JavaBeans components and set their proper-
ties, and EL expressions to access their properties. You can also access Java-
Beans components and other objects in scripting elements, which are described
in Chapter 16.

Shared Objects
The conditions affecting concurrent access to shared objects described in Con-
trolling Concurrent Access to Shared Resources (page 465) apply to objects
accessed from JSP pages that run as multithreaded servlets. You can indicate
how a Web container should dispatch multiple client requests with the following
page directive:

<%@ page isThreadSafe="true|false" %>

When the isThreadSafe attribute is set to true, the Web container may choose
to dispatch multiple concurrent client requests to the JSP page. This is the
default setting. If using true, you must ensure that you properly synchronize
access to any shared objects defined at the page level. This includes objects cre-
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ated within declarations, JavaBeans components with page scope, and attributes
of the page context object (see Implicit Objects, page 514).

If isThreadSafe is set to false, requests are dispatched one at a time, in the
order they were received, and access to page level objects does not have to be
controlled. However, you still must ensure that access to attributes of the appli-

cation or session scope objects and to JavaBeans components with application
or session scope is properly synchronized. Futhermore, it is not recommended to
set isThreadSafe to false because the JSP page’s generated servlet will imple-
ment the javax.servlet.SingleThreadModel interface and since the Servlet
2.4 specification deprecates SingleThreadModel, the generated servlet will con-
tain deprecated code.

Expression Language
A primary feature of JSP technology version 2.0 is its support for an expression
language. An expression language makes it possible to easily access application
data stored in JavaBeans components. For example, the JSP expression language
allows a page author to access a bean using a simple syntax such as

${name}

for a simple variable or

${name.foo.bar}

for a nested property.

The test attribute of the following conditional tag is supplied with an EL
expression that compares the number of items in the session-scoped bean named
cart with 0:

<c:if test="${sessionScope.cart.numberOfItems > 0}">
...

</c:if>

The JSP expression evaluator is responsible for handling EL expressions, which
may include literals and are enclosed by the ${ } characters. For example:

<c:if test="${bean1.a < 3}" >
...

</c:if>
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Any value that does not begin with ${ is treated as a literal that is parsed to the
expected type using the PropertyEditor for the type:

<c:if test="true" >
...
</c:if>

Literal values that contain the ${ characters must be escaped as follows:

<mytags:example attr1="an expression is ${'${'}true}" />

Deactivating Expression Evaluation
Since the pattern that identifies EL expressions—${ }—was not reserved in the
JSP specifications before JSP 2.0, there may be applications where such a pat-
tern is intended to pass through verbatim. To prevent the pattern from being eval-
uated, EL evaluation can be deactivated.

To deactivate the evaluation of EL expressions you specify the isELIgnored

attribute of the page directive

<%@ page isELIgnored ="true|false" %>

The valid values of this attribute are true and false. If true, EL expressions are
ignored when they appear in template text or tag attributes. If false, EL expres-
sions are evaluated by the container.

The default value varies depending on the version of the Web application
deployment descriptor. The default mode for JSP pages delivered using a Servlet
2.3 or earlier descriptor is to ignore EL expressions; this provides backwards
compatibility. The default mode for JSP pages delivered with a Servlet 2.4
descriptor is to evaluate EL expressions; this automatically provides the default
that most applications want. You can also deactivate EL expression evaluation
for a group of JSP pages (see Deactivating EL Evaluation, page 534).

Using Expressions
EL Expressions can be used in two situations:

• In template text

• In any standard or custom tag attribute that can accept an expression



VARIABLES 513
The value of an expression in template text is computed and inserted into the
current output. An expression will not be evaluated if the body of the tag is
declared to be tagdependent (see body-content Attribute, page 603).

Three ways to set a tag attribute value:

• With a single expression construct:
<some:tag value="${expr}"/>

The expression is evaluated and the result is coerced to the attribute’s
expected type.

• With one or more expressions separated or surrounded by text:
<some:tag value="some${expr}${expr}text${expr}"/>

The expressions are evaluated from left to right. Each expression is
coerced to a String and then concatenated with any intervening text. The
resulting String is then coerced to the attribute’s expected type.

• With only text:
<some:tag value="sometext"/>

In this case, the attribute’s String value is coerced to the attribute's
expected type.

Expressions used to set attribute values are evaluated in the context of an
expected type. If the result of the expression evaluation does not match the
expected type exactly a type conversion will be performed. For example, the
expression ${1.2E4 + 1.4} provided as the value of an attribute of type float,
will result in the following conversion: Float.valueOf("1.2E4 +

1.4").floatValue(). See Section JSP2.8 of the JSP 2.0 Specification for the
complete type conversion rules.

Variables
The JSP container evaluates a variable that appears in an expression by looking
up its value according to the behavior of PageContext.findAt-

tribute(String). For example, when evaluating the expression ${product},
the container will look for product in the page, request, session, and application
scopes and will return its value. If product is not found, null is returned. A
variable that matches one of the implicit objects described in Implicit
Objects (page 514) will return that implicit object instead of the variable’s value.

Properties of variables are accessed using the . operator, and may be nested arbi-
trarily.

http://java.sun.com/products/jsp/download.html#specs
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The JSP expression language unifies the treatment of the . and [] operators.

expr-a.expr-b is equivalent to a["expr-b"]; that is, the expression expr-b is

used to construct a literal whose value is the identifier, and then the [] operator
is used with that value.

To evaluate expr-a[expr-b], evaluate expr-a into value-a and evaluate expr-

b into value-b. If either value-a or value-b is null, return null.

• If value-a is a Map, return value-a.get(value-b). If !value-a.con-

tainsKey(value-b), then return null.

• If value-a is a List or array, coerce value-b to int and return value-

a.get(value-b) or Array.get(value-a, value-b), as appropriate. If
the coercion couldn’t be performed, an error is returned. If the get call
returns an IndexOutOfBoundsException, null is returned. If the get call
returns another exception, an error is returned.

• If value-a is a JavaBeans object, coerce value-b to String. If value-b
is a readable property of value-a, then return the result of a get call. If the
get method throws an exception, an error is returned.

Implicit Objects
The JSP expression language defines a set of implicit objects:

• pageContext - The context for the JSP page. Provides access to various
objects including:

• servletContext - The context for the JSP page’s servlet and any Web
components contained in the same application. See Accessing the Web
Context (page 485).

• session - The session object for the client. See Maintaining Client
State (page 486).

• request - The request triggering the execution of the JSP page. See
Getting Information from Requests (page 469).

• response - The response returned by the JSP page. See Constructing
Responses, page 471).
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In addition, several implicit objects are available that allow easy access to the
following objects:

• param - maps a request parameter name to a single value

• paramValues - maps a request parameter name to an array of values

• header - maps a request header name to a single value

• headerValues - maps a request header name to an array of values

• cookie - maps a cookie name to a single cookie

• initParam - maps a context initialization parameter name to a single value

Finally, there are objects that allow access to the various scoped variables
described in Using Scope Objects (page 464).

• pageScope - maps page-scoped variable names to their values

• requestScope - maps request-scoped variable names to their values

• sessionScope - maps session-scoped variable names to their values

• applicationScope - maps application-scoped variable names to their val-
ues

When an expression references one of these objects by name, the appropriate
object is returned instead of the corresponding attribute. For example: ${page-
Context} returns the PageContext object, even if there is an existing pageCon-

text attribute containing some other value.

Literals
The JSP expression language defines the following literals:

• Boolean: true and false

• Integer: as in Java

• Floating point: as in Java

• String: with single and double quotes. " is escaped as \", ' is escaped as
\', and \ is escaped as \\.

• Null: null
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Operators
In addition to the . and [] operators discussed in Variables (page 513), the JSP
expression language provides the following operators:

• Arithmetic: +, - (binary), *, / and div, % and mod, -(unary)

• Logical: and, &&, or, ||, not, !

• Relational: ==, eq, !=, ne, <, lt, >, gt, <=, ge, >=, le. Comparisons may be
made against other values, or against boolean, string, integer, or floating
point literals.

• Empty: The empty operator is a prefix operation that can be used to deter-
mine if a value is null or empty.

• Conditional: A ? B : C. Evaluate B or C, depending on the result of the

evaluation of A.

The precedence of operators highest to lowest, left to right is:

• [] .

• () - Used to change the precedence of operators.

• - (unary) not ! empty
• * / div % mod

• + - (binary)
• < > <= >= lt gt le ge

• == != eq ne

• && and

• || or

• ? :

Reserved Words
The following words are reserved for the JSP expression language and should
not be used as identifiers.

and eq gt true instanceof
or ne le false empty
not lt ge null div mod

Note that many of these words are not in the language now, but they may be in
the future, so you should avoid using them.
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Examples
Table 12–2 contains example EL expressions and the result of evaluating the
expressions.

Table 12–2 Example Expressions

EL Expression Result

${1 > (4/2)} false

${4.0 >= 3} true

${100.0 == 100} true

${(10*10) ne 100} false

${'a' < 'b'} true

${'hip' gt 'hit'} false

${4 > 3} true

${1.2E4 + 1.4} 12001.4

${3 div 4} 0.75

${10 mod 4} 2

${!empty param.Add}
True if the request parameter named Add is
null or an empty string.

${pageContext.request.contextPath} The context path

${sessionScope.cart.numberOfItems}
The value of the numberOfItems property
of the session-scoped attribute named cart

${param['mycom.productId']}
The value of the request parameter named
mycom.productId

${header["host"]} The host

${departments[deptName]}
The value of the entry named deptName in
the departments map

${requestScope['javax.servlet.
forward.servlet_path']}

The value of the request-scoped attribute
named javax.servlet.
forward.servlet_path
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Functions
The JSP expression language allows you to define a function that can be invoked
in an expression. Functions are defined using the same mechanisms as custom
tags (See Using Custom Tags, page 525 and Chapter 15).

Using Functions
Functions can appear in template text and tag attribute values.

To use a function in a JSP page, you import the tag library containing the func-
tion using a taglib directive. Then, you preface the function invocation with the
prefix declared in the directive.

For example, the date example page index.jsp imports the /functions library
and invokes the function equals in an expression:

<%@ taglib prefix="f" uri="/functions"%>
...

<c:when
test="${f:equals(selectedLocaleString,

localeString)}" >

Defining Functions
To define a function you program it as a public static method in a public class.
The mypkg.MyLocales class in the date example defines a function that tests the
equality of two Strings as follows:

package mypkg;
public class MyLocales {

...
public static boolean equals( String l1, String l2 ) {

return l1.equals(l2);
}

}

Then, you map the function name as used in the EL expression to the defining
class and function signature in a TLD. The following functions.tld file in the
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date example maps the equals function to the class containing the implementa-
tion of the function equals and the signature of the function:

<function>
<name>equals</name>
<function-class>mypkg.MyLocales</function-class>
<function-signature>boolean equals( java.lang.String,

java.lang.String )</function-signature>
</function>

A tag library can only have one function element with any given name element.

JavaBeans Components
JavaBeans components are Java classes that can be easily reused and composed
together into applications. Any Java class that follows certain design conventions
is a JavaBeans component.

JavaServer Pages technology directly supports using JavaBeans components
with standard JSP language elements. You can easily create and initialize beans
and get and set the values of their properties.

JavaBeans Component Design
Conventions
JavaBeans component design conventions govern the properties of the class and
govern the public methods that give access to the properties.

A JavaBeans component property can be

• Read/write, read-only, or write-only

• Simple, which means it contains a single value, or indexed, which means
it represents an array of values

A property does not have to be implemented by an instance variable. It must sim-
ply be accessible using public methods that conform to the following conven-
tions:

• For each readable property, the bean must have a method of the form

PropertyClass getProperty() { ... }
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• For each writable property, the bean must have a method of the form

setProperty(PropertyClass pc) { ... }

In addition to the property methods, a JavaBeans component must define a con-
structor that takes no parameters.

The Duke’s Bookstore application JSP pages enter.jsp, bookdetails.jsp,
catalog.jsp, and showcart.jsp use the database.BookDB and data-

base.BookDetails JavaBeans components. BookDB provides a JavaBeans com-
ponent front end to the access object database.BookDBAO. The JSP pages
showcart.jsp and cashier.jsp access the bean cart.ShoppingCart, which
represents a user’s shopping cart.

The BookDB bean has two writable properties, bookId and database, and three
readable properties, bookDetails, numberOfBooks, and books. These latter
properties do not correspond to any instance variables, but are a function of the
bookId and database properties.

package database
public class BookDB {
private String bookId = "0";
private BookDBAO database = null;
public BookDB () {
}

public void setBookId(String bookId) {
this.bookId = bookId;
}
public void setDatabase(BookDBAO database) {
this.database = database;
}
public BookDetails getBookDetails() throws

BookNotFoundException {
return (BookDetails)database.getBookDetails(bookId);

}
public Collection getBooks() throws BooksNotFoundException {

return database.getBooks();
}
public void buyBooks(ShoppingCart cart)

throws OrderException {
database.buyBooks(cart);

}
public int getNumberOfBooks() throws BooksNotFoundException {

return database.getNumberOfBooks();
}

}

../examples/web/bookstore2/src/database/BookDB.java
../examples/web/bookstore/src/database/BookDetails.java
../examples/web/bookstore/src/database/BookDetails.java
../examples/web/bookstore/src/cart/ShoppingCart.java
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Creating and Using a JavaBeans
Component
You declare that your JSP page will use a JavaBeans component using a
jsp:useBean element. There are two forms:

<jsp:useBean id="beanName"
class="fully_qualified_classname" scope="scope"/>

and

<jsp:useBean id="beanName"
class="fully_qualified_classname" scope="scope">
<jsp:setProperty .../>

</jsp:useBean>

The second form is used when you want to include jsp:setProperty state-
ments, described in the next section, for initializing bean properties.

The jsp:useBean element declares that the page will use a bean that is stored
within and accessible from the specified scope, which can be application,
session, request, or page. If no such bean exists, the statement creates the
bean and stores it as an attribute of the scope object (see Using Scope
Objects, page 464). The value of the id attribute determines the name of the
bean in the scope and the identifier used to reference the bean in EL expressions,
other JSP elements, and scripting expressions (see Chapter 16). The value sup-
plied for the class attribute must be a fully-qualified class name. Note that
beans cannot be in the unnamed package. Thus the format of the value must be
package_name.class_name.

The following element creates an instance of mypkg.myLocales if none exists,
stores it as an attribute of the application scope, and makes the bean available
throughout the application by the identifier locales:

<jsp:useBean id="locales" scope="application"
class="mypkg.MyLocales"/>



522 JAVASERVER PAGES TECHNOLOGY
Setting JavaBeans Component
Properties
The standard way to set JavaBeans component properties in a JSP page is with
the jsp:setProperty element. The syntax of the jsp:setProperty element
depends on the source of the property value. Table 12–3 summarizes the various
ways to set a property of a JavaBeans component using the jsp:setProperty

element.

A property set from a constant string or request parameter must have a type
listed in Table 12–4. Since both a constant and request parameter are strings, the

Table 12–3 Valid Bean Property Assignments from String Values

Value Source Element Syntax

String constant
<jsp:setProperty name="beanName"

property="propName" value="string constant"/>

Request parameter
<jsp:setProperty name="beanName"

property="propName" param="paramName"/>

Request parameter name
matches bean property

<jsp:setProperty name="beanName"
property="propName"/>

<jsp:setProperty name="beanName"
property="*"/>

Expression

<jsp:setProperty name="beanName"
property="propName" value="expression"/>

<jsp:setProperty name="beanName"
property="propName" >
<jsp:attribute name="value">
expression
</jsp:attribute>

</jsp:setProperty>

1. beanName must be the same as that specified for the id
attribute in a useBean element.
2. There must be a setPropName method in the JavaBeans
component.
3. paramName must be a request parameter name.
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Web container automatically converts the value to the property’s type; the con-
version applied is shown in the table.

String values can be used to assign values to a property that has a PropertyEd-

itor class. When that is the case, the setAsText(String) method is used. A
conversion failure arises if the method throws an IllegalArgumentException.

The value assigned to an indexed property must be an array, and the rules just
described apply to the elements.

You use an expression to set the value of a property whose type is a compound
Java programming language type. The type returned from an expression must
match or be castable to the type of the property.

Table 12–4 Valid Property Value Assignments from String Values

Property Type Conversion on String Value

Bean Property Uses setAsText(string-literal)

boolean or Boolean As indicated in java.lang.Boolean.valueOf(String)

byte or Byte As indicated in java.lang.Byte.valueOf(String)

char or Character As indicated in java.lang.String.charAt(0)

double or Double As indicated in java.lang.Double.valueOf(String)

int or Integer As indicated in java.lang.Integer.valueOf(String)

float or Float As indicated in java.lang.Float.valueOf(String)

long or Long As indicated in java.lang.Long.valueOf(String)

short or Short As indicated in java.lang.Short.valueOf(String)

Object new String(string-literal)
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The Duke’s Bookstore application demonstrates how to use the setProperty

element to set the current book from a request parameter in the database helper
bean in bookstore2/web/bookdetails.jsp:

<c:set var="bid" value="${param.bookId}"/>
<jsp:setProperty name="bookDB" property="bookId"

value="${bid}" />

The following fragment from the page bookstore2/web/bookshowcart.jsp

illustrates how to initialize a BookDB bean with a database object. Because the
initialization is nested in a useBean element, it is only executed when the bean is
created.

<jsp:useBean id="bookDB" class="database.BookDB" scope="page">
<jsp:setProperty name="bookDB" property="database"

value="${bookDBAO}" />
</jsp:useBean>

Retrieving JavaBeans Component
Properties
The main way to retrieve JavaBeans component properties is with the JSP
expression language. Thus, to retrieve a book title, the Duke’s Bookstore appli-
cation uses the following expression:

${bookDB.bookDetails.title}

Another way to retrieve component properties is to use the jsp:getProperty

element. This element converts the value of the property into a String and
inserts the value into the response stream:

<jsp:getProperty name="beanName" property="propName"/>

Note that beanName must be the same as that specified for the id attribute in a
useBean element, and there must be a getPropName method in the JavaBeans
component. Although the preferred approach to getting properties is to use an
EL expression, the getProperty element is available if you need to disable
expression evaluation.

../examples/web/bookstore2/web/bookdetails.txt
../examples/web/bookstore2/web/bookshowcart.txt
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Using Custom Tags
Custom tags are user-defined JSP language elements that encapsulate recurring
tasks. Custom tags are distributed in a tag library, which defines a set of related
custom tags and contains the objects that implement the tags.

Custom tags have the syntax

<prefix:tag attr1="value" ... attrN="value" />

or

<prefix:tag attr1="value" ... attrN="value" >
body

</prefix:tag>

where prefix distinguishes tags for a library, tag is the tag identifier, and attr1

... attrN are attributes that modify the behavior of the tag.

To use a custom tag in a JSP page, you must:

• Declare the tag library containing the tag

• Make the tag library implementation available to the Web application

See Chapter 12 for detailed information on the different types of tags and how to
implement tags.

Declaring Tag Libraries
You declare that a JSP page will use tags defined in a tag library by including a
taglib directive in the page before any custom tag from that tag library is used.
If you forget to include the taglib directive for a tag library in a JSP page, the
JSP compiler will treat any invocation of a custom tag from that library as tem-
plate data, and simply insert the text of the custom tag call into the response.

<%@ taglib prefix="tt" [tagdir=/WEB-INF/tags/dir | uri=URI ] %>

The prefix attribute defines the prefix that distinguishes tags defined by a given
tag library from those provided by other tag libraries.

If the tag library is defined with tag files (see Encapsulating Reusable Content
using Tag Files, page 598), you supply the tagdir attribute to identify the loca-
tion of the files. The value of the attribute must start with /WEB-INF/tags/ and a
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translation error will occur if the value points to a directory that doesn’t exist or
if used in conjunction with the uri attribute.

The uri attribute refers to a URI that uniquely identifies the tag library descrip-
tor (TLD), a document that describes the tag library (See Tag Library
Descriptors, page 614).

Tag library descriptor file names must have the extension .tld. TLD files are
stored in the WEB-INF directory or subdirectory of the WAR file or in the META-

INF/ directory or subdirectory of a tag library packaged in a JAR. You can refer-
ence a TLD directly or indirectly.

The following taglib directive directly references a TLD filename:

<%@ taglib prefix="tlt" uri="/WEB-INF/iterator.tld"%>

This taglib directive uses a short logical name to indirectly reference the TLD:

<%@ taglib prefix="tlt" uri="/tlt"%>

The iterator example defines and uses a simple iteration tag. The JSP pages
use a logical name to reference the TLD. A sample iterator.war is provided in
<INSTALL>/j2eetutorial14/examples/web/provided-wars/. To build and
package the example:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/iterator/.

2. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/itera-

tor/build/ directory.

3. Start deploytool.

4. Create a Web application called iterator by running the New Web Com-
ponent Wizard. Select File→New→Web Component.

5. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. Click Browse.

c. In the WAR Location field, enter <INSTALL>/docs/tutorial/

examples/web/iterator/iterator.war.

d. In the WAR Name field, enter iterator.

e. In the Context Root field, enter /iterator.
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f. Click Edit. In the Edit Contents dialog, navigate to <INSTALL>/docs/

tutorial/examples/web/iterator/build/. Select the index.jsp

and list.jsp JSP pages and iterator.tld and click Add. Notice that
iterator.tld is put into /WEB-INF/.

g. Click Next.

h. Select the JSP radio button.

i. Click Next.

j. Select index.jsp from the JSP file combo box.

k. Click Finish.

You map a logical name to an absolute location in the Web application deploy-
ment descriptor. To specifyThe iterator example specifies the mapping of the
logical name /tlt to the absolute location /WEB-INF/iterator.tldwith
deploytool:

1. Select the File Refs tab.

2. Click the Add button in the JSP Tag Libraries tab.

3. Enter the relative URI /tlt in the Coded Reference field.

4. Enter the absolute location /WEB-INF/iterator.tld in the Tag Library
field.

You can also reference a TLD in a taglib directive with an absolute URI. For
example, the absolute URIs for the JSTL library are:

• Core: http://java.sun.com/jsp/jstl/core

• XML: http://java.sun.com/jsp/jstl/xml

• Internationalization: http://java.sun.com/jsp/jstl/fmt

• SQL: http://java.sun.com/jsp/jstl/sql

• Functions: http://java.sun.com/jsp/jstl/functions

When you reference a tag library with an absolute URI that exactly matches the
URI declared in the taglib element of the TLD (see Tag Library
Descriptors, page 614), you do not have to add the taglib element to web.xml;
the JSP container automatically locates the TLD inside the JSTL library imple-
mentation.
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Including the Tag Library
Implementation
In addition to declaring the tag library, you also need to make the tag library
implementation available to the Web application. There are several ways to do
this. Tag library implementations can be included in a WAR in an unpacked for-
mat: tag files are packaged in the /WEB-INF/tag/ directory and tag handler
classes are packaged in the /WEB-INF/classes/ directory of the WAR. Tag
libraries already packaged into a JAR file are included in the /WEB-INF/lib/

directory of the WAR. Finally, an application server may load a tag library into
all the Web applications running on the server. For example, in the J2EE 1.4
Application Server, the JSTL TLDs and libraries are distributed in the archive-
appserv-jstl.jar in <J2EE_HOME>/lib/.This library is automatically loaded
into the classpath of all Web applications running on the J2EE application server
so you don’t need to add it to your Web application.

To package the iterator tag library implementation in the /WEB-INF/classes/

directory and deploy the iterator example with deploytool:

1. Select the General tab.

2. Click Edit.

3. Add the iterator tag library classes.

a. In the Edit Contents dialog, navigate to <INSTALL>/docs/tutorial/

examples/web/iterator/build/.

b. Select the iterator and myorg packages and click Add. Notice that the
tag library implementation classes are packaged into /WEB-INF/

classes/.

4. Click OK.

5. Select File→Save.

6. Start the J2EE application server.

7. Deploy the application.

a. Select Tools→Deploy.

b. Click OK.

To run the iterator application, open the URL http://localhost:8080/

iterator in a browser.
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Reusing Content in JSP Pages
There are many mechanisms for reusing JSP content in a JSP page. Three mech-
anisms that can be categorized as direct reuse—the include directive, preludes
and codas, and the jsp:include element—are discussed below. An indirect
method of content reuse occurs when a tag file is used to define a custom tag that
is used by many Web applications. Tag files are discussed in the section Encap-
sulating Reusable Content using Tag Files (page 598) in Chapter 15.

The include directive is processed when the JSP page is translated into a servlet
class. The effect of the directive is to insert the text contained in another file—
either static content or another JSP page—in the including JSP page. You would
probably use the include directive to include banner content, copyright infor-
mation, or any chunk of content that you might want to reuse in another page.
The syntax for the include directive is as follows:

<%@ include file="filename" %>

For example, all the Duke’s Bookstore application pages could include the file
banner.jspf which contains the banner content, with the following directive:

<%@ include file="banner.jspf" %>

Another way to do a static include is with the prelude and coda mechanism
described in Defining Implicit Includes (page 535). This is the approach used by
the Duke’s Bookstore application.

Because you must put an include directive in each file that reuses the resource
referenced by the directive, this approach has its limitations. Preludes and codas
can only be applied to the beginning and end of pages. For a more flexible
approach to building pages out of content chunks, see A Template Tag
Library (page 636).

The jsp:include element is processed when a JSP page is executed. The
include action allows you to include either a static or dynamic resource in a JSP
file. The results of including static and dynamic resources are quite different. If
the resource is static, its content is inserted into the calling JSP file. If the
resource is dynamic, the request is sent to the included resource, the included
page is executed, and then the result is included in the response from the calling
JSP page. The syntax for the jsp:include element is:

<jsp:include page="includedPage" />

../examples/web/bookstore2/web/template/banner.txt
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The hello1 application discussed in Packaging Web Modules (page 94)
includes the page that generates the response with the following statement:

<jsp:include page="response.jsp"/>

Transferring Control to Another Web
Component

The mechanism for transferring control to another Web component from a JSP
page uses the functionality provided by the Java Servlet API as described in
Transferring Control to Another Web Component (page 484). You access this
functionality from a JSP page with the jsp:forward element:

<jsp:forward page="/main.jsp" />

Note that if any data has already been returned to a client, the jsp:forward ele-
ment will fail with an IllegalStateException.

jsp:param Element
When an include or forward element is invoked, the original request object is
provided to the target page. If you wish to provide additional data to that page,
you can append parameters to the request object with the jsp:param element:

<jsp:include page="..." >
<jsp:param name="param1" value="value1"/>

</jsp:include>

When doing jsp:include or jsp:forward, the included page or forwarded
page will see the original request object, with the original parameters augmented
with the new parameters and new values taking precedence over existing values
when applicable.For example, if the request has a parameter A=foo and a param-
eter A=bar is specified for forward, the forwarded request shall have A=bar,foo.
Note that the new parameter has precedence.

The scope of the new parameters is the jsp:include or jsp:forward call; that
is in the case of an jsp:include the new parameters (and values) will not apply
after the include.
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Including an Applet
You can include an applet or JavaBeans component in a JSP page by using the
jsp:plugin element. This element generates HTML that contains the appropri-
ate client-browser-dependent constructs (<object> or <embed>) that will result
in the download of the Java Plug-in software (if required) and client-side compo-
nent and subsequent execution of any client-side component. The syntax for the
jsp:plugin element is as follows:

<jsp:plugin
type="bean|applet"
code="objectCode"
codebase="objectCodebase"
{ align="alignment" }
{ archive="archiveList" }
{ height="height" }
{ hspace="hspace" }
{ jreversion="jreversion" }
{ name="componentName" }
{ vspace="vspace" }
{ width="width" }
{ nspluginurl="url" }
{ iepluginurl="url" } >
{ <jsp:params>

{ <jsp:param name="paramName" value= paramValue" /> }+
</jsp:params> }
{ <jsp:fallback> arbitrary_text </jsp:fallback> }

</jsp:plugin>

The jsp:plugin tag is replaced by either an <object> or <embed> tag as appro-
priate for the requesting client. The attributes of the jsp:plugin tag provide
configuration data for the presentation of the element as well as the version of
the plug-in required. The nspluginurl and iepluginurl attributes override the
default URL where the plug-in can be downloaded.

The jsp:params element specifies parameters to the applet or JavaBeans com-
ponent. The jsp:fallback element indicates the content to be used by the client
browser if the plug-in cannot be started (either because <object> or <embed> is
not supported by the client or because of some other problem).

If the plug-in can start but the applet or JavaBeans component cannot be found
or started, a plug-in-specific message will be presented to the user, most likely a
pop-up window reporting a ClassNotFoundException.
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The Duke’s Bookstore page /template/prelude.jspf creates the banner that
displays a dynamic digital clock generated by DigitalClock:

Figure 12–3 Duke’s Bookstore with Applet

The jsp:plugin element used to download the applet follows:

<jsp:plugin
type="applet"
code="DigitalClock.class"
codebase="/bookstore2"
jreversion="1.4"
align="center" height="25" width="300"
nspluginurl="http://java.sun.com/j2se/1.4.2/download.html"
iepluginurl="http://java.sun.com/j2se/1.4.2/download.html" >
<jsp:params>

<jsp:param name="language"

../examples/web/bookstore2/web/template/prelude.txt
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value="${pageContext.request.locale.language}" />
<jsp:param name="country"

value="${pageContext.request.locale.country}" />
<jsp:param name="bgcolor" value="FFFFFF" />
<jsp:param name="fgcolor" value="CC0066" />

</jsp:params>
<jsp:fallback>

<p>Unable to start plugin.</p>
</jsp:fallback>

</jsp:plugin>

Setting Properties for Groups of JSP
Pages

It is possible to specify certain properties for a group of JSP pages:

• Expression language evaluation

• Treatment of scripting elements (see Disabling Scripting, page 646)

• Page encoding

• Automatic prelude and coda includes

A JSP property group is defined by naming the group and specifying one or
more URL patterns; all the properties in the group apply to the resources that
match any of the URL patterns. If a resource matches URL patterns in more than
one group, the pattern that is most specific applies.To define a property group-
with deploytool:

1. Select the WAR.

2. Select the JSP Properties tab.

3. Click the Add button next to the Name list.

4. Enter the name of the property group.

5. Click the Add button next to the URL Pattern list.

6. Enter the URL pattern (a / followed by a regular expression).

The following sections discuss the properties and how they are interpreted for
various combinations of group properties, individual page directives, and Web
application deployment descriptor version.
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Deactivating EL Evaluation
Each JSP page has a default mode for EL expression evaluation. The default
value varies depending on the version of the Web application deployment
descriptor. The default mode for JSP pages delivered using a Servlet 2.3 or ear-
lier descriptor is to ignore EL expressions; this provides backwards compatibil-
ity. The default mode for JSP pages delivered with a Servlet 2.4 descriptor is to
evaluate EL expressions; this automatically provides the default that most appli-
cations want. For tag files (see Encapsulating Reusable Content using Tag
Files, page 598), the default is to always evaluate expressions.

You can override the default mode through the isELIgnored attribute of the
page directive in JSP pages and the isELIgnored attribute of the tag directive in
tag files. The default mode can also be explicitly changed by setting the value of
the EL Evaluation Ignored checkbox in the JSP Properties tab. Table 12–5 sum-
marizes the EL evaluation settings for JSP pages and their meanings:

Table 12–5 EL Evaluation Settings for JSP Pages

JSP Configuration
Page Directive
isELIgnored EL Encountered

Unspecified Unspecified Evaluated if 2.4 web.xml

Ignored if <= 2.3 web.xml

false Unspecified Evaluated

true Unspecified Ignored

Overridden by page
directive

false Evaluated

Overridden by page
directive

true Ignored
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Table 12–6 summarizes the EL evaluation settings for tag files and their mean-
ings:

Declaring Page Encodings
You set the page encoding of a group of JSP pages by selecting a page encoding
from the Page Encoding drop-down list. Valid values are the same as the pag-

eEncoding attribute of the page directive. A translation-time error results if you
define the page encoding of a JSP page with one value in the JSP configuration
element and then give it a different value in a pageEncoding directive.

Defining Implicit Includes
You can implicitly include preludes and codas for a group of JSP pages by add-
ingitems to the Include Preludes and Codas lists. Their values are context-rela-
tive paths that must correspond to elements in the Web application. When the
elements are present, the given paths are automatically included (as in an
include directive) at the beginning and end of each JSP page in the property
group respectively. When there is more than one include or coda element in a
group, they are included in the order they appear. When more than one JSP prop-
erty group applies to a JSP page, the corresponding elements will be processed
in the same order as they appear in the JSP configuration section.

For example, the Duke’s Bookstore uses the files /template/prelude.jspf and
/template/coda.jspf to include the banner and other boilerplate in each
screen. To add these files to the Duke’s Bookstore property group with deploy-

tool:

1. Define a property group with name bookstore2 and URL pattern *.jsp.

2. Click the Edit button next to the Include Preludes list.

Table 12–6 EL Evaluation Settings for Tag Files

Tag Directive isELIgnored EL Encountered

Unspecified Evaluated

false Evaluated

true Ignored
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3. Click Add.

4. Enter /template/prelude.jspf.

5. Click OK.

6. Click the Edit button next to the Include Codas list.

7. Click Add.

8. Enter /template/coda.jspf.

9. Click OK.

Preludes and codas can only put the included code at the beginning and end of
each file. For a more flexible approach to building pages out of content chunks,
see A Template Tag Library (page 636).

Further Information
For further information on JavaServer Pages technology see:

• JavaServer Pages 2.0 Specification
http://java.sun.com/products/jsp/download.html#specs

• The JavaServer Pages Web site
http://java.sun.com/products/jsp

http://java.sun.com/products/jsp/download.html#specs
http://java.sun.com/products/jsp
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JavaServer Pages
Documents

A JSP document is a JSP page written in XML syntax as opposed to the stan-
dard syntax described in Chapter 12. Because it is written in XML syntax, a JSP
document is also an XML document and therefore gives you all of the benefits
offered by the XML standard, including:

• You can author a JSP document using one of the many XML-aware tools
on the market, enabling you to ensure that your JSP document is well-
formed XML

• You can validate the JSP document against a DTD

• You can nest and scope namespaces within a JSP document

• You can use a JSP document for data-interchange between Web applica-
tions and as part of a compile-time XML pipeline

In addition to these benefits, the XML syntax also gives the JSP page author less
complexity and more flexibility. For example, a page author can take any XML
document and use it as a JSP document. Also, elements in XML syntax can be
used in JSP pages written in standard syntax, allowing a gradual transition from
JSP pages to JSP documents.

This chapter gives you more details on the benefits of JSP documents and shows
you how easy it is to create a JSP document using a very simple example.
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You can also write tag files in XML syntax. This chapter currently covers only
JSP documents. Writing tag files in XML syntax will be addressed in a future
release of the tutorial.

The Example JSP Document
This chapter uses the bookstore5 and books applications to demonstrate writing
JSP pages in XML syntax. The JSP pages of the bookstore5 application use the
JSTL XML tags (see XML Tags, page 572) to manipulate the book data from an
XML stream. The books application contains the JSP document, books.jspx,
which accesses the book data from the database and converts it into the XML
stream. The bookstore5 application accesses this XML stream to get the book
data.

These applications show how easy it is to generate XML data and stream it
between Web applications. The books application could be considered the appli-
cation hosted by the book warehouse’s server. The bookstore5 application
could be considered the application hosted by the book retailer’s server. In this
way, the customer of the bookstore Web site sees the list of books currently
available, according to the warehouse’s database.

The source for the Duke's Bookstore application is located in the <INSTALL>/

j2eetutorial14/examples/web/bookstore5/ directory created when you
unzip the tutorial bundle (see About the Examples (page xxix)). Sample
bookstore5.war and books.war files are provided in <INSTALL>/

j2eetutorial14/examples/web/provided-wars/.

To build, package, deploy, and run the applications:

1. Build and package the bookstore common files as described in Duke’s
Bookstore Examples (page 109).

2. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/bookstore5/.

3. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/

bookstore5/build/ directory.

4. Start the J2EE 1.4 Application Server.

5. Perform all the operations described in Accessing Databases from Web
Applications (page 109).

6. Start deploytool.
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7. Create a Web application called bookstore5 by running the New Web
Application Wizard. Select File→New→Web Component.

8. New Web Component Wizard

a. In the Introduction screen click Next.

b. In the WAR File screen, select the Create New Stand-Alone WAR Mod-
ule radio button.

c. Click Browse and in the file chooser, navigate to <INSTALL>/

j2eetutorial14/examples/web/bookstore5/.

d. In the File Name field, enter bookstore5.

e. Click Choose Module File.

f. In the WAR Name field, enter bookstore5.

g. In the Context Root field, enter /bookstore5.

h. Click Edit to add the content files.

i. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/bookstore5/build/. Select the JSP pages bookcash-

ier.jsp, bookcatalog.jsp, bookdetails.jsp, bookreceipt.jsp,
bookshowcart.jsp, bookstore.jsp, parseBooks.jsp and the tem-

plate directory and click Add. Click OK.

j. Add the shared bookstore library. Navigate to <INSTALL>/

j2eetutorial14/examples/build/web/bookstore/dist/. Select
bookstore.jar and Click Add.

k. Click OK.

l. Click Next.

m.Select the JSP radio button.

n. Click Next.

o. Select /bookstore.jsp from the JSP Filename combo box.

p. Click Finish.

9. Add each of the Web components listed in Table 13–1. For each compo-
nent:

a. Select File→New→Web Component.

b. Click Next in the Introduction screen.

c. In the WAR File screen, click the Add to Existing WAR Module radio
button. Since the WAR file contains all of the JSP pages, you do not
have to add any more content.

d. Click Next.
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e. Select the JSP radio button.

f. Click Next.

g. Select the page from the JSP Filename combo box.

h. Click Finish.

i. Select the Web component you added from the tree.

j. Select the Aliases tabbed pane.

k. Click Add. Enter the alias as shown in Table 13–1.

10.Add the JSTL resource bundle basename context parameter.

a. Select the bookstore5 WAR file from the tree.

b. Select the Context tab.

c. Click Add.

d. Enter javax.servlet.jsp.jstl.fmt.localizationContext for the
Coded Parameter.

e. Enter messages.BookstoreMessages for the Value.

11.Add the context path to the XML stream.

a. While on the Context tab, click Add again.

b. Enter booksURL for the Coded Parameter.

c. Enter http://localhost:8080/books/books.jspx for the Value.

12.Set prelude and codas for all JSP pages.

a. Select the JSP Properties tab.

Table 13–1 Duke’s Bookstore Web Components

Web Component Name JSP Page Component Alias

bookcashier bookcashier.jsp /bookcashier

bookcatalog bookcatalog.jsp /bookcatalog

bookdetails bookdetails.jsp /bookdetails

bookreceipt bookreceipt.jsp /bookreceipt

bookshowcart bookshowcart.jsp /bookshowcart

bookstore bookstore.jsp /bookstore
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b. Click the Add button next to the Name list.

c. Enter bookstore5.

d. Click the Add URL button next to the URL Pattern list.

e. Enter *.jsp.

f. Click the Edit Preludes button next to the Include Preludes list.

g. Click Add.

h. Enter /template/prelude.jspf.

i. Click OK.

j. Click the Edit Codas button next to the Include Codas list.

k. Click Add.

l. Enter /template/coda.jspf.

m.Click OK.

13.Select File→Save.

14.Deploy the application.

a. Select Tools→Deploy.

b. Click OK.

c. A popup dialog will display the results of the deployment. Click Close.

15.Create a Web application called books by running the New Web Compo-
nent Wizard. Select File→New→Web Component.

16.New Web Component Wizard

a. Click Next in the Introduction screen

b. In the WAR File screen, select the Create New Stand-Alone WAR Mod-
ule radio button.

c. Click Browse and in the file chooser, navigate to <INSTALL>/

j2eetutorial14/examples/web/bookstore5/.

d. In the File Name field, enter books.

e. Click Choose Module File.

f. In the WAR Display Name field, enter books.

g. In the Context Root field, enter /books.

h. Click Edit to add the content files.

i. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/bookstore5/build/. Select the JSP document
books.jspx and the database, listeners, and template directories
and click Add.
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j. Add the shared bookstore library. Navigate to <INSTALL>/

j2eetutorial14/examples/build/web/bookstore/dist/. Select
bookstore.jar and Click Add. Click OK.

k. Click Next.

l. Select the JSP radio button.

m.Click Next.

n. Select /books.jspx from the JSP Filename combo box.

o. Click Finish.

17.Identify the books.jspx as an XML document.

a. Select the JSP Properties tab.

b. Click the Add button next to the Name list.

c. Enter books.

d. Click the Add URL button next to the URL Pattern list.

e. Enter *.jspx.

f. Select the checkbox labelled "Is XML Document".

18.Add the listener class listeners.ContextListener (described in Han-
dling Servlet Life Cycle Events, page 461).

a. Select the Event Listeners tab.

b. Click Add.

c. Select the listeners.ContextListener class from drop down field in
the Event Listener Classes panel.

19.Add a resource reference for the database.

a. Select the Resource Refs tab.

b. Click Add.

c. Enter jdbc/BookDB in the Coded Name field.

d. Accept the default type javax.sql.DataSource.

e. Accept the default authorization Container.

f. Accept the default selected Shareable.

g. Enter jdbc/BookDB in the JNDI name field of the "Sun-specific Settings
for jdbc/BookDB" frame.

20.Select File→Save.

21.Deploy the application.

a. Select the books WAR file from the tree.
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b. Select Tools→Deploy.

c. Click OK.

d. A popup dialog will display the results of the deployment. Click Close.

22.Open the bookstore URL http://localhost:8080/bookstore5/book-

store.

Creating a JSP Document
A JSP document is an XML document and therefore must comply with the XML
standard. Fundamentally, this means that a JSP document must be well-
formed— meaning that each start-tag must have a corresponding end-tag—and
that it must have only one root element. In addition, JSP elements included in the
JSP document must comply with the XML syntax.

Much of the standard JSP syntax is already XML-compliant, including all of the
standard actions. Those elements that are not compliant are summarized in Table
13–2 along with the equivalent elements in XML syntax. As you can see from
the table, JSP documents are not much different from a JSP pages. If you know
standard JSP syntax, you will find it easy to both convert your current JSP pages
to XML syntax and create new JSP documents.

Table 13–2 standard syntax versus XML syntax

syntax
elements standard syntax XML syntax

comments <%--..%> <!-- .. -->

declarations <%! ..%> <jsp:declaration> .. </jsp:declaration>

directives

<%@ include .. %> <jsp:directive.include .. />

<%@ page .. %> <jsp:directive.page .. />

<%@ taglib .. %> xmlns:prefix="tag library URL"

expressions <%= ..%> <jsp:expression> .. </jsp:expression>

scriptlets <% ..%> <jsp:scriptlet> .. </jsp:scriptlet>
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To illustrate how simple it is to transition to XML syntax, let’s convert the
greeting.jsp page from Web Application Life Cycle (page 86) to a JSP docu-
ment. The standard syntax version is:

<%@ taglib uri="http://java.sun.com/jsp/jstl/core"
prefix="c" %>

<%@ taglib uri="http://java.sun.com/jsp/jstl/functions"
prefix="fn" %>

<html>
<head><title>Hello</title></head>
<body bgcolor="white">

<img src="duke.waving.gif">
<h2>My name is Duke. What is yours?</h2>
<form method="get">

<input type="text" name="username" size="25">
<p></p>
<input type="submit" value="Submit">
<input type="reset" value="Reset">

</form>
<jsp:useBean id="userNameBean" class="hello.UserNameBean"

scope="request"/>
<jsp:setProperty name="userNameBean" property="name"

value="${param.username}" />
<c:if test="${fn:length(userNameBean.name) > 0}" >

<%@include file="response.jsp" %>
</c:if>

</body>
</html>

The same page in XML syntax is:

<html
xmlns:c="http://java.sun.com/jsp/jstl/core"
xmlns:fn="http://java.sun.com/jsp/jstl/functions"

>
<head><title>Hello</title></head>
<body bgcolor="white" />
<img src="duke.waving.gif" />
<h2>My name is Duke. What is yours?</h2>
<form method="get">

<input type="text" name="username" size="25" />
<p></p>
<input type="submit" value="Submit" />
<input type="reset" value="Reset" />

</form>
<jsp:useBean id="userNameBean" class="hello.UserNameBean"

scope="request"/>
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<jsp:setProperty name="userNameBean" property="name"
value="${param.username}" />

<c:if test="${fn:length(userNameBean.name) gt 0}" >
<jsp:directive.include="response.jsp" />

</c:if>
</body>

</html>

As you can see, a number of constructs legal in standard syntax have been
changed to comply with XML syntax:

• The taglib directives have been removed. Tag libraries are now declared
using XML namespaces, as shown in the html element.

• The img and input tags did not have matching end-tags and have been
made XML-compliant by the addition of a "/" to the start-tag.

• The ">" symbol in the EL expression has been replaced with a gt

• The include directive is changed to the XML-compliant jsp:direc-

tive.include tag.

With only these few small changes and saving the file with a .jspx extension,
this page is a JSP document.

Using the example described in The Example JSP Document (page 538), the rest
of this chapter gives you more details on how to transition from standard syntax
to XML syntax. It explains how to use XML namespaces to declare tag libraries,
include directives, and create static and dynamic content in your JSP documents.
It also describes jsp:root and jsp:output, two elements that are used exclu-
sively in JSP documents.

Declaring Tag Libraries
This section explains how to use XML namespaces to declare tag libraries.

In standard syntax, the taglib directive declares tag libraries used in a JSP page.
Here is an example of a taglib directive:

<%@ taglib uri="http://java.sun.com/jsp/jstl/core"
prefix="c" %>
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This syntax is not allowed in JSP documents. To declare a tag library in a JSP
document, you need to use the xmlns attribute, which is used to declare
namespaces according to the XML standard:

...
xmlns:c="http://java.sun.com/jsp/jstl/core"
...

The value that identifies the location of the tag library can take three forms:

• A plain URI that is a unique identifier for the tag library. The container
tries to match it against any <taglib-uri> elements in the application's
web.xml or the <uri> element of TLDs in JAR files in WEB-INF/lib or
TLDs under WEB-INF.

• A URN of the form urn:jsptld:path

• A URN of the form urn:jsptagdir:path

The URN of the form urn:jsptld:path points to one tag library packaged with
the application:

xmlns:u="urn:jsptld:/WEB-INF/tlds/my.tld"

The URN of the form urn:jsptagdir:path must start with /WEB-INF/tags/

and identifies tag extensions (implemented as tag files) installed in the WEB-INF/

tags/ directory or a subdirectory of it:

xmlns:u="urn:jsptagdir:/WEB-INF/tags/mytaglibs/"

You can include the xmlns attribute in any element in your JSP document, just as
you can in an XML document. In JSP 1.2, you could only include it in a manda-
tory jsp:root element. This new capability has many advantages, including:

• It follows the XML standard, making it easier to use any XML document
as a JSP document

• It allows you to scope prefixes to an element and override them

• It allows you to use xmlns to declare other namespaces, not just tag librar-
ies.
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The books.jspx page declares the tag libraries it uses with the xmlns attributes
in the root element, books:

<books
xmlns:c="http://java.sun.com/jsp/jstl/core"
xmlns:jsp="http://java.sun.com/JSP/Page"

>

By doing this, all elements within the books element have access to these tag
libraries.

As an alternative, you could scope the namespaces, like this:

<books>
...

<jsp:useBean xmlns:jsp="http://java.sun.com/JSP/Page"
id="bookDB"
class="database.BookDB"
scope="page">

<jsp:setProperty name="bookDB"
property="database" value="${bookDBAO}" />

</jsp:useBean>
<c:forEach xmlns:c="http://java.sun.com/jsp/jstl/core"

var="book" begin="0" items="${bookDB.books}">
...

</c:forEach>
</books>

This way, the tag library referenced by the jsp prefix is only available to the
jsp:useBean element and its subelements. Likewise, the tag library referenced
by the c prefix is only available to the c:forEach element.

Scoping the namespaces also allows you to override the prefix. For example, in
another part of the page, you could bind the c prefix to a different namespace or
tag library. Conversely, the jsp prefix must always be bound to the JSP
namespace: http://java.sun.com/JSP/Page.

Including Directives in a JSP Document
Directives are elements that relay messages to the JSP container and affect how
it compiles the JSP page. The directives themselves do not appear in the XML
output.
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There are three directives: include, page, and taglib. The taglib directive is
covered in the previous section.

The jsp:directive.page element defines a number of page-dependent proper-
ties and communicates these to the JSP container. This element must be a child
of the root element. Its syntax is:

<jsp:directive.page page_directive_attr_list />

The page_directive_attr_list is the same list of attributes that the <@ page

...> directive has. These are described in Chapter 12. All of the attributes are
optional. Except for the import and pageEncoding attributes, there can be only
one instance of each attribute in an element, but an element can contain more
than one attribute.

One example of a page directive is one that tells the JSP container to load an
error page when it throws an exception. You can add this error page directive to
the books.jspx page:

<books xmlns:jsp="http://java.sun.com/JSP/Page">
<jsp:directive.page errorPage="errorpage.jsp" />
...

</books>

If there is an error when you try to execute the page (perhaps when you want to
see the XML output of books.jspx), the error page is accessed.

The jsp:directive.include directive is used to insert the text contained in

another file—either static content or another JSP page—in the including

JSP document. You can place this element anywhere in a document. Its
syntax is:

<jsp:directive.include file="relativeURLspec” />

The XML view of a JSP document does not contain jsp:directive.include

elements; rather the included file is expanded in place. This is done to simplify

validation.

Suppose that you wanted to use an include directive to add a JSP document con-
taining magazine data inside the JSP document containing the books data. To do
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this, you can add the following include directive to books.jspx, assuming that
magazines.jspx generates the magazine XML data.

<jsp:root version="2.0" >
<books ...>
...
</books>
<jsp:directive.include file="magazine.jspx" />

</jsp:root>

Note that jsp:root is required because otherwise books.jspx would have two
root elements: <books> and <magazines>. The output generated from
books.jspx will be a sequence of XML documents: one with <books> and the
other with <magazines> as its root element.

The output of this example will not be well-formed XML because of the two root
elements, so the client might refuse to process it. However, it is still a legal JSP
document.

In addition to including JSP documents in JSP documents, you can also include
JSP pages written in standard syntax in JSP documents, and you can include JSP
documents in JSP pages written in standard syntax. The container detects the
page you are including and parses it as either a standard syntax JSP page or a
JSP document and then places it into the XML view for validation.

Creating Static and Dynamic Content
A template provides a way to separate the common elements that are part of each
screen (the static content) from the elements that change with each screen (the
dynamic content) of an application. See A Template Tag Library (page 636) for
more information on templates. This section explains how to represent static
template text and dynamic content in a JSP document.

You can represent static template text in a JSP document with uninterpreted
XML tags or with the jsp:text element. The jsp:text element passes its con-
tent through to the output.
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If you use jsp:text, all whitespace is preserved. For example, consider this
example using XML tags:

<books>
<book>

Web Servers for Fun and Profit
</book>

</books>

The output generated from this XML has all whitespace removed:

<books><book>
Web Servers for Fun and Profit

</book></books>

If you wrap the example XML with a <jsp:text> tag, all whitespace is pre-
served. The whitespace characters are #x20, #x9, #xD and #xA.

You can also use jsp:text to output template data that is not well-formed. The
${counter} expression in the following example would be illegal in a JSP docu-
ment if it were not wrapped in a jsp:text tag.

<c:forEach var="counter" begin="1" end="${3}">
<jsp:text>${counter}</jsp:text>

</c:forEach>

This example will output 123.

The jsp:text tag must not contain any other elements. Therefore, if you need to
nest a tag inside jsp:text, you must wrap the tag inside CDATA.

You also need to use CDATA if you need to output some elements that are not
well-formed. The following example requires CDATA wrappers around the
blockquote start and end tags because the blockquote element is not well-
formed. This is because the blockquote element overlaps with other elements in
the example.

<c:forEach var="i" begin="1" end="${x}">
<![CDATA[<blockquote>]]>

</c:forEach>
...
<c:forEach var="i" begin="1" end="${x}">

<![CDATA[</blockquote>]]>
</c:forEach>
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Just like JSP pages, JSP documents can generate dynamic template content with
EL expressions, scripting elements, standard actions, and custom actions. The
books.jspx document uses EL expressions and custom actions to generate the
XML book data.

As shown in this snippet from books.jspx, the c:forEach JSTL tag iterates
through the list of books and generates the XML data stream while the EL
expressions access the JavaBeans component that in turn retrieves the data from
the database:

<c:forEach xmlns:c="http://java.sun.com/jsp/jstl/core"
var="book" begin="0" items="${bookDB.books}">
<book id="${book.bookId}" >

<surname>${book.surname}</surname>
<firstname>${book.firstName}</firstname>
<title>${book.title}</title>
<price>${book.price}</price>
<year>${book.year}</year>
<description>${book.description}</description>
<inventory>${book.inventory}</inventory>

</book>
</c:forEach>

When using the expression language in your JSP documents, you will need to
substitute some of the operators for alternative notation so that they will not be
interpreted as XML markup. Table 13–3 enumerates the more common opera-
tors and their alternative syntax in JSP documents.

Table 13–3 EL operators and JSP document-compliant alternative notation

EL operator JSP document notation

< lt

> gt

<= le

>= ge

!= ne
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You can also use EL expressions with jsp:element to generate tags dynami-
cally rather than hardcoding them. This example could be used to generate an
HTML header tag with a lang attribute:

<jsp:element name="${content.headerName}"
xmlns:jsp="http://java.sun.com/JSP/Page">

<jsp:attribute name="lang">${content.lang}</jsp:attribute>
<jsp:body>${content.body}</jsp:body>

</jsp:element>

The name attribute identifies the generated tag’s name. The jsp:attribute gen-
erates the lang attribute. The body of the jsp:attribute tag identifies the value
of the lang attribute. The jsp:body tag generates the body of the tag. The output
of this example jsp:element could be:

<h1 lang="fr">Heading in French</h1>

As shown in Table 13–2, scripting elements (described in Chapter 16) are repre-
sented as XML elements when they appear in a JSP document. The only excep-
tion is a scriplet expression used to specify a request-time attribute value. Instead
of using <%=expr %>, a JSP document uses %= expr % to represent a request-
time attribute value.

The three scripting elements are: declarations, scriptlets, and expressions.

A jsp:declaration element declares a scripting language construct available to
other scripting elements. A jsp:declaration element has no attributes and its
body is the declaration itself. Its syntax is:

<jsp:declaration> declaration goes here </jsp:declaration>

A jsp:scriptlet element contains a Java program fragment called a scriptlet.
This element has no attributes and its body is the program fragment that com-
prises the scriptlet. Its syntax is:

<jsp:scriptlet> code fragment goes here </jsp:scriptlet>

The jsp:expression element inserts the value of a scripting language

expression, converted into a string, into the data stream returned to the cli-

ent. A jsp:expression element has no attributes and its body is the expression.
Its syntax is:

<jsp:expression> expression goes here </jsp:expression>
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Using the jsp:root Element
The jsp:root element represents the root element of a JSP document. A
jsp:root element is not required for JSP documents. You can specify your own
root element, enabling you to take any XML document and use it as a JSP docu-
ment. The root element of the books.jspx example JSP document is books.

Although the jsp:root element is not required, it is still useful in these cases:

• You want to identify the document as a JSP document to the JSP container
without having to add any configuration attributes to the deployment
descriptor or name the document with a .jspx extension

• You want to generate—from a single JSP document—more than one XML
document or XML content mixed with non-XML content

The version attribute is the only required attribute of the jsp:root element. It
specifies the JSP specification version that the JSP document is using.

The jsp:root element can also include xmlns attributes for specifying tag
libraries used by the other elements in the page.

The books.jspx page does not need a jsp:root element, and therefore doesn’t
include one. However, suppose that you want to generate two XML documents
from books.jspx, one that lists books and the other that lists magazines, assum-
ing magazines are in the database. This example is similar to the one in the sec-
tion Including Directives in a JSP Document (page 547). To do this, you can use
this jsp:root element:

<jsp:root
xmlns:jsp="http://java.sun.com/JSP/Page" version="2.0" >
<books>...</books>
<magazines>...</magazines>

</jsp:root>

Notice in this example that jsp:root defines the JSP namespace because both
the books and magazines elements use the elements defined in this namespace.

Using the jsp:output Element
The jsp:output element specifies the XML declaration or the document type
declaration in the request output of the JSP document. For more information on
the XML declaration see The XML Prolog (page 27). For more information on
the document type declaration see Referencing the DTD (page 60).
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The XML declaration and document type declaration that are declared by the
jsp:output element are not interpreted by the JSP container. Instead, the con-
tainer simply directs them to the request output.

To illustrate this, here is an example of specifying a document type declaration
with jsp:output:

<jsp:output doctype-root-element="books"
doctype-system="books.dtd" />

The resulting output is:

<!DOCTYPE books SYSTEM "books.dtd" >

Specifying the document type declaration in the jsp:output element will not
cause the JSP container to validate the JSP document against the books.dtd.

If you want the JSP document to be validated against the DTD, you need to man-
ually include the document type declaration within the JSP document, just as
you would with any XML document.

Table 13–4 shows all of the jsp:output attributes. They are all optional, but
some attributes depend on other attributes occurring in the same jsp:output

element, as explained in the table. The rest of this section explains more about
using jsp:output to generate an XML declaration and a document type declara-
tion.

Table 13–4 jsp:output attributes

attribute what it specifies

omit-xml-declaration
A value of true or yes omits the XML declaration. A value
of false or no generates an XML declaration

doctype-root-element
Indicates the root element of the XML document in the
DOCTYPE. Can only be specified if doctype-system is
specified

doctype-system
Specifies that a DOCTYPE is generated in output and
gives the SYSTEM literal

doctype-public
Specifies the value for the Public ID of the generated
DOCTYPE. Can only be specified if doctype-system is
specified
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Generating XML Declarations
Here is an example of an XML declaration:

<?xml version="1.0" encoding="UTF-8" ?>

This declaration is the default XML declaration, meaning that—if the JSP con-
tainer is generating an XML declaration—this is what the JSP container will
include in the output of your JSP document.

Neither a JSP document nor its request output is required to have an XML decla-
ration. In fact, if the JSP document is not producing XML output then it
shouldn’t have an XML declaration.

The JSP container will not include the XML declaration in the output when:

• You set the omit-xml-declaration attribute of the jsp:output element
to either "true" or "yes", or

• You have a jsp:root element in your JSP document, and you do not spec-
ify omit-xml-declaration="false" in jsp:output.

The JSP container will include the XML declaration in the output when:

• You set the omit-xml-declaration attribute of the jsp:output element
to either "false" or "no", or

• You do not have a jsp:root action in your JSP document, and you do not
specify the omit-xml-declaration attribute in jsp:output.

The books.jspx JSP document does not include a jsp:root action or a
jsp:output. Therefore, the default XML declaration is generated in the output.

Generating a Document Type Declaration
The document type declaration specifies a DTD, which defines the structural
rules for the XML document in which the document type declaration occurs.
XML documents are not required to have a DTD associated with them. In fact,
the books example does not include one.

This section shows you how to add a document type declaration to the XML out-
put of books.jspx using the jsp:output element. It also shows you how to
enter the document type declaration manually into books.jspx so that the JSP
container will interpret it and validate the document against the DTD.
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As shown in Table 13–4, the jsp:output element has three attributes that you
use to generate the document type declaration:

• doctype-root-element: Indicates the root element of the XML docu-
ment

• doctype-system: Indicates the URI reference to the DTD

• doctype-public: A more flexible way to reference the DTD. This identi-
fier gives more information about the DTD without giving a specific loca-
tion. A public identifier resolves to the same actual document on any
system even though the location of that document on each system may
vary. See the XML 1.0 specification for more information.

The rules for using the attributes are:

• The doctype attributes can appear in any order

• The doctype-root attribute must be specified if the doctype-system

attribute is specified

• The doctype-public attribute must not be specified unless doctype-sys-
tem is specified

This syntax notation summarizes these rules:

<jsp:output (omit-xml-
declaration="yes"|"no"|"true"|"false")(doctypeDecl) />

doctypeDecl:=(doctype-root-element="rootElement"
doctype-public="PublicLiteral"

doctype-system="SystemLiteral")
| (doctype-root-element="rootElement"
doctype-system="SystemLiteral")

Suppose that you wanted to reference a DTD, called books.DTD, from the output
of the books.jspx page. The DTD would look like this:

<!ELEMENT books (book+) >
<!ELEMENT book (surname, firstname, title, price, year,

description, inventory) >
<!ATTLIST book id CDATA #REQUIRED >
<!ELEMENT surname (#PCDATA) >
<!ELEMENT firstname (#PCDATA) >
<!ELEMENT title (#PCDATA) >
<!ELEMENT price (#PCDATA) >
<!ELEMENT year (#PCDATA) >
<!ELEMENT description (#PCDATA) >
<!ELEMENT inventory (#PCDATA) >

http://www.w3.org/XML/
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To add a document type declaration that references the DTD to the XML request
output generated from books.jspx, include this jsp:output element in
books.jspx:

<jsp:output doctype-root-element="books"
doctype-system="books.DTD" />

With this jsp:output action, the JSP container generates this document type
declaration in the request output:

<!DOCTYPE books SYSTEM "books.DTD" />

The jsp:output does not need to be located before the root element of the doc-
ument. The JSP container will automatically place the resulting document type
declaration before the start of the output of the JSP document.

Note that the JSP container will not interpret anything provided by jsp:output.
This means that the JSP container will not validate the XML document against
the DTD. It only generates the document type declaration in the XML request
output. To see the XML output, run http://localhost:8080/books/

books.jspx in your browser after you have updated books.WAR with books.DTD

and the jsp:output element. When using some browsers, you might need to
view the source of the page to actually see the output.

Directing the document type declaration to output without interpreting it is use-
ful in situations where another system receiving the output expects to see it. For
example, two companies who do business via a Web service might make use of a
standard DTD, against which any XML content exchanged between the compa-
nies is validated. The document type declaration tells the receiver the nature of
the data in the XML file.

For the JSP container to validate books.jspx against book.DTD, you need to
manually include the document type declaration in the books.jspx file rather
than using jsp:output. However, you need to add definitions for all tags in your
DTD, including definitions for standard elements and custom tags, like
jsp:useBean and c:forEach. You also need to ensure that the DTD is located in
the <J2EE_HOME>/domains/domain1/config directory so that the JSP container
will validate the JSP document against the DTD.
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Identifying the JSP Document to the
Container

A JSP document must be identified as such to the JSP container so that the con-
tainer interprets it as an XML document. There are three ways to do this:

• In your application’s web.xml file, set the is-xml element of the jsp-

property-group element to true. The section, The Example JSP
Document, page 538, step 17 explains how to do this if you are using
deploytool to build the application WAR file.

• Use a Servlet version 2.4 web.xml file and give your JSP document the
.jspx extension

• Include a jsp:root element in your JSP document. This method is back-
ward compatible with JSP 1.2.
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JavaServer Pages
Standard Tag Library

THE JavaServer Pages Standard Tag Library (JSTL) encapsulates core func-
tionality common to many JSP applications. For example, instead of iterating
over lists using a scriptlet or different iteration tags from numerous vendors,
JSTL defines a standard set of tags. This standardization allows you to learn a
single set of tags and use them on multiple JSP containers. Also, a standard tag
library is more likely to have an optimized implementation.

JSTL has support for common, structural tasks such as iteration and condition-
als, tags for manipulating XML documents, internationalization tags, and tags
for accessing databases using SQL.

This chapter demonstrates JSTL through excerpts from the JSP version of the
Duke’s Bookstore application discussed in the previous chapter. It assumes that
you are familiar with the material in the Using Custom Tags (page 525) section
of Chapter 12.

The Example JSP Pages
This chapter illustrates JSTL with excerpts from the JSP version of the Duke’s
Bookstore application discussed in Chapter 12 rewritten to replace the Java-
Beans component database helper object with direct calls to the database via the
JSTL SQL tags. For most applications, it is better to encapsulate calls to a data-
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base in a bean. JSTL includes SQL tags for situations where a new application is
being prototyped and the overhead of creating a bean may not be warranted.

The source for the Duke’s Bookstore application is located in the <INSTALL>/

j2eetutorial14/examples/web/bookstore4/ directory created when you
unzip the tutorial bundle (see About the Examples, page xxix). A sample
bookstore4.war is provided in <INSTALL>/j2eetutorial14/examples/web/

provided-wars/. To build, package, deploy, and run the example:

1. Build and package the bookstore common files as described in Duke’s
Bookstore Examples (page 109).

2. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/bookstore4/.

3. Run asant copy. This target will copy files to the <INSTALL>/

j2eetutorial14/examples/web/bookstore4/build/ directory.

4. Start the J2EE application server.

5. Perform all the operations described in Accessing Databases from Web
Applications, page 109.

6. Start deploytool.

7. Create a Web application called bookstore4 by running the New Web
Component Wizard. Select File→New→Web Component.

8. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/web/bookstore4/bookstore4.war.

c. In the WAR Name field, enter bookstore4.

d. In the Context Root field, enter /bookstore4.

e. Click Edit to add the content files.

f. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/bookstore4/build/. Select the JSP pages book-

store.jsp, bookdetails.jsp, bookcatalog.jsp, bookshow-

cart.jsp, bookcashier.jsp, bookreceipt.jsp and the template

directory and click Add.

g. Add the shared bookstore library. Navigate to <INSTALL>/

j2eetutorial14/examples/build/web/bookstore/dist/. Select
bookstore.jar and Click Add.

h. Click OK.

i. Click Next.
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j. Select the JSP radio button.

k. Click Next.

l. Select bookstore.jsp from the JSP Filename combo box.

m.Click Next.

n. Click Add. Enter the alias /bookstore.

o. Click Finish.

9. Add each of the Web components listed in Table 14–1. For each compo-
nent:

a. Select File→New→Web Component.

b. Click the Add to Existing WAR Module radio button Since the WAR
contains all of the JSP pages, you do not have to add any more content.

c. Click Next.

d. Select the JSP radio button and the Component Aliases checkbox.

e. Click Next.

f. Select the page from the JSP Filename combo box.

g. Click Finish.

10.Set the alias for each Web component.

a. Select the component.

b. Select the Aliases tab.

c. Click the Add button.

d. Enter the alias.

Table 14–1 Duke’s Bookstore Web Components

Web Component Name JSP Page Alias

bookcatalog bookcatalog.jsp /bookcatalog

bookdetails bookdetails.jsp /bookdetails

bookshowcart bookshowcart.jsp /bookshowcart

bookcashier bookcashier.jsp /bookcashier

bookreceipt bookreceipt.jsp /bookreceipt
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11.Add the JSTL resource bundle basename context parameter.

a. Select the Web module.

b. Select the Context tab.

c. Click Add.

d. Enter javax.servlet.jsp.jstl.fmt.localizationContext for the
Coded Parameter.

e. Enter messages.BookstoreMessages for the Value.

12.Set prelude and codas for all JSP pages.

a. Select the JSP Properties tab.

b. Click the Add button next to the Name list.

c. Enter bookstore4.

d. Click the Add button next to the URL Pattern list.

e. Enter *.jsp.

f. Click the Edit button next to the Include Preludes list.

g. Click Add.

h. Enter /template/prelude.jspf.

i. Click OK.

j. Click the Edit button next to the Include Codas list.

k. Click Add.

l. Enter /template/coda.jspf.

m.Click OK.

13.Add a resource reference for the database.

a. Select the Resource Refs tab.

b. Click Add.

c. Enter jdbc/BookDB in the Coded Name field.

d. Accept the default type javax.sql.DataSource.

e. Accept the default authorization Container.

f. Accept the default selected Shareable.

g. Enter jdbc/BookDB in the JNDI name field the Deployment setting for
jdbc/BookDB frame.

14.Select File→Save.

15.Deploy the application.

a. Select Tools→Deploy.
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b. Click OK.

16.Open the bookstore URL http://localhost:8080/bookstore4/book-

store.

See Troubleshooting (page 460) for help with diagnosing common problems.

Using JSTL
JSTL includes a wide variety of tags that fit into discrete functional areas. To
reflect this, as well as to give each area its own namespace, JSTL is exposed as
multiple tag libraries. The URIs for the libraries are:

• Core: http://java.sun.com/jsp/jstl/core

• XML: http://java.sun.com/jsp/jstl/xml

• Internationalization: http://java.sun.com/jsp/jstl/fmt

• SQL: http://java.sun.com/jsp/jstl/sql

• Functions: http://java.sun.com/jsp/jstl/functions

Table 14–2 summarizes these functional areas along with the prefixes used in
this tutorial.

Table 14–2 JSTL Tags

Area Subfunction Prefix

Core Variable Support

c
Flow Control

URL Management

Miscellaneous

XML Core

xFlow Control

Transformation
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Thus, the tutorial references the JSTL core tags in JSP pages with the following
taglib:

<%@ taglib uri="http://java.sun.com/jsp/jstl/core"
prefix="c" %>

In addition to declaring the tag libraries, tutorial examples access the JSTL API
and implementation. In the J2EE 1.4 Application Server, the JSTL TLDs and

libraries are distributed in the archive appserv-jstl.jarin <J2EE_HOME>/lib/

.This library is automatically loaded into the classpath of all Web applications
running on the J2EE application server so you don’t need to add it to your Web
application.

Tag Collaboration
Tags usually collaborate with their environment in implicit and explicit ways.
Implicit collaboration is done via a well defined interface that allows nested tags
to work seamlessly with the ancestor tag exposing that interface. The JSTL con-
ditional tags employ this mode of collaboration.

Explicit collaboration happens when a tag exposes information to its environ-
ment. JSTL tags expose information as JSP EL variables; the convention JSTL
follows is to use the name var for any tag attribute that exports information

I18n Locale

fmtMessage formatting

Number and date formatting

Database SQL sql

Functions Collection length
fn

String manipulation

Table 14–2 JSTL Tags (Continued)

Area Subfunction Prefix
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about the tag. For example, the forEach tag exposes the current item of the
shopping cart it is iterating over in the following way:

<c:forEach var="item" items="${sessionScope.cart.items}">
...

</c:forEach>

In situations where a tag exposes more than one piece of information, the name
var is used for the primary piece of information being exported, and an appro-
priate name is selected for any other secondary piece of information exposed.
For example, iteration status information is exported by the forEach tag via the
attribute status.

For situations where you want to use an EL variable exposed by a JSTL tag in an
expression in the page’s scripting language (see Chapter 16), you use the stan-
dard JSP element jsp:useBean to declare a scripting variable.

For example, bookshowcart.jsp removes a book from a shopping cart using a
scriptlet. The ID of the book to be removed is passed as a request parameter. The
value of the request parameter is first exposed as an EL variable (to be used later
by the JSTL sql:query tag) and then declared as scripting variable and passed
to the cart.remove method:

<c:set var="bookId" value="${param.Remove}"/>
<jsp:useBean id="bookId" type="java.lang.String" />
<% cart.remove(bookId); %>
<sql:query var="books"

dataSource="${applicationScope.bookDS}">
select * from PUBLIC.books where id = ?
<sql:param value="${bookId}" />

</sql:query>

../examples/web/bookstore4/web/bookshowcart.txt
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Core Tags
Table 14–3 summarizes the core tags, which include those related to expressions,
flow control, and a generic way to access URL-based resources whose content
can then be included or processed within the JSP page.

Variable Support Tags
The set tag sets the value of an EL variable or the property of an EL variable in
any of the JSP scopes (page, request, session, application). If the variable does
not already exist, it is created.

The JSP EL variable or property can be set either from attribute value:

<c:set var="foo" scope="session" value="..."/>

Table 14–3 Core Tags

Area Function Tags Prefix

Core Variable Support
remove
set

c

Flow Control

choose
when
otherwise

forEach
forTokens
if

URL Management

import
param

redirect
param

url
param

Miscellaneous
catch
out
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or from the body of the tag:

<c:set var="foo">
...

</c:set>

For example, the following sets a EL variable named bookID with the value of
the request parameter named Remove:

<c:set var="bookId" value="${param.Remove}"/>

To remove an EL variable, you use the remove tag. When the bookstore JSP
page bookreceipt.jsp is invoked, the shopping session is finished, so the cart

session attribute is removed as follows:

<c:remove var="cart" scope="session"/>

Flow Control Tags
To execute flow control logic, a page author must generally resort to using script-
lets. For example, the following scriptlet is used to iterate through a shopping
cart:

<%
Iterator i = cart.getItems().iterator();
while (i.hasNext()) {

ShoppingCartItem item =
(ShoppingCartItem)i.next();

...
%>

<tr>
<td align="right" bgcolor="#ffffff">
${item.quantity}
</td>
...

<%
}

%>

Flow control tags eliminate the need for scriptlets. The next two sections have
examples that demonstrate the conditional and iterator tags.

../examples/web/bookstore4/web/bookreceipt.txt
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Conditional Tags
The if tag allows the conditional execution of its body according to value of a
test attribute. The following example from bookcatalog.jsp tests whether the
request parameter Add is empty. If the test evaluates to true, the page queries the
database for the book record identified by the request parameter and adds the
book to the shopping cart:

<c:if test="${!empty param.Add}">
<c:set var="bid" value="${param.Add}"/>
<jsp:useBean id="bid"  type="java.lang.String" />
 <sql:query var="books"

dataSource="${applicationScope.bookDS}">
select * from PUBLIC.books where id = ?
<sql:param value="${bid}" />

</sql:query>
<c:forEach var="bookRow" begin="0" items="${books.rows}">

<jsp:useBean id="bookRow" type="java.util.Map" />
<jsp:useBean id="addedBook"

class="database.BookDetails" scope="page" />
...
<% cart.add(bid, addedBook); %>

...
</c:if>

The choose tag performs conditional block execution by the embedded when sub
tags. It renders the body of the first when tag whose test condition evaluates to
true. If none of the test conditions of nested when tags evaluate to true, then the
body of an otherwise tag is evaluated, if present.

For example, the following sample code shows how to render text based on a
customer’s membership category.

<c:choose>
<c:when test="${customer.category == 'trial'}" >

...
</c:when>
<c:when test="${customer.category == 'member'}" >

...
</c:when>

<c:when test="${customer.category == 'preferred'}" >
...

</c:when>

../examples/web/bookstore4/web/bookcatalog.txt
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<c:otherwise>
...

</c:otherwise>
</c:choose>

The choose, when, and otherwise tags can be used to construct an if-then-
else statement as follows:

<c:choose>
<c:when test="${count == 0}" >

No records matched your selection.
</c:when>
<c:otherwise>

${count} records matched your selection.
</c:otherwise>

</c:choose>

Iterator Tags
The forEach tag allows you to iterate over a collection of objects. You specify
the collection via the items attribute, and the current item is available through a
scope variable named by the item attribute.

A large number of collection types are supported by forEach, including all
implementations of java.util.Collection and java.util.Map. If the items

attribute is of type java.util.Map, then the current item will be of type
java.util.Map.Entry, which has the following properties:

• key - the key under which the item is stored in the underlying Map

• value - the value that corresponds to the key

Arrays of objects as well as arrays of primitive types (for example, int) are also
supported. For arrays of primitive types, the current item for the iteration is auto-
matically wrapped with its standard wrapper class (for example, Integer for
int, Float for float, and so on).

Implementations of java.util.Iterator and java.util.Enumeration are
supported but these must be used with caution. Iterator and Enumeration

objects are not resettable so they should not be used within more than one itera-
tion tag. Finally, java.lang.String objects can be iterated over if the string
contains a list of comma separated values (for example: Monday,Tues-
day,Wednesday,Thursday,Friday).
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Here’s the shopping cart iteration from the previous section with the forEach

tag:

<c:forEach var="item" items="${sessionScope.cart.items}">
...
<tr>

<td align="right" bgcolor="#ffffff">
${item.quantity}

</td>
...

</c:forEach>

The forTokens tag is used to iterate over a collection of tokens separated by a
delimiter.

URL Tags
The jsp:include element provides for the inclusion of static and dynamic
resources in the same context as the current page. However, jsp:include cannot
access resources that reside outside of the Web application and causes unneces-
sary buffering when the resource included is used by another element.

In the example below, the transform element uses the content of the included
resource as the input of its transformation. The jsp:include element reads the
content of the response, writes it to the body content of the enclosing transform
element, which then re-reads the exact same content. It would be more efficient
if the transform element could access the input source directly and avoid the
buffering involved in the body content of the transform tag.

<acme:transform>
<jsp:include page="/exec/employeesList"/>

<acme:transform/>

The import tag is therefore the simple, generic way to access URL-based
resources whose content can then be included and or processed within the JSP
page. For example, in XML Tags (page 572), import is used to read in the XML
document containing book information and assign the content to the scoped vari-
able xml:

<c:import url="/books.xml" var="xml" />
<x:parse doc="${xml}" var="booklist"

scope="application" />
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The param tag, analogous to the jsp:param tag (see jsp:param
Element, page 530), can be used with import to specify request parameters.

In Session Tracking (page 488) we discussed how an application must rewrite
URLs to enable session tracking whenever the client turns off cookies. You can
use the url tag to rewrite URLs returned from a JSP page. The tag includes the
session ID in the URL only if cookies are disabled; otherwise, it returns the URL
unchanged. Note that this feature requires the URL to be relative. The url tag
takes param subtags for including parameters in the returned URL. For example,
bookcatalog.jsp rewrites the URL used to add a book to the shopping cart as
follows:

<c:url var="url" value="/catalog" >
<c:param name="Add" value="${bookId}" />

</c:url>
<p><strong><a href="${url}">

The redirect tag sends an HTTP redirect to the client. The redirect tag takes
param subtags for including parameters in the returned URL.

Miscellaneous Tags
The catch tag provides a complement to the JSP error page mechanism. It
allows page authors to recover gracefully from error conditions that they can
control. Actions that are of central importance to a page should not be encapsu-
lated in a catch, so their exceptions will propagate to an error page. Actions
with secondary importance to the page should be wrapped in a catch, so they
never cause the error page mechanism to be invoked.

The exception thrown is stored in the variable identified by var, which always
has page scope. If no exception occurred, the scoped variable identified by var is
removed if it existed. If var is missing, the exception is simply caught and not
saved.

The out tag evaluates an expression and outputs the result of the evaluation to
the current JspWriter object. The syntax and attributes are

<c:out value="value" [escapeXml="{true|false}"]
[default="defaultValue"] />

If the result of the evaluation is a java.io.Reader object, data is first read from
the Reader object and then written into the current JspWriter object. The spe-

../examples/web/bookstore4/web/bookcatalog.txt
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cial processing associated with Reader objects improves performance when
large amount of data must be read and then written to the response.

If escapeXml is true, the character conversions listed in Table 14–4 are applied:

XML Tags
A key aspect of dealing with XML documents is to be able to easily access their
content. XPath, a W3C recommendation since 1999, provides an easy notation
for specifying and selecting parts of an XML document. The JSTL XML tag set,
listed in Table 14–5, is based on XPath (see How XPath Works, page 263).

Table 14–4 Character Conversions

Character
Character
Entity Code

< &lt;

> &gt;

& &amp;

' &#039;

" &#034;

Table 14–5 XML Tags

Area Function Tags Prefix

XML

Core
out
parse
set

x
Flow Control

choose
when
otherwise

forEach
if

Transformation
transform

param
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The XML tags use XPath as a local expression language; XPath expressions are
always specified using attribute select. This means that only values specified
for select attributes are evaluated using the XPath expression language. All
other attributes are evaluated using the rules associated with the JSP 2.0 expres-
sion language.

In addition to the standard XPath syntax, the JSTL XPath engine supports the
following scopes to access Web application data within an XPath expression:

• $foo

• $param:

• $header:

• $cookie:

• $initParam:

• $pageScope:

• $requestScope:

• $sessionScope:

• $applicationScope:

These scopes are defined in exactly the same way as their counterparts in the JSP
expression language discussed in Implicit Objects (page 514). Table 14–6 shows
some examples of using the scopes.

The XML tags are illustrated in another version (bookstore5) of the Duke’s
Bookstore application. This version replaces the database with an XML repre-
sentation of the bookstore database which is retrieved from another Web applica-
tion. The directions for building and deploying this version of the application are
in The Example JSP Document (page 538). A sample bookstore5.war is pro-
vided in <INSTALL>/j2eetutorial14/examples/web/provided-wars/.

Table 14–6 Example XPath Expressions

XPath Expression Result

$sessionScope:profile The session-scoped EL variable named profile

$initParam:mycom.productId
The String value of the mycom.productId context
parameter
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Core Tags
The core XML tags provide basic functionality to easily parse and access XML
data.

The parse tag parses an XML document and saves the resulting object in the EL
variable specified by attribute var. In bookstore5, the XML document is parsed
and saved to a context attribute in parseBooks.jsp, which is included by all JSP
pages that need access to the document:

<c:if test="${applicationScope:booklist == null}" >
<c:import url="${initParam.booksURL}" var="xml" />
<x:parse doc="${xml}" var="booklist" scope="application" />

</c:if>

The set and out tags parallel the behavior described in Variable Support
Tags (page 566) and Miscellaneous Tags (page 571) for the XPath local expres-
sion language. The set tag evaluates an XPath expression and sets the result into
a JSP EL variable specified by attribute var. The out tag evaluates an XPath
expression on the current context node and outputs the result of the evaluation to
the current JspWriter object.

The JSP page bookdetails.jsp selects a book element whose id attribute
matches the request parameter bookId and sets the abook attribute. The out tag
then selects the book’s title element and outputs the result.

<x:set var="abook"
select="$applicationScope.booklist/

books/book[@id=$param:bookId]" />
<h2><x:out select="$abook/title"/></h2>

As you have just seen, x:set stores an internal XML representation of a node
retrieved using an XPath expression; it doesn’t convert the selected node into a
String and store it. Thus, x:set is primarily useful for storing parts of docu-
ments for later retrieval.

If you want to store a String, you need to use x:out within c:set. The x:out

tag converts the node to a String, and c:set then stores the String as an EL

../examples/web/bookstore5/web/parseBooks.txt
../examples/web/bookstore5/web/bookdetails.txt
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variable. For example, bookdetails.jsp stores an EL variable containing a
book price, which is later provided as the value of a fmt tag, as follows:

<c:set var="price">
<x:out select="$abook/price"/>

</c:set>
<h4><fmt:message key="ItemPrice"/>:

<fmt:formatNumber value="${price}" type="currency"/>

The other option, which is more direct but requires that the user have more
knowledge of XPath, is to coerce the node to a String manually using XPath’s
string function.

<x:set var="price" select="string($abook/price)"/>

Flow Control Tags
The XML flow control tags parallel the behavior described in Flow Control
Tags (page 567) for the XPath expression language.

The JSP page bookcatalog.jsp uses the forEach tag to display all the books
contained in booklist as follows:

<x:forEach var="book"
select="$applicationScope:booklist/books/*">
<tr>

<c:set var="bookId">
<x:out select="$book/@id"/>

</c:set>=
<td bgcolor="#ffffaa">

<c:url var="url"
value="/bookdetails" >

<c:param name="bookId" value="${bookId}" />
<c:param name="Clear" value="0" />

</c:url>
<a href="${url}">
<strong><x:out select="$book/title"/>&nbsp;
</strong></a></td>

<td bgcolor="#ffffaa" rowspan=2>
<c:set var="price">

<x:out select="$book/price"/>
</c:set>
<fmt:formatNumber value="${price}" type="currency"/>
&nbsp;

</td>

../examples/web/bookstore5/web/bookdetails.txt
../examples/web/bookstore5/web/bookcatalog.txt
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<td bgcolor="#ffffaa" rowspan=2>
<c:url var="url" value="/catalog" >

<c:param name="Add" value="${bookId}" />
</c:url>
<p><strong><a href="${url}">&nbsp;

<fmt:message key="CartAdd"/>&nbsp;</a>
</td>

</tr>
<tr>

<td bgcolor="#ffffff">
&nbsp;&nbsp;<fmt:message key="By"/> <em>

<x:out select="$book/firstname"/>&nbsp;
<x:out select="$book/surname"/></em></td></tr>

</x:forEach>

Transformation Tags
The transform tag applies a transformation, specified by a XSLT stylesheet set
by the attribute xslt, to an XML document, specified by the attribute doc. If the
doc attribute is not specified, the input XML document is read from the tag’s
body content.

The param subtag can be used along with transform to set transformation
parameters. The attributes name and value are used to specify the parameter. The
value attribute is optional. If it is not specified the value is retrieved from the
tag’s body.

Internationalization Tags
Chapter 17 covers how to design Web applications so that they conform to the
language and formatting conventions of client locales. This section describes
tags that support the internationalization of JSP pages.

JSTL defines tags for: setting the locale for a page, creating locale-sensitive mes-
sages, and formatting and parsing data elements such as numbers, currencies,
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dates, and times in a locale-sensitive or customized manner. Table 14–7 lists the
tags.

JSTL i18n tags use a localization context to localize their data. A localization
context contains a locale and a resource bundle instance. To specify the localiza-
tion context, you define the context parameter javax.serv-

let.jsp.jstl.fmt.localizationContext, whose value can be a
javax.servlet.jsp.jstl.fmt.LocalizationContext or a String. A String

context parameter is interpreted as the name of a resource bundle basename. For
the Duke’s Bookstore application, the context parameter is the String mes-

sages.BookstoreMessages, which is set with deploytool in the Context tab of
the WAR inspector. This setting can be overridden in a JSP page by using the
JSTL fmt:setBundle tag. When a request is received, JSTL automatically sets
the locale based on the value retrieved from the request header and chooses the
correct resource bundle using the basename specified in the context parameter.

Setting the Locale
The setLocale tag is used to override the client-specified locale for a page. The
requestEncoding tag is used to set the request’s character encoding, in order to
be able to correctly decode request parameter values whose encoding is different
from ISO-8859-1.

Table 14–7 Internationalization Tags

Area Function Tags Prefix

I18n

Setting Locale
setLocale
requestEncoding

fmt

Messaging

bundle
message

param
setBundle

Number and Date Formatting

formatNumber
formatDate
parseDate
parseNumber
setTimeZone
timeZone
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Messaging Tags
By default, browser-sensing capabilities for locales are enabled. This means that
the client determines (via its browser settings) which locale to use, and allows
page authors to cater to the language preferences of their clients.

bundle Tag
You use the bundle tag to specify a resource bundle for a page.

To define a resource bundle for a Web application you specify the context param-
eter javax.servlet.jsp.jstl.fmt.localizationContext in the Web appli-
cation deployment descriptor.

message Tag
The message tag is used to output localized strings. The following tag from
bookcatalog.jsp

<h3><fmt:message key="Choose"/></h3>

is used to output a string inviting customers to choose a book from the catalog.

The param subtag provides a single argument (for parametric replacement) to the
compound message or pattern in its parent message tag. One param tag must be
specified for each variable in the compound message or pattern. Parametric
replacement takes place in the order of the param tags.

Formatting Tags
JSTL provides a set of tags for parsing and formatting locale-sensitive numbers
and dates.

The formatNumber tag is used to output localized numbers. The following tag
from bookshowcart.jsp

<fmt:formatNumber value="${book.price}" type="currency"/>

is used to display a localized price for a book. Note that since the price is main-
tained in the database in dollars, the localization is somewhat simplistic, because

../examples/web/bookstore4/web/bookcatalog.txt
../examples/web/bookstore4/web/bookshowcart.txt


SQL TAGS 579
the formatNumber tag is unaware of exchange rates. The tag formats currencies
but does not convert them.

Analogous tags for formatting dates (formatDate), and parsing numbers and
dates (parseNumber, parseDate) are also available. The timeZone tag estab-
lishes the time zone (specified via the value attribute) to be used by any nested
formatDate tags.

In bookreceipt.jsp, a “pretend” ship date is created and then formatted with
the formatDate tag:

<jsp:useBean id="now" class="java.util.Date" />
<jsp:setProperty name="now" property="time"

value="${now.time + 432000000}" />
<fmt:message key="ShipDate"/>
<fmt:formatDate value="${now}" type="date"

dateStyle="full"/>.

SQL Tags
The JSTL SQL tags listed in Table 14–8 are designed for quick prototyping and
simple applications. For production applications, database operations are nor-
mally encapsulated in JavaBeans components.

The setDataSource tag is provided to allow you to set data source information
for the database. You can provide a JNDI name or DriverManager parameters to

Table 14–8 SQL Tags

Area Function Tags Prefix

Data-
base

setDataSource

sql
SQL

query
dateParam
param

transaction
update

dateParam
param

../examples/web/bookstore4/web/bookreceipt.txt
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set the data source information. All of the Duke’s Bookstore pages that have
more than one SQL tag use the following statement to set the data source:

<sql:setDataSource dataSource="jdbc/BookDB" />

The query tag is used to perform an SQL query that returns a result set. For
parameterized SQL queries, you use a nested param tag inside the query tag.

In bookcatalog.jsp, the value of the Add request parameter determines which
book information should be retrieved from the database. This parameter is saved
as the attribute name bid and passed to the param tag. Notice that the query tag
obtains its data source from the context attribute bookDS set in the context lis-
tener.

<c:set var="bid" value="${param.Add}"/>
<sql:query var="books" >

select * from PUBLIC.books where id = ?
<sql:param value="${bid}" />

</sql:query>

The update tag is used to update a database row. The transaction tag is used to
perform a series of SQL statements atomically.

The JSP page bookreceipt.jsp page uses both tags to update the database
inventory for each purchase. Since a shopping cart can contain more than one
book, the transaction tag is used to wrap multiple queries and updates. First
the page establishes that there is sufficient inventory, then the updates are per-
formed.

<c:set var="sufficientInventory" value="true" />
<sql:transaction>

<c:forEach var="item" items="${sessionScope.cart.items}">
<c:set var="book" value="${item.item}" />
<c:set var="bookId" value="${book.bookId}" />

<sql:query var="books"
sql="select * from PUBLIC.books where id = ?" >
<sql:param value="${bookId}" />

</sql:query>
<jsp:useBean id="inventory"

class="database.BookInventory" />
<c:forEach var="bookRow" begin="0"

items="${books.rowsByIndex}">
<jsp:useBean id="bookRow" type="java.lang.Object[]" />
<jsp:setProperty name="inventory" property="quantity"

value="${bookRow[7]}" />

../examples/web/bookstore4/web/bookcatalog.txt
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<c:if test="${item.quantity > inventory.quantity}">
<c:set var="sufficientInventory" value="false" />
<h3><font color="red" size="+2">
<fmt:message key="OrderError"/>
There is insufficient inventory for
<i>${bookRow[3]}</i>.</font></h3>

</c:if>
</c:forEach>

</c:forEach>

<c:if test="${sufficientInventory == 'true'}" />
<c:forEach var="item" items="${sessionScope.cart.items}">
  <c:set var="book" value="${item.item}" />
  <c:set var="bookId" value="${book.bookId}" />

<sql:query var="books"
sql="select * from PUBLIC.books where id = ?" >
<sql:param value="${bookId}" />

</sql:query>

<c:forEach var="bookRow" begin="0"
items="${books.rows}">
<sql:update var="books" sql="update PUBLIC.books set

inventory = inventory - ? where id = ?" >
<sql:param value="${item.quantity}" />
<sql:param value="${bookId}" />

</sql:update>
</c:forEach>

</c:forEach>
<h3><fmt:message key="ThankYou"/>

${param.cardname}.</h3><br>
</c:if>

</sql:transaction>

query Tag Result Interface
The Result interface is used to retrieve information from objects returned from
a query tag.

public interface Result
public String[] getColumnNames();
public int getRowCount()
public Map[] getRows();
public Object[][] getRowsByIndex();
public boolean isLimitedByMaxRows();
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For complete information about this interface, see the API documentation for the
javax.servlet.jsp.jstl.sql package.

The var attribute set by a query tag is of type Result. The getRows method
returns an array of maps that can be supplied to the items attribute of a forEach

tag. The JSTL expression language converts the syntax ${result.rows} to a
call to result.getRows. The expression ${books.rows} in the following exam-
ple returns an array of maps.

When you provide a array of maps to the forEach tag, the var attribute set by
the tag is of type Map. To retrieve information from a row, use the
get("colname") method to get a column value. The JSTL expression language
converts the syntax ${map.colname} to a call to map.get("colname"). For
example, the expression ${book.title} returns the value of the title entry of a
book map.

The Duke’s Bookstore page bookdetails.jsp retrieves the column values from
the book map as follows.

<c:forEach var="book" begin="0" items="${books.rows}">
<h2>${book.title}</h2>
&nbsp;<fmt:message key="By"/> <em>${book.firstname}
${book.surname}</em>&nbsp;&nbsp;
(${book.year})<br> &nbsp; <br>
<h4><fmt:message key="Critics"/></h4>
<blockquote>${book.description}</blockquote>
<h4><fmt:message key="ItemPrice"/>:
<fmt:formatNumber value="${book.price}" type="currency"/>
</h4>

</c:forEach>

The following excerpt from bookcatalog.jsp uses the Row interface to retrieve
values from the columns of a book row using scripting language expressions.
First the book row that matches a request parameter (bid) is retrieved from the
database. Since the bid and bookRow objects are later used by tags that use
scripting language expressions to set attribute values and a scriptlet that adds a
book to the shopping cart, both objects are declared as scripting variables using
the jsp:useBean tag. The page creates a bean that describes the book and script-
ing language expressions are used to set the book properties from book row col-
umn values. Finally the book is added to the shopping cart.

http://java.sun.com/j2ee/1.4/docs/api/index.htmlapi/javax/servlet/jsp/jstl/sql/package-summary.html
../examples/web/bookstore4/web/bookdetails.txt
../examples/web/bookstore4/web/bookcatalog.txt
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You might want to compare this version of bookcatalog.jsp to the versions in
JavaServer Pages Technology (page 493) and Custom Tags in JSP
Pages (page 587) that use a book database JavaBeans component.

<sql:query var="books"
dataSource="${applicationScope.bookDS}">
select * from PUBLIC.books where id = ?
<sql:param value="${bid}" />

</sql:query>
<c:forEach var="bookRow" begin="0"

items="${books.rowsByIndex}">
<jsp:useBean id="bid"  type="java.lang.String" />
<jsp:useBean id="bookRow" type="java.lang.Object[]" />
<jsp:useBean id="addedBook" class="database.BookDetails"

scope="page" />
<jsp:setProperty name="addedBook" property="bookId"

value="${bookRow[0]}" />
<jsp:setProperty name="addedBook" property="surname"

value="${bookRow[1]}" />
<jsp:setProperty name="addedBook" property="firstName"

value="${bookRow[2]}" />
<jsp:setProperty name="addedBook" property="title"

value="${bookRow[3]}" />
<jsp:setProperty name="addedBook" property="price"

value="${bookRow[4])}" />
<jsp:setProperty name="addedBook" property="year"

value="${bookRow[6]}" />
<jsp:setProperty name="addedBook"

property="description"
value="${bookRow[7]}" />

<jsp:setProperty name="addedBook" property="inventory"
value="${bookRow[8]}" />

</jsp:useBean>
<% cart.add(bid, addedBook); %>
...

</c:forEach>
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Functions
Table 14–9 lists the JSTL functions

While the java.util.Collection interface defines a size method, it does not
conform to the JavaBeans design pattern for properties and cannot be accessed
via the JSP expression language. The length function can be applied to any col-
lection supported by the c:forEach and returns the length of the collection.
When applied to a String, it returns the number of characters in the string.

For example, the index.jsp page of the hello1 application introduced in
Chapter 3 uses the fn:length function and c:if tag to determine whether to
include a response page:

<%@ taglib uri="http://java.sun.com/jsp/jstl/core"
prefix="c" %>

<%@ taglib uri="http://java.sun.com/jsp/jstl/functions"
prefix="fn" %>

<html>
<head><title>Hello</title></head>
...
<input type="text" name="username" size="25">
<p></p>
<input type="submit" value="Submit">
<input type="reset" value="Reset">
</form>

Table 14–9 Functions

Area Function Tags Prefix

Functions Collection
length

length

fn

String
manipulation

toUpperCase, toLowerCase
substring, substringAfter,
substringBefore
trim
replace
indexOf, startsWith, endsWith,
contains, containsIgnoreCase
split, join
escapeXml
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<c:if test="${fn:length(param.username) > 0}" >
  <%@include file="response.jsp" %>
</c:if>
</body>
</html>

The rest of the JSTL functions are concerned with string manipulation:

• toUpperCase, toLowerCase - Changes the capitalization of a string.

• substring, substringBefore, substringAfter - Gets a subset of a
string.

• trim - Trims whitespace from a string.

• replace - Replaces characters in a string.

• indexOf, startsWith, endsWith, contains, containsIgnoreCase -
Checks if a string contains another string.

• split - Splits a string into an array.

• join - Joins a collection into a string.

• escapeXml - Escapes XML characters in a string.

Further Information
For further information on JSTL see:

• The JSTL 1.1 Specification. This chapter documents the early access
maintenance release of the JSTL Specification.
http://java.sun.com/products/jsp/jstl/index.html#specs

• The JSTL Web site
http://java.sun.com/products/jsp/jstl

http://java.sun.com/products/jsp/jstl/index.html#specs
http://java.sun.com/products/jsp/jstl
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Custom Tags in JSP
Pages

THE standard JSP tags simplify JSP page development and maintenance. JSP
technology also provides a mechanism for encapsulating other types of dynamic
functionality in custom tags, which are extensions to the JSP language. Some
examples of tasks that can be performed by custom tags include operations on
implicit objects, processing forms, accessing databases and other enterprise ser-
vices such as e-mail and directories, and flow control. Custom tags increase pro-
ductivity because they can be reused across more than one application.

Custom tags are distributed in a tag library, which defines a set of related custom
tags and contains the objects that implement the tags. The object that implements
a custom tag is called a tag handler. JSP technology defines two types of tag
handlers: simple and classic. Simple tag handlers can only be used for tags that
do not use scripting elements in attribute values or the tag body. Classic tag han-
dlers must be used if scripting elements are required. Simple tag handlers are
covered in this chapter and classic tag handlers are discussed in Chapter 16.

You can write simple tag handlers with the JSP language or with the Java lan-
guage. A tag file is a source file containing a reusable fragment of JSP code that
is translated into a simple tag handler by the Web container. Tag files can be used
to develop custom tags that are presentation-centric or that can take advantage of
existing tag libraries, or by page authors who do not know Java. For occasions
when the flexibility of the Java programming language is needed to define the
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tag, JSP technology provides a simple API for developing a tag handler in the
Java programming language.

This chapter assumes you are familiar with the material in Chapter 12, especially
the section Using Custom Tags (page 525). For more information about tag
libraries and for pointers to some freely-available libraries, see

http://java.sun.com/products/jsp/taglibraries.html

What Is a Custom Tag?
A custom tag is a user-defined JSP language element. When a JSP page contain-
ing a custom tag is translated into a servlet, the tag is converted to operations on
a tag handler. The Web container then invokes those operations when the JSP
page’s servlet is executed.

Custom tags have a rich set of features. They can

• Be customized via attributes passed from the calling page.

• Pass variables back to the calling page.

• Access all the objects available to JSP pages.

• Communicate with each other. You can create and initialize a JavaBeans
component, create a public EL variable that refers to that bean in one tag,
and then use the bean in another tag.

• Be nested within one another and communicate via private variables.

The Example JSP Pages
This chapter describes the tasks involved in defining tags. The chapter illustrates
the tasks with excerpts from the JSP version of the Duke’s Bookstore application
discussed in The Example JSP Pages (page 497) rewritten to take advantage of
several new custom tags:

• A catalog tag for rendering the book catalog

• A shipDate tag for rendering the ship date of an order

• A template library for ensuring a common look and feel among all screens
and composing screens out of content chunks

http://java.sun.com/products/jsp/taglibraries.html
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The last section in the chapter, Examples (page 634), describes several tags in
detail: a simplified iteration tag and the set of tags in the tutorial-template

tag library.

The tutorial-template tag library defines a set of tags for creating an applica-
tion template. The template is a JSP page with placeholders for the parts that
need to change with each screen. Each of these placeholders is referred to as a
parameter of the template. For example, a simple template could include a title
parameter for the top of the generated screen and a body parameter to refer to a
JSP page for the custom content of the screen. The template is created with a set
of nested tags—definition, screen, and parameter—that are used to build a
table of screen definitions for Duke’s Bookstore and with an insert tag to insert
parameters from the table into the screen.

Figure 15–1 shows the flow of a request through the following Duke’s Bookstore
Web components:

• template.jsp, which determines the structure of each screen. It uses the
insert tag to compose a screen from subcomponents.

• screendefinitions.jsp, which defines the subcomponents used by each
screen. All screens have the same banner, but different title and body con-
tent (specified by the JSP Page column in Table 12–1).

• Dispatcher, a servlet, which processes requests and forwards to tem-

plate.jsp.

../examples/web/bookstore3/web/template/template.txt
../examples/web/bookstore3/web/template/screendefinitions.txt
../examples/web/bookstore3/src/Dispatcher.java
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Figure 15–1 Request Flow Through Duke’s Bookstore Components

The source code for the Duke’s Bookstore application is located in the
<INSTALL>/j2eetutorial14/examples/web/bookstore3/ directory created
when you unzip the tutorial bundle (see About the Examples, page xxix). A sam-
ple bookstore3.war is provided in <INSTALL>/j2eetutorial14/examples/

web/provided-wars/. To build, package, deploy, and run the example:

1. Build and package the bookstore common files as described in Configuring
Web Modules (page 104).

2. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

bookstore3/.

3. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/

bookstore3/build/ directory.

4. Start the J2EE application server.

5. Perform all the operations described in Accessing Databases from Web
Applications, page 109.

6. Start deploytool.



THE EXAMPLE JSP PAGES 591
7. Create a Web application called bookstore3.

a. Select File→New→Web Component.

b. Select the Create New Stand-Alone WAR Module radio button.

c. Click Browse.

d. In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/web/bookstore3/bookstore3.war.

e. In the WAR Name field, enter bookstore3.

8. Add Web application files and libraries.

a. Click Edit.

b. Add the application content. In the Edit Contents dialog, navigate to
<INSTALL>/j2eetutorial14/examples/web/bookstore3/build/.
Select the JSP pages bookstore.jsp, bookdetails.jsp, bookcata-
log.jsp, bookshowcart.jsp, bookcashier.jsp, bookreceipt.jsp,
bookordererror.jsp, the tag files catalog.tag and shipDate.tag

and the dispatcher, database, listeners, and template directories
and click Add. Click OK.

c. Add the shared bookstore library. Navigate to <INSTALL>/

j2eetutorial14/examples/build/web/bookstore/dist/. Select
bookstore.jar and Click Add.

9. Define the Web component.

a. Click Next.

b. Select the Servlet radio button.

c. Click Next.

d. Select dispatcher.Dispatcher from the Servlet class combo box.

e. Click Finish.

10.In the Deployment Setting frame, set the Context Root field value to /

bookstore3.

11.Add the listener class listeners.ContextListener (described in Han-
dling Servlet Life Cycle Events, page 461).

a. Select the Event Listeners tab.

b. Click Add.

c. Select the listeners.ContextListener class from drop down field in
the Event Listener Classes panel.
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12.Add the aliases.

a. Select Dispatcher.

b. Select the Aliases tab.

c. Click Add and then type /bookstore in the Aliases field. Repeat to
add the aliases /bookcatalog, /bookdetails, /bookshowcart, /

bookcashier, /bookordererror, and /bookreceipt.

13.Add the JSTL resource bundle basename context parameter.

a. Select the Web module.

b. Select the Context tab.

c. Click Add.

d. Enter javax.servlet.jsp.jstl.fmt.localizationContext for the
Coded Parameter.

e. Enter messages.BookstoreMessages for the Value.

14.Set prelude for all JSP pages.

a. Select the JSP Properties tab.

b. Click the Add button next to the Name list.

c. Enter bookstore3.

d. Click the Add button next to the URL Pattern list.

e. Enter *.jsp.

f. Click the Edit button next to the Include Preludes list.

g. Click Add.

h. Enter /template/prelude.jspf.

i. Click OK.

15.Add a resource reference for the database.

a. Select the Resource Refs tab.

b. Click Add.

c. Enter jdbc/BookDB in the Coded Name field.

d. Accept the default type javax.sql.DataSource.

e. Accept the default authorization Container.

f. Accept the default selected Shareable.

g. Enter jdbc/BookDB in the JNDI name field of the Sun-specific Settings
frame.
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16.Deploy the application.

a. Select Tools→Deploy.

b. Click OK.

c. A popup dialog will display the results of the deployment. Click Close.

17.Open the bookstore URL
http://localhost:8080/bookstore3/bookstore.

See Troubleshooting (page 460) for help with diagnosing common problems.

Types of Tags
JSP simple tags are invoked using XML syntax. They have a start tag and end
tag, and possibly a body:

<tt:tag>
body

</tt:tag>

A custom tag with no body is expressed as follows:

<tt:tag /> or <tt:tag></tt:tag>

Tags with Attributes
A simple tag can have attributes. Attributes customize the behavior of a custom
tag just as parameters customize the behavior of a method.

There are three types of attributes:

• Simple attributes

• Fragment attributes

• Dynamic attributes

Simple Attributes
Simple attributes are evaluated by the container prior to being passed to the tag
handler. Simple attributes are listed in the start tag and have the syntax
attr="value". You can set a simple attribute value from a String constant, an
EL expression, or with a jsp:attribute element (see jsp:attribute
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Element, page 595). The conversion process between the constants and expres-
sions and attribute types follows the rules described for JavaBeans component
properties in Setting JavaBeans Component Properties (page 522).

The Duke’s Bookstore page bookcatalog.jsp calls the catalog tag which has
two attributes. The first attribute, a reference to a book database object, is set by
an EL expression. The second attribute, which sets the color of the rows in a
table that represents the bookstore catalog, is set with a String constant.

<sc:catalog bookDB ="${bookDB}" color="#cccccc">

Fragment Attributes
A JSP fragment is a portion of JSP code passed to a tag handler that can be
invoked as many times as needed. You can think of a fragment as a template that
is used by a tag handler to produce customized content. Thus, unlike simple
attributes which are evaluated by the container, fragment attributes are evaluated
by tag handlers during tag invocation.

You declare an attribute to be a fragment by using the fragment attribute in a tag
file attribute directive (see Declaring Tag Attributes in Tag Files, page 603) or
by using the fragment subelement of the attribute TLD element (see Declar-
ing Tag Attributes for Tag Handlers, page 621). You define the value of fragment
attribute with a jsp:attribute element. When used to specify a fragment
attribute, the body of the jsp:attribute element can only contain template text
and standard and custom tags; it cannot contain scripting elements (see
Chapter 16).

JSP fragments can be parametrized via expression language (EL) variables in the
JSP code that composes the fragment. The EL variables are set by the tag han-
dler, thus allowing the handler to customize the fragment each time it is invoked
(see Declaring Tag Variables in Tag Files, page 604 and Declaring Tag Variables
for Tag Handlers, page 622).

The catalog tag discussed earlier accepts two fragments: normalPrice, which
is displayed for a product that’s full price, and onSale, which is displayed for a
product that’s on sale.

<sc:catalog bookDB ="${bookDB}" color="#cccccc">
<jsp:attribute name="normalPrice">

<fmt:formatNumber value="${price}" type="currency"/>
  </jsp:attribute>

<jsp:attribute name="onSale">
<strike><fmt:formatNumber value="${price}"

../examples/web/bookstore3/web/bookcatalog.txt
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type="currency"/></strike><br/>
<font color="red"><fmt:formatNumber value="${salePrice}"

type="currency"/></font>
</jsp:attribute>

</sc:catalog>

The tag executes the normalPrice fragment, using the values for the price EL
variable, if the product is full price. If the product is on sale, the tag executes the
onSale fragment, using the price and salePrice variables.

Dynamic Attributes
A dynamic attribute is an attribute that is not specified in the definition of the
tag. Dynamic attributes are primarily used by tags whose attributes are treated in
a uniform manner, but whose names are not necessarily known at development
time.

For example, this tag accepts an arbitrary number of attributes whose values are
colors and outputs a bulleted list of the attributes colored according to the values:

<colored:colored color1="red" color2="yellow" color3="blue"/>

You can also set the value of dynamic attributes with an EL expression or using
the jsp:attribute element.

jsp:attribute Element
The jsp:attribute element allows you to define the value of a tag attribute in
the body of an XML element instead of in the value of an XML attribute.

For example, the Duke’s Bookstore template page screendefinitions.jsp

uses jsp:attribute to use the output of fmt:message to set the value of the
value attribute of tt:parameter:

...
<tt:screen id="/bookcatalog">

<tt:parameter name="title" direct="true">
<jsp:attribute name="value" >

<fmt:message key="TitleBookCatalog"/>
</jsp:attribute>

</tt:parameter>
<tt:parameter name="banner" value="/template/banner.jsp"

direct="false"/>
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<tt:parameter name="body" value="/bookcatalog.jsp"
direct="false"/>

</tt:screen>
...

jsp:attribute accepts a name attribute and a trim attribute. The name attribute
identifies which tag attribute is being specified. The optional trim attribute
determines whether whitespace appearing at the beginning and end of the ele-
ment body should be discarded or not. By default, the leading and trailing
whitespace is discarded. The whitespace is trimmed when the JSP page is trans-
lated. If a body contains a custom tag that produces leading or trailing
whitespace, that whitespace is preserved regardless of the value of the trim

attribute.

An empty body is equivalent to specifying "" as the value of the attribute.

The body of jsp:attribute is restricted according to the type of attribute being
specified:

• For simple attributes that accept an EL expression, the body can be any JSP
content.

• For simple attributes that do not accept an EL expression, the body can
only contain template text.

• For fragment attributes, the body must not contain any scripting elements
(See Chapter 16).

Tags with Bodies
A simple tag can contain custom and core tags, HTML text, and tag-dependent
body content between the start and end tag.

In the following example, the Duke’s Bookstore application page bookshow-

cart.jsp uses the JSTL c:if tag to print the body if the request contains a
parameter named Clear:

<c:if test="${param.Clear}">
<font color="#ff0000" size="+2"><strong>
You just cleared your shopping cart!
</strong><br>&nbsp;<br></font>

</c:if>

../examples/web/bookstore3/web/bookshowcart.txt
../examples/web/bookstore3/web/bookshowcart.txt
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jsp:body Element
You can also specify the body of a simple tag explicitly using the jsp:body ele-
ment. If one or more attributes are specified with the jsp:attribute element,
then jsp:body is the only way to specify the body of the tag. If one or more
jsp:attribute elements appear in the body of a tag invocation but you don’t
include a jsp:body element, the tag has an empty body.

Tags That Define Variables
A simple tag can define an EL variable that can be used within the calling page.
In the following example, the iterator tag sets the value of the EL variable
departmentName as it iterates through a collection of department names.

<tlt:iterator var="departmentName" type="java.lang.String"
group="${myorg.departmentNames}">

<tr>
<td><a href="list.jsp?deptName=${departmentName}">

${departmentName}</a></td>
</tr>

</tlt:iterator>

Communication Between Tags
Custom tags communicate with each other through shared objects. There are two
types of shared objects: public and private.

In the following example, the c:set tag creates a public EL variable called
aVariable, which is then reused by anotherTag.

<c:set var="aVariable" value="aValue" />
<tt:anotherTag attr1="${aVariable}" />

Nested tags can share private objects. In the next example, an object created by
outerTag is available to innerTag. The inner tag retrieves its parent tag and then
retrieves an object from the parent. Since the object is not named, the potential
for naming conflicts is reduced.

<tt:outerTag>
<tt:innerTag />

</tt:outerTag>
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The Duke’s Bookstore page template.jsp uses a set of cooperating tags that
share public and private objects to define the screens of the application. These
tags are described in A Template Tag Library (page 636).

Encapsulating Reusable Content using
Tag Files

A tag file is a source file that contains a fragment of JSP code that is reusable as
a custom tag. Tag files allow you to create custom tags using JSP syntax. Just as
a JSP page gets translated into a servlet class and then compiled, a tag file gets
translated into a tag handler and then compiled.

The recommended file extension for a tag file is .tag. As is the case with JSP
files, the tag may be composed of a top file that includes other files that contain
either a complete tag or a fragment of a tag file. Just as the recommended exten-
sion for a fragment of a JSP file is .jspf, the recommended extension for a frag-
ment of a tag file is .tagf.

The following version of the Hello, World application introduced in Chapter 3
uses a tag to generate the response. The response tag, which accepts two
attributes—a greeting string and a name—is encapsulated in response.tag:

<%@ attribute name="greeting" required="true" %>
<%@ attribute name="name" required="true" %>
<h2><font color="black">${greeting}, ${name}!</font></h2>

The highlighted line in greeting.jsp page invokes the response tag if the
length of the username request parameter is greater than 0:

<%@ taglib tagdir="/WEB-INF/tags" prefix="h" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/core"

prefix="c" %>
<%@ taglib uri="http://java.sun.com/jsp/jstl/functions"

prefix="fn" %>
<html>
<head><title>Hello</title></head>
<body bgcolor="white">
<img src="duke.waving.gif">
<c:set var="greeting" value="Hello" />
<h2>${greeting}, my name is Duke. What's yours?</h2>
<form method="get">
<input type="text" name="username" size="25">
<p></p>

../examples/web/bookstore3/web/template/template.txt


ENCAPSULATING REUSABLE CONTENT USING TAG FILES 599
<input type="submit" value="Submit">
<input type="reset" value="Reset">
</form>

<c:if test="${fn:length(param.username) > 0}" >
<h:response greeting=”${greeting}”

name="${param.username}"/>
</c:if>
</body>
</html>

A sample hello3.war is provided in <INSTALL>/j2eetutorial14/examples/

web/provided-wars/. To build, package, deploy, and run the hello3 applica-
tion:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

web/hello3/.

2. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/web/hello3/

build/ directory.

3. Start the J2EE application server.

4. Start deploytool.

5. Create a Web application called hello3 by running the New Web Compo-
nent Wizard. Select File→New→Web Component.

6. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/web/hello3/hello3.war.

c. In the WAR Name field enter hello3.

d. In the Context Root field, enter /hello3.

e. Click Edit to add the content files.

f. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/web/hello3/build/. Select duke.waving.gif, greet-

ing.jsp, and response.tag and click Add. Click OK.

g. Click Next.

h. Select the JSP radio button.

i. Click Next.

j. Select greeting.jsp from the Servlet Class combo box.

k. Click Finish.
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7. Set greeting.jsp to be a welcome file (see Declaring Welcome
Files, page 106).

a. Select the File Refs tab.

b. Click Add to add a welcome file.

c. Select greeting.jsp from the drop-down list.

8. Select File→Save.

9. Deploy the application.

a. Select Tools→Deploy.

b. In the Connection Settings frame, enter the user name and password you
specified when you installed the J2EE 1.4 Application Server.

c. Click OK.

d. A popup dialog will display the results of the deployment. Click Close.

10.Open your browser to http://localhost:8080/hello3

Tag File Location
Tag files can be placed in one of two locations: in the /WEB-INF/tags/ directory
or subdirectory of a Web application or in a JAR file (see Packaged Tag
Files, page 619) in the /WEB-INF/lib/ directory of a Web application. Pack-
aged tag files require a tag library descriptor (see Tag Library
Descriptors, page 614), an XML document that contains information about a
library as a whole and about each tag contained in the library. Tag files that
appear in any other location are not considered tag extensions and are ignored by
the Web container.
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Tag File Directives
Directives are used to control aspects of tag file translation to a tag handler, spec-
ify aspects of the tag, attributes of the tag, and variables exposed by the tag.
Table 15–1 lists the directives that you can use in tag files.

Declaring Tags
The tag directive is similar to the JSP page’s page directive, but applies to tag
files. Some of the elements in the tag directive appear in the tag element of a

Table 15–1 Tag File Directives

Directive Description

taglib
Identical to taglib directive (see Declaring Tag Libraries, page 525) for JSP
pages.

include
Identical to include directive (see Reusing Content in JSP Pages, page 529)
for JSP pages. Note that if the included file contains syntax unsuitable for tag
files, a translation error will occur.

tag

Similar to the page directive in a JSP page, but applies to tag files instead of
JSP pages. Like the page directive, a translation unit can contain more than
one instance of the tag directive. All the attributes apply to the complete
translation unit. However, there can be only one occurrence of any attribute/
value defined by this directive in a given translation unit. With the exception
of the import attribute, multiple attribute/value (re)definitions result in a
translation error.

Also used for declaring custom tag properties such as display name. See
Declaring Tags (page 601).

attribute
Declares attributes of the custom tag defined in the tag file. See body-content
Attribute (page 603).

variable
Declares an EL variable exposed by the tag to the calling page. See Declaring
Tag Variables in Tag Files (page 604).
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TLD (see Declaring Tag Handlers, page 619). Table 15–2 lists the tag directive
attributes.

Table 15–2 tag Directive Attributes

Attribute Description

display-name
(optional) A short name that is intended to be displayed by tools.
Defaults to the name of the tag file without the extension .tag.

body-content

(optional) Provides information on the content of the body of the
tag. Can be either empty, tagdependent, or scriptless. A
translation error will result if JSP or any other value is used.
Defaults to scriptless. See body-content Attribute (page 603).

dynamic-attributes

(optional) Indicates whether this tag supports additional attributes
with dynamic names. The value identifies a scoped attribute in
which to place a Map containing the names and values of the
dynamic attributes passed during invocation of the tag.

A translation error results if the value of the dynamic-
attributes of a tag directive is equal to the value of a name-
given of a variable directive or the value of a name attribute of
an attribute directive.

small-icon
(optional) Relative path, from the tag source file, of an image file
containing a small icon that can be used by tools. Defaults to no
small icon.

large-icon
(optional) Relative path, from the tag source file, of an image file
containing a large icon that can be used by tools. Defaults to no
large icon.

description
(optional) Defines an arbitrary string that describes this tag.
Defaults to no description.

example
(optional) Defines an arbitrary string that presents an informal
description of an example of a use of this action. Defaults to no
example.

language
(optional) Carries the same syntax and semantics of the language
attribute of the page directive.

import
(optional) Carries the same syntax and semantics of the import
attribute of the page directive.
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body-content Attribute
You specify the character of a tag’s body content using the body-content

attribute:

bodycontent="empty | scriptless | tagdependent"

You must declare the body content of tags that do not accept a body as empty.
For tags that have a body there are two options. Body content containing custom
and standard tags and HTML text is specified as scriptless. All other types of
body content—for example, SQL statements passed to the query tag—is speci-
fied as tagdependent. If no attribute is specified, the default is scriptless.

Declaring Tag Attributes in Tag Files
You declare the attributes of a custom tag defined in a tag file with the
attribute directive. A TLD has an analogous attribute element (see Declar-
ing Tag Attributes for Tag Handlers, page 621). Table 15–3 lists the attribute

directive attributes:

pageEncoding
(optional) Carries the same syntax and semantics of the pageEn-
coding attribute in the page directive.

isELIgnored
(optional) Carries the same syntax and semantics of the isELI-
gnored attribute of the page directive.

Table 15–3 attribute Directive Attributes

Attribute Description

description (optional) Description of the attribute. Defaults to no description.

Table 15–2 tag Directive Attributes (Continued)

Attribute Description
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Declaring Tag Variables in Tag Files
Tag attributes are used to customize tag behavior much like parameters are used
to customize the behavior of object methods. In fact, using tag attributes and EL
variables, is it possible to emulate various types of parameters—IN, OUT, and
nested.

To emulate IN parameters, use tag attributes. A tag attribute is communicated
between the calling page and the tag file when the tag is invoked. No further
communication occurs between the calling page and tag file.

name

The unique name of the attribute being declared. A translation error results
if more than one attribute directive appears in the same translation unit
with the same name.

A translation error results if the value of a name attribute of an attribute
directive is equal to the value of dynamic-attributes attribute of a tag
directive or the value of a name-given attribute of a variable directive.

required
(optional) Whether this attribute is required (true) or optional (false).
Defaults to false.

rtexprvalue
(optional) Whether the attribute’s value may be dynamically calculated at
runtime by an expression. Defaults to true.

type
(optional) The runtime type of the attribute’s value. Defaults to
java.lang.String.

fragment

(optional) Whether this attribute is a fragment to be evaluated by the tag
handler (true) or a normal attribute to be evaluated by the container prior to
being passed to the tag handler.

If this attribute is true:
You do not specify the rtexprvalue attribute. The container fixes the
rtexprvalue attribute at true.
You do not specify the type attribute. The container fixes the type attribute
at javax.servlet.jsp.tagext.JspFragment.

Defaults to false.

Table 15–3 attribute Directive Attributes (Continued)

Attribute Description
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To emulate OUT or nested parameters, use EL variables. The variable is not ini-
tialized by the calling page, but set by the tag file. Each type of parameter is syn-
chronized with the calling page at various points according to the scope of the
variable. See Variable Synchronization (page 606) for details.

You declare an EL variable exposed by a tag file with the variable directive. A
TLD has an analogous variable element (see Declaring Tag Variables for Tag
Handlers, page 622). Table 15–4 lists the variable directive attributes:

Table 15–4 variable Directive Attributes

Attribute Description

description
(optional) An optional description of this variable. Defaults to no
description.

name-given |
name-from-
attribute

Defines an EL variable to be used in the page invoking this tag. Either
name-given or name-from-attribute must be specified. If name-
given is specified, the value is the name of the variable. If name-
from-attribute is specified, the value is the name of an attribute
whose (translation-time) value at of the start of the tag invocation will
give the name of the variable.
Translation errors arise in the following circumstances:

1. Specifying neither name-given or name-from-attribute or
both.
2. If two variable directives have the same name-given.
3. If the value of name-given attribute of a variable directive is
equal to the value of a name attribute of an attribute directive or the
value of dynamic-attributes attribute of a tag directive.

alias

Defines a variable, local to the tag file, to hold the value of the EL vari-
able. The container will synchronize this value with the variable whose
name is given in name-from-attribute.

Required when name-from-attribute is specified. A translation
error results if used without name-from-attribute.

A translation error results if the value of alias is the same as the value
of a name attribute of an attribute directive or the name-given
attribute of a variable directive.

variable-class
(optional) The name of the class of the variable. The default is
java.lang.String.

declare (optional) Whether the variable is declared or not. True is the default.
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Variable Synchronization
The Web container handles the synchronization of variables between a tag file
and a calling page. Table 15–5 summarizes when and how each object is syn-
chronized according to the object’s scope.

If name-given is used to specify the variable name, the name of the variable in
the calling page and the name of the variable in the tag file are the same and are
equal to the value of name-given.

The name-from-attribute and alias attributes of the variable directive can
be used to customize the name of the variable in the calling page while using
another name in the tag file. When using these attributes, the name of the vari-
able in the calling page is set from the value of name-from-attribute at the
time the tag was called. The name of the corresponding variable in the tag file is
the value of alias.

scope
(optional) The scope of the variable. Can be either AT_BEGIN, AT_END,
or NESTED. Defaults to NESTED.

Table 15–5 Variable Synchronization Behavior

AT_BEGIN NESTED AT_END

Beginning of tag file not synch. save not synch.

Before any fragment invocation via
jsp:invoke or jsp:doBody (see
Evaluating Fragments Passed to Tag

Files, page 609)

tag→page tag→page not synch

End of tag file tag→page restore tag→page

Table 15–4 variable Directive Attributes

Attribute Description



TAG FILE DIRECTIVES 607
Synchronization Examples
The following examples illustrate how variable synchronization works between
a tag file and its calling page. All the example JSP pages and tag files reference
the JSTL core tag library with the prefix c. The JSP pages reference a tag file
located in /WEB-INF/tags with the prefix my.

AT_BEGIN Scope
In this example, the AT_BEGIN scope is used to pass the value of the variable
named x to the tag’s body and at the end of the tag invocation.

<%-- callingpage.jsp --%>
<c:set var="x" value="1"/>
${x} <%-- (x == 1) --%>
<my:example>

${x} <%-- (x == 2) --%>
</my:example>
${x} <%-- (x == 4) --%>

<%-- example.tag --%>
<%@ variable name-given="x" scope="AT_BEGIN" %>
${x} <%-- (x == null) --%>
<c:set var="x" value="2"/>
<jsp:doBody/>
${x} <%-- (x == 2) --%>
<c:set var="x" value="4"/>

NESTED Scope
In this example, the NESTED scope is used to make a variable named x available
only to the tag’s body. The tag sets the variable to 2 and this value is passed to
the calling page before the body is invoked. Since the scope is NESTED, and the
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calling page also had a variable named x, its original value, 1, is restored when
the tag completes.

<%-- callingpage.jsp --%>
<c:set var="x" value="1"/>
${x} <%-- (x == 1) --%>
<my:example>

${x} <%-- (x == 2) --%>
</my:example>
${x} <%-- (x == 1) --%>

<%-- example.tag --%>
<%@ variable name-given="x" scope="NESTED" %>
${x} <%-- (x == null) --%>
<c:set var="x" value="2"/>
<jsp:doBody/>
${x} <%-- (x == 2) --%>
<c:set var="x" value="4"/>

AT_END Scope
In this example, the AT_END scope is used to return a value to the page. The body
of the tag is not affected.

<%-- callingpage.jsp --%>
<c:set var="x" value="1"/>
${x} <%-- (x == 1) --%>
<my:example>

${x} <%-- (x == 1) --%>
</my:example>
${x} <%-- (x == 4) --%>

<%-- example.tag --%>
<%@ variable name-given="x" scope="AT_END" %>
${x} <%-- (x == null) --%>
<c:set var="x" value="2"/>
<jsp:doBody/>
${x} <%-- (x == 2) --%>
<c:set var="x" value="4"/>

AT_BEGIN and name-from-attribute
In this example the AT_BEGIN scope is used to pass an EL variable to the tag’s
body, and make it available to the calling page at the end of the tag invocation.
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The name of the variable is specified via the value of the attribute var. The vari-
able is referenced by a local name, result, in the tag file.

<%-- callingpage.jsp --%>
<c:set var="x" value="1"/>
${x} <%-- (x == 1) --%>
<my:example var="x">

${x} <%-- (x == 2) --%>
${result} <%-- (result == null) --%>
<c:set var="result" value="invisible"/>

</my:example>
${x} <%-- (x == 4) --%>
${result} <%-- (result == ‘invisible’) --%>

<%-- example.tag --%>
<%@ attribute name="var" required="true" rtexprvalue="false"%>
<%@ variable alias="result" name-from-attribute="var"

scope="AT_BEGIN" %>
${x} <%-- (x == null) --%>
${result} <%-- (result == null) --%>
<c:set var="x" value="ignored"/>
<c:set var="result" value="2"/>
<jsp:doBody/>
${x} <%-- (x == ‘ignored’) --%>
${result} <%-- (result == 2) --%>
<c:set var="result" value="4"/>

Evaluating Fragments Passed to Tag Files
When a tag file is executed, the Web container passes it two types of fragments:
fragment attributes and the tag body, which is implemented as a fragment. Recall
from the discussion of fragment attributes that fragments are evaluated by the tag
handler as opposed to the Web container. Within a tag file, you use the
jsp:invoke element to evaluate a fragment attribute and the jsp:doBody ele-
ment to evaluate a tag file body.

The result of evaluating either type of fragment is sent to the response or stored
in an EL variable for later manipulation. To store the result of evaluating a frag-
ment to an EL variable, you specify the var or varReader attributes. If var is
specified, the container stores the result in an EL variable of type String with
the name specified by var. If varReader is specified, the container stores the
result in an EL variable of type java.io.Reader with the name specified by
varReader. The Reader object can then be passed to a custom tag for further
processing. A translation error occurs if both var and varReader are specified.
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An optional scope attribute indicates the scope of the resulting variable. The
possible values are page (default), request, session, or application. A trans-
lation error occurs if this attribute appears without specifying the var or
varReader attribute.

Examples

Simple Attributes
The Duke’s Bookstore shipDate tag, defined in shipDate.tag, is a custom tag
with a simple attribute. The tag generates the date of a book order according to
the type of shipping requested.

<%@ taglib prefix="sc" tagdir="/WEB-INF/tags" %>
<h3><fmt:message key="ThankYou"/> ${param.cardname}.</h3><br>
<fmt:message key="With"/>
<em><fmt:message key="${param.shipping}"/></em>,
<fmt:message key="ShipDateLC"/>
<sc:shipDate shipping="${param.shipping}" />

The tag determines the number of days until shipment from the shipping

attribute passed to it by the page bookreceipt.jsp. From the days, the tag com-
putes the ship date. It then formats the ship date.

<%@ attribute name="shipping" required="true" %>

<jsp:useBean id="now" class="java.util.Date" />
<jsp:useBean id="shipDate" class="java.util.Date" />
<c:choose>
  <c:when test="${shipping == 'QuickShip'}">
    <c:set var="days" value="2" />
  </c:when>
  <c:when test="${shipping == 'NormalShip'}">
    <c:set var="days" value="5" />
  </c:when>
  <c:when test="${shipping == 'SaverShip'}">
    <c:set var="days" value="7" />
  </c:when>
</c:choose>
<jsp:setProperty name="shipDate" property="time"

value="${now.time + 86400000 * days}" />
<fmt:formatDate value="${shipDate}" type="date"

dateStyle="full"/>.<br><br>

../examples/web/bookstore3/web/shipDate.txt
../examples/web/bookstore3/web/bookreceipt.txt
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Simple and Fragment Attributes and
Variables
The Duke’s Bookstore catalog tag, defined in catalog.tag, is a custom tag
with simple and fragment attributes and variables. The tag renders the catalog of
a book database as an HTML table. The tag file declares that it sets variables
named price and salePrice via variable directives. The fragment normal-
Price uses the variable price and the fragment onSale uses the variables price
and salePrice. Before the tag invokes the fragment attributes with the
jsp:invoke element, the Web container passes values for the variables back to
the calling page.

<%@ attribute name="bookDB" required="true"
type="database.BookDB" %>

<%@ attribute name="color" required="true" %>
<%@ attribute name="normalPrice" fragment="true" %>
<%@ attribute name="onSale" fragment="true" %>

<%@ variable name-given="price" %>
<%@ variable name-given="salePrice" %>

<center>
<table>
<c:forEach var="book" begin="0" items="${bookDB.books}">

<tr>
<c:set var="bookId" value="${book.bookId}" />
<td bgcolor="${color}">

<c:url var="url" value="/bookdetails" >
<c:param name="bookId" value="${bookId}" />

</c:url>
<a href="${url}"><

strong>${book.title}&nbsp;</strong></a></td>
<td bgcolor="${color}" rowspan=2>
<c:set var="salePrice" value="${book.price * .85}" />
<c:set var="price" value="${book.price}" />
<c:choose>

<c:when test="${book.onSale}" >
<jsp:invoke fragment="onSale" />

</c:when>
<c:otherwise>

<jsp:invoke fragment="normalPrice"/>
</c:otherwise>

</c:choose>

&nbsp;</td>

../examples/web/bookstore3/web/catalog.txt
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...
</table>
</center>

The page bookcatalog.jsp invokes the catalog tag with simple attributes
bookDB, which contains catalog data, and color, which customizes the coloring
of the table rows. The formatting of the book price is determined by two frag-
ment attributes—normalPrice and onSale—that are conditionally invoked by
the tag according to data retrieved from the book database.

<sc:catalog bookDB ="${bookDB}" color="#cccccc">
<jsp:attribute name="normalPrice">

<fmt:formatNumber value="${price}" type="currency"/>
</jsp:attribute>
<jsp:attribute name="onSale">

<strike>
<fmt:formatNumber value="${price}" type="currency"/>
</strike><br/>
<font color="red">
<fmt:formatNumber value="${salePrice}" type="currency"/>
</font>

</jsp:attribute>
</sc:catalog>

The screen produced by bookcatalog.jsp is shown in Figure 15–2. You can
compare it to the version in Figure 12–2.

../examples/web/bookstore3/web/bookcatalog.txt
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Figure 15–2 Book Catalog

Dynamic Attributes
The following code implements the tag discussed in Dynamic
Attributes (page 595). An arbitrary number of attributes whose values are colors
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are stored in a Map named by the dynamic-attributes attribute of the tag

directive. The JSTL forEach tag is used to iterate through the Map and the
attribute keys and colored attribute values are printed in a bulleted list.

<%@ tag dynamic-attributes="colorMap"%>
<ul>
<c:forEach var="color" begin="0" items="${colorMap}">

<li>${color.key} =
<font color="${color.value}">${color.value}</font><li>

</c:forEach>
</ul>

Tag Library Descriptors
If you want to redistribute your tag files or implement your custom tags with tag
handlers written in Java, you need to declare the tags in a tag library descriptor
(TLD). A tag library descriptor (TLD) is an XML document that contains infor-
mation about a library as a whole and about each tag contained in the library.
TLDs are used by a Web container to validate the tags and by JSP page develop-
ment tools.

Tag library descriptor file names must have the extension .tld and must be
packaged in the /WEB-INF/ directory or subdirectory of the WAR file or in the /

META-INF/ directory or subdirectory of a tag library packaged in a JAR. If a tag
is implemented as a tag file and is packaged in /WEB-INF/tags/or a subdirec-
tory, a TLD will be automatically generated by the Web container, though you
can provide one if you wish.

A TLD must begin with a root taglib element that specifies the schema and
required JSP version:

<taglib xmlns="http://java.sun.com/xml/ns/j2ee"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/j2ee/web-

jsptaglibrary_2_0.xsd"
version="2.0">
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Table 15–6 lists the subelements of the taglib element:

This section describes the top-level elements of TLDs. Subsequent sections
describe how to declare tags defined in tag files, how to declare tags defined in
tag handlers, and how to declare tag attributes and variables.

Table 15–6 taglib Subelements

Element Description

description (optional) A string describing the use of the tag library.

display-name (optional) Name intended to be displayed by tools.

icon (optional) Icon that can be used by tools.

tlib-version The tag library’s version.

short-name (optional) Name that could be used by a JSP page authoring tool to cre-
ate names with a mnemonic value.

uri A URI that uniquely identifies the tag library.

validator See validator Element (page 616).

listener See listener Element (page 616).

tag-file | tag Declares the tag files or tags defined in the tag library. See Declaring Tag
Files (page 616) and Declaring Tag Handlers (page 619). A tag library is
considered invalid if a tag-file element has a name subelement with
the same content as a name subelement in a tag element.

function Zero or more EL functions (see Functions, page 518) defined in the tag
library.

tag-extension
(optional) Extensions that provide extra information about the tag library
for tools.
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validator Element
This element defines an optional tag library validator that can be used to validate
the conformance of any JSP page importing this tag library to its requirements.
Table 15–7 lists the subelements of the validator element:

listener Element
A tag library can specify some classes that are event listeners (see Handling
Servlet Life Cycle Events, page 461). The listeners are listed in the TLD as lis-
tener elements, and the Web container will instantiate the listener classes and
register them in a way analogous to listeners defined at the WAR level. Unlike
WAR-level listeners, the order in which the tag library listeners are registered is
undefined. The only subelement of the listener element is the listener-

class element, which must contain the fully qualified name of the listener class.

Declaring Tag Files
Although not required for tag files, providing a TLD allows you to share the tag
across more than one tag library and lets you import the tag library using a URI
instead of the tagdir attribute.

Table 15–7 validator Subelements

Element Description

validator-class
The class implementing
javax.servlet.jsp.tagext.TagLibraryValidator

init-param (optional) Initialization parameters.
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tag-file TLD Element
A tag file is declared in the TLD with a tag-file element, whose subelements
are listed in Table 15–8:

Unpackaged Tag Files
Tag files placed in a subdirectory of /WEB-INF/tags/ do not require a TLD file
and don’t have to be packaged. Thus, to create reusable JSP code, you simply
create a new tag file and place the code inside of it.

The Web container generates an implicit tag library for each directory under and
including /WEB-INF/tags/. There are no special relationships between subdi-

Table 15–8 tag-file Subelements

Element Description

description (optional) A description of the tag.

display-name (optional) Name intended to be displayed by tools.

icon (optional) Icon that can be used by tools.

name The unique tag name.

path

Where to find the tag file implementing this tag, relative to the root of
the Web application or the root of the JAR file for a tag library packaged
in a JAR. This must begin with /WEB-INF/tags/ if the tag file resides
in the WAR, or /META-INF/tags/ if the tag file resides in a JAR.

example (optional) Informal description of an example use of the tag.

tag-extension
(optional) Extensions that provide extra information about the tag for
tools.
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rectories—they are allowed simply for organizational purposes. For example, the
following Web application contains three tag libraries:

/WEB-INF/tags/
/WEB-INF/tags/a.tag
/WEB-INF/tags/b.tag
/WEB-INF/tags/foo/
/WEB-INF/tags/foo/c.tag
/WEB-INF/tags/bar/baz/
/WEB-INF/tags/bar/baz/d.tag

The implicit TLD for each library has the following values:

• tlib-version for the tag library. Defaults to 1.0.

• short-name is derived from the directory name. If the directory is /WEB-
INF/tags/, the short name is simply tags. Otherwise, the full directory
path (relative to the Web application) is taken, minus the /WEB-INF/tags/
prefix. Then, all / characters are replaced with -, which yields the short
name. Note that short names are not guaranteed to be unique.

• A tag-file element is considered to exist for each tag file, with the fol-
lowing sub-elements:

• The name for each is the filename of the tag file, without the .tag exten-
sion.

• The path for each is the path of the tag file, relative to the root of the
Web application.

So, for the previous example, the implicit TLD for the /WEB-INF/tags/bar/

baz/ directory would be:

<taglib>
<tlib-version>1.0</tlib-version>
<short-name>bar-baz</short-name>
<tag-file>

<name>d</name>
<path>/WEB-INF/tags/bar/baz/d.tag</path>

</tag-file>
</taglib>

Despite the existence of an implicit tag library, a TLD in the Web application can
still create additional tags from the same tag files. To accomplish this, you add a
tag-file element with a path that points to the tag file.
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Packaged Tag Files
Tag files can be packaged in the /META-INF/tags/ directory in a JAR file
installed in the /WEB-INF/lib/ directory of the Web application. Tags placed
here are typically part of a reusable library of tags that can be easily used in any
Web application.

Tag files bundled in a JAR require a tag library descriptor. Tag files that appear in
a JAR but are not defined in a TLD are ignored by the Web container.

When used in a JAR file, the path subelement of the tag-file element specifies
the full path of the tag file from the root of the JAR. Therefore, it must always
begin with /META-INF/tags/.

Tag files can also be compiled into Java classes and bundled as a tag library. This
is useful when you wish to distribute a binary version of the tag library without
the original source. If you choose this form of packaging you must use a tool that
produces portable JSP code that uses only standard APIs.

Declaring Tag Handlers
When tags are implemented with tag handlers written in Java, each tag in the
library must be declared in the TLD with the tag element. The tag element con-
tains the tag name, the class of its tag handler, information on the tag’s attributes,
and information on the variables created by the tag (see Tags That Define
Variables, page 597).

Each attribute declaration contains an indication of whether the attribute is
required, whether its value can be determined by request-time expressions, the
type of the attribute, and whether the attribute is a fragment. Variable informa-
tion can be given directly in the TLD or through a tag extra info class. Table 15–
9 lists the subelements of the tag element:

Table 15–9 tag Subelements

Element Description

description (optional) A description of the tag.

display-name (optional) name intended to be displayed by tools.

icon (optional) Icon that can be used by tools.
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body-content Element
You specify the type of body that is valid for this tag with the body-content ele-
ment. This element is used by the Web container to validate that a tag invocation
has the correct body syntax and by page composition tools to assist the page
author in providing a valid tag body. There are four possible values:

• tagdependent—The body of the tag is interpreted by the tag implementa-
tion itself, and is most likely in a different language, for example, embed-
ded SQL statements.

• JSP—The body of the tag contains nested JSP syntax.

• empty—The body must be empty.

• scriptless—The body accepts only template text, EL expressions, and
custom tags. No scripting elements are allowed.

name The unique tag name.

tag-class The fully-qualified name of the tag handler class.

tei-class (optional) Subclass of javax.servlet.jsp.tagext.TagExtraInfo.
See Declaring Tag Variables for Tag Handlers (page 622).

body-content The body content type. See body-content Element (page 620).

variable (optional) Declares an EL variable exposed by the tag to the calling page.
See Declaring Tag Variables for Tag Handlers (page 622).

attribute Declares attributes of the custom tag. See Declaring Tag Attributes for Tag
Handlers (page 621).

dynamic-
attributes

Whether the tag supports additional attributes with dynamic names.
Defaults to false. If true, the tag handler class must implement the
javax.servlet.jsp.tagext.DynamicAttributes interface.

example (optional) Informal description of an example use of the tag.

tag-extension
(optional) Extensions that provide extra information about the tag for
tools.

Table 15–9 tag Subelements (Continued)

Element Description
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Declaring Tag Attributes for Tag Handlers
For each tag attribute, you must specify whether the attribute is required,
whether the value can be determined by an expression, optionally, the type of the
attribute in an attribute element, and whether the attribute is a fragment. If the
rtexprvalue element is true or yes, then the type element defines the return
type expected from any expression specified as the value of the attribute.For
static values, the type is always java.lang.String. An attribute is specified in a
TLD in an attribute element. Table 15–10 lists the subelements of the
attribute element.

If a tag attribute is not required, a tag handler should provide a default value.

Table 15–10 attribute Subelements

Element Description

description (optional) A description of the attribute.

name
The unique name of the attribute being declared. A translation error results
if more than one attribute element appears in the same tag with the
same name.

required (optional) Whether the attribute is required. The default is false.

rtexprvalue
(optional) Whether the attribute’s value may be dynamically calculated at
runtime by an EL expression. The default is false.

type
(optional) The runtime type of the attribute’s value. Defaults to
java.lang.String if not specified.

fragment

(optional) Whether this attribute is a fragment to be evaluated by the tag
handler (true) or a normal attribute to be evaluated by the container prior to
being passed to the tag handler.

If this attribute is true:
You do not specify the rtexprvalue attribute. The container fixes the
rtexprvalue attribute at true.
You do not specify the type attribute. The container fixes the type
attribute at javax.servlet.jsp.tagext.JspFragment.

Defaults to false.
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The tag element for a tag that outputs its body if a test evaluates to true declares
that the test attribute is required and that its value can be set by a runtime
expression.

<tag>
<name>present</name>

 <tag-class>condpkg.IfSimpleTag</tag-class>
<body-content>scriptless</body-content>
...
<attribute>

<name>test</name>
<required>true</required>
<rtexprvalue>true</rtexprvalue>

</attribute>
...

</tag>

Declaring Tag Variables for Tag Handlers
The example described in Tags That Define Variables (page 597) defines an EL
variable departmentName:

<tlt:iterator var="departmentName" type="java.lang.String"
group="${myorg.departmentNames}">

<tr>
<td><a href="list.jsp?deptName=${departmentName}">

${departmentName}</a></td>
</tr>

</tlt:iterator>

When the JSP page containing this tag is translated, the Web container generates
code to synchronize the variable with the object referenced by the variable. To
generate the code, the Web container requires certain information about the vari-
able:

• Variable name

• Variable class

• Whether the variable refers to a new or existing object

• The availability of the variable

There are two ways to provide this information: by specifying the variable

TLD subelement or by defining a tag extra info class and including the tei-

class element in the TLD (see TagExtraInfo Class, page 631). Using the vari-
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able element is simpler, but less dynamic. With the variable element, the only
aspect of the variable that you can specify at runtime is its name (via the name-

from-attribute element). If you provide this information in a tag extra info
class, you can also specify the type of the variable at runtime.

Table 15–11 lists the subelements of the variable element.

Table 15–11 variable Subelements

Element Description

description (optional) A description of the variable.

name-given |
name-from-
attribute

Defines an EL variable to be used in the page invoking this tag. Either
name-given or name-from-attribute must be specified. If name-
given is specified, the value is the name of the variable. If name-from-
attribute is specified, the value is the name of an attribute whose (trans-
lation-time) value at of the start of the tag invocation will give the name of
the variable.
Translation errors arise in the following circumstances:

1. Specifying neither name-given or name-from-attribute or both.
2. If two variable elements have the same name-given.

variable-
class

(optional) The fully qualified name of the class of the object.
java.lang.String is the default.

declare
(optional) Whether the object is declared or not. True is the default.A
translation error results if both declare and fragment are specified.

scope
(optional) The scope of the variable defined. Can be either AT_BEGIN,
AT_END, or NESTED (see Table 15–12). Defaults to NESTED.

Table 15–12 Variable Availability

Value Availability

NESTED Between the start tag and the end tag.

AT_BEGIN
From the start tag until the scope of any enclosing
tag. If there's no enclosing tag, then to the end of the
page.
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You could define the following variable element for the tlt:iterator tag:

<tag>
<variable>

<name-given>var</name-given>
<variable-class>java.lang.String</variable-class>
<declare>true</declare>
<scope>NESTED</scope>

</variable>
</tag>

Programming Simple Tag Handlers
The classes and interfaces used to implement simple tag handlers are contained
in the javax.servlet.jsp.tagext package. Simple tag handlers implement the
SimpleTag interface. Interfaces can be used to take an existing Java object and
make it a tag handler. For most newly created handlers, you would use the Sim-

pleTagSupport classes as a base class.

The heart of a simple tag handler is a single method—doTag—which gets
invoked when the end element of the tag is encountered. Note that the default
implementation of the doTag method of SimpleTagSupport does nothing.

A tag handler has access to an API that allows it to communicate with the JSP
page. The entry point to the API is the JSP context object (javax.serv-
let.jsp.JspContext). JspContext provides access to implicit objects. Page-
Context extends JspContext with servlet-specific behavior. A tag handler can
retrieve all the other implicit objects (request, session, and application) accessi-
ble from a JSP page through these objects. If the tag is nested, a tag handler also
has access to the handler (called the parent) associated with the enclosing tag.

AT_END
After the end tag until the scope of any enclosing tag.
If there's no enclosing tag, then to the end of the
page.

Table 15–12 Variable Availability (Continued)

Value Availability

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/package-summary.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/SimpleTag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/SimpleTagSupport.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/SimpleTagSupport.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/JspContext.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/JspContext.html
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Packaging Tag Handlers
Tag handlers can be made available to a Web application in two basic ways. The
classes implementing the tag handlers can be stored in an unpacked form in the
WEB-INF/classes/ subdirectory of the Web application. Alternatively, if the
library is distributed as a JAR, it is stored in the WEB-INF/lib/ directory of the
Web application.

How Is a Simple Tag Handler Invoked?
The SimpleTag interface defines the basic protocol between a simple tag handler
and a JSP page’s servlet. The JSP page’s servlet invokes the setJspContext,
setParent, and attribute setting methods before calling doStartTag.

ATag t = new ATag();
t.setJSPContext(...);
t.setParent(...);
t.setAttribute1(value1);
t.setAttribute2(value2);
...
t.setJspBody(new JspFragment(...))
t.doTag();

The following sections describe the methods that you need to develop for each
type of tag introduced in Types of Tags (page 593).

Basic Tags
The handler for a basic tag without a body must implement the doTag method of
the SimpleTag interface. The doTag method is invoked when the start tag is
encountered.

The basic tag discussed in the first section,

<tt:basic />

would be implemented by the following tag handler:

public HelloWorldSimpleTag extends SimpleTagSupport {
public void doTag() throws JspException, IOException {

getJspContext().getOut().write("Hello, world.");
}

}
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Tags with Attributes

Defining Attributes in a Tag Handler
For each tag attribute, you must define a set method in the tag handler that con-
forms to the JavaBeans architecture conventions. For example, the tag handler
for the JSTL c:if tag,

<c:if test="${Clear}">

contains the following method:

public void setTest(boolean test) {
this.test = test;

}

Attribute Validation
The documentation for a tag library should describe valid values for tag
attributes. When a JSP page is translated, a Web container will enforce any con-
straints contained in the TLD element for each attribute.

The attributes passed to a tag can also be validated at translation time with the
validate method of a class derived from TagExtraInfo. This class is also used
to provide information about variables defined by the tag (see TagExtraInfo
Class, page 631).

The validate method is passed the attribute information in a TagData object,
which contains attribute-value tuples for each of the tag’s attributes. Since the
validation occurs at translation time, the value of an attribute that is computed at
request time will be set to TagData.REQUEST_TIME_VALUE.

The tag <tt:twa attr1="value1"/> has the following TLD attribute ele-
ment:

<attribute>
<name>attr1</name>
<required>true</required>
<rtexprvalue>true</rtexprvalue>

</attribute>

This declaration indicates that the value of attr1 can be determined at runtime.
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The following validate method checks that the value of attr1 is a valid Bool-
ean value. Note that since the value of attr1 can be computed at runtime, vali-
date must check whether the tag user has chosen to provide a runtime value.

public class TwaTEI extends TagExtraInfo {
public ValidationMessage[] validate(TagData data) {

Object o = data.getAttribute("attr1");
if (o != null && o != TagData.REQUEST_TIME_VALUE) {

if (((String)o).toLowerCase().equals("true") ||
((String)o).toLowerCase().equals("false") )
return null;

else
return new ValidationMessage(data.getId(),

"Invalid boolean value.");
}
else

return null;
}

}

Dynamic Attributes
Tag handlers that support dynamic attributes must declare that they do so in the
tag element of the TLD (see Declaring Tag Handlers, page 619). In addition,
your tag handler must implement the setDynamicAttribute method of the
DynamicAttributes interface. For each attribute specified in the tag invocation
that does not have a corresponding attribute element in the TLD, the Web con-
tainer calls setDynamicAttribute, passing in the namespace of the attribute (or
null if in the default namespace), the name of the attribute, and the value of the
attribute. You must implement the setDynamicAttribute method to remember
the names and values of the dynamic attributes so that they can be used later on
when doTag is executed. If the setDynamicAttribute method an exception, the
doTag method is not invoked for the tag, and the exception must be treated in the
same manner as if it came from an attribute setter method.

The following implementation of setDynamicAttribute saves the attribute
names and values in lists. Then, in the doTag method, the names and values are
echoed to the response in an HTML list.

private ArrayList keys = new ArrayList();
private ArrayList values = new ArrayList();

public void setDynamicAttribute(String uri,
String localName, Object value ) throws JspException {
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keys.add( localName );
values.add( value );

}

public void doTag() throws JspException, IOException {
JspWriter out = getJspContext().getOut();
for( int i = 0; i < keys.size(); i++ ) {
    String key = (String)keys.get( i );
    Object value = values.get( i );
    out.println( "<li>" + key + " = " + value + "</li>" );
}

}

Tags with Bodies
A tag handler for a tag with a body is implemented differently depending on
whether or not the tag handler needs to manipulate the body. A tag handler
manipulates the body when it reads or modifies the contents of the body.

Tag Handler Does Not Manipulate the Body
If a tag handler needs to simply evaluate the body, it gets the body with the
getJspBody method of SimpleTag and then evaluates the body with the invoke

method.

The following tag handler accepts a test parameter and evaluates the body of
the tag if the test evaluates to true. The body of the tag is encapsulated in a JSP
fragment. If the test is true, the handler retrieves the fragment with the getJsp-

Body method. The invoke method directs all output to a supplied writer or to the
JspWriter returned by the getOut method of the JspContext associated with
the tag handler if the writer is null.

public class IfSimpleTag extends SimpleTagSupport {
private boolean test;
public void setTest(boolean test) {

this.test = test;
}
public void doTag() throws JspException, IOException {

if(test){
getJspBody().invoke(null);

}
}

}
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Tag Handler Manipulates the Body
If the tag handler needs to manipulate the body, the tag handler must capture the
body in a StringWriter. The invoke method directs all output to a supplied
writer. Then the modified body is written to the JspWriter returned by the
getOut method of the JspContext. Thus, a tag that converts its body to upper
case could be written as follows:

public class SimpleWriter extends SimpleTagSupport {
public void doTag() throws JspException, IOException {

StringWriter sw = new StringWriter();
jspBody.invoke(sw);
jspContext().

getOut().println(sw.toString().toUpperCase());
}

}

Tags That Define Variables
Similar communication mechanisms exist for communication between JSP page
and tag handlers as for JSP pages and tag files.

To emulate IN parameters, use tag attributes. A tag attribute is communicated
between the calling page and the tag handler when the tag is invoked. No further
communication occurs between the calling page and tag handler.

To emulate OUT or nested parameters, use variables with availability AT_BEGIN,
AT_END, or NESTED. The variable is not initialized by the calling page, but set by
the tag handler.

For AT_BEGIN availability, the variable is available in the calling page from the
start tag until the scope of any enclosing tag. If there's no enclosing tag, then the
variable is available to the end of the page. For AT_END availability, the variable
is available in the calling page after the end tag until the scope of any enclosing
tag. If there's no enclosing tag, then the variable is available to the end of the
page. For nested parameters, the variable is available in the calling page between
the start tag and the end tag.

When you develop a tag handler you are responsible for creating and setting the
object referenced by the variable into a context accessible from the page. You do
this by using the JspContext().setAttribute(name, value) or JspCon-

text.setAttribute(name, value, scope) method. You retrieve the page con-
text with the getJspContext method of SimpleTag.
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Typically, an attribute passed to the custom tag specifies the name of the variable
and the value of the variable is dependent on another attribute. For example, the
iterator tag retrieves the name of the variable from the var attribute and deter-
mines the value of the variable from a computation performed on the group

attribute.

public void doTag() throws JspException, IOException {
if (iterator == null)

return;
while (iterator.hasNext()) {

getJspContext().setAttribute(var, iterator.next());
getJspBody().invoke(null);

}
}
public void setVar(String var) {

this.var = var;
}
public void setGroup(Collection group) {

this.group = group;
if(group.size() > 0)

iterator = group.iterator();
}

The scope that an variable can have is summarized in Table 15–13. The scope
constrains the accessibility and lifetime of the object.

Table 15–13 Scope of Objects

Name Accessible From Lifetime

page Current page
Until the response has been sent back
to the user or the request is passed to
a new page

request
Current page and any included or
forwarded pages

Until the response has been sent back
to the user

session
Current request and any subsequent
request from the same browser
(subject to session lifetime)

The life of the user’s session

application
Current and any future request in
the same Web application

The life of the application
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TagExtraInfo Class
In Declaring Tag Variables for Tag Handlers (page 622) we discussed how to
provide information about tag variable in the tag library descriptor. Here we
describe another approach: defining a tag extra info class. You define a tag extra
info class by extending the class javax.servlet.jsp.tagext.TagExtraInfo.
A TagExtraInfo must implement the getVariableInfo method to return an
array of VariableInfo objects containing the following information:

• Variable name

• Variable class

• Whether the variable refers to a new object

• The availability of the variable

The Web container passes a parameter of type javax.serv-

let.jsp.tagext.TagData to the getVariableInfo method that contains
attribute-value tuples for each of the tag’s attributes. These attributes can be used
to provide the VariableInfo object with an EL variable’s name and class.

The following example demonstrates how to provide information about the vari-
able created by the iterator tag in a tag extra info class. Since the name (var)
and class (type) of the variable are passed in as tag attributes, they can be
retrieved with the data.getAttributeString method and used to fill in the
VariableInfo constructor. To allow the variable var to be used only within the
tag body, the scope of the object is set to be NESTED.

package iterator;
public class IteratorTei extends TagExtraInfo {

public VariableInfo[] getVariableInfo(TagData data) {
String type = data.getAttributeString("type");
if (type == null)

type = "java.lang.Object";
return new VariableInfo[] {

new VariableInfo(data.getAttributeString("var"),
type,
true,
VariableInfo.NESTED)

};
}

}
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The fully qualified name of the tag extra info class defined for an EL variable
must be declared in the TLD in the tei-class subelement of the tag element.
Thus, the tei-class element for IteratorTei would be as follows:

<tei-class>
iterator.IteratorTei

</tei-class>

Cooperating Tags
Tags cooperate by sharing objects. JSP technology supports two styles of object
sharing.

The first style requires that a shared object be named and stored in the page con-
text (one of the implicit objects accessible to both JSP pages and tag handlers).
To access objects created and named by another tag, a tag handler uses the page-
Context.getAttribute(name, scope) method.

In the second style of object sharing, an object created by the enclosing tag han-
dler of a group of nested tags is available to all inner tag handlers. This form of
object sharing has the advantage that it uses a private namespace for the objects,
thus reducing the potential for naming conflicts.

To access an object created by an enclosing tag, a tag handler must first obtain its
enclosing tag with the static method SimpleTagSupport.findAncestorWith-

Class(from, class) or the SimpleTagSupport.getParent method. The
former method should be used when a specific nesting of tag handlers cannot be
guaranteed. Once the ancestor has been retrieved, a tag handler can access any
statically or dynamically created objects. Statically created objects are members
of the parent. Private objects can also be created dynamically. Such objects can
be stored in a tag handler with the setValue method and retrieved with the
getValue method.

The following example illustrates a tag handler that supports both the named and
private object approaches to sharing objects. In the example, the handler for a
query tag checks whether an attribute named connectionId has been set. If the
connectionId attribute has been set, the handler retrieves the connection object
from the page context. Otherwise, the tag handler first retrieves the tag handler
for the enclosing tag, and then retrieves the connection object from that handler.
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public class QueryTag extends SimpleTagSupport {
public int doTag() throws JspException {

String cid = getConnectionId();
Connection connection;
if (cid != null) {
// there is a connection id, use it

connection =(Connection)pageContext.
getAttribute(cid);

} else {
ConnectionTag ancestorTag =

(ConnectionTag)findAncestorWithClass(this,
ConnectionTag.class);

if (ancestorTag == null) {
throw new JspTagException("A query without

a connection attribute must be nested
within a connection tag.");

}
connection = ancestorTag.getConnection();
...

}
}

}

The query tag implemented by this tag handler could be used in either of the fol-
lowing ways:

<tt:connection cid="con01" ... >
...

</tt:connection>
<tt:query id="balances" connectionId="con01">

SELECT account, balance FROM acct_table
where customer_number = ?

<tt:param value="${requestScope.custNumber}" />
</tt:query>

<tt:connection ... >
<tt:query cid="balances">

SELECT account, balance FROM acct_table
where customer_number = ?
<tt:param value="${requestScope.custNumber}" />

</tt:query>
</tt:connection>
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The TLD for the tag handler indicates that the connectionId attribute is
optional with the following declaration:

<tag>
...
<attribute>

<name>connectionId</name>
<required>false</required>

</attribute>
</tag>

Examples
The custom tags described in this section demonstrate solutions to two recurring
problems in developing JSP applications: minimizing the amount of Java pro-
gramming in JSP pages and ensuring a common look and feel across applica-
tions. In doing so, they illustrate many of the styles of tags discussed in the first
part of the chapter.

An Iteration Tag
Constructing page content that is dependent on dynamically generated data often
requires the use of flow control scripting statements. By moving the flow control
logic to tag handlers, flow control tags reduce the amount of scripting needed in
JSP pages.

The iterator tag retrieves objects from a collection stored in a JavaBeans com-
ponent and assigns them to an EL variable. This tag is a very simplified example
of the an iterator tag. Web applications requiring such functionality should use
the JSTL forEach tag, which is discussed in Iterator Tags (page 569). The body
of the tag retrieves information from the variable. While elements remain in the
collection, the iterator tag causes the body to be reevaluated.

JSP Page
The index.jsp page invokes the iterator tag to iterate through a collection of
department names. Each item in the collection is assigned to the department-

Name variable.
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<%@ taglib uri="/tlt" prefix="tlt" %>
<html>

<head>
<title>Departments</title>
</head>
<body bgcolor="white">
<jsp:useBean id="myorg" class="myorg.Organization"/>
<table border=2 cellspacing=3 cellpadding=3>

<tr>
<td><b>Departments</b></td>

</tr>
<tlt:iterator var="departmentName" type="java.lang.String"

group="${myorg.departmentNames}">
<tr>

<td><a href="list.jsp?deptName=${departmentName}">
${departmentName}</a></td>

</tr>
</tlt:iterator>
</table>
</body>

</html>

Tag Handler
The tag handler passes the current element of the group back to the page in an
EL variable called var, which is accessed using the expression language in the
calling page. After the variable is set, the body is evaluated with the invoke

method.

public void doTag() throws JspException, IOException {
if (iterator == null)

return;
while (iterator.hasNext()) {

getJspContext().setAttribute(var, iterator.next());
getJspBody().invoke(null);

}
}
public void setVar(String var) {

this.var = var;
}
public void setGroup(Collection group) {

this.group = group;
if(group.size() > 0)

iterator = group.iterator();
}
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A Template Tag Library
A template provides a way to separate the common elements that are part of each
screen from the elements that change with each screen of an application. Putting
all the common elements together into one file makes it easier to maintain and
enforce a consistent look and feel in all the screens. It also makes development
of individual screens easier because the designer can focus on portions of a
screen that are specific to that screen while the template takes care of the com-
mon portions.

The template is a JSP page with placeholders for the parts that need to change
with each screen. Each of these placeholders is referred to as a parameter of the
template. For example, a simple template could include a title parameter for the
top of the generated screen and a body parameter to refer to a JSP page for the
custom content of the screen.

The template uses a set of nested tags—definition, screen, and parameter—
to define a table of screen definitions and uses an insert tag to insert parameters
from a screen definition into a specific application screen.

JSP Pages
The template for the Duke’s Bookstore example, template.jsp, is shown
below. This page includes a JSP page that creates the screen definition and then
uses the insert tag to insert parameters from the definition into the application
screen.

<%@ taglib uri="/tutorial-template" prefix="tt" %>
<%@ page errorPage="/template/errorinclude.jsp" %>
<%@ include file="/template/screendefinitions.jsp" %>
<html>
<head>
<title>
<tt:insert definition="bookstore" parameter="title"/>
</title>
</head>
<body  bgcolor="#FFFFFF">
  <tt:insert definition="bookstore" parameter="banner"/>
<tt:insert definition="bookstore" parameter="body"/>
<center><em>Copyright &copy; 2002 Sun Microsystems, Inc. </
em></center>
</body>
</html>

../examples/web/bookstore3/web/template/template.txt
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screendefinitions.jsp creates a screen definition based on a request attribute
selectedScreen:

<tt:definition name="bookstore"
screen="${requestScope

['javax.servlet.forward.servlet_path']}">
<tt:screen id="/bookstore">
<tt:parameter name="title" value="Duke's Bookstore"

direct="true"/>
<tt:parameter name="banner" value="/template/banner.jsp"

direct="false"/>
<tt:parameter name="body" value="/bookstore.jsp"

direct="false"/>
</tt:screen>
<tt:screen id="/bookcatalog">
<tt:parameter name="title" direct="true">

      <jsp:attribute name="value" >
        <fmt:message key="TitleBookCatalog"/>
      </jsp:attribute>
    </tt:parameter>
    <tt:parameter name="banner" value="/template/banner.jsp"

direct="false"/>
<tt:parameter name="body" value="/bookcatalog.jsp"
direct="false"/>

</tt:screen>
...

</tt:definition>

The template is instantiated by the Dispatcher servlet. Dispatcher first gets the
requested screen and stores it as an attribute of the request. This is necessary
because when the request is forwarded to template.jsp, the request URL
doesn’t contain the original request (for example, /bookstore3/catalog) but
instead reflects the path (/bookstore3/template.jsp) of the forwarded page.
Then Dispatcher performs business logic based on the request URL, which
updates model objects. Finally, the servlet dispatches the request to tem-

plate.jsp:

public class Dispatcher extends HttpServlet {
public void doGet(HttpServletRequest request,

HttpServletResponse response) {
String bookId = null;
BookDetails book = null;
String clear = null;
BookDBAO bookDBAO =

(BookDBAO)getServletContext().
getAttribute("bookDBAO");

../examples/web/bookstore3/web/template/screendefinitions.txt
../examples/web/bookstore3/src/Dispatcher.java
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HttpSession session = request.getSession();
String selectedScreen = request.getServletPath();
ShoppingCart cart = (ShoppingCart)session.

getAttribute("cart");
if (cart == null) {

cart = new ShoppingCart();
session.setAttribute("cart", cart);

}
request.setAttribute("selectedScreen",

request.getServletPath());
if (selectedScreen.equals("/bookcatalog")) {

bookId = request.getParameter("Add");
if (!bookId.equals("")) {

try {
book = bookDBAO.getBookDetails(bookId);
if ( book.getOnSale() ) {

double sale = book.getPrice() * .85;
Float salePrice = new Float(sale);
book.setPrice(salePrice.floatValue());

}
cart.add(bookId, book);

} catch (BookNotFoundException ex) {
// not possible

}
}

} else if (selectedScreen.equals("/bookshowcart")) {
bookId =request.getParameter("Remove");
if (bookId != null) {

cart.remove(bookId);
}
clear = request.getParameter("Clear");
if (clear != null && clear.equals("clear")) {

cart.clear();
}

} else if (selectedScreen.equals("/bookreceipt")) {
// Update the inventory

try {
bookDBAO.buyBooks(cart);

} catch (OrderException ex) {
request.setAttribute("selectedScreen",

"/bookOrderError");
}

}
try {

request.
getRequestDispatcher(
"/template/template.jsp").
forward(request, response);
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} catch(Exception ex) {
ex.printStackTrace();

}
}

public void doPost(HttpServletRequest request,
HttpServletResponse response) {
request.setAttribute("selectedScreen",

request.getServletPath());
try {

request.
getRequestDispatcher(
"/template/template.jsp").
forward(request, response);

} catch(Exception ex) {
ex.printStackTrace();

}
}

}

Tag Handlers
The template tag library contains four tag handlers—DefinitionTag,
ScreenTag, ParameterTag, and InsertTag—that demonstrate the use of coop-
erating tags. DefinitionTag, ScreenTag, and ParameterTag comprise a set of
nested tag handlers that share private objects. DefinitionTag creates a public
object named bookstore that is used by InsertTag.

In doTag, DefinitionTag creates a private object named screens that contains
a hash table of screen definitions. A screen definition consists of a screen identi-
fier and a set of parameters associated with the screen. These parameters are
loaded when the body of the definition tag, which contains nested screen and
parameter tags, is invoked. DefinitionTag creates a public object of class Def-
inition, selects a screen definition from the screens object based on the URL
passed in the request, and uses it to initialize a public Definition object.

public int doTag() {
try {

screens = new HashMap();
getJspBody().invoke(null);
Definition definition = new Definition();
PageContext context = (PageContext)getJspContext();
ArrayList params = (ArrayList) screens.get(screenId);
Iterator ir = null;
if (params != null) {

ir = params.iterator();

../examples/web/bookstore3/src/template/DefinitionTag.java
../examples/web/bookstore3/src/template/Definition.java
../examples/web/bookstore3/src/template/Definition.java
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while (ir.hasNext())
definition.setParam((Parameter)ir.next());

// put the definition in the page context
context.setAttribute(definitionName, definition,

context.APPLICATION_SCOPE);
}

}

The table of screen definitions is filled in by ScreenTag and ParameterTag from
text provided as attributes to these tags. Table 15–14 shows the contents of the
screen definitions hash table for the Duke’s Bookstore application.

If the URL passed in the request is /bookstore, the Definition contains the
items from the first row of Table 15–14:

The parameters for the URL /bookstore are shown in Table 15–16. The param-
eters specify that the value of the title parameter, Duke’s Bookstore, should be

Table 15–14 Screen Definitions

Screen Id Title Banner Body

/bookstore Duke’s Bookstore /banner.jsp /bookstore.jsp

/bookcatalog Book Catalog /banner.jsp /bookcatalog.jsp

/bookdetails Book Description /banner.jsp /bookdetails.jsp

/bookshowcart Shopping Cart /banner.jsp /bookshowcart.jsp

/bookcashier Cashier /banner.jsp /bookcashier.jsp

/bookreceipt Receipt /banner.jsp /bookreceipt.jsp

Table 15–15 Definition for URL /bookstore

Title Banner Body

Duke’s Bookstore /banner.jsp /bookstore.jsp
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inserted directly into the output stream, but the values of banner and body

should be dynamically included.

InsertTag inserts parameters of the screen definition into the response. In the
doTag method, it retrieves the definition object from the page context and then
inserts the parameter value. If the parameter is direct, it is directly inserted into
the response; otherwise, the request is sent to the parameter, and the response is
dynamically included into the overall response.

public void doTag() throws JspTagException {
Definition definition = null;
Parameter parameter = null;
boolean directInclude = false;
PageContext context = (PageContext)getJspContext();

// get the definition from the page context
definition = (Definition)context.getAttribute(

definitionName, context.APPLICATION_SCOPE);
// get the parameter

if (parameterName != null && definition != null)
parameter = (Parameter)

definition.getParam(parameterName);

if (parameter != null)
directInclude = parameter.isDirect();

try {
// if parameter is direct, print to out
if (directInclude && parameter  != null)

context.getOut().print(parameter.getValue());
// if parameter is indirect,

include results of dispatching to page
else {

Table 15–16 Parameters for the URL /bookstore

Parameter
Name Parameter Value isDirect

title Duke’s Bookstore true

banner /banner.jsp false

body /bookstore.jsp false

../examples/web/bookstore3/src/template/InsertTag.java
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if ((parameter != null) &&
(parameter.getValue() !=  null))

context.include(parameter.getValue());
}

} catch (Exception ex) {
  throw new JspTagException(ex.getMessage());

}
}



16
643
Scripting in JSP Pages

JSP scripting elements allow you to use Java programming language state-
ments in your JSP pages. Scripting element are typically used to create and
access objects, define methods, and manage the flow of control. Many tasks that
require the use of scripts can be eliminated by using custom tag libraries, in par-
ticular the JSP Standard Tag Library. Since one of the goals of JSP technology is
to separate static template data from the code needed to dynamically generate
content, very sparing use of JSP scripting is recommended. Nevertheless, there
may be some circumstances that require its use.

There are three ways to create and use objects in scripting elements:

• Instance and class variables of the JSP page’s servlet class are created in
declarations and accessed in scriptlets and expressions.

• Local variables of the JSP page’s servlet class are created and used in
scriptlets and expressions.

• Attributes of scope objects (see Using Scope Objects, page 464) are cre-
ated and used in scriptlets and expressions.

This chapter briefly describes the syntax and usage of JSP scripting elements.

Bios.html
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The Example JSP Pages
This chapter illustrates JSP scripting elements using a version of the hello2

example introduced in Chapter 3—webclient—that accesses a Web service. To
build, package, deploy, and run the webclient example:

1. Build and deploy the JAX-RPC Web service MyHelloService described
in Creating a Web Service with JAX-RPC (page 333).

2. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

jaxrpc/webclient/.

3. Run asant build. This target will spawn any necessary compilations and
copy files to the <INSTALL>/j2eetutorial14/examples/jaxrpc/web-

client/build/ directory.

4. Start the J2EE application server.

5. Start deploytool.

6. Create a Web application called webclient by running the New Web
Component Wizard. Select File→New→Web Component.

7. New Web Component Wizard

a. Select the Create New Stand-Alone WAR Module radio button.

b. Click Browse and in the file chooser, navigate to <INSTALL>/

j2eetutorial14/examples/jaxrpc/webclient/.

c. In the File Name field, enter webclient.

d. Click Choose Module File.

e. In the WAR Display Name field enter webclient.

f. In the Context Root field, enter /webclient.

g. Click Edit to add the content files.

h. In the Edit Contents dialog, navigate to <INSTALL>/j2eetutorial14/

examples/jaxrpc/webclient/build/. Select duke.waving.gif,
greeting.jsp, response.jsp, and the webclient directory and click
Add.

i. Click OK.

j. Click Next.

k. Select the JSP radio button.

l. Click Next.

m.Select greeting.jsp from the Servlet Class combo box.

n. Click Finish.
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8. Add an alias to the greeting Web component.

a. Select the greeting Web component.

b. Select the Aliases tab.

c. Click Add to add a new mapping.

d. Type /greeting in the aliases list.

9. Select File→Save.

10.Deploy the WAR.

11.Open your browser to http://localhost:8080/webclient/greeting

Note: The example assumes that the Java WSDP runs on the default port, 8080. If
you have changed the port, you must update the port number in the file
<INSTALL>/j2eetutorial14/examples/jaxrpc/webclient/
response.jsp before building and running the examples.

Using Scripting
JSP technology allows a container to support any scripting language that can call
Java objects. If you wish to use a scripting language other than the default, java,
you must specify it in the language attribute of the page directive at the begin-
ning of a JSP page:

<%@ page language="scripting language" %>

Since scripting elements are converted to programming language statements in
the JSP page’s servlet class, you must import any classes and packages used by a
JSP page. If the page language is java, you import a class or package with the
import attribute of the page directive:

<%@ page import="fully_qualified_classname, packagename.*" %>

The webclient JSP page response.jsp imports the classes needed to access
the JAX-RPC stub class and the Web service client classes with the following
page directive:

<%@ page import="javax.xml.rpc.Stub,webclient.*" %>
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Disabling Scripting
By default, scripting in JSP pages is valid. Since scripting can make pages diffi-

cult to maintain, some JSP page authors or page authoring groups may want to fol-
low a methodology where scripting elements are not allowed.

You can invalidate scripting for a group of JSP pages with deploytool by
setting the value of the Scripting Invalid checkbox in the JSP Properties tab of a
WAR. For information on how to define a group of JSP pages, see Setting Prop-
erties for Groups of JSP Pages (page 533). When scripting is invalid, scriptlets,
scripting expressions, and declarations will produce a translation error if present

in any of the pages in the group. Table 16–1 summarizes the scripting settings
and their meanings:

Declarations
A JSP declaration is used to declare variables and methods in a page’s scripting
language. The syntax for a declaration is as follows:

<%! scripting language declaration %>

When the scripting language is the Java programming language, variables and
methods in JSP declarations become declarations in the JSP page’s servlet class.

Initializing and Finalizing a JSP Page
You can customize the initialization process to allow the JSP page to read persis-
tent configuration data, initialize resources, and perform any other one-time

Table 16–1 Scripting Settings

JSP Configuration Scripting Encountered

unspecified Valid

false Valid

true Translation Error
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activities by overriding the jspInit method of the JspPage interface. You
release resources using the jspDestroy method. The methods are defined using
JSP declarations.

For example, an older version of the Duke’s Bookstore application retrieved the
object that accesses the bookstore database from the context and stored a refer-
ence to the object in the variable bookDBAO in the jspInit method.The variable
definition and the initialization and finalization methods jspInit and jspDe-

stroy were defined in a declaration:

<%!
private BookDBAO bookDBAO;
public void jspInit() {
bookDBAO =

(BookDBAO)getServletContext().getAttribute("bookDB");
if (bookDBAO == null)

System.out.println("Couldn’t get database.");
}
%>

When the JSP page was removed from service, the jspDestroy method released
the BookDBAO variable.

<%!
public void jspDestroy() {

bookDBAO = null;
}
%>

Scriptlets
A JSP scriptlet is used to contain any code fragment that is valid for the scripting
language used in a page. The syntax for a scriptlet is as follows:

<%
scripting language statements

%>

When the scripting language is set to java, a scriptlet is transformed into a Java
programming language statement fragment and is inserted into the service
method of the JSP page’s servlet. A programming language variable created
within a scriptlet is accessible from anywhere within the JSP page.
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In the Web service version of the hello2 application, greeting.jsp contains a
scriptlet to retrieve the request parameter named username and test whether it is
empty. If the if statement evaluates to true, the response page is included. Since
the if statement opens a block, the HTML markup would be followed by a
scriptlet that closes the block.

<%
String username = request.getParameter("username");
if ( username != null && username.length() > 0 ) {

%>
<%@include file="response.jsp" %>

<%
}

%>

Expressions
A JSP expression is used to insert the value of a scripting language expression,
converted into a string, into the data stream returned to the client. When the
scripting language is the Java programming language, an expression is trans-
formed into a statement that converts the value of the expression into a String

object and inserts it into the implicit out object.

The syntax for an expression is as follows:

<%= scripting language expression %>

Note that a semicolon is not allowed within a JSP expression, even if the same
expression has a semicolon when you use it within a scriptlet.

In the Web service version of the hello2 application, response.jsp contains
the following scriptlet which creates a JAX-RPC stub, sets the endpoint on the
stub, and then invokes the sayHello method on the stub, passing the user name
retrieved from a request parameter:

<%
String resp = null;
try {

Stub stub = (Stub)(new
MyHelloService_Impl().getHelloIFPort());

stub._setProperty(
javax.xml.rpc.Stub.ENDPOINT_ADDRESS_PROPERTY,
"http://localhost:8080/hello-jaxrpc/hello");

HelloIF hello = (HelloIF)stub;
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resp =
hello.sayHello(request.getParameter("username"));

} catch (Exception ex) {
resp = ex.toString();

}
%>

A scripting expression is then used to insert the value of resp into the output
stream:

<h2><font color="black"><%= resp %>!</font></h2>

Programming Tags That Accept
Scripting Elements

Tag that accept scripting elements in attribute values or the body cannot be pro-
grammed as simple tags; they must be implemented as classic tags. The follow-
ing sections describe the TLD elements and JSP tag extension API specific to
classic tag handlers. All other TLD elements are the same as for simple tags.

TLD Elements
You specify the character of a classic tag’s body content using the body-content
element:

<body-content>empty | JSP | tagdependent</body-content>

You must declare the body content of tags that do not have a body as empty. For
tags that have a body, there are two options. Body content containing custom and
core tags, scripting elements, and HTML text is categorized as JSP. All other
types of body content—for example, SQL statements passed to the query tag—
would be labeled tagdependent.

Tag Handlers
Classic tag handlers are written with the Java language and implement either the
Tag, IterationTag, or BodyTag interface. Interfaces can be used to take an
existing Java object and make it a tag handler. For newly created handlers, you
can use the TagSupport and BodyTagSupport classes as base classes.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/Tag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/IterationTag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/BodyTag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/TagSupport.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/BodyTagSupport.html
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The classes and interfaces used to implement classic tag handlers are contained
in the javax.servlet.jsp.tagext package. Classic tag handlers implement
either the Tag, IterationTag, or BodyTag interface. Interfaces can be used to
take an existing Java object and make it a tag handler. For newly created classic
tag handlers, you can use the TagSupport and BodyTagSupport classes as base
classes. These classes and interfaces are contained in the javax.serv-

let.jsp.tagext package.

Tag handler methods defined by the Tag and BodyTag interfaces are called by the
JSP page’s servlet at various points during the evaluation of the tag. When the
start element of a custom tag is encountered, the JSP page’s servlet calls methods
to initialize the appropriate handler and then invokes the handler’s doStartTag

method. When the end element of a custom tag is encountered, the handler’s
doEndTag method is invoked for all but simple tags. Additional methods are
invoked in between when a tag handler needs to manipulate the body of the tag.
For further information, see Tags with Bodies (page 652). In order to provide a
tag handler implementation, you must implement the methods, summarized in
Table 16–2, that are invoked at various stages of processing the tag.

A tag handler has access to an API that allows it to communicate with the JSP
page. The entry points to the API are two objects: the JSP context (javax.serv-
let.jsp.JspContext) for simple tag handlers and the page context
(javax.servlet.jsp.PageContext) for classic tag handlers. JspContext pro-
vides access to implicit objects. PageContext extends JspContext with HTTP-
specific behavior. A tag handler can retrieve all the other implicit objects

Table 16–2 Tag Handler Methods

Tag Type Interface Methods

Basic Tag doStartTag, doEndTag

Attributes Tag
doStartTag, doEndTag,
setAttribute1,...,N, release

Body Tag doStartTag, doEndTag, release

Body, iterative
evaluation

IterationTag
doStartTag, doAfterBody, doEndTag,
release

Body, manipulation BodyTag
doStartTag, doEndTag, release,
doInitBody, doAfterBody

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/package-summary.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/Tag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/Tag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/BodyTag.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/TagSupport.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/tagext/BodyTagSupport.html
http://java.sun.com/j2ee/1.4/docs/api/api/javax/servlet/jsp/tagext/package-summary.html
http://java.sun.com/j2ee/1.4/docs/api/api/javax/servlet/jsp/tagext/package-summary.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/JspContext.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/JspContext.html
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/jsp/PageContext.html
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(request, session, and application) accessible from a JSP page through these
objects. In addition, implicit objects can have named attributes associated with
them. Such attributes are accessed using [set|get]Attribute methods.

If the tag is nested, a tag handler also has access to the handler (called the par-
ent) associated with the enclosing tag.

How Is a Classic Tag Handler Invoked?
The Tag interface defines the basic protocol between a tag handler and a JSP
page’s servlet. It defines the life cycle and the methods to be invoked when the
start and end tags are encountered.

The JSP page’s servlet invokes the setPageContext, setParent, and attribute
setting methods before calling doStartTag. The JSP page’s servlet also guaran-
tees that release will be invoked on the tag handler before the end of the page.

Here is a typical tag handler method invocation sequence:

ATag t = new ATag();
t.setPageContext(...);
t.setParent(...);
t.setAttribute1(value1);
t.setAttribute2(value2);
t.doStartTag();
t.doEndTag();
t.release();

The BodyTag interface extends Tag by defining additional methods that let a tag
handler access its body. The interface provides three new methods:

• setBodyContent—Creates body content and adds to the tag handler

• doInitBody—Called before evaluation of the tag body

• doAfterBody—Called after evaluation of the tag body

A typical invocation sequence is:

t.doStartTag();
out = pageContext.pushBody();
t.setBodyContent(out);
// perform any initialization needed after body content is set
t.doInitBody();
t.doAfterBody();
// while doAfterBody returns EVAL_BODY_AGAIN we
// iterate body evaluation
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...
t.doAfterBody();
t.doEndTag();
out = pageContext.popBody();
t.release();

Tags with Bodies
A tag handler for a tag with a body is implemented differently depending on
whether or not the tag handler needs to manipulate the body. A tag handler
manipulates the body when it reads or modifies the contents of the body.

Tag Handler Does Not Manipulate the Body
If the tag handler does not need to manipulate the body, the tag handler should
implement the Tag interface. If the tag handler implements the Tag interface and
the body of the tag needs to be evaluated, the doStartTag method needs to
return EVAL_BODY_INCLUDE; otherwise it should return SKIP_BODY.

If a tag handler needs to iteratively evaluate the body, it should implement the
IterationTag interface. The tag handler should return EVAL_BODY_AGAIN doAf-

terBody method if it determines that the body needs to be evaluated again.

Tag Handler Manipulates the Body
If the tag handler needs to manipulate the body, the tag handler must implement
BodyTag (or be derived from BodyTagSupport).

When a tag handler implements the BodyTag interface, it must implement the
doInitBody and the doAfterBody methods. These methods manipulate body
content passed to the tag handler by the JSP page’s servlet.

Body content supports several methods to read and write its contents. A tag han-
dler can use the body content’s getString or getReader methods to extract
information from the body, and the writeOut(out) method to write the body
contents to an out stream. The writer supplied to the writeOut method is
obtained using the tag handler’s getPreviousOut method. This method is used
to ensure that a tag handler’s results are available to an enclosing tag handler.

If the body of the tag needs to be evaluated, the doStartTag method needs to
return EVAL_BODY_BUFFERED; otherwise, it should return SKIP_BODY.
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doInitBody Method
The doInitBody method is called after the body content is set but before it is
evaluated. You generally use this method to perform any initialization that
depends on the body content.

doAfterBody Method
The doAfterBody method is called after the body content is evaluated. doAf-
terBody must return an indication of whether to continue evaluating the body.
Thus, if the body should be evaluated again, as would be the case if you were
implementing an iteration tag, doAfterBody should return EVAL_BODY_AGAIN;
otherwise, doAfterBody should return SKIP_BODY.

The following example reads the content of the body (which contains a SQL
query) and passes it to an object that executes the query. Since the body does not
need to be reevaluated, doAfterBody returns SKIP_BODY.

public class QueryTag extends BodyTagSupport {
public int doAfterBody() throws JspTagException {

BodyContent bc = getBodyContent();
// get the bc as string
String query = bc.getString();
// clean up
bc.clearBody();
try {

Statement stmt = connection.createStatement();
result = stmt.executeQuery(query);

} catch (SQLException e) {
throw new JspTagException("QueryTag: " +

 e.getMessage());
}
return SKIP_BODY;

}
}

release Method
A tag handler should reset its state and release any private resources in the
release method.

Cooperating Tags
Tags cooperate by sharing objects. JSP technology supports two styles of object
sharing.
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The first style requires that a shared object be named and stored in the page con-
text (one of the implicit objects accessible to both JSP pages and tag handlers).
To access objects created and named by another tag, a tag handler uses the page-
Context.getAttribute(name, scope) method.

In the second style of object sharing, an object created by the enclosing tag han-
dler of a group of nested tags is available to all inner tag handlers. This form of
object sharing has the advantage that it uses a private namespace for the objects,
thus reducing the potential for naming conflicts.

To access an object created by an enclosing tag, a tag handler must first obtain its
enclosing tag with the static method TagSupport.findAncestorWith-

Class(from, class) or the TagSupport.getParent method. The former
method should be used when a specific nesting of tag handlers cannot be guaran-
teed. Once the ancestor has been retrieved, a tag handler can access any statically
or dynamically created objects. Statically created objects are members of the
parent. Private objects can also be created dynamically. Such objects can be
stored in a tag handler with the setValue method and retrieved with the
getValue method.

The following example illustrates a tag handler that supports both the named and
private object approaches to sharing objects. In the example, the handler for a
query tag checks whether an attribute named connectionId has been set. If the
connection attribute has been set, the handler retrieves the connection object
from the page context. Otherwise, the tag handler first retrieves the tag handler
for the enclosing tag, and then retrieves the connection object from that handler.

public class QueryTag extends BodyTagSupport {
public int doStartTag() throws JspException {

String cid = getConnectionId();
Connection connection;
if (cid != null) {
// there is a connection id, use it

connection =(Connection)pageContext.
getAttribute(cid);

} else {
ConnectionTag ancestorTag =

(ConnectionTag)findAncestorWithClass(this,
ConnectionTag.class);

if (ancestorTag == null) {
throw new JspTagException("A query without

a connection attribute must be nested
within a connection tag.");

}
connection = ancestorTag.getConnection();
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...
}

}
}

The query tag implemented by this tag handler could be used in either of the fol-
lowing ways:

<tt:connection cid="con01" ... >
...

</tt:connection>
<tt:query id="balances" connectionId="con01">

SELECT account, balance FROM acct_table
where customer_number = ?

<tt:param value="${requestScope.custNumber}" />
</tt:query>

<tt:connection ... >
<tt:query cid="balances">

SELECT account, balance FROM acct_table
where customer_number = ?
<tt:param value="${requestScope.custNumber}" />

</tt:query>
</tt:connection>

The TLD for the tag handler indicates that the connectionId attribute is
optional with the following declaration:

<tag>
...
<attribute>

<name>connectionId</name>
<required>false</required>

</attribute>
</tag>

Tags That Define Variables
The mechanisms for defining EL variables in classic tags are similar to those
described in Chapter 15. You must declare the variable in a variable element of
the TLD or in a tag extra info class. You use
PageContext().setAttribute(name, value) or PageContext.setAt-

tribute(name, value, scope) methods in the tag handler to create or update
an association between a name accessible in the page context and the object that
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is the value of the variable. For classic tag handlers, Table 16–3 illustrates how
the availability of a variable affects when you may want to set or update the vari-
able’s value.

An EL variable defined by a custom tag can also be accessed in a scripting
expression. For example, the Web service described in the previous section could
be encapsulated in a custom tag that returns the response in an EL variable
named by the var attribute and then var could be accessed in a scripting expres-
sion as follows:

<ws:hello var="response"
name="<%=request.getParameter("username")%>" />

<h2><font color="black"><%= response %>!</font></h2>

Remember that in situations where scripting is not allowed

• In a tag body where the body-content is declared as scriptless

• In a page where scripting is specified to be invalid

you wouldn’t be able to access the EL variable in a scriptlet or expression.
Instead, you would have to use the JSP expression language to access the vari-

able.

Table 16–3 Scripting Variable Availability

Value Availability In Methods

NESTED
Between the start
tag and the end tag

doStartTag, doInitBody, and doAfterBody.

AT_BEGIN
From the start tag
until the end of the
page

doStartTag, doInitBody, doAfterBody, and
doEndTag.

AT_END
After the end tag
until the end of the
page

doEndTag
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Internationalizing and
Localizing Web

Applications

Internationalization is the process of preparing an application to support more
than one language and data format. Localization is the process of adapting an
internationalized application to support a specific region or locale. Examples of
locale-dependent information include messages and user interface labels, char-
acter sets and encoding, and date and currency formats.Although all client user
interfaces should be internationalized and localized, it is particularly important
for Web applications because of the global nature of the Web.

Java Platform Localization Classes
In the Java 2 platform, java.util.Locale represents a specific geographical,
political, or cultural region. The string representation of a locale consists of the
international standard 2-character abbreviation for language and country and an
optional variant, all separated by underscore _ characters. Examples of locale
strings include fr (French), de_CH (Swiss German), and en_US_POSIX (United
States English on a POSIX-compliant platform).

http://java.sun.com/j2se/1.4.1/docs/api/java/util/Locale.html
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Locale-sensitive data is stored in a java.util.ResourceBundle. A resource
bundle contains key-value pairs, where the keys uniquely identify a locale-spe-
cific object in the bundle. A resource bundle can be backed by a text file (proper-
ties resource bundle) or a class (list resource bundle) containing the pairs. A
resource bundle instance is constructed by appending a locale string representa-
tion to a base name.

For more details on internationalization and localization in the Java 2 platform,
see

http://java.sun.com/docs/books/tutorial/i18n/index.html

In the Web technology chapters, the Duke’s Bookstore example contains
resource bundles with the base name messages.BookstoreMessages for the
locales en_US and es_ES. See Internationalization Tags (page 576) for informa-
tion on the JSTL i18n tags.

Providing Localized Messages and
Labels

Messages and labels should be tailored according to the conventions of a user's
language and region. There are two approaches to providing localized messages
and labels in a Web application:

• Provide a version of the JSP page in each of the target locales and have a
controller servlet dispatch the request to the appropriate page depending
on the requested locale. This approach is useful if large amounts of data on
a page or an entire Web application need to be internationalized.

• Isolate any locale-sensitive data on a page into resource bundles, and
access the data so that the corresponding translated message is fetched
automatically and inserted into the page. Thus, instead of creating strings
directly in your code, you create a resource bundle that contains transla-
tions and read the translations from that bundle using the corresponding
key.

http://java.sun.com/docs/books/tutorial/i18n/index.html
http://java.sun.com/j2se/1.4.1/docs/api/java/util/ResourceBundle.html
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The Duke’s Bookstore application follows the second approach. Here are a few
lines from the default resource bundle messages.BookstoreMessages.java:

{"TitleCashier", "Cashier"},
{"TitleBookDescription", "Book Description"},
{"Visitor", "You are visitor number "},
{"What", "What We're Reading"},
{"Talk", " talks about how Web components can transform the way
you develop applications for the Web. This is a must read for
any self respecting Web developer!"},
{"Start", "Start Shopping"},

To get the correct strings for a given user, a Web component retrieves the locale
(set by a browser language preference) from the request using the getLocale

method, opens the resource bundle for that locale, and then saves the bundle as a
session attribute (see Associating Attributes with a Session, page 486):

ResourceBundle messages = (ResourceBundle)session.
getAttribute("messages");
if (messages == null) {

Locale locale=request.getLocale();
messages = ResourceBundle.

getBundle("messages.BookstoreMessages", locale);
session.setAttribute("messages", messages);

}

A Web component retrieves the resource bundle from the session:

ResourceBundle messages =
(ResourceBundle)session.getAttribute("messages");

and looks up the string associated with the key TitleCashier as follows:

messages.getString("TitleCashier");

The JSP versions of the Duke’s Bookstore application uses the fmt:message tag
to provide localized strings for introductory messages, HTML link text, button
labels, and error messages. For more information on the JSTL messaging tags,
see Messaging Tags (page 578).
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Date and Number Formatting
Java programs use the DateFormat.getDateInstance(int, locale) to parse
and format dates in a locale-sensitive manner. Java programs use the Number-

Format.getXXXInstance(locale) method, where XXX can be Currency, Num-
ber, or Percent, to parse and format numerical values in a locale-sensitive
manner. The servlet version of Duke’s Bookstore uses the currency version of
this method to format book prices.

JSTL applications use the fmt:formatDate and fmt:parseDate tags to handle
localized dates, and fmt:formatNumber and fmt:parseNumber tags to handle
localized numbers, including currency values. For more information on the JSTL
formatting tags, see Formatting Tags (page 578). The JSTL version of Duke’s
bookstore uses the fmt:formatNumber tag to format book prices and the
fmt:formatDate tag to format delivery dates.

Character Sets and Encodings

Character Sets
A character set is a set of textual and graphic symbols, each of which is mapped
to a set of nonnegative integers.

The first character set used in computing was ASCII. It is limited in that it can
only represent American English. ASCII contains upper- and lower-case Latin
alphabets, numerals, punctuation, a set of control codes, and a few miscellaneous
symbols.

Unicode defines a standardized, universal character set that can be extended to
accommodate additions. Unicode characters may be represented as escape
sequences, using the notation \uXXXX, where XXXX is the character’s 16-bit repre-
sentation in hexadecimal when the Java program source file encoding doesn’t
support Unicode. For example, the Spanish version of the Duke’s Bookstore
message file uses Unicode for non-ASCII characters:

{"TitleCashier", "Cajero"},
{"TitleBookDescription", "Descripci" + "\u00f3" + "n del
Libro"},
{"Visitor", "Es visitanten" + "\u00fa" + "mero "},
{"What", "Qu" + "\u00e9" + " libros leemos"},
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{"Talk", " describe como componentes de software de web pueden
transformar la manera en que desrrollamos aplicaciones para el
web. Este libro es obligatorio para cualquier programador de
respeto!"},
{"Start", "Empezar a Comprar"},

Character Encoding
A character encoding maps a character set to units of a specific width, and
defines byte serialization and ordering rules. Many character sets have more than
one encoding. For example, Java programs can represent Japanese character sets
using the EUC-JP or Shift-JIS encodings, among others. Each encoding has
rules for representing and serializing a character set.

The ISO 8859 series defines thirteen character encodings that can represent texts
in dozens of languages. Each ISO 8859 character encoding may have up to 256
characters. ISO 8859-1 (Latin-1) comprises the ASCII character set, characters
with diacritics (accents, diaereses, cedillas, circumflexes, and so on), and addi-
tional symbols.

UTF-8 (Unicode Transformation Format, 8 bit form) is a variable-width charac-
ter encoding that encodes 16-bit Unicode characters as one to four bytes. A byte
in UTF-8 is equivalent to 7-bit ASCII if its high-order bit is zero; otherwise, the
character comprises a variable number of bytes.

UTF-8 is compatible with the majority of existing Web content and provides
access to the Unicode character set. Current versions of browsers and email cli-
ents support UTF-8. In addition, many new Web standards specify UTF-8 as
their character encoding. For example, UTF-8 is one of the two required encod-
ings for XML documents (the other is UTF-16).

See Appendix A for more information on character encodings in the Java 2 plat-
form.

Web components usually use PrintWriter to produce responses, which auto-
matically encodes using ISO 8859-1. Servlets may also output binary data with
OutputStream classes, which perform no encoding. An application that uses a
character set that cannot use the default encoding must explicitly set a different
encoding.



662 INTERNATIONALIZING AND LOCALIZING WEB APPLICATIONS
For Web components, three encodings must be considered:

• Request

• Page (JSP pages)

• Response

Request Encoding
The request encoding is the character encoding in which parameters in an
incoming request are interpreted. Currently, many browsers do not send a
request encoding qualifier with the Content-Type header. In such cases, a Web
container will use the default encoding—ISO-8859-1—to parse request data.

If the client hasn’t set character encoding and the request data is encoded with a
different encoding than the default, the data won’t be interpreted correctly. To
remedy this situation, you can use the ServletRequest.setCharacterEncod-

ing(String enc) method to override the character encoding supplied by the
container. This method must be called prior to reading request parameters or
reading input using getReader. To control the request encoding from JSP pages,
you can use the JSTL fmt:requestEncoding tag.

This method must be called prior to parsing any request parameters or reading
any input from the request. Calling this method once data has been read will not
affect the encoding.

Page Encoding
For JSP pages, the page encoding is the character encoding in which the file is
encoded.

For JSP pages in standard syntax, the page encoding is determined from the fol-
lowing sources:

• The Page Encoding value of a JSP property group (see Setting Properties
for Groups of JSP Pages, page 533) whose URL pattern matches the page.

• The pageEncoding attribute of the page directive of the page. It is a trans-
lation-time error to name different encodings in the pageEncoding

attribute of the page directive of a JSP page and in a JSP property group.

• The CHARSET value of the contentType attribute of the page directive.

If none of the above is provided, ISO-8859-1 is used as the default page encod-
ing.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequest.html#setCharacterEncoding(java.lang.String)
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletRequest.html#setCharacterEncoding(java.lang.String)
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For JSP pages in XML syntax (JSP documents), the page encoding is determined
as described in section 4.3.3 and appendix F.1 of the XMLspecification.

The pageEncoding and contentType attributes determine the page character
encoding of only the file that physically contains the page directive. A Web con-
tainer raises a translation-time error if an unsupported page encoding is speci-
fied.

Response Encoding
The response encoding is the character encoding of the textual response gener-
ated from a Web component. The response encoding must be set appropriately
so that the characters are rendered correctly for a given locale. A Web container
sets an initial response encoding for a JSP page from the following sources:

• The CHARSET value of the contentType attribute of the page directive.

• The encoding specified by the pageEncoding attribute of the page direc-
tive

• The Page Encoding value of a JSP property group whose URL pattern
matches the page.

If none of the above is provided, ISO-8859-1 is used as the default response
encoding.

The setCharacterEncoding, setContentType, and setLocale methods can be
called repeatedly to change the character encoding. Calls made after the servlet
response’s getWriter method has been called or after the response is committed
have no effect on the character encoding. Data is sent to the response stream on
buffer flushes for buffered pages, or on encountering the first content on unbuf-
fered pages.

Calls to setContentType set the character encoding only if the given content
type string provides a value for the charset attribute. Calls to setLocale set the
character encoding only if neither setCharacterEncoding nor setContentType
has set the character encoding before. To control the response encoding from
JSP pages, you can use the JSTL fmt.setLocale tag.

To obtain the character encoding for a locale, the setLocale method checks the
locale encoding mapping for the Web application. For example, to map Japanese
to the Japanese specific encoding Shift_JIS,

1. Select the WAR.

2. Click the Advanced Settings button.

http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletResponse.html#setCharacterEncoding(java.lang.String)
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletResponse.html#setContentType(java.lang.String)
http://java.sun.com/j2ee/1.4/docs/api/javax/servlet/ServletResponse.html#setLocale(java.util.Locale)
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3. In the Locale Character Encoding table, Click the Add button.

4. Enter ja in the Extension column.

5. Enter Shift_JIS in the Character Encoding column.

If a mapping is not set for the Web application, setLocale uses a J2EE 1.4
Application Server mapping.

The first application in Chapter 12 allows a user to choose an English string rep-
resentation of a locale from all the locales available to the Java 2 platform and
then outputs a date localized for that locale. To ensure that the characters in the
date can be rendered correctly for a wide variety of character sets, the JSP page
that generates the date sets the response encoding to UTF-8 with the following
directive:

<%@ page contentType="text/html; charset=UTF-8" %>

Further Information
For a detailed discussion on internationalizing Web applications, see the Java
BluePrints for the Enterprise:

http://java.sun.com/blueprints/enterprise

http://java.sun.com/blueprints/guidelines/designing_enterprise_applications_2e/i18n/i18n.html#1076131
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Enterprise Beans

ENTERPRISE beans are the J2EE components that implement Enterprise Java-
Beans (EJB) technology. Enterprise beans run in the EJB container, a runtime
environment within the J2EE server (see Figure 1–5, page 10). Although trans-
parent to the application developer, the EJB container provides system-level ser-
vices such as transactions to its enterprise beans. These services enable you to
quickly build and deploy enterprise beans, which form the core of transactional
J2EE applications.

What Is an Enterprise Bean?
Written in the Java programming language, an enterprise bean is a server-side
component that encapsulates the business logic of an application. The business
logic is the code that fulfills the purpose of the application. In an inventory con-
trol application, for example, the enterprise beans might implement the business
logic in methods called checkInventoryLevel and orderProduct. By invoking
these methods, remote clients can access the inventory services provided by the
application.

Benefits of Enterprise Beans
For several reasons, enterprise beans simplify the development of large, distrib-
uted applications. First, because the EJB container provides system-level ser-
vices to enterprise beans, the bean developer can concentrate on solving business



666 ENTERPRISE BEANS
problems. The EJB container—not the bean developer—is responsible for sys-
tem-level services such as transaction management and security authorization.

Second, because the beans—and not the clients—contain the application’s busi-
ness logic, the client developer can focus on the presentation of the client. The
client developer does not have to code the routines that implement business rules
or access databases. As a result, the clients are thinner, a benefit that is particu-
larly important for clients that run on small devices.

Third, because enterprise beans are portable components, the application assem-
bler can build new applications from existing beans. These applications can run
on any compliant J2EE server.

When to Use Enterprise Beans
You should consider using enterprise beans if your application has any of the fol-
lowing requirements:

• The application must be scalable. To accommodate a growing number of
users, you may need to distribute an application’s components across mul-
tiple machines. Not only can the enterprise beans of an application run on
different machines, but their location will remain transparent to the clients.

• Transactions are required to ensure data integrity. Enterprise beans support
transactions, the mechanisms that manage the concurrent access of shared
objects.

• The application will have a variety of clients. With just a few lines of code,
remote clients can easily locate enterprise beans. These clients can be thin,
various, and numerous.

Types of Enterprise Beans
Table 18–1 summarizes the three different types of enterprise beans. The follow-
ing sections discuss each type in more detail.

Table 18–1 Summary of Enterprise Bean Types

Enterprise Bean Type Purpose

Session Performs a task for a client; implements a Web service
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What Is a Session Bean?
A session bean represents a single client inside the J2EE server. To access an
application that is deployed on the server, the client invokes the session bean’s
methods. The session bean performs work for its client, shielding the client from
complexity by executing business tasks inside the server.

As its name suggests, a session bean is similar to an interactive session. A ses-
sion bean is not shared—it can have just one client, in the same way that an
interactive session can have just one user. Like an interactive session, a session
bean is not persistent. (That is, its data is not saved to a database.) When the cli-
ent terminates, its session bean appears to terminate and is no longer associated
with the client.

For code samples, see Chapter 20.

State Management Modes
There are two types of session beans: stateful and stateless.

Stateful Session Beans
The state of an object consists of the values of its instance variables. In a stateful
session bean, the instance variables represent the state of a unique client-bean
session. Because the client interacts (“talks”) with its bean, this state is often
called the conversational state.

The state is retained for the duration of the client-bean session. If the client
removes the bean or terminates, the session ends and the state disappears. This
transient nature of the state is not a problem, however, because when the conver-
sation between the client and the bean ends there is no need to retain the state.

Entity Represents a business entity object that exists in persistent storage

Message-Driven
Acts as a listener for the Java Message Service API, processing
messages asynchronously

Table 18–1 Summary of Enterprise Bean Types

Enterprise Bean Type Purpose
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Stateless Session Beans
A stateless session bean does not maintain a conversational state for the client.
When a client invokes the method of a stateless bean, the bean’s instance vari-
ables may contain a state, but only for the duration of the invocation. When the
method is finished, the state is no longer retained. Except during method invoca-
tion, all instances of a stateless bean are equivalent, allowing the EJB container
to assign an instance to any client.

Because stateless session beans can support multiple clients, they can offer better
scalability for applications that require large numbers of clients. Typically, an
application requires fewer stateless session beans than stateful session beans to
support the same number of clients.

At times, the EJB container may write a stateful session bean to secondary stor-
age. However, stateless session beans are never written to secondary storage.
Therefore, stateless beans may offer better performance than stateful beans.

A stateless session bean can implement a Web service, but other types of enter-
prise beans cannot.

When to Use Session Beans
In general, you should use a session bean if the following circumstances hold:

• At any given time, only one client has access to the bean instance.

• The state of the bean is not persistent, existing only for a short period of
time (perhaps a few hours).

• The bean implements a Web service.

Stateful session beans are appropriate if any of the following conditions are true:

• The bean’s state represents the interaction between the bean and a specific
client.

• The bean needs to hold information about the client across method invoca-
tions.

• The bean mediates between the client and the other components of the
application, presenting a simplified view to the client.

• Behind the scenes, the bean manages the work flow of several enterprise
beans. For an example, see the AccountControllerEJB session bean in
Chapter 32.
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To improve performance, you might choose a stateless session bean if it has any
of these traits:

• The bean’s state has no data for a specific client.

• In a single method invocation, the bean performs a generic task for all cli-
ents. For example, you might use a stateless session bean to send an e-mail
that confirms an online order.

• The bean fetches from a database a set of read-only data that is often used
by clients. Such a bean, for example, could retrieve the table rows that rep-
resent the products that are on sale this month.

What Is an Entity Bean?
An entity bean represents a business object in a persistent storage mechanism.
Some examples of business objects are customers, orders, and products. In the
J2EE Application Server, the persistent storage mechanism is a relational data-
base. Typically, each entity bean has an underlying table in a relational database,
and each instance of the bean corresponds to a row in that table. For code
examples of entity beans, please refer to chapters 21 and 22.

What Makes Entity Beans Different from
Session Beans?
Entity beans differ from session beans in several ways. Entity beans are persis-
tent, allow shared access, have primary keys, and may participate in relation-
ships with other entity beans.

Persistence
Because the state of an entity bean is saved in a storage mechanism, it is persis-
tent. Persistence means that the entity bean’s state exists beyond the lifetime of
the application or the J2EE server process. If you’ve worked with databases,
you’re familiar with persistent data. The data in a database is persistent because
it still exists even after you shut down the database server or the applications it
services.

There are two types of persistence for entity beans: bean-managed and con-
tainer-managed. With bean-managed persistence, the entity bean code that you
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write contains the calls that access the database. If your bean has container-man-
aged persistence, the EJB container automatically generates the necessary data-
base access calls. The code that you write for the entity bean does not include
these calls. For additional information, see the section Container-Managed
Persistence (page 670).

Shared Access
Entity beans may be shared by multiple clients. Because the clients might want
to change the same data, it’s important that entity beans work within transac-
tions. Typically, the EJB container provides transaction management. In this
case, you specify the transaction attributes in the bean’s deployment descriptor.
You do not have to code the transaction boundaries in the bean—the container
marks the boundaries for you. See Chapter 25 for more information.

Primary Key
Each entity bean has a unique object identifier. A customer entity bean, for
example, might be identified by a customer number. The unique identifier, or pri-
mary key, enables the client to locate a particular entity bean. For more informa-
tion see the section Primary Keys for Bean-Managed Persistence (page 773).

Relationships
Like a table in a relational database, an entity bean may be related to other entity
beans. For example, in a college enrollment application, StudentEJB and Cour-

seEJB would be related because students enroll in classes.

You implement relationships differently for entity beans with bean-managed per-
sistence and those with container-managed persistence. With bean-managed per-
sistence, the code that you write implements the relationships. But with
container-managed persistence, the EJB container takes care of the relationships
for you. For this reason, relationships in entity beans with container-managed
persistence are often referred to as container-managed relationships.

Container-Managed Persistence
The term container-managed persistence means that the EJB container handles
all database access required by the entity bean. The bean’s code contains no
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database access (SQL) calls. As a result, the bean’s code is not tied to a specific
persistent storage mechanism (database). Because of this flexibility, even if you
redeploy the same entity bean on different J2EE servers that use different data-
bases, you won’t need to modify or recompile the bean’s code. In short, your
entity beans are more portable.

In order to generate the data access calls, the container needs information that
you provide in the entity bean’s abstract schema.

Abstract Schema
Part of an entity bean’s deployment descriptor, the abstract schema defines the
bean’s persistent fields and relationships. The term abstract distinguishes this
schema from the physical schema of the underlying data store. In a relational
database, for example, the physical schema is made up of structures such as
tables and columns.

You specify the name of an abstract schema in the deployment descriptor. This
name is referenced by queries written in the Enterprise JavaBeans Query Lan-
guage (“EJB QL”). For an entity bean with container-managed persistence, you
must define an EJB QL query for every finder method (except findByPrima-
ryKey). The EJB QL query determines the query that is executed by the EJB
container when the finder method is invoked. To learn more about EJB QL, see
Chapter 24.
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You’ll probably find it helpful to sketch the abstract schema before writing any
code. Figure 18–1 represents a simple abstract schema that describes the
relationships between three entity beans. These relationships are discussed
further in the sections that follow.

Figure 18–1 A High-Level View of an Abstract Schema

Persistent Fields
The persistent fields of an entity bean are stored in the underlying data store.
Collectively, these fields constitute the state of the bean. At runtime, the EJB
container automatically synchronizes this state with the database. During
deployment, the container typically maps the entity bean to a database table and
maps the persistent fields to the table’s columns.

A CustomerEJB entity bean, for example, might have persistent fields such as
firstName, lastName, phone, and emailAddress. In container-managed persis-
tence, these fields are virtual. You declare them in the abstract schema, but you
do not code them as instance variables in the entity bean class. Instead, the per-
sistent fields are identified in the code by access methods (getters and setters).
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Relationship Fields
A relationship field is like a foreign key in a database table—it identifies a
related bean. Like a persistent field, a relationship field is virtual and is defined
in the enterprise bean class with access methods. But unlike a persistent field, a
relationship field does not represent the bean’s state. Relationship fields are dis-
cussed further in Direction in Container-Managed Relationships (page 673).

Multiplicity in Container-Managed
Relationships
There are four types of multiplicities:

One-to-one: Each entity bean instance is related to a single instance of another
entity bean. For example, to model a physical warehouse in which each storage
bin contains a single widget, StorageBinEJB and WidgetEJB would have a one-
to-one relationship.

One-to-many: An entity bean instance may be related to multiple instances of the
other entity bean. A sales order, for example, can have multiple line items. In the
order application, OrderEJB would have a one-to-many relationship with
LineItemEJB.

Many-to-one: Multiple instances of an entity bean may be related to a single
instance of the other entity bean. This multiplicity is the opposite of a one-to-
many relationship. In the example mentioned in the previous item, from the per-
spective of LineItemEJB the relationship to OrderEJB is many-to-one.

Many-to-many: The entity bean instances may be related to multiple instances of
each other. For example, in college each course has many students, and every
student may take several courses. Therefore, in an enrollment application, Cour-
seEJB and StudentEJB would have a many-to-many relationship.

Direction in Container-Managed
Relationships
The direction of a relationship may be either bidirectional or unidirectional. In a
bidirectional relationship, each entity bean has a relationship field that refers to
the other bean. Through the relationship field, an entity bean’s code can access
its related object. If an entity bean has a relative field, then we often say that it
“knows” about its related object. For example, if OrderEJB knows what



674 ENTERPRISE BEANS
LineItemEJB instances it has and if LineItemEJB knows what OrderEJB it
belongs to, then they have a bidirectional relationship.

In a unidirectional relationship, only one entity bean has a relationship field that
refers to the other. For example, LineItemEJB would have a relationship field
that identifies ProductEJB, but ProductEJB would not have a relationship field
for LineItemEJB. In other words, LineItemEJB knows about ProductEJB, but
ProductEJB doesn’t know which LineItemEJB instances refer to it.

EJB QL queries often navigate across relationships. The direction of a relation-
ship determines whether a query can navigate from one bean to another. For
example, a query can navigate from LineItemEJB to ProductEJB, but cannot
navigate in the opposite direction. For OrderEJB and LineItemEJB, a query
could navigate in both directions, since these two beans have a bidirectional rela-
tionship.

When to Use Entity Beans
You should probably use an entity bean under the following conditions:

• The bean represents a business entity, not a procedure. For example, Cred-
itCardEJB would be an entity bean, but CreditCardVerifierEJB would
be a session bean.

• The bean’s state must be persistent. If the bean instance terminates or if the
J2EE server is shut down, the bean’s state still exists in persistent storage
(a database).

What Is a Message-Driven Bean?
A message-driven bean is an enterprise bean that allows J2EE applications to
process messages asynchronously. It normally acts as a JMS message listener,
which is similar to an event listener except that it receives JMS messages instead
of events. The messages may be sent by any J2EE component—an application
client, another enterprise bean, or a Web component—or by a JMS application or
system that does not use J2EE technology. Message-driven beans may process
either JMS messages or other kinds of messages.

For a simple code sample, see Chapter 23. For more information about using
message-driven beans, see Using the JMS API in a J2EE
Application (page 1035) and Chapter 30.
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What Makes Message-Driven Beans
Different from Session and Entity Beans?
The most visible difference between message-driven beans and session and
entity beans is that clients do not access message-driven beans through inter-
faces. Interfaces are described in the section Defining Client Access with
Interfaces (page 676). Unlike a session or entity bean, a message-driven bean has
only a bean class.

In several respects, a message-driven bean resembles a stateless session bean.

• A message-driven bean’s instances retain no data or conversational state
for a specific client.

• All instances of a message-driven bean are equivalent, allowing the EJB
container to assign a message to any message-driven bean instance. The
container can pool these instances to allow streams of messages to be pro-
cessed concurrently.

• A single message-driven bean can process messages from multiple clients.

The instance variables of the message-driven bean instance can contain some
state across the handling of client messages—for example, a JMS API connec-
tion, an open database connection, or an object reference to an enterprise bean
object.

Client components do not locate message-driven beans and invoke methods
directly on them. Instead, a client accesses a message-driven bean through JMS
by sending messages to the message destination for which the message-driven
bean class is the MessageListener. A message-driven bean’s destination is
assigned during deployment using Application Server resources.

Message-driven beans have the following characteristics:

• They execute upon receipt of a single client message.

• The are asynchronously invoked.

• They are relatively short-lived.

• They do not represent directly shared data in the database, but they may
access and update this data.

• They may be transaction-aware.

• They are stateless.

When a message arrives, the container calls the message-driven bean’s onMes-

sage method to process the message. The onMessage method normally casts the
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message to one of the five JMS message types and handles it in accordance with
the application’s business logic. The onMessage method may call helper meth-
ods, or it may invoke a session or entity bean to process the information in the
message or to store it in a database.

A message may be delivered to a message-driven bean within a transaction con-
text, so that all operations within the onMessage method are part of a single
transaction. If message processing is rolled back, the message will be redeliv-
ered. For more information, see Chapter 23.

When to Use Message-Driven Beans
Session beans and entity beans allow you to send JMS messages and to receive
them synchronously, but not asynchronously. To avoid tying up server resources,
you may prefer not to use blocking synchronous receives in a server-side compo-
nent. To receive messages asynchronously, use a message-driven bean.

Defining Client Access with Interfaces
The material in this section applies only to session and entity beans, not to mes-
sage-driven beans. Because they have a different programming model, message-
driven beans do not have interfaces that define client access.

A client may access a session or an entity bean only through the methods defined
in the bean’s interfaces. These interfaces define the client’s view of a bean. All
other aspects of the bean—method implementations, deployment descriptor set-
tings, abstract schemas, and database access calls—are hidden from the client.

Well-designed interfaces simplify the development and maintenance of J2EE
applications. Not only do clean interfaces shield the clients from any complexi-
ties in the EJB tier, but they also allow the beans to change internally without
affecting the clients. For example, even if you change your entity beans from
bean-managed to container-managed persistence, you won’t have to alter the cli-
ent code. But if you were to change the method definitions in the interfaces, then
you might have to modify the client code as well. Therefore, to isolate your cli-
ents from possible changes in the beans, it is important that you design the inter-
faces carefully.

When you design a J2EE application, one of the first decisions you make is the
type of client access allowed by the enterprise beans: remote, local, or Web ser-
vice.
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Remote Clients
A remote client of an enterprise bean has the following traits:

• It may run on a different machine and a different Java virtual machine
(JVM) than the enterprise bean it accesses. (It is not required to run on a
different JVM.)

• It can be a Web component, a J2EE application client, or another enterprise
bean.

• To a remote client, the location of the enterprise bean is transparent.

To create an enterprise bean with remote access, you must code a remote inter-
face and a home interface. The remote interface defines the business methods
that are specific to the bean. For example, the remote interface of a bean named
BankAccountEJB might have business methods named deposit and credit. The
home interface defines the bean’s life cycle methods—create and remove. For
entity beans, the home interface also defines finder methods and home methods.
Finder methods are used to locate entity beans. Home methods are business
methods that are invoked on all instances of an entity bean class. Figure 18–2
shows how the interfaces control the client’s view of an enterprise bean.

Figure 18–2 Interfaces for an Enterprise Bean With Remote Access
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Local Clients
A local client has these characteristics:

• It must run in the same JVM as the enterprise bean it accesses.

• It may be a Web component or another enterprise bean.

• To the local client, the location of the enterprise bean it accesses is not
transparent.

• It is often an entity bean that has a container-managed relationship with
another entity bean.

To build an enterprise bean that allows local access, you must code the local
interface and the local home interface. The local interface defines the bean’s
business methods, and the local home interface defines its life cycle and finder
methods.

Local Interfaces and Container-
Managed Relationships
If an entity bean is the target of a container-managed relationship, then it must
have local interfaces. The direction of the relationship determines whether or not
a bean is the target. In Figure 18–1, for example, ProductEJB is the target of a
unidirectional relationship with LineItemEJB. Because LineItemEJB accesses
ProductEJB locally, ProductEJB must have the local interfaces. LineItemEJB
also needs local interfaces—not because of its relationship with ProductEJB—
but because it is the target of a relationship with OrderEJB. And because the
relationship between LineItemEJB and OrderEJB is bidirectional, both beans
must have local interfaces.

Because they require local access, entity beans that participate in a container-
managed relationship must reside in the same EJB JAR file. The primary benefit
of this locality is increased performance—local calls are usually faster than
remote calls.

Deciding on Remote or Local Access
The decision regarding whether to allow local or remote access depends on the
following factors.
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Container-managed relationships: If an entity bean is the target of a container-
managed relationship, it must use local access.

Tight or loose coupling of related beans: Tightly coupled beans depend on one
another. For example, a completed sales order must have one or more line items,
which cannot exist without the order to which they belong. The OrderEJB and
LineItemEJB entity beans that model this relationship are tightly coupled.
Tightly coupled beans are good candidates for local access. Since they fit
together as a logical unit, they probably call each other often and would benefit
from the increased performance that is possible with local access.

Type of client: If an enterprise bean is accessed by J2EE application clients, then
it should allow remote access. In a production environment, these clients almost
always run on different machines than the J2EE server. If an enterprise bean’s
clients are Web components or other enterprise beans, then the type of access
depends on how you want to distribute your components.

Component distribution: J2EE applications are scalable because their server-side
components can be distributed across multiple machines. In a distributed appli-
cation, for example, the Web components may run on a different server than the
enterprise beans they access. In this distributed scenario, the enterprise beans
should allow remote access.

Performance: Because of factors such as network latency, remote calls may be
slower than local calls. On the other hand, if you distribute components among
different servers, you might improve the application’s overall performance. Both
of these statements are generalizations; actual performance can vary in different
operational environments. Nevertheless, you should keep in mind how your
application design might affect performance.

If you aren’t sure which type of access an enterprise bean should have, then
choose remote access. This decision gives you more flexibility—in the future
you can distribute your components to accommodate growing demands on your
application.

Although uncommon, it is possible for an enterprise bean to allow both remote
and local access. Such a bean would require both remote and local interfaces.

Web Service Clients
A Web service client can access a J2EE application in two ways. First, the client
can access a Web service created with JAX-RPC. (For more information on
JAX-RPC, see the chapter, Building Web Services With JAX-RPC, page 329.)
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Second, a Web service client can invoke the business methods of a stateless ses-
sion bean. Other types of enterprise beans cannot be accessed by Web service
clients.

Provided that it uses the correct protocols (SOAP, HTTP, WSDL), any Web ser-
vice client can access a stateless session bean, whether or not the client is written
in the Java™ programming language. The client doesn’t even “know” what tech-
nology implements the service-- stateless session bean, JAX-RPC, or some other
technology. In addition, enterprise beans and Web components may be clients of
Web services. This flexibility enables you to integrate J2EE applications with
Web services.

A Web service client accesses a stateless session bean through the bean’s Web
service endpoint interface. Like a remote interface, a Web service endpoint inter-
face defines the business methods of the bean. In contrast to a remote interface, a
Web service endpoint interface is not accompanied by a home interface, which
defines the bean’s life-cycle methods. The only methods of the bean that may be
invoked by a Web service client are the business methods that are defined in the
Web service endpoint interface.

For a code sample, see A Web Service Example: HelloServiceEJB (page 721).

Method Parameters and Access
The type of access affects the parameters of the bean methods that are called by
clients. The following topics apply not only to method parameters, but also to
method return values.

Isolation
The parameters of remote calls are more isolated than those of local calls. With
remote calls, the client and bean operate on different copies of a parameter
object. If the client changes the value of the object, the value of the copy in the
bean does not change. This layer of isolation can help protect the bean if the cli-
ent accidentally modifies the data.

In a local call, both the client and the bean may modify the same parameter
object. In general, you should not rely on this side effect of local calls. Perhaps
someday you will want to distribute your components, replacing the local calls
with remote ones.
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Similar to remote clients, Web service clients operate on different copies of
parameters than the bean that implements the Web service.

Granularity of Accessed Data
Because remote calls are likely to be slower than local calls, the parameters in
remote methods should be relatively coarse-grained. Since a coarse-grained
object contains more data than a fine-grained one, fewer access calls are
required. For the same reason, the parameters of the methods called by Web ser-
vice clients should also be coarse-grained.

For example, suppose that a CustomerEJB entity bean is accessed remotely. This
bean would have a single getter method that returns a CustomerDetails object,
which encapsulates all of the customer’s information. But if CustomerEJB is to
be accessed locally, it could have a getter method for each instance variable:
getFirstName, getLastName, getPhoneNumber, and so forth. Because local
calls are fast, the multiple calls to these finer-grained getter methods would not
significantly degrade performance.

The Contents of an Enterprise Bean
To develop an enterprise bean, you must provide the following files:

• Deployment descriptor: An XML file that specifies information about the
bean such as its persistence type and transaction attributes. The deploy-

tool utility creates the deployment descriptor when you step through the
New Enterprise Bean wizard.

• Enterprise bean class: Implements the methods defined in the following
interfaces.

• Interfaces: The remote and home interfaces are required for remote access.
For local access, the local and local home interfaces are required. For
access by Web service clients, the Web service endpoint interface is
required. See the section Defining Client Access with
Interfaces (page 676). (Please note that these interfaces are not used by
message-driven beans.)

• Helper classes: Other classes needed by the enterprise bean class, such as
exception and utility classes.

You package the files in the preceding list into an EJB JAR file, the module that
stores the enterprise bean. An EJB JAR file is portable and may be used for dif-
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ferent applications. To assemble a J2EE application, you package one or more
modules—such as EJB JAR files—into an EAR file, the archive file that holds
the application. When you deploy the EAR file that contains the bean’s EJB JAR
file, you also deploy the enterprise bean onto the J2EE server. You may also
deploy an EJB JAR that is not contained in an EAR file.

Naming Conventions for Enterprise
Beans

Because enterprise beans are composed of multiple parts, it’s useful to follow a
naming convention for your applications. Table 18–2 summarizes the conven-
tions for the example beans of this tutorial.

DD means that the item is an element in the bean’s deployment descriptor.

Table 18–2 Naming Conventions for Enterprise Beans

Item Syntax Example

Enterprise bean name (DD) <name>EJB AccountEJB

EJB JAR display name (DD) <name>JAR AccountJAR

Enterprise bean class <name>Bean AccountBean

Home interface <name>Home AccountHome

Remote interface <name> Account

Local home interface <name>LocalHome AccountLocalHome

Local interface <name>Local AccountLocal

Abstract schema (DD) <name> Account
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The Life Cycles of Enterprise Beans
An enterprise bean goes through various stages during its lifetime, or life cycle.
Each type of enterprise bean—session, entity, or message-driven—has a differ-
ent life cycle.

The descriptions that follow refer to methods that are explained along with the
code examples in the next two chapters. If you are new to enterprise beans, you
should skip this section and try out the code examples first.

The Life Cycle of a Stateful Session Bean
Figure 18–3 illustrates the stages that a session bean passes through during its
lifetime. The client initiates the life cycle by invoking the create method. The
EJB container instantiates the bean and then invokes the setSessionContext

and ejbCreate methods in the session bean. The bean is now ready to have its
business methods invoked.

Figure 18–3 Life Cycle of a Stateful Session Bean

While in the ready stage, the EJB container may decide to deactivate, or passi-
vate, the bean by moving it from memory to secondary storage. (Typically, the
EJB container uses a least-recently-used algorithm to select a bean for passiva-
tion.) The EJB container invokes the bean’s ejbPassivate method immediately
before passivating it. If a client invokes a business method on the bean while it is
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in the passive stage, the EJB container activates the bean, calls the bean’s ejbAc-
tivate method, and then moves it to the ready stage.

At the end of the life cycle, the client invokes the remove method and the EJB
container calls the bean’s ejbRemove method. The bean’s instance is ready for
garbage collection.

Your code controls the invocation of only two life-cycle methods—the create

and remove methods in the client. All other methods in Figure 18–3 are invoked
by the EJB container. The ejbCreate method, for example, is inside the bean
class, allowing you to perform certain operations right after the bean is instanti-
ated. For instance, you may wish to connect to a database in the ejbCreate

method. See Chapter 26 for more information.

The Life Cycle of a Stateless Session
Bean
Because a stateless session bean is never passivated, its life cycle has just two
stages: nonexistent and ready for the invocation of business methods. Figure 18–
4 illustrates the stages of a stateless session bean.

Figure 18–4 Life Cycle of a Stateless Session Bean
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The Life Cycle of an Entity Bean
Figure 18–5 shows the stages that an entity bean passes through during its life-
time. After the EJB container creates the instance, it calls the setEntityCon-

text method of the entity bean class. The setEntityContext method passes the
entity context to the bean.

After instantiation, the entity bean moves to a pool of available instances. While
in the pooled stage, the instance is not associated with any particular EJB object
identity. All instances in the pool are identical. The EJB container assigns an
identity to an instance when moving it to the ready stage.

There are two paths from the pooled stage to the ready stage. On the first path,
the client invokes the create method, causing the EJB container to call the ejb-

Create and ejbPostCreate methods. On the second path, the EJB container
invokes the ejbActivate method. While in the ready stage, an entity bean’s
business methods may be invoked.

There are also two paths from the ready stage to the pooled stage. First, a client
may invoke the remove method, which causes the EJB container to call the
ejbRemove method. Second, the EJB container may invoke the ejbPassivate

method.
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Figure 18–5 Life Cycle of an Entity Bean

At the end of the life cycle, the EJB container removes the instance from the
pool and invokes the unsetEntityContext method.

In the pooled state, an instance is not associated with any particular EJB object
identity. With bean-managed persistence, when the EJB container moves an
instance from the pooled state to the ready state, it does not automatically set the
primary key. Therefore, the ejbCreate and ejbActivate methods must assign a
value to the primary key. If the primary key is incorrect, the ejbLoad and ejb-

Store methods cannot synchronize the instance variables with the database. In
the section The SavingsAccountEJB Example (page 741), the ejbCreate
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method assigns the primary key from one of the input parameters. The ejbActi-

vate method sets the primary key (id) as follows:

id = (String)context.getPrimaryKey();

In the pooled state, the values of the instance variables are not needed. You can
make these instance variables eligible for garbage collection by setting them to
null in the ejbPassivate method.

The Life Cycle of a Message-Driven
Bean
Figure 18–6 illustrates the stages in the life cycle of a message-driven bean.

The EJB container usually creates a pool of message-driven bean instances. For
each instance, the EJB container instantiates the bean and performs these tasks:

1. It calls the setMessageDrivenContext method to pass the context object
to the instance.

2. It calls the instance’s ejbCreate method.

Figure 18–6 Life Cycle of a Message-Driven Bean
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Like a stateless session bean, a message-driven bean is never passivated, and it
has only two states: nonexistent and ready to receive messages.

At the end of the life cycle, the container calls the ejbRemove method. The
bean’s instance is then ready for garbage collection.
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Getting Started With
Enterprise Beans

THIS chapter shows how to develop, deploy, and run a simple J2EE applica-
tion named ConverterApp. The purpose of ConverterApp is to calculate cur-
rency conversions between Yen and Eurodollars. ConverterApp consists of an
enterprise bean, which performs the calculations, and two types of clients: a
J2EE application client and a Web client.

Here’s an overview of the steps you’ll follow in this chapter:

1. Create the J2EE application: ConverterApp

2. Create the enterprise bean: ConverterEJB

3. Create the J2EE application client: ConverterClient

4. Create the Web client in ConverterWAR

5. Deploy ConverterApp onto the server

6. From a terminal window, run ConverterClient

7. Using a browser, run the Web client

Before proceeding, make sure that you’ve done the following:

• Read the Overview (TBD link) chapter

• Tried out the TBD tutorial in TBD

• Started the server (see TBD)

• Launched deploytool (see TBD)
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Creating the J2EE Application
In this section, you’ll create a J2EE application named ConverterApp, storing it
in the file ConverterApp.ear.

1. In deploytool, select File→New→Application EAR.

2. Click Browse.

3. In the file chooser, navigate to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/converter/

4. In the File Name field, enter ConverterApp.ear.

5. Click New Application.

6. Click OK.

7. Verify that the ConverterApp.ear file resides in the directory specified in
step 3.

At this point, the application contains no J2EE components and cannot be
deployed. In the sections that follow, when you run the deploytool wizards to
create the components, deploytool will add the components to the Converter-

App.ear file.

Creating the Enterprise Bean
An enterprise bean is a server-side component that contains the business logic of
an application. At runtime, the clients execute the business logic by invoking the
enterprise bean’s methods. The enterprise bean in our example is a stateless ses-
sion bean called ConverterEJB. The source code for ConverterEJB is in the
<INSTALL>/j2eetutorial14/examples/ejb/converter/src/ directory.

Creating ConverterEJB requires these steps:

1. Coding the bean’s interfaces and class (the source code is provided)

2. Compiling the source code with asant

3. With deploytool, packaging the bean into an EJB JAR file and inserting the
EJB JAR file into the application’s ConverterApp.ear file
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Coding the Enterprise Bean
The enterprise bean in this example needs the following code:

• Remote interface

• Home interface

• Enterprise bean class

Coding the Remote Interface
A remote interface defines the business methods that a client may call. The busi-
ness methods are implemented in the enterprise bean code. The source code for
the Converter remote interface follows.

import javax.ejb.EJBObject;
import java.rmi.RemoteException;
import java.math.*;

public interface Converter extends EJBObject {
   public BigDecimal dollarToYen(BigDecimal dollars)
      throws RemoteException;
   public BigDecimal yenToEuro(BigDecimal yen)
      throws RemoteException;
}

Coding the Home Interface
A home interface defines the methods that allow a client to create, find, or
remove an enterprise bean. The ConverterHome interface contains a single cre-
ate method, which returns an object of the remote interface type. Here is the
source code for the ConverterHome interface:

import java.io.Serializable;
import java.rmi.RemoteException;
import javax.ejb.CreateException;
import javax.ejb.EJBHome;

public interface ConverterHome extends EJBHome {
Converter create() throws RemoteException, CreateException;

}
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Coding the Enterprise Bean Class
The enterprise bean class for this example is called ConverterBean. This class
implements the two business methods, dollarToYen and yenToEuro, that the
Converter remote interface defines. The source code for the ConverterBean

class follows.

import java.rmi.RemoteException;
import javax.ejb.SessionBean;
import javax.ejb.SessionContext;
import java.math.*;

public class ConverterBean implements SessionBean {

BigDecimal yenRate = new BigDecimal("121.6000");
BigDecimal euroRate = new BigDecimal("0.0077");

public BigDecimal dollarToYen(BigDecimal dollars) {
BigDecimal result = dollars.multiply(yenRate);
return result.setScale(2,BigDecimal.ROUND_UP);

}

   public BigDecimal yenToEuro(BigDecimal yen) {
      BigDecimal result = yen.multiply(euroRate);
      return result.setScale(2,BigDecimal.ROUND_UP);
   }

   public ConverterBean() {}
   public void ejbCreate() {}
   public void ejbRemove() {}
   public void ejbActivate() {}
   public void ejbPassivate() {}
   public void setSessionContext(SessionContext sc) {}
}

Compiling the Source Files
Now you are ready to compile the remote interface (Converter.java), home
interface (ConverterHome.java), and the enterprise bean class (Converter-
Bean.java).

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/converter/

2. Type the following command:
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asant build

This command compiles the source files for the enterprise bean and the J2EE
application client, placing the class files in the converter/build subdirectory
(not the src directory). The Web client in this example requires no compilation.
For more information about asant, see Building and Running the
Examples (page xxix).

Note: When compiling the code, the preceding asant task includes the j2ee.jar

file in the classpath. This file resides in the lib directory of your J2EE Application
Server installation. If you plan on using other tools to compile the source code for
J2EE components, make sure that the classpath includes the j2ee.jar file.

Packaging the Enterprise Bean
To package an enterprise bean, you run the Edit Enterprise Bean wizard of the
deploytool utility. During this process, the wizard performs the following
tasks:

• Creates the bean’s deployment descriptor

• Packages the deployment descriptor and the bean’s classes in an EJB JAR
file

• Inserts the EJB JAR file into the ConverterApp.ear file

To start the Edit Enterprise Bean wizard, select File→New→Enterprise Bean. The
wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2. EJB JAR dialog box

a. Select the button labelled Create New JAR Module in Application.

b. In the combo box below this button, select ConverterApp.

c. In the JAR Display Name field, enter ConverterJAR.

d. Click Edit.

e. In the tree under Available Files, locate the converter/build subdirec-
tory. (If the target directory is many levels down in the tree, you can sim-
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plify the tree view by entering all or part of the directory’s path name in
the Starting Directory field.)

f. In the Available Files tree select these classes: Converter.class, Con-
verterBean.class, and ConverterHome.class. (You may also drag
and drop these class files to the Contents text area.)

g. Click Add.

h. Click OK.

i. Click Next.

3. General dialog box

a. Under Bean Type, select the Session button.

b. Select the Stateless button.

c. In the Enterprise Bean Class combo box, select converter.Convert-
erBean.

d. In the Enterprise Bean Name field, enter ConverterEJB.

e. In the Remote Home Interface combo box, select converter.Convert-
erHome.

f. In the Remote Interface combo box, select converter.Converter.

g. Click Next.

4. In the Configuration Options dialog box, click Next.

5. Click Finish.

Creating the J2EE Application Client
A J2EE application client is a program written in the Java programming lan-
guage. At runtime, the client program executes in a different virtual machine
than the J2EE server. For detailed information on the appclient command line
tool see the man page at http://java.sun.com/j2ee/1.4/docs/rel-

notes/cliref/index.html.

The J2EE application client in this example requires two different JAR files. The
first JAR file is for the J2EE component of the client. This JAR file contains the
client’s deployment descriptor and class files; it is created when you run the New
Application Client wizard. Defined by the J2EE Specification, this JAR file is
portable across all compliant J2EE servers.

The second JAR file contains stub classes that are required by the client program
at runtime. These stub classes enable the client to access the enterprise beans that

http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/index.html
http://java.sun.com/j2ee/1.4/docs/relnotes/cliref/index.html
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are running in the J2EE server. The JAR file for the stubs is created by deploy-
tool when you deploy the application. Because this JAR file is not covered by the
J2EE Specification, it is implementation specific, intended only for the J2EE
Application Server.

The J2EE application client source code is in the ConverterClient.java file,
which is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/converter/src/

You already compiled this code along with the enterprise bean code in the sec-
tion Compiling the Source Files (page 692).

Coding the J2EE Application Client
The ConverterClient.java source code illustrates the basic tasks performed
by the client of an enterprise bean:

• Locating the home interface

• Creating an enterprise bean instance

• Invoking a business method

Locating the Home Interface
The ConverterHome interface defines life-cycle methods such as create. Before
the ConverterClient can invoke the create method, it must locate and instanti-
ate an object whose type is ConverterHome. This is a four-step process.

1. Create an initial naming context.

Context initial = new InitialContext();

The Context interface is part of the Java Naming and Directory Interface
(JNDI). A naming context is a set of name-to-object bindings. A name
that is bound within a context is the JNDI name of the object.

An InitialContext object, which implements the Context interface,
provides the starting point for the resolution of names. All naming opera-
tions are relative to a context.

2. Obtain the environment naming context of the application client.

Context myEnv = (Context)initial.lookup("java:comp/env");
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The java:comp/env name is bound to the environment naming context of
the ConverterClient component.

3. Retrieve the object bound to the name ejb/SimpleConverter.

Object objref = myEnv.lookup("ejb/SimpleConverter");

The ejb/SimpleConverter name is bound to an enterprise bean refer-
ence, a logical name for the home of an enterprise bean. In this case, the
ejb/SimpleConverter name refers to the ConverterHome object. The
names of enterprise beans should reside in the java:com/env/ejb sub-
context.

4. Narrow the reference to a ConverterHome object.

ConverterHome home =

(ConverterHome) PortableRemoteObject.narrow(objref,

ConverterHome.class);

Creating an Enterprise Bean Instance
To create the bean instance, the client invokes the create method on the Con-

verterHome object. The create method returns an object whose type is Con-

verter. The remote Converter interface defines the business methods of the
bean that the client may call. When the client invokes the create method, the
EJB container instantiates the bean and then invokes the ConverterBean.ejb-

Create method. The client invokes the create method as follows:

Converter currencyConverter = home.create();

Invoking a Business Method
Calling a business method is easy—you simply invoke the method on the Con-

verter object. The EJB container will invoke the corresponding method on the
ConverterEJB instance that is running on the server. The client invokes the dol-

larToYen business method in the following lines of code.

BigDecimal param = new BigDecimal ("100.00");
BigDecimal amount = currencyConverter.dollarToYen(param);
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ConverterClient Source Code
The full source code for the ConverterClient program follows.

import javax.naming.Context;
import javax.naming.InitialContext;
import javax.rmi.PortableRemoteObject;
import java.math.BigDecimal;

public class ConverterClient {

public static void main(String[] args) {

try {
Context initial = new InitialContext();
Object objref = initial.lookup

("java:comp/env/ejb/SimpleConverter");

ConverterHome home =
(ConverterHome)PortableRemoteObject.narrow(objref,

ConverterHome.class);

Converter currencyConverter = home.create();

BigDecimal param = new BigDecimal ("100.00");
BigDecimal amount =

currencyConverter.dollarToYen(param);
System.out.println(amount);
amount = currencyConverter.yenToEuro(param);
System.out.println(amount);

System.exit(0);

} catch (Exception ex) {
System.err.println("Caught an unexpected exception!");
ex.printStackTrace();

}
}

}

Compiling the Application Client
The application client files are compiled at the same time as the enterprise bean
files, as described in Compiling the Source Files (page 692).
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Packaging the J2EE Application Client
To package an application client component, you run the New Application Client
wizard of the deploytool. During this process the wizard performs the follow-
ing tasks.

• Creates the application client’s deployment descriptor

• Puts the deployment descriptor and client files into a JAR file

• Adds the JAR file to the application’s ConverterApp.ear file

To start the New Application Client wizard, select File→New→Application Cli-
ent. The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2.  JAR File Contents dialog box

a. Select the button labelled Create New AppClient Module in Applica-
tion.

b. In the combo box below this button, select ConverterApp.

c. In the AppClient Display Name field, enter ConverterClient.

d. Click Edit.

e. In the tree under Available Files, locate this directory:

<INSTALL>/j2eetutorial14/examples/ejb/converter/build/

f. Select the ConverterClient.class file

g. Click Add.

h. Click OK.

i. Click Next.

3. General dialog box

a. In the Main Class combo box, select ConverterClient.

b. Click Next.

c. Click Finish.
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Specifying the Application Client’s
Enterprise Bean Reference
When it invokes the lookup method, the ConverterClient refers to the home of
an enterprise bean:

Object objref = myEnv.lookup("ejb/SimpleConverter");

You specify this reference as follows.

1. In the tree, select ConverterClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field, enter ejb/SimpleConverter.

5. In the EJB Type field, select Session.

6. In the Interfaces field, select Remote.

7. In the Home Interface column, field converter.ConverterHome.

8. In the Local/Remote Interface field, enter converter.Converter.

9. In the Enterprise Bean Name field, enter ConverterEJB.

10.Click OK.

Creating the Web Client
The Web client is contained in the JSP page
<INSTALL>/j2eetutorial14/examples/ejb/converter/web/index.jsp. A
JSP page is a text-based document that contains JSP elements, which construct
dynamic content, and static template data, which can be expressed in any text-
based format such as HTML, WML, and XML.

Coding the Web Client
The statements (in bold in the following code) for locating the home interface,
creating an enterprise bean instance, and invoking a business method are nearly
identical to those of the J2EE application client. The parameter of the lookup

method is the only difference; the motivation for using a different name is dis-
cussed in Mapping the Enterprise Bean References (page 703).
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The classes needed by the client are declared with a JSP page directive (enclosed
within the <%@ %> characters). Because locating the home interface and creating
the enterprise bean are performed only once, this code appears in a JSP declara-
tion (enclosed within the <%! %> characters) that contains the initialization
method, jspInit, of the JSP page. The declaration is followed by standard
HTML markup for creating a form with an input field. A scriptlet (enclosed
within the <% %> characters) retrieves a parameter from the request and converts
it to a BigDecimal object. Finally, JSP expressions (enclosed within <%= %>

characters) invoke the enterprise bean’s business methods and insert the result
into the stream of data returned to the client.

<%@ page import="Converter,ConverterHome,javax.ejb.*,
javax.naming.*, javax.rmi.PortableRemoteObject,
java.rmi.RemoteException" %>
<%!

private Converter converter = null;
public void jspInit() {

try {
InitialContext ic = new InitialContext();
Object objRef = ic.lookup("

java:comp/env/ejb/TheConverter");
ConverterHome home =
(ConverterHome)PortableRemoteObject.narrow(
objRef, ConverterHome.class);
converter = home.create();

} catch (RemoteException ex) {
...

}
}
...

%>
<html>
<head>

 <title>Converter</title>
</head>

<body bgcolor="white">
<h1><center>Converter</center></h1>
<hr>
<p>Enter an amount to convert:</p>
<form method="get">
<input type="text" name="amount" size="25">
<br>
<p>
<input type="submit" value="Submit">
<input type="reset" value="Reset">
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</form>
<%

String amount = request.getParameter("amount");
if ( amount != null && amount.length() > 0 ) {

BigDecimal d = new BigDecimal (amount);
%>

<p><%= amount %> dollars are
<%= converter.dollarToYen(d) %>  Yen.

<p><%= amount %> Yen are
<%= converter.yenToEuro(d) %>  Euro.

<%
 }

%>
</body>
</html>

Compiling the Web Client
The J2EE server automatically compiles Web clients that are JSP pages. If the
Web client were a servlet, you would have to compile it.

Packaging the Web Client
To package a Web client, you run the New Web Component wizard of the
deploytool utility. During this process the wizard performs the following tasks.

• Creates the Web application deployment descriptor

• Adds the component files to a WAR file

• Adds the WAR file to the application’s ConverterApp.ear file

To start the New Web Component wizard, select File→New→Web Component.
The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2. WAR File dialog box

a. Select the button labelled Create New WAR Module in Application.

a. In the combo box below this button, select ConverterApp.

b. In the WAR Display Name field, enter ConverterWAR.

c. Click Edit.
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d. In the tree under Available Files, locate this directory:

<INSTALL>/j2eetutorial14/examples/ejb/converter/web/

e. Select index.jsp.

f. Click Add.

g. Click OK.

h. Click Next.

3. Choose Component Type dialog box

a. Select the JSP button.

b. Click Next.

4. Component General Properties dialog box

a. In the JSP Filename combo box, select index.jsp.

b. Click Finish.

Specifying the Web Client’s Enterprise
Bean Reference
When it invokes the lookup method, the Web client refers to the home of an
enterprise bean:

Object objRef = ic.lookup("java:comp/env/ejb/TheConverter");

You specify this reference as follows:

1. In the tree, select ConverterClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field, enter ejb/TheConverter.

5. In the EJB Type field, select Session.

6. In the Interfaces field, select Remote.

7. In the Home Interface column, field converter.ConverterHome.

8. In the Local/Remote Interface field, enter converter.Converter.

9. In the Enterprise Bean Name field, enter ConverterEJB.

10.Click OK.
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Mapping the Enterprise Bean
References

Although the J2EE application client and the Web client access the same enter-
prise bean, their code refers to the bean’s home by different names. The J2EE
application client refers to the bean’s home as ejb/SimpleConverter, but the
Web client refers to it as ejb/TheConverter. These references are in the param-
eters of the lookup calls. In order for the lookup method to retrieve the home
object, you must map the references in the code to the enterprise bean’s JNDI
name. Although this mapping adds a level of indirection, it decouples the clients
from the beans, making it easier to assemble applications from J2EE compo-
nents.

To map the enterprise bean references in the clients to the JNDI name of the
bean, follow these steps.

1. In the tree, select ConverterApp.

2. Select the JNDI Names tab.

3. In the Application table, note that the JNDI name for the enterprise bean is
ConverterEJB.

4. In the References table enter ConverterEJB in the JNDI Name column for
each row.

Figure 19–1 shows what the JNDI Names tab should look like after you’ve per-
formed the preceding steps.
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Figure 19–1 ConverterApp JNDI Names

Specifying the Web Client’s Context
Root

The context root identifies the Web application. To set the context root, follow
these steps:

1. In the tree, select ConverterApp.

2. Select the Web Context tab.

3. In the Context Root field, enter /converter.

For more information, see Setting the Context Root (page 96).
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Deploying the J2EE Application
Now that the J2EE application contains the components, it is ready for deploy-
ment.

1. Select the ConverterApp application.

2. Select Tools→Deploy.

3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Tell deploytool to create a JAR file that contains the client stubs. (For
more information on client JAR files, see the description under Creating
the J2EE Application Client, page 694.)

a. Select the Return Client JAR check box.

b. In the field below the check box, enter
<INSTALL>/j2eetutorial14/examples/ejb/converter.

5. Click OK.

6. In the Distribute Module dialog box click Close when the deployment
completes.

7. Verify the deployment.

a. In the tree, expand the Servers node and select the host that is running
the J2EE server.

b. In the Deployed Objects table, make sure that the ConverterApp is
listed and its status is Running.

8. Verify that a stub client JAR named ConverterAppClient.jar resides in
<INSTALL>/j2eetutorial14/examples/ejb/converter.

Running the J2EE Application Client
To run the J2EE application client, perform the following steps.

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/converter/

2. Type the following command:

appclient -client ConverterAppClient.jar

3. In the terminal window, the client displays these lines:
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. . .

12160.00

0.77

. . .

Running the Web Client
To run the Web client, point your browser at the following URL. Replace <host>
with the name of the host running the J2EE server. If your browser is running on
the same host as the J2EE server, you may replace <host> with localhost.

http://<host>:1024/converter

You should see the screen shown in Figure 19–2 after entering 100 in the input
field and clicking Submit.

Figure 19–2 Converter Web Client
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Modifying the J2EE Application
The J2EE Application Server and deploytool support iterative development.
Whenever you make a change to a J2EE application, you must redeploy the
application.

Modifying a Class File
To modify a class file in an enterprise bean, you change the source code, recom-
pile it, and redeploy the application. For example, if you want to change the
exchange rate in the dollarToYen business method of the ConverterBean class,
you would follow these steps.

1. Edit ConverterBean.java.

2. Recompile ConverterBean.java.

a. In a terminal window, go to the
<INSTALL>/j2eetutorial14/examples/ejb/converter/ subdirec-
tory.

b. Type asant build.

3. In deploytool, select Tools→Update Module Files.

4. The Update Files dialog box appears. If the modified files are listed at the
top of the dialog, click OK and go to step 6. If the files are listed at the bot-
tom, they have not been found. Select one of those files and click Edit
Search Paths.

5. In the Edit Search Paths dialog, specify the directories where the Update
Files dialog will search for modified files.

a. In the Search Root field, enter the fully-qualified name of the directory
from which the search will start.

b. In the Path Directory list, add a row for each directory that you want
searched. Unless fully-qualified, these directory names are relative to
the Search Root field.

c. Click OK.

6. Select Tools→Deploy. Make sure the checkbox labeled Save Object Before
Deploying is checked. If you do not want to deploy at this time, select
Tools→Save to save the search paths specified in step 5.

To modify the contents of a WAR file you follow the preceding steps. The
Update Files operation checks to see if any files have changed, including HTML
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files and JSP pages. If you change the index.jsp file of ConverterApp, be sure
to type asant. This task copies the index.jsp file from the web to the build

directory.

Adding a File
To add a file to the EJB JAR or WAR of the application, perform these steps.

1. In deploytool, select the JAR or WAR in the tree.

2. Select the General tab.

3. Click Edit.

4. In the tree of the Available Files field, locate the file and click Add.

5. Click OK.

6. From the main toolbar, select Tools→Update Module Files.

7. Select Tools→Deploy.

 Modifying a Deployment Setting
To modify a deployment setting of ConverterApp, you edit the appropriate field
in a tabbed pane and redeploy the application. For example, to change a JNDI
name from ATypo to ConverterEJB, you would follow these steps.

1. In deploytool, select ConverterApp in the tree.

2. Select the JNDI Names tab.

3. In the JNDI Name field, enter MyConverter.

4. From the main toolbar, select File→Save.

5. Select Tools→Update Module Files.

6. Select Tools→Deploy.



20
709
Session Bean
Examples

SESSION beans are powerful because they extend the reach of your clients into
remote servers, yet are easy to build. In Chapter 19, you built a stateless session
bean named ConverterEJB. This chapter examines the source code of three
more session beans:

• CartEJB - a stateful session bean that is accessed by a remote client

• HelloServiceEJB - a stateless session bean that implements a Web service

• TimerSessionEJB - a stateless session bean that sets a timer

The CartEJB Example
The CartEJB session bean represents a shopping cart in an online bookstore. The
bean’s client may add a book to the cart, remove a book, or retrieve the cart’s
contents. To construct CartEJB, you need the following code:

• Session bean class (CartBean)

• Home interface (CartHome)

• Remote interface (Cart)

All session beans require a session bean class. All enterprise beans that permit
remote access must have a home and remote interface. To meet the needs of a
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specific application, an enterprise bean may also need some helper classes. The
CartEJB session bean uses two helper classes, BookException and IdVerifier,
which are discussed in the section Helper Classes (page 716).

The source code for this example is in the
<J2EE_HOME>/j2eetutorial14/examples/ejb/cart/ directory.

Session Bean Class
The session bean class for this example is called CartBean. Like any session
bean, the CartBean class must meet these requirements:

• It implements the SessionBean interface.

• The class is defined as public.

• The class cannot be defined as abstract or final.

• It implements one or more ejbCreate methods.

• It implements the business methods.

• It contains a public constructor with no parameters.

• It must not define the finalize method.

 The source code for the CartBean class follows.

import java.util.*;
import javax.ejb.*;

public class CartBean implements SessionBean {

String customerName;
String customerId;
Vector contents;

public void ejbCreate(String person)
throws CreateException {

if (person == null) {
throw new CreateException("Null person not allowed.");

}
else {

customerName = person;
}

customerId = "0";
contents = new Vector();
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}

public void ejbCreate(String person, String id)
throws CreateException {

if (person == null) {
throw new CreateException("Null person not allowed.");

}
else {

customerName = person;
}

IdVerifier idChecker = new IdVerifier();
if (idChecker.validate(id)) {

customerId = id;
}
else {

throw new CreateException("Invalid id: "+ id);
}

contents = new Vector();
}

public void addBook(String title) {
contents.addElement(title);

}

public void removeBook(String title) throws BookException {

boolean result = contents.removeElement(title);
if (result == false) {

throw new BookException(title + "not in cart.");
}

   }

   public Vector getContents() {
      return contents;
   }

   public CartBean() {}
   public void ejbRemove() {}
   public void ejbActivate() {}
   public void ejbPassivate() {}
   public void setSessionContext(SessionContext sc) {}

}
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The SessionBean Interface
The SessionBean interface extends the EnterpriseBean interface, which in
turn extends the Serializable interface. The SessionBean interface declares
the ejbRemove, ejbActivate, ejbPassivate, and setSessionContext meth-
ods. The CartBean class doesn’t use these methods, but it must implement them
because they’re declared in the SessionBean interface. Consequently, these
methods are empty in the CartBean class. Later sections explain when you
might use these methods.

The ejbCreate Methods
Because an enterprise bean runs inside an EJB container, a client cannot directly
instantiate the bean. Only the EJB container can instantiate an enterprise bean.
During instantiation, the example program performs the following steps.

1. The client invokes a create method on the home object:

Cart shoppingCart = home.create("Duke DeEarl","123");

2. The EJB container instantiates the enterprise bean.

3. The EJB container invokes the appropriate ejbCreate method in Cart-

Bean:

public void ejbCreate(String person, String id)
throws CreateException {

if (person == null) {
throw new CreateException("Null person not allowed.");

}
else {

customerName = person;
}

IdVerifier idChecker = new IdVerifier();
if (idChecker.validate(id)) {

customerId = id;
}
else {

throw new CreateException("Invalid id: "+ id);
}

contents = new Vector();
}

http://java.sun.com/j2ee/tutorial/api/javax/ejb/SessionBean.html
http://java.sun.com/j2ee/tutorial/api/javax/ejb/EnterpriseBean.html
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Typically, an ejbCreate method initializes the state of the enterprise bean. The
preceding ejbCreate method, for example, initializes the customerName and
customerId variables with the arguments passed by the create method.

An enterprise bean must have one or more ejbCreate methods. The signatures
of the methods must meet the following requirements:

• The access control modifier must be public.

• The return type must be void.

• If the bean allows remote access, the arguments must be legal types for the
Java Remote Method Invocation (“Java RMI”) API.

• The modifier cannot be static or final.

The throws clause may include the javax.ejb.CreateException and other
exceptions that are specific to your application. The ejbCreate method usually
throws a CreateException if an input parameter is invalid.

Business Methods
The primary purpose of a session bean is to run business tasks for the client. The
client invokes business methods on the remote object reference that is returned
by the create method. From the client’s perspective, the business methods
appear to run locally, but they actually run remotely in the session bean. The fol-
lowing code snippet shows how the CartClient program invokes the business
methods:

Cart shoppingCart = home.create("Duke DeEarl", "123");
...
shoppingCart.addBook("The Martian Chronicles");
shoppingCart.removeBook("Alice In Wonderland");
bookList = shoppingCart.getContents();

The CartBean class implements the business methods in the following code:

public void addBook(String title) {
   contents.addElement(title);
}

public void removeBook(String title) throws BookException {
   boolean result = contents.removeElement(title);
   if (result == false) {
      throw new BookException(title + "not in cart.");
   }
}
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public Vector getContents() {
   return contents;
}

The signature of a business method must conform to these rules:

• The method name must not conflict with one defined by the EJB architec-
ture. For example, you cannot call a business method ejbCreate or
ejbActivate.

• The access control modifier must be public.

• If the bean allows remote access, the arguments and return types must be
legal types for the Java RMI API.

• The modifier must not be static or final.

The throws clause may include exceptions that you define for your application.
The removeBook method, for example, throws the BookException if the book is
not in the cart.

To indicate a system-level problem, such as the inability to connect to a data-
base, a business method should throw the javax.ejb.EJBException. When a
business method throws an EJBException, the container wraps it in a Remote-

Exception, which is caught by the client. The container will not wrap applica-
tion exceptions such as BookException. Because EJBException is a subclass of
RuntimeException, you do not need to include it in the throws clause of the
business method.

Home Interface
A home interface extends the javax.ejb.EJBHome interface. For a session bean,
the purpose of the home interface is to define the create methods that a remote
client may invoke. The CartClient program, for example, invokes this create

method:

Cart shoppingCart = home.create("Duke DeEarl", "123”);
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Every create method in the home interface corresponds to an ejbCreate

method in the bean class. The signatures of the ejbCreate methods in the Cart-

Bean class follow:

public void ejbCreate(String person) throws CreateException
...
public void ejbCreate(String person, String id)
   throws CreateException

Compare the ejbCreate signatures with those of the create methods in the
CartHome interface:

import java.io.Serializable;
import java.rmi.RemoteException;
import javax.ejb.CreateException;
import javax.ejb.EJBHome;

public interface CartHome extends EJBHome {
Cart create(String person) throws

RemoteException, CreateException;
Cart create(String person, String id) throws

RemoteException, CreateException;
}

The signatures of the ejbCreate and create methods are similar, but differ in
important ways. The rules for defining the signatures of the create methods of a
home interface follow.

• The number and types of arguments in a create method must match those
of its corresponding ejbCreate method.

• The arguments and return type of the create method must be valid RMI
types.

• A create method returns the remote interface type of the enterprise bean.
(But an ejbCreate method returns void.)

• The throws clause of the create method must include the
java.rmi.RemoteException and the javax.ejb.CreateException.
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Remote Interface
The remote interface, which extends javax.ejb.EJBObject, defines the busi-
ness methods that a remote client may invoke. Here is the source code for the
Cart remote interface:

import java.util.*;
import javax.ejb.EJBObject;
import java.rmi.RemoteException;

public interface Cart extends EJBObject {

   public void addBook(String title) throws RemoteException;
   public void removeBook(String title) throws

BookException, RemoteException;
   public Vector getContents() throws RemoteException;
}

The method definitions in a remote interface must follow these rules:

• Each method in the remote interface must match a method implemented in
the enterprise bean class.

• The signatures of the methods in the remote interface must be identical to
the signatures of the corresponding methods in the enterprise bean class.

• The arguments and return values must be valid RMI types.

• The throws clause must include the java.rmi.RemoteException.

Helper Classes
The CartEJB session bean has two helper classes: BookException and IdVeri-

fier. The BookException is thrown by the removeBook method and the IdVer-

ifier validates the customerId in one of the ejbCreate methods. Helper
classes must reside in the EJB JAR file that contains the enterprise bean class.

Building the CartEJB Example
Now you are ready to compile the remote interface (Cart.java), home interface
(CartHome.java), the enterprise bean class (CartBean.java), the client class
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(CartClient.java), and helper classes (BookException.java and IdVeri-

fier.java).

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/cart/

2. Type the following command:

asant build

Creating the Application
In this section, you’ll create a J2EE application named CartApp, storing it in the
file CartApp.ear.

1. In deploytool, select File→New→Application EAR.

2. Click Browse.

3. In the file chooser, navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/cart/.

4. In the File Name field, enter CartApp.

5. Click New Application.

6. Click OK.

7. Verify that the CartApp.ear file resides in
<INSTALL>/j2eetutorial14/examples/ejb/cart/.

Packaging the Enterprise Bean
1. In deploytool, select File→New→Enterprise Bean.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application.

b. In the Create New JAR Module in Application field select CartApp.

c. In the JAR Name field enter CartJAR.

d. Click Choose Module File.

e. Click Edit.

f. Locate the <INSTALL>/j2eetutorial14/exam-

ples/ejb/cart/build/ directory.

g. Select BookException.class, Cart.class, CartBean.class, CartH-
ome.class, and IdVerifier.class.
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h. Click Add.

i. Click OK.

j. Click Next.

3. In the General screen:

a. In the Enterprise Bean Class field select CartBean.

b. In the Enterprise Bean Name field enter CartEJB.

c. In the Enterprise Bean Type field select Stateful Session.

d. In the Remote Home Interface field select CartHome.

e. In the Remote Interface field select Cart.

f. Click Next.

4. In the Configuration Options screen:

a. In the Expose Bean as Web Service Endpoint field, select No.

b. Click Next.

5. Click Finish.

Packaging the Application Client
To package an application client component, you run the New Application Client
wizard of the deploytool. During this process the wizard performs the follow-
ing tasks.

• Creates the application client’s deployment descriptor

• Puts the deployment descriptor and client files into a JAR file

• Adds the JAR file to the application’s CartApp.ear file

To start the New Application Client wizard, select File→New→Application Client
JAR. The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2.  JAR File Contents dialog box

a. Select the button labelled Create New AppClient Module in Applica-
tion.

b. In the combo box below this button, select CartApp.
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c. In the AppClient Display Name field, enter CartClient.

d. Click Edit.

e. In the tree under Available Files, locate the
<INSTALL>/j2eetutorial14/examples/ejb/cart/build directory.

f. Select CartClient.class,

g. Click Add.

h. Click OK.

i. Click Next.

3. General dialog box

a. In the Main Class combo box, select CartClient.

b. Click Next.

c. Click Finish.

Specifying the Application Client’s Enterprise
Bean Reference
When it invokes the lookup method, the CartClient refers to the home of an
enterprise bean:

Object objref =
initial.lookup("java:comp/env/ejb/SimpleCart");

You specify this reference as follows.

1. In the tree, select CartClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field, enter ejb/SimpleCart.

5. In the EJB Type field, select Session.

6. In the Interfaces field, select Remote.

7. In the Home Interface field, enter CartHome.

8. In the Local/Remote Interface field, enter CartSession.

9. In the JNDI field, enter CartEJB.

10.Click OK.
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Deploying the Enterprise Application
Now that the J2EE application contains the components, it is ready for deploy-
ment.

1. Select CartApp.

2. Select Tools→Deploy.

3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Under Application Client Stub Directory check Return Client Jar.

5. In the field below the checkbox enter
<INSTALL>/j2eetutorial14/examples/ejb/cart/.

6. Click OK.

7. In the Distribute Module dialog box click Close when the deployment
completes.

8. Verify the deployment.

a. In the tree, expand the Servers node and select the host that is running
the J2EE server.

b. In the Deployed Objects table, make sure that CartApp is listed and its
status is Running.

c. Verify that CartAppClient.jar is in
<INSTALL>/j2eetutorial14/examples/ejb/cart/.

Running the J2EE Application Client
To run the J2EE application client, perform the following steps.

1. In a terminal window, go to the <INSTALL>/j2eetutorial14/

examples/ejb/cart/ directory.

2. Type the following command:

appclient -client CartAppClient.jar

3. In the terminal window, the client displays these lines:

The Martian Chronicles

2001 A Space Odyssey

The Left Hand of Darkness

Caught a BookException: Alice in Wonderland not in cart.
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A Web Service Example:
HelloServiceEJB

HelloServiceEJB is a stateless session bean that implements a single method,
sayHello. This method matches the sayHello method invoked by the clients
described in Creating Web Service Clients with JAX-RPC (page 339). Later in
this section, you’ll test the HelloServiceEJB by running one of these JAX-RPC
clients.

Web Service Endpoint Interface
HelloService is the bean’s Web service endpoint interface. It provides the cli-
ent’s view of the Web service, hiding the stateless session bean from the client. A
Web service endpoint interface must conform to the rules of a JAX-RPC service
definition interface. For a summary of these rules, see Coding the Service End-
point Interface and Implementation Class (page 334). Here is the source code for
the HelloService interface:

package helloservice;
import java.rmi.RemoteException;
import java.rmi.Remote;

public interface HelloService extends Remote {

   public String sayHello(String name) throws RemoteException;
}

Stateless Session Bean Implementation
Class
The HelloServiceBean class implements the sayHello method defined by the
HelloService interface. The interface decouples the implementation class from
the type of client access. For example, if you added remote and home interfaces
to HelloServiceEJB, the methods of the HelloServiceBean class could also be
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accessed by remote clients. No changes to the HelloServiceBean class would
be necessary. The source code for the HelloServiceBean class follows:

package helloservice;
import java.rmi.RemoteException;
import javax.ejb.SessionBean;
import javax.ejb.SessionContext;

public class HelloServiceBean implements SessionBean {

   public String sayHello(String name) {

      return “Hello “ + name + “from HelloServiceEJB”;
   }

   public HelloServiceBean() {}
   public void ejbCreate() {}
   public void ejbRemove() {}
   public void ejbActivate() {}
   public void ejbPassivate() {}
   public void setSessionContext(SessionContext sc) {}
}

Building HelloServiceEJB
In a terminal window, go to the <INSTALL>/j2eetutorial14/exam-

ples/ejb/helloservice/ directory. To build HelloServiceEJB, type the fol-
lowing command:

asant build-service

This command performs the following tasks:

• Compiles the bean’s source code files

• Creates the MyHelloService.wsdl file by running the following wscom-

pile command:

wscompile -define -d build/output -nd build -classpath build

-mapping build/mapping.xml config-interface.xml

The wscompile tool writes the MyHelloService.wsdl file to the
<INSTALL>/j2eetutorial14/examples/ejb/helloservice/build/ subdirec-
tory. For more information about the wscompile tool, see Chapter 8.

Use deploytool to package and deploy this example.
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Creating the Application
In this section, you’ll create a J2EE application named HelloService, storing it
in the file HelloService.ear.

1. In deploytool, select File→New→Application EAR.

2. Click Browse.

3. In the file chooser, navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/helloservice/.

4. In the File Name field, enter HelloServiceApp.

5. Click New Application.

6. Click OK.

7. Verify that the HelloServiceApp.ear file resides in
<INSTALL>/j2eetutorial14/examples/ejb/helloservice/.

Packaging the Enterprise Bean
Start the Edit Enterprise Bean wizard by selecting File→New→Enterprise Java-
Bean JAR. The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2. EJB JAR dialog box

a. Select the button labelled Create New JAR Module in Application.

b. In the combo box below this button, select HelloService.

c. In the JAR Display Name field, enter HelloServiceJAR.

d. Click Edit.

e. In the tree under Available Files, locate the
<INSTALL>/j2eetutorial14/examples/ejb/helloservice/build/

directory.

f. In the Available Files tree select mapping.xml and MyHelloSer-

vice.wsdl.

g. Select these classes from the
<INSTALL>/j2eetutorial14/examples/ejb/helloser-

vice/build/helloservice/ directory: HelloIF.class and HelloS-

erviceBean.class.
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h. Click Add.

i. Click OK.

j. Click Next.

3. General dialog box

a. Under Enterprise Bean Type, select Stateless Session.

b. In the Enterprise Bean Class combo box, select helloservice.Hel-
loServiceBean.

c. In the Enterprise Bean Name field, enter HelloServiceEJB.

d. Click Next.

4. In the Configuration Options dialog box, click Next. The wizard will auto-
matically select the Yes button for Expose Bean as Web Service Endpoint.

5. In the Choose Service dialog box:

a. Select META-INF/wsdl/MyHelloService.wsdl in the WSDL File
combo box.

b. Select mapping.xml from the Mapping File combo box.

c. Make sure MyHelloService is in the Service Name and Service Display
Name edit boxes.

6. In the Web Service Endpoint dialog box:

a. Select helloservice.HelloIF in the Service Endpoint Interface
combo box.

b. In the WSDL Port section, set the Namespace to urn:Foo, and the Local
Part to HelloIFPort.

c. In the Sun-specific Settings section, set the Endpoint Address URI to
hello-ejb/hello.

d. Click Next.

7. Click Finish.

8. Select HelloServiceJAR in the tree in deploytool.

9. Click the Web Services tabbed pane.

10.Select MyHelloService in the WebServices table.

11.In the Sun-specific Settings section in the WSDL Publish Location field
enter hello-ejb/hello?WSDL.
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Deploying the Enterprise Application
Now that the J2EE application contains the enterprise bean, it is ready for
deployment.

1. Select the HelloService application.

2. Select Tools→Deploy.

3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Click OK.

5. In the Distribute Module dialog box click Close when the deployment
completes.

6. Verify the deployment.

a. In the tree, expand the Servers node and select the host that is running
the J2EE application server.

b. In the Deployed Objects table, make sure that HelloService is listed
and its status is Running.

Building the Web Service Client
In the next section, to test the Web service implemented by HelloServiceEJB,
you will run the JAX-RPC client described in Chapter 8.

Verify that HelloServiceEJB has been deployed by clicking on the target appli-
cation server in the Servers tree in deploytool. In the Deployed Objects tree
you should see HelloServiceApp.

To build the static stub client, perform these steps:

1. In a terminal go to the <INSTALL>/j2eetutorial14/exam-

ples/jaxrpc/helloservice/ directory and type:

asant build

2. In a terminal go to the <INSTALL>/j2eetutorial14/exam-

ples/jaxrpc/staticstub/ directory.

3. Open config-wsdl.xml in a text editor and change the line that reads:

<wsdl location="http://localhost:8080/hello-

jaxrpc/hello?WSDL"

To:
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<wsdl location="http://localhost:8080/hello-ejb/hello?WSDL"

4. Type:

asant build

5. Edit the build.properties file and change the endpoint.address prop-
erty to

http://localhost:8080/hello-ejb/hello

For details about creating the JAX-RPC service and client, see these sections:
Creating a Web Service with JAX-RPC (page 333) and Static Stub Client
Example (page 339).

Running the Web Service Client
To run the client, go to the <INSTALL>/j2eetutorial14/exam-

ples/jaxrpc/staticstub/ directory and enter:

asant run

The client should display the following line:

Hello Duke! (from HelloServiceEJB)

Other Enterprise Bean Features
The topics that follow apply to both session and entity beans.

Accessing Environment Entries
Stored in an enterprise bean’s deployment descriptor, an environment entry is a
name-value pair that allows you to customize the bean’s business logic without
changing its source code. An enterprise bean that calculates discounts, for exam-
ple, might have an environment entry named Discount Percent. Before deploy-
ing the bean’s application, you could run a development tool to assign Discount

Percent a value of .05 in the bean’s deployment descriptor. When you run the
application, the bean fetches the .05 value from its environment.

In the following code example, the applyDiscount method uses environment
entries to calculate a discount based on the purchase amount. First, the method
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locates the environment naming context by invoking lookup with the
java:comp/env parameter. Then it calls lookup on the environment to get the
values for the Discount Level and Discount Percent names. For example, if
you assign a value of .05 to the Discount Percent entry, the code will assign .05
to the discountPercent variable. The applyDiscount method, which follows,
is in the CheckerBean class. The source code for this example is in
<J2EE_HOME>/j2eetutorial14/examples/ejb/checker.

public double applyDiscount(double amount) {

try {

double discount;

Context initial = new InitialContext();
Context environment =

(Context)initial.lookup("java:comp/env");

Double discountLevel =
(Double)environment.lookup("Discount Level");

Double discountPercent =
(Double)environment.lookup("Discount Percent");

if (amount >= discountLevel.doubleValue()) {
discount = discountPercent.doubleValue();

}
else {

discount = 0.00;
}

return amount * (1.00 - discount);

} catch (NamingException ex) {
throw new EJBException("NamingException: "+

ex.getMessage());
}

}
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Comparing Enterprise Beans
A client can determine if two stateful session beans are identical by invoking the
isIdentical method:

bookCart = home.create("Bill Shakespeare");
videoCart = home.create("Lefty Lee");
...
if (bookCart.isIdentical(bookCart)) {
   // true ... }
if (bookCart.isIdentical(videoCart)) {
   // false ... }

Because stateless session beans have the same object identity, the isIdentical

method always returns true when used to compare them.

To determine if two entity beans are identical, the client can invoke the isIden-

tical method, or it can fetch and compare the beans’s primary keys:

String key1 = (String)accta.getPrimaryKey();
String key2 = (String)acctb.getPrimaryKey();

if (key1.compareTo(key2) == 0)
   System.out.println(“equal”);

Passing an Enterprise Bean’s Object
Reference
Suppose that your enterprise bean needs to pass a reference to itself to another
bean. You might want to pass the reference, for example, so that the second bean
can call the first bean’s methods. You can’t pass the this reference because it
points to the bean’s instance, which is running in the EJB container. Only the
container may directly invoke methods on the bean’s instance. Clients access the
instance indirectly by invoking methods on the object whose type is the bean’s
remote interface. It is the reference to this object (the bean’s remote reference)
that the first bean would pass to the second bean.

A session bean obtains its remote reference by calling the getEJBObject method
of the SessionContext interface. An entity bean would call the getEJBObject

method of the EntityContext interface. These interfaces provide beans with
access to the instance contexts maintained by the EJB container. Typically, the
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bean saves the context in the setSessionContext method. The following code
fragment shows how a session bean might use these methods.

public class WagonBean implements SessionBean {

   SessionContext context;
   ...
   public void setSessionContext(SessionContext sc) {
      this.context = sc;
   }
   ...
   public void passItOn(Basket basket) {

...
      basket.copyItems(context.getEJBObject());
   }

Using the Timer Service
Applications that model business work-flows often rely on timed notifications.
The timer service of the EJB container enables you to schedule timed notifica-
tions for all types of enterprise beans except for stateful session beans. You can
schedule a timed notification to occur at a specific time, after a duration of time,
or at timed intervals. For example, you could set timers to go off at 10:30 AM on
May 23, in 30 days, or every 12 hours.

When a timer expires (goes off), the EJB container calls the ejbTimeout method
of the bean’s implementation class. The ejbTimeout method contains the busi-
ness logic that handles the timed event. Because ejbTimeout is defined by the
javax.ejb.TimedObject interface, the bean class must implement TimedOb-

ject.

There are four interfaces in the javax.ejb package that are related to timers:

• TimedObject

• Timer

• TimerHandle

• TimerService
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Creating Timers
To create a timer, the bean invokes one of the createTimer methods of the Tim-

erService interface. (For details on the method signatures, see the TimerSer-

vice API documentation.) When the bean invokes createTimer, the timer
service begins to count down the timer duration.

The bean described in The TimerSessionEJB Example (page 732) creates a
timer as follows:

TimerService timerService = context.getTimerService();
Timer timer = timerService.createTimer(intervalDuration,
    “created timer”);

In the TimerSessionEJB example, createTimer is invoked in a business
method, which is called by a client. An entity bean can also create a timer in a
business method. If you want to create a timer for each instance of an entity
bean, you could code the createTimer call in the bean’s ejbCreate method.

Timers are persistent. If the server is shut down (or even crashes), timers are
saved and will become active again when the server is restarted. If a timer
expires while the server is down, the container will call ejbTimeout when the
server is restarted.

A timer for an entity bean is associated with the bean’s identity—that is, with a
particular instance of the bean. If an entity bean sets a timer in ejbCreate, for
example, each bean instance will have its own timer. In contrast, stateless session
and message-driven beans do not have unique timers for each instance.

The Date and long parameters of the createTimer methods represent time with
the resolution of milliseconds. However, because the timer service is not
intended for real-time applications, a callback to ejbTimeout might not occur
with millisecond precision. The timer service is for business applications, which
typically measure time in hours, days, or longer durations.

Cancelling and Saving Timers
Timers may cancelled by the following events:

• When a single-event timer expires, the EJB container calls ejbTimeout

and then cancels the timer.

• When an entity bean instance is removed, the container cancels the timers
associated with the instance.
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• When the bean invokes the cancel method of the Timer interface, the con-
tainer cancels the timer.

If a method is invoked on a cancelled timer, the container throws the
javax.ejb.NoSuchObjectLocalException.

To save a Timer object for future reference, invoke its getHandle method and
store the TimerHandle object in a database. (A TimerHandle object is serializ-
able.) To re-instantiate the Timer object, retrieve the handle from the database
and invoke getTimer on the handle. A TimerHandle object cannot be passed as
an argument of a method defined in a remote or Web service interface. In other
words, remote clients and Web service clients cannot access a bean’s TimerHan-
dle object. Local clients, however, do not have this restriction.

Getting Timer Information
In addition to defining the cancel and getHandle methods, the Timer interface
also defines methods for obtaining information about timers:

public long getTimeRemaining();
public java.util.Date getNextTimeout();
public java.io.Serializable getInfo();

The getInfo method returns the object that was the last parameter of the cre-

ateTimer invocation. For example, in the createTimer code snippet of the pre-
ceding section, this information parameter is a String object with the value,
created timer.

To retrieve all of a bean’s active timers, call the getTimers method of the Tim-

erService interface. The getTimers method returns a collection of Timer

objects.

Transactions and Timers
An enterprise bean usually creates a timer within a transaction. If this transaction
is rolled back, the timer creation is also rolled back. Similarly, if a bean cancels a
timer within a transaction that gets rolled back, the timer cancellation is rolled
back. In this case, the timer’s duration is reset as if the cancellation had never
occurred.

In beans with container-managed transactions, the ejbTimeout method usually
has the RequiresNew transaction attribute. With this attribute, the EJB container
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begins the new transaction before calling ejbTimeout. If the transaction is rolled
back, the container will try to call ejbTimeout at least one more time.

The TimerSessionEJB Example
The source code for this example is in the <INSTALL>/j2eetutorial14/exam-

ples/ejb/timersession/src/ directory.

TimerSessionEJB is a stateless session bean that shows how to set a timer. The
implementation class for TimerSessionEJB is called TimerSessionBean. In the
source code listing of TimerSessionBean that follows, note the myCreateTimer

and ejbTimeout methods. Because it’s a business method, myCreateTimer is
defined in the bean’s remote interface (TimerSession) and may be invoked by
the client. In this example, the client invokes myCreateTimer with an interval
duration of 30000 milliseconds. The myCreateTimer method fetches a Tim-

erService object from the bean’s SessionContext. Then it creates a new timer
by invoking the createTimer method of TimerService. Now that the timer is
set, the EJB container will invoke the ejbTimer method of TimerSessionBean
when the timer expires—in about 30 seconds. Here’s the source code for the
TimerSessionBean class:

import javax.ejb.*;

public class TimerSessionBean implements SessionBean,
    TimedObject {

    private SessionContext context;

    public TimerHandle myCreateTimer(long intervalDuration) {

        System.out.println
            (“TimerSessionBean: start createTimer “);
        TimerService timerService =
            context.getTimerService();
        Timer timer =
            timerService.createTimer(intervalDuration,
            “created timer”);
}

    public void ejbTimeout(Timer timer) {

        System.out.println(“TimerSessionBean: ejbTimeout “);
    }
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    public void setSessionContext(SessionContext sc) {
        System.out.println(“TimerSessionBean:
            setSessionContext”);
        context = sc;
     }

     public void ejbCreate() {
        System.out.println(“TimerSessionBean: ejbCreate”);
     }

     public TimerSessionBean() {}
     public void ejbRemove() {}
     public void ejbActivate() {}
     public void ejbPassivate() {}

}

Note: To run the TimerSessionEJB example, you must start the PointBase server
before you start the J2EE application server. If you don't start the PointBase server,
or if you start it after the J2EE application server, then you will get a
java.rmi.RemoteException with the message, EJB Timer service not avail-

able.

Building TimerSessionEJB
In a terminal window, go to the <INSTALL>/j2eetutorial14/exam-

ples/ejb/timersession/ directory. To build TimerSessionEJB, type the fol-
lowing command:

asant build

Use deploytool to package and deploy this example.

Creating the Application
In this section, you’ll create a J2EE application named TimerSessionApp, stor-
ing it in the file TimerSessionApp.ear.

1. In deploytool, select File→New→Application EAR.

2. Click Browse.
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3. In the file chooser, navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/timersession/.

4. In the File Name field, enter TimerSessionApp.ear.

5. Click New Application.

6. Click OK.

7. Verify that the TimerSessonApp.ear file resides in
<INSTALL>/j2eetutorial14/examples/ejb/timersession/.

Packaging the Enterprise Bean
Start the Edit Enterprise Bean wizard by selecting File→New→Enterprise Java-
Bean JAR. The wizard displays the following dialog boxes.

1. In the Introduction dialog box:

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2. In the EJB JAR dialog box:

a. Select the button labelled Create New JAR Module in Application.

b. In the combo box below this button, select TimerSessionApp.

c. In the JAR Display Name field, enter TimerSessionJAR.

d. Click Edit.

e. In the tree under Available Files, locate the
<INSTALL>/j2eetutorial14/examples/ejb/timersession/build/

directory.

f. Select these classes: TimerSession.class, TimerSession-

Bean.class, and TimerSessionHome.class.

g. Click Add.

h. Click OK.

i. Click Next.

3. General dialog box

a. In the Enterprise Bean Class combo box, select TimerSessionBean.

b. In the Enterprise Bean Name field, enter TimerSessionEJB.

c. Under Bean Type, select the Stateless Session.

d. In the Remote Interfaces section, select TimerSessionHome for the
Remote Home Interface and TimerSession for the Remote Interface.
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e. Click Next.

4. In the Configure Options dialog box:

a. Select No for Expose Bean as Web Service Endpoint.

b. Click Next.

5. Click Finish.

Compiling the Application Client
The application client files are compiled at the same time as the enterprise bean
files.

Packaging the Application Client
To package an application client component, you run the New Application Client
wizard of the deploytool. During this process the wizard performs the follow-
ing tasks.

• Creates the application client’s deployment descriptor

• Puts the deployment descriptor and client files into a JAR file

• Adds the JAR file to the application’s TimerSessionApp.ear file

To start the New Application Client wizard, select File→New→Application Client
JAR. The wizard displays the following dialog boxes.

1. Introduction dialog box

a. Read the explanatory text for an overview of the wizard’s features.

b. Click Next.

2.  JAR File Contents dialog box

a. Select the button labelled Create New AppClient Module in Applica-
tion.

b. In the combo box below this button, select TimerSessionApp.

c. In the AppClient Display Name field, enter TimerSessionClient.

d. Click Edit.

e. In the tree under Available Files, locate the
<INSTALL>/j2eetutorial14/examples/ejb/timersession/build

directory.

f. Select the TimerSessionClient.class file
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g. Click Add.

h. Click OK.

i. Click Next.

3. General dialog box

a. In the Main Class combo box, select TimerSessionClient.

b. Click Next.

c. Click Finish.

Specifying the Application Client’s Enterprise
Bean Reference
When it invokes the lookup method, the TimerSessionClient refers to the
home of an enterprise bean:

Object objref =
initial.lookup("java:comp/env/ejb/SimpleTimerSession");

You specify this reference as follows.

1. In the tree, select TimerSessionClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field, enter ejb/SimpleTimerSession.

5. In the EJB Type field, select Session.

6. In the Interfaces field, select Remote.

7. In the Home Interface field, enter TimerSessionHome.

8. In the Local/Remote Interface field, enter TimerSession.

9. In the JNDI field, enter TimerSessionEJB.

10.Click OK.

Deploying the Enterprise Application
Now that the J2EE application contains the components, it is ready for deploy-
ment.

1. Select TimerSessionApp.
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2. Select Tools→Deploy.

3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Under Application Client Stub Directory check Return Client Jar.

5. In the field below the checkbox enter
<INSTALL>/j2eetutorial14/examples/ejb/timersession/.

6. Click OK.

7. In the Distribute Module dialog box click Close when the deployment
completes.

8. Verify the deployment.

a. In the tree, expand the Servers node and select the host that is running
the J2EE server.

b. In the Deployed Objects table, make sure that TimerSessionApp is
listed and its status is Running.

c. Verify that TimerSessionAppClient.jar is in
<INSTALL>/j2eetutorial14/examples/ejb/timersession/.

Running the J2EE Application Client
To run the J2EE application client, perform the following steps.

1. In a terminal window, go to the <INSTALL>/j2eetutorial14/

examples/ejb/timersession/ directory.

2. Type the following command:

appclient -client TimerSessionAppClient.jar

3. In the terminal window, the client displays these lines:

Creating a timer with an interval duration of 30000 ms.

The output from the timer is sent to the server.log located in the
<J2EE_HOME>/domains/domain1/server/logs/ directory. After about 30 sec-
onds, open up server.log in a text editor and you will see the following lines:

TimerSessionBean: setSessionContext
TimerSessionBean: ejbCreate
TimerSessionBean: start createTimer
TimerSessionBean: ejbTimeout
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Note: To run the TimerSessionEJB example, you must start the PointBase server
before you start the J2EE application server. If you don't start the PointBase server,
or if you start it after the J2EE application server, then you will get a
java.rmi.RemoteException with the message, EJB Timer service not avail-

able.

Handling Exceptions
The exceptions thrown by enterprise beans fall into two categories: system and
application.

A system exception indicates a problem with the services that support an applica-
tion. Examples of these problems include the following: a database connection
cannot be obtained, a SQL insert fails because the database is full, or a lookup

method cannot find the desired object. If your enterprise bean encounters a sys-
tem-level problem, it should throw a javax.ejb.EJBException. The container
will wrap the EJBException in a RemoteException, which it passes back to the
client. Because the EJBException is a subclass of the RuntimeException, you
do not have to specify it in the throws clause of the method declaration. If a sys-
tem exception is thrown, the EJB container might destroy the bean instance.
Therefore, a system exception cannot be handled by the bean’s client program; it
requires intervention by a system administrator.

An application exception signals an error in the business logic of an enterprise
bean. There are two types of application exceptions: customized and predefined.
A customized exception is one that you’ve coded yourself, such as the Insuffi-

centBalanceException thrown by the debit business method of the Sav-

ingsAccountEJB example. The javax.ejb package includes several predefined
exceptions that are designed to handle common problems. For example, an ejb-

Create method should throw a CreateException to indicate an invalid input
parameter. When an enterprise bean throws an application exception, the con-
tainer does not wrap it in another exception. The client should be able to handle
any application exception it receives.

If a system exception occurs within a transaction, the EJB container rolls back
the transaction. However, if an application exception is thrown within a transac-
tion, the container does not roll back the transaction.
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Table 20–1 summarizes the exceptions of the javax.ejb package. All of these
exceptions are application exceptions, except for the NoSuchEntityException

and the EJBException, which are system exceptions.

Table 20–1 Exceptions

Method Name Exception It Throws Reason for Throwing

ejbCreate CreateException
An input parameter is
invalid.

ejbFindByPrimaryKey
(and other finder methods
that return a single object)

ObjectNotFoundException
(subclass of FinderException)

The database row for the
requested entity bean
cannot be found.

ejbRemove RemoveException
The entity bean’s row
cannot be deleted from
the database.

ejbLoad NoSuchEntityException
The database row to be
loaded into the entity
bean cannot be found.

ejbStore NoSuchEntityException
The database row to be
updated cannot be found.

(all methods) EJBException
A system problem has
been encountered.
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741
Bean-Managed
Persistence Examples

DATA is at the heart of most business applications. In J2EE applications, entity
beans represent the business objects that are stored in a database. For entity
beans with bean-managed persistence, you must write the code for the database
access calls. Although writing this code is an additional responsibility, you will
have more control over how the entity bean accesses a database.

This chapter discusses the coding techniques for entity beans with bean-man-
aged persistence. For conceptual information on entity beans, please see What Is
an Entity Bean? (page 669).

The SavingsAccountEJB Example
The entity bean illustrated in this section represents a simple bank account. The
state of SavingsAccountEJB is stored in the savingsaccount table of a rela-
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tional database. The savingsaccount table is created by the following SQL
statement:

CREATE TABLE savingsaccount
(id VARCHAR(3)
CONSTRAINT pk_savingsaccount PRIMARY KEY,
firstname VARCHAR(24),
lastname  VARCHAR(24),
balance   NUMERIC(10,2));

The SavingsAccountEJB example requires the following code:

• Entity bean class (SavingsAccountBean)

• Home interface (SavingsAccountHome)

• Remote interface (SavingsAccount)

This example also makes use of the following classes:

• A utility class named InsufficientBalanceException

• A client class called SavingsAccountClient

The source code for this example is in this directory:

<INSTALL>/j2eetutorial14/ejb/savingsaccount/src/

Entity Bean Class
The sample entity bean class is called SavingsAccountBean. As you look
through its code, note that it meets the requirements of any entity bean with
bean-managed persistence. First of all, it implements the following:

• EntityBean interface

• Zero or more ejbCreate and ejbPostCreate methods

• Finder methods

• Business methods

• Home methods

In addition, an entity bean class with bean-managed persistence has these
requirements:

• The class is defined as public.

• The class cannot be defined as abstract or final.

• It contains an empty constructor.
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• It does not implement the finalize method.

The EntityBean Interface
The EntityBean interface extends the EnterpriseBean interface, which extends
the Serializable interface. The EntityBean interface declares a number of
methods, such as ejbActivate and ejbLoad, which you must implement in your
entity bean class. These methods are discussed in later sections.

The ejbCreate Method
When the client invokes a create method, the EJB container invokes the corre-
sponding ejbCreate method. Typically, an ejbCreate method in an entity bean
performs the following tasks:

• Inserts the entity state into the database

• Initializes the instance variables

• Returns the primary key

The ejbCreate method of SavingsAccountBean inserts the entity state into the
database by invoking the private insertRow method, which issues the SQL
INSERT statement. Here is the source code for the ejbCreate method:

public String ejbCreate(String id, String firstName,
   String lastName, BigDecimal balance)
   throws CreateException {

   if (balance.signum() == -1)  {
      throw new CreateException
         ("A negative initial balance is not allowed.");
   }

   try {
      insertRow(id, firstName, lastName, balance);
   } catch (Exception ex) {
       throw new EJBException("ejbCreate: " +
          ex.getMessage());
   }

   this.id = id;
   this.firstName = firstName;
   this.lastName = lastName;

http://java.sun.com/j2ee/tutorial/api/javax/ejb/EntityBean.html
http://java.sun.com/j2ee/tutorial/api/javax/ejb/EnterpriseBean.html
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   this.balance = balance;

   return id;
}

Although the SavingsAccountBean class has just one ejbCreate method, an
enterprise bean may contain multiple ejbCreate methods. For an example, see
the CartEJB.java source code in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/cart/src/

When writing an ejbCreate method for an entity bean, be sure to follow these
rules:

• The access control modifier must be public.

• The return type must be the primary key.

• The arguments must be legal types for the Java RMI API.

• The method modifier cannot be final or static.

The throws clause may include the javax.ejb.CreateException and excep-
tions that are specific to your application. An ejbCreate method usually throws
a CreateException if an input parameter is invalid. If an ejbCreate method
cannot create an entity because another entity with the same primary key already
exists, it should throw a javax.ejb.DuplicateKeyException (a subclass of
CreateException). If a client receives a CreateException or a Dupli-

cateKeyException, it should assume that the entity was not created.

The state of an entity bean may be directly inserted into the database by an appli-
cation that is unknown to the J2EE server. For example, a SQL script might
insert a row into the savingsaccount table. Although the entity bean for this
row was not created by an ejbCreate method, the bean can be located by a cli-
ent program.

The ejbPostCreate Method
For each ejbCreate method, you must write an ejbPostCreate method in the
entity bean class. The EJB container invokes ejbPostCreate immediately after
it calls ejbCreate. Unlike the ejbCreate method, the ejbPostCreate method
can invoke the getPrimaryKey and getEJBObject methods of the EntityCon-

text interface. For more information on the getEJBObject method, see the sec-
tion Passing an Enterprise Bean’s Object Reference (page 728). Often, your
ejbPostCreate methods will be empty.
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The signature of an ejbPostCreate method must meet the following require-
ments:

• The number and types of arguments must match a corresponding ejbCre-

ate method.

• The access control modifier must be public.

• The method modifier cannot be final or static.

• The return type must be void.

The throws clause may include the javax.ejb.CreateException and excep-
tions that are specific to your application.

The ejbRemove Method
A client deletes an entity bean by invoking the remove method. This invocation
causes the EJB container to call the ejbRemove method, which deletes the entity
state from the database. In the SavingsAccountBean class, the ejbRemove

method invokes a private method named deleteRow, which issues a SQL DELETE

statement. The ejbRemove method is short:

public void ejbRemove() {
    try {
        deleteRow(id);
    catch (Exception ex) {
        throw new EJBException("ejbRemove: " +
        ex.getMessage());
        }
    }
}

If the ejbRemove method encounters a system problem, it should throw the
javax.ejb.EJBException. If it encounters an application error, it should throw
a javax.ejb.RemoveException. For a comparison of system and application
exceptions, see the section deploytool Tips for Entity Beans with Bean-Managed
Persistence (page 776).

An entity bean may also be removed directly by a database deletion. For exam-
ple, if a SQL script deletes a row that contains an entity bean state, then that
entity bean is removed.
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The ejbLoad and ejbStore Methods
If the EJB container needs to synchronize the instance variables of an entity bean
with the corresponding values stored in a database, it invokes the ejbLoad and
ejbStore methods. The ejbLoad method refreshes the instance variables from
the database, and the ejbStore method writes the variables to the database. The
client may not call ejbLoad and ejbStore.

If a business method is associated with a transaction, the container invokes ejb-
Load before the business method executes. Immediately after the business
method executes, the container calls ejbStore. Because the container invokes
ejbLoad and ejbStore, you do not have to refresh and store the instance vari-
ables in your business methods. The SavingsAccountBean class relies on the
container to synchronize the instance variables with the database. Therefore, the
business methods of SavingsAccountBean should be associated with transac-
tions.

If the ejbLoad and ejbStore methods cannot locate an entity in the underlying
database, they should throw the javax.ejb.NoSuchEntityException. This
exception is a subclass of EJBException. Because EJBException is a subclass
of RuntimeException, you do not have to include it in the throws clause. When
NoSuchEntityException is thrown, the EJB container wraps it in a RemoteEx-

ception before returning it to the client.

In the SavingsAccountBean class, ejbLoad invokes the loadRow method, which
issues a SQL SELECT statement and assigns the retrieved data to the instance
variables. The ejbStore method calls the storeRow method, which stores the
instance variables in the database with a SQL UPDATE statement. Here is the code
for the ejbLoad and ejbStore methods:

public void ejbLoad() {

try {
loadRow();

} catch (Exception ex) {
throw new EJBException("ejbLoad: " +

ex.getMessage());
}

}

public void ejbStore() {

try {
storeRow();

} catch (Exception ex) {
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throw new EJBException("ejbStore: " +
ex.getMessage());

}
}

The Finder Methods
The finder methods allow clients to locate entity beans. The SavingsAccount-

Client program locates entity beans with three finder methods:

SavingsAccount jones = home.findByPrimaryKey("836");
...
Collection c = home.findByLastName("Smith");
...
Collection c = home.findInRange(20.00, 99.00);

For every finder method available to a client, the entity bean class must imple-
ment a corresponding method that begins with the prefix ejbFind. The Sav-

ingsAccountBean class, for example, implements the ejbFindByLastName

method as follows:

public Collection ejbFindByLastName(String lastName)
throws FinderException {

Collection result;

try {
result = selectByLastName(lastName);

} catch (Exception ex) {
throw new EJBException("ejbFindByLastName " +

ex.getMessage());
}
return result;

}

The finder methods that are specific to your application, such as ejbFindBy-

LastName and ejbFindInRange, are optional—but the ejbFindByPrimaryKey

method is required. As its name implies, the ejbFindByPrimaryKey method
accepts as an argument the primary key, which it uses to locate an entity bean. In
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the SavingsAccountBean class, the primary key is the id variable. Here is the
code for the ejbFindByPrimaryKey method:

public String ejbFindByPrimaryKey(String primaryKey)
throws FinderException {

boolean result;

try {
result = selectByPrimaryKey(primaryKey);

} catch (Exception ex) {
throw new EJBException("ejbFindByPrimaryKey: " +

ex.getMessage());
}

if (result) {
return primaryKey;

}
else {

throw new ObjectNotFoundException
("Row for id " + primaryKey + " not found.");

}
}

The ejbFindByPrimaryKey method may look strange to you, because it uses a
primary key for both the method argument and return value. However, remember
that the client does not call ejbFindByPrimaryKey directly. It is the EJB con-
tainer that calls the ejbFindByPrimaryKey method. The client invokes the
findByPrimaryKey method, which is defined in the home interface.

The following list summarizes the rules for the finder methods that you imple-
ment in an entity bean class with bean-managed persistence:

• The ejbFindByPrimaryKey method must be implemented.

• A finder method name must start with the prefix ejbFind.

• The access control modifier must be public.

• The method modifier cannot be final or static.

• The arguments and return type must be legal types for the Java RMI API.
(This requirement applies only to methods defined in a remote—not
local—home interface.)

• The return type must be the primary key or a collection of primary keys.

The throws clause may include the javax.ejb.FinderException and excep-
tions that are specific to your application. If a finder method returns a single pri-
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mary key and the requested entity does not exist, the method should throw the
javax.ejb.ObjectNotFoundException (a subclass of FinderException). If a
finder method returns a collection of primary keys and it does not find any
objects, it should return an empty collection.

The Business Methods
The business methods contain the business logic that you want to encapsulate
within the entity bean. Usually, the business methods do not access the database,
allowing you to separate the business logic from the database access code. The
SavingsAccountBean class contains the following business methods:

public void debit(BigDecimal amount)
   throws InsufficientBalanceException {

   if (balance.compareTo(amount) == -1) {
       throw new InsufficientBalanceException();
   }
   balance = balance.subtract(amount);
}

public void credit(BigDecimal amount) {

   balance = balance.add(amount);
}

public String getFirstName() {

   return firstName;
}

public String getLastName() {

   return lastName;
}

public BigDecimal getBalance() {

   return balance;
}
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The SavingsAccountClient program invokes the business methods as follows:

BigDecimal zeroAmount = new BigDecimal("0.00");
SavingsAccount duke = home.create("123", "Duke", "Earl",
    zeroAmount);
...
duke.credit(new BigDecimal("88.50"));
duke.debit(new BigDecimal("20.25"));
BigDecimal balance = duke.getBalance();

The requirements for the signature of a business method are the same for both
session and entity beans:

• The method name must not conflict with a method name defined by the
EJB architecture. For example, you cannot call a business method ejbCre-

ate or ejbActivate.

• The access control modifier must be public.

• The method modifier cannot be final or static.

• The arguments and return types must be legal types for the Java RMI API.
This requirement applies only to methods defined in a remote—not local—
home interface.

The throws clause may include the exceptions that you define for your applica-
tion. The debit method, for example, throws the InsufficientBalanceExcep-

tion. To indicate a system-level problem, a business method should throw the
javax.ejb.EJBException.

The Home Methods
A home method contains the business logic that applies to all entity beans of a
particular class. In contrast, the logic in a business method applies to a single
entity bean, an instance with a unique identity. During a home method invoca-
tion, the instance has neither a unique identity nor a state that represents a busi-
ness object. Consequently, a home method must not access the bean’s
persistence state (instance variables). (For container-managed persistence, a
home method also must not access relationships.)

Typically, a home method locates a collection of bean instances and invokes
business methods as it iterates through the collection. This approach is taken by
the ejbHomeChargeForLowBalance method of the SavingsAccountBean class.
The ejbHomeChargeForLowBalance method applies a service charge to all sav-
ings accounts with balances less than a specified amount. The method locates
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these accounts by invoking the findInRange method. As it iterates through the
collection of SavingsAccount instances, the ejbHomeChargeForLowBalance

method checks the balance and invokes the debit business method. Here is the
source code of the ejbHomeChargeForLowBalance method:

public void ejbHomeChargeForLowBalance(
    BigDecimal minimumBalance, BigDecimal charge)
    throws InsufficientBalanceException {

   try {
       SavingsAccountHome home =
       (SavingsAccountHome)context.getEJBHome();
       Collection c = home.findInRange(new BigDecimal("0.00"),
           minimumBalance.subtract(new BigDecimal("0.01")));

       Iterator i = c.iterator();

       while (i.hasNext()) {
          SavingsAccount account = (SavingsAccount)i.next();
          if (account.getBalance().compareTo(charge) == 1) {
             account.debit(charge);
          }
       }

   } catch (Exception ex) {
       throw new EJBException("ejbHomeChargeForLowBalance: "
           + ex.getMessage());
   }
}

The home interface defines a corresponding method named chargeForLowBal-

ance (see Home Method Definitions, page 754). Since the interface provides the
client view, the SavingsAccountClient program invokes the home method as
follows:

SavingsAccountHome home;
...
home.chargeForLowBalance(new BigDecimal("10.00"),

new BigDecimal("1.00"));

In the entity bean class, the implementation of a home method must adhere to
these rules:

• A home method name must start with the prefix ejbHome.

• The access control modifier must be public.
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• The method modifier cannot be static.

The throws clause may include exceptions that are specific to your application;
it must not throw the java.rmi.RemoteException.

Database Calls
Table 21–1 summarizes the database access calls in the SavingsAccountBean

class. The business methods of the SavingsAccountBean class are absent from
the preceding table because they do not access the database. Instead, these busi-
ness methods update the instance variables, which are written to the database
when the EJB container calls ejbStore. Another developer might have chosen
to access the database in the business methods of the SavingsAccountBean

class. This choice is one of those design decisions that depend on the specific
needs of your application.

Before accessing a database, you must connect to it. For more information, see
Chapter 26.

Table 21–1 SQL Statements in SavingsAccountBean

Method SQL Statement

ejbCreate INSERT

ejbFindByPrimaryKey SELECT

ejbFindByLastName SELECT

ejbFindInRange SELECT

ejbLoad SELECT

ejbRemove DELETE

ejbStore UPDATE
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Home Interface
The home interface defines the create, finder, and home methods. The Sav-

ingsAccountHome interface follows:

import java.util.Collection;
import java.math.BigDecimal;
import java.rmi.RemoteException;
import javax.ejb.*;

public interface SavingsAccountHome extends EJBHome {

    public SavingsAccount create(String id, String firstName,
        String lastName, BigDecimal balance)
        throws RemoteException, CreateException;

    public SavingsAccount findByPrimaryKey(String id)
        throws FinderException, RemoteException;

    public Collection findByLastName(String lastName)
        throws FinderException, RemoteException;

    public Collection findInRange(BigDecimal low,
        BigDecimal high)
        throws FinderException, RemoteException;

public void chargeForLowBalance(BigDecimal minimumBalance,
       BigDecimal charge)
       throws InsufficientBalanceException, RemoteException;
}

create Method Definitions
Each create method in the home interface must conform to the following
requirements:

• It has the same number and types of arguments as its matching ejbCreate

method in the enterprise bean class.

• It returns the remote interface type of the enterprise bean.

• The throws clause includes the exceptions specified by the throws clause
of the corresponding ejbCreate and ejbPostCreate methods.

• The throws clause includes the javax.ejb.CreateException.

• If the method is defined in a remote—not local—home interface, then the
throws clause includes the java.rmi.RemoteException.
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Finder Method Definitions
Every finder method in the home interface corresponds to a finder method in the
entity bean class. The name of a finder method in the home interface begins with
find, whereas the corresponding name in the entity bean class begins with
ejbFind. For example, the SavingsAccountHome class defines the
findByLastName method, and the SavingsAccountBean class implements the
ejbFindByLastName method. The rules for defining the signatures of the finder
methods of a home interface follow.

• The number and types of arguments must match those of the correspond-
ing method in the entity bean class.

• The return type is the entity bean’s remote interface type, or a collection of
those types.

• The exceptions in the throws clause include those of the corresponding
method in the entity bean class.

• The throws clause contains the javax.ejb.FinderException.

• If the method is defined in a remote—not local—home interface, then the
throws clause includes the java.rmi.RemoteException.

Home Method Definitions
Each home method definition in the home interface corresponds to a method in
the entity bean class. In the home interface, the method name is arbitrary, pro-
vided that it does not begin with create or find. In the bean class, the matching
method name begins with ejbHome. For example, in the SavingsAccountBean

class the name is ejbHomeChargeForLowBalance, but in the SavingsAccountH-

ome interface the name is chargeForLowBalance.

The home method signature must follow the same rules specified for finder
methods in the previous section (except that a home method does not throw a
FinderException).
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Remote Interface
The remote interface extends javax.ejb.EJBObject and defines the business
methods that a remote client may invoke. Here is the SavingsAccount remote
interface:

import javax.ejb.EJBObject;
import java.rmi.RemoteException;
import java.math.BigDecimal;

public interface SavingsAccount extends EJBObject {

    public void debit(BigDecimal amount)
        throws InsufficientBalanceException, RemoteException;

    public void credit(BigDecimal amount)
        throws RemoteException;

    public String getFirstName()
        throws RemoteException;

    public String getLastName()
        throws RemoteException;

    public BigDecimal getBalance()
        throws RemoteException;
}

The requirements for the method definitions in a remote interface are the same
for both session and entity beans:

• Each method in the remote interface must match a method in the enterprise
bean class.

• The signatures of the methods in the remote interface must be identical to
the signatures of the corresponding methods in the enterprise bean class.

• The arguments and return values must be valid RMI types.

• The throws clause must include java.rmi.RemoteException.

A local interface has the same requirements, with the following exceptions:

• The arguments and return values are not required to be valid RMI types.

• The throws clause does not include java.rmi.RemoteException.
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Running the SavingsAccountEJB
Example
Before you run this example, you must define the datasource, create the data-
base, and deploy the SavingsAccountApp.ear file.

Defining the Data Source
Follow the instructions in Defining a Data Source in the J2EE Application
Server (page 901). This data source is a factory for database connections. For
more information, see DataSource Objects and Connection Pools (page 899).

Creating the Database Table
The instructions that follow explain how to use the SavingsAccountEJB exam-
ple with PointBase, the database software that is included in the J2EE Applica-
tion Server bundle.

1. Start the PointBase server. For instructions, see Starting the PointBase
Database Server (page 110).

2. Create the savingsaccount database table by running the create.sql

script.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/savingsaccount/

b. Type the following command, which runs the create.sql script:

asant create-db_common

Deploying the Application
1. In deploytool, open the SavingsAccountApp.ear file, which resides in

this directory:

<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

2. Deploy the SavingsAccountApp application.

3. In the Deploy Module dialog box, do the following:

a. Select the Return Client JAR checkbox.

b. In the field below the check box, enter the following:
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<INSTALL>/j2eetutorial14/examples/ejb/savingsaccount

For detailed instructions, see Deploying the J2EE Application (page 705).

Running the Client
To run the SavingsAccountClient program, do the following:

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/savingsaccount/

2. Type the following command on a single line:

appclient -client SavingsAccountAppClient.jar

3. The client should display the following lines:

balance = 68.25

balance = 32.55

456: 44.77

730: 19.54

268: 100.07

836: 32.55

456: 44.77

4

7

To modify this example, see the instructions in Modifying the J2EE
Application (page 707).

Mapping Table Relationships for Bean-
Managed Persistence

In a relational database, tables can be related by common columns. The relation-
ships between the tables affect the design of their corresponding entity beans.
The entity beans discussed in this section are backed up by tables with the fol-
lowing types of relationships:

• One-to-one

• One-to-many

• Many-to-many



758 BEAN-MANAGED PERSISTENCE EXAMPLES
One-to-One Relationships
In a one-to-one relationship, each row in a table is related to a single row in
another table. For example, in a warehouse application, a storagebin table
might have a one-to-one relationship with a widget table. This application
would model a physical warehouse in which each storage bin contains one type
of widget and each widget resides in one storage bin.

Figure 21–1 illustrates the storagebin and widget tables. Because the stor-

agebinid uniquely identifies a row in the storagebin table, it is that table’s pri-
mary key. The widgetid is the primary key of the widget table. The two tables
are related because the widgetid is also a column in the storagebin table. By
referring to the primary key of the widget table, the widgetid in the storage-

bin table identifies which widget resides in a particular storage bin in the ware-
house. Because the widgetid of the storagebin table refers to the primary key
of another table, it is called a foreign key. (The figures in this chapter denote a
primary key with PK and a foreign key with FK.)

Figure 21–1 One-to-One Table Relationship

A dependent (child) table includes a foreign key that matches the primary key of
the referenced (parent) table. The values of the foreign keys in the storagebin

(child) table depend on the primary keys in the widget (parent) table. For exam-
ple, if the storagebin table has a row with a widgetid of 344, then the widget
table should also have a row whose widgetid is 344.

When designing a database application, you may choose to enforce the depen-
dency between the parent and child tables. There are two ways to enforce such a
dependency: by defining a referential constraint in the database or by performing
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checks in the application code. The storagebin table has a referential constraint
named fk_widgetid:

CREATE TABLE storagebin
   (storagebinid VARCHAR(3)
    CONSTRAINT pk_storagebin PRIMARY KEY,
    widgetid VARCHAR(3),
    quantity INTEGER,
    CONSTRAINT fk_widgetid
    FOREIGN KEY (widgetid)
     REFERENCES widget(widgetid));

The source code for the following example is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/storagebin/src/

The StorageBinBean and WidgetBean classes illustrate the one-to-one relation-
ship of the storagebin and widget tables. The StorageBinBean class contains
variables for each column in the storagebin table, including the foreign key,
widgetId:

private String storageBinId;
private String widgetId;
private int quantity;

The ejbFindByWidgetId method of the StorageBinBean class returns the
storageBinId that matches a given widgetId:

public String ejbFindByWidgetId(String widgetId)
   throws FinderException {

   String storageBinId;

   try {
      storageBinId = selectByWidgetId(widgetId);
    } catch (Exception ex) {
        throw new EJBException("ejbFindByWidgetId: " +
           ex.getMessage());
    }

   if (storageBinId == null) {
      throw new ObjectNotFoundException
         ("Row for widgetId " + widgetId + " not found.");
   }
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   else {
      return storageBinId;
   }
}

The ejbFindByWidgetId method locates the widgetId by querying the database
in the selectByWidgetId method:

private String selectByWidgetId(String widgetId)
   throws SQLException {

   String storageBinId;

   makeConnection();
   String selectStatement =
         "select storagebinid " +
         "from storagebin where widgetid = ? ";
   PreparedStatement prepStmt =
         con.prepareStatement(selectStatement);
   prepStmt.setString(1, widgetId);

   ResultSet rs = prepStmt.executeQuery();

   if (rs.next()) {
      storageBinId = rs.getString(1);
   }
   else {
      storageBinId = null;
   }

   prepStmt.close();
   releaseConnection();
   return storageBinId;
}

To find out in which storage bin a widget resides, the StorageBinClient pro-
gram calls the findByWidgetId method:

String widgetId = "777";
StorageBin storageBin =
   storageBinHome.findByWidgetId(widgetId);
String storageBinId = (String)storageBin.getPrimaryKey();
int quantity = storageBin.getQuantity();
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Running the StorageBinEJB Example
1. Create the storagebin database table.

a. In a terminal window, go to this directory:
<INSTALL>/j2eetutorial14/examples/ejb/storagebin/

b. Type this command:

asant create-db_common

2. In deploytool, deploy the StorageBinApp.ear file, which is in this direc-
tory:
<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

3. Run the client.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/storagebin/

b. Type the following command on a single line:

appclient -client StorageBinAppClient.jar

c. The client should display the following:

. . .

777 388 500 1.0 Duct Tape

. . .

One-to-Many Relationships
If the primary key in a parent table matches multiple foreign keys in a child
table, then the relationship is one-to-many. This relationship is common in data-
base applications. For example, an application for a sports league might access a
team table and a player table. Each team has multiple players, and each player
belongs to a single team. Every row in the child table (player) has a foreign key
identifying the player’s team. This foreign key matches the team table’s primary
key.

The sections that follow describe how you might implement one-to-many rela-
tionships in entity beans. When designing such entity beans, you must decide
whether both tables are represented by entity beans, or just one.



762 BEAN-MANAGED PERSISTENCE EXAMPLES
A Helper Class for the Child Table
Not every database table needs to be mapped to an entity bean. If a database
table doesn’t represent a business entity, or if it stores information that is con-
tained in another entity, then the table should be represented with a helper class.
In an online shopping application, for example, each order submitted by a cus-
tomer can have multiple line items. The application stores the information in the
database tables shown by Figure 21–2.

Figure 21–2 One-to-Many Relationship: Order and Line Items

Not only does a line item belong to an order, it also does not exist without the
order. Therefore, the lineitems table should be represented with a helper class
and not with an entity bean. Using a helper class in this case is not required, but
doing so might improve performance because a helper class uses fewer system
resources than an entity bean.

The source code for the following example is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/order/src/

The LineItem and OrderBean classes show how to implement a one-to-many
relationship with a helper class (LineItem). The instance variables in the
LineItem class correspond to the columns in the lineitems table. The itemNo

variable matches the primary key for the lineitems table, and the orderId vari-
able represents the table’s foreign key. Here is the source code for the LineItem

class:

public class LineItem implements java.io.Serializable {

   String productId;
   int quantity;
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   double unitPrice;
   int itemNo;
   String orderId;

   public LineItem(String productId, int quantity,
     double unitPrice, int itemNo, String orderId) {

      this.productId = productId;
      this.quantity = quantity;
      this.unitPrice = unitPrice;
      this.itemNo = itemNo;
      this.orderId = orderId;
   }

   public String getProductId() {
      return productId;
   }

   public int getQuantity() {
      return quantity;
   }

   public double getUnitPrice() {
      return unitPrice;
   }

   public int getItemNo() {
      return itemNo;
   }

   public String getOrderId() {
      return orderId;
   }
}

The OrderBean class contains an ArrayList variable named lineItems. Each
element in the lineItems variable is a LineItem object. The lineItems vari-
able is passed to the OrderBean class in the ejbCreate method. For every
LineItem object in the lineItems variable, the ejbCreate method inserts a row
into the lineitems table. It also inserts a single row into the orders table. The
code for the ejbCreate method follows:

public String ejbCreate(String orderId, String customerId,
    String status, double totalPrice, ArrayList lineItems)
    throws CreateException {
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    try {
       insertOrder(orderId, customerId, status, totalPrice);
       for (int i = 0; i < lineItems.size(); i++) {
          LineItem item = (LineItem)lineItems.get(i);
          insertItem(item);
       }
    } catch (Exception ex) {
        throw new EJBException("ejbCreate: " +
           ex.getMessage());
    }

    this.orderId = orderId;
    this.customerId = customerId;
    this.status = status;
    this.totalPrice = totalPrice;
    this.lineItems = lineItems ;

    return orderId;
}

The OrderClient program creates and loads an ArrayList of LineItem objects.
The program passes this ArrayList to the entity bean when it invokes the cre-

ate method:

ArrayList lineItems = new ArrayList();
lineItems.add(new LineItem("p23", 13, 12.00, 1, "123"));
lineItems.add(new LineItem("p67", 47, 89.00, 2, "123"));
lineItems.add(new LineItem("p11", 28, 41.00, 3, "123"));
...
Order duke = home.create("123", "c44", "open",
   totalItems(lineItems), lineItems);

Other methods in the OrderBean class also access both database tables. The
ejbRemove method, for example, not only deletes a row from the orders table,
but also deletes all corresponding rows in the lineitems table. The ejbLoad and
ejbStore methods synchronize the state of an OrderEJB instance, including the
lineItems ArrayList, with the orders and lineitems tables.

The ejbFindByProductId method enables clients to locate all orders that have a
particular product. This method queries the lineitems table for all rows with a
specific productId. The method returns a Collection of Order objects. The
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OrderClient program iterates through the Collection and prints the primary
key of each order:

Collection c = home.findByProductId("p67");
Iterator i=c.iterator();
while (i.hasNext()) {
   Order order = (Order)i.next();
   String id = (String)order.getPrimaryKey();
   System.out.println(id);
}

Running the OrderEJB Example
1. Create the order database table.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/order/

b. Type this command:

asant create-db_common

2. In deploytool, deploy the OrderApp.ear file, which is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

3. Run the client.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/order/

b. Type the following command on a single line:

appclient -client OrderAppClient.jar

c. The client should display the following lines:

. . .

123 1 p23 12.0

123 2 p67 89.0

123 3 p11 41.0

. . .
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An Entity Bean for the Child Table
You should consider building an entity bean for a child table under the following
conditions:

• The information in the child table is not dependent on the parent table.

• The business entity of the child table could exist without that of the parent
table.

• The child table might be accessed by another application that does not
access the parent table.

These conditions exist in the following scenario. Suppose that each sales repre-
sentative in a company has multiple customers and that each customer has only
one sales representative. The company tracks its sales force with a database
application. In the database, each row in the salesrep table (parent) matches
multiple rows in the customer table (child). Figure 21–3 illustrates this relation-
ship.

Figure 21–3 One-to-Many Relationship: Sales Representative and Customers

The SalesRepBean and CustomerBean entity bean classes implement the one-to-
many relationship of the sales and customer tables.

The source code for this example is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/salesrep/src/

The SalesRepBean class contains a variable named customerIds, which is an
ArrayList of String elements. These String elements identify which custom-
ers belong to the sales representative. Because the customerIds variable reflects
this relationship, the SalesRepBean class must keep the variable up to date.
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The SalesRepBean class instantiates the customerIds variable in the setEnti-

tyContext method, not in ejbCreate. The container invokes setEntityCon-

text just once—when it creates the bean instance—ensuring that customerIds
is instantiated just once. Because the same bean instance can assume different
identities during its life cycle, instantiating customerIds in ejbCreate might
cause multiple and unnecessary instantiations. Therefore, the SalesRepBean

class instantiates the customerIds variable in setEntityContext:

public void setEntityContext(EntityContext context) {

this.context = context;
customerIds = new ArrayList();

try {
Context initial = new InitialContext();
Object objref =

initial.lookup("java:comp/env/ejb/Customer");

customerHome =
(CustomerHome)PortableRemoteObject.narrow(objref,

CustomerHome.class);
} catch (Exception ex) {

throw new EJBException("setEntityContext: " +
ex.getMessage());

}
}

Invoked by the ejbLoad method, loadCustomerIds is a private method that
refreshes the customerIds variable. There are two approaches when coding a
method such as loadCustomerIds: fetch the identifiers from the customer data-
base table or get them from the CustomerEJB entity bean. Fetching the identifi-
ers from the database might be faster, but exposes the code in the SalesRepBean

class to the CustomerEJB bean’s underlying database table. In the future, if you
were to change the CustomerEJB bean’s table (or move the bean to a different
J2EE server), you might need to change the SalesRepBean code. But if the
SalesRepBean class gets the identifiers from the CustomerEJB entity bean, no
coding changes would be required. The two approaches present a trade-off: per-
formance versus flexibility. The SalesRepEJB example opts for flexibility, load-
ing the customerIds variable by calling the findBySalesRep and
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getPrimaryKey methods of CustomerEJB. Here is the code for the loadCusto-

merIds method:

private void loadCustomerIds() {

   customerIds.clear();

   try {
      Collection c = customerHome.findBySalesRep(salesRepId);
      Iterator i=c.iterator();

      while (i.hasNext()) {
         Customer customer = (Customer)i.next();
         String id = (String)customer.getPrimaryKey();
         customerIds.add(id);
      }

} catch (Exception ex) {
throw new EJBException("Exception in loadCustomerIds: " +

          ex.getMessage());
}

}

If a customer’s sales representative changes, the client program updates the data-
base by calling the setSalesRepId method of the CustomerBean class. The next
time a business method of the SalesRepBean class is called, the ejbLoad method
invokes loadCustomerIds, which refreshes the customerIds variable. (To
ensure that ejbLoad is invoked before each business method, set the transaction
attributes of the business methods to Required.) For example, the SalesRepCli-

ent program changes the salesRepId for a customer named Mary Jackson as
follows:

Customer mary = customerHome.findByPrimaryKey("987");
mary.setSalesRepId("543");

The salesRepId value 543 identifies a sales representative named Janice Martin.
To list all of Janice’s customers, the SalesRepClient program invokes the
getCustomerIds method, iterates through the ArrayList of identifiers, and
locates each CustomerEJB entity bean by calling its findByPrimaryKey method:

SalesRep janice = salesHome.findByPrimaryKey("543");
ArrayList a = janice.getCustomerIds();
i = a.iterator();

while (i.hasNext()) {
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   String customerId = (String)i.next();
   Customer customer =
customerHome.findByPrimaryKey(customerId);
   String name = customer.getName();
   System.out.println(customerId + ": " + name);
}

Running the SalesRepEJB Example
1. Create the salesrep database table.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/salesrep/

b. Type this command:

asant create-db_common

2. In deploytool, deploy the SalesRepApp.ear file, which is in this direc-
tory:

<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

3. Run the client.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/salesrep/

b. Type the following command on a single line:

appclient -client SalesRepAppClient.jar

c. The client should display the following lines:

. . .

customerId = 221

customerId = 388

customerId = 456

customerId = 844

987: Mary Jackson

221: Alice Smith

388: Bill Williamson

456: Joe Smith

844: Buzz Murphy

. . .
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Many-to-Many Relationships
In a many-to-many relationship, each entity may be related to multiple occur-
rences of the other entity. For example, a college course has many students and
each student may take several courses. In a database, this relationship is repre-
sented by a cross reference table containing the foreign keys. In Figure 21–4, the
cross reference table is the enrollment table. These tables are accessed by the
StudentBean, CourseBean, and EnrollerBean classes.

Figure 21–4 Many-to-Many Relationship: Students and Courses

The source code for this example is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/enroller/src/

The StudentBean and CourseBean classes are complementary. Each class con-
tains an ArrayList of foreign keys. The StudentBean class contains an Array-

List named courseIds, which identifies the courses the student is enrolled in.
Likewise, the CourseBean class contains an ArrayList named studentIds.

The ejbLoad method of the StudentBean class adds elements to the courseIds

ArrayList by calling loadCourseIds, a private method. The loadCourseIds
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method gets the course identifiers from the EnrollerEJB session bean. The
source code for the loadCourseIds method follows:

private void loadCourseIds() {

   courseIds.clear();

   try {
      Enroller enroller = enrollerHome.create();
      ArrayList a = enroller.getCourseIds(studentId);
      courseIds.addAll(a);

} catch (Exception ex) {
       throw new EJBException("Exception in loadCourseIds: " +
          ex.getMessage());

}
}

Invoked by the loadCourseIds method, the getCourseIds method of the
EnrollerBean class queries the enrollment table:

select courseid from enrollment
where studentid = ?

Only the EnrollerBean class accesses the enrollment table. Therefore, the
EnrollerBean class manages the student-course relationship represented in the
enrollment table. If a student enrolls in a course, for example, the client calls
the enroll business method, which inserts a row:

insert into enrollment
values (studentid, courseid)

If a student drops a course, the unEnroll method deletes a row:

delete from enrollment
where studentid = ? and courseid = ?

And if a student leaves the school, the deleteStudent method deletes all rows
in the table for that student:

delete from enrollment
where student = ?

The EnrollerBean class does not delete the matching row from the student

table. That action is performed by the ejbRemove method of the StudentBean
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class. To ensure that both deletes are executed as a single operation, they should
belong to the same transaction. See Chapter 25  for more information.

Running the EnrollerEJB Example
1. Create the enroller database table.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/enroller/

b. Type this command:

asant create-db_common

2. In deploytool, deploy the EnrollerApp.ear file, which is in this direc-
tory:

<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

3. Run the client.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/enroller/

b. Type the following command on a single line:

appclient -client EnrollerAppClient.jar

c. The client should display the following lines:

. . .

Denise Smith:

220 Power J2EE Programming

333 XML Made Easy

777 An Introduction to Java Programming

An Introduction to Java Programming:

823 Denise Smith

456 Joe Smith

388 Elizabeth Willis

. . .
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Primary Keys for Bean-Managed
Persistence

You specify the primary key class in the entity bean’s deployment descriptor. In
most cases, your primary key class will be a String, an Integer, or some other
class that belongs to the J2SE or J2EE standard libraries. For some entity beans,
you will need to define your own primary key class. For example, if the bean has
a composite primary key (that is, one composed of multiple fields), then you
must create a primary key class.

The Primary Key Class
The following primary key class is a composite key—the productId and ven-

dorId fields together uniquely identify an entity bean.

public class ItemKey implements java.io.Serializable {

   public String productId;
   public String vendorId;

   public ItemKey() { };

   public ItemKey(String productId, String vendorId) {

     this.productId = productId;
     this.vendorId = vendorId;
   }

   public String getProductId() {

      return productId;
   }

   public String getVendorId() {

      return vendorId;
   }

   public boolean equals(Object other) {

      if (other instanceof ItemKey) {
         return (productId.equals(((ItemKey)other).productId)

&& vendorId.equals(((ItemKey)other).vendorId));
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      }
      return false;
   }

   public int hashCode() {

      return productId.concat(vendorId).hashCode();
   }
}

For bean-managed persistence, a primary key class must meet these require-
ments:

• The access control modifier of the class is public.

• All fields are declared as public.

• The class has a public default constructor.

• The class implements the hashCode() and equals(Object other) meth-
ods.

• The class is serializable.

Primary Keys in the Entity Bean Class
With bean-managed persistence, the ejbCreate method assigns the input param-
eters to instance variables and then returns the primary key class:

public ItemKey ejbCreate(String productId, String vendorId,
   String description) throws CreateException {

   if (productId == null || vendorId == null) {
      throw new CreateException(
                "The productId and vendorId are required.");
   }

   this.productId = productId;
   this.vendorId = vendorId;
   this.description = description;

   return new ItemKey(productId, vendorId);
}
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The ejbFindByPrimaryKey verifies the existence of the database row for the
given primary key:

public ItemKey ejbFindByPrimaryKey(ItemKey primaryKey)
   throws FinderException {

   try {
      if (selectByPrimaryKey(primaryKey))
         return primaryKey;
   ...
}

private boolean selectByPrimaryKey(ItemKey primaryKey)
   throws SQLException {

   String selectStatement =
         "select productid " +
         "from item where productid = ? and vendorid = ?";
   PreparedStatement prepStmt =
         con.prepareStatement(selectStatement);
   prepStmt.setString(1, primaryKey.getProductId());
   prepStmt.setString(2, primaryKey.getVendorId());
   ResultSet rs = prepStmt.executeQuery();
   boolean result = rs.next();
   prepStmt.close();
   return result;
}

Getting the Primary Key
A client can fetch the primary key of an entity bean by invoking the getPrima-

ryKey method of the EJBObject class:

SavingsAccount account;
...
String id = (String)account.getPrimaryKey();

The entity bean retrieves its own primary key by calling the getPrimaryKey

method of the EntityContext class:

EntityContext context;
...
String id = (String) context.getPrimaryKey();
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deploytool Tips for Entity Beans with
Bean-Managed Persistence

Chapter 20 gave step-by-step instructions for creating and packaging a session
bean. To build an entity bean, you follow the same procedures, but with the fol-
lowing exceptions.

1. In the New Enterprise Bean wizard, specify the bean’s type and persistent
management.

a. In the General dialog box, select the Entity radio button.

b. In the Entity Settings dialog box, select the radio button for Bean-Man-
aged Persistence.

2. In the Resource Refs tab, specify the resource factories referenced by the
bean. These settings enable the bean to connect to the database. For more
information on resource references, see Database Connections (page 900).

3. Before you deploy the bean, verify that the JNDI names are correct.

a. Select the application from the tree.

b. Select the JNDI Names tab.
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Container-Managed
Persistence Examples

AN entity bean with container-managed persistence offers important advan-
tages to the bean developer. First, the EJB container handles all database storage
and retrieval calls. Second, the container manages the relationships between the
entity beans. Because of these services, you don’t have to code the database
access calls in the entity bean. Instead, you specify settings in the bean’s deploy-
ment descriptor. Not only does this approach save you time, but it makes the
bean portable across various database servers.

This chapter focuses on the source code and deployment settings for an example
called RosterApp, an application that features entity beans with container-man-
aged persistence. If you are unfamiliar with the terms and concepts mentioned in
this chapter, please consult the section Container-Managed
Persistence (page 670).

Overview of the RosterApp Application
The RosterApp application maintains the team rosters for players in sports
leagues. The application has five components. The RosterAppClient compo-
nent is a J2EE application client that accesses the RosterEJB session bean
through the bean’s remote interfaces. RosterEJB accesses three entity beans—
PlayerEJB, TeamEJB, and LeagueEJB—through their local interfaces.
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The entity beans use container-managed persistence and relationships. The
TeamEJB and PlayerEJB entity beans have a bidirectional, many-to-many rela-
tionship. In a bidirectional relationship, each bean has a relationship field whose
value identifies the related bean instance. The multiplicity of the TeamEJB-

PlayerEJB relationship is many-to-many: Players who participate in more than
one sport belong to multiple teams, and each team has multiple players. The
LeagueEJB and TeamEJB entity beans also have a bidirectional relationship, but
the multiplicity is one-to-many: A league has many teams, but a team can belong
to just one league.

Figure 22–1 shows the components and relationships of the RosterApp applica-
tion. The dotted lines represent the access gained through invocations of the
JNDI lookup method. The solid lines represent the container-managed relation-
ships.

Figure 22–1 RosterApp J2EE Application

The PlayerEJB Code
The PlayerEJB entity bean represents a player in a sports league. Like any entity
bean with container-managed persistence, PlayerEJB needs the following code:

• Entity bean class (PlayerBean)

• Local home interface (LocalPlayerHome)
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• Local interface (LocalPlayer)

The source code for this example is in the
<INSTALL>/j2eetutorial14/examples/ejb/cmproster directory.

Entity Bean Class
The code of the entity bean class must meet the container-managed persistence
syntax requirements. First, the class must be defined as public and abstract.
Second, the class must implement the following:

• The EntityBean interface

• Zero or more ejbCreate and ejbPostCreate methods

• The get and set access methods, defined as abstract, for the persistent
and relationship fields

• Any select methods, defining them as abstract

• The home methods

• The business methods

The entity bean class must not implement these methods:

• The finder methods

• The finalize method

Differences between Container-Managed
and Bean-Managed Code
Because it contains no calls to access the database, an entity bean with container-
managed persistence requires a lot less code than one with bean-managed persis-
tence. For example, the PlayerBean.java source file discussed in this chapter is
much smaller than the SavingsAccountBean.java code documented in
Chapter 21. Table 22–1 compares the code of the two types of entity beans.

Table 22–1 Coding Differences between Persistent Types

Difference Container-Managed Bean-Managed

Class definition Abstract Not abstract
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Note that for both types of persistence, the rules for implementing business and
home methods are the same. See the sections The Business Methods (page 749)
and The Home Methods (page 750) in Chapter 21.

Access Methods
An entity bean with container-managed persistence has persistent and relation-
ship fields. These fields are virtual, so you do not code them in the class as
instance variables. Instead, you specify them in the bean’s deployment descrip-
tor. To permit access to the fields, you define abstract get and set methods in the
entity bean class.

Database access calls Handled by container Coded by developers

Persistent state
Represented by virtual persis-
tent fields

Coded as instance variables

Access methods for persis-
tent and relationship fields

Required None

findByPrimaryKey
method

Handled by container Coded by developers

Customized finder methods
Handled by container, but the
developer must define the
EJB QL) queries

Coded by developers

Select methods Handled by container None

Return value of ejbCreate null Must be the primary key

Table 22–1 Coding Differences between Persistent Types (Continued)

Difference Container-Managed Bean-Managed
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Access Methods for Persistent Fields
The EJB container automatically performs the database storage and retrieval of
the bean’s persistent fields. The deployment descriptor of PlayerEJB specifies
the following persistent fields:

• playerId (primary key)

• name

• position

• salary

The PlayerBean class defines the access methods for the persistent fields as fol-
lows:

public abstract String getPlayerId();
public abstract void setPlayerId(String id);

public abstract String getName();
public abstract void setName(String name);

public abstract String getPosition();
public abstract void setPosition(String position);

public abstract double getSalary();
public abstract void setSalary(double salary);

The name of an access method begins with get or set, followed by the capital-
ized name of the persistent or relationship field. For example, the accessor meth-
ods for the salary field are getSalary and setSalary. This naming convention
is similar to that of JavaBeans components.

Access Methods for Relationship Fields
In the RosterApp application, since a player can belong to multiple teams, a
PlayerEJB instance may be related to many TeamEJB instances. To specify this
relationship, the deployment descriptor of PlayerEJB defines a relationship field
named teams. In the PlayerBean class, the access methods for the teams rela-
tionship field are as follows:

public abstract Collection getTeams();
public abstract void setTeams(Collection teams);
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Finder and Select Methods
Finder and select methods use EJB QL queries to return objects and state infor-
mation of entity beans using container-managed persistence.

A select method is similar to a finder method in the following ways:

• A select method can return a local or remote interface (or a collection of
interfaces).

• A select method queries a database.

• The deployment descriptor specifies an EJB QL query for a select method.

• The entity bean class does not implement the select method.

However, a select method differs significantly from a finder method:

• A select method can return a persistent field (or a collection thereof) of a
related entity bean. A finder method can return only a local or remote inter-
face (or a collection of interfaces).

• Since it is not exposed in any of the local or remote interfaces, a select
method cannot be invoked by a client. It can be invoked only by the meth-
ods implemented within the entity bean class. A select method is usually
invoked by either a business or home method.

• A select method is defined in the entity bean class. For bean-managed per-
sistence, a finder method is defined in the entity bean class, but for con-
tainer-managed persistence it is not.

The PlayerBean class defines these select methods:

public abstract Collection ejbSelectLeagues(LocalPlayer player)
throws FinderException;

public abstract Collection ejbSelectSports(LocalPlayer player)
throws FinderException;

The signature for a select method must follow these rules:

• The prefix of the method name must be ejbSelect.

• The access control modifier must be public.

• The method must be declared as abstract.

• The throws clause must include the javax.ejb.FinderException.
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Business Methods
Since clients cannot invoke select methods, the PlayerBean class wraps them in
the getLeagues and getSports business methods:

public Collection getLeagues() throws FinderException {

LocalPlayer player =
(team.LocalPlayer)context.getEJBLocalObject();

return ejbSelectLeagues(player);
}

public Collection getSports() throws FinderException {

LocalPlayer player =
(team.LocalPlayer)context.getEJBLocalObject();

return ejbSelectSports(player);
}

Entity Bean Methods
Because the container handles persistence, the life-cycle methods in the Player-
Bean class are nearly empty.

The ejbCreate method initializes the bean instance by assigning the input argu-
ments to the persistent fields. At the end of the transaction that contains the cre-
ate call, the container inserts a row into the database. Here is the source code for
the ejbCreate method:

public String ejbCreate (String id, String name,
    String position, double salary) throws CreateException {

    setPlayerId(id);
    setName(name);
    setPosition(position);
    setSalary(salary);
    return null;
}

The ejbPostCreate method returns void and it has the same input parameters
as the ejbCreate method. If you want to set a relationship field to initialize the
bean instance, you should do so in the ejbPostCreate method. You may not set
a relationship field in the ejbCreate method.
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Except for a debug statement, the ejbRemove method in the PlayerBean class is
empty. The container invokes ejbRemove before removing the entity object.

The container automatically synchronizes the state of the entity bean with the
database. After the container loads the bean’s state from the database, it invokes
the ejbLoad method. In like manner, before storing the state in the database, the
container invokes the ejbStore method.

Local Home Interface
The local home interface defines the create, finder, and home methods that may
be invoked by local clients.

The syntax rules for a create method follow:

• The name begins with create.

• It has the same number and types of arguments as its matching ejbCreate

method in the entity bean class.

• It returns the local interface type of the entity bean.

• The throws clause includes the exceptions specified by the throws clause
of the corresponding ejbCreate method.

• The throws clause contains the javax.ejb.CreateException.

These rules apply for a finder method:

• The name begins with find.

• The return type is the entity bean’s local interface type, or a collection of
those types.

• The throws clause contains the javax.ejb.FinderException.

• The findByPrimaryKey method must be defined.

An excerpt of the LocalPlayerHome interface follows.

package team;

import java.util.*;
import javax.ejb.*;

public interface LocalPlayerHome extends EJBLocalHome {

    public LocalPlayer create (String id, String name,
        String position, double salary)
        throws CreateException;
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    public LocalPlayer findByPrimaryKey (String id)
        throws FinderException;

    public Collection findByPosition(String position)
        throws FinderException;
     ...
    public Collection findByLeague(LocalLeague league)
        throws FinderException;
    ...
  }

Local Interface
This interface defines the business and access methods that a local client may
invoke. The PlayerBean class implements two business methods: getLeagues
and getSports. It also defines several get and set access methods for the
persistent and relationship fields. The set methods are hidden from the bean’s
clients because they are not defined in the LocalPlayer interface. However, the
get methods are exposed to the clients by the interface:

package team;

import java.util.*;
import javax.ejb.*;

public interface LocalPlayer extends EJBLocalObject {

    public String getPlayerId();
    public String getName();
    public String getPosition();
    public double getSalary();
    public Collection getTeams();

    public Collection getLeagues() throws FinderException;
    public Collection getSports() throws FinderException;
}

Method Invocations in RosterApp
To show how the various components interact, this section describes the
sequence of method invocations that occur for particular functions. The source
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code for the components is in the
<INSTALL>/j2eetutorial14/examples/ejb/cmproster directory.

Creating a Player

1. RosterClient
The RosterClient invokes the createPlayer business method of the Ros-

terEJB session bean to create a new player. In the following line of code, the
type of the myRoster object is Roster, the remote interface of RosterEJB. The
argument of the createPlayer method is a PlayerDetails object, which
encapsulates information about a particular player.

myRoster.createPlayer(new PlayerDetails("P1", "Phil Jones",
"goalkeeper", 100.00));

2. RosterEJB
The createPlayer method of the RosterEJB session bean creates a new
instance of the PlayerEJB entity bean. Because the access of PlayerEJB is local,
the create method is defined in the local home interface, LocalPlayerHome.
The type of the playerHome object is LocalPlayerHome. Here is the source code
for the createPlayer method:

public void createPlayer(PlayerDetails details) {

try {
LocalPlayer player = playerHome.create(details.getId(),

details.getName(), details.getPosition(),
details.getSalary());

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}
}

3. PlayerEJB
The ejbCreate method assigns the input arguments to the bean’s persistent
fields by calling the set access methods. At the end of the transaction that con-
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tains the create call, the container saves the persistent fields in the database by
issuing a SQL INSERT statement. The code for the ejbCreate method follows.

public String ejbCreate (String id, String name,
String position, double salary) throws CreateException {

setPlayerId(id);
setName(name);
setPosition(position);
setSalary(salary);
return null;

}

Adding a Player to a Team

1. RosterClient
The RosterClient calls the addPlayer business method of the RosterEJB ses-
sion bean to add player P1 to team T1. The P1 and T1 parameters are the primary
keys of the PlayerEJB and TeamEJB instances, respectively.

 myRoster.addPlayer("P1", "T1");

2. RosterEJB
The addPlayer method performs two steps. First, it calls findByPrimaryKey to
locate the PlayerEJB and TeamEJB instances. Second, it invokes the addPlayer

business method of the TeamEJB entity bean. Here is the source code for the
addPlayer method of the RosterEJB session bean:

public void addPlayer(String playerId, String teamId) {

try {
LocalTeam team = teamHome.findByPrimaryKey(teamId);
LocalPlayer player =

playerHome.findByPrimaryKey(playerId);
team.addPlayer(player);

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}
}



788 CONTAINER-MANAGED PERSISTENCE EXAMPLES
3. TeamEJB
The TeamEJB entity bean has a relationship field named players, a Collection

that represents the players that belong to the team. The access methods for the
players relationship field are as follows:

public abstract Collection getPlayers();
public abstract void setPlayers(Collection players);

The addPlayer method of TeamEJB invokes the getPlayers access method to
fetch the Collection of related LocalPlayer objects. Next, the addPlayer

method invokes the add method of the Collection interface. Here is the source
code for the addPlayer method:

public void addPlayer(LocalPlayer player) {
try {

Collection players = getPlayers();
players.add(player);

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}
}

Removing a Player

1. RosterClient
To remove player P4, the client would invoke the removePlayer method of the
RosterEJB session bean:

myRoster.removePlayer("P4");

2. RosterEJB
The removePlayer method locates the PlayerEJB instance by calling findBy-

PrimaryKey and then invokes the remove method on the instance. This invoca-
tion signals the container to delete the row in the database that corresponds to the
PlayerEJB instance. The container also removes the item for this instance from
the players relationship field in the TeamEJB entity bean. By this removal, the
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container automatically updates the TeamEJB-PlayerEJB relationship. Here is
the removePlayer method of the RosterEJB session bean:

public void removePlayer(String playerId) {
try {

LocalPlayer player =
playerHome.findByPrimaryKey(playerId);

player.remove();
} catch (Exception ex) {

throw new EJBException(ex.getMessage());
}

}

Dropping a Player from a Team

1. RosterClient
To drop player P2 from team T1, the client would call the dropPlayer method of
the RosterEJB session bean:

myRoster.dropPlayer("P2", "T1");

2. RosterEJB
The dropPlayer method retrieves the PlayerEJB and TeamEJB instances by call-
ing their findByPrimaryKey methods. Next, it invokes the dropPlayer business
method of the TeamEJB entity bean. The dropPlayer method of the RosterEJB

session bean follows:

public void dropPlayer(String playerId, String teamId) {

try {
LocalPlayer player =

playerHome.findByPrimaryKey(playerId);
LocalTeam team = teamHome.findByPrimaryKey(teamId);
team.dropPlayer(player);

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}
}
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3. TeamEJB
The dropPlayer method updates the TeamEJB-PlayerEJB relationship. First,
the method retrieves the Collection of LocalPlayer objects that correspond to
the players relationship field. Next, it drops the target player by calling the
remove method of the Collection interface. Here is the dropPlayer method of
the TeamEJB entity bean:

public void dropPlayer(LocalPlayer player) {

try {
Collection players = getPlayers();
players.remove(player);

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}
}

Getting the Players of a Team

1. RosterClient
The client can fetch a team’s players by calling the getPlayersOfTeam method
of the RosterEJB session bean. This method returns an ArrayList of Player-
Details objects. A PlayerDetail object contains four variables—playerId,
name, position, and salary—which are copies of the PlayerEJB persistent
fields. The RosterClient calls the getPlayersOfTeam method as follows:

playerList = myRoster.getPlayersOfTeam("T2");

2. RosterEJB
The getPlayersOfTeam method of the RosterEJB session bean locates the
LocalTeam object of the target team by invoking the findByPrimaryKey

method. Next, the getPlayersOfTeam method calls the getPlayers method of
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the TeamEJB entity bean. Here is the source code for the getPlayersOfTeam

method:

public ArrayList getPlayersOfTeam(String teamId) {

Collection players = null;

try {
LocalTeam team = teamHome.findByPrimaryKey(teamId);
players = team.getPlayers();

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}

return copyPlayersToDetails(players);
}

The getPlayersOfTeam method returns the ArrayList of PlayerDetails

objects that is generated by the copyPlayersToDetails method:

private ArrayList copyPlayersToDetails(Collection players) {

ArrayList detailsList = new ArrayList();
Iterator i = players.iterator();

while (i.hasNext()) {
LocalPlayer player = (LocalPlayer) i.next();
PlayerDetails details =

new PlayerDetails(player.getPlayerId(),
player.getName(), player.getPosition(),
player.getSalary());

detailsList.add(details);
}

return detailsList;
}

3. TeamEJB
The getPlayers method of the TeamEJB entity bean is an access method of the
players relationship field:

public abstract Collection getPlayers();
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This method is exposed to local clients because it is defined in the local inter-
face, LocalTeam:

public Collection getPlayers();

When invoked by a local client, a get access method returns a reference to the
relationship field. If the local client alters the object returned by a get access
method, it also alters the value of the relationship field inside the entity bean. For
example, a local client of the TeamEJB entity bean could drop a player from a
team as follows:

LocalTeam team = teamHome.findByPrimaryKey(teamId);
Collection players = team.getPlayers();
players.remove(player);

If you want to prevent a local client from modifying a relationship field in this
manner, you should take the approach described in the next section.

Getting a Copy of a Team’s Players
In contrast to the methods discussed in the preceding section, the methods in this
section demonstrate the following techniques:

• Filtering the information passed back to the remote client

• Preventing the local client from directly modifying a relationship field

1. RosterClient
If you wanted to hide the salary of a player from a remote client, you would
require the client to call the getPlayersOfTeamCopy method of the RosterEJB

session bean. Like the getPlayersOfTeam method, the getPlayersOfTeamCopy

method returns an ArrayList of PlayerDetails objects. However, the objects
returned by getPlayersOfTeamCopy are different—their salary variables have
been set to zero. The RosterClient calls the getPlayersOfTeamCopy method
as follows:

playerList = myRoster.getPlayersOfTeamCopy("T5");
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2. RosterEJB
Unlike the getPlayersOfTeam method, the getPlayersOfTeamCopy method
does not invoke the getPlayers access method that is exposed in the LocalTeam

interface. Instead, the getPlayersOfTeamCopy method retrieves a copy of the
player information by invoking the getCopyOfPlayers business method that is
defined in the LocalTeam interface. As a result, the getPlayersOfTeamCopy

method cannot modify the players relationship field of TeamEJB. Here is the
source code for the getPlayersOfTeamCopy method of RosterEJB:

public ArrayList getPlayersOfTeamCopy(String teamId) {

ArrayList playersList = null;

try {
LocalTeam team = teamHome.findByPrimaryKey(teamId);
playersList = team.getCopyOfPlayers();

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}

return playersList;
}

3. TeamEJB
The getCopyOfPlayers method of TeamEJB returns an ArrayList of PlayerDe-
tails objects. To create this ArrayList, the method iterates through the Col-

lection of related LocalPlayer objects and copies information to the variables
of the PlayerDetails objects. The method copies the values of PlayerEJB per-
sistent fields—except for the salary field, which it sets to zero. As a result, a
player’s salary is hidden from a client that invokes the getPlayersOfTeamCopy

method. The source code for the getCopyOfPlayers method of TeamEJB fol-
lows.

public ArrayList getCopyOfPlayers() {

ArrayList playerList = new ArrayList();
Collection players = getPlayers();

Iterator i = players.iterator();
while (i.hasNext()) {

LocalPlayer player = (LocalPlayer) i.next();
PlayerDetails details =
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new PlayerDetails(player.getPlayerId(),
player.getName(), player.getPosition(), 0.00);

playerList.add(details);
}

return playerList;
}

Finding the Players by Position

1. RosterClient
The client starts the procedure by invoking the getPlayersByPosition method
of the RosterEJB session bean:

playerList = myRoster.getPlayersByPosition("defender");

2. RosterEJB
The getPlayersByPosition method retrieves the players list by invoking the
findByPosition method of the PlayerEJB entity bean:

public ArrayList getPlayersByPosition(String position) {

Collection players = null;

try {
players = playerHome.findByPosition(position);

} catch (Exception ex) {
throw new EJBException(ex.getMessage());

}

return copyPlayersToDetails(players);
}

3. PlayerEJB
The LocalPlayerHome interface defines the findByPosition method:

public Collection findByPosition(String position)
throws FinderException;
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Because the PlayerEJB entity bean uses container-managed persistence, the
entity bean class (PlayerBean) does not implement its finder methods. To spec-
ify the queries associated with the finder methods, EJB QL queries must be
defined in the bean’s deployment descriptor. For example, the findByPosition

method has this EJB QL query:

SELECT DISTINCT OBJECT(p) FROM Player p
WHERE p.position = ?1

At runtime, when the container invokes the findByPosition method, it will exe-
cute the corresponding SQL SELECT statement.

For details about EJB QL, please refer to Chapter 24. To learn how to view and
edit an EJB QL query in deploytool, see the section Finder/Select Methods
Dialog Box (PlayerEJB) (page 817).

Getting the Sports of a Player

1. RosterClient
The client invokes the getSportsOfPlayer method of the RosterEJB session
bean:

sportList = myRoster.getSportsOfPlayer("P28");

2. RosterEJB
The getSportsOfPlayer method returns an ArrayList of String objects that
represent the sports of the specified player. It constructs the ArrayList from a
Collection returned by the getSports business method of the PlayerEJB

entity bean. Here is the source code for the getSportsOfPlayer method of the
RosterEJB session bean:

public ArrayList getSportsOfPlayer(String playerId) {

ArrayList sportsList = new ArrayList();
Collection sports = null;

try {
LocalPlayer player =

playerHome.findByPrimaryKey(playerId);
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sports = player.getSports();
} catch (Exception ex) {

throw new EJBException(ex.getMessage());
}

Iterator i = sports.iterator();
while (i.hasNext()) {

String sport = (String) i.next();
sportsList.add(sport);

}
return sportsList;

}

3. PlayerEJB
The getSports method is a wrapper for the ejbSelectSports method. Since
the parameter of the ejbSelectSports method is of type LocalPlayer, the
getSports method passes along a reference to the entity bean instance. The
PlayerBean class implements the getSports method as follows:

public Collection getSports() throws FinderException {

LocalPlayer player =
(team.LocalPlayer)context.getEJBLocalObject();

return ejbSelectSports(player);
}

The PlayerBean class defines the ejbSelectSports method:

public abstract Collection ejbSelectSports(LocalPlayer player)
throws FinderException;

The bean’s deployment descriptor specifies the following EJB QL query for the
ejbSelectSports method:

SELECT DISTINCT t.league.sport
FROM Player p, IN (p.teams) AS t
WHERE p = ?1

Because PlayerEJB uses container-managed persistence, when the ejbSe-

lectSports method is invoked the EJB container will execute its corresponding
SQL SELECT statement.
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Building and Running the RosterApp
Example

Now that you understand the structure of the RosterApp example EAR file, you
will assemble the enterprise application, the application client, and run the exam-
ple. This section gives detailed instructions on how to build and run the Roster-
App example located at
<INSTALL>/j2eetutorial14/examples/ejb/cmproster/.

Creating the Database Tables
The instructions that follow explain how to use the RosterApp example with
PointBase, the database software that is included in the J2EE Application Server
bundle.

1. Start the PointBase server. For instructions, see Starting the PointBase
Database Server (page 110).

2. Create the database tables by running the create.sql script.

a. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/cmproster/

b. Type the following command, which runs the create.sql script:

asant create-db_common

Creating the JDBC Resource
You must create the jdbc/ejbTutorialDB resource. For instructions on creating
this resource in the Admin Console, see Defining a Data Source in the J2EE
Application Server (page 901).

Capturing the Table Schema
You will now create a database schema file, which will allow you to map fields
from the enterprise beans to columns in the database tables created above.

1. Make sure the PointBase server is running.

2. In a terminal window, go to:
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<INSTALL>/j2eetutorial14/examples/ejb/cmproster/

3. Type the following command to create the database schema file, named
cmproster.dbschema, in the ./build/ directory:
asant capture-db-schema

The capture-db-schema task calls the capture-schema utility to output an
XML file, cmproster.dbschema, that represents the structure of the database
tables created in Creating the Database Tables above. cmproster.dbschema will
be used to automatically map the enterprise bean fields to database columns.

The command that’s called when you run the capture-db-schema task is as fol-
lows:

capture-schema -dburl
jdbc:pointbase:server://localhost:9092/sun-appserv-samples
-username pbpublic -password pbpublic -table LEAGUE
-table PLAYER -table TEAM -table TEAM_PLAYER
-schemaname PBPUBLIC
-driver com.pointbase.jdbc.jdbcUniversalDriver
-out build/cmproster.dbschema

Building the Enterprise Beans
You will now build the enterprise beans.

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/cmproster/

2. Type the following command:

asant build

Creating the Enterprise Application
Create a new application in deploytool called RosterApp.

1. In deploytool select File→New→Application.

2. In the Application File Name field click Browse.

3. Navigate to <INSTALL>/j2eetutorial14/examples/ejb/cmproster/.

4. In the File Name field enter RosterApp.

5. Click New Application.

6. Click OK.
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Packaging the Enterprise Beans
You will now package the four enterprise beans, RosterEJB, LeagueEJB, Play-
erEJB, TeamEJB. RosterEJB, a stateful session bean, will be packaged in Ros-
terJAR. LeagueEJB, PlayerEJB, and TeamEJB are entity beans using container-
managed persistence, and will be packaged in TeamJAR.

Packaging RosterEJB
1. Create a new enterprise bean in RosterApp by selecting File→New→Enter-

prise Bean.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application.

b. Enter RosterJAR under JAR Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/cmproster/build/.

e. Select the roster, and util directories.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select roster.RosterBean under Enterprise Bean Class.

b. Enter RosterEJB under Enterprise Bean Name.

c. Select Stateful Session under Enterprise Bean Type.

d. Select roster.RosterHome under Remote Home Interface.

e. Select roster.Roster under Remote Interface.

f. Select Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point.

5. Click Finish.
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Packaging LeagueEJB, PlayerEJB, and
TeamEJB

1. Create a new enterprise bean in RosterApp by selecting File→New→Enter-
prise Bean.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application.

b. Enter TeamJAR under JAR Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/cmproster/build/.

e. Select the team and util directories, and the cmproster.dbschema file.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select team.LeagueBean under Enterprise Bean Class.

b. Enter LeagueEJB under Enterprise Bean Name.

Note: Be sure you enter the correct name in the Enterprise Bean Name field for
LeagueEJB, PlayerEJB, and TeamEJB to allow the automatic mapping of persisted
fields and relationships.

c. Select team.LocalLeagueHome under Local Home Interface.

d. Select team.LocalLeague under Local Interface.

e. Click Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point and click Next.

5. In the Entity Settings screen:

a. In the Persistence Management Type field select Container-Managed
Persistence (2.0).

b. In the Fields To Be Persisted frame check name, leagueId, and sport.

c. In the Abstract Schema Name field enter League.

d. In the Primary Key Class field select java.lang.String.
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e. In the Primary Key Field Name field select leagueId.

f. Click Next.

6. Click Finish.

Now we’ll add PlayerEJB to TeamJAR.

1. Create a new enterprise bean in TeamJAR by selecting File→New→Enter-
prise Bean.

2. In the EJB JAR screen:

a. Select Add To Existing JAR Module.

b. Select TeamJAR (RosterApp) under Add To Existing JAR Module.

c. Click Next.

3. In the General screen:

a. Select team.PlayerBean under Enterprise Bean Class.

b. Enter PlayerEJB under Enterprise Bean Name.

c. Select team.LocalPlayerHome under Local Home Interface.

d. Select team.LocalPlayer under Local Interface.

e. Click Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point and click Next.

5. In the Entity Settings screen:

a. In the Persistence Management Type field select Container-Managed
Persistence (2.0).

b. In the Fields To Be Persisted frame check name, position, playerId,
and salary.

c. In the Abstract Schema Name field enter Player.

d. In the Primary Key Class field select java.lang.String.

e. In the Primary Key Field Name field select playerId.

f. Click Next.

6. Click Finish.

Now we’ll add TeamEJB to TeamJAR.

1. Create a new enterprise bean in TeamJAR by selecting File→New→Enter-
prise Bean.

2. In the EJB JAR screen:

a. Select Add To Existing JAR Module.
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b. Select TeamJAR (RosterApp) under Add To Existing JAR Module.

c. Click Next.

3. In the General screen:

a. Select team.TeamBean under Enterprise Bean Class.

b. Enter TeamEJB under Enterprise Bean Name.

c. Select team.LocalTeamHome under Local Home Interface.

d. Select team.LocalTeam under Local Interface.

e. Click Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point and click Next.

5. In the Entity Settings screen:

a. In the Persistence Management Type field select Container-Managed
Persistence (2.0).

b. In the Fields To Be Persisted frame check name, teamId, and city.

c. In the Abstract Schema Name field enter Team.

d. In the Primary Key Class field select java.lang.String.

e. In the Primary Key Field Name field select teamId.

f. Click Next.

6. Click Finish.

Adding EJB-QL queries to PlayerEJB
PlayerEJB contains finder and selector methods that use EJB-QL queries. These
steps will add the appropriate EJB-QL queries to the methods.

1. Select PlayerEJB in the tree in deploytool.

2. Select the Entity tabbed pane.

3. Click Find/Select Queries.

4. Select Local Finders:

a. For the findAll method enter:

select object(p) from Player p

b. For the findByCity method enter:

select distinct object(p) from Player p,

in (p.teams) as t

where t.city = ?1
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c. For the findByHigherSalary method enter:

select distinct object(p1)

from Player p1, Player p2

where p1.salary > p2.salary and

p2.name = ?1

d. For the findByLeague method enter:

select distinct object(p) from Player p,

in (p.teams) as t

where t.league = ?1

e. For the findByPosition method enter:

select distinct object(p) from Player p

where p.position = ?1

f. For the findByPositionAndName method enter:

select distinct object(p) from Player p

where p.position = ?1 and p.name = ?2

g. For the findBySalaryRange method enter:

select distinct object(p) from Player p

where p.salary between ?1 and ?2

h. For the findBySport method enter:

select distinct object(p) from Player p,

in (p.teams) as t

where t.league.sport = ?1

i. For the findByTest method enter:

select distinct object(p) from Player p

where p.name = ?1

j. For the findNotOnTeam method enter:

select object(p) from Player p

where p.teams is empty

5. Select Select Methods:

a. For the ejbSelectLeagues method enter:

select distinct t.league

from Player p, in (p.teams) as t

where p = ?1

b. For the ejbSelectSports method enter:
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select distinct t.league.sport

from Player p, in (p.teams) as t

where p = ?1

c. Under Return EJBs of Type select None for ejbSelectSports.

6. Click OK.

7. Select File→Save.

Creating the Field Mappings
1. Select TeamJAR from the tree in deploytool.

2. Select the General tabbed pane.

3. Click Sun-specific Settings.

4. In the Sun-specific Settings dialog:

a. In the JNDI Name field enter jdbc/ejbTutorialDB.

b. Click Create Field Mappings.

5. In the Create Field Mappings dialog:

a. Select Map to Tables in Database Schema File.

b. Select cmproster.dbschema under Database Schema Files in Module.

c. Click OK.

6. You will be prompted with a dialog informing you that this will remove all
current field mappings for the enterprise beans in TeamJAR. Click OK to
continue. LeageEJB, PlayerEJB, and TeamEJB will have their fields auto-
matically mapped to columns in the tables in the database resource
jdbc/ejbTutorialDB.

7. Click Close.

Establishing Relationships Between Enterprise
Beans
To create the container-managed relationships between the enterprise beans, do
the following:

1. Select TeamJAR in the tree in deploytool.

2. Select the Relationships tabbed pane.

3. Click Add.
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4. In the Add Relationship dialog:

a. In the Multiplicity field select Many to Many (*:*).

b. In the Enterprise Bean A section:

1.In the Enterprise Bean Name field, select TeamEJB.

2.In the Field Referencing Bean B field, select players.

3.In the Field Type field, select java.util.Collection.

c. In the Enterprise Bean B section:

1.In the Enterprise Bean Name field, select PlayerEJB.

2.In the Field Referencing Bean A field, select teams.

3.In the Field Type field, select java.util.Collection.

d. Click OK.

5. Click Add.

6. In the Add Relationship dialog:

a. In the Multiplicity field select One to Many (1:*).

b. In the Enterprise Bean A section:

1.In the Enterprise Bean Name field, select LeagueEJB.

2.In the Field Referencing Bean B field, select teams.

3.In the Field Type field, select java.util.Collection.

c. In the Enterprise Bean B section:

1.In the Enterprise Bean Name field, select TeamEJB.

2.In the Field Referencing Bean A field, select league.

3.Check Delete When Bean A Is Deleted.

d. Click OK.

Mapping the Container-Managed
Relationship Fields

1. Select TeamJAR in deploytool’s tree.

2. Select the Relationships tabbed pane.

3. Click Sun-specific Settings.

4. Under Persistent Field Mappings in the Enterprise Bean field select
LeagueEJB.

5. In the Persistent Field Mapping table select the teams row.
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6. Click the ellipses (...) button after <unmapped relationship> to open
the Map Relationship Field wizard.

7. In the Map Relationship wizard:

a. Select Link the Mapped Tables Directly.

b. Click Next.

c. Verify that under Key Column Pairs Local Column has the value
LEAGUE.ID and Foreign Column has the value TEAM.LEAGUE_ID.

d. Click Finish

Notice that TeamEJB’s league field was automatically mapped.

8. Under Persistent Field Mappings in the Enterprise Bean field select Play-
erEJB.

9. In the Persistent Field Mapping table select the teams row.

10.Click the ellipses (...) button after <unmapped relationship> to open
the Map Relationship Field wizard.

11.In the Map Relationship wizard:

a. Select Link the Mapped Tables Using a Join Table.

b. Click Next.

c. Verify that under Key Column Pairs Local Column has the value
PLAYER.ID and Join Table Column has the value
TEAM_PLAYER.PLAYER_ID.

d. Click Next.

e. Verify that under Key Column Pairs Join Table Column has the value
TEAM_PLAYER.TEAM_ID and Foreign Column has the value TEAM.ID.

f. Click Finish.

12.Click Close.

Setting RosterEJB’s Transaction Attributes
1. Select RosterEJB in deploytool’s tree.

2. Click the Transactions tabbed pane.

3. In the Transaction Management field click Container-Managed.
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Setting the Enterprise Bean References
First, you’ll set the enterprise bean reference for ejb/SimpleLeague.

1. Select RosterEJB in deploytool’s tree.

2. Click the EJB Refs tabbed pane.

3. Click Add.

4. In the Add Enterprise Bean Reference dialog:

a. In the Coded Name field enter ejb/SimpleLeague.

b. In the EJB Type field select Entity.

c. In the Interfaces field select Local.

d. In the Home Interface field enter team.LocalLeagueHome.

e. In the Local/Remote Interface field enter team.LocalLeague.

f. Click OK.

5. Select the row you just added.

6. Under Sun-specific Settings for ejb/SimpleLeague in the Enterprise Bean
Name field select ejb-jar-ic1.jar#LeagueEJB.

Next, you’ll set the enterprise bean reference for ejb/SimplePlayer.

1. Click Add.

2. In the Add Enterprise Bean Reference dialog:

a. In the Coded Name field enter ejb/SimplePlayer.

b. In the EJB Type field select Entity.

c. In the Interfaces field select Local.

d. In the Home Interface field enter team.LocalPlayerHome.

e. In the Local/Remote Interface field enter team.LocalPlayer.

f. Click OK.

3. Select the row you just added.

4. Under Sun-specific Settings for ejb/SimplePlayer in the Enterprise Bean
Name field select ejb-jar-ic1.jar#PlayerEJB.

Finally, you’ll set the enterprise bean reference for ejb/SimpleTeam.

1. Click Add.

2. In the Add Enterprise Bean Reference dialog:

a. In the Coded Name field enter ejb/SimpleTeam.
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b. In the EJB Type field select Entity.

c. In the Interfaces field select Local.

d. In the Home Interface field enter team.LocalTeamHome.

e. In the Local/Remote Interface field enter team.LocalTeam.

f. Click OK.

3. Select the row you just added.

4. Under Sun-specific Settings for ejb/SimpleTeam in the Enterprise Bean
Name field select ejb-jar-ic1.jar#TeamEJB.

5. Select File→Save.

Packaging the Enterprise Application
Client

1. Create a new application client in RosterApp by selecting File→New→Ap-
plication Client.

2. In the JAR File Contents screen:

a. Select RosterApp under Create New AppClient Module in Application.

b. Enter RosterClient under AppClient Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/cmproster/build/.

e. Select the client and util directories.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select client.RosterClient under Main Class.

b. Select (Use container-managed authentication) under Callback Handler
Class.

c. Click Next.

4. Click Finish.
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Setting the Enterprise Bean Reference
1. Select RosterClient in deploytool’s tree.

2. Select the EJB Refs tabbed pane.

3. Click Add.

4. In the Add Enterprise Bean Reference dialog:

a. In the Coded Name field enter ejb/SimpleRoster.

b. In the EJB Type field select Session.

c. In the Interfaces field select Remote.

d. In the Home Interface field enter roster.RosterHome.

e. In the Local/Remote Interface field enter roster.Roster.

f. Click OK.

5. Select the row you just added.

6. Under Sun-specific Settings for ejb/SimpleRoster select JNDI Name.

7. In the JNDI Name field select RosterEJB.

8. Select File→Save.

Deploying the Enterprise Application
1. Select Tools→Deploy.

2. In the Deploy Module RosterApp dialog enter the username and password.

3. Under Application Client Stub Directory check Return Client Jar.

4. Confirm the path in the field below the checkbox is
<INSTALL>/j2eetutorial14/examples/ejb/cmproster/. If it isn’t,
click Browse and navigate to
<INSTALL>/j2eetutorial14/examples/ejb/cmproster/build/.

5. Click OK.

6. Confirm the application deployed and started correctly, and the client stub
JAR was created at <INSTALL>/j2eetutorial14/exam-

ples/ejb/cmproster/build/.

7. Click Close.
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Running the Client Application
1. In a terminal go to <INSTALL>/j2eetutorial14/exam-

ples/ejb/cmproster/.

2. Type the following command:

appclient -client RosterAppClient.jar

3. In the terminal window, the client displays these lines:

P7 Rebecca Struthers midfielder 777.0

P6 Ian Carlyle goalkeeper 555.0

P9 Jan Wesley defender 100.0

P10 Terry Smithson midfielder 100.0

P8 Anne Anderson forward 65.0

T2 Gophers Manteca

T5 Crows Orland

T1 Honey Bees Visalia

P2 Alice Smith defender 505.0

P5 Barney Bold defender 100.0

P25 Frank Fletcher defender 399.0

P9 Jan Wesley defender 100.0

P22 Janice Walker defender 857.0

L1 Mountain Soccer

L2 Valley Basketball

A Guided Tour of the RosterApp
Settings

This section introduces you to the settings of the deployment descriptors for
entity beans with container-managed persistence and relationships. As this tour
guides you through the deploytool screens, it discusses the highlights of the
tabs and dialog boxes that appear.

To begin our tour, please run deploytool and open the RosterApp.ear file,
which is in the <INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

directory.
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RosterApp
To view the deployment settings for the application, select the RosterApp node
in the tree view.

General Tab (RosterApp)
The Contents field displays the files contained in the RosterApp.ear file,
including the two EJB JAR files (ejb-jar-ic.jar, ejb-jar-ic1.jar) and the
J2EE application client JAR file (app-client-ic.jar). See Figure 22–2.

Figure 22–2 General Tab of RosterApp
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JNDI Names Tab (RosterApp)
The Application table lists the JNDI names for the enterprise beans in the Ros-

terApp application.

The References table has one entry. The EJB Ref entry maps the coded name
(ejb/SimpleRoster) in the RosterClient to the JNDI name of the RosterEJB

session bean.

RosterClient
To view this client, expand the RosterApp node by clicking its adjacent key icon
in the tree view. Next, select RosterClient.

JAR File Tab (RosterClient)
The Contents field shows the files contained by the app-client-ic.jar file:
two XML files (the deployment descriptors) and the class files (RosterCli-
ent.class, Debug.class, LeagueDetails.class, PlayerDetails.class,
TeamDetails.class).

EJB Refs Tab (RosterClient)
The RosterClient accesses a single bean, the RosterEJB session bean. Because
this access is remote, the value in the Interfaces column is Remote and the value
for the Local/Remote Interface column is the bean’s remote interface (ros-
ter.Roster).

RosterJAR
In the tree view, select RosterJAR. This JAR file contains the RosterEJB session
bean.

General Tab (RosterJAR)
The Contents field lists three packages of class files. The roster package con-
tains the class files required for RosterEJB—the session bean class, remote
interface, and home interface. The team package includes the local interfaces for
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the entity beans accessed by the RosterEJB session bean. The util package
holds the utility classes for this application.

RosterEJB
In the tree view, expand the RosterJAR node and select RosterEJB.

General Tab (RosterEJB)
This tab shows that RosterEJB is a stateful session bean with remote access.
Because it allows no local access, the Local Interfaces fields are empty.

EJB Refs Tab (RosterEJB)
The RosterEJB session bean accesses three entity beans: PlayerEJB, TeamEJB,
and LeagueEJB. Because this access is local, the entries in the Interfaces col-
umns are defined as Local. The Home Interface column lists the local home
interfaces of the entity beans. The Local/Remote Interfaces column displays the
local interfaces of the entity beans.

To view the runtime deployment settings, select a row in the table. For example,
when you select the row with the Coded Name of ejb/SimpleLeague, the
LeagueEJB name appears in the Enterprise Bean Name field. If a component ref-
erences a local entity bean, then you must enter the name of the referenced bean
in the Enterprise Bean Name field.

TeamJAR
In the tree view, select the TeamJAR node. This JAR file contains the three related
entity beans: LeagueEJB, TeamEJB, and PlayerEJB.

General Tab (TeamJAR)
The Contents field shows two packages of class files: team and util. The team

package has the entity bean classes, local interfaces, and local home interfaces
for all three entity beans. The util package contains utility classes. It also shows
the database schema file used to map the enterprise bean’s fields to the database.
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Relationships Tab (TeamJAR)
On this tab (Figure 22–3) you define the relationships between entity beans with
container-managed persistence.

Figure 22–3 Relationships Tab of TeamJAR

The Container Managed Relationships table summarizes two relationships:
TeamEJB-PlayerEJB and LeagueEJB-TeamEJB. In the TeamEJB-PlayerEJB rela-
tionship, TeamEJB is designated as EJB A and PlayerEJB as EJB B. (This desig-
nation is arbitrary—we could have assigned PlayerEJB to EJB A and TeamEJB

to EJB B.)

Edit Relationship Dialog Box (TeamJAR)
To view the Edit Relationship dialog box (Figure 22–4), on the Relationships tab
select a row and click Edit. For example, to view the TeamEJB-PlayerEJB rela-
tionship, select the row in which the EJB A value is Team and then click Edit.

TeamEJB-PlayerEJB Relationship

The Multiplicity combo box offers four choices. For this relationship, the Many
To Many choice should be selected because a team has many players and a
player can belong to more than one team.

The information in the Enterprise Bean A box defines TeamEJB side of the rela-
tionship. The Field Referencing Bean B combo box displays the relationship
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field (players) in TeamEJB. This field corresponds to the relationship access
methods in the TeamBean.java source code:

public abstract Collection getPlayers();
public abstract void setPlayers(Collection players);

Figure 22–4 Edit Relationship Dialog Box of TeamJAR

The selection of the Field Type combo box is java.util.Collection, which
matches the players type in the access methods. The players type is a multi-
valued object (Collection) because on the TeamEJB side of the relationship the
multiplicity is many.

The TeamEJB-PlayerEJB relationship is bidirectional—each bean has a relation-
ship field that identifies the related bean. If this relationship were unidirectional,
then one of the beans would not have a relationship field identifying the other
bean. For the bean without the relationship field, the value of the Field Referenc-
ing combo box would be <none>.

LeagueEJB-TeamEJB Relationship

In the Edit Relationship dialog box, the Multiplicity choice should be One to
Many. This choice indicates that a single league has multiple teams.

For LeagueEJB, the relationship field is teams and for TeamEJB it is league.
Because TeamEJB is on the multiple side of the relationship, the teams field is a
Collection. In contrast, since LeagueEJB is on the single side of the relation-
ship, the league field is a single-valued object, a LocalLeague. The Team-

Bean.java code defines the league relationship field with these access methods:

public abstract LocalLeague getLeague();
public abstract void setLeague(LocalLeague league);
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For TeamEJB (Enterprise Bean B), the Delete When Bean A Is Deleted checkbox
is selected. Because of this selection, when a LeagueEJB instance is deleted the
related TeamEJB instances are automatically deleted. This type of deletion, in
which one deletion triggers another, is called a cascade delete. For LeagueEJB,
the corresponding checkbox is disabled: If you delete a team, you don’t want to
automatically delete the league, because there may be other teams in that league.
In general, if a bean is on the multiple side of a relationship, the other bean can-
not be automatically deleted.

PlayerEJB
In the tree view, expand the TeamJAR node and select the PlayerEJB entity bean.

General Tab (PlayerEJB)
This tab shows the enterprise bean class and interfaces. Since the PlayerEJB

entity bean uses container-managed persistence, it has local interfaces. It does
not have remote interfaces because it does not allow remote access.

Entity Tab (PlayerEJB)
The field at the top of the tabbed page define the bean’s persistence type (Figure
22–5). For PlayerEJB, this type is Container-Managed Persistence, version 2.0.
(Because version 1.1 did not support relationships, it is not recommended. These
version numbers identify a particular release of the Enterprise JavaBeans Speci-
fication, not the J2EE Application Server software.)

The Fields To Be Persisted box lists the persistent and relationship fields defined
by the access methods in the PlayerBean.java code. The checkboxes for the
persistent fields must be selected, but those for the relationship fields must not be
selected. The PlayerEJB entity bean has one relationship field: teams.

The abstract schema name is Player, a name that represents the relationships
and persistent fields of the PlayerEJB entity bean. This abstract name is refer-
enced in the PlayerEJB EJB QL queries. For more information on EJB QL, see
Chapter 24.
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Figure 22–5 Entity Tab of PlayerEJB

Finder/Select Methods Dialog Box (PlayerEJB)
To open this dialog box, click Finder/Select Methods on the Entity tab. This dia-
log box (Figure 22–6) enables you to view and edit the EJB QL queries for a
bean’s finder and select methods. For example, to list the finder methods defined
in the LocalPlayerHome interface, select the Local Finders radio button. When
you select the finder method, its EJB QL query appears in an editable text field.
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Figure 22–6 Finder/Select Methods Dialog Box of PlayerEJB

Sun-Specific CMP Settings Dialog Box (PlayerEJB)
To view this dialog box, click Sun-specific CMP Settings in the Entity tab. In this
dialog box, you define the runtime settings of an entity bean with container-man-
aged persistence. These runtime settings are specific to the J2EE Application
Server; other implementations of the J2EE platform may take a different
approach.

In the J2EE Application Server, the bean’s persistent fields are stored in a rela-
tional database table. In the checkboxes of the Database Table box, you specify
whether or not the server automatically creates or drops the table. If you want to
save the data in your table between deployments, then make sure that the Delete
Table checkbox is not selected. Otherwise, every time you undeploy the bean,
the table will be deleted.

The J2EE server accesses the database by issuing SQL calls. In an entity bean
with container-managed persistence, you do not code these calls. The container
creates the SQL calls automatically when you access the persistent fields and
relationships.

In the Persistent Field Mapping section, the mappings and relationships for all
the entity beans in TeamJAR are listed. For example, to see the mappings and
relationships for PlayerEJB, select it from the Enterprise Bean field.
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Figure 22–7 CMP Settings for PlayerEJB.

Primary Keys for Container-Managed
Persistence

Sometimes you must implement the class and package it along with the entity
bean. For example, if your entity bean requires a composite primary key (which
is made up of multiple fields) or a primary key field is a Java programming lan-
guage primitive type, then you need to provide a customized primary key class.
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The Primary Key Class
In the following example, the PurchaseOrderKey class implements a composite
key for the PurchaseOrderEJB entity bean. The key is composed of two fields,
productModel and vendorId, whose names must match two of the persistent
fields in the entity bean class.

public class PurchaseOrderKey implements java.io.Serializable {

public String productModel;
public String vendorId;

public PurchaseOrderKey() { };

public boolean equals(Object other) {

if (other instanceof PurchaseOrderKey) {
return (productModel.equals(

((PurchaseOrderKey)other).productModel) &&
vendorId.equals(
((PurchaseOrderKey)other).vendorId));

}
return false;

}

public int hashCode() {

return productModel.concat(vendorId).hashCode();
}

}

For container-managed persistence, a primary key class must meet the following
requirements:

• The access control modifier of the class is public.

• All fields are declared as public.

• The fields are a subset of the bean’s persistent fields.

• The class has a public default constructor.

• The class implements the hashCode() and equals(Object other) meth-
ods.

• The class is serializable.
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Primary Keys in the Entity Bean Class
In the PurchaseOrderBean class, the following access methods define the per-
sistent fields (vendorId and productModel) that make up the primary key:

public abstract String getVendorId();
public abstract void setVendorId(String id);

public abstract String getProductModel();
public abstract void setProductModel(String name);

The next code sample shows the ejbCreate method of the PurchaseOrderBean

class. The return type of the ejbCreate method is the primary key, but the return
value is null. Although not required, the null return value is recommended for
container-managed persistence. This approach saves overhead because the bean
does not have to instantiate the primary key class for the return value.

public PurchaseOrderKey ejbCreate (String vendorId,
    String productModel, String productName)
    throws CreateException {

setVendorId(vendorId);
    setProductModel(productModel);
    setProductName(productName);

    return null;
}

Generating Primary Key Values
For some entity beans, the value of a primary key has a meaning for the business
entity. For example, in an entity bean that represents a player on a sports team,
the primary key might be the player’s driver’s license number. But for other
beans, the key’s value is arbitrary—provided that it’s unique. With container-
managed persistence, these key values can be generated automatically by the
EJB container. To take advantage of this feature, an entity bean must meet these
requirements:

• In the deployment descriptor, the primary key class is defined as a
java.lang.Object. The primary key field is not specified.

• In the home interface, the argument of the findByPrimaryKey method
must be a java.lang.Object.
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• In the entity bean class, the return type of the ejbCreate method must be
a java.lang.Object.

In these entity beans, the primary key values are in an internal field that only the
EJB container can access. You cannot associate the primary key with a persistent
field or any other instance variable. However, you can fetch the bean’s primary
key by invoking the getPrimaryKey method on the bean reference, and you can
locate the bean by invoking its findByPrimaryKey method.

deploytool Tips for Entity Beans with
Container-Managed Persistence

Chapter 19 covered the basic steps for building and packaging enterprise beans.
This section highlights the tasks in deploytool that are needed for entity beans
with container-managed persistence. The examples referenced in this section are
from A Guided Tour of the RosterApp Settings (page 810).

Selecting the Persistent Fields and
Abstract Schema Name
In the Entity tab of the enterprise bean, enter the field information and the
abstract schema name.

1. In the Fields To Be Persisted list, select the fields that will be saved in the
database. The names of the persistent fields are determined by the access
methods defined in the entity bean code. Be sure to not select container-
managed relationship fields.

2. Enter values in the Primary Key Class and Primary Key Field Name fields.
The primary key uniquely identifies the entity bean.

3. In the Abstract Schema Name field, enter a name that represents the entity
bean. This name will be referenced in the EJB QL queries.

An example is shown in the section Entity Tab (PlayerEJB) (page 816).
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Defining EJB QL Queries for Finder and
Select Methods
You specify these settings in the Finder/Select Methods dialog box.

1. To open the Finder/Select Methods dialog box, go to the Entity tab and
click Finder/Select Methods.

2. To display a set of finder or select methods, click one of the radio buttons
under the Show label.

3. To specify an EJB QL query, choose the name of the finder or select
method from the Method list and then enter the query in the field labeled
EJB QL Query.

An example is shown in the section Finder/Select Methods Dialog Box
(PlayerEJB) (page 817).

Defining Relationships
The Relationships tab enables you to define relationships between entity beans
that reside in the same EJB JAR file.

1. Before you create a relationship between two entity beans, you must first
create both beans with the New Enterprise Bean wizard.

2. To display the Relationships tab, select the EJB JAR in the tree view and
then select the Relationships tab.

3. To add or edit a relationship, go the Relationships tab and click the appro-
priate button.

4. The Add (or Edit) Relationship dialog box appears. (The Add Relationship
and Edit Relationship dialog boxes are identical.)

An example is shown in the section Edit Relationship Dialog Box
(TeamJAR) (page 814).
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Creating the Database Tables at Deploy
Time in deploytool
The RosterApp example used a database schema file to map database tables to
enterprise bean fields. You can alternately have the container create the database
tables at deploy-time by setting some options in deploytool.

1. Select TeamJAR in the tree in deploytool.

2. Select the Relationships tabbed pane.

3. Click Sun-specific Settings.

4. Click Create Field Mappings.

5. Select Automatically Generate Necessary Tables.

6. Click OK.

When you deploy RosterApp, the tables will be created and named according to
the values in the Persistent Field Mappings table.
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A Message-Driven
Bean Example

SINCE message-driven beans are based on the Java Message Service (JMS)
technology, to understand the example in this chapter you should already be
familiar with basic JMS concepts such as queues and messages. To learn about
these concepts, see Chapter 29.

This chapter describes the source code of a simple message-driven bean exam-
ple. Before proceeding, you should read the basic conceptual information in the
section What Is a Message-Driven Bean? (page 674) as well as Using Message-
Driven Beans (page 1037) in Chapter 29.

Example Application Overview
This application has the following components:

• SimpleMessageClient: A J2EE application client that sends several mes-
sages to a queue.

• SimpleMessageEJB: A message-driven bean that asynchronously receives
and processes the messages that are sent to the queue.

Figure 23–1 illustrates the structure of this application. The application client
sends messages to the queue, which was created administratively using the
Admin Console. The JMS provider (in this, case the J2EE server) delivers the
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messages to the instances of the message-driven bean, which then processes the
messages.

Figure 23–1 The SimpleMessageApp Application

The source code for this application is in the <INSTALL>/j2eetutorial14/

examples/ejb/simplemessage directory.

The J2EE Application Client
The SimpleMessageClient sends messages to the queue that the SimpleMes-

sageBean listens to. The client starts out by locating the connection factory and
queue:

connectionFactory =
    (ConnectionFactory) jndiContext.lookup
    ("java:comp/env/jms/MyConnectionFactory");
destination =
    (Queue) jndiContext.lookup("java:comp/env/jms/QueueName");

Next, the client creates the queue connection, session, and sender:

connection = connectionFactory.createConnection();
session = connection.createSession(false,
    Session.AUTO_ACKNOWLEDGE);
messageProducer = session.createProducer(destination);
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Finally, the client sends several messages to the queue:

message = session.createTextMessage();

for (int i = 0; i < NUM_MSGS; i++) {
     message.setText("This is message " + (i + 1));
     System.out.println("Sending message: " +
         message.getText());
     messageProducer.send(message);
}

The Message-Driven Bean Class
The code for the SimpleMessageEJB class illustrates the requirements of a mes-
sage-driven bean class:

• It implements the MessageDrivenBean and MessageListener interfaces.

• The class is defined as public.

• The class cannot be defined as abstract or final.

• It implements one onMessage method.

• It implements one ejbCreate method and one ejbRemove method.

• It contains a public constructor with no arguments.

• It must not define the finalize method.

Unlike session and entity beans, message-driven beans do not have the remote or
local interfaces that define client access. Client components do not locate mes-
sage-driven beans and invoke methods on them. Although message-driven beans
do not have business methods, they may contain helper methods that are invoked
internally by the onMessage method.

The onMessage Method
When the queue receives a message, the EJB container invokes the onMessage

method of the message-driven bean.

The onMessage method is called by the bean’s container when a message has
arrived for the bean to service. This method contains the business logic that han-
dles the processing of the message. It is the message-driven bean’s responsibility
to parse the message and perform the necessary business logic.

The onMessage method has a single argument: the incoming message.
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The message-driven bean class defines one onMessage method, whose signature
must follow these rules:

• The method must be declared as public and must not be declared as final
or static.

• The return type must be void.

• The method must have a single argument of type javax.jms.Message.

• The throws clause must not define any application exceptions.

• The onMessage method is invoked in the scope of a transaction that is
determined by the transaction attribute specified in the deployment
descriptor.

In the SimpleMessageBean class, the onMessage method casts the incoming
message to a TextMessage and displays the text:

public void onMessage(Message inMessage) {
    TextMessage msg = null;

    try {
        if (inMessage instanceof TextMessage) {
            msg = (TextMessage) inMessage;
            System.out.println
                ("MESSAGE BEAN: Message received: " +
                msg.getText());
        } else {
            System.out.println
                ("Message of wrong type: " +
                inMessage.getClass().getName());
        }
    } catch (JMSException e) {
        e.printStackTrace();
        mdc.setRollbackOnly();
    } catch (Throwable te) {
        te.printStackTrace();
    }
}
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The ejbCreate and ejbRemove Methods
The signatures of these methods have the following requirements:

• The access control modifier must be public.

• The return type must be void.

• The modifier cannot be static or final.

• The throws clause must not define any application exceptions.

• The method has no arguments.

In the SimpleMessageBean class, the ejbCreate and ejbRemove methods are
empty.

Deploying and Running
SimpleMessageApp

To deploy and run this example, go to the <INSTALL>/j2eetutorial14/exam-

ples/ejb/simplemessage directory.

Creating the Administered Objects
This example requires the following:

• A JMS connection factory resource

• A JMS destination resource

• A physical destination to which the destination resource refers

If you ran the simple JMS examples in Chapter 29 and did not delete the
resources afterwards, you already have these resources and do not need to per-
form these steps.

To start the Admin Console, follow the instructions in Starting the Admin
Console (page 92).

To create the connection factory, perform the following steps:

1. Expand the Java Message Service node, then click Connection Factories.

2. Click New. The Create JMS Connection Factory screen appears.

3. In the JNDI Name field, type jms/QueueConnectionFactory.



830 A MESSAGE-DRIVEN BEAN EXAMPLE
4. Choose javax.jms.QueueConnectionFactory from the Type menu.

5. Select the Enabled checkbox.

6. Click OK.

To create the physical destination, perform the following steps:

1. In the left-hand pane, click Physical Destinations.

2. Click New. The Create Physical Destination pane appears.

3. In the Physical Destination Name field, type PhysicalQueue.

4. Choose queue from the Type menu.

5. Click OK.

To create the destination resource and link it to the physical destination, perform
the following steps:

1. In the left-hand pane, click Destination Resources.

2. Click New. The Create JMS Destination Resource pane appears.

3. In the JNDI Name field, type jms/Queue.

4. Choose javax.jms.Queue from the Type menu.

5. Select the Enabled checkbox.

6. Under Additional Properties, click Add.

7. Type Name in the Name field.

8. Type PhysicalQueue in the Value field.

9. Click OK.

If you are in a hurry, you can create all the administered objects described in this
section by using the following asant target:

asant create-resources

This target is in the file <INSTALL>/j2eetutorial14/examples/ejb/common/

targets.xml.

Deploying the Application
1. In deploytool, open the SimpleMessageApp.ear file, which resides in

this directory:

<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

2. Deploy the SimpleMessageApp application.



RUNNING THE CLIENT 831
3. In the Deploy Module dialog box,

a. Select the Return Client JAR checkbox.

b. In the field below the check box, enter the following:

<INSTALL>/j2eetutorial14/examples/ejb/simplemessage

Running the Client
After you deploy the application, you run the client as follows:

1. In the directory <INSTALL>/j2eetutorial14/examples/ejb/simple-

message, type the following command on a single line:

appclient -client SimpleMessageAppClient.jar

2. The client displays these lines:

Sending message: This is message 1

Sending message: This is message 2

Sending message: This is message 3

3. In the server log file, the following lines should be displayed:

MESSAGE BEAN: Message received: This is message 1

MESSAGE BEAN: Message received: This is message 2

MESSAGE BEAN: Message received: This is message 3

Removing the Administered Objects
You may use the Admin Console to delete the connection factory and queue after
you run the example. These resources are needed for the JMS examples in Chap-
ters 29 and 30, however, so if you plan to run those examples, do not delete the
resources.

deploytool Tips for Message-Driven
Beans

Chapter 19 covered the basic steps for building and packaging enterprise beans.
This section describes the tasks in deploytool that are necessary for message-
driven beans. To view this example in deploytool, expand the SimpleMessage-
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App node in the tree view, then expand the MDBJAR node and select SimpleMes-
sageBean.

Specifying the Bean’s Type
You specify the type when you create the bean with the New Enterprise Bean
wizard.

1. To start the wizard, select File→New→Enterprise Bean.

2. In the General dialog box of the wizard, choose the enterprise bean class
of the bean, and accept the bean class name (the default) as the display
name. The Enterprise Bean Type appears as Message-Driven by default.

Setting the Message-Driven Bean’s
Characteristics
You may specify these settings in two places:

• The Message-Driven Bean Settings dialog box of the New Enterprise Bean
wizard

• The Message-Driven tab of the bean

These settings are as follows:

1. For the Messaging Service, accept the default, JMS.

2. For the Destination Type, select either javax.jms.Queue or
javax.jms.Topic. A queue uses the point-to-point messaging domain and
may have at most one consumer. A topic uses the publish/subscribe mes-
saging domain; it may have zero, one, or many consumers. For this exam-
ple, you would select javax.jms.Queue.

3. For the Target Destination Name, type the name of the physical destination
that you created administratively. For an example, see the section Creating
the Administered Objects (page 829). The destination is either a queue or
a topic object; it represents the source of incoming messages and the tar-
get of outgoing messages. For this example, you would type Physical-

Queue.

4. If your bean will be a durable subscriber to a topic, select the Durable Sub-
scription checkbox and enter a subscription name. If it uses a message
selector, enter the value in the Message Selector text area. For an example
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that uses these features, see A J2EE Application that Uses the JMS API
with a Session Bean (page 1052). You normally leave the Acknowledge-
ment Mode set to Auto-Acknowledge.

For information on durable subscriptions, see Creating Durable
Subscriptions (page 1023). For information on message selectors, see
Message Selectors (page 993). For information on message acknowledg-
ment, see Controlling Message Acknowledgment (page 1016).

5. In the Connection Factory JNDI Name (Sun-specific Setting) field, type
the JNDI name of the connection factory the bean will use. For this exam-
ple, you would type jms/QueueConnectionFactory.

Use the tabbed panes as follows:

1. Transactions tab of the bean:

a. Select the Container-Managed radio button.

b. Verify that the onMessage method has the Required attribute.

2. Message Destinations tab of the bean JAR file:

a. Click Add.

b. Type the physical destination name (for this example, PhysicalQueue)
in the Destination Name field and press Enter.

c. Type the JNDI name of the destination resource (for this example, jms/
Queue) in the JNDI Name field.

deploytool Tips for Components that
Send Messages

You set resource references and message destination references for any compo-
nent that sends messages: a client, a session or entity bean, or even another mes-
sage-driven bean. For examples, see Chapter 30. In this application, the client is
the sending component. To view this example in deploytool, expand the Sim-

pleMessageApp node, then select SimpleMessageClient from the tree view.



834 A MESSAGE-DRIVEN BEAN EXAMPLE
Setting the Resource References
You use the Resource Refs tabbed pane to specify the connection factory refer-
ences for the component.

1. In the tree view, select the client node.

2. Select the Resource Refs tab.

3. Click Add.

4. In the Coded Name field, enter the name that matches the parameter of the
lookup method in the client’s code. For example, since the lookup param-
eter is java:comp/env/jms/MyConnectionFactory, the Coded Name
should be jms/MyConnectionFactory.

5. In the Type field, select the connection factory class that matches the des-
tination type. The destination class in the code is javax.jms.Connec-

tionFactory, so select that class.

6. In the Authentication field, in most cases you will select Container. You
would select Application if your code explicitly logs on to the messaging
service.

7. In the Sharable field, make sure the checkbox is selected. This choice
allows the container to optimize connections.

8. In the Sun-specific Settings area, enter jms/QueueConnectionFactory in
the JNDI Name field. Enter j2ee in both the User Name and Password
fields.

Setting the Message Destination
References
For any new application, you use the Msg Dest Refs tab to specify the destina-
tion of messages. The Resource Env Refs tab provides similar information, but it
is available primarily for backward compatibility.

1. Select the Msg Dest Refs tab.

2. Click Add.

3. In the Coded Name field of the dialog box that appears, type a name that
matches the parameter of the lookup call that locates the queue or topic.
In this example, the lookup parameter is java:comp/env/jms/Queue-

Name, so the Coded Name is jms/QueueName.
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4. In the Destination Type field, select the class that matches the destination
type (in this case, javax.jms.Queue).

5. From the Usage menu, select either Produces or ConsumesProduces,
depending on whether this component sends messages or both sends and
receives messages. For this example, select Produces.

6. In the Destination Name field, enter the name of the destination you cre-
ated (in this case, PhysicalQueue).

Setting the Message Destinations
When you use the Msg Dest Refs tab, you also use the Message Destinations tab
to link the destination to its JNDI name.

1. Select the Message Destinations tab.

2. Click Add.

3. In the Destination Name field, type the name of the destination (in this
case, PhysicalQueue) and press Return. The name also appears in the Dis-
play Name field. The names of the components that consume and produce
messages for the destination appear in the Producers and Consumers areas.

4. In the JNDI Name field, type the name of the JMS resource you created (in
this case, jms/Queue).

Specifying the JNDI Names
The JNDI name for a message-driven bean is the name of the destination
resource.

1. In the tree view, select the application’s node.

2. Select the JNDI Names tab and enter the appropriate names. For example,
the SimpleMessageApp discussed in this chapter uses the JNDI names
shown in Table 23–1.

Table 23–1 JNDI Names for the SimpleMessageApp Application

Component or Reference Name JNDI Name

SimpleMessageBean jms/Queue

jms/MyConnectionFactory jms/QueueConnectionFactory
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Enterprise JavaBeans
Query Language

THE Enterprise JavaBeans Query Language (EJB QL) defines the queries for
the finder and select methods of an entity bean with container-managed persis-
tence. A subset of SQL92, EJB QL has extensions that allow navigation over the
relationships defined in an entity bean’s abstract schema. The scope of an EJB
QL query spans the abstract schemas of related entity beans that are packaged in
the same EJB JAR file.

You define EJB QL queries in the deployment descriptor of the entity bean. Typ-
ically, a tool will translate these queries into the target language of the underly-
ing data store. Because of this translation, entity beans with container-managed
persistence are portable—their code is not tied to a specific type of data store.

This chapter relies on the material presented in earlier chapters. For conceptual
information, see the section Container-Managed Persistence (page 670). For
code examples, see Chapter 22.
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Terminology
The following list defines some of the terms referred to in this chapter.

• Abstract schema: The part of an entity bean’s deployment descriptor that
defines the bean’s persistent fields and relationships.

• Abstract schema name: A logical name that is referenced in EJB QL que-
ries. You specify an abstract schema name for each entity bean with con-
tainer-managed persistence.

• Abstract schema type: All EJB QL expressions evaluate to a type. If the
expression is an abstract schema name, by default its type is the local inter-
face of the entity bean for which the abstract schema name is defined.

• Backus-Naur Form (BNF): A notation that describes the syntax of high-
level languages. The syntax diagrams in this chapter are in BNF notation.

• Navigation: The traversal of relationships in an EJB QL expression. The
navigation operator is a period.

• Path expression: An expression that navigates to a related entity bean.

• Persistent field: A virtual field of an entity bean with container-managed
persistence; it is stored in a database.

• Relationship field: A virtual field of an entity bean with container-managed
persistence; it identifies a related entity bean.

Simplified Syntax
This section briefly describes the syntax of EJB QL so that you can quickly
move on to the next section, Example Queries. When you are ready to learn
about the syntax in more detail, see the section Full Syntax (page 844).

An EJB QL query has four clauses: SELECT, FROM, WHERE, and ORDER BY. The
SELECT and FROM clauses are required, but the WHERE and ORDER BY clauses
are optional. Here is the high-level BNF syntax of an EJB QL query:

EJB QL ::= select_clause from_clause
[where_clause][orderby_clause]

The SELECT clause defines the types of the objects or values returned by the
query. A return type is either a local interface, a remote interface, or a persistent
field.
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The FROM clause defines the scope of the query by declaring one or more identifi-
cation variables, which may be referenced in the SELECT and WHERE clauses. An
identification variable represents one of the following elements:

• The abstract schema name of an entity bean

• A member of a collection that is the multiple side of a one-to-many rela-
tionship

The WHERE clause is a conditional expression that restricts the objects or values
retrieved by the query. Although optional, most queries have a WHERE clause.

The ORDER BY clause sorts the objects or values returned by the query into a
specified order.

Example Queries
The following queries are from the PlayerEJB entity bean of the RosterApp

J2EE application, which is documented in Chapter 22. To see the relationships
between the beans of the RosterApp, see Figure 22–1 (page 778).

Simple Finder Queries
If you are unfamiliar with EJB QL, these simple queries are a good place to start.

Example 1

SELECT OBJECT(p)
FROM Player p

Data retrieved: All players.

Finder method: findall()

Description: The FROM clause declares an identification variable named p, omit-
ting the optional keyword AS. If the AS keyword were included, the clause would
be written as follows:

FROM Player AS p

The Player element is the abstract schema name of the PlayerEJB entity bean.
Because the bean defines the findall method in the LocalPlayerHome inter-
face, the objects returned by the query have the LocalPlayer type.
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See also: Identification Variables (page 850)

Example 2

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.position = ?1

Data retrieved: The players with the position specified by the finder method’s
parameter.

Finder method: findByPosition(String position)

Description: In a SELECT clause, the OBJECT keyword must precede a stand-
alone identification variable such as p. (A stand-alone identification variable is
not part of a path expression.) The DISTINCT keyword eliminates duplicate val-
ues.

The WHERE clause restricts the players retrieved by checking their position, a
persistent field of the PlayerEJB entity bean. The ?1 element denotes the input
parameter of the findByPosition method.

See also: Input Parameters (page 855), DISTINCT and OBJECT
Keywords (page 864)

Example 3

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.position = ?1 AND p.name = ?2

Data retrieved: The players with the specified position and name.

Finder method: findByPositionAndName(String position, String name)

Description: The position and name elements are persistent fields of the Play-

erEJB entity bean. The WHERE clause compares the values of these fields with the
parameters of the findByPositionAndName method. EJB QL denotes an input
parameter with a question mark followed by an integer. The first input parameter
is ?1, the second is ?2, and so forth.
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Finder Queries That Navigate to Related
Beans
In EJB QL, an expression can traverse—or navigate—to related beans. These
expressions are the primary difference between EJB QL and SQL. EJB QL navi-
gates to related beans, whereas SQL joins tables.

Example 4

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.city = ?1

Data retrieved: The players whose teams belong to the specified city.

Finder method: findByCity(String city)

Description: The FROM clause declares two identification variables: p and t. The
p variable represents the PlayerEJB entity bean, and the t variable represents the
related TeamEJB beans. The declaration for t references the previously declared
p variable. The IN keyword signifies that teams is a collection of related beans.
The p.teams expression navigates from a PlayerEJB bean to its related TeamEJB

beans. The period in the p.teams expression is the navigation operator.

In the WHERE clause, the period preceding the persistent variable city is a delim-
iter, not a navigation operator. Strictly speaking, expressions can navigate to
relationship fields (related beans), but not to persistent fields. To access a persis-
tent field, an expression uses the period as a delimiter.

Expressions may not navigate beyond (or further qualify) relationship fields that
are collections. In the syntax of an expression, a collection-valued field is a ter-
minal symbol. Because the teams field is a collection, the WHERE clause cannot
specify p.teams.city—an illegal expression.

See also: Path Expressions (page 852)

Example 5

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.league = ?1

Data retrieved: The players that belong to the specified league.
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Finder method: findByLeague(LocalLeague league)

Description: The expressions in this query navigate over two relationships. The
p.teams expression navigates the PlayerEJB-TeamEJB relationship, and the
t.league expression navigates the TeamEJB-LeagueEJB relationship.

In the other examples, the input parameters are String objects, but in this exam-
ple the parameter is an object whose type is a LocalLeague interface. This type
matches the league relationship field in the comparison expression of the WHERE

clause.

Example 6

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.league.sport = ?1

Data retrieved: The players who participate in the specified sport.

Finder method: findBySport(String sport)

Description: The sport persistent field belongs to the LeagueEJB bean. To reach
the sport field, the query must first navigate from the PlayerEJB bean to the
TeamEJB bean (p.teams) and then from the TeamEJB bean to the LeagueEJB bean
(t.league). Because the league relationship field is not a collection, it may be
followed by the sport persistent field.

Finder Queries with Other Conditional
Expressions
Every WHERE clause must specify a conditional expression, of which there are
several kinds. In the previous examples, the conditional expressions are compar-
ison expressions that test for equality. The following examples demonstrate
some of the other kinds of conditional expressions. For descriptions of all condi-
tional expressions, see the section WHERE Clause (page 854).

Example 7

SELECT OBJECT(p)
FROM Player p
WHERE p.teams IS EMPTY

Data retrieved: All players who do not belong to a team.
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Finder method: findNotOnTeam()

Description: The teams relationship field of the PlayerEJB bean is a collection.
If a player does not belong to a team, then the teams collection is empty and the
conditional expression is TRUE.

See also: Empty Collection Comparison Expressions (page 859)

Example 8

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.salary BETWEEN ?1 AND ?2

Data retrieved: The players whose salaries fall within the range of the specified
salaries.

Finder method: findBySalaryRange(double low, double high)

Description: This BETWEEN expression has three arithmetic expressions: a persis-
tent field (p.salary) and the two input parameters (?1 and ?2). The following
expression is equivalent to the BETWEEN expression:

p.salary >= ?1 AND p.salary <= ?2

See also: BETWEEN Expressions (page 857)

Example 9

SELECT DISTINCT OBJECT(p1)
FROM Player p1, Player p2
WHERE p1.salary > p2.salary AND p2.name = ?1

Data retrieved: All players whose salaries are higher than the salary of the
player with the specified name.

Finder method: findByHigherSalary(String name)

Description: The FROM clause declares two identification variables (p1 and p2) of
the same type (Player). Two identification variables are needed because the
WHERE clause compares the salary of one player (p2) with that of the other play-
ers (p1).

See also: Identification Variables (page 850)
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Select Queries
The queries in this section are for select methods. Unlike finder methods, a select
method may return persistent fields or other entity beans.

Example 10

SELECT DISTINCT t.league
FROM Player p, IN (p.teams) AS t
WHERE p = ?1

Data retrieved: The leagues to which the specified player belongs.

Select Method: ejbSelectLeagues(LocalPlayer player)

Description: The return type of this query is the abstract schema type of the
LeagueEJB entity bean. This abstract schema type maps to the LocalLeague-

Home interface. Because the expression t.league is not a stand-alone identifica-
tion variable, the OBJECT keyword is omitted.

See also: SELECT Clause (page 862)

Example 11

SELECT DISTINCT t.league.sport
FROM Player p, IN (p.teams) AS t
WHERE p = ?1

Data retrieved: The sports that the specified player participates in.

Select Method: ejbSelectSports(LocalPlayer player)

Description: This query returns a String named sport, which is a persistent
field of the LeagueEJB entity bean.

Full Syntax
This section discusses the EJB QL syntax, as defined in the Enterprise JavaBeans
Specification. Much of the following material paraphrases or directly quotes the
specification.
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BNF Symbols
Table 24–1 describes the BNF symbols used in this chapter.

BNF Grammar of EJB QL
Here is the entire BNF diagram for EJB QL:

EJB QL ::= select_clause from_clause [where_clause]
[orderby_clause]

from_clause ::=FROM identification_variable_declaration
    [, identification_variable_declaration]*

identification_variable_declaration ::=
collection_member_declaration |
    range_variable_declaration

collection_member_declaration ::= IN (
collection_valued_path_expression) [AS ] identifier

range_variable_declaration ::=
    abstract_schema_name [AS ] identifier

Table 24–1 BNF Symbol Summary

Symbol Description

::=
The element to the left of the symbol is defined by the con-
structs on the right.

* The preceding construct may occur zero or more times.

{...} The constructs within the curly braces are grouped together.

[...] The constructs within the square brackets are optional.

| An exclusive OR.

BOLDFACE
A keyword (although capitalized in the BNF diagram, key-
words are not case sensitive).

Whitespace
A whitespace character can be a space, horizontal tab, or line
feed.
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cmp_path_expression ::=
    {identification_variable |
     single_valued_cmr_path_expression}.cmp_field

single_valued_cmr_path_expression ::=
    identification_variable.[single_valued_cmr_field.]*
     single_valued_cmr_field

single_valued_path_expression ::=
    cmp_path_expression | single_valued_cmr_path_expression

collection_valued_path_expression ::=
    identification_variable.[single_valued_cmr_field.]
    *collection_valued_cmr_field

select_clause ::= SELECT [DISTINCT ] {select_expression
    |OBJECT( identification_variable) }

select_expression ::= single_valued_path_expression |
aggregate_select_expression

aggregate_select_expression ::=
    {AVG |MAX |MIN |SUM |COUNT }( [DISTINCT ]
     cmp_path_expression) |

COUNT ( [DISTINCT ] identification_variable |
     single_valued_cmr_path_expression)

where_clause ::= WHERE conditional_expression

conditional_expression ::= conditional_term |
    conditional_expression OR conditional_term

conditional_term ::= conditional_factor |
    conditional_term AND conditional_factor

conditional_factor ::= [NOT ] conditional_primary

conditional_primary ::= simple_cond_expression |
     (conditional_expression)

simple_cond_expression ::=
    comparison_expression | between_expression |
    like_expression | in_expression |
    null_comparison_expression |
    empty_collection_comparison_expression |
    collection_member_expression
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between_expression ::=
    arithmetic_expression [NOT ]BETWEEN
    arithmetic_expression AND arithmetic_expression

in_expression ::=
    cmp_path_expression [NOT ] IN
    ( {literal | input_parameter}
    [, { literal | input_parameter} ]*)

like_expression ::=
    cmp_path_expression [NOT ] LIKE
    pattern_value [ESCAPE escape_character]

null_comparison_expression ::=
    {single_valued_path_expression |
    input_parameter}IS [NOT ] NULL

empty_collection_comparison_expression ::=
    collection_valued_path_expression IS [NOT] EMPTY

collection_member_expression ::=
    {single_valued_cmr_path_expression |
     identification_variable | input_parameter}
    [NOT ] MEMBER [OF ] collection_valued_path_expression

comparison_expression ::=
    string_value comparison_operator string_expression |
    boolean_value {= |<> } boolean_expression} |
    datetime_value comparison_operator datetime_expression |
    entity_bean_value {= |<> } entity_bean_expression |
    arithmetic_value comparison_operator arithmetic_expression

arithmetic_value ::= cmp_path_expression |
     functions_returning_numerics

comparison_operator ::=
    = |> |>= |< |<= |<>

arithmetic_expression ::= arithmetic_term |
    arithmetic_expression {+ |- } arithmetic_term

arithmetic_term ::= arithmetic_factor |
     arithmetic_term {* |/ } arithmetic_factor

arithmetic_factor ::= [{+ |- }] arithmetic_primary

arithmetic_primary ::= cmp_path_expression | literal |
    (arithmetic_expression) | input_parameter |
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    functions_returning_numerics

string_value ::= cmp_path_expression |
     functions_returning_strings

string_expression ::= string_primary | input_parameter

string_primary ::= cmp_path_expression | literal |
    (string_expression) | functions_returning_strings

datetime_value ::= cmp_path_expression

datetime_expression ::= datetime_value | input_parameter

boolean_value ::= cmp_path_expression

boolean_expression ::= cmp_path_expression | literal |
    input_parameter

entity_bean_value ::= single_valued_cmr_path_expression |
    identification_variable

entity_bean_expression ::= entity_bean_value | input_parameter

functions_returning_strings ::=
CONCAT( string_expression, string_expression) |
SUBSTRING( string_expression, arithmetic_expression,

    arithmetic_expression)

functions_returning_numerics ::=
LENGTH( string_expression) |
LOCATE( string_expression, string_expression

    [, arithmetic_expression]) |
ABS( arithmetic_expression) |
SQRT( arithmetic_expression) |
MOD( arithmetic_expression, arithmetic_expression)

orderby_clause ::= ORDER BY orderby_item [, orderby_item]*

orderby_item ::= cmp_path_expression [ASC |DESC ]

FROM Clause
The FROM clause defines the domain of the query by declaring identification vari-
ables. Here is the syntax of the FROM clause:
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from_clause ::= FROM identification_variable_declaration
    [, identification_variable_declaration]*

identification_variable_declaration ::=
    collection_member_declaration |
    range_variable_declaration

collection_member_declaration ::=
    IN (collection_valued_path_expression) [AS] identifier

range_variable_declaration ::=
    abstract_schema_name [AS] identifier

Identifiers
An identifier is a sequence of one or more characters. The first character must be
a valid first character (letter, $, _) in an identifier of the Java programming lan-
guage (hereafter in this chapter called simply “Java”). Each subsequent character
in the sequence must be a valid non-first character (letter, digit, $, _) in a Java
identifier. (For details, see the J2SE API documentation of the isJavaIdentifi-
erStart and isJavaIdentifierPart methods of the Character class.) The
question mark (?) is a reserved character in EJB QL and cannot be used in an
identifier. Unlike a Java variable, an EJB QL identifier is not case sensitive.

An identifier cannot be the same as an EJB QL keyword:

EJB QL keywords are also reserved words in SQL. In the future, the list of EJB
QL keywords may expand to include other reserved SQL words. The Enterprise
JavaBeans Specification recommends that you not use other reserved SQL words
for EJB QL identifiers.

AND
AS
ASC
AVG
BETWEEN
BY
COUNT
DESC
DISTINCT
EMPTY

FALSE
FROM
IN
IS
LIKE
MAX
MEMBER
MIN
MOD
NOT

NULL
OBJECT
OF
OR
ORDER
SELECT
SUM
TRUE
UNKNOWN
WHERE
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Identification Variables
An identification variable is an identifier declared in the FROM clause. Although
the SELECT and WHERE clauses may reference identification variables, they cannot
declare them. All identification variables must be declared in the FROM clause.

Since an identification variable is an identifier, it has the same naming conven-
tions and restrictions as an identifier. For example, an identification variable is
not case sensitive and it cannot be the same as an EJB QL keyword. (See the
previous section for more naming rules.) Also, within a given EJB JAR file, an
identifier name must not match the name of any entity bean or abstract schema.

The FROM clause may contain multiple declarations, separated by commas. A
declaration may reference another identification variable that has been previ-
ously declared (to the left). In the following FROM clause, the variable t refer-
ences the previously declared variable p:

FROM Player p, IN (p.teams) AS t

Even if an identification variable is not used in the WHERE clause, its declaration
can affect the results of the query. For an example, compare the next two queries.
The following query returns all players, whether or not they belong to a team:

SELECT OBJECT(p)
FROM Player p

In contrast, because the next query declares the t identification variable, it
fetches all players that belong to a team:

SELECT OBJECT(p)
FROM Player p, IN (p.teams) AS t

The following query returns the same results as the preceding query, but the
WHERE clause makes it easier to read:

SELECT OBJECT(p)
FROM Player p
WHERE p.teams IS NOT EMPTY

An identification variable always designates a reference to a single value, whose
type is that of the expression used in the declaration. There are two kinds of dec-
larations: range variable and collection member.
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Range Variable Declarations
To declare an identification variable as an abstract schema type, you specify a
range variable declaration. In other words, an identification variable can range
over the abstract schema type of an entity bean. In the following example, an
identification variable named p represents the abstract schema named Player:

FROM Player p

A range variable declaration may include the optional AS operator:

FROM Player AS p

In most cases, to obtain objects a query navigates through the relationships with
path expressions. But for those objects that cannot be obtained by navigation,
you can use a range variable declaration to designate a starting point (or root).

If the query compares multiple values of the same abstract schema type, then the
FROM clause must declare multiple identification variables for the abstract
schema:

FROM Player p1, Player p2

For a sample of such a query, see Example 9 (page 843).

Collection Member Declarations
In a one-to-many relationship, the multiple side consists of a collection of entity
beans. An identification variable may represent a member of this collection. To
access a collection member, the path expression in the variable’s declaration nav-
igates through the relationships in the abstract schema. (For more information on
path expressions, see the following section.) Because a path expression may be
based on another path expression, the navigation can traverse several relation-
ships. See Example 6 (page 842).

A collection member declaration must include the IN operator, but it may omit
the optional AS operator.

In the following example, the entity bean represented by the abstract schema
named Player has a relationship field called teams. The identification variable
called t represents a single member of the teams collection.

FROM Player p, IN (p.teams) AS t
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Path Expressions
Path expressions are important constructs in the syntax of EJB QL, for several
reasons. First, they define navigation paths through the relationships in the
abstract schema. These path definitions affect both the scope and the results of a
query. Second, they may appear in any of the three main clauses of an EJB QL
query (SELECT, WHERE, FROM). Finally, although much of EJB QL is a subset of
SQL, path expressions are extensions not found in SQL.

Syntax
Here is the syntax for path expressions:

cmp_path_expression ::=
    {identification_variable |
     single_valued_cmr_path_expression}.cmp_field

single_valued_cmr_path_expression ::=
    identification_variable.[single_valued_cmr_field.]*
     single_valued_cmr_field

single_valued_path_expression ::=
    cmp_path_expression | single_valued_cmr_path_expression

collection_valued_path_expression ::=
    identification_variable.[single_valued_cmr_field.]
    *collection_valued_cmr_field

In the preceding diagram, the cmp_field element represents a persistent field,
and the cmr_field element designates a relationship field. The term
single_valued qualifies the relationship field as the single side of a one-to-one
or one-to-many relationship; the term collection_valued designates it as the
multiple (collection) side of a relationship. The
single_valued_cmr_path_expression is the abstract schema type of the
related entity bean.

The period (.) in a path expression serves two functions. If a period precedes a
persistent field, it is a delimiter between the field and the identification variable.
If a period precedes a relationship field, it is a navigation operator.
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Examples
In the following query, the WHERE clause contains a cmp_path_expression. The
p is an identification variable, and salary is a persistent field of Player.

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.salary BETWEEN ?1 AND ?2

The WHERE clause of the next example also contains a cmp_path_expression.
The t is an identification variable, league is a single-valued relationship field,
and sport is a persistent field of league.

SELECT DISTINCT OBJECT(p)
FROM Player p, IN (p.teams) AS t
WHERE t.league.sport = ?1

In the next query, the WHERE clause contains a
collection_valued_path_expression. The p is an identification variable, and
teams designates a collection-valued relationship field.

SELECT DISTINCT OBJECT(p)
FROM Player p
WHERE p.teams IS EMPTY

Expression Types
The type of an expression is the type of the object represented by the ending ele-
ment, which can be one of the following:

• Persistent field

• Single-valued relationship field

• Collection-valued relationship field

For example, the type of the expression p.salary is double because the termi-
nating persistent field (salary) is a double.

In the expression p.teams, the terminating element is a collection-valued rela-
tionship field (teams). This expression’s type is a collection of the abstract
schema type named Team. Because Team is the abstract schema name for the
TeamEJB entity bean, this type maps to the bean’s local interface, LocalTeam. For
more information on the type mapping of abstract schemas, see the section
Return Types (page 863).
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Navigation
A path expression enables the query to navigate to related entity beans. The ter-
minating elements of an expression determine whether navigation is allowed. If
an expression contains a single-valued relationship field, the navigation may
continue to an object that is related to the field. However, an expression cannot
navigate beyond a persistent field or a collection-valued relationship field. For
example, the expression p.teams.league.sport is illegal, since teams is a col-
lection-valued relationship field. To reach the sport field, the FROM clause could
define an identification variable named t for the teams field:

FROM Player AS p, IN (p.teams) t
WHERE t.league.sport = 'soccer'

WHERE Clause
The WHERE clause specifies a conditional expression that limits the values
returned by the query. The query returns all corresponding values in the data
store for which the conditional expression is TRUE. Although usually specified,
the WHERE clause is optional. If the WHERE clause is omitted, then the query
returns all values. The high-level syntax for the WHERE clause follows:

where_clause ::= WHERE conditional_expression

Literals
There are three kinds of literals: string, numeric, and boolean.

String Literals
A string literal is enclosed in single quotes:

'Duke'

If a string literal contains a single quote, you indicate the quote with two single
quotes:

'Duke''s'

Like a Java String, a string literal in EJB QL uses the Unicode character encod-
ing.
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Numeric Literals
There are two types of numeric literals: exact and approximate.

An exact numeric literal is a numeric value without a decimal point, such as 65,
−233, +12. Using the Java integer syntax, exact numeric literals support numbers
in the range of a Java long.

An approximate numeric literal is a numeric value in scientific notation, such as
57., −85.7, +2.1. Using the syntax of the Java floating point literal, approximate
numeric literals support numbers in the range of a Java double.

Boolean Literals
A boolean literal is either TRUE or FALSE. These keywords are not case sensitive.

Input Parameters
An input parameter is designated by a question mark (?) followed by an integer.
For example, the first input parameter is ?1, the second is ?2, and so forth.

The following rules apply to input parameters:

• They can be used only in a WHERE clause.

• Their use is restricted to a single-valued path expression within a condi-
tional expression.

• They must be numbered, starting with the integer 1.

• The number of input parameters in the WHERE clause must not exceed the
number of input parameters in the corresponding finder or select method.

• The type of an input parameter in the WHERE clause must match the type of
the corresponding argument in the finder or select method.

Conditional Expressions
A WHERE clause consists of a conditional expression, which is evaluated from left
to right within a precedence level. You may change the order of evaluation with
parentheses.

Here is the syntax of a conditional expression:

conditional_expression ::= conditional_term |
    conditional_expression OR conditional_term

conditional_term ::= conditional_factor |
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    conditional_term AND conditional_factor

conditional_factor ::= [NOT ] conditional_primary

conditional_primary ::= simple_cond_expression |
     (conditional_expression)

simple_cond_expression ::=
    comparison_expression | between_expression |
    like_expression | in_expression |
    null_comparison_expression |
    empty_collection_comparison_expression |
    collection_member_expression

Operators and Their Precedence
Table 24–2 lists the EJB QL operators in order of decreasing precedence.

Table 24–2 EJB QL Operator Precedence

 Type Precedence Order

Navigation . (a period)

Arithmetic + - (unary)
* / (multiplication and division)
+ - (addition and subtraction)

Comparison =
>
>=
<
<=
<> (not equal)

Logical NOT
AND
OR



WHERE CLAUSE 857
BETWEEN Expressions
A BETWEEN expression determines whether an arithmetic expression falls within
a range of values. The syntax of the BETWEEN expression follows:

between_expression ::=
arithmetic_expression [NOT] BETWEEN
arithmetic_expression AND arithmetic_expression

These two expressions are equivalent:

p.age BETWEEN 15 AND 19
p.age >= 15 AND p.age <= 19

The following two expressions are also equivalent:

p.age NOT BETWEEN 15 AND 19
p.age < 15 OR p.age > 19

If an arithmetic expression has a NULL value, then the value of the BETWEEN

expression is unknown.

IN Expressions
An IN expression determines whether or not a string belongs to a set of string lit-
erals. Here is the syntax of the IN expression:

in_expression ::=
    cmp_path_expression [NOT ] IN
    ( {literal | input_parameter}
    [, { literal | input_parameter} ]*)

The path expression must have a string or numeric value. If the path expression
has a NULL value, then the value of the IN expression is unknown.

In the following example, if the country is UK the expression is TRUE. If the coun-
try is Peru it is FALSE.

o.country IN ('UK', 'US', 'France')
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LIKE Expressions
A LIKE expression determines whether a wildcard pattern matches a string. Here
is the syntax:

like_expression ::=
    cmp_path_expression [NOT ] LIKE
    pattern_value [ESCAPE escape_character]

The path expression must have a string or numeric value. If this value is NULL,
then the value of the LIKE expression is unknown. The pattern value is a string
literal that may contain wildcard characters. The underscore (_) wildcard charac-
ter represents any single character. The percent (%) wildcard character represents
zero or more characters. The ESCAPE clause specifies an escape character for the
wildcard characters in the pattern value. Table 24–3 shows some sample LIKE

expressions.

NULL Comparison Expressions
A NULL comparison expression tests whether a single-valued path expression or
an input parameter has a NULL value. Usually, the NULL comparison expression is

Table 24–3 LIKE Expression Examples

 Expression TRUE FALSE

address.phone LIKE '12%3'
'123'
'12993'

'1234'

asentence.word LIKE 'l_se' 'lose' 'loose'

aword.underscored LIKE '\_%’ ESCAPE '\' '_foo' 'bar'

address.phone NOT LIKE '12%3' 1234
'123'
'12993'
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used to test whether or not a single-valued relationship has been set. Here is the
syntax of a NULL comparison expression:

null_comparison_expression ::=
    {single_valued_path_expression |

 input_parameter}IS [NOT ] NULL

Empty Collection Comparison Expressions
An empty collection comparison expression tests whether a collection-valued
path expression has no elements. In other words, it tests whether or not a collec-
tion-valued relationship has been set. Here is the syntax:

empty_collection_comparison_expression ::=
 collection_valued_path_expression IS [NOT] EMPTY

If the collection-valued path expression is NULL, then the empty collection com-
parison expression has a NULL value.

Collection Member Expressions
The collection member expression determines whether a value is a member of a
collection. The value and the collection members must have the same type. The
expression syntax follows:

collection_member_expression ::=
    {single_valued_cmr_path_expression |
    identification_variable | input_parameter}
    [NOT ] MEMBER [OF ] collection_valued_path_expression

If either the collection-valued or single-valued path expression is unknown, then
the collection member expression is unknown. If the collection-valued path
expression designates an empty collection, then the collection member expres-
sion is FALSE.

Functional Expressions
EJB QL includes several string and arithmetic functions, which are listed in the
following tables. In Table 24–4, the start and length arguments are of type
int. They designate positions in the String argument. The first position in a
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string is designated by 1. In Table 24–5, the number argument may be either an
int, a float, or a double.

NULL Values
If the target of a reference is not in the persistent store, then the target is NULL.
For conditional expressions containing NULL, EJB QL uses the semantics defined
by SQL92. Briefly, these semantics are as follows:

• If a comparison or arithmetic operation has an unknown value, it yields a
NULL value.

• Two NULL values are not equal. Comparing two NULL values yields an
unknown value.

• The IS NULL test converts a NULL persistent field or a single-valued rela-
tionship field to TRUE. The IS NOT NULL test converts them to FALSE.

Table 24–4 String Expressions

Function Syntax Return Type

CONCAT(String, String) String

LENGTH(String) int

LOCATE(String, String [, start]) int

SUBSTRING(String, start, length) String

Table 24–5 Arithmetic Expressions

Function Syntax Return Type

ABS(number) int, float, or double

MOD(int, int) int

SQRT(double) double
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• Boolean operators and conditional tests use the three-valued logic defined
by the following tables. (In these tables, T stands for TRUE, F for FALSE,
and U for unknown.)

Equality Semantics
In EJB QL, only values of the same type can be compared. However, this rule
has one exception: Exact and approximate numeric values can be compared. In
such a comparison, the required type conversion adheres to the rules of Java
numeric promotion.

EJB QL treats compared values as if they were Java types, not as if they repre-
sented types in the underlying data store. For example, if a persistent field could
be either an integer or a NULL, then it must be designated as an Integer object,
not as an int primitive. This designation is required because a Java object can be
NULL but a primitive cannot.

Two strings are equal only if they contain the same sequence of characters. Trail-
ing blanks are significant; for example, the strings 'abc' and 'abc ' are not
equal.

Table 24–6 AND Operator Logic

AND T F U

T T F U

F F F F

U U F U

Table 24–7 OR Operator Logic

OR T F U

T T T T

F T F U

U T U U
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Two entity beans of the same abstract schema type are equal only if their primary
keys have the same value.

SELECT Clause
The SELECT clause defines the types of the objects or values returned by the
query. The SELECT clause has the following syntax:

select_clause ::= SELECT [DISTINCT ] {select_expression
    |OBJECT( identification_variable) }

select_expression ::= single_valued_path_expression |
    aggregate_select_expression

aggregate_select_expression ::=
    {AVG |MAX |MIN |SUM |COUNT }( [DISTINCT ]
    cmp_path_expression) |

COUNT ( [DISTINCT ] identification_variable |
    single_valued_cmr_path_expression)

Table 24–8 NOT Operator Logic

NOT

T F

F T

U U

Table 24–9 Conditional Test

Conditional Test T F U

Expression IS TRUE T F F

Expression IS FALSE F T F

Expression is unknown F F T
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Return Types
The return type defined by the SELECT clause must match that of the finder or
select method for which the query is defined.

For finder method queries, the return type of the SELECT clause is the abstract
schema type of the entity bean that defines the finder method. This abstract
schema type maps to either a remote or local interface. If the bean’s remote
home interface defines the finder method, then the return type is the remote inter-
face (or a collection of remote interfaces). Likewise, if the local home interface
defines the finder method, the return type is the local interface (or a collection).
For example, the LocalPlayerHome interface of the PlayerEJB entity bean
defines the findall method:

public Collection findAll() throws FinderException;

The EJB QL query of the findall method returns a collection of LocalPlayer
interface types:

SELECT OBJECT(p)
FROM Player p

For select method queries (except for aggregate function queries), the return type
of the SELECT clause may be one of the following:

• The abstract schema of the entity bean that contains the select method

• The abstract schema of a related entity bean

(By default, each of these abstract schema types maps to the local inter-
face of the entity bean. Although uncommon, in the deployment descrip-
tor you may override the default mapping by specifying a remote
interface.)

• A persistent field

The PlayerEJB entity bean, for example, implements the ejbSelectSports

method, which returns a collection of String objects for sport. The sport is a
persistent field of the LeagueEJB entity bean. See Example 11 (page 844).

A SELECT clause cannot specify a collection-valued expression. For example, the
SELECT clause p.teams is invalid because teams is a collection. However, the
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clause in the following query is valid because the t is a single element of the
teams collection:

SELECT t
FROM Player p, IN (p.teams) AS t

For select method queries with an aggregate function (AVG, COUNT, MAX, MIN,
SUM), in the SELECT clause, the following rules apply:

• The select method must return a single object, primitive, or wrapper type
that is compatible with the standard JDBC conversion mappings for the
persistent field type.

• For the AVG, MAX, MIN, SUM functions, if the select method return type is an
object and the function returns no values, then the select method returns
null. In this case, if the select method return type is a primitive, then the
container throws the ObjectNotFoundException.

• For the COUNT function, the result of the select method must be an exact
numeric type. If the function returns no values, the select method returns 0.

DISTINCT and OBJECT Keywords
The DISTINCT keyword eliminates duplicate return values. If the method of the
query returns a java.util.Collection—which allows duplicates—then you
must specify the DISTINCT keyword to eliminate duplicates. However, if the
method returns a java.util.Set, the DISTINCT keyword is redundant because a
java.util.Set may not contain duplicates.

The OBJECT keyword must precede a stand-alone identification variable, but it
must not precede a single-valued path expression. If an identification variable is
part of a single-valued path expression, it is not stand-alone.

Aggregate Functions
The SELECT clause may contain an aggregate function with the following syntax:

aggregate_select_expression ::=
    {AVG |MAX |MIN |SUM |COUNT }( [DISTINCT ]
    cmp_path_expression) |

COUNT ( [DISTINCT ] identification_variable |
    single_valued_cmr_path_expression)
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Except for the COUNT function, the path expression argument for an aggregate
function must terminate in a persistent field. For the COUNT function, the path
expression argument may terminate in a persistent field, a relationship field, or
an identification variable.

The arguments of the SUM and AVG functions must be numeric. The arguments of
the MAX and MIN functions must be orderable: numeric, string, character, or date.

If the argument is empty, the COUNT function returns 0 and the other aggregate
functions return NULL.

If the DISTINCT keyword is specified, duplicate values are eliminated before the
aggregate function is applied. NULL values are always eliminated before the func-
tion is applied, whether or not the DISTINCT keyword is used.

ORDER BY Clause
As its name suggests, the ORDER BY clause orders the values or objects returned
by the query. The syntax of the clause follows:

orderby_clause ::= ORDER BY orderby_item [, orderby_item]*

orderby_item ::= cmp_path_expression [ASC |DESC ]

If the ORDER BY clause contains multiple orderby_item elements, the left-to-
right sequence of the elements determines the high-to-low precedence.

The ASC keyword specifies ascending order (the default) and the DESC keyword
indicates descending order.

If the ORDER BY clause is used, then the SELECT clause must be one of the follow-
ing:

• An identification variable x, denoted as OBJECT(x)

• A single_valued_cmr_path_expression

• A cmp_path_expression

If the SELECT clause is an identification variable or a
single_valued_cmr_path_expression, the orderby_item must be an order-
able persistent field of the entity bean returned by the SELECT clause. If the
SELECT clause is a cmp_path_expression, the cmp_path_expression and the
orderby_item must evaluate to the same persistent field of the same entity bean.
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EJB QL Restrictions
EJB QL has a few restrictions:

• Comments are not allowed.

• To compare date and time values in an EJB QL query, use long primitives
to represent the values as milliseconds. Do not use the java.util.Date

and java.sql.Time objects in EJB QL comparisons.

• Because support for BigDecimal and BigInteger types is optional for
EJB 2.1 containers, applications that use these types in EJB QL queries
may not be portable.

• Currently, container-managed persistence does not support inheritance.
For this reason, two entity beans of different types cannot be compared.
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Transactions

A typical enterprise application accesses and stores information in one or more
databases. Because this information is critical for business operations, it must be
accurate, current, and reliable. Data integrity would be lost if multiple programs
were allowed to update the same information simultaneously. It would also be
lost if a system that failed while processing a business transaction were to leave
the affected data only partially updated. By preventing both of these scenarios,
software transactions ensure data integrity. Transactions control the concurrent
access of data by multiple programs. In the event of a system failure, transac-
tions make sure that after recovery the data will be in a consistent state.

What Is a Transaction?
To emulate a business transaction, a program may need to perform several steps.
A financial program, for example, might transfer funds from a checking account
to a savings account with the steps listed in the following pseudocode:

begin transaction
   debit checking account
   credit savings account
   update history log
commit transaction

Either all three of these steps must complete, or none of them at all. Otherwise,
data integrity is lost. Because the steps within a transaction are a unified whole, a
transaction is often defined as an indivisible unit of work.
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A transaction can end in two ways: with a commit or a rollback. When a transac-
tion commits, the data modifications made by its statements are saved. If a state-
ment within a transaction fails, the transaction rolls back, undoing the effects of
all statements in the transaction. In the pseudocode, for example, if a disk drive
crashed during the credit step, the transaction would roll back and undo the
data modifications made by the debit statement. Although the transaction
failed, data integrity would be intact because the accounts still balance.

In the preceding pseudocode, the begin and commit statements mark the bound-
aries of the transaction. When designing an enterprise bean, you determine how
the boundaries are set by specifying either container-managed or bean-managed
transactions.

Container-Managed Transactions
In an enterprise bean with container-managed transactions, the EJB container
sets the boundaries of the transactions. You can use container-managed transac-
tions with any type of enterprise bean: session, entity, or message-driven. Con-
tainer-managed transactions simplify development because the enterprise bean
code does not explicitly mark the transaction’s boundaries. The code does not
include statements that begin and end the transaction.

Typically, the container begins a transaction immediately before an enterprise
bean method starts. It commits the transaction just before the method exits. Each
method can be associated with a single transaction. Nested or multiple transac-
tions are not allowed within a method.

Container-managed transactions do not require all methods to be associated with
transactions. When deploying a bean, you specify which of the bean’s methods
are associated with transactions by setting the transaction attributes.

Transaction Attributes
A transaction attribute controls the scope of a transaction. Figure 25–1 illustrates
why controlling the scope is important. In the diagram, method-A begins a trans-
action and then invokes method-B of Bean-2. When method-B executes, does it
run within the scope of the transaction started by method-A or does it execute
with a new transaction? The answer depends on the transaction attribute of
method-B.
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Figure 25–1 Transaction Scope

A transaction attribute may have one of the following values:

• Required

• RequiresNew

• Mandatory

• NotSupported

• Supports

• Never

Required
If the client is running within a transaction and invokes the enterprise bean’s
method, the method executes within the client’s transaction. If the client is not
associated with a transaction, the container starts a new transaction before run-
ning the method.

The Required attribute will work for most transactions. Therefore, you may
want to use it as a default, at least in the early phases of development. Because
transaction attributes are declarative, you can easily change them at a later time.

RequiresNew
If the client is running within a transaction and invokes the enterprise bean’s
method, the container takes the following steps:

1. Suspends the client’s transaction

2. Starts a new transaction

3. Delegates the call to the method
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4. Resumes the client’s transaction after the method completes

If the client is not associated with a transaction, the container starts a new trans-
action before running the method.

You should use the RequiresNew attribute when you want to ensure that the
method always runs within a new transaction.

Mandatory
If the client is running within a transaction and invokes the enterprise bean’s
method, the method executes within the client’s transaction. If the client is not
associated with a transaction, the container throws the TransactionRequire-

dException.

Use the Mandatory attribute if the enterprise bean’s method must use the trans-
action of the client.

NotSupported
If the client is running within a transaction and invokes the enterprise bean’s
method, the container suspends the client’s transaction before invoking the
method. After the method has completed, the container resumes the client’s
transaction.

If the client is not associated with a transaction, the container does not start a
new transaction before running the method.

Use the NotSupported attribute for methods that don’t need transactions.
Because transactions involve overhead, this attribute may improve performance.

Supports
If the client is running within a transaction and invokes the enterprise bean’s
method, the method executes within the client’s transaction. If the client is not
associated with a transaction, the container does not start a new transaction
before running the method.

Because the transactional behavior of the method may vary, you should use the
Supports attribute with caution.



TRANSACTION ATTRIBUTES 871
Never
If the client is running within a transaction and invokes the enterprise bean’s
method, the container throws a RemoteException. If the client is not associated
with a transaction, the container does not start a new transaction before running
the method.

Summary of Transaction Attributes
Table 25–1 summarizes the effects of the transaction attributes. Both the T1 and
T2 transactions are controlled by the container. A T1 transaction is associated
with the client that calls a method in the enterprise bean. In most cases, the client
is another enterprise bean. A T2 transaction is started by the container just before
the method executes.

In the last column of Table 25–1, the word “None” means that the business
method does not execute within a transaction controlled by the container. How-
ever, the database calls in such a business method might be controlled by the
transaction manager of the DBMS.

Setting Transaction Attributes
Because transaction attributes are stored in the deployment descriptor, they can
be changed during several phases of J2EE application development: enterprise
bean creation, application assembly, and deployment. However, it is the respon-
sibility of an enterprise bean developer to specify the attributes when creating
the bean. The attributes should be modified only by an application developer
who is assembling components into larger applications. Do not expect the person
deploying the J2EE application to specify the transaction attributes.

Table 25–1 Transaction Attributes and Scope

Transaction
Attribute

Client’s
Transaction

Business Method’s
Transaction

Required None T2

T1 T1
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You can specify the transaction attributes for the entire enterprise bean or for
individual methods. If you’ve specified one attribute for a method and another
for the bean, the attribute for the method takes precedence. When specifying
attributes for individual methods, the requirements differ with the type of bean.
Session beans need the attributes defined for business methods, but do not allow
them for the create methods. Entity beans require transaction attributes for the
business, create, remove, and finder methods. Message-driven beans require
transaction attributes (either Required or NotSupported) for the onMessage

method.

Rolling Back a Container-Managed
Transaction
There are two ways to roll back a container-managed transaction. First, if a sys-
tem exception is thrown, the container will automatically roll back the transac-
tion. Second, by invoking the setRollbackOnly method of the EJBContext

interface, the bean method instructs the container to roll back the transaction. If

RequiresNew None T2

T1 T2

Mandatory None error

T1 T1

NotSupported None None

T1 None

Supports None None

T1 T1

Never None None

T1 Error

Table 25–1 Transaction Attributes and Scope (Continued)

Transaction
Attribute

Client’s
Transaction

Business Method’s
Transaction
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the bean throws an application exception, the rollback is not automatic, but may
be initiated by a call to setRollbackOnly. For a description of system and appli-
cation exceptions, see deploytool Tips for Entity Beans with Bean-Managed
Persistence (page 776).

The source code for the following example is in the
<INSTALL>/j2eetutorial14/examples/ejb/bank directory.

The transferToSaving method of the BankEJB example illustrates the set-

RollbackOnly method. If a negative checking balance occurs, transferToSav-
ing invokes setRollBackOnly and throws an application exception
(InsufficientBalanceException). The updateChecking and updateSaving

methods update database tables. If the updates fail, these methods throw a
SQLException and the transferToSaving method throws an EJBException.
Because the EJBException is a system exception, it causes the container to auto-
matically roll back the transaction. Here is the code for the transferToSaving

method:

public void transferToSaving(double amount) throws
   InsufficientBalanceException  {

   checkingBalance -= amount;
   savingBalance += amount;

   try {
      updateChecking(checkingBalance);
      if (checkingBalance < 0.00) {
         context.setRollbackOnly();
         throw new InsufficientBalanceException();
      }
      updateSaving(savingBalance);
   } catch (SQLException ex) {
       throw new EJBException
          ("Transaction failed due to SQLException: "
          + ex.getMessage());
   }
}

When the container rolls back a transaction, it always undoes the changes to data
made by SQL calls within the transaction. However, only in entity beans will the
container undo changes made to instance variables. (It does so by automatically
invoking the entity bean’s ejbLoad method, which loads the instance variables
from the database.) When a rollback occurs, a session bean must explicitly reset
any instance variables changed within the transaction. The easiest way to reset a
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session bean’s instance variables is by implementing the SessionSynchroniza-

tion interface.

Synchronizing a Session Bean’s Instance
Variables
The SessionSynchronization interface, which is optional, allows you to syn-
chronize the instance variables with their corresponding values in the database.
The container invokes the SessionSynchronization methods—afterBegin,
beforeCompletion, and afterCompletion—at each of the main stages of a
transaction.

The afterBegin method informs the instance that a new transaction has begun.
The container invokes afterBegin immediately before it invokes the business
method. The afterBegin method is a good place to load the instance variables
from the database. The BankBean class, for example, loads the checkingBal-

ance and savingBalance variables in the afterBegin method:

public void afterBegin() {

   System.out.println("afterBegin()");
   try {
      checkingBalance = selectChecking();
      savingBalance = selectSaving();
   } catch (SQLException ex) {
       throw new EJBException("afterBegin Exception: " +
           ex.getMessage());
   }
}

The container invokes the beforeCompletion method after the business method
has finished, but just before the transaction commits. The beforeCompletion

method is the last opportunity for the session bean to roll back the transaction
(by calling setRollbackOnly). If it hasn’t already updated the database with the
values of the instance variables, the session bean may do so in the beforeCom-

pletion method.

The afterCompletion method indicates that the transaction has completed. It
has a single boolean parameter, whose value is true if the transaction was com-
mitted and false if it was rolled back. If a rollback occurred, the session bean



COMPILING THE BANKEJB EXAMPLE 875
can refresh its instance variables from the database in the afterCompletion

method:

public void afterCompletion(boolean committed) {

   System.out.println("afterCompletion: " + committed);
   if (committed == false) {
      try {
         checkingBalance = selectChecking();
         savingBalance = selectSaving();
      } catch (SQLException ex) {

throw new EJBException("afterCompletion SQLException:
" + ex.getMessage());

      }
   }
}

Compiling the BankEJB Example
To compile the classes and interfaces in the BankEJB example, follow these
steps:

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/bank/

2. Start the PointBase server. For instructions, see Starting the PointBase
Database Server (page 110).

3. Create the database tables and data by typing:

asant create-db_common

4. Type the following command to build the enterprise bean’s classes and
interfaces:

asant build

Packaging the BankEJB Example
The BankEJB session bean uses container-managed transactions. These steps
assume you are familiar with the steps needed to create and deploy an enterprise
application using deploytool, as described in Getting Started With Enterprise
Beans (page 689).
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Creating the J2EE Application
1. Create a new application named BankApp in:

<INSTALL>/j2eetutorial14/examples/ejb/bank/

Packaging the Enterprise Bean
1. Create a new enterprise bean in BankApp by selecting File→New→Enter-

prise Bean.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application.

b. Enter BankJAR under JAR Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/bank/build/.

e. Select Bank.class, BankBean.class, BankHome.class, and Insuffi-

cientBalanceException.class.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select BankBean under Enterprise Bean Class.

b. Enter BankEJB under Enterprise Bean Name.

c. Select Stateful Session under Enterprise Bean Type.

d. Select BankHome under Remote Home Interface.

e. Select Bank under Remote Interface.

f. Select Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point.

5. Click Finish.

6. Select BankEJB in deploytool’s tree.

7. In the Transactions tab:

a. Select Container-Managed under Transaction Management.

b. Verify that getCheckingBalance(), getSavingBalance(), and
transferToSaving() have the Required Transaction Attribute.
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Packaging the J2EE Application Client
1. Createanewapplicationclient inBankAppbyselectingFile→New→Appli-

cation Client.

2. In the JAR File Contents screen:

a. Select BankApp under Create New AppClient Module in Application.

b. Enter BankClient under AppClient Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/bank/build/.

e. Select BankClient.class.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select BankClient under Main Class.

b. Select (Use container-managed authentication) under Callback Handler
Class.

c. Click Next.

4. Click Finish.

Specifying the Application Client’s Enterprise
Bean Reference
When it invokes the lookup method, BankClient refers to the home of an enter-
prise bean:

Object objref =
initial.lookup("java:comp/env/ejb/SimpleBank");

You specify this reference as follows:

1. In the tree, select BankClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field enter ejb/SimpleBank.
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5. In the EJB Type field select Session.

6. In the Interfaces field select Remote.

7. In the Home Interface field enter BankHome.

8. In the Local/Remote Interface field, enter Bank.

9. Click OK.

10.Select the line you just added.

11.Under Sun-specific Settings for ejb/SimpleBank select JNDI Name.

12.In the JNDI Name field select BankEJB.

13.Select File→Save.

Deploying the J2EE Application
1. Select BankApp in deploytool.

2. Select Tools→Deploy.

3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Tell deploytool to create a JAR file that contains the client stubs:

a. Check the Return Client JAR box.

b. In the field below the check box, enter
<INSTALL>/j2eetutorial14/examples/ejb/bank/.

5. Click OK.

6. In the Distribute Module dialog box click Close when the deployment
completes successfully.

Running the J2EE Application Client
1. In a terminal window, go to the <INSTALL>/j2eetutorial14/

examples/ejb/bank/ directory.

2. Type the following command:

appclient -client BankAppClient.jar

In the terminal window, the client displays these lines:

checking: 60.0
saving: 540.0
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Methods Not Allowed in Container-
Managed Transactions
You should not invoke any method that might interfere with the transaction
boundaries set by the container. The list of prohibited methods follows:

• The commit, setAutoCommit, and rollback methods of java.sql.Con-
nection

• The getUserTransaction method of javax.ejb.EJBContext

• Any method of javax.transaction.UserTransaction

You may, however, use these methods to set boundaries in bean-managed trans-
actions.

Bean-Managed Transactions
In a bean-managed transaction, the code in the session or message-driven bean
explicitly marks the boundaries of the transaction. An entity bean cannot have
bean-managed transactions; it must use container-managed transactions instead.
Although beans with container-managed transactions require less coding, they
have one limitation: When a method is executing, it can be associated with either
a single transaction or no transaction at all. If this limitation will make coding
your bean difficult, you should consider using bean-managed transactions.

The following pseudocode illustrates the kind of fine-grained control you can
obtain with bean-managed transactions. By checking various conditions, the
pseudocode decides whether to start or stop different transactions within the
business method.

begin transaction
...
update table-a
...
if (condition-x)
   commit transaction
else if (condition-y)
   update table-b
   commit transaction
else
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   rollback transaction
   begin transaction
   update table-c
   commit transaction

When coding a bean-managed transaction for session or message-driven beans,
you must decide whether to use JDBC or JTA transactions. The sections that fol-
low discuss both types of transactions.

JDBC Transactions
A JDBC transaction is controlled by the transaction manager of the DBMS. You
may want to use JDBC transactions when wrapping legacy code inside a session
bean. To code a JDBC transaction, you invoke the commit and rollback meth-
ods of the java.sql.Connection interface. The beginning of a transaction is
implicit. A transaction begins with the first SQL statement that follows the most
recent commit, rollback, or connect statement. (This rule is generally true, but
may vary with DBMS vendor.)

The source code for the following example is in the
<INSTALL>/j2eetutorial14/examples/ejb/warehouse/ directory.

The following code is from the WarehouseEJB example, a session bean that uses
the Connection interface’s methods to delimit bean-managed transactions. The
ship method starts by invoking setAutoCommit on the Connection object
named con. This invocation tells the DBMS not to automatically commit every
SQL statement. Next, the ship method calls routines that update the order_item
and inventory database tables. If the updates succeed, the transaction is com-
mitted. If an exception is thrown, however, the transaction is rolled back.

public void ship (String productId, String orderId, int
quantity) {

   try {
      makeConnection();
      con.setAutoCommit(false);
      updateOrderItem(productId, orderId);
      updateInventory(productId, quantity);
      con.commit();
   } catch (Exception ex) {
       try {
          con.rollback();
          throw new EJBException("Transaction failed: " +
             ex.getMessage());
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       } catch (SQLException sqx) {
           throw new EJBException("Rollback failed: " +
              sqx.getMessage());
       }
    } finally {
        releaseConnection();
    }
}

Deploying and Running the
WarehouseEJB Example
WarehouseEJB is a session bean that uses a bean-managed, JDBC transactions.
These steps assume you are familiar with the steps needed to create and deploy
an enterprise application using deploytool, as described in Session Bean
Examples (page 709). To deploy and run the example, do the following:

Compiling the WarehouseEJB Example
To compile the classes and interfaces in the WarehouseEJB example, follow
these steps:

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/warehouse/

2. Start the PointBase server. For instructions, see Starting the PointBase
Database Server (page 110).

3. Create the database tables and data by typing:

asant create-db_common

4. Type the following command to build the enterprise bean’s classes and
interfaces:

asant build

Packaging the WarehouseEJB Example
The WarehouseEJB session bean uses bean-managed transactions. These steps
assume you are familiar with the steps needed to create and deploy an enterprise
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application using deploytool, as described in Getting Started With Enterprise
Beans (page 689).

Creating the J2EE Application
1. Create a new application named WarehouseApp in:

<INSTALL>/j2eetutorial14/examples/ejb/warehouse/

Packaging the Enterprise Bean
1. Create a new enterprise bean in WarehouseApp by selecting File→New→

Enterprise Bean.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application.

b. Enter WarehouseJAR under JAR Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/warehouse/.

e. Select Warehouse.class, WarehouseBean.class, and Warehouse-

Home.class.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select WarehouseBean under Enterprise Bean Class.

b. Enter WarehouseEJB under Enterprise Bean Name.

c. Select Stateful Session under Enterprise Bean Type.

d. Select WarehouseHome under Remote Home Interface.

e. Select Warehouse under Remote Interface.

f. Select Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point.

5. Click Finish.

6. Select WarehouseEJB in deploytool’s tree.

7. In the Transactions tab:
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g. Select Bean-Managed under Transaction Management.

8. In the Resource Refs tab:

a. Click Add.

b. Double-click the Coded Name column for the row that was just created.

c. Enter jdbc/WarehouseDB.

d. Under Sun-specific Settings for jdbc/WarehouseDB in the JNDI Name
field select jdbc/ejbTutorialDB.

Packaging the J2EE Application Client
1. Create a new application client in WarehouseApp by selecting

File→New→Application Client.

2. In the JAR File Contents screen:

a. Select WarehouseApp under Create New AppClient Module in Appli-
cation.

b. Enter WarehouseClient under AppClient Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/exam-

ples/ejb/warehouse/.

e. Select WarehouseClient.class.

f. Click Add.

g. Click OK.

h. Click Next.

3. In the General screen:

a. Select WarehouseClient under Main Class.

b. Select (Use container-managed authentication) under Callback Handler
Class.

c. Click Next.

4. Click Finish.
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Specifying the Application Client’s Enterprise
Bean Reference
When it invokes the lookup method, WarehouseClient refers to the home of an
enterprise bean:

Object objref =
initial.lookup("java:comp/env/ejb/SimpleWarehouse");

You specify this reference as follows:

1. In the tree, select WarehouseClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field enter ejb/SimpleWarehouse.

5. In the EJB Type field select Session.

6. In the Interfaces field select Remote.

7. In the Home Interface field enter WarehouseHome.

8. In the Local/Remote Interface field, enter Warehouse.

9. Click OK.

10.Select the line you just added.

11.Under Sun-specific Settings for ejb/SimpleWarehouse select JNDI
Name.

12.In the JNDI Name field select WarehouseEJB.

13.Select File→Save.

Deploying the J2EE Application
1. Select WarehouseApp in deploytool.

2. Select Tools→Deploy.

3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Tell deploytool to create a JAR file that contains the client stubs:

a. Check the Return Client JAR box.

b. In the field below the check box, enter
<INSTALL>/j2eetutorial14/examples/ejb/warehouse/.
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5. Click OK.

6. In the Distribute Module dialog box click Close when the deployment
completes successfully.

Running the J2EE Application Client
1. In a terminal window, go to the <INSTALL>/j2eetutorial14/

examples/ejb/warehouse/ directory.

2. Type the following command:

appclient -client WarehouseAppClient.jar

In the terminal window, the client displays these lines:

status = shipped

JTA Transactions
JTA is the abbreviation for the Java Transaction API. This API allows you to
demarcate transactions in a manner that is independent of the transaction man-
ager implementation. The J2EE Application Server implements the transaction
manager with the Java Transaction Service (“JTS”). But your code doesn’t call
the JTS methods directly. Instead, it invokes the JTA methods, which then call
the lower-level JTS routines.

A JTA transaction is controlled by the J2EE transaction manager. You may want
to use a JTA transaction because it can span updates to multiple databases from
different vendors. A particular DBMS’s transaction manager may not work with
heterogeneous databases. However, the J2EE transaction manager does have one
limitation—it does not support nested transactions. In other words, it cannot start
a transaction for an instance until the previous transaction has ended.

The source code for the following example is in the
<INSTALL>/j2eetutorial14/examples/ejb/teller/ directory.

To demarcate a JTA transaction, you invoke the begin, commit, and rollback

methods of the javax.transaction.UserTransaction interface. The follow-
ing code, taken from the TellerBean class, demonstrates the UserTransaction

methods. The begin and commit invocations delimit the updates to the database.
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If the updates fail, the code invokes the rollback method and throws an EJBEx-

ception.

public void withdrawCash(double amount) {

   UserTransaction ut = context.getUserTransaction();

   try {
      ut.begin();
      updateChecking(amount);
      machineBalance -= amount;
      insertMachine(machineBalance);
      ut.commit();
   } catch (Exception ex) {
       try {
          ut.rollback();
       } catch (SystemException syex) {
           throw new EJBException
              ("Rollback failed: " + syex.getMessage());
       }
       throw new EJBException
          ("Transaction failed: " + ex.getMessage());
    }
}

Deploying and Running the TellerEJB
Example
The TellerEJB session bean uses bean-managed, JTA transactions. These steps
assume you are familiar with the steps needed to create and deploy an enterprise
application using deploytool, as described in Session Bean
Examples (page 709). To deploy and run the TellerEJB example, perform these
steps:

Compiling the TellerEJB Example
To compile the classes and interfaces in the TellerEJB example, follow these
steps:

1. In a terminal window, go to this directory:

<INSTALL>/j2eetutorial14/examples/ejb/teller/
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2. Start the PointBase server. For instructions, see Starting the PointBase
Database Server (page 110).

3. Create the database tables and data by typing:

asant create-db_common

4. Type the following command to build the enterprise bean’s classes and
interfaces:

asant build

Packaging the TellerEJB Example
The TellerEJB session bean uses JTA transactions. These steps assume you are
familiar with the steps needed to create and deploy an enterprise application
using deploytool, as described in Getting Started With Enterprise
Beans (page 689).

Creating the J2EE Application
1. Create a new application named TellerApp in:

<INSTALL>/j2eetutorial14/examples/ejb/teller/

Packaging the Enterprise Bean
1. Create a new enterprise bean in TellerApp by selecting File→New→ Enter-

prise Bean.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application.

b. Enter TellerJAR under JAR Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/examples/ejb/teller/.

e. Select Teller.class, TellerBean.class, and TellerHome.class.

f. Click Add.

g. Click OK.

h. Click Next.
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3. In the General screen:

a. Select TellerBean under Enterprise Bean Class.

b. Enter TellerEJB under Enterprise Bean Name.

c. Select Stateful Session under Enterprise Bean Type.

d. Select TellerHome under Remote Home Interface.

e. Select Teller under Remote Interface.

f. Select Next.

4. In the Configuration Options screen, select No under Expose Bean as Web
Service End Point.

5. Click Finish.

6. Select TellerEJB in deploytool’s tree.

7. In the Transactions tab:

g. Select Bean-Managed under Transaction Management.

8. In the Resource Refs tab:

a. Click Add.

b. Double-click the Coded Name column for the row that was just created.

c. Enter jdbc/TellerDB.

d. Under Sun-specific Settings for jdbc/TellerDB in the JNDI Name field
select jdbc/ejbTutorialDB.

Packaging the J2EE Application Client
1. Create a new application client in TellerApp by selecting File→New→Ap-

plication Client.

2. In the JAR File Contents screen:

a. Select TellerApp under Create New AppClient Module in Application.

b. Enter TellerClient under AppClient Name.

c. Click Edit.

d. Navigate to <INSTALL>/j2eetutorial14/examples/ejb/teller/.

e. Select TellerClient.class.

f. Click Add.

g. Click OK.

h. Click Next.
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3. In the General screen:

a. Select TellerClient under Main Class.

b. Select (Use container-managed authentication) under Callback Handler
Class.

c. Click Next.

4. Click Finish.

Specifying the Application Client’s Enterprise
Bean Reference
When it invokes the lookup method, TellerClient refers to the home of an
enterprise bean:

Object objref =
initial.lookup("java:comp/env/ejb/SimpleTeller");

You specify this reference as follows:

1. In the tree, select TellerClient.

2. Select the EJB Refs tab.

3. Click Add.

4. In the Coded Name field enter ejb/SimpleTeller.

5. In the EJB Type field select Session.

6. In the Interfaces field select Remote.

7. In the Home Interface field enter TellerHome.

8. In the Local/Remote Interface field, enter Teller.

9. Click OK.

10.Select the line you just added.

11.Under Sun-specific Settings for ejb/SimpleTeller select JNDI Name.

12.In the JNDI Name field select TellerEJB.

13.Select File→Save.

Deploying the J2EE Application
1. Select TellerApp in deploytool.

2. Select Tools→Deploy.
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3. Under Connection Settings, enter the user name and password for the J2EE
application server.

4. Tell deploytool to create a JAR file that contains the client stubs:

a. Check the Return Client JAR box.

b. In the field below the check box, enter
<INSTALL>/j2eetutorial14/examples/ejb/teller/.

5. Click OK.

6. In the Distribute Module dialog box click Close when the deployment
completes successfully.

Running the J2EE Application Client
1. In a terminal window, go to the <INSTALL>/j2eetutorial14/

examples/ejb/teller/ directory.

2. Type the following command:

appclient -client TellerAppClient.jar

In the terminal window, the client displays these lines:

checking = 500.0
checking = 440.0

Returning without Committing
In a stateless session bean with bean-managed transactions, a business method
must commit or roll back a transaction before returning. However, a stateful ses-
sion bean does not have this restriction.

In a stateful session bean with a JTA transaction, the association between the
bean instance and the transaction is retained across multiple client calls. Even if
each business method called by the client opens and closes the database connec-
tion, the association is retained until the instance completes the transaction.

In a stateful session bean with a JDBC transaction, the JDBC connection retains
the association between the bean instance and the transaction across multiple
calls. If the connection is closed, the association is not retained.
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Methods Not Allowed in Bean-Managed
Transactions
Do not invoke the getRollbackOnly and setRollbackOnly methods of the
EJBContext interface in bean-managed transactions. These methods should be
used only in container-managed transactions. For bean-managed transactions,
invoke the getStatus and rollback methods of the UserTransaction inter-
face.

Summary of Transaction Options for
Enterprise Beans

If you’re unsure about how to set up transactions in an enterprise bean, here’s a
tip: In the bean’s deployment descriptor, specify container-managed transac-
tions. Then, set the Required transaction attribute for the entire bean. This
approach will work most of the time.

Table 25–2 lists the types of transactions that are allowed for the different types
of enterprise beans. An entity bean must use container-managed transactions.
With container-managed transactions, you specify the transaction attributes in
the deployment descriptor and you roll back a transaction with the setRoll-

backOnly method of the EJBContext interface.

A session bean may have either container-managed or bean-managed transac-
tions. There are two types of bean-managed transactions: JDBC and JTA trans-
actions. You delimit JDBC transactions with the commit and rollback methods

Table 25–2 Allowed Transaction Types for Enterprise Beans

Bean Type Container-Managed

Bean-Managed

JTA JDBC

Entity Y N N

Session Y Y Y

Message-driven Y Y Y
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of the Connection interface. To demarcate JTA transactions, you invoke the
begin, commit, and rollback methods of the UserTransaction interface.

In a session bean with bean-managed transactions, it is possible to mix JDBC
and JTA transactions. This practice is not recommended, however, because it
could make your code difficult to debug and maintain.

Like a session bean, a message-driven bean may have either container-managed
or bean-managed transactions.

Transaction Timeouts
For container-managed transactions, you control the transaction timeout interval
by setting the value of the timeout-in-seconds property in the domain.xml

file, which is in the config directory of your J2EE Application Server installa-
tion. For example, you would set the timeout value to 5 seconds as follows:

timeout-in-seconds=5

With this setting, if the transaction has not completed within 5 seconds, the EJB
container rolls it back.

When the J2EE application server is first installed, the timeout value is set to 0:

transaction.timeout=0

If the value is 0, the transaction will not time out.

Only enterprise beans with container-managed transactions are affected by the
transaction.timeout property. For enterprise beans with bean-managed JTA
transactions, you invoke the setTransactionTimeout method of the User-

Transaction interface.

Isolation Levels
Transactions not only ensure the full completion (or rollback) of the statements
that they enclose but also isolate the data modified by the statements. The
isolation level describes the degree to which the data being updated is visible to
other transactions.
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Suppose that a transaction in one program updates a customer’s phone number,
but before the transaction commits another program reads the same phone num-
ber. Will the second program read the updated and uncommitted phone number
or will it read the old one? The answer depends on the isolation level of the trans-
action. If the transaction allows other programs to read uncommitted data, per-
formance may improve because the other programs don’t have to wait until the
transaction ends. But there’s a trade-off—if the transaction rolls back, another
program might read the wrong data.

For entity beans with container-managed persistence, you can change the isola-
tion level by editing the consistency element in the sun-cmp-mapping.xml

file. These beans use the default isolation level of the DBMS, which is usually
READ_COMMITTED.

For entity beans with bean-managed persistence and for all session beans, you
can set the isolation level programmatically with the API provided by the under-
lying DBMS. A DBMS, for example, might allow you to permit uncommitted
reads by invoking the setTransactionIsolation method:

Connection con;
...
con.setTransactionIsolation(TRANSACTION_READ_UNCOMMITTED);

Do not change the isolation level in the middle of a transaction. Usually, such a
change causes the DBMS software to issue an implicit commit. Because the iso-
lation levels offered by DBMS vendors may vary, you should check the DBMS
documentation for more information. Isolation levels are not standardized for the
J2EE platform.

Updating Multiple Databases
The J2EE transaction manager controls all enterprise bean transactions except
for bean-managed JDBC transactions. The J2EE transaction manager allows an
enterprise bean to update multiple databases within a transaction. The figures
that follow show two scenarios for updating multiple databases in a single trans-
action.

In Figure 25–2, the client invokes a business method in Bean-A. The business
method begins a transaction, updates Database X, updates Database Y, and
invokes a business method in Bean-B. The second business method updates
Database Z and returns control to the business method in Bean-A, which com-
mits the transaction. All three database updates occur in the same transaction.
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Figure 25–2 Updating Multiple Databases

In Figure 25–3, the client calls a business method in Bean-A, which begins a
transaction and updates Database X. Then, Bean-A invokes a method in Bean-B,
which resides in a remote J2EE server. The method in Bean-B updates Database
Y. The transaction managers of the J2EE servers ensure that both databases are
updated in the same transaction.

Figure 25–3 Updating Multiple Databases across J2EE Servers
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Transactions in Web Components
You may demarcate a transaction in a Web component with either the
java.sql.Connection or javax.transaction.UserTransaction interface.
These are the same interfaces that a session bean with bean-managed transac-
tions may use. Transactions demarcated with the Connection interface are dis-
cussed in the section JDBC Transactions (page 880) and those with the
UserTransaction interface are discussed in the section JTA
Transactions (page 885). For an example of a Web component using transac-
tions, see Accessing Databases (page 467).
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Resource
Connections

BOTH enterprise beans and Web components can access a wide variety of
resources, including databases, mail sessions, Java Message Service objects,
JAXR connection factories, and URLs. The J2EE platform provides mechanisms
that allow you to access all of these resources in a similar manner. This chapter
describes how to get connections to several types of resources. Although the
code samples in this chapter are from enterprise beans, they will also work in
Web components.

JNDI Naming
In a distributed application, components need to access other components and
resources such as databases. For example, a servlet might invoke remote meth-
ods on an enterprise bean that retrieves information from a database. In the J2EE
platform, the Java Naming and Directory Interface (JNDI) naming service
enables components to locate other components and resources. To locate a JDBC
resource, for example, an enterprise bean invokes the JNDI lookup method. The
JNDI naming service maintains a set of bindings that relate names to objects.
The lookup method passes a JNDI name parameter and returns the related
object.
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For detailed information about JNDI, see the JNDI Tutorial:

http://java.sun.com/products/jndi/tutorial

JNDI provides a naming context, which is a a set of name-to-object bindings. All
naming operations are relative to a context. A name that is bound within a con-
text is the JNDI name of the object. In Specifying a Resource
Reference (page 901), for example, the JNDI name for the JDBC resource (or
data source) is jdbc/ejbTutorialDB. A Context object provides the methods
for binding names to objects, unbinding names from objects, renaming objects,
and listing the bindings. JNDI also provides subcontext functionality. Much like
a directory in a file system, a subcontext is a context within a context. This hier-
archical structure permits better organization of information. For naming ser-
vices that support subcontexts, the Context class also provides methods for
creating and destroying subcontexts. Table 26–1 describes JNDI subcontexts for
connection factories in the J2EE Application Server.

Note: To avoid collisions with names of other enterprise resources in JNDI, and to
avoid portability problems, all names in a J2EE Application Server application
should begin with the string java:comp/env.

Table 26–1 JNDI Subcontexts for Connection Factories

Resource
Manager
Type Connection Factory Type JNDI Subcontext

JDBC javax.sql.DataSource java:comp/env/jdbc

JMS
javax.jms.TopicConnectionFactory
javax.jms.QueueConnectionFactory

java:comp/env/jms

JavaMail javax.mail.Session java:comp/env/mail

URL java.net.URL java:comp/env/url

Connector javax.resource.cci.ConnectionFactory java:comp/env/eis

JAXR
Resource
Adapter

javax.xml.registry.ConnectionFactory
java:comp/env/eis/
JAXR

http://java.sun.com/products/jndi/tutorial
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DataSource Objects and Connection
Pools

To store, organize, and retrieve data, most applications use a relational database.
J2EE components access relational databases through the JDBC 2.0 API. For
information on this API, see the JDBC Tutorial:

http://java.sun.com/docs/books/tutorial/jdbc

In the JDBC API, databases are accessed via DataSource objects. A Data-

Source has a set of properties that identify and describe the real world data
source that it represents. These properties include information like the location
of the database server, the name of the database, the network protocol to use to
communicate with the server, and so on. A data source is sometimes referred to
as a JDBC resource.

Applications access a data source using a connection, and a DataSource object
can be thought of as a factory for connections to the particular data source that
the DataSource instance represents. In a basic DataSource implementation, a
call to the method DataSource.getConnection returns a connection object that
is a physical connection to the data source.

If a DataSource object is registered with a JNDI naming service, an application
can use the JNDI API to access that DataSource object, which can then be used
to connect to the data source it represents.

DataSource objects that implement connection pooling also produce a connec-
tion to the particular data source that the DataSource class represents. The con-
nection object that the method DataSource.getConnection returns is a handle
to a PooledConnection object rather than being a physical connection. An
application uses the connection object like any other connection. Connection
pooling has no effect on application code except that a pooled connection, like
all connections, should always be explicitly closed. When an application closes a
connection that is pooled, the connection is returned to a pool of reusable con-
nections. The next time DataSource.getConnection is called, a handle to one
of these pooled connections will be returned if one is available. Because connec-
tion pooling avoids creating a new physical connection every time one is
requested, it can help applications run significantly faster.

The installation process of the J2EE Application Server automatically creates a
connection pool named PointBasePool. In this book, all of the code examples

http://java.sun.com/docs/books/tutorial/jdbc
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that access a database use DataSource objects that are mapped to PointBase-

Pool.

Database Connections
The J2EE Application Server ships with a relational database product named
PointBase. The following material shows how the SavingsAccountEJB example
of Chapter 21 accesses a PointBase database. The SavingsAccountEJB compo-
nent is an entity bean with bean-managed persistence.

Session beans and Web components will use the same approach as SavingsAc-
countEJB to access a database. (Entity beans with container-managed persis-
tence are different. See Chapter 22.)

Coding a Database Connection
For the SavingsAccountEJB example, the code that connects to the database is
in the entity bean implementation class, SavingsAccountBean. The source code
for this class is in this directory:

<INSTALL>/j2eetutorial14/ejb/savingsaccount/src/

The bean connects to the database in three steps:

1. Specify the logical name of the database.
private String dbName

= "java:comp/env/jdbc/SavingsAccountDB";

The java:comp/env portion of the logical name is the environment nam-
ing context of the component. The jdbc/SavingsAccountDB string is the
resource reference name (sometimes referred to as the coded name). In
deploytool, you specify the resource reference name and then map it to
the JNDI name of the DataSource object.

2. Obtain the DataSource object associated with the logical name.
InitialContext ic = new InitialContext();
DataSource ds = (DataSource) ic.lookup(dbName);

Given the logical name for the resource, the lookup method returns the
DataSource object that is bound to the JNDI name in the directory.

3. Get the Connection object from the DataSource object.
Connection con = ds.getConnection();
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Defining a Data Source in the J2EE
Application Server
In the previous section, you mapped the resource reference to the JNDI name of
the data source. The deploytool utility stores this mapping information in a
deployment descriptor of SavingsAccountEJB. In addition to setting the bean’s
deployment descriptor, you also need to define the data source in the J2EE
Application Server. You can define a data source with the Admin Console.

To create the data source with the Admin Console, follow this procedure:

1. Open the URL http://localhost:4848/asadmin in a browser.

2. Expand the JDBC node.

3. Select the JDBC Resources node.

4. Click New.

5. Type jdbc/ejbTutorialDB for the JNDI Name.

6. Choose PointBasePool for the Pool Name.

7. Click OK.

8. Note that jdbc/ejbTutorialDB is listed under the JDBC Resources node.

Specifying a Resource Reference
The application for the SavingAccountEJB example is in the SavingsAccoun-

tApp.ear file, which is in this directory:

<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

For your convenience, the resource reference and JNDI names in SavingsAc-

countApp.ear have already been configured in deploytool. However, you may
find it instructive to open SavingsAccountApp.ear in deploytool and follow
these steps for specifying the resource reference.

1. In deploytool, select SavingsAccountEJB from the tree.

2. Select the Resource Refs tab.

3. Click Add.

4. In the Coded Name field, enter jdbc/SavingsAccountDB.

5. In the Type combo box, select javax.sql.DataSource.

6. In the Authentication combo box, select Container.
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7. If you want other enterprise beans to share the connections acquired from
the DataSource, select the Sharable checkbox.

8. To map the resource reference to the data source, enter jdbc/ejbTutori-
alDB in the JNDI Name field.

If the preceding steps are followed, the Resource Refs tab will appear as shown
in Figure 26–1.

Figure 26–1 Resource Refs Tabbed Pane of SavingsAccountEJB
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Mail Session Connections
If you’ve ever ordered a product from a Web site, you’ve probably received an e-
mail confirming your order. The ConfirmerBean class demonstrates how to send
e-mail from an enterprise bean.

The source code for this example is in this directory:

<INSTALL>/j2eetutorial14/ejb/confirmer/src/

In the sendNotice method of the ConfirmerBean class, the lookup method
returns a Session object, which represents a mail session. Like a database con-
nection, a mail session is a resource. As with any resource, you must link the
coded name (mail/TheMailSession) with a JNDI name. Using the Session

object as an argument, the sendNotice method creates an empty Message

object. After calling several set methods on the Message object, sendNotice
invokes the send method of the Transport class to send the message on its way.
The source code for the sendNotice method follows.

public void sendNotice(String recipient) {

   try {
       Context initial = new InitialContext();
       Session session =
         (Session) initial.lookup(
         "java:comp/env/mail/TheMailSession");

       Message msg = new MimeMessage(session);
       msg.setFrom();

       msg.setRecipients(Message.RecipientType.TO,
          InternetAddress.parse(recipient, false));

       msg.setSubject("Test Message from ConfirmerBean");

       DateFormat dateFormatter =
         DateFormat.getDateTimeInstance(
         DateFormat.LONG, DateFormat.SHORT);

       Date timeStamp = new Date();

String messageText = "Thank you for your order." + '\n' +
          "We received your order on " +
          dateFormatter.format(timeStamp) + ".";



904 RESOURCE CONNECTIONS
       msg.setText(messageText);
       msg.setHeader("X-Mailer", mailer);
       msg.setSentDate(timeStamp);

       Transport.send(msg);

   } catch(Exception e) {
       throw new EJBException(e.getMessage());
   }
}

Running the ConfirmerEJB Example

Setting Up the JavaMail Resource
To create a JavaMail resource in the J2EE Application Server with the Admin
Console, follow these steps:

1. Open the URL http://localhost:4848/asadmin in a browser.

2. Select the Java Mail Sessions node.

3. Click New.

4. Type mail/MySession for the JNDI Name.

5. Type the name of the host running your mail server for the Mail Host.

6. Type the destination email address for Default User.

7. Type your email address for the Default Return Address.

8. Click OK.

9. Note that mail/MySession is listed under the Java Mail Sessions node.

Deploying the Application
1. In deploytool, open the ConfirmerApp.ear file, which resides in this

directory:
<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

2. Verify the resource reference.

a. In the tree, expand the ConfirmerApp node.

b. Select the ConfirmerEJB node.

c. Select the Resource Refs tab.
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d. Note the JavaMail resource reference for mail/TheMailSession.

3. Verify the mapping of the reference to the JNDI name.

a. In the tree, select the ConfirmerApp node.

b. Select the JNDI Names tab.

c. Note the mapping of mail/TheMailSession (coded in Confirmer-

Bean.java) to mail/MySession (specified in build.properties).

4. Deploy the ConfirmerApp Application.

5. In the Deploy Module dialog box, do the following:

a. Select the Return Client JAR checkbox.

b. In the field below the check box, enter the following:

<INSTALL>/j2eetutorial14/examples/ejb/confirmer

Running the Client
To run the SavingsAccountClient program, do the following:

1. In a terminal window, go to this directory:
<INSTALL>/j2eetutorial14/examples/ejb/confirmer/

2. Type the following command on a single line:
appclient -client ConfirmerAppClient.jar your_email_address

3. The client should display the following lines:

...
Sending email to . . .
...

To modify this example, see the instructions in Modifying the J2EE
Application (page 707)

URL Connections
A Uniform Resource Locator (URL) specifies the location of a resource on the
Web. The HTMLReaderBean class shows how to connect to a URL from within an
enterprise bean.

The source code for this example is in this directory:

<INSTALL>/j2eetutorial14/ejb/htmlreader/src/
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The getContents method of the HTMLReaderBean class returns a String that
contains the contents of an HTML file. This method looks up the java.net.URL

object associated with a coded name (url/MyURL), opens a connection to it, and
then reads its contents from an InputStream. Here is the source code for the
getContents method.

public StringBuffer getContents() throws HTTPResponseException
{

   Context context;
   URL url;
   StringBuffer buffer;
   String line;
   int responseCode;
   HttpURLConnection connection;
   InputStream input;
   BufferedReader dataInput;

   try {
      context = new InitialContext();
      url = (URL)context.lookup("java:comp/env/url/MyURL");
      connection = (HttpURLConnection)url.openConnection();
      responseCode = connection.getResponseCode();
   } catch (Exception ex) {
       throw new EJBException(ex.getMessage());
   }

   if (responseCode != HttpURLConnection.HTTP_OK) {
throw new HTTPResponseException("HTTP response code: " +

         String.valueOf(responseCode));
   }

   try {
      buffer = new StringBuffer();
      input = connection.getInputStream();
      dataInput =

new BufferedReader(new InputStreamReader(input));
      while ((line = dataInput.readLine()) != null) {
         buffer.append(line);
         buffer.append('\n’);
      }
   } catch (Exception ex) {
       throw new EJBException(ex.getMessage());
   }
   return buffer;
}
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Running the HTMLReaderEJB Example
The coded name (url/MyURL) must be mapped to a JNDI name (a URL string).
In the provided HTMLReaderApp application, the mapping has already been spec-
ified. The next section shows you how to verify the mapping in deploytool.

Deploying the Application
1. In deploytool, open the HTMLReaderApp.ear file, which resides in this

directory:
<INSTALL>/j2eetutorial14/examples/ejb/provided-ears/

2. Verify the resource reference.

a. In the tree, expand the HTMLReaderApp node.

b. Select the HTMLReaderEJB node.

c. Select the Resource Refs tab.

d. Note the URL resource reference for url/MyURL.

3. Verify the mapping of the reference to the JNDI name.

a. In the tree, select the ConfirmerApp node.

b. Select the JNDI Names tab.

c. Note the mapping of url/MyURL (coded in HTMLReaderBean.java) to
this URL:

http://localhost:8080/index.html

4. Deploy the HTMLReaderApp application.

5. In the Deploy Module dialog box, do the following:

a. Select the Return Client JAR checkbox.

b. In the field below the check box, enter the following:

<INSTALL>/j2eetutorial14/examples/ejb/htmlreader

Running the Client
To run the HTMLReaderClient program, do the following:

1. In a terminal window, go to this directory:
<INSTALL>/j2eetutorial14/examples/ejb/htmlreader/
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2. Type the following command on a single line:
appclient -client HTMLReaderAppClient.jar

3. The client should display the source of the HTML file at this URL:

http://localhost:8080/index.html

Further Information
For information on creating JMS resources, see Administered
Objects (page 987). For information on creating JAXR resources, see Creating
JAXR Resources (page 447).
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Security

THE J2EE application programming model insulates developers from mecha-
nism-specific implementation details of application security. The J2EE platform
provides this insulation in a way that enhances the portability of applications,
allowing them to be deployed in diverse security environments.

Some of the material in this chapter assumes that you have an understanding of
basic security concepts. To learn more about these concepts, we highly recom-
mend that you explore the Security trail in The Java™ Tutorial (see http://

java.sun.com/docs/books/tutorial/security1.2/index.html) before you
begin this chapter.

Overview
The J2EE platform defines declarative contracts between those who develop and
assemble application components and those who configure applications in oper-
ational environments. In the context of application security, application provid-
ers are required to declare the security requirements of their applications in such
a way that these requirements can be satisfied during application configuration.
The declarative security mechanisms used in an application are expressed in a
declarative syntax in a document called a deployment descriptor. An application
deployer then employs container-specific tools to map the application require-
ments that are in a deployment descriptor to security mechanisms that are imple-
mented by J2EE servers or Web containers.

http://java.sun.com/docs/books/tutorial/security1.2/index.html
http://java.sun.com/docs/books/tutorial/security1.2/index.html
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Programmatic security refers to security decisions that are made by security-
aware applications. Programmatic security is useful when declarative security
alone is not sufficient to express the security model of an application. For exam-
ple, an application might make authorization decisions based on the time of day,
the parameters of a call, or the internal state of an enterprise bean or Web com-
ponent. Another application might restrict access based on user information
stored in a database.

J2EE and Java Web Services applications are made up of components that can be
deployed into different containers. These components are used to build a multi-
tier enterprise application. The goal of the J2EE security architecture is to
achieve end-to-end security by securing each tier.

The tiers can contain both protected and unprotected resources. Often, you need
to protect resources to ensure that only authorized users have access. Authoriza-
tion provides controlled access to protected resources. Authorization is based on
identification and authentication. Identification is a process that enables recogni-
tion of an entity by a system, and authentication is a process that verifies the
identity of a user, device, or other entity in a computer system, usually as a pre-
requisite to allowing access to resources in a system.

Authorization and authentication are not required to access unprotected
resources. Accessing a resource without authentication is referred to as unau-
thenticated or anonymous access.

Realms, Users, Groups, and Roles
A J2EE user is similar to an operating system user. Typically, both types of users
represent people. However, these two types of users are not the same. The J2EE
server authentication service has no knowledge of the user name and password
you provide when you log on to the operating system. The J2EE server authenti-
cation service is not connected to the security mechanism of the operating sys-
tem. The two security services manage users that belong to different realms.
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The J2EE server’s authentication service includes and interacts with the follow-
ing components:

• Realm - A collection of users and groups that are controlled by the same
authentication policy.

• User - An individual (or application program) identity that has been
defined in the J2EE 1.4 Application Server. Users can be associated with a
group.

• Group - A set of authenticated users, classified by common traits, defined
in the J2EE Application Server.

• Role - An abstract name for the permission to access a particular set of
resources in an application. A role can be compared to a key that can open
a lock. Many people might have a copy of the key, and the lock doesn’t care
who you are, just that you have the right key.

The J2EE server authentication service can govern users in multiple realms. In
this release of the J2EE 1.4 Application Server, the file and certificate

realms come preconfigured for the Application Server.

When using the file realm, the J2EE server authentication service verifies user
identity by checking the file realm. This realm is used for the authentication of
all clients except for Web browser clients that use the HTTPS protocol and cer-
tificates.

A J2EE user of the file realm can belong to a J2EE group. (A user in the cer-

tificate realm cannot.) A J2EE group is a category of users classified by com-
mon traits, such as job title or customer profile. For example, most customers of
an e-commerce application might belong to the CUSTOMER group, but the big
spenders would belong to the PREFERRED group. Categorizing users into groups
makes it easier to control the access of large numbers of users. The section EJB-
Tier Security (page 959) explains how to control user access to enterprise beans.

When using the certificate realm, certificates are used with the HTTPS proto-
col to authenticate Web browser clients. To verify the identity of a user in the
certificate realm, the authentication service verifies an X.509 certificate. For
step-by-step instructions for creating this type of certificate, see Setting Up Dig-
ital Certificates (page 933). The common name field of the X.509 certificate is
used as the principal name.
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Setting up Security Roles
When you design an enterprise bean or Web component, you should always
think about the kinds of users who will access the component. For example, a
Web application for a Human Resources department might have a different
request URL for someone who has been assigned the role of admin than for
someone who has been assigned the role of director. The admin role may let
you view some employee data, but the director role enables you to view salary
information. Each of these security roles is an abstract logical grouping of users
that is defined by the person who assembles the application. When an application
is deployed, the deployer will map the roles to security identities in the opera-
tional environment.

A J2EE group also represents a category of users, but it has a different scope
from a role. A J2EE group is designated for the entire J2EE server, whereas a
role is associated with a specific application in a J2EE server only.

To create a role for a Web application, see Setting Security Requirements Using
deploytool (page 917).

To create a role for a J2EE application, declare it for the application EAR file.
For example, you could use the following procedure to create a role with
deploytool:

1. Select an application.

2. In the Roles tabbed pane, click Add to add a row to the table.

3. In the Name column, enter the security role name, bankCustomer for
example.

4. Click the folded-paper icon to add a description of the security role, Cus-
tomer-of-Bank for example.

5. Click OK.

Before you can map the role to users or groups (see Mapping Roles to
Users and Groups (page 913)), you must first create those users or groups
(see Managing Users (page 913)).
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Managing Users
To add authorized users to the Application Server,

1. Start the Application Server if you haven’t already done so. Information on
starting the Application Server is available at Starting and Stopping the
J2EE Application Server (page 91).

2. Start the Admin Console if you haven’t already done so. You can start the
Admin Console by starting a Web browser and browsing to http://

localhost:4848/asadmin. If you changed the default Admin port during
installation, enter the correct port number in place of 4848.

3. Enter the user name and password provided during installation.

4. Expand the Security node in the Admin Console tree.

5. Expand the Realms node.

6. Select the file realm.

7. Click the Manage Users button.

8. Click New to add a new user to the file realm.

9. Enter the user’s name, password, and the group(s) to which this user will
belong. Click OK to add this user to the list of users in the file realm.

10.Click Logout when you have completed this task.

Mapping Roles to Users and Groups
When you are developing a J2EE application, you don’t need to know what cate-
gories of users have been defined for the realm in which the application will be
run. In the J2EE platform, the security architecture provides a mechanism for
automatically mapping the roles defined in the application to the users or groups
defined in the runtime realm. After your application has been deployed, the
administrator of the J2EE server will map the roles of the application to the users
or groups of the file realm.

Use deploytool to map roles defined for an application to J2EE users and/or
groups:

1. Add authorized users and/or groups to the file realm using the Admin
Console as discussed in Managing Users (page 913). You must define the
users and groups for the Application Server before you can map them to
application security roles.

2. Create or open the Web Application in deploytool. Creating an applica-
tion using deploytool is discussed in Packaging Web Modules (page 94).
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3. Select the Web application in the deploytool tree. Select the Security
tabbed pane. We use the Security tabbed pane to add a security constraint
to the Web application. If you would like more information on security
constraints, read Protecting Web Resources (page 916). Click Add Con-
straint to add a security constraint to this application.

4. Click Add Collections to add a Web Resource Collection to this applica-
tion.

5. Click Edit Roles to select which roles are authorized to access restricted
parts of this application.

6. Click Edit Roles in the Authorized Roles for Security Constraint dialog.

7. Click Add to add a new role. Click in the cell that is created under Name.
For this example, add the roles of CUSTOMER and MANAGER. Click OK to exit
this dialog.

8. Add both roles to the list of authorized roles by selecting each in turning
and clicking Add.

9. Click OK to exit the Authorized Roles dialog.

10.Select the Security Role Mapping tabbed pane to map the users defined for
the Application Server to roles defined for this application.

11.Select a Role Name, for example, MANAGER, in the Role Name pane. These
are the role names we defined in the Authorized Roles for Security Con-
straint dialog.

12.Click Add User/Group to Role. (If this button is grayed out, log on to the
Admin Server before continuing.) Use this dialog to select a specific user
or group to map to the MANAGER role. Then click Map to Role. If you
selected a user, the name of the user will display in the User name pane
when the MANAGER role is selected in the Role Name pane. If you
selected a group, the name of the group will display in the Group name
pane when the MANAGER role is selected. When you defined users using
the Admin Console, you provided them with a name, password, and group.
Any users assigned to the group selected in this step will have access to the
restricted Web application.

Web-Tier Security
Security in a Web application is configured in the Web application deployment
descriptor using deploytool. When the settings are entered in deploytool, they
are saved to the deployment descriptor contained in the WAR. To view the gener-
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ated deployment descriptor, choose Descriptor Viewer from deploytool’s Tools
menu. For more information on deployment descriptors, see Chapter 3.

After a WAR is created, select the Security tabbed pane to configure its security
elements. See Setting Security Requirements Using deploytool (page 917) for
more information on using deploytool to accomplish these tasks:

• User Authentication Method

The User Authentication Method box on the Security tab of deploytool
enables you to specify how the user is prompted to login in. If specified,
the user must be authenticated before it can access any resource that is
constrained by a Security Constraint. The User Authentication Method is
discussed in Using Login Authentication (page 920).

• Security Constraints

The Security Constraint is used to define the access privileges to a collec-
tion of resources using their URL mapping. Security constraints are dis-
cussed in Protecting Web Resources (page 916).

• Web Resource Collections

The Web Resource Collections is part of a security constraint and
describes a URL pattern and HTTP method pair that refer to resources
that need to be protected. Web Resource Collections are discussed in Pro-
tecting Web Resources (page 916).

• Network Security Requirement

The Network Security Requirement is used to configure HTTP basic or
form-based authentication over SSL. Select a Network Security Require-
ment for each Security Constraint. Network Security Requirements are
discussed in What is Secure Socket Layer Technology? (page 932).

• Authorized Roles

The Authorized Roles section is used to specify which roles that have
been defined for an application are authorized to access this Web
Resource Collection. The roles defined for the application must be
mapped to users and groups defined on the server. Authorized roles are
discussed in Setting up Security Roles (page 912).

These elements of the deployment descriptor may be entered directly into the
web.xml file, or created using an application deployment tool, such as deploy-

tool. This document describes creating the deployment descriptor using
deploytool.
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Some elements of Web application security need to be addressed in the deploy-
ment descriptor for the Web server, rather than the deployment descriptor for the
Web application. This information is discussed in Installing and Configuring
SSL Support (page 932), Using Programmatic Security in the Web
Tier (page 931), and Setting up Security Roles (page 912).

Protecting Web Resources
You protect Web resources by specifying a security constraint. A security con-
straint determines who is authorized to access a Web resource collection, which
is a list of URL patterns and HTTP methods that describe a set of resources to be
protected. Security constraints are defined using an application deployment tool,
such as deploytool, as discussed in Setting Security Requirements Using
deploytool (page 917) or in a deployment descriptor.

If you try to access a protected Web resource as an unauthenticated user, the Web
container will try to authenticate you. The container will only accept the request
after you have proven your identity to the container and have been granted per-
mission to access the resource.

Security constraints only work on the original request URI, not on calls made via
a RequestDispatcher (which include <jsp:include> and <jsp:forward>).
Inside the application, it is assumed that the application itself has complete
access to all resources and would not forward a user request unless it had
decided that the requesting user had access also.

Many applications feature unprotected Web content, which any caller can access
without authentication. In the Web tier, unrestricted access is provided simply by
not configuring a security constraint for that particular request URI. It is com-
mon to have some unprotected resources and some protected resources. In this
case, you will have security constraints and a login method defined, but it will
not be used to control access to the unprotected resources. The user won’t be
asked to log on until the first time they enter a protected request URI.

In the Java Servlet Specification, the request URI is the part of a URL after the
host name and port. For example, let’s say you have an e-commerce site with a
browsable catalog you would want anyone to be able to access and a shopping
cart area for customers only. You could set up the paths for your Web application
so that the pattern /cart/* is protected, but nothing else is protected. Assuming
the application is installed at context path /myapp,

• http://localhost:8080/myapp/index.jsp is not protected
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• http://localhost:8080/myapp/cart/index.jsp is protected

A user will not be prompted to log in until the first time that user accesses a
resource in the cart/ subdirectory.

To set up a security constraint, see the section Setting Security Requirements
Using deploytool (page 917).

Setting Security Requirements Using
deploytool
To set security requirements for a WAR, select the WAR in the deploytool tree,
then select the Security tabbed pane. In the Security tabbed pane, you can define
how users are authenticated to the server and which users have access to particu-
lar resources.

1.  Choose the Authentication Method.

Authentication refers to the method by which a client verifies the identity
of a user to a server. The authentication methods supported in this release
are shown below and are discussed in more detail in Using Login
Authentication (page 920). Select one of the following authentication
methods from the Authentication Method list:

a.None

b. Basic
c.Client Certificate

d.Digest

e. Form Based

If you selected Basic or Digest authentication, click Settings to go to the
User Authentication Settings dialog and enter the Realm Name. If you
selected Form Based authentication, click Settings to go to the User
Authentication Settings dialog and enter the Realm Name, Login Page,
and Error Page.

2. Define a Security Constraint.

In the Security Constraints section of the screen, you can define the secu-
rity constraints for accessing the content of your WAR file. Click the Add
button adjacent to the Security Constraints field to add a security con-
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straint. Double-click the cell containing the Security Constraint to change
its name. Each Security Constraint consists of:

a. A Web Resource Collection, which describes a URL pattern and HTTP
method pair that refer to resources that need to be protected.

b. An Authorization Constraint, which is a set of roles that are defined to
have access to the Web Resource Collection.

c. A User Data Constraint, which defines whether a resource is accessed
with confidentiality protection, integrity protection, or no protection.

3. Define a Web Resource Collection for this Security Constraint.

With the security constraint selected, click the Add button adjacent to the
Web Resource Collections field to add a Web resource collection to the
security constraint. A Web Resource Collection is part of a Security Con-
straint and describes a URL pattern and HTTP method pair that refer to
resources that need to be protected. Double-click the cell containing the
Web Resource Collection to edit its name.

4. Edit the contents of the Web Resource Collection by selecting it in the list,
then clicking the Edit button. The Edit Contents dialog box displays. Use
it to add individual files or whole directories to the Web resource collec-
tion, to add a URL pattern, or to specify which HTTP methods will be gov-
erned by this Web Resource Collection.

a. Select the files and directories that you want to the Web Resource Col-
lection (WRC) in the top text field and then click the Add button to add
them to the Web Resource Collection.

b. Add URL patterns to the Web Resource Collection by clicking Add
URL and entering the URL in the edit field. For example, specify /* to
protect all resources.

c. Specify which HTTP Methods are to be added to the Web application.
The options are: Delete, Get, Head, Options, Post, Put, and Trace.

d. Click OK to return to the Security tabbed pane. The contents of the
WRC display in the box beside the Edit button.

5. Select the Network Security Requirement for this Security Constraint. The
choices are None, Integral, and Confidential.

a. Specify NONE when the application does not require a security con-
straint.

b. Specify CONFIDENTIAL when the application requires that data be trans-
mitted so as to prevent other entities from observing the contents of the
transmission.
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c. Specify INTEGRAL when the application requires that the data be sent
between client and server in such a way that it cannot be changed in
transit.

If you specify CONFIDENTIAL or INTEGRAL as a security constraint, that
type of security constraint applies to all requests that match the URL pat-
terns in the Web Resource Collection, not just to the login dialog. For fur-
ther discussion on Network Security Requirements, see What is Secure
Socket Layer Technology? (page 932).

6. Select which roles are authorized to access the secure application. In the
Authorized Roles pane, click Edit to specify which defined roles are autho-
rized to access this secure application.

Select the role for which you want to authorize access from the list of
Roles and click the Add button to add it to the list of Authorized Roles.

If Roles have not been defined for this application, click the Edit Roles
button and add the Roles for this application. If you add Roles in this
fashion, make sure to select the Security Role Mapping tab and map the
roles to the appropriate users and groups. For more information on Role
Mapping, see Mapping Roles to Users and Groups (page 913).

7. To add security specifically to a JSP page or to a servlet in the application,
select the JSP page or servlet in the deploytool tree and select the Secu-
rity tab. For more information on the options displayed on this page, see
Declaring and Linking Role References (page 931).

The resulting deployment descriptor can be viewed by selecting the WAR
file in the deploytool tree and then selecting Descriptor Viewer from the
Tools menu.

Specifying a Secure Connection
When the login authentication method is set to BASIC or FORM, passwords are not
protected, meaning that passwords sent between a client and a server on a non-
protected session can be viewed and intercepted by third parties.

To configure HTTP basic or form-based authentication over SSL, specify CON-

FIDENTIAL or INTEGRAL as the Network Security Requirement on the WAR’s
Security page in deploytool. Specify CONFIDENTIAL when the application
requires that data be transmitted so as to prevent other entities from observing
the contents of the transmission. Specify INTEGRAL when the application
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requires that the data be sent between client and server in such a way that it can-
not be changed in transit.

If you specify CONFIDENTIAL or INTEGRAL as a security constraint, that type of
security constraint applies to all requests that match the URL patterns in the Web
resource collection, not just to the login dialog.

If the default configuration of your server does not support SSL, you must con-
figure it with an SSL connector to make this work. By default, the J2EE 1.4
Application Server is configured with an SSL Connector. To set up an SSL con-
nector on other servers, see Installing and Configuring SSL Support (page 932).

Note: Good Security Practice: If you are using sessions, once you switch to SSL
you should never accept any further requests for that session that are non-SSL. For
example, a shopping site might not use SSL until the checkout page, then it may
switch to using SSL in order to accept your card number. After switching to SSL,
you should stop listening to non-SSL requests for this session. The reason for this
practice is that the session ID itself was non-encrypted on the earlier communica-
tions, which is not so bad when you’re just doing your shopping, but once the credit
card information is stored in the session, you don’t want a bad guy trying to fake the
purchase transaction against your credit card. This practice could be easily imple-
mented using a filter.

Using Login Authentication
When you try to access a protected Web resource, the Web container activates
the authentication mechanism that has been configured for that resource. With a
Web Application selected in the deploytool tree, select the Security tabbed
pane and select one of the following User Authentication Methods:

• None

If you do not specify one of the following methods, the user will not be
authenticated.

• Basic

If you specify HTTP basic authentication, the Web server will authenti-
cate a user by using the user name and password obtained from the Web
client. HTTP basic authentication is not particularly secure. Basic authen-
tication sends user names and passwords over the Internet as text that is
uu-encoded, but not encrypted. This form of authentication, which uses
Base64 encoding, can expose your user names and passwords unless all
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connections are over SSL. If someone can intercept the transmission, the
user name and password information can easily be decoded. An example
application that uses HTTP Basic Authentication in a JAX-RPC service is
described in Example: Basic Authentication with JAX-RPC (page 943).

• Form-based

If you specify form-based authentication, you can customize the login
screen and error pages that are presented to the end user by an HTTP
browser.

Form-based authentication is not particularly secure. In form-based
authentication, the content of the user dialog is sent as plain text, and the
target server is not authenticated. This form of authentication can expose
your user names and passwords unless all connections are over SSL. If
someone can intercept the transmission, the user name and password
information can easily be decoded. An example application using form-
based authentication is included in the tutorial and is discussed in Exam-
ple: Using Form-Based Authentication (page 922).

• Client-Certificate

Client-certificate authentication is a more secure method of authentica-
tion than either basic or form-based authentication. It uses HTTP over
SSL, in which the server and, optionally, the client authenticate one
another with Public Key Certificates. Secure Sockets Layer (SSL) pro-
vides data encryption, server authentication, message integrity, and
optional client authentication for a TCP/IP connection. You can think of a
public key certificate as the digital equivalent of a passport. It is issued by
a trusted organization, which is called a certificate authority (CA), and
provides identification for the bearer. If you specify client-certificate
authentication, the Web server will authenticate the client using the cli-
ent’s X.509 certificate, a public key certificate that conforms to a standard
that is defined by X.509 Public Key Infrastructure (PKI). Prior to running
an application that uses SSL, you must configure SSL support on the
server (see Installing and Configuring SSL Support, page 932) and set up
the public key certificate (see Setting Up Digital Certificates, page 933).
An example application that uses CLIENT-CERT authentication is dis-
cussed in Example: Client-Certificate Authentication over HTTP/SSL
with JAX-RPC (page 950).
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To configure the authentication mechanism that the Web resources in a WAR
will use, select the WAR in the deploytool tree, and select the Security tabbed
pane, then proceed as follows:

• Specify one of the User Authentication Methods described above.

• Specify a security realm. If omitted, the file realm is assumed. Select the
Settings button beside the User Authentication Mechanism field to specify
the realm.

• If the authentication method is specified as Form-based, specify a form
login page and form error page. Select the Settings button beside the User
Authentication Mechanism field to specify the Login Page and the Error
Page to be used for form-based authentication.

Example: Using Form-Based
Authentication
In this section, we discuss how to add form-based authentication to a basic JSP
page. With form-based authentication, you can customize the login screen and
error pages that are presented to the Web client for authentication of their user
name and password. If the topic of authentication is new to you, please refer to
the section titled Using Login Authentication (page 920).

The example application discussed in this tutorial can be found in <INSTALL>/

j2eetutorial14/examples/security/formbasedauth/. In general, the fol-
lowing steps are necessary to add form-based authentication to a Web client. In
the example application included with this tutorial, most of these steps have been
completed for you and are listed here expressly for the purpose of listing what
needs to be done should you wish to create a similar application outside of this
tutorial.

• Map the role name to the appropriate users and groups defined for the J2EE
1.4 Application Server. See Adding Authorized Users (page 923) for more
information on needed modifications.

• Edit the build.properties files. The build.properties file needs to be
modified because the properties in this file are specific to your installation
of the J2EE 1.4 Application Server and J2EE 1.4 Tutorial. See Setting Up
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To Build and Deploy Tutorial Examples (page 90) for information on
which properties need to be set.

• Create the Web client. For this example, the Web client, a very simple JSP
page, is already created. The client is discussed in Creating a Web Client
for Form-Based Authentication (page 923).

• Create the login form and login error form pages. For this example, these
files are already created. These pages are discussed in Creating the Login
Form and Error Page (page 924).

• Add the appropriate security elements using deploytool. See Specifying
Security Elements for Form-Based Authentication (page 925) for informa-
tion on which settings need to be made.

• Build, package, deploy, and run the Web application (see Building, Pack-
aging, Deploying, and Running the Form-Based Authentication
Example, page 926). You will use the asant tool to compile and install the
example application.

Adding Authorized Users
This example application authorizes the role of loginUser. In order to specify
which users can assume that role and access the protected parts of the applica-
tion, you must map the role to users and groups defined for the J2EE 1.4 Appli-
cation Server. Information on adding users and groups using the Admin Console
is discussed in Managing Users (page 913)

When the Application Server is started, it reads the settings in its configuration
files. When a constrained resource is accessed, the Application Server verifies
that the user name and password are authorized to access that resource before
granting access to the requestor. The roles that are authorized to access a
resource are specified in the security constraint for this application.

Information for adding users to the J2EE 1.4 Application Server is provided in
Managing Users (page 913). For this example, create a new user and assign that
user to the group loginUser.

Creating a Web Client for Form-Based
Authentication
The Web client is a standard JSP page. None of the code that adds form-based
authentication to the example is included in the Web client. The information that
adds the form-based authentication to this example is specified in the deploy-
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ment descriptor, which is created with deploytool. The code for the JSP page
used in this example, formbasedauth/web/index.jsp, is listed below. The run-
ning application is shown in Figure 27–2.

<html>
<head><title>Hello</title></head>
<body bgcolor="white">

<img src="duke.waving.gif">
<h2>My name is Duke.</h2>
<h2><font color="black">Hello,

${pageContext.request.userPrincipal.name}!</font></h2>
</body>
</html>

Creating the Login Form and Error Page
The Security tabbed pane specifies the JSP page that contains the form to be
used to obtain the user name and password in order to verify that access to the
client is authorized to that user. If login authentication fails, the error page is dis-
played in place of the requested page.

The login page can be an HTML page, a JSP page, or a servlet, and must return
an HTML page containing a form that conforms to specific naming conventions
(see the Java Servlet 2.4 Specification for more information on these require-
ments). The content of the login form in an HTML page, JSP page, or servlet for
a login page should be as follows:

<form method=post action="j_security_check" >
 <input type="text"  name= "j_username" >
 <input type="password"  name= "j_password" >
</form>

The full code for the login page used in this example can be found at
<INSTALL>/j2eetutorial14/examples/security/formbasedauth/web/

logon.jsp. An example of the running login form page is shown in Figure 27–1.

The login error page is displayed if a user name and password combination that
is not authorized to access the protected URI is entered on the login page. For
this example, the login error page can be found at <INSTALL>/j2eetutorial14/
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examples/security/formbasedauth/web/logonError.jsp. The code for this
page is displayed below:

<html>
<head>
<title>
 Login Error
</title>
</head>
<c:url var="url" value="/logon.jsp"/>
<p><a href="${url}">Try again.</a></p>
</html>

Specifying Security Elements for Form-Based
Authentication
The following elements are added to this application using deploytool to
enable form-based authentication.

• The Security Constraint is used to define the access privileges to a collec-
tion of resources using their URL mapping.

• The Web Resource Collection is used to identify a subset of the resources
within a Web application to which a security constraint applies. In this
example, by specifying an URL pattern of /*, we are specifying that all
resources in this application are protected.

• The Authorized Roles list indicates the user roles that should be permitted
access to this resource collection. In this example, it is users assigned the
role of loginUser. If no role name is provided, no user is allowed to access
the portion of the Web application described by the security constraint.

• The User Authentication Method is used to configure the authentication
method that should be used and the attributes needed by the form login
mechanism. The Login Page parameter provides the URI of a Web
resource relative to the document root that will be used to authenticate the
user. The Error Page parameter requires a URI of a Web resource relative
to the document root that send a response when authentication has failed.

In the J2EE 1.4 Application Server, these security elements are added to the
application using deploytool, after the application has been packaged. Informa-
tion on adding the security elements to this application using deploytool is dis-
cussed in Adding Security to the Form-Based Example (page 927).
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Building, Packaging, Deploying, and Running
the Form-Based Authentication Example
To build, package, deploy, and run the security/formbasedauth example,
which uses form-based authentication, follow these steps.

Building the Form-Based Authentication Example
1. Follow the instructions in Setting Up To Build and Deploy Tutorial

Examples (page 90).

2. Follow the instructions in Adding Authorized Users (page 923).

3. Go to the <INSTALL>/j2eetutorial14/examples/security/form-

basedauth/ directory.

4. Build the Web application by entering the following at the terminal win-
dow or command prompt in the formbasedauth/ directory (this and the
following steps that use asant assume that you have the executable for
asant in your path: if not, you will need to provide the fully-qualified path
to the executable). This command runs the target named build in the
build.xml file. The build target compiles any Java files in the application
and copies Web components to the appropriate directories for deployment.

asant build

Packaging the Web Application
1. Start the J2EE 1.4 Application Server if you have not already done so. For

information on starting the Application Server, see Starting and Stopping
the J2EE Application Server (page 91).

2. Start deploytool. Information on starting deploytool can be found in
Starting the deploytool Utility (page 92).

3. Package the formbasedauth example using deploytool following these
steps. More detail on packaging Web applications can be found at Packag-
ing Web Modules (page 94).

a. Select File→New→Web Component from the deploytool menu.

b. Select Next.

c. Select the Create New Stand-Alone WAR Module radio button.

d. In the WAR Location field, browse to the <INSTALL>/

j2eetutorial14/examples/security/formbasedauth/ directory
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and create the file formbasedauth.war. Give the WAR the name Form-
BasedAuth.

e. Enter /formbasedauth in the Context Root field.

f. Click Edit to add the contents of the application to the WAR file. Select
the formbasedauth/ directory from the Starting Directory list. Select
each of the files index.jsp, logon.jsp, logonError.jsp, and
duke.waving.gif from the build/ directory and then click Add. Click
OK to close this dialog.

g. Click Next.

h. Select JSP.

i. Click Next.

j. Select index.jsp for the JSP File Name.

k. Click Next.

l. Click Finish.

The FormBasedAuth example displays in the deploytool tree.

Adding Security to the Form-Based Example
To add form-based authentication to your application, select the application in
the deploytool tree, then follow these steps:

1. Select the Security tabbed pane.

2. Select Form Based for the User Authentication Method.

3. Select the Settings dialog. Set the following properties in this dialog:

• Set Realm Name to file.

• Select logon.jsp from the Login Page list.

• Select logonError.jsp from the Login Error Page list.

4. Select Add Constraints to add a security constraint to this example.

5. Select Add Collections to add a Web Resource Collection to this example.

6. With the Security Constraint and Web Resource Collection selected, click
the Edit Collections button.

7. In the Edit Contents dialog, select Add URL pattern. In the edit box, make
sure the URL pattern reads /*. Click OK to close this dialog. Using a URL
pattern of /* and selecting no HTTP patterns means that all files and meth-
ods in this application are protected and may only be accessed by a user
who provides an authorized login.
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8. Click Edit Roles on the Security tabbed pane, then Edit Roles again in the
Authorized Roles dialog. Click Add to add the role loginUser, which is
the authorized role for this security constraint. Click OK to close this dia-
log.

9. Select loginUser in the left pane and click Add to add it to the list of
Authorized Roles for this application. Select OK to close this dialog.

10.Create a Security Role Reference. This is needed for this example to map
the role of loginUser defined in the previous steps to the group loginUser

created using the Admin Console in Adding Authorized Users (page 923).
To do this, select the Security Role Mapping tabbed pane in deploytool.

11.Select the role of loginUser.

12.Select Add User/Group to Role. If you don’t see the list of users and
groups you defined using the Admin Console, connect to the Admin Server
(by double-clicking it in the deploytool tree), then make the Admin
Server (which is localhost:4848 by default) the Current Target Server by
selecting File→Current Target Server.

13.Select loginUser from the Group Name list, then click Map to Role.
When the loginUser role is selected in the Role Name list, the loginUser
group will display under the Group Name list.

After all of the security elements have been added, view the generated deploy-
ment descriptor by selecting Tools→Descriptor Viewer→Descriptor Viewer
from the deploytool menu.

Deploying the Web Application
Deploy the Web application by selecting the formbasedauth application in the
deploytool tree, then selecting Tools→Deploy.

Running the Web Application
Run the Web client by entering the following URL in your Web browser:

http://localhost:8080/formbasedauth

The login form displays in the browser, as shown in Figure 27–1. Enter a user
name and password combination that corresponds to the role of loginUser, then
click the Submit button.
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Figure 27–1 Form-Based Login Page

If you entered Debbie as the name, and there is a user defined for the
J2EE 1.4 Application Server with the user name of Debbie that also
matches the password you entered and which is assigned to the group of
loginUser which we mapped to the role of loginUser, the display will
appear as in Figure 27–2 after you click the Submit button.



930 SECURITY
Figure 27–2 The Running Form-Based Authentication Example

Using Authentication with SSL
Passwords are not protected for confidentiality with HTTP basic or form-based
authentication, meaning that passwords sent between a client and a server on a
non-protected session can be viewed and intercepted by third parties. To over-
come this limitation, you can run these authentication protocols over an SSL-
protected session and ensure that all message content is protected for confidenti-
ality. To configure HTTP basic or form-based authentication over SSL, specify
CONFIDENTIAL or INTEGRAL as the Network Security Requirement on the WAR’s
Security page in deploytool. Read the section Specifying a Secure
Connection (page 919) for more information.
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Using Programmatic Security in the Web
Tier
Programmatic security is used by security-aware applications when declarative
security alone is not sufficient to express the security model of the application.
Programmatic security consists of the following methods of the HttpServle-

tRequest interface:

• getRemoteUser - used to determine the user name with which the client
authenticated.

• isUserInRole - used to determine if a user is in a specific security role.

• getUserPrincipal - returns a java.security.Principal object.

These APIs allow servlets to make business logic decisions based on the logical
role of the remote user. They also allow the servlet to determine the principal
name of the current user.

Declaring and Linking Role References
A security role reference allows a Web component to reference an existing secu-
rity role. A security role is an application-specific logical grouping of users, clas-
sified by common traits such as customer profile or job title. When an
application is deployed, roles are mapped to security identities, such as princi-
pals (identities assigned to users as a result of authentication) or groups, in the
operational environment. Based on this, a user with a certain security role has
associated access rights to a Web application. The link is the actual name of the
security role that is being referenced.

During application assembly, the assembler creates security roles for the applica-
tion and associates these roles with available security mechanisms. The assem-
bler then resolves the security role references in individual servlets and JSP
pages by linking them to roles defined for the application.

The security role reference defines a mapping between the name of a role that is
called from a Web component using isUserInRole(String name) and the
name of a security role that has been defined for the application.

For example, the mapping of the security role reference cust to the security role
with role name bankCustomer, is shown in the example below.

1. Select the Web component in the deploytool tree.

2. Select the Security tab.
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3. Select Add Constraints and Add Collections to add a security constraint
and Web resource collection. Adding a security constraint enables the Edit
Roles button.

4. Select the Edit Roles button to open the Authorized Roles dialog. Click the
Edit Roles button to open the Edit Roles dialog. Click Add to add an autho-
rized role to this application.

5. Click in the edit box and enter a role, for example, admin or loginUser. If
you haven’t added any users, refer to Managing Users (page 913) for infor-
mation on how to do so. Select OK to close this dialog.

6. Select the role you just added in the left pane, click Add to add it to the list
of authorized roles for this application. Click OK to close this dialog. The
role you added displays in the list of Authorized Roles on the Security
tabbed pane.

Now that you’ve set up a role for this application, you need to map it the list of
users and groups set up for the Application Server. To do this,

1. Log onto the localhost:4848 by double-clicking it in the deploytool

tree. If you skip this step, the roles defined for the Application Server will
not be displayed in subsequent steps.

2. Select the Security Role Mapping tabbed pane.

3. Select the Role Name you entered. Select Add User/Groups to Role.

4. Select the User or Group Name that you want to map to this security role,
then select Map to Role.

5. Select Save from the File menu to save these changes.

When you use the isUserInRole(String role) method, the String role is
mapped to the role name defined in the Authorized Roles section of the WAR
file’s Security tabbed pane.

Installing and Configuring SSL Support
What is Secure Socket Layer
Technology?
Secure Socket Layer (SSL) is a technology that allows Web browsers and Web
servers to communicate over a secured connection. In this secure connection, the
data that is being sent is encrypted before being sent, then decrypted upon
receipt and prior to processing. Both the browser and the server encrypt all traffic
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before sending any data. SSL addresses the following important security consid-
erations.

• Authentication

During your initial attempt to communicate with a Web server over a
secure connection, that server will present your Web browser with a set of
credentials in the form of a server certificate. The purpose of the certifi-
cate is to verify that the site is who and what it claims to be. In some
cases, the server may request a certificate that the client is who and what it
claims to be (which is known as client authentication).

• Confidentiality

When data is being passed between the client and server on a network,
third parties can view and intercept this data. SSL responses are encrypted
so that the data cannot be deciphered by the third-party and the data
remains confidential.

• Integrity

When data is being passed between the client and server on a network,
third parties can view and intercept this data. SSL helps guarantee that the
data will not be modified in transit by that third party.

To install and configure SSL support on your stand-alone Web server, you need
the following components. SSL support is already provided if you are using the
J2EE 1.4 Application Server. If you are using a different Web server, consult the
documentation for your product.

• A server certificate keystore (see Setting Up Digital
Certificates, page 933).

• An HTTPS connector (see Configuring the SSL Connector, page 939).

To verify that SSL support is enabled, see Verifying SSL Support (page 939).

Setting Up Digital Certificates

Note: Digital certificates for the J2EE 1.4 Application Server have already been
generated and can be found in the directory <J2EE_HOME>/domains/domain1/
config/.

In order to use SSL, a J2EE server must have an associated certificate for each
external interface, or IP address, that accepts secure connections. The theory
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behind this design is that a server should provide some kind of reasonable assur-
ance that its owner is who you think it is, particularly before receiving any sensi-
tive information. It may be useful to think of a certificate as a “digital driver’s
license” for an Internet address. It states with which company the site is associ-
ated, along with some basic contact information about the site owner or adminis-
trator.

The digital certificate is cryptographically signed by its owner and is difficult for
anyone else to forge. For sites involved in e-commerce, or any other business
transaction in which authentication of identity is important, a certificate can be
purchased from a well-known Certificate Authority (CA) such as Verisign or
Thawte.

If authentication is not really a concern, such as if an administrator simply wants
to ensure that data being transmitted and received by the server is private and
cannot be snooped by anyone eavesdropping on the connection, you can simply
save the time and expense involved in obtaining a CA certificate and simply use
a self-signed certificate.

SSL uses public key cryptography, which is based on key pairs. Key pairs con-
tain one public key and one private key. If data is encrypted with one key, it can
only be decrypted with the other key of the pair. This property is fundamental to
establishing trust and privacy in transactions. For example, using SSL, the server
computes a value and encrypts the value using its private key. The encrypted
value is called a digital signature. The client decrypts the encrypted value using
the server’s public key and compares the value to its own computed value. If the
two values match, the client can trust that the signature is authentic since only
the private key could have been used to produce such a signature.

Digital certificates are used with the HTTPS protocol to authenticate Web cli-
ents. The HTTPS service of most Web servers will not run unless a digital certif-
icate has been installed. Use the procedure outlined below to set up a digital
certificate that can be used by your Web server to enable SSL.

One tool that can be used to set up a digital certificate is keytool, a key and cer-
tificate management utility that ships with J2EE 1.4 Application Server. It
enables users to administer their own public/private key pairs and associated cer-
tificates for use in self-authentication (where the user authenticates himself/her-
self to other users/services) or data integrity and authentication services, using
digital signatures. It also allows users to cache the public keys (in the form of
certificates) of their communicating peers. For a better understanding of key-
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tool and public key cryptography, read the keytool documentation at the fol-
lowing URL:

http://java.sun.com/j2se/1.4.2/docs/tooldocs/solaris/key-
tool.html

Creating a Server Certificate
A server certificate has already been created for the J2EE 1.4 Application Server.
The certificates can be found in the <J2EE_HOME>/domains/domain1/config/

directory. The server certificate is in keystore.jks. The client certificate is con-
tained in the trust-store file, cacerts.jks.

If necessary, you can use keytool to generate certificates. The keytool stores
the keys and certificates in a file termed a keystore. A keystore is a repository of
certificates used for identifying a client or a server. Typically, a keystore contains
one client or one server’s identity. The default keystore implementation imple-
ments the keystore as a file. It protects private keys with a password.

The keystores are created in the directory from which you run keytool. This can
be the directory where the application resides or it can be a directory common to
many applications.

To create a server certificate,

1. Create the keystore.

2. Export the certificate from the keystore.

3. Sign the certificate.

4. Import the certificate into a trust-store. A trust-store is a repository of cer-
tificates used for verifying the certificates. A trust-store typically contains
more than one certificate. An example using a trust-store for SSL-based
mutual authentication is discussed in Example: Client-Certificate Authen-
tication over HTTP/SSL with JAX-RPC (page 950).

Run keytool to generate the server keystore, which we will name server-key-

store.jks. This step uses the alias server-alias to generate a new public/pri-
vate key pair and wrap the public key into a self-signed certificate inside
server-keystore.jks. The key pair is generated using an algorithm of type
RSA, with a default password of changeit. For more information on keytool

options, see its online help at http://java.sun.com/j2se/1.4.2/docs/

tooldocs/solaris/keytool.html.

http://java.sun.com/j2se/1.4.1/docs/tooldocs/solaris/keytool.html
http://java.sun.com/j2se/1.4.2/docs/tooldocs/solaris/keytool.html
http://java.sun.com/j2se/1.4.2/docs/tooldocs/solaris/keytool.html
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From the directory in which you want to create the keystore, run keytool with
the following parameters. When you press Enter, keytool prompts you to enter
the server name, organizational unit, organization, locality, state, and country
code. Note that you must enter the server name in response to keytool’s first
prompt in which it asks for first and last names. For testing purposes, this may be
localhost. The host specified in the keystore must match the host identified in
the host variable specified in the <INSTALL>/j2eetutorial14/examples/com-

mon/build.properties.

1. Generate the server certificate.

<JAVA_HOME>\bin\keytool -genkey -alias server-alias

-keyalg RSA -keypass changeit -storepass changeit

-keystore keystore.jks

2. Export the generated server certificate in keystore.jks into the file
server.cer.

<JAVA_HOME>\bin\keytool -export -alias server-alias

-storepass changeit -file server.cer -keystore keystore.jks

3. If you want to have the certificate signed by a CA, read Signing Digital
Certificates (page 937) for more information.

4. To create the trust-store file cacerts.jks and add the server certificate to
the trust-store, run keytool from the directory where you created the key-
store and server certificate with the following parameters:

<JAVA_HOME>\bin\keytool -import -v -trustcacerts

-alias server-alias -file server.cer

-keystore cacerts.jks -keypass changeit

-storepass changeit

Information on the certificate, such as that shown below will display.

<INSTALL>/j2eetutorial14/examples/gs 60% keytool -import

-v -trustcacerts -alias server-alias -file server.cer

-keystore cacerts.jks -keypass changeit -storepass changeit

Owner: CN=localhost, OU=Sun Micro, O=Docs, L=Santa Clara,

ST=CA, C=US

Issuer: CN=localhost, OU=Sun Micro, O=Docs, L=Santa Clara,

ST=CA, C=US

Serial number: 3e932169

Valid from: Tue Apr 08

Certificate fingerprints:

MD5: 52:9F:49:68:ED:78:6F:39:87:F3:98:B3:6A:6B:0F:90
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SHA1: EE:2E:2A:A6:9E:03:9A:3A:1C:17:4A:28:5E:97:20:78:3F:

Trust this certificate? [no]:

5. Enter yes, then strike the Enter or Return key. The following information
displays:

Certificate was added to keystore

[Saving cacerts.jks]

Signing Digital Certificates
Once you’ve created a digital certificate, you will want to have it signed by its
owner. Once the digital certificate is cryptographically signed by its owner, it is
difficult for anyone else to forge. For sites involved in e-commerce, or any other
business transaction in which authentication of identity is important, a certificate
can be purchased from a well-known Certificate Authority (CA) such as Verisign
or Thawte.

If authentication is not really a concern, such as if an administrator simply wants
to ensure that data being transmitted and received by the server is private and
cannot be snooped by anyone eavesdropping on the connection, you can simply
save the time and expense involved in obtaining a CA certificate and simply use
the self-signed certificate.

Creating a Client Certificate for Mutual
Authentication
This section discusses setting up client-side authentication. When both server
and client-side authentication are enabled, this is called mutual, or two-way,
authentication. In client authentication, clients are required to submit certificates
that are issued by a certificate authority that you choose to accept. From the
directory where you want to create the client certificate, run keytool as outlined
below. When you press Enter, keytool prompts you to enter the server name,
organizational unit, organization, locality, state, and country code. Note that you
must enter the server name in response to keytool’s first prompt in which it asks
for first and last names. For testing purposes, this may be localhost. The host
specified in the keystore must match the host identified in the host variable spec-
ified in the <INSTALL>/j2eetutorial14/examples/common/build.proper-

ties file.
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To create a keystore named client-keystore.jks that contains a client certifi-
cate named client.cer, follow these steps:

1. Generate the client certificate.

<JAVA_HOME>\bin\keytool -genkey -alias client-alias -keyalg

RSA -keypass changeit -storepass changeit

-keystore keystore.jks

2. Export the generated client certificate into the file client.cer.

<JAVA_HOME>\bin\keytool -export -alias client-alias

-storepass changeit -file client.cer -keystore keystore.jks

3. Add the certificate to the trust-store file cacerts.jks. Run keytool from
the directory where you created the keystore and client certificate with the
following parameters:

<JAVA_HOME>\bin\keytool -import -v -trustcacerts

-alias client-alias -file client.cer

-keystore cacerts.jks -keypass changeit

-storepass changeit

Keytool returns this message:

Owner: CN=J2EE Client, OU=Java Web Services, O=Sun, L=Santa

Clara, ST=CA, C=US

Issuer: CN=J2EE Client, OU=Java Web Services, O=Sun, L=Santa

Clara, ST=CA, C=US

Serial number: 3e39e66a

Valid from: Thu Jan 30 18:58:50 PST 2003 until: Wed Apr 30

19:58:50 PDT 2003

Certificate fingerprints:

MD5: 5A:B0:4C:88:4E:F8:EF:E9:E5:8B:53:BD:D0:AA:8E:5A

SHA1:90:00:36:5B:E0:A7:A2:BD:67:DB:EA:37:B9:61:3E:26:B3:89:

46:

32

Trust this certificate? [no]: yes

Certificate was added to keystore

For an example application that uses mutual authentication, see Example: Cli-
ent-Certificate Authentication over HTTP/SSL with JAX-RPC (page 950). For
information on verifying that mutual authentication is running, see Verifying
Mutual Authentication is Running (page 941).
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Miscellaneous Commands for Certificates
• To check the contents of a keystore that contains a certificate with an alias

server-alias:

keytool -list -keystore keystore.jks -alias server-alias -v

• To check the contents of the cacerts file:

keytool -list -keystore cacerts.jks

Configuring the SSL Connector
An SSL Connector is preconfigured for the J2EE 1.4 Application Server. You do
not have to configure anything.

Verifying SSL Support
For testing purposes, and to verify that SSL support has been correctly installed,
load the default introduction page with a URL that connects to port defined in
the server deployment descriptor:

https://localhost:1043/

The https in this URL indicates that the browser should be using the SSL proto-
col. The localhost in this example assumes you are running the example on
your local machine as part of the development process. The 1043 in this example
is the secure port that was specified where the SSL Connector was created in
Configuring the SSL Connector (page 939). If you are using a different server or
port, modify this value accordingly.

The first time a user loads this application, the New Site Certificate or Security
Alert dialog displays. Select Next to move through the series of dialogs, select
Finish when you reach the last dialog. The certificates will only display the first
time. When you accept the certificates, subsequent hits to this site assume that
you still trust the content.

General Tips on Running SSL
The SSL protocol is designed to be as efficient as securely possible. However,
encryption/decryption is a computationally expensive process from a perfor-
mance standpoint. It is not strictly necessary to run an entire Web application
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over SSL, and it is customary for a developer to decide which pages require a
secure connection and which do not. Pages that might require a secure connec-
tion include login pages, personal information pages, shopping cart checkouts,
or any pages where credit card information could possibly be transmitted. Any
page within an application can be requested over a secure socket by simply pre-
fixing the address with https: instead of http:. Any pages which absolutely
require a secure connection should check the protocol type associated with the
page request and take the appropriate action if https: is not specified.

Using name-based virtual hosts on a secured connection can be problematic.
This is a design limitation of the SSL protocol itself. The SSL handshake, where
the client browser accepts the server certificate, must occur before the HTTP
request is accessed. As a result, the request information containing the virtual
host name cannot be determined prior to authentication, and it is therefore not
possible to assign multiple certificates to a single IP address. If all virtual hosts
on a single IP address need to authenticate against the same certificate, the addi-
tion of multiple virtual hosts should not interfere with normal SSL operations on
the server. Be aware, however, that most client browsers will compare the
server’s domain name against the domain name listed in the certificate, if any
(applicable primarily to official, CA-signed certificates). If the domain names do
not match, these browsers will display a warning to the client. In general, only
address-based virtual hosts are commonly used with SSL in a production envi-
ronment.

Enabling Mutual Authentication Over SSL
This section discusses setting up client-side authentication. When both server
and client-side authentication are enabled, this is called mutual, or two-way,
authentication. In client authentication, clients are required to submit certificates
that are issued by a certificate authority that you choose to accept. There are at
least two ways to enable client authentication. No matter which way you choose,
you must enter the keystore location and password in the Web server configura-
tion file to enable SSL, as discussed in Configuring the SSL
Connector (page 939). The two ways to enable mutual authentication over SSL
are:

• Set the clientAuth property in the certificate realm to true. To do this,

a. Start the Application Server if you haven’t already done so. Information
on starting the Application Server can be found at Starting and Stopping
the J2EE Application Server (page 91).
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b. Start the Admin Console. Information on starting the Admin Console
can be found at Starting the Admin Console (page 92).

c. In the Admin Console tree, expand Security, then expand Realms, and
select certificate. The certificate realm is used for all transfers
over HTTP with SSL.

d. Select Add to add the property of clientAuth to the server. Enter cli-
entAuth for the Name field and enter true for the Value field.

e. Click Save to save these new properties.

f. Logout of the Admin Console.

When you enable client authentication by setting the clientAuth prop-
erty to "true”, client authentication will be required for all the requests
going through the specified SSL port.

• Set the method of authentication to Client-Certificate using deploy-

tool. By enabling client authentication in this way, client authentication is
enabled only for a specific resource controlled by the security constraint.
Setting client authentication in this way is discussed in Example: Client-
Certificate Authentication over HTTP/SSL with JAX-RPC (page 950).

When client authentication is enabled in both ways mentioned above, client
authentication will be performed twice.

Verifying Mutual Authentication is Running
You can verify that mutual authentication is working by obtaining debug mes-
sages. This should be done at the client end, and this example shows how to pass
a system property in targets.xml so that targets.xml forks a client with
javax.net.debug in its system properties, which could be added in a file such
as <INSTALL>/j2eetutorial14/examples/security/common/targets.xml.

To enable debug messages for SSL mutual authentication, pass the system prop-
erty javax.net.debug=ssl,handshake, which will provide information on
whether mutual authentication is working or not. The following example modi-
fies the run-mutualauth-client target from the <INSTALL>/j2eetutorial14/

examples/security/common/targets.xml file by adding sysproperty as
shown in bold:

<target name="run-mutualauth-client"
description="Runs a client with mutual authentication over
SSL">

<java classname="${client.class}" fork="yes" >
<arg line="${key.store} ${key.store.password}

${trust.store} ${trust.store.password}
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${endpoint.address}" />
<sysproperty key="javax.net.debug" value="ssl,

handshake" />
<sysproperty key="javax.net.ssl.keyStore"

value="${key.store}" />
<sysproperty key="java.net.ssl.keyStorePassword"

value="${key.store.password}"/>
<classpath refid="run.classpath" />

</java>
</target>

XML and Web Services Security
XML and Web Services Security can include Transport-Level Security and Mes-
sage-Level Security. This section discusses Transport-Level Security, which
includes the following tutorials. Information about using Message-Level Secu-
rity may be included in future releases of the J2EE Tutorial.

Transport-Level Security (page 942), is where security is addressed by the trans-
port layer. Adding security in this way is discussed in the following example sec-
tions:

• Example: Basic Authentication with JAX-RPC (page 943)

• Example: Client-Certificate Authentication over HTTP/SSL with JAX-
RPC (page 950)

Transport-Level Security
Authentication is a process that verifies the identity of a user, device, or other
entity in a computer system, usually as a prerequisite to allowing access to
resources in a system. There are several ways in which this can happen, the fol-
lowing ways are discussed in this section:

• A user authentication method can be defined for an application in its
deployment descriptor. When a user authentication method is specified for
an application, the Web container activates the specified authentication
mechanism when you attempt to access a protected resource. The options
for user authentication methods are discussed in Using Login
Authentication, page 920. The example application discussed in Example:
Basic Authentication with JAX-RPC (page 943) shows how to add basic
authentication to a JAX-RPC application. The example discussed in
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Example: Client-Certificate Authentication over HTTP/SSL with JAX-
RPC, page 950 shows how to add client-certificate, or mutual, authentica-
tion to a JAX-RPC application.

• A transport guarantee can be defined for an application in its deployment
descriptor. Use this method to run over an SSL-protected session and
ensure that all message content is protected for confidentiality. The options
for transport guarantees are discussed in Specifying a Secure
Connection, page 919. An example application that discusses running over
an SSL-protected session is discussed in Example: Client-Certificate
Authentication over HTTP/SSL with JAX-RPC (page 950).

When running over an SSL-protected session, the server and client can
authenticate one another and negotiate an encryption algorithm and cryp-
tographic keys before the application protocol transmits or receives its
first byte of data.

Secure Socket Layer (SSL) technology allows Web browsers and Web
servers to communicate over a secured connection. In this secure connec-
tion, the data that is being sent is encrypted before being sent, then
decrypted upon receipt and prior to processing. Both the browser and the
server encrypt all traffic before sending any data. For more information,
see What is Secure Socket Layer Technology? (page 932).

Digital certificates are necessary when running HTTP over SSL
(HTTPS). The HTTPS service of most Web servers will not run unless a
digital certificate has been installed. Digital certificates have already been
created for the J2EE 1.4 Application Server.

Example: Basic Authentication with JAX-
RPC
In this section, we discuss how to configure JAX-RPC-based Web service appli-
cations for HTTP basic authentication. With HTTP basic authentication, the
Web server will authenticate a user by using the user name and password
obtained from the Web client. If the topic of authentication is new to you, please
refer to the section titled Using Login Authentication, page 920.

For this tutorial, we begin with the example application in <INSTALL>/

j2eetutorial14/examples/jaxrpc/staticstub/ and <INSTALL>/

j2eetutorial14/examples/jaxrpc/helloservice/ and add user name/pass-
word authentication. The resulting application can be found in the directories
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<INSTALL>/j2eetutorial14/examples/security/basicauth/ and
<INSTALL>/j2eetutorial14/examples/security/basicauthclient/. In
general, the following steps are necessary to add basic authentication to a JAX-
RPC application. In the example application included with this tutorial, many of
these steps have been completed for you and are listed here expressly for the pur-
pose of listing what needs to be done should you wish to create a similar applica-
tion outside of this tutorial.

• Add the appropriate security elements using deploytool. For this exam-
ple, the security elements are added in the packaging and deployment
phase. Refer to Adding Basic Authentication using deploytool (page 949)
for more information.

• Edit the build.properties files. The build.properties file needs to be
modified because the properties in this file are specific to your installation.
See Setting Up To Build and Deploy Tutorial Examples (page 90) for
information on which properties need to be set.

• Set security properties in the client code. For the example application, this
step has been completed. The code for this example is shown in Set Secu-
rity Properties in the Client Code (page 944).

• Build, package, deploy, and run the Web service (see Building, Packaging,
Deploying, and Running the Example for Basic
Authentication, page 946). You will use the asant tool to compile and run
the example application.

Set Security Properties in the Client Code
The source code for the client is in the HelloClient.java file of the
<INSTALL>/j2eetutorial14/examples/security/basicauthclient/src/

directory. For basic authentication, the client code must set username and pass-

word properties. The username and password properties correspond to the admin

group, which includes the user name and password combination entered during
installation and the role of admin that is provided in the application deployment
descriptor as an authorized role for secure transactions. (See Setting up Security
Roles, page 912.)
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The client sets the aforementioned security properties as shown in the code
below. The code in bold is the code that had been added from the original ver-
sion of the jaxrpc/staticstub example application.

package basicauthclient;

import javax.xml.rpc.Stub;

public class HelloClient {

    public static void main(String[] args) {

        if (args.length !=3) {
System.out.println("HelloClient Error: Wrong

number of runtime arguments!");
System.exit(1);

        }

String username=args[0];
        String password=args[1];

String endpointAddress=args[2];

// print to display for verification purposes
System.out.println("username: " + username);

        System.out.println("password: " + password);
System.out.println("Endpoint address = " +

endpointAddress);

try {
Stub stub = createProxy();

stub._setProperty(
javax.xml.rpc.Stub.USERNAME_PROPERTY,

username);
stub._setProperty(

javax.xml.rpc.Stub.PASSWORD_PROPERTY,
password);

stub._setProperty
(javax.xml.rpc.Stub.ENDPOINT_ADDRESS_PROPERTY,
endpointAddress);

HelloIF hello = (HelloIF)stub;
System.out.println(hello.sayHello("Duke (secure)"));

        } catch (Exception ex) {
            ex.printStackTrace();
        }
    }
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    private static Stub createProxy() {
// Note: MyHelloService_Impl is implementation-specific.

        return (Stub)(new
MyHelloService_Impl().getHelloIFPort());

    }
}

Building, Packaging, Deploying, and Running
the Example for Basic Authentication
To build, package, deploy, and run the security/basicauth example using
basic authentication, follow these steps,

Build the Basic Authentication Example
1. Set up your system for running the tutorial examples if you haven’t done

so already by following the instructions in Setting Up To Build and Deploy
Tutorial Examples (page 90).

2. From a terminal window or command prompt, go to the <INSTALL>/

j2eetutorial14/examples/security/basicauth/ directory.

3. Build the JAX-RPC service by entering the following at the terminal win-
dow or command prompt in the basicauth/ directory (this and the follow-
ing steps that use asant assume that you have the executable for asant in
your path: if not, you will need to provide the fully-qualified path to the
executable). This command runs the target named build in the build.xml
file.

asant build

4. Change to the <INSTALL>/j2eetutorial14/examples/security/basi-

cauthclient/ directory. Build the JAX-RPC client by entering the fol-
lowing at the terminal window or command prompt:

asant build

Package the Basic Authentication Example
You can package the basic authentication example using deploytool, or just
open the Web ARchive (WAR file) located in the <INSTALL>/j2eetutorial14/

examples/security/provided-wars/basicauth.war file. This section shows
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the steps you use to package the JAX-RPC service. More detail on packaging
JAX-RPC services can be found in Packaging the Service (page 336).

1. Start the Application Server if you haven’t already done so. Instructions
for starting the Application Server can be found at Starting and Stopping
the J2EE Application Server (page 91).

2. Start deploytool if you haven’t already done so. Information on starting
deploytool can be found in Starting the deploytool Utility (page 92).

3. Select File→New→Web Component from the deploytool menu. The
wizard displays the following dialog boxes.

a. Introduction dialog box

1.Read the explanatory text for an overview of the wizard’s features.

2.Click Next.

b. WAR File dialog box

1.Select the button labeled Create New Stand-Alone WAR Module.

2.In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/security/basicauth/BasicAuth.war.

3.In the WAR Display Field, enter BasicAuth.

4.Click Edit.

5.In the tree under Available Files, locate the <INSTALL>/
j2eetutorial14/examples/security/basicauth/ directory.

6.Select the build/ subdirectory.

7.Click Add.

8.Click OK.

9.Click Next.

c. Choose Component Type dialog box

1.Select the Web Services Endpoint button.

2.Click Next.

d. Choose Service dialog box

1.In the WSDL File combo box, select WEB-INF/wsdl/MyBasicHel-
loService.wsdl.

2.In the Mapping File combo box, select build/mapping.xml.

3.Click Next.

e. Component General Properties dialog box
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1.In the Service Endpoint Implementation combo box, select basic-
auth.HelloImpl.

2.Click Next.

f. Web Service Endpoint dialog box

1.In the Service Endpoint Interface combo box, select basicauth.Hel-
loIF.

2.In the Namespace field, select urn:Foo.

3.In the Local Part field, select HelloIFPort.

4.deploytool will enter a default Endpoint Address URI HelloImpl in
this dialog. This endpoint address must be updated in the following
steps.

5.Click Next.

6.Click Finish.

To access MyHelloService, the tutorial clients will specify this service
endpoint address URI:

http://localhost:8080/basicauth-jaxrpc/hello

The /basicauth-jaxrpc string is the context root of the servlet that
implements MySecureHelloService. The /hello string is the servlet
alias.

4. Specify the endpoint address by setting the context root and alias as fol-
lows:

a. In deploytool, select BasicAuth in the tree.

b. Select the General tab.

c. In the Context Root field, enter basicauth-jaxrpc.

d. In the tree, select HelloImpl.

e. Select the Aliases tab.

f. In the Component Aliases table, add /hello. (Don’t forget the forward
slash.)

g. In the Endpoint tab, select hello for the Endpoint Address in the Sun-
specific Settings Frame.

h. Select File→Save.
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Adding Basic Authentication using deploytool
For HTTP basic authentication, the application deployment descriptor, web.xml,
includes the information on who is authorized to access the application, which
URL patterns and HTTP methods are protected, and what type of user authenti-
cation method this application uses. This information is added to the deployment
descriptor using deploytool, and its contents are discussed in more detail in
Web-Tier Security (page 914) and in the Java Servlet Specification, which can be
browsed or downloaded online at http://java.sun.com/products/servlet/.

1. Select the basic authentication example in the deploytool tree.

2. Select the Security tabbed pane.

3. Select Basic for the User Authentication Method.

4. Select Add Constraints to add a Security Constraint.

5. Select Add Collection to add a Web Resource Collection.

6. Select the Web Resource Collection from the list, then select Edit Collec-
tions.

7. Select Add URL Pattern. Enter /hello in the text field. Click OK.

8. Select the HTTP GET and POST methods.

9. Click OK to close the Edit Contents dialog.

10.Select Edit Roles on the Security tabbed pane to specify an authorized role
for this application.

11.Click Edit Roles in the Authorized Roles dialog to add an authorized user
to this application. Click Add in the Edit Roles dialog and add the Name
of admin. Click OK to close this dialog.

12.Select admin under the Roles in column, then click Add to add it to the list
of authorized roles for this application. Click OK to close the dialog.

Note that the Authorized Roles list specifies admin, a group that was specified
during installation. For more information on defining and linking roles to users
and groups defined on the server, see Setting up Security Roles (page 912).

Deploy the Basic Authentication Example
1. Start the Application Server if you have not already done so.

2. Deploy the WAR that contains the JAX-RPC service by selecting the
BasicAuth application in the deploytool tree, then select Tools→Deploy.

http://java.sun.com/products/servlet/
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Running the Basic Authentication Example
3. Run the JAX-RPC client by entering the following at the terminal window

or command prompt in the basicauthclient/ directory:

asant run

The client should display the following output:

Buildfile: build.xml

run-secure-client:
[java] username: your_name
[java] password: your_pwd
[java] Endpoint address = http://localhost:8080/basicauth-

jaxrpc/hello
[java] Hello Duke (secure)

BUILD SUCCESSFUL

Example: Client-Certificate
Authentication over HTTP/SSL with JAX-
RPC
In this section, we discuss how to configure a simple JAX-RPC-based Web ser-
vice application for client-certificate authentication over HTTP/SSL. Client-cer-
tificate authentication uses HTTP over SSL, in which the server and, optionally,
the client authenticate one another with Public Key Certificates. If the topic of
authentication is new to you, please refer to the section titled Using Login
Authentication (page 920).

This example application starts with the example application in <INSTALL>/

j2eetutorial14/examples/jaxrpc/helloservice/ and adds both client and
server authentication to the example. In SSL certificate-based basic authentica-
tion, the server presents its certificate to the client, and the client authenticates to
the server by sending its user name and password. This type of authentication is
sometimes called server authentication. Mutual authentication adds the dimen-
sion of client authentication. For mutual authentication, we need both the client’s
identity, as contained in a client certificate, and the server’s identity, as contained
in a server certificate inside a keystore file (keystore.jks), and we need both of
these identities to be contained in a mutual trust-store (cacerts.jks) where they
can be verified.
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To add mutual authentication to the <INSTALL>/j2eetutorial14/examples/

jaxrpc/helloservice/ example, we need to complete the following steps. In
the example application included with this tutorial, many of these steps have
been completed for you and are listed here expressly for the purpose of listing
what needs to be done should you wish to create a similar application outside of
this tutorial.

1. Create the appropriate certificates and keystores. For this example, the cer-
tificates and keystores are created for a generic localhost and are
included with the J2EE 1.4 Application Server. See the section Keystores
and Trust-Stores in the Mutual Authentication Example (page 951) for a
discussion of these files. If you are creating a different application, refer to
the section Setting Up Digital Certificates (page 933) for more information
on creating the keystores and certificates and importing the client and
server identity into the trust-store.

2. Edit the build.properties files to add the location and password to the
trust-store, and other properties, as appropriate. For a discussion of the
modifications that need to be made to build.properties, see Modifying
the Build Properties (page 952).

3. Set security properties in the client code. For the example application, this
step has been completed. For a discussion of the security properties that
have been set in HelloClient, see Setting Security Properties in the Client
Code (page 952).

4. Add the appropriate security elements using deploytool. The security
elements are discussed in the section Enabling Mutual Authentication over
SSL (page 954).

5. Build and package the client and server files, deploy the server, and run the
client (see Build, Package, Deploy, and Run the Mutual Authentication
Example, page 955). You will use the asant tool to compile and deploy-

tool to deploy the example application.

Keystores and Trust-Stores in the Mutual
Authentication Example
In this example, the keystore file (keystore.jks) and the trust-store file (cac-
erts.jks) have already been created for a generic localhost and are included
with the J2EE 1.4 Application Server in the directory <J2EE_HOME>/domains/
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domain1/config/. These files were created using the following steps, which are
discussed in more detail in Setting Up Digital Certificates (page 933).

1. Create a server certificate in the file keystore.jks.

2. Export the certificate.

3. Import the certificate into the trust-store, cacerts.jks.

4. Create a client certificate in the client keystore.

5. Export the certificate.

6. Import the certificate into the trust-store, cacerts.jks.

Modifying the Build Properties
To build and run the application with mutual authentication, we have set up the
example so that some of the values are passed to the application from various
build.properties files.

To run any of the examples, you need to modify the build.properties file
located in the <INSTALL>/j2eetutorial14/examples/common/ directory to
provide the location where the J2EE 1.4 Application Server is installed. If you
need more information, see Setting Up To Build and Deploy Tutorial
Examples (page 90).

For this example, the build.properties file that is specific to this application,
<INSTALL>/j2eetutorial14/examples/security/common/build.proper-

ties, has been modified for you. This file provides specific information about
the JAX-RPC examples to the asant targets we will be running later regarding
the location of the keystore and trust-store files and their associated passwords.

Make sure that the following properties exist and are correctly defined.

trust.store=${j2ee.home}/domains/domain1/config/cacerts.jks
trust.store.password=changeit
key.store=${j2ee.home}/domains/domain1/config/keystore.jks
key.store.password=changeit

Setting Security Properties in the Client Code
The source code for the client is in the HelloClient.java file of the
<INSTALL>/j2eetutorial14/examples/security/mutualauthclient/src/

directory. For mutual authentication, the client code must set several security-
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related properties. These values are passed into the client code when the asant

build and run tasks are executed.

• trustStore. The value of the trustStore property is the fully qualified
name of the trust-store file: <J2EE_HOME>/domains/domain1/config/

cacerts.jks

• trustStorePassword. The trustStorePassword property is the pass-
word of the trust-store. The default value of this password is changeit.

• keyStore. The value of the keyStore property is the fully qualified name
of the keystore file: <J2EE_HOME>/domains/domain1/config/key-

store.jks

• keyStorePassword. The keyStorePassword property is the password of
the keystore. The default value of this password is changeit.

• ENDPOINT_ADDRESS_PROPERTY. The endpointAddress property sets the
endpoint address that the stub uses to access the service.

The client sets the aforementioned security properties as shown in the code
below. The code in bold is the code that had been added from the original ver-
sion of the jaxrpc/staticstub example application.

package mutualauthclient;

import javax.xml.rpc.Stub;

public class HelloClient {

    public static void main(String[] args) {

        if (args.length !=5) {
System.out.println("HelloClient Error: Need 5
runtime arguments!");

System.exit(1);
        }

        String keyStore=args[0];
        String keyStorePassword=args[1];
        String trustStore=args[2];
        String trustStorePassword=args[3];

String endpointAddress=args[4];

// print to display for verification purposes
System.out.println("keystore: " + keyStore);
System.out.println("keystorePassword: " +
keyStorePassword);



954 SECURITY
        System.out.println("trustStore: " + trustStore);
System.out.println("trustStorePassword: " +
trustStorePassword);

        System.out.println("Endpoint address: " +
endpointAddress);

try {
Stub stub = createProxy();
System.setProperty("javax.net.ssl.keyStore",

keyStore);
System.setProperty("javax.net.ssl.keyStorePassword",

keyStorePassword);
System.setProperty("javax.net.ssl.trustStore",

trustStore);
System.setProperty("javax.net.ssl.trustStorePassword",

trustStorePassword);
stub._setProperty(

javax.xml.rpc.Stub.ENDPOINT_ADDRESS_PROPERTY,
endpointAddress);

HelloIF hello = (HelloIF)stub;
System.out.println(hello.sayHello("Duke! (secure!"));

        } catch (Exception ex) {
            ex.printStackTrace();
        }
    }

    private static Stub createProxy() {
// Note: MyHelloService_Impl is implementation-specific.

        return (Stub)(new
MySecureHelloService_Impl().getHelloIFPort());

    }
}

Enabling Mutual Authentication over SSL
The two ways of implementing client authentication are discussed in Enabling
Mutual Authentication Over SSL (page 940). You can set client authentication
for all applications (by specifying this in the deployment descriptor for the
server) or for just a single application (by specifying this in the deployment
descriptor for the application). For this example, we are enabling client authenti-
cation for this application only, so we specify the login authentication method as
being Client Certificate. The steps for adding Client Certificate authentica-
tion are shown in Adding Client Certificate Authentication using
deploytool (page 958).
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For more information on login configuration options, read Using Login
Authentication (page 920).

The user authentication method specifies a client-certificate method of authenti-
cation in this example. For this authentication to run over SSL, we also need to
specify which type of transport guarantee to use. For this example, we have cho-
sen CONFIDENTIAL, which is specified in the Network Security Requirement
field on the Security tabbed pane in deploytool.

For more information on this type of constraint, read Specifying a Secure
Connection (page 919).

Build, Package, Deploy, and Run the Mutual
Authentication Example
To build, deploy, and run the JAX-RPC service example with mutual authentica-
tion, follow these steps.

Build the Mutual Authentication Example
To compile the application files and copy them to the correct directories, run the
asant build task. More information on what happens when the build task is
called can be found in Building the Service (page 335).

1. If you haven’t already done so, follow these steps for setting up the exam-
ple.

• Configuring the SSL Connector (page 939).

• Setting Up To Build and Deploy Tutorial Examples (page 90).

2. Go to the <INSTALL>/j2eetutorial14/examples/security/mutual-

auth/ directory.

3. Build the JAX-RPC service by entering the following at the terminal win-
dow or command prompt in the mutualauth/ directory (this and the fol-
lowing steps that use asant assume that you have the executable for asant
in your path: if not, you will need to provide the fully-qualified path to the
asant executable):

asant build

4. Change to the directory <INSTALL>/j2eetutorial14/examples/secu-

rity/mutualauthclient/.

5. Build the JAX-RPC client by entering the following at the terminal win-
dow or command prompt:
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asant build

Package the Mutual Authentication Example
You can package the mutual authentication example using deploytool, or just
open the WAR file located in the <INSTALL>/j2eetutorial14/examples/

security/provided-wars/mutualauth.WAR file. This section shows the steps
you use to package the JAX-RPC service.

1. Start deploytool if you haven’t already done so.

2. Select File→New→Web Component from the deploytool menu. The
wizard displays the following dialog boxes.

a. Introduction dialog box

1.Read the explanatory text for an overview of the wizard’s features.

2.Click Next.

b. WAR File dialog box

1.Select the button labelled Create New Stand-Alone WAR Module.

2.In the WAR Location field, enter <INSTALL>/j2eetutorial14/

examples/security/mutualauth/MutualAuth.war.

3.In the WAR Display Field, enter MutualAuth.

4.Click Edit.

5.In the tree under Available Files, locate the <INSTALL>/
j2eetutorial14/examples/security/mutualauth/ directory.

6.Select the build/ subdirectory.

7.Click Add.

8.Click OK.

9.Click Next.

c. Choose Component Type dialog box

1.Select the Web Services Endpoint button.

2.Click Next.

d. Choose Service dialog box

1.In the WSDL File combo box, select WEB-INF/wsdl/MySecureHel-
loService.wsdl.

2.In the Mapping File combo box, select build/mapping.xml.

3.Click Next.
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e. Component General Properties dialog box

1.In the Service Endpoint Implementation combo box, select mutual-
auth.HelloImpl.

2.Click Next.

f. Web Service Endpoint dialog box

1.In the Service Endpoint Interface combo box, select mutual-

auth.HelloIF.

2.In the Namespace field, select urn:Foo.

3.In the Local Part field, select HelloIFPort.

4.deploytool will enter a default Endpoint Address URI HelloImpl in
this dialog. This endpoint address must be updated in the following
steps.

5.Click Next.

6.Click Finish.

To access MyHelloService, the tutorial clients will specify this service
endpoint address URI:

http://localhost:8080/mutualauth-jaxrpc/hello

The /mutualauth-jaxrpc string is the context root of the servlet that
implements MySecureHelloService. The /hello string is the servlet
alias.

3. Specify the endpoint address by setting the context root and alias as fol-
lows:

a. In deploytool, select mutualauth in the tree.

b. Select the General tab.

c. In the Context Root field, enter mutualauth-jaxrpc.

d. In the tree, select HelloImpl.

e. Select the Aliases tab.

f. In the Component Aliases table, add /hello. (Don’t forget the forward
slash.)

g. In the Endpoint tab, select hello for the Endpoint Address in the Sun-
specific Settings Frame.

h. Select File→Save.
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Adding Client Certificate Authentication using
deploytool
For HTTP client-certificate authentication, the application deployment descrip-
tor, web.xml, includes the information on who is authorized to access the appli-
cation, which URL patterns and HTTP methods are protected, and what type of
user authentication method this application uses. This information is added to
the deployment descriptor using deploytool, and its contents are discussed in
more detail in Web-Tier Security (page 914) and in the Java Servlet Specifica-
tion, which can be browsed or downloaded online at http://java.sun.com/
products/servlet/.

1. Select the mutualauth example in the deploytool tree.

2. Select the Security tabbed pane.

3. Select Client Certificate for the User Authentication Method.

4. Select Add Constraints to add a Security Constraint.

5. Select Add Collection to add a Web Resource Collection.

6. Select the Web Resource Collection from the list, then select Edit Collec-
tions.

7. Select Add URL Pattern. Enter /hello in the text field. Click OK.

8. Select the HTTP GET and POST methods.

9. Click OK to close the Edit Contents dialog.

10.Select CONFIDENTIAL under Network Security Requirement so that the
application requires HTTP/SSL.

11.Select Edit Roles on the Security tabbed pane to specify an authorized role
for this application.

12.Click Edit Roles in the Authorized Roles dialog to add an authorized user
to this application. Click Add in the Edit Roles dialog and add the Name
of admin. Click OK to close this dialog.

13.Select admin under the Roles in column, then click Add to add it to the list
of authorized roles for this application. Click OK to close the dialog.

Note that the Authorized Roles list specifies admin, a group that was specified
during installation. For more information on defining and linking roles to users
and groups defined on the server, see Setting up Security Roles (page 912).

http://java.sun.com/products/servlet/
http://java.sun.com/products/servlet/
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Deploy the Mutual Authentication Example
1. Deploy the JAX-RPC service by selecting the mutualauth example in the

deploytool tree, then select Tools→Deploy.

Run the Mutual Authentication Example
Enter the following command from the mutualauthclient/ directory at the ter-
minal window or command prompt to run the JAX-RPC client:

 asant run

The client should display the following output:

Buildfile: build.xml

run-mutualauth-client:
[java] keyStore: <J2EE_HOME>/domains/domain1/config/

cacerts.jks
[java] keyStorePassword: changeit
[java] trustStore: <J2EE_HOME>/domains/domain1/config/

keystore.jks
[java] trustStorePassword: changeit
[java] endpointAddress = https://localhost:1043/secure-

mutualauth/hello
[java] Hello Duke (secure)

BUILD SUCCESSFUL

For information on verifying that mutual authentication is running, see Verifying
Mutual Authentication is Running (page 941).

EJB-Tier Security
The following sections describe declarative and programmatic security mecha-
nisms that can be used to protect resources in the EJB tier. The protected
resources include methods of enterprise beans that are called from application
clients, Web components, or other enterprise beans.

You can protect EJB-tier resources by doing the following:

• Declaring method permissions

• Mapping roles to J2EE users and groups
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For information about mapping roles to J2EE users and groups, see Mapping
Roles to Users and Groups (page 913).

Declaring Method Permissions
After you’ve defined the roles (see Setting up Security Roles, page 912), you can
define the method permissions of an enterprise bean. Method permissions indi-
cate which roles are allowed to invoke which methods. You can define method
permissions in different ways.

• You can apply method permissions to all of the methods of the specified
enterprise bean’s home, component, and/or Web service endpoint inter-
faces.

• You can apply method permissions to the specified method of the enter-
prise bean. If the enterprise bean contains multiple methods with the same
method name, the method permission applies to all of the methods.

• If the enterprise bean contains multiple methods with the same method
name but the methods have different method parameters (such as cre-

ate(a,b) and create(a,b,c)), you can apply method permissions by
specifying the method parameters.

In general, use deploytool to specify method permissions by mapping roles to
methods:

1. Select the enterprise bean.

2. Select the Security tab.

3. Select the interface type (Local, Local Home, Remote, or Remote Home)
and the table displays methods contained in the selected interface. If no
interfaces have been defined, the interface buttons will be disabled.

4. In the Method permissions table, select Sel Roles in the Availability col-
umn.

5. Then select a role’s checkbox if that role should be allowed to invoke a
method.

Configuring IOR Security
Enterprise beans that are deployed in one vendor’s server product are often
accessed from J2EE client components that are deployed in another vendor’s
product. Common Secure Interoperability version 2 (CSIv2), a CORBA/IIOP-
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based standard interoperability protocol, addresses this situation by providing
authentication, protection of integrity and confidentiality, and principal propaga-
tion for invocations on enterprise beans, where the invocations take place over an
enterprise’s intranet.

CSIv2 config settings are specified in the Interoperable Object Reference (IOR)
of the target enterprise bean. In the IOR security configuration dialog, you can
specify the security information for the Interoperable Object Reference (IOR).

To get to the IOR security configuration dialog, select the enterprise bean to
which you want to add the settings in the deploytool tree view. From the Gen-
eral tabbed pane, select Sun-specific Settings. In the General sub-pane of the
EJB Settings pane, press the IOR button.

In the Transport Configuration sub-pane:

• The Integrity field specifies if the target supports integrity-protected mes-
sages for transport.

• The Confidentiality field specifies if the target supports privacy-protected
messages (SSL) for transport.

• The Establish Trust in Target field specifies whether or not the target com-
ponent is capable of authenticating to a client for transport. Used for
mutual authentication (validate the server's identity).

The Establish Trust in Client field specifies whether or not the target component
is capable of authenticating a client for transport (target asks the client to authen-
ticate itself).

In each of these fields, you can select whether the item is supported, required, or
none (not activated).

In the As Context sub-pane:

• Use the Required drop-down list to identify if the authentication method
specified is required to be used for client authentication. Setting this field
to True indicates that the authentication method specified is required; False
indicates the method authentication is not required.

• Use the Authorization Method drop-down list to authenticate the client.
The only supported value is USERNAME_PASSWORD.

• Use the Realm field to identify the realm in which the user is authenticated.

In the Duke's Bank example, the As Context setting is used to require client
authentication (with username password) when access to protected methods in
the AccountControllerBean and CustomerControllerBean components is
attempted.
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In the Sas Context sub-pane:

• Use the Caller Propagation drop-down list to identify whether or not the
target component will accept propagated caller identities.

In the Duke's Bank example, the Sas Context setting is set to Supported for the
AccountBean, CustomerBean, and TxBean components, indicating that these tar-
get components will accept propagated caller identities.

Using Programmatic Security in the EJB
Tier
Programmatic security in the EJB tier consists of the getCallerPrincipal and
the isCallerInRole methods. You can use the getCallerPrincipal method to
determine the caller of the enterprise bean, and the isCallerInRole method to
determine if the caller has the specified role.

The getCallerPrincipal method of the EJBContext interface returns the
java.security.Principal object that identifies the caller of the enterprise
bean. (In this case, a principal is the same as a user.) In the following example,
the getUser method of an enterprise bean returns the name of the J2EE user that
invoked it:

public String getUser() {
   return context.getCallerPrincipal().getName();
}

You can determine whether an enterprise bean’s caller belongs to the Customer

role.

boolean result = context.isCallerInRole("Customer");

Unauthenticated User Name
Web applications accept unauthenticated Web clients and allow these clients to
make calls to the EJB container. The EJB specification requires a security cre-
dential for accessing EJB methods. Typically, the credential will be that of a
generic unauthenticated user.



APPLICATION CLIENT-TIER SECURITY 963
Application Client-Tier Security
Authentication requirements for J2EE application clients are the same as the
requirements for other J2EE components. Access to protected resources in either
the EJB tier or the Web tier requires user authentication, whereas access to
unprotected resources does not.

An application client can use the Java Authentication and Authorization Service
(JAAS) for authentication. JAAS implements a Java version of the standard
Pluggable Authentication Module (PAM) framework, which permits applica-
tions to remain independent from underlying authentication technologies. You
can plug new or updated authentication technologies under an application with-
out making any modifications to the application itself. Applications enable the
authentication process by instantiating a LoginContext object, which, in turn,
references a configuration to determine the authentication technologies or login
modules that will be used to perform the authentication.

A typical login module could prompt for and verify a user name and password.
Other modules could read and verify a voice or fingerprint sample.

In some cases, a login module needs to communicate with the user to obtain
authentication information. Login modules use a javax.security.auth.call-

back.CallbackHandler for this purpose. Applications implement the Call-

backHandler interface and pass it to the login context, which forwards it directly
to the underlying login modules. A login module uses the callback handler both
to gather input (such as a password or smart card PIN number) from users or to
supply information (such as status information) to users. By allowing the appli-
cation to specify the callback handler, an underlying login module can remain
independent of the different ways applications interact with users.

For example, the implementation of a callback handler for a GUI application
might display a window to solicit user input. Or, the implementation of a call-
back handler for a command line tool might simply prompt the user for input
directly from the command line.

The login module passes an array of appropriate callbacks to the callback han-
dler’s handle method (for example, a NameCallback for the user name and a
PasswordCallback for the password), and the callback handler performs the
requested user interaction and sets appropriate values in the callbacks. For exam-
ple, to process a NameCallback, the CallbackHandler may prompt for a name,
retrieve the value from the user, and call the setName method of the NameCall-

back to store the name.
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EIS-Tier Security
In the EIS tier, an application component requests a connection to an EIS
resource. As part of this connection, the EIS may require a sign-on to the
resource. The application component provider has two choices for the design of
the EIS sign-on:

• With the container-managed sign-on approach, the application component
lets the container take the responsibility of configuring and managing the
EIS sign-on. The container determines the user name and password for
establishing a connection to an EIS instance.

• With the component-managed sign-on approach, the application compo-
nent code manages EIS sign-on by including code that performs the sign-
on process to an EIS.

Container-Managed Sign-On
With container-managed sign-on, an application component does not have to
pass any security information for signing on to the resource to the getConnec-

tion() method. The security information is supplied by the container, as shown
in the following example.

// Business method in an application component
Context initctx = new InitialContext();

// Perform JNDI lookup to obtain a connection factory
javax.resource.cci.ConnectionFactory cxf =
     (javax.resource.cci.ConnectionFactory)initctx.lookup(
      “java:comp/env/eis/MainframeCxFactory”);

// Invoke factory to obtain a connection. The security
// information is not passed in the getConnection method
javax.resource.cci.Connection cx = cxf.getConnection();
...

Component-Managed Sign-On
With component-managed sign-on, an application component is responsible for
passing the security information that is needed for signing on to the resource to



CONFIGURING RESOURCE ADAPTER SECURITY 965
the getConnection() method. Security information could be a user name and
password, for example, as shown here:

// Method in an application component
Context initctx = new InitialContext();

// Perform JNDI lookup to obtain a connection factory
javax.resource.cci.ConnectionFactory cxf =
     (javax.resource.cci.ConnectionFactory)initctx.lookup(
       “java:comp/env/eis/MainframeCxFactory”);

// Get a new ConnectionSpec
com.myeis.ConnectionSpecImpl properties = //..

// Invoke factory to obtain a connection
properties.setUserName(“...”);
properties.setPassword(“...”);
javax.resource.cci.Connection cx =
  cxf.getConnection(properties);
...

Configuring Resource Adapter Security
In addition to configuring the sign-on, you can also configure the following secu-
rity settings for the resource adapter:

• Authentication mechanism(s)

• Reauthentication support

• Security permissions

To configure these settings using deploytool:

1. Select the resource adapter file.

2. Select the Security tabbed pane.

3. In the Authentication Mechanisms pane, specify the authentication mech-
anism(s) that are supported by this resource adapter:

• Select Password to require a username and password to connect to an
EIS

• Select Kerberos Version 5.0 to require the resource adapter to support
the Kerberos authentication mechanism.
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You can select more than one mechanism or no mechanism. If you do not
select one, no standard security authentication is supported as part of the
security contract.

4. Select Reauthentication Supported if the resource adapter implementation
supports performing reauthentication on an existing physical connection.
Reauthentication is performed when an application server calls the get-
Connection method with a security context that is different than the one
used to establish the connection. This information is for the resource
adapter implementation and not for the underlying EIS instance.

5. In the Security Permissions pane, click Add to enter a security permission
that the resource adapter needs to access system resources in the opera-
tional environment. You need to specify only those permissions that are not
included in the default set (see section 11.2 of the Connector specification).
For example, to allow the resource to look up the name of any remote host,
add the following security permission:

 permission java.net.SocketPermission *, "resolve";

For each security permission you add, click the column to the far right
labelled with a folded paper to enter a description for the permission. To
delete a security permission, select the permission in the table and click
Delete.

Propagating Security Identity
When you deploy an enterprise bean or Web component, you can specify the
security identity that will be propagated (illustrated in Figure 27–1) to enterprise
beans invoked from within that component.
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Figure 27–1 Security Identity Propagation

You can choose one of the following propagation styles:

• The caller identity of the intermediate component is propagated to the tar-
get enterprise bean. This technique is used when the target container trusts
the intermediate container.

• A specific identity is propagated to the target enterprise bean. This tech-
nique is used when the target container expects access via a specific iden-
tity.

Configuring a Component’s Propagated
Security Identity
To configure an enterprise bean’s propagated security identity:

1. Select the enterprise bean to configure.

2. In the Security Identity panel of the Security pane, select the security iden-
tity that will be propagated to the beans that this enterprise bean calls:

• If you want the principal of this enterprise bean’s caller to be propagated
to other beans that it calls, choose Use Caller ID.

• If you want a security identity other than the caller’s identity propagated
to other beans, choose Run as Role, select the role from the menu, then
select the User in Role from the available users in the selected role.

3. If the role that you want to use as the security identity is not in the list, click
Edit Roles and add the role.
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To configure a Web component’s propagated security identity:

1. Select the Web component to configure.

2. In the Security Identity panel of the Security pane, select Use Caller ID if
the caller ID is to be propagated to methods of other components called
from this Web component. Otherwise, select Run as Role, and select a role
from the list of known roles in the WAR file.

3. If the role that you want to use as the security identity is not in the list, click
Edit Roles and add it.

Configuring Client Authentication
If an application component in an application client container accesses a pro-
tected method on a bean, use client authentication.

Trust between Containers
When an enterprise bean is designed so that either the original caller identity or a
designated identity is used to call a target bean, the target bean will receive the
propagated identity only; it will not receive any authentication data.

There is no way for the target container to authenticate the propagated security
identity. However, since the security identity is used in authorization checks (for
example, method permissions or with the isCallerInRole() method), it is
vitally important that the security identity be authentic. Since there is no authen-
tication data available to authenticate the propagated identity, the target must
trust that the calling container has propagated an authenticated security identity.

By default, the J2EE 1.4 Application Server is configured to trust identities that
are propagated from different containers. Therefore, there are no special steps
that you need to take to set up a trust relationship.

What is Java Authorization Contract for
Containers?

Java Authorization Contract for Containers (JACC) defines security contracts
between the J2EE Application Server and authorization policy modules. These
contracts specify how the authorization providers are installed, configured, and
used in access decisions.
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J2EE Connector
Architecture

THE other chapters in this book are intended for business application develop-
ers, but this chapter is for advanced users such as system integrators and tools
developers.

The J2EE Connector architecture enables J2EE components such as enterprise
beans to interact with enterprise information systems (EISs). EIS software
includes various types of systems: enterprise resource planning (ERP), main-
frame transaction processing, and non-relational databases, among others. The
J2EE Connector architecture simplifies the integration of diverse EISs. Each EIS
requires just one implementation of the J2EE Connector architecture. Because
an implementation adheres to the J2EE Connector Specification, it is portable
across all compliant J2EE servers.

About Resource Adapters
A resource adapter is a J2EE component that implements the J2EE Connector
architecture for a specific EIS. It is through the resource adapter that a J2EE
application and an EIS communicate with each other (see Figure 28–1).

Stored in a Resource Adapter Archive (RAR) file, a resource adapter may be
deployed on any J2EE server, much like the EAR file of a J2EE application. A
RAR file may be contained in an EAR file or it may exist as a separate file.
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A resource adapter is analogous to a JDBC driver. Both provide a standard API
through which an application can access a resource that is outside the J2EE
server. For a resource adapter, the outside resource is an EIS; for a JDBC driver,
it is a DBMS. Resource adapters and JDBC drivers are rarely created by applica-
tion developers. In most cases, both types of software are built by vendors who
sell products such as tools, servers, or integration software.

Resource Adapter Contracts
Figure 28–1 shows the application and system contracts, the two principal con-
tracts implemented by a resource adapter. The application contract defines the
API through which a J2EE component such as an enterprise bean accesses the
EIS. This API is the only view that the component has of the EIS. The resource
adapter itself and its system contracts are transparent to the J2EE component.

The system contracts link the resource adapter to important services—connec-
tion, transaction, and security—that are managed by the J2EE server.
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Figure 28–1 Accessing an EIS Through a Resource Adapter

The connection management contract supports connection pooling, a technique
that enhances application performance and scalability. Connection pooling is
transparent to the application, which simply obtains a connection to the EIS.

Because of the transaction management contract, a call to the EIS may be
enclosed in an XA transaction. XA transactions are global—they may contain
calls to multiple EISs, databases, and enterprise bean business methods.
Although often appropriate, XA transactions are not mandatory. Instead, an
application may use local transactions, which are managed by the individual
EIS, or it may use no transactions at all.

To protect the information in an EIS, the security management contract provides
these mechanisms: authentication, authorization, and secure communication
between the J2EE server and the EIS.
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Connector 1.5 Resource Adapters
With the latest release of the Connector architecture (Connector 1.5), EISs and
external systems can supply resource adapters for connecting from an EIS to a
J2EE application server. The architecture specifies additional contracts, includ-
ing a lifecycle management contract, a work management contract, and plugga-
bility contracts for message providers and for importing transactions. By
following the specification, a resource adapter provider has the flexibility to
implement those services that it desires or needs.

Extending Messaging Capabilities
To enable external systems to connect to a J2EE application server, the Connec-
tor architecture has extended the capabilities of message-driven beans to handle
messages from any message provider. That is, message-driven beans are no
longer limited to handling JMS messages. Instead, EISs and message providers
can plug any message provider, including their own custom or proprietary mes-
sage providers, into a J2EE container.

To use this feature, a message provider or an EIS provides a resource adapter
according to the Connector 1.5-specified contract. The contract details APIs for
message handling and message delivery. A conforming resource adapter is
assured of the ability to send messages from any provider to a message-driven
bean, plus it can be plugged into a J2EE container in a standard manner.

Work Management Contract
The Connector 1.5 work management contract ensures that resource adapters use
threads in the proper, recommended manner. It also enables the J2EE application
server to manage threads for resource adapters.

Resource adapters that improperly use threads can create problems for the entire
application server environment. For example, a resource adapter might create too
many threads or it might not properly release threads it has created. Poor thread
handling inhibits application server shutdown. It also impacts the application
server’s performance because creating and destroying threads are expensive
operations.

The work management contract establishes a means for the application server to
pool and reuse threads, similar to pooling and reusing connections. By adhering
to this contract, the resource adapter does not have to manage threads itself.
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Instead, the resource adapter has the application server create and provide
needed threads. When the resource adapter is finished with a given thread, it
returns the thread to the application server. The application server manages the
thread: it can return the thread to a pool and reuse it later, or it may destroy the
thread. Handling threads in this manner results in increased application server
performance and more efficient use of resources.

In addition to moving thread management to the application server, the Connec-
tor 1.5 architecture also provides a flexible model for a resource adapter that uses
threads:

• The requesting thread can choose to block—stop its own execution—until
the work thread completes.

• Or, the requesting thread can block while it waits to get the thread. When
the application server provides a work thread, then the requesting thread
and the work thread execute in parallel.

• The resource adapter can opt to submit the work for the thread to a queue.
The thread executes the work from the queue at some later point. The
resource adapter continues its own execution from the point it submitted
the work to the queue, regardless of when the thread executes it.

With the latter two approaches, the resource adapter and the thread may execute
simultaneously or independently from each other. For these approaches, the con-
tract specifies a listener mechanism to notify the resource adapter that the thread
has completed its operation. The resource adapter can also specify the execution
context for the thread and the work management contract controls the context in
which the thread executes.

Transaction Inflow
The Connector 1.5 architecture also expands the transaction support for resource
adapters. Previously, transaction flow went from the J2EE application server to
an EIS. That is, the transaction started from an enterprise bean on the J2EE
application server, and the same transaction remained in force during operations
on the EIS.

Now, transactions can be imported from an EIS to the J2EE application server.
The architecture specifies how to propagate the transaction context from the EIS.
For example, a transaction can be started by the EIS, such as a CICs system.
Within the same CICs transaction, a connection can be made through a resource
adapter to an enterprise bean on the application server. The enterprise bean does
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its work under the CICs transaction context and commits within that transaction
context.

The Connector 1.5 architecture also specifies how the container participates in
transaction completion and how it handles crash recovery to ensure that data
integrity is not lost.

Lifecycle Management
The Connector 1.5 architecture specifies a lifecycle management contract that
allows an application server to manage the lifecycle of a resource adapter. This
contract provides a mechanism for the application server to bootstrap a resource
adapter instance during the instance’s deployment or application server startup.
It also provides a means for the application server to notify the resource adapter
instance when it is undeployed or when an orderly shutdown of the application
server takes place.

Common Client Interface
This section describes how components use the Connector architecture Common
Client Interface (CCI) API and a resource adapter to access data from an EIS.
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Defined by the J2EE Connector architecture specification, the CCI defines a set
of interfaces and classes whose methods allow a client to perform typical data
access operations. The CCI interfaces and classes are as follows:

• ConnectionFactory: Provides an application component with a Connec-

tion instance to an EIS.

• Connection: Represents the connection to the underlying EIS.

• ConnectionSpec: Provides a means for an application component to pass
connection-request-specific properties to the ConnectionFactory when
making a connection request.

• Interaction: Provides a means for an application component to execute
EIS functions, such as database stored procedures.

• InteractionSpec: Holds properties pertaining to an application compo-
nent’s interaction with an EIS.

• Record: The superclass for the different kinds of record instances. Record
instances may be MappedRecord, IndexedRecord, or ResultSet

instances, which all inherit from the Record interface.

• RecordFactory: Provides an application component with a Record

instance.

• IndexedRecord: Represents an ordered collection of Record instances
based on the java.util.List interface.

A client or application component that uses the CCI to interact with an underly-
ing EIS does so in a prescribed manner. The component must establish a connec-
tion to the EIS’s resource manager, and it does so using the ConnectionFactory.
The Connection object represents the actual connection to the EIS and is used
for subsequent interactions with the EIS.

The component performs its interactions with the EIS, such as accessing data
from a specific table, using an Interaction object. The application component
defines the Interaction object using an InteractionSpec object. When the
application component reads data from the EIS (such as from database tables) or
writes to those tables, it does so using a particular type of Record instance, either
a MappedRecord, IndexedRecord, or ResultSet instance. Just as the Connec-

tionFactory creates Connection instances, a RecordFactory creates Record

instances.

Note, too, that a client application that relies on a CCI resource adapter is very
much like any other J2EE client that uses enterprise bean methods.
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The Java Message
Service API

THIS chapter provides an introduction to the Java Message Service Application
Programming Interface (the JMS API). It contains the following sections:

• Overview

• Basic JMS API Concepts

• The JMS API Programming Model

• Writing Simple JMS Client Applications

• Creating Robust JMS Applications

• Using the JMS API in a J2EE Application

• Further Information

Overview
This overview of the JMS API answers the following questions.

• What Is Messaging?

• What Is the JMS API?

• When Can You Use the JMS API?

• How Does the JMS API Work with the J2EE Platform?
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What Is Messaging?
Messaging is a method of communication between software components or
applications. A messaging system is a peer-to-peer facility: A messaging client
can send messages to, and receive messages from, any other client. Each client
connects to a messaging agent that provides facilities for creating, sending,
receiving, and reading messages.

Messaging enables distributed communication that is loosely coupled. A compo-
nent sends a message to a destination, and the recipient can retrieve the message
from the destination. However, the sender and the receiver do not have to be
available at the same time in order to communicate. In fact, the sender does not
need to know anything about the receiver; nor does the receiver need to know
anything about the sender. The sender and the receiver need to know only what
message format and what destination to use. In this respect, messaging differs
from tightly coupled technologies, such as Remote Method Invocation (RMI),
which require an application to know a remote application’s methods.

Messaging also differs from electronic mail (e-mail), which is a method of com-
munication between people or between software applications and people. Mes-
saging is used for communication between software applications or software
components.

What Is the JMS API?
The Java Message Service is a Java API that allows applications to create, send,
receive, and read messages. Designed by Sun and several partner companies, the
JMS API defines a common set of interfaces and associated semantics that allow
programs written in the Java programming language to communicate with other
messaging implementations.

The JMS API minimizes the set of concepts a programmer must learn to use
messaging products but provides enough features to support sophisticated mes-
saging applications. It also strives to maximize the portability of JMS applica-
tions across JMS providers in the same messaging domain.

The JMS API enables communication that is not only loosely coupled but also

• Asynchronous. A JMS provider can deliver messages to a client as they
arrive; a client does not have to request messages in order to receive them.
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• Reliable. The JMS API can ensure that a message is delivered once and
only once. Lower levels of reliability are available for applications that can
afford to miss messages or to receive duplicate messages.

The JMS Specification was first published in August 1998. The latest version of
the JMS Specification is Version 1.1, which was released in April 2002. You can
download a copy of the Specification from the JMS Web site, http://

java.sun.com/products/jms/.

When Can You Use the JMS API?
An enterprise application provider is likely to choose a messaging API over a
tightly coupled API, such as Remote Procedure Call (RPC), under the following
circumstances.

• The provider wants the components not to depend on information about
other components’ interfaces, so that components can be easily replaced.

• The provider wants the application to run whether or not all components
are up and running simultaneously.

• The application business model allows a component to send information to
another and to continue to operate without receiving an immediate
response.

For example, components of an enterprise application for an automobile manu-
facturer can use the JMS API in situations like these.

• The inventory component can send a message to the factory component
when the inventory level for a product goes below a certain level, so the
factory can make more cars.

• The factory component can send a message to the parts components so that
the factory can assemble the parts it needs.

• The parts components in turn can send messages to their own inventory
and order components to update their inventories and to order new parts
from suppliers.

• Both the factory and the parts components can send messages to the
accounting component to update their budget numbers.

• The business can publish updated catalog items to its sales force.

Using messaging for these tasks allows the various components to interact with
one another efficiently, without tying up network or other resources. Figure 29–1
illustrates how this simple example might work.

http://java.sun.com/products/jms/
http://java.sun.com/products/jms/
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Figure 29–1 Messaging in an Enterprise Application

Manufacturing is only one example of how an enterprise can use the JMS API.
Retail applications, financial services applications, health services applications,
and many others can make use of messaging.

How Does the JMS API Work with the
J2EE Platform?
When the JMS API was introduced in 1998, its most important purpose was to
allow Java applications to access existing messaging-oriented middleware
(MOM) systems, such as MQSeries from IBM. Since that time, many vendors
have adopted and implemented the JMS API, so that a JMS product can now
provide a complete messaging capability for an enterprise.

Since the 1.3 release of the J2EE platform (“the J2EE 1.3 platform”), the JMS
API has been an integral part of the platform, and application developers can use
messaging with components using J2EE APIs (“J2EE components”).

The JMS API in the J2EE platform has the following features.

• Application clients, Enterprise JavaBeans (EJB) components, and Web
components can send or synchronously receive a JMS message. Applica-
tion clients can in addition receive JMS messages asynchronously.
(Applets, however, are not required to support the JMS API.)

• Message-driven beans, which are a kind of enterprise bean, enable the
asynchronous consumption of messages. A JMS provider may optionally
implement concurrent processing of messages by message-driven beans.
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• Message sends and receives can participate in distributed transactions.

The JMS API enhances the J2EE platform by simplifying enterprise develop-
ment, allowing loosely coupled, reliable, asynchronous interactions among J2EE
components and legacy systems capable of messaging. A developer can easily
add new behavior to a J2EE application with existing business events by adding
a new message-driven bean to operate on specific business events. The J2EE
platform’s EJB container architecture, moreover, enhances the JMS API by pro-
viding support for distributed transactions and allowing for the concurrent con-
sumption of messages.

Another J2EE platform technology, the J2EE Connector Architecture, provides
tight integration between J2EE applications and existing Enterprise Information
(EIS) systems. The JMS API, on the other hand, allows for a very loosely cou-
pled interaction between J2EE applications and existing EIS systems.

At the 1.4 release of the J2EE platform, the JMS provider may be integrated with
the application server using the J2EE Connector Architecture. You access the
JMS provider through a resource adapter. For more information, see the Enter-
prise JavaBeans Specification, v2.1, and the J2EE Connector Architecture Spec-
ification, v1.5.

Basic JMS API Concepts
This section introduces the most basic JMS API concepts, the ones you must
know to get started writing simple JMS client applications:

• JMS API Architecture

• Messaging Domains

• Message Consumption

The next section introduces the JMS API programming model. Later sections
cover more advanced concepts, including the ones you need to write J2EE appli-
cations that use message-driven beans.
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JMS API Architecture
A JMS application is composed of the following parts.

• A JMS provider is a messaging system that implements the JMS interfaces
and provides administrative and control features. An implementation of
the J2EE platform at release 1.3 and above includes a JMS provider.

• JMS clients are the programs or components, written in the Java program-
ming language, that produce and consume messages. Any J2EE compo-
nent can act as a JMS client.

• Messages are the objects that communicate information between JMS cli-
ents.

• Administered objects are preconfigured JMS objects created by an admin-
istrator for the use of clients. The two kinds of administered objects are
destinations and connection factories, which are described in Adminis-
tered Objects (page 987).

Figure 29–2 illustrates the way these parts interact. Administrative tools allow
you to bind destinations and connection factories into a Java Naming and Direc-
tory Interface (JNDI) API namespace. A JMS client can then look up the admin-
istered objects in the namespace and then establish a logical connection to the
same objects through the JMS provider.

Figure 29–2 JMS API Architecture

Messaging Domains
Before the JMS API existed, most messaging products supported either the
point-to-point or the publish/subscribe approach to messaging. The JMS Specifi-
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cation provides a separate domain for each approach and defines compliance for
each domain. A standalone JMS provider may implement one or both domains.
A J2EE provider must implement both domains.

In fact, most implementations of the JMS API provide support for both the
point-to-point and the publish/subscribe domains, and some JMS clients com-
bine the use of both domains in a single application. In this way, the JMS API
has extended the power and flexibility of messaging products.

The JMS 1.1 Specification goes one step further: it provides common interfaces
that enable you to use the JMS API in a way that is not specific to either domain.
The following subsections describe the two messaging domains and then
describes this new way of programming using common interfaces.

Point-to-Point Messaging Domain
A point-to-point (PTP) product or application is built around the concept of mes-
sage queues, senders, and receivers. Each message is addressed to a specific
queue, and receiving clients extract messages from the queue(s) established to
hold their messages. Queues retain all messages sent to them until the messages
are consumed or until the messages expire.

PTP messaging has the following characteristics and is illustrated in Figure 29–
3.

Figure 29–3 Point-to-Point Messaging

• Each message has only one consumer.

• A sender and a receiver of a message have no timing dependencies. The
receiver can fetch the message whether or not it was running when the cli-
ent sent the message.

• The receiver acknowledges the successful processing of a message.
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Use PTP messaging when every message you send must be processed success-
fully by one consumer.

Publish/Subscribe Messaging Domain
In a publish/subscribe (pub/sub) product or application, clients address messages
to a topic. Publishers and subscribers are generally anonymous and may dynam-
ically publish or subscribe to the content hierarchy. The system takes care of dis-
tributing the messages arriving from a topic’s multiple publishers to its multiple
subscribers. Topics retain messages only as long as it takes to distribute them to
current subscribers.

Pub/sub messaging has the following characteristics.

• Each message may have multiple consumers.

• Publishers and subscribers have a timing dependency. A client that sub-
scribes to a topic can consume only messages published after the client has
created a subscription, and the subscriber must continue to be active in
order for it to consume messages.

The JMS API relaxes this timing dependency to some extent by allowing clients
to create durable subscriptions. Durable subscriptions can receive messages sent
while the subscribers are not active. Durable subscriptions provide the flexibility
and reliability of queues but still allow clients to send messages to many recipi-
ents. For more information about durable subscriptions, see Creating Durable
Subscriptions (page 1023).

Use pub/sub messaging when each message can be processed by zero, one, or
many consumers. Figure 29–4 illustrates pub/sub messaging.



MESSAGE CONSUMPTION 985
Figure 29–4 Publish/Subscribe Messaging

Programming with the Common Interfaces
Version 1.1 of the JMS API allows you to use the same code to access either the
PTP or the pub/sub domain. The administered objects that you use remain
domain-specific, and the behavior of the application will depend partly on
whether you are using a queue or a topic. However, the code itself can be com-
mon to both domains, making your applications flexible and reusable. This tuto-
rial describes and illustrates these common interfaces.

Message Consumption
Messaging products are inherently asynchronous: there is no fundamental timing
dependency between the production and the consumption of a message. How-
ever, the JMS Specification uses this term in a more precise sense. Messages can
be consumed in either of two ways:

• Synchronously. A subscriber or a receiver explicitly fetches the message
from the destination by calling the receive method. The receive method
can block until a message arrives or can time out if a message does not
arrive within a specified time limit.

• Asynchronously. A client can register a message listener with a consumer.
A message listener is similar to an event listener. Whenever a message
arrives at the destination, the JMS provider delivers the message by calling
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the listener’s onMessage method, which acts on the contents of the mes-
sage.

The JMS API Programming Model
The basic building blocks of a JMS application consist of

• Administered Objects: connection factories and destinations

• Connections

• Sessions

• Message Producers

• Message Consumers

• Messages

Figure 29–5 shows how all these objects fit together in a JMS client application.

Figure 29–5 The JMS API Programming Model

This section describes all these objects briefly and provides sample commands
and code snippets that show how to create and use the objects. The last section
briefly describes JMS API exception handling.
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Examples that show how to combine all these objects in applications appear in
later sections. For more details, see the JMS API documentation, which is part of
the J2EE API documentation.

Administered Objects
Two parts of a JMS application—destinations and connection factories—are best
maintained administratively rather than programmatically. The technology
underlying these objects is likely to be very different from one implementation
of the JMS API to another. Therefore, the management of these objects belongs
with other administrative tasks that vary from provider to provider.

JMS clients access these objects through interfaces that are portable, so a client
application can run with little or no change on more than one implementation of
the JMS API. Ordinarily, an administrator configures administered objects in a
JNDI namespace, and JMS clients then look them up, using the JNDI API. J2EE
applications always use the JNDI API.

With the J2EE Application Server, you use the Admin Console to create JMS
administered objects in the form of resources. You can also use the asadmin

command.

Connection Factories
A connection factory is the object a client uses to create a connection with a pro-
vider. A connection factory encapsulates a set of connection configuration
parameters that has been defined by an administrator. Each connection factory is
an instance of either the QueueConnectionFactory or the TopicConnection-

Factory interface.

To learn how to use the Admin Console to create connection factories, see Creat-
ing JMS Administered Objects (page 1002).

At the beginning of a JMS client program, you usually perform a JNDI lookup of
the connection factory. The connection factory itself is specific to one domain or
the other. However, you normally assign it to a ConnectionFactory object.

Calling the InitialContext method with no parameters results in a search of
the current classpath for a vendor-specific file named jndi.properties. This
file indicates which JNDI implementation to use and which namespace to use.
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For example, the following code fragment obtains an InitialContext object
and uses it to look up the QueueConnectionFactory and the TopicConnection-
Factory by name, then assigns each to a ConnectionFactory object:

Context ctx = new InitialContext();

ConnectionFactory connectionFactory1 =
(ConnectionFactory) ctx.lookup("QueueConnectionFactory");

ConnectionFactory connectionFactory2 =
(ConnectionFactory) ctx.lookup("TopicConnectionFactory");

Destinations
A destination is the object a client uses to specify the target of messages it pro-
duces and the source of messages it consumes. In the PTP messaging domain,
destinations are called queues. In the pub/sub messaging domain, destinations
are called topics.

Creating destinations using the J2EE Application Server is a two-step process.
You create a JMS destination resource that specifies the JNDI name of the desti-
nation. You also create a physical destination to which the JNDI name refers.

To learn how to use the Admin Console to create physical destinations and desti-
nation resources, see Creating JMS Administered Objects (page 1002).

A JMS application may use multiple queues and/or topics.

In addition to looking up a connection factory in a client program, you usually
look up a destination. Like connection factories, destinations are specific to one
domain or the other. You normally assign the destination to a Destination

object. In order to preserve the semantics of queues and topics, however, you
cast the object to a destination of the appropriate type.

For example, the following line of code performs a JNDI lookup of the previ-
ously created topic MyTopic and assigns it to a Destination object, after casting
it to a Topic object:

Destination myDest = (Topic) ctx.lookup("MyTopic");

The following line of code looks up a queue named MyQueue and assigns it to a
Destination object, after casting it to a Queue object:

Destination myDest = (Queue) ctx.lookup("MyQueue");
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With the common interfaces, you can mix or match connection factories and des-
tinations. That is, you can look up a QueueConnectionFactory and use it with a
Topic, and you can look up a TopicConnectionFactory and use it with a
Queue. The behavior of the application will depend on the kind of destination
you use, not on the kind of connection factory you use.

Connections
A connection encapsulates a virtual connection with a JMS provider. A connec-
tion could represent an open TCP/IP socket between a client and a provider ser-
vice daemon. You use a connection to create one or more sessions.

Connections implement the Connection interface. Once you have a Connec-

tionFactory object, you can use it to create a Connection:

Connection connection = connectionFactory.createConnection();

When an application completes, you need to close any connections that you have
created. Failure to close a connection can cause resources not to be released by
the JMS provider. Closing a connection also closes its sessions and their mes-
sage producers and message consumers.

connection.close();

Before your application can consume messages, you must call the connection’s
start method; for details, see Message Consumers (page 991). If you want to
stop message delivery temporarily without closing the connection, you call the
stop method.

Sessions
A session is a single-threaded context for producing and consuming messages.
You use sessions to create message producers, message consumers, and mes-
sages. Sessions serialize the execution of message listeners; for details, see Mes-
sage Listeners (page 992).

A session provides a transactional context with which to group a set of sends and
receives into an atomic unit of work. For details, see Using JMS API Local
Transactions (page 1027).
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Sessions implement the Session interface. After you create a Connection

object, you use it to create a Session:

Session session = connection.createSession(false,
Session.AUTO_ACKNOWLEDGE);

The first argument means that the session is not transacted; the second means
that the session automatically acknowledges messages when they have been
received successfully. (For more information, see Controlling Message
Acknowledgment, page 1016.)

To create a transacted session, use the following code:

Session session = connection.createSession(true, 0);

Here, the first argument means that the session is transacted; the second indicates
that message acknowledgment is not specified for transacted sessions. For more
information on transactions, see Using JMS API Local
Transactions (page 1027). For the way JMS transactions work in J2EE applica-
tions, see Using the JMS API in a J2EE Application (page 1035).

Message Producers
A message producer is an object created by a session and is used for sending
messages to a destination. It implements the MessageProducer interface.

You use a Session to create a MessageProducer for a destination. Here, the first
example creates a producer for the destination myQueue, the second for the desti-
nation myTopic:

MessageProducer producer = session.createProducer(myQueue);

MessageProducer producer = session.createProducer(myTopic);

You can create an unidentified producer by specifying null as the argument to
createProducer. With an unidentified producer, you can wait to specify which
destination to send the message to until you send a message.

Once you have created a message producer, you can use it to send messages,
using the send method:

producer.send(message);
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You have to create the messages first; see Messages (page 993).

If you created an unidentified producer, use an overloaded send method that
specifies the destination as the first parameter. For example:

MessageProducer anon_prod = session.createProducer(null);

anon_prod.send(myQueue, message);

Message Consumers
A message consumer is an object created by a session and is used for receiving
messages sent to a destination. A message consumer allows a JMS client to reg-
ister interest in a destination with a JMS provider. The JMS provider manages
the delivery of messages from a destination to the registered consumers of the
destination.

A message consumer implements the MessageConsumer interface.

For example, you use a Session to create a MessageConsumer for either a queue
or a topic:

MessageConsumer consumer = session.createConsumer(myQueue);

MessageConsumer consumer = session.createConsumer(myTopic);

You use the Session.createDurableSubscriber method to create a durable
topic subscriber. This method is valid only if you are using a topic. For details,
see Creating Durable Subscriptions (page 1023).

Once you have created a message consumer, it becomes active, and you can use
it to receive messages. You can use the close method for a MessageConsumer to
make the message consumer inactive. Message delivery does not begin until you
start the connection you created by calling the start method. (Remember
always to call the start method; forgetting to start the connection is one of the
most common JMS programming errors.)
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You use the receive method to consume a message synchronously. You can use
this method at any time after you call the start method:

connection.start();
Message m = consumer.receive();

connection.start();
Message m = consumer.receive(1000); // time out after a second

To consume a message asynchronously, you use a message listener, described in
Message Listeners (page 992).

Message Listeners
A message listener is an object that acts as an asynchronous event handler for
messages. This object implements the MessageListener interface, which con-
tains one method, onMessage. In the onMessage method, you define the actions
to be taken when a message arrives.

You register the message listener with a specific MessageConsumer by using the
setMessageListener method. For example, if you define a class named Lis-

tener that implements the MessageListener interface, you can register the
message listener as follows:

Listener myListener = new Listener();
consumer.setMessageListener(myListener);

After you register the message listener, you call the start method on the Con-

nection to begin message delivery. (If you call start before you register the
message listener, you are likely to miss messages.)

Once message delivery begins, the message consumer automatically calls the
message listener’s onMessage method whenever a message is delivered. The
onMessage method takes one argument of type Message, which your implemen-
tation of the method can cast to any of the other message types (see Message
Bodies, page 995).

A message listener is not specific to a particular destination type. The same lis-
tener can obtain messages from either a queue or a topic, depending on the type
of destination for which the message consumer was created. A message listener
does, however, usually expect a specific message type and format. Moreover, if it
needs to reply to messages, a message listener must either assume a particular
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destination type or obtain the destination type of the message and create a pro-
ducer for that destination type.

Your onMessage method should handle all exceptions. It must not throw checked
exceptions, and throwing a RuntimeException is considered a programming
error.

The session used to create the message consumer serializes the execution of all
message listeners registered with the session. At any time, only one of the ses-
sion’s message listeners is running.

In the J2EE platform, a message-driven bean is a special kind of message lis-
tener. For details, see Using Message-Driven Beans (page 1037).

Message Selectors
If your messaging application needs to filter the messages it receives, you can
use a JMS API message selector, which allows a message consumer to specify
the messages it is interested in. Message selectors assign the work of filtering
messages to the JMS provider rather than to the application. For an example of
an application that uses a message selector, see A J2EE Application that Uses
the JMS API with a Session Bean (page 1052).

A message selector is a String that contains an expression. The syntax of the
expression is based on a subset of the SQL92 conditional expression syntax. The
message selector in the example selects any message with a NewsType property
that is set to the value ’Sports’ or ’Opinion’:

NewsType = ’Sports’ OR NewsType = ’Opinion’

The createConsumer and createDurableSubscriber methods allow you to
specify a message selector as an argument when you create a message consumer.

The message consumer then receives only messages whose headers and proper-
ties match the selector. (See Message Headers, page 994, and Message
Properties, page 995). A message selector cannot select messages on the basis of
the content of the message body.

Messages
The ultimate purpose of a JMS application is to produce and to consume mes-
sages that can then be used by other software applications. JMS messages have a
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basic format that is simple but highly flexible, allowing you to create messages
that match formats used by non-JMS applications on heterogeneous platforms.

A JMS message has three parts: a header, properties, and a body. Only the header
is required. The following sections describe these parts:

• Message Headers

• Message Properties (optional)

• Message Bodies (optional)

For complete documentation of message headers, properties, and bodies, see the
documentation of the Message interface in the API documentation.

Message Headers
A JMS message header contains a number of predefined fields that contain val-
ues that both clients and providers use to identify and to route messages. Table
29–1 lists the JMS message header fields and indicates how their values are set.
For example, every message has a unique identifier, represented in the header
field JMSMessageID. The value of another header field, JMSDestination, repre-
sents the queue or the topic to which the message is sent. Other fields include a
timestamp and a priority level.

Each header field has associated setter and getter methods, which are docu-
mented in the description of the Message interface. Some header fields are
intended to be set by a client, but many are set automatically by the send or the
publish method, which overrides any client-set values.

Table 29–1 How JMS Message Header Field Values Are Set

Header Field Set By

JMSDestination send or publish method

JMSDeliveryMode send or publish method

JMSExpiration send or publish method

JMSPriority send or publish method

JMSMessageID send or publish method

JMSTimestamp send or publish method
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Message Properties
You can create and set properties for messages if you need values in addition to
those provided by the header fields. You can use properties to provide compati-
bility with other messaging systems, or you can use them to create message
selectors (see Message Selectors, page 993). For an example of setting a prop-
erty to be used as a message selector, see A J2EE Application that Uses the JMS
API with a Session Bean (page 1052).

The JMS API provides some predefined property names that a provider may sup-
port. The use of either these predefined properties or user-defined properties is
optional.

Message Bodies
The JMS API defines five message body formats, also called message types,
which allow you to send and to receive data in many different forms and provide
compatibility with existing messaging formats. Table 29–2 describes these mes-
sage types.

JMSCorrelationID Client

JMSReplyTo Client

JMSType Client

JMSRedelivered JMS provider

Table 29–2 JMS Message Types

Message Type Body Contains

TextMessage
A java.lang.String object (for example, the contents of an Extensi-
ble Markup Language file).

Table 29–1 How JMS Message Header Field Values Are Set

Header Field Set By
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The JMS API provides methods for creating messages of each type and for fill-
ing in their contents. For example, to create and send a TextMessage, you might
use the following statements:

TextMessage message = session.createTextMessage();
message.setText(msg_text);     // msg_text is a String
producer.send(message);

At the consuming end, a message arrives as a generic Message object and must
be cast to the appropriate message type. You can use one or more getter methods
to extract the message contents. The following code fragment uses the getText

method:

Message m = consumer.receive();
if (m instanceof TextMessage) {

TextMessage message = (TextMessage) m;
System.out.println("Reading message: " + message.getText());

} else {
// Handle error

}

MapMessage

A set of name/value pairs, with names as String objects and values as
primitive types in the Java programming language. The entries can be
accessed sequentially by enumerator or randomly by name. The order
of the entries is undefined.

BytesMessage
A stream of uninterpreted bytes. This message type is for literally
encoding a body to match an existing message format.

StreamMessage
A stream of primitive values in the Java programming language, filled
and read sequentially.

ObjectMessage A Serializable object in the Java programming language.

Message
Nothing. Composed of header fields and properties only. This message
type is useful when a message body is not required.

Table 29–2 JMS Message Types

Message Type Body Contains
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Exception Handling
The root class for exceptions thrown by JMS API methods is JMSException.
Catching JMSException provides a generic way of handling all exceptions
related to the JMS API. The JMSException class includes the following sub-
classes, which are described in the API documentation:

• IllegalStateException

• InvalidClientIDException

• InvalidDestinationException

• InvalidSelectorException

• JMSSecurityException

• MessageEOFException

• MessageFormatException

• MessageNotReadableException

• MessageNotWriteableException

• ResourceAllocationException

• TransactionInProgressException

• TransactionRolledBackException

All the examples in the tutorial catch and handle JMSException when it is appro-
priate to do so.

Writing Simple JMS Client Applications
This section shows how to create, package, and run simple JMS client programs
packaged as standalone J2EE application clients. These clients access a server
based on J2EE technology (“J2EE server”). The clients demonstrate the basic
tasks that a JMS application must perform:

• Creating a connection and a session

• Creating message producers and consumers

• Sending and receiving messages

In a J2EE application, some of these tasks are performed, in whole or in part, by
the container. If you learn about these tasks, you will have a good basis for
understanding how a JMS application works on the J2EE platform.
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The section covers the following topics:

• Setting your environment to run J2EE applications

• An example that uses synchronous message receives

• An example that uses a message listener

• Running JMS clients on multiple systems

Each example uses two programs: one that sends messages and one that receives
them. You can run the programs in two terminal windows.

When you write a JMS application to run in a J2EE application, you use many of
the same methods in much the same sequence as you do for a standalone appli-
cation client. However, there are some significant differences. Using the JMS
API in a J2EE Application (page 1035) describes these differences, and the next
chapter provides examples that illustrate them.

The examples for this section are in the following directory:

<INSTALL>/j2eetutorial14/examples/jms/simple/

A Simple Example of Synchronous
Message Receives
This section describes the sending and receiving programs in an example that
uses the receive method to consume messages synchronously. This section then
explains how to compile, package, and run the programs, using the J2EE 1.4
Application Server.

The following sections describe the steps in creating and running the example:

• Writing the Client Programs

• Compiling the Clients

• Starting the JMS Provider

• Creating JMS Administered Objects

• Packaging the Clients

• Running the Clients
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Writing the Client Programs
The sending program, src/SimpleProducer.java, performs the following
steps:

1. Performs a JNDI lookup of the ConnectionFactory and Destination:
/*
 * Create a JNDI API InitialContext object if none exists
 * yet.
 */
try {

jndiContext = new InitialContext();
} catch (NamingException e) {

System.out.println("Could not create JNDI API " +
"context: " + e.toString());

System.exit(1);
}

/*
 * Look up connection factory and destination.  If either
 * does not exist, exit.  If you look up a
 * TopicConnectionFactory instead of a
 * QueueConnectionFactory, program behavior is the same.
 */
try {

connectionFactory = (ConnectionFactory)
jndiContext.lookup("jms/QueueConnectionFactory");
if (destType.equals("queue")) {

dest = (Queue) jndiContext.lookup(destName);
} else if (destType.equals("topic")) {

dest = (Topic) jndiContext.lookup(destName);
} else {

throw new Exception("Invalid destination type" +
"; must be queue or topic");

}
} catch (Exception e) {

System.out.println("JNDI API lookup failed: " +
e.toString());

System.exit(1);
}

2. Creates a Connection and a Session:
connection = connectionFactory.createConnection();
session = connection.createSession(false,

Session.AUTO_ACKNOWLEDGE);

3. Creates a MessageProducer and a TextMessage:

../examples/jms/simple/src/SimpleProducer.java
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producer = session.createProducer(dest);
message = session.createTextMessage();

4. Sends one or more messages to the destination:
for (int i = 0; i < NUM_MSGS; i++) {

message.setText("This is message " + (i + 1));
System.out.println("Sending message: " +

message.getText());
producer.send(message);

}

5. Sends an empty control message to indicate the end of the message stream:
producer.send(session.createMessage());

6. Closes the connection in a finally block, automatically closing the ses-
sion and MessageProducer:
} finally {

if (connection != null) {
try {

connection.close();
} catch (JMSException e) {}

}
}

The receiving program, src/SimpleSynchConsumer.java, performs the follow-
ing steps:

1. Performs a JNDI lookup of the ConnectionFactory and Destination.

2. Creates a Connection and a Session

3. Creates a MessageConsumer:
consumer = session.createConsumer(dest);

4. Starts the connection, causing message delivery to begin:
connection.start();

5. Receives the messages sent to the destination until the end-of-message-
stream control message is received:
while (true) {

Message m = consumer.receive(1);
if (m != null) {

if (m instanceof TextMessage) {
message = (TextMessage) m;
System.out.println("Reading message: " +

message.getText());
} else {

break;
}

../examples/jms/simple/src/SimpleSynchConsumer.java
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}
}

6. Closes the connection in a finally block, automatically closing the ses-
sion and MessageConsumer.

The receive method can be used in several ways to perform a synchronous
receive. If you specify no arguments or an argument of 0, the method blocks
indefinitely until a message arrives:

Message m = consumer.receive();

Message m = consumer.receive(0);

For a simple client program, this may not matter. But if you do not want your
program to consume system resources unnecessarily, use a timed synchronous
receive. Do one of the following:

• Call the receive method with a timeout argument greater than 0:
Message m = consumer.receive(1); // 1 millisecond

• Call the receiveNoWait method, which receives a message only if one is
available:
Message m = consumer.receiveNoWait();

The SimpleSynchConsumer program uses an indefinite while loop to receive
messages, calling receive with a timeout argument. Calling receiveNoWait

would have the same effect.

Compiling the Clients
You can compile the examples using the asant tool.

To compile the examples, do the following.

1. In a terminal window, go to the following directory:

<INSTALL>/j2eetutorial14/examples/jms/simple/

2. Type the following command:

asant build

This command uses the build.xml file in the simple directory to compile all the
source files in the directory. The class files are placed in the build directory.
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Starting the JMS Provider
When you use the J2EE Application Server, your JMS provider is the Applica-
tion Server. Start the server as described in Starting and Stopping the J2EE
Application Server (page 91).

Creating JMS Administered Objects
Creating the JMS administered objects for this section involves the following:

• Starting the Admin Console

• Creating two connection factories

• Creating two physical destinations

• Creating two destination resources

If you built and ran the SimpleMessage example in Chapter 23 and did not delete
the resources afterwards, you need to create only half of these resources, those
that involve topics.

To start the Admin Console, follow the instructions in Starting the Admin
Console (page 92).

To create the connection factories, perform the following steps:

1. Expand the Java Message Service node, then click Connection Factories.

2. Click New. The Create JMS Connection Factory screen appears.

3. In the JNDI Name field, type jms/QueueConnectionFactory.

4. Choose javax.jms.QueueConnectionFactory from the Type menu.

5. Select the Enabled checkbox.

6. Click OK.

7. Click New again.

8. In the JNDI Name field, type jms/TopicConnectionFactory.

9. Choose javax.jms.TopicConnectionFactory from the Type menu.

10.Select the Enabled checkbox.

11.Click OK.

To create the physical destinations, perform the following steps:

1. In the left-hand pane, click Physical Destinations.

2. Click New. The Create Physical Destination pane appears.
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3. In the Physical Destination Name field, type PhysicalQueue.

4. Choose queue from the Type menu.

5. Click OK.

6. Click New again.

7. In the Physical Destination Name field, type PhysicalTopic.

8. Choose topic from the Type menu.

9. Click OK.

To create the destination resources and link them to the physical destinations,
perform the following steps:

1. In the left-hand pane, click Destination Resources.

2. Click New. The Create JMS Destination Resource pane appears.

3. In the JNDI Name field, type jms/Queue.

4. Choose javax.jms.Queue from the Type menu.

5. Select the Enabled checkbox.

6. Under Additional Properties, click Add.

7. Type Name in the Name field.

8. Type PhysicalQueue in the Value field.

9. Click OK.

10.Click New again.

11.In the JNDI Name field, type jms/Topic.

12.Choose javax.jms.Topic from the Type menu.

13.Select the Enabled checkbox.

14.Under Additional Properties, click Add.

15.Enter Name in the Name field.

16.Enter PhysicalTopic in the Value field.

17.Click OK.

If you are in a hurry, you can create all the administered objects described in this
section by using the following asant target:

asant create-resources

This target is in the file <INSTALL>/j2eetutorial14/examples/jms/common/

targets.xml, so you can use it from any of the JMS examples directories.
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If you built and ran the SimpleMessage example in Chapter 23 and did not delete
the resources afterwards, use the following asant target to create only the
resources that do not exist already:

asant create-topic-resources

Packaging the Clients
In order to run these examples using the J2EE Application Server, you need to
package each one in a standalone client JAR file.

First, start deploytool:

• On Windows systems, choose Start→Programs→Sun
Microsystems→J2EE 1.4 SDK→Deploytool.

• On UNIX systems, use the deploytool command.

Package the SimpleProducer example as follows:

1. Choose File→New→Application Client to start the Application Client
Wizard.

2. Select the radio button labeled Create New Stand-Alone AppClient Mod-
ule.

3. Click Browse next to the AppClient Location field and navigate to the
<INSTALL>/j2eetutorial14/examples/jms/simple/ directory.

4. Type SimpleProducer in the File Name field and click Choose Module
File.

5. Verify that SimpleProducer appears in the AppClient Name field.

6. Click the Edit button next to the Contents text area.

7. In the dialog box, locate the build directory. Select Simple-

Producer.class from the Available Files tree and click Add, then OK

8. In the General screen, select SimpleProducer in the Main Class combo
box.

9. Click Next.

10.Click Finish.
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Package the SimpleSynchConsumer example the same way, except for the fol-
lowing:

• In Step 4, type SimpleSynchConsumer.jar in the File Name field.

• In Step 5, verify that SimpleSynchConsumer appears in the AppClient
Name field.

• In Step 7, select SimpleSynchConsumer.class from the Available Files
tree and click Add, then OK.

• In Step 8, select SimpleSynchConsumer in the Main Class combo box.

Running the Clients
You run the sample programs using the appclient command. Each of the pro-
grams takes command-line arguments: a destination name, a destination type,
and, for SimpleProducer, a number of messages.

Run the clients as follows.

1. Run the SimpleProducer program, sending three messages to the queue
jms/Queue:
appclient -client SimpleProducer.jar jms/Queue queue 3

The output of the program looks like this, along with some output from
the AppClient container:

Destination name is jms/Queue, type is queue
Sending message: This is message 1
Sending message: This is message 2
Sending message: This is message 3

The messages are now in the queue, waiting to be received.

2. In the same window, run the SimpleSynchConsumer program, specifying
the queue name and type:
appclient -client SimpleSynchConsumer.jar jms/Queue queue

The output of the program looks like this:

Destination name is jms/Queue, type is queue
Reading message: This is message 1
Reading message: This is message 2
Reading message: This is message 3

3. Now try running the programs in the opposite order. Run the Simple-

SynchConsumer program. It displays the queue name and then appears to
hang, waiting for messages.
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4. In a different terminal window, run the SimpleProducer program. When
the messages have been sent, the SimpleSynchConsumer program receives
them and exits.

5. Now run the SimpleProducer program using a topic instead of a queue:
appclient -client SimpleProducer.jar jms/Topic topic 3

The output of the program looks like this:

Destination name is jms/Topic, type is topic
Sending message: This is message 1
Sending message: This is message 2
Sending message: This is message 3

6. Now run the SimpleSynchConsumer program using the topic:
appclient -client SimpleSynchConsumer.jar jms/Topic topic

The result, however, is different. Because you are using a topic, messages
that were sent before you started the consumer cannot be received. (See
Publish/Subscribe Messaging Domain, page 984, for details.) Instead of
receiving the messages, the program appears to hang.

7. Run the SimpleProducer program again in another terminal window. Now
the SimpleSynchConsumer program receives the messages:
Destination name is jms/Topic, type is topic
Reading message: This is message 1
Reading message: This is message 2
Reading message: This is message 3

A Simple Example of Asynchronous
Message Consumption
This section describes the receiving programs in an example that uses a message
listener to consume messages asynchronously. This section then explains how to
compile and run the programs, using the J2EE 1.4 Application Server.

The following sections describe the steps in creating and running the example:

• Writing the client programs

• Compiling the clients

• Starting the JMS provider

• Creating the JMS administered objects

• Running the clients

• Deleting the destinations and stopping the server



A SIMPLE EXAMPLE OF ASYNCHRONOUS MESSAGE CONSUMPTION 1007
Writing the Client Programs
The sending program is src/SimpleProducer.java, the same program used in
the example in A Simple Example of Synchronous Message
Receives (page 998). You may, however, want to comment out the following line
of code, where the producer sends a non-text control message to indicate the end
of the messages:

producer.send(session.createMessage());

An asynchronous consumer normally runs indefinitely. This one runs until the
user types the letter q or Q to stop the program, so it does not use the non-text
control message.

The receiving program, src/SimpleAsynchConsumer.java, performs the fol-
lowing steps:

1. Performs a JNDI lookup of the ConnectionFactory and Destination

2. Creates a Connection and a Session

3. Creates a MessageConsumer

4. Creates an instance of the TextListener class and registers it as the mes-
sage listener for the MessageConsumer:
listener = new TextListener();
consumer.setMessageListener(listener);

5. Starts the connection, causing message delivery to begin

6. Listens for the messages published to the destination, stopping when the
user types the character q or Q:
System.out.println("To end program, type Q or q, " +

"then <return>");
inputStreamReader = new InputStreamReader(System.in);
while (!((answer == ’q’) || (answer == ’Q’))) {

try {
answer = (char) inputStreamReader.read();

} catch (IOException e) {
System.out.println("I/O exception: "

+ e.toString());
}

}

7. Closes the connection, which automatically closes the session and
MessageConsumer

../examples/jms/simple/src/SimpleProducer.java
../examples/jms/simple/src/SimpleAsynchConsumer.java
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The message listener, src/TextListener.java, follows these steps:

1. When a message arrives, the onMessage method is called automatically.

2. The onMessage method converts the incoming message to a TextMessage
and displays its content. If the message is not a text message, it reports this
fact:

public void onMessage(Message message) {
TextMessage msg = null;

try {
if (message instanceof TextMessage) {

msg = (TextMessage) message;
System.out.println("Reading message: " +

msg.getText());
} else {

System.out.println("Message is not a " +
"TextMessage");

}
} catch (JMSException e) {

System.out.println("JMSException in onMessage(): " +
e.toString());

} catch (Throwable t) {
System.out.println("Exception in onMessage():" +

t.getMessage());
}

}

Compiling the Clients
Compile the programs if you did not do so before or if you edited Simple-

Producer.java as described in Writing the Client Programs (page 1007):

asant build

Starting the JMS Provider
If you did not do so before, start the J2EE Application Server in another terminal
window.

You will use the connection factories and destinations you created in Creating
JMS Administered Objects (page 1002).

../examples/jms/simple/src/TextListener.java
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Packaging the SimpleAsynchConsumer
Client
If you did not do so before, start deploytool.

Package the SimpleAsynchConsumer example as follows:

1. Choose File→New→Application Client to start the Application Client
Wizard.

2. Select the radio button labeled Create New Stand-Alone AppClient Mod-
ule.

3. Click Browse next to the AppClient Location field and navigate to the
<INSTALL>/j2eetutorial14/examples/jms/simple/ directory.

4. Type SimpleAsynchConsumer in the File Name field, then click Choose
Module File.

5. Verify that SimpleAsynchConsumer appears in the AppClient Name field.

6. Click the Edit button next to the Contents text area.

7. In the dialog box, locate the build directory. Select SimpleAsynchCon-
sumer.class and TextListener.class from the Available Files tree and
click Add, then OK

8. In the General screen, select SimpleAsynchConsumer in the Main Class
combo box.

9. Click Next.

10.Click Finish.

If you did not already package the SimpleProducer program, do so by following
the instructions in Packaging the Clients (page 1004).

Running the Clients
As before, you run the sample programs using the appclient command.

Run the clients as follows.

1. Run the SimpleAsynchConsumer program, specifying the topic jms/

Topic and its type.

appclient -client SimpleAsynchConsumer.jar jms/Topic topic
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The program displays the following lines and appears to hang:

Destination name is jms/Topic, type is topic

To end program, type Q or q, then <return>

2. In another terminal window, run the SimpleProducer program, sending
three messages. The commands look like this:
appclient -client SimpleProducer.jar jms/Topic topic 3

The output of the program looks like this:

Destination name is jms/Topic, type is topic

Sending message: This is message 1

Sending message: This is message 2

Sending message: This is message 3

In the other window, the SimpleAsynchConsumer program displays the
following:

Destination name is jms/Topic, type is topic

To end program, type Q or q, then <return>

Reading message: This is message 1

Reading message: This is message 2

Reading message: This is message 3

If you did not edit SimpleProducer.java, the following line also
appears:

Message is not a TextMessage

3. Type Q or q to stop the program.

4. Now run the programs using a queue. In this case, as with the synchronous
example, you can run the SimpleProducer program first, because there is
no timing dependency between the sender and receiver:

appclient -client SimpleProducer.jar jms/Queue queue 3

The output of the program looks like this:

Destination name is jms/Queue, type is queue

Sending message: This is message 1

Sending message: This is message 2

Sending message: This is message 3

5. Run the SimpleAsynchConsumer program:

appclient -client SimpleAsynchConsumer.jar jms/Queue queue
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The output of the program looks like this:

Destination name is jms/Queue, type is queue

To end program, type Q or q, then <return>

Reading message: This is message 1

Reading message: This is message 2

Reading message: This is message 3

6. Type Q or q to stop the program.

Running JMS Client Programs on Multiple
Systems
JMS client programs can communicate with each other when they are running on
different systems in a network. The systems must be visible to each other by
name—the UNIX host name or the Microsoft Windows computer name—and
must both be running the J2EE server. You do not have to install the tutorial
examples on both systems; you can use the examples installed on one system if
you can access its file system from the other system.

Suppose that you want to run the SimpleProducer program on one system,
mars, and the SimpleSynchConsumer program on another system, earth. Before
you can do so, you need to perform these tasks:

• Create two new administered objects

• Edit the source code

• Recompile the source code and update the client JAR files

Note: A limitation in the JMS provider in the J2EE Application Server may cause
a runtime failure to create a connection to systems that use the Dynamic Host Con-
figuration Protocol (DHCP) to obtain an IP address. You can, however, create a con-
nection from a system that uses DHCP to a system that does not use DHCP. In the
examples in this tutorial, mars can be a system that uses DHCP, and earth can be a
system that does not use DHCP.

Before you begin, start the server on both systems:

1. Start the Application Server on earth and log in to the Admin Console.

2. Start the Application Server on mars and log in to the Admin Console.
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Creating Administered Objects for Multiple
Systems
To run these programs, you need to do the following:

• Create a new connection factory on both earth and mars

• Create a destination resource and physical destination on both earth and
mars

Create a new connection factory on earth as follows:

1. In the Admin Console, expand the Java Message Service node, then click
Connection Factories.

2. Click New. The Create JMS Connection Factory screen appears.

3. In the JNDI Name field, type jms/EarthQueueConnectionFactory.

4. Choose javax.jms.QueueConnectionFactory from the Type menu.

5. Select the Enabled checkbox.

6. Click OK.

Create a new connection factory with the same name on mars as follows:

1. In the Admin Console, expand the Java Message Service node, then click
Connection Factories.

2. Click New. The Create JMS Connection Factory screen appears.

3. In the JNDI Name field, type jms/EarthQueueConnectionFactory.

4. Choose javax.jms.QueueConnectionFactory from the Type menu.

5. Select the Enabled checkbox.

6. Click Add in the Additional Properties area. A Name/Value line appears.

7. In the Name field, type MessageServiceAddressList.

8. In the Value field, type the name of the remote system (whatever the real
name of earth is). If the JMS service on the remote system uses a port
number other than the default (7676), specify the port number also, using
the syntax sys-name:port-number.

9. Click OK.

If you have been working on either earth or mars already, you have the queue
on one system. On the system that does not have the queue, perform the follow-
ing steps:

1. Use the Admin Console to create a physical destination named Physical-

Queue, just as you did in Creating JMS Administered Objects (page 1002).
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2. Use the Admin Console to create a destination resource named jms/Queue

and set its Name property to the value PhysicalQueue.

Running the Programs
These steps assume that you have the tutorial installed on only one of the two
systems you are using.

To edit, update, and run the programs, perform the following steps on the system
where you first ran them:

1. In both SimpleProducer.java and SimpleSynchConsumer.java, change
the line that looks up the connection factory so that it refers to the new con-
nection factory:

connectionFactory = (ConnectionFactory)

jndiContext.lookup("jms/EarthQueueConnectionFactory");

2. Recompile the programs:

asant build

3. In deploytool, choose Tools→Update Module Files to add the recom-
piled source files to the SimpleProducer.jar and SimpleSynch-

Consumer.jar files.

4. Save the changed JAR files.

5. Run SimpleProducer on mars:

appclient -client SimpleProducer.jar jms/Queue queue 3

6. Run SimpleSynchConsumer on earth:

appclient -client SimpleSynchConsumer.jar jms/Queue queue

Because both connection factories have the same name, you can run either the
producer or the consumer on either system.

For examples showing how to deploy J2EE applications on two different sys-
tems, see An Application Example that Consumes Messages from a Remote
J2EE Server (page 1069) and An Application Example that Deploys a Message-
Driven Bean on Two J2EE Servers (page 1075).
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Deleting the Connection Factory and
Stopping the Server
You will need the connection factory jms/EarthQueueConnectionFactory in
the next chapter. However, if you wish to delete it, perform the following steps in
the Admin Console:

1. Expand the Java Message Service node and click Connection Factories.

2. Select the checkbox next to jms/EarthQueueConnectionFactory and
click Delete.

Remember to delete the connection factory on both systems.

You may also use the Admin Console to delete the destinations and connection
factories you created in Creating JMS Administered Objects (page 1002). How-
ever, we recommend that you keep them, because they will be used in most of
the examples in the next chapter. Once you have created them, they will be avail-
able whenever you restart the J2EE Application Server.

Delete the class files for the programs as follows:

asant clean

If you wish, you can manually delete the client JAR files.

You can stop the J2EE Application Server as well, but you will need it to run the
sample programs in the next section.

Creating Robust JMS Applications
This section explains how to use features of the JMS API to achieve the level of
reliability and performance your application requires. Many people choose to
implement JMS applications because they cannot tolerate dropped or duplicate
messages and require that every message be received once and only once. The
JMS API provides this functionality.

The most reliable way to produce a message is to send a PERSISTENT message
within a transaction. JMS messages are PERSISTENT by default. A transaction is
a unit of work into which you can group a series of operations, such as message
sends and receives, so that the operations either all succeed or all fail. For details,
see Specifying Message Persistence (page 1020) and Using JMS API Local
Transactions (page 1027).
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The most reliable way to consume a message is to do so within a transaction,
either from a queue or from a durable subscription to a topic. For details, see
Creating Temporary Destinations (page 1022), Creating Durable
Subscriptions (page 1023), and Using JMS API Local Transactions (page 1027).

For other applications, a lower level of reliability can reduce overhead and
improve performance. You can send messages with varying priority levels—see
Setting Message Priority Levels (page 1021)—and you can set them to expire
after a certain length of time (see Allowing Messages to Expire, page 1021).

The JMS API provides several ways to achieve various kinds and degrees of reli-
ability. This section divides them into two categories:

• Using Basic Reliability Mechanisms

• Using Advanced Reliability Mechanisms

The following sections describe these features as they apply to JMS clients.
Some of the features work differently in J2EE applications; in these cases, the
differences are noted here and are explained in detail in Using the JMS API in a
J2EE Application (page 1035).

This section includes three sample programs, which you can find in the directory
<INSTALL>/j2eetutorial14/examples/jms/advanced/src/, along with a
utility class called SampleUtilities.java.

To compile the programs in advance, go to the <INSTALL>/j2eetutorial14/

examples/jms/advanced directory and use the following asant target:

asant build

Using Basic Reliability Mechanisms
The basic mechanisms for achieving or affecting reliable message delivery are as
follows:

• Controlling message acknowledgment. You can specify various levels of
control over message acknowledgment.

• Specifying message persistence. You can specify that messages are persis-
tent, meaning that they must not be lost in the event of a provider failure.

• Setting message priority levels. You can set various priority levels for mes-
sages, which can affect the order in which the messages are delivered.

• Allowing messages to expire. You can specify an expiration time for mes-
sages, so that they will not be delivered if they are obsolete.

../examples/jms/advanced/src/SampleUtilities.java
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• Creating temporary destinations. You can create temporary destinations
that last only for the duration of the connection in which they are created.

Controlling Message Acknowledgment
Until a JMS message has been acknowledged, it is not considered to be success-
fully consumed. The successful consumption of a message ordinarily takes place
in three stages.

1. The client receives the message.

2. The client processes the message.

3. The message is acknowledged. Acknowledgment is initiated either by the
JMS provider or by the client, depending on the session acknowledgment
mode.

In transacted sessions (see Using JMS API Local Transactions, page 1027),
acknowledgment happens automatically when a transaction is committed. If a
transaction is rolled back, all consumed messages are redelivered.

In nontransacted sessions, when and how a message is acknowledged depends
on the value specified as the second argument of the createSession method.
The three possible argument values are:

• Session.AUTO_ACKNOWLEDGE. The session automatically acknowledges a
client’s receipt of a message either when the client has successfully
returned from a call to receive or when the MessageListener it has
called to process the message returns successfully. A synchronous receive
in an AUTO_ACKNOWLEDGE session is the one exception to the rule that mes-
sage consumption is a three-stage process as described above.

In this case, the receipt and acknowledgment take place in one step, fol-
lowed by the processing of the message.

• Session.CLIENT_ACKNOWLEDGE. A client acknowledges a message by
calling the message’s acknowledge method. In this mode, acknowledg-
ment takes place on the session level: Acknowledging a consumed mes-
sage automatically acknowledges the receipt of all messages that have
been consumed by its session. For example, if a message consumer con-
sumes ten messages and then acknowledges the fifth message delivered, all
ten messages are acknowledged.

• Session.DUPS_OK_ACKNOWLEDGE. This option instructs the session to
lazily acknowledge the delivery of messages. This is likely to result in the
delivery of some duplicate messages if the JMS provider fails, so it should
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be used only by consumers that can tolerate duplicate messages. (If the
JMS provider redelivers a message, it must set the value of the
JMSRedelivered message header to true.) This option can reduce session
overhead by minimizing the work the session does to prevent duplicates.

If messages have been received from a queue but not acknowledged when a ses-
sion terminates, the JMS provider retains them and redelivers them when a con-
sumer next accesses the queue. The provider also retains unacknowledged
messages for a terminated session with a durable TopicSubscriber. (See Creat-
ing Durable Subscriptions, page 1023.) Unacknowledged messages for a nondu-
rable TopicSubscriber are dropped when the session is closed.

If you use a queue or a durable subscription, you can use the Session.recover

method to stop a nontransacted session and restart it with its first unacknowl-
edged message. In effect, the session’s series of delivered messages is reset to
the point after its last acknowledged message. The messages it now delivers may
be different from those that were originally delivered, if messages have expired
or higher-priority messages have arrived. For a nondurable TopicSubscriber,
the provider may drop unacknowledged messages when its session is recovered.

The sample program in the next section demonstrates two ways to ensure that a
message will not be acknowledged until processing of the message is complete.

A Message Acknowledgment Example
The AckEquivExample.java program in the directory <INSTALL>/

j2eetutorial14/examples/jms/advanced/src/ shows how the following two
scenarios both ensure that a message will not be acknowledged until processing
of it is complete:

• Using an asynchronous message consumer—a message listener—in an
AUTO_ACKNOWLEDGE session

• Using a synchronous receiver in a CLIENT_ACKNOWLEDGE session

With a message listener, the automatic acknowledgment happens when the
onMessage method returns—that is, after message processing has finished. With
a synchronous receiver, the client acknowledges the message after processing is
complete. (If you use AUTO_ACKNOWLEDGE with a synchronous receive, the
acknowledgment happens immediately after the receive call; if any subsequent
processing steps fail, the message cannot be redelivered.)

The program contains a SynchSender class, a SynchReceiver class, an Asynch-

Subscriber class with a TextListener class, a MultiplePublisher class, a
main method, and a method that runs the other classes’ threads.

../examples/jms/advanced/src/AckEquivExample.java
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The program uses the following objects:

• jms/Queue and jms/Topic, the queue and topic that you created in Creat-
ing JMS Administered Objects (page 1002)

• ControlQueue, an additional queue

• jms/DurableTopicConnectionFactory, a connection factory with a cli-
ent ID (see Creating Durable Subscriptions (page 1023) for more informa-
tion)

Use the Admin Console to create the new queue and connection factory as fol-
lows:

1. Create a physical destination of type queue with the name ControlQueueP.

2. Create a destination resource with the name ControlQueue and type
javax.jms.Queue. Add the property Name with the value ControlQueueP.

3. Create a connection factory with the name jms/DurableTopicConnec-

tionFactory and type javax.jms.TopicConnectionFactory. Add the
property ClientId with the value MyID.

If you did not do so previously, compile the source file:

asant build

To package the program, perform the following steps:

1. If you did not do so before, start deploytool.

2. Choose File→New→Application Client to start the Application Client
Wizard.

3. Select the radio button labeled Create New Stand-Alone AppClient Mod-
ule.

4. Click Browse next to the AppClient Location field and navigate to the
<INSTALL>/j2eetutorial14/examples/jms/advanced/ directory.

5. Type AckEquivExample in the File Name field and click Choose Module
File.

6. Verify that AckEquivExample appears in the AppClient Name field.

7. Click the Edit button next to the Contents text area.

8. In the dialog box, locate the build directory. Select the seven classes
whose names begin with AckEquivExample from the Available Files tree
and click Add.

9. Select the two classes whose names begin with SampleUtilities from
the Available Files tree and click Add, then OK.
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10.Click Next.

11.In the General screen, select AckEquivExample in the Main Class combo
box.

12.Click Next.

13.Click Finish.

To run the program, use the following command:

appclient -client AckEquivExample.jar

The program output looks like this:

Queue name is ControlQueue
Queue name is jms/Queue
Topic name is jms/Topic
Connection factory name is jms/DurableTopicConnectionFactory
  SENDER: Created client-acknowledge session
SENDER: Sending message: Here is a client-acknowledge message

  RECEIVER: Created client-acknowledge session
  RECEIVER: Processing message: Here is a client-acknowledge
message
  RECEIVER: Now I’ll acknowledge the message
PUBLISHER: Created auto-acknowledge session
SUBSCRIBER: Created auto-acknowledge session
PUBLISHER: Receiving synchronize messages from ControlQueue;
count = 1
SUBSCRIBER: Sending synchronize message to ControlQueue
PUBLISHER: Received synchronize message;  expect 0 more
PUBLISHER: Publishing message: Here is an auto-acknowledge
message 1
PUBLISHER: Publishing message: Here is an auto-acknowledge
message 2
SUBSCRIBER: Processing message: Here is an auto-acknowledge
message 1
PUBLISHER: Publishing message: Here is an auto-acknowledge
message 3
SUBSCRIBER: Processing message: Here is an auto-acknowledge
message 2
SUBSCRIBER: Processing message: Here is an auto-acknowledge
message 3

After you run the program, you can delete the physical destination Control-

QueueP and the destination resource ControlQueue.
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Specifying Message Persistence
The JMS API supports two delivery modes for messages to specify whether
messages are lost if the JMS provider fails. These delivery modes are fields of
the DeliveryMode interface.

• The PERSISTENT delivery mode, which is the default, instructs the JMS
provider to take extra care to ensure that a message is not lost in transit in
case of a JMS provider failure. A message sent with this delivery mode is
logged to stable storage when it is sent.

• The NON_PERSISTENT delivery mode does not require the JMS provider to
store the message or otherwise guarantee that it is not lost if the provider
fails.

You can specify the delivery mode in either of two ways.

• You can use the setDeliveryMode method of the MessageProducer inter-
face to set the delivery mode for all messages sent by that producer. For
example, the following call sets the delivery mode to NON_PERSISTENT for
a producer:
producer.setDeliveryMode(DeliveryMode.NON_PERSISTENT);

• You can use the long form of the send or the publish method to set the
delivery mode for a specific message. The second argument sets the deliv-
ery mode. For example, the following send call sets the delivery mode for
message to NON_PERSISTENT:
producer.send(message, DeliveryMode.NON_PERSISTENT, 3,

10000);

The third and fourth arguments set the priority level and expiration time,
which are described in the next two subsections.

If you do not specify a delivery mode, the default is PERSISTENT. Using the
NON_PERSISTENT delivery mode may improve performance and reduce storage
overhead, but you should use it only if your application can afford to miss
messages.
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Setting Message Priority Levels
You can use message priority levels to instruct the JMS provider to deliver
urgent messages first. You can set the priority level in either of two ways.

• You can use the setPriority method of the MessageProducer interface
to set the priority level for all messages sent by that producer. For example,
the following call sets a priority level of 7 for a producer:
producer.setPriority(7);

• You can use the long form of the send or the publish method to set the
priority level for a specific message. The third argument sets the priority
level. For example, the following send call sets the priority level for mes-
sage to 3:
producer.send(message, DeliveryMode.NON_PERSISTENT, 3,

10000);

The ten levels of priority range from 0 (lowest) to 9 (highest). If you do not spec-
ify a priority level, the default level is 4. A JMS provider tries to deliver higher-
priority messages before lower-priority ones but does not have to deliver mes-
sages in exact order of priority.

Allowing Messages to Expire
By default, a message never expires. If a message will become obsolete after a
certain period, however, you may want to set an expiration time. You can do this
in either of two ways.

• You can use the setTimeToLive method of the MessageProducer inter-
face to set a default expiration time for all messages sent by that producer.
For example, the following call sets a time to live of one minute for a pro-
ducer:
producer.setTimeToLive(60000);

• You can use the long form of the send or the publish method to set an
expiration time for a specific message. The fourth argument sets the expi-
ration time in milliseconds. For example, the following send call sets a
time to live of 10 seconds:
producer.send(message, DeliveryMode.NON_PERSISTENT, 3,

10000);

If the specified timeToLive value is 0, the message never expires.

When the message is sent, the specified timeToLive is added to the current time
to give the expiration time. Any message not delivered before the specified expi-
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ration time is destroyed. The destruction of obsolete messages conserves storage
and computing resources.

Creating Temporary Destinations
Normally, you create JMS destinations—queues and topics—administratively
rather than programmatically. Your JMS provider includes a tool that you use to
create and to remove destinations, and it is common for destinations to be long
lasting.

The JMS API also enables you to create destinations—TemporaryQueue and
TemporaryTopic objects—that last only for the duration of the connection in
which they are created. You create these destinations dynamically, using the
Session.createTemporaryQueue and the Session.createTemporaryTopic

methods.

The only message consumers that can consume from a temporary destination are
those created by the same connection that created the destination. Any message
producer can send to the temporary destination. If you close the connection that
a temporary destination belongs to, the destination is closed and its contents lost.

You can use temporary destinations to implement a simple request/reply mecha-
nism. If you create a temporary destination and specify it as the value of the
JMSReplyTo message header field when you send a message, the consumer of
the message can use the value of the JMSReplyTo field as the destination to
which it sends a reply. The consumer can also reference the original request by
setting the JMSCorrelationID header field of the reply message to the value of
the JMSMessageID header field of the request. For example, an onMessage

method may create a session so that it can send a reply to the message it receives.
It can use code like the following:

producer = session.createProducer(msg.getJMSReplyTo());
replyMsg = session.createTextMessage("Consumer " +

"processed message: " + msg.getText());
replyMsg.setJMSCorrelationID(msg.getJMSMessageID());
producer.send(replyMsg);

For more examples, see Chapter 30.
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Using Advanced Reliability Mechanisms
The more advanced mechanisms for achieving reliable message delivery are the
following:

• Creating durable subscriptions. You can create durable topic subscriptions,
which receive messages published while the subscriber is not active. Dura-
ble subscriptions offer the reliability of queues to the publish/subscribe
message domain.

• Using local transactions. You can use local transactions, which allow you to
group a series of sends and receives into an atomic unit of work. Transac-
tions are rolled back if they fail at any time.

Creating Durable Subscriptions
To ensure that a pub/sub application receives all published messages, use
PERSISTENT delivery mode for the publishers. In addition, use durable subscrip-
tions for the subscribers.

The Session.createConsumer method creates a nondurable subscriber if a
topic is specified as the destination. A nondurable subscriber can receive only
messages that are published while it is active.

At the cost of higher overhead, you can use the Session.createDurable-

Subscriber method to create a durable subscriber. A durable subscription can
have only one active subscriber at a time.

A durable subscriber registers a durable subscription with a unique identity that
is retained by the JMS provider. Subsequent subscriber objects with the same
identity resume the subscription in the state in which it was left by the previous
subscriber. If a durable subscription has no active subscriber, the JMS provider
retains the subscription’s messages until they are received by the subscription or
until they expire.

You establish the unique identity of a durable subscriber by setting the
following:

• A client ID for the connection

• A topic and a subscription name for the subscriber

You set the client ID administratively for a client-specific connection factory
using the Admin Console.
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After using this connection factory to create the connection and the session, you
call the createDurableSubscriber method with two arguments—the topic and
a string that specifies the name of the subscription:

String subName = "MySub";
MessageConsumer topicSubscriber =

session.createDurableSubscriber(myTopic, subName);

The subscriber becomes active after you start the Connection or Topic-

Connection. Later on, you might close the subscriber:

topicSubscriber.close();

The JMS provider stores the messages sent or published to the topic, as it would
store messages sent to a queue. If the program or another application calls
createDurableSubscriber with the same connection factory and its client ID,
the same topic, and the same subscription name, the subscription is reactivated,
and the JMS provider delivers the messages that were published while the sub-
scriber was inactive.

To delete a durable subscription, first close the subscriber, and then use the
unsubscribe method, with the subscription name as the argument:

topicSubscriber.close();
session.unsubscribe("MySub");

The unsubscribe method deletes the state that the provider maintains for the
subscriber.

Figure 29–6 and Figure 29–7 show the difference between a nondurable and a
durable subscriber. With an ordinary, nondurable, subscriber, the subscriber and
the subscription begin and end at the same point and are, in effect, identical.
When a subscriber is closed, the subscription ends as well. Here, create stands
for a call to Session.createConsumer with a Topic argument, and close

stands for a call to MessageConsumer.close. Any messages published to the
topic between the time of the first close and the time of the second create are
not consumed by the subscriber. In Figure 29–6, the subscriber consumes mes-
sages M1, M2, M5, and M6, but messages M3 and M4 are lost.
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Figure 29–6 Nondurable Subscribers and Subscriptions

With a durable subscriber, the subscriber can be closed and recreated, but the
subscription continues to exist and to hold messages until the application calls
the unsubscribe method. In Figure 29–7, create stands for a call to Ses-

sion.createDurableSubscriber, close stands for a call to MessageCon-

sumer.close, and unsubscribe stands for a call to Session.unsubscribe.
Messages published while the subscriber is closed are received when the sub-
scriber is created again. So even though messages M2, M4, and M5 arrive while
the subscriber is closed, they are not lost.

Figure 29–7 A Durable Subscriber and Subscription

See A J2EE Application that Uses the JMS API with a Session
Bean (page 1052) for an example of a J2EE application that uses durable sub-
scriptions. See A Message Acknowledgment Example (page 1017) and the next
section for examples of client applications that use durable subscriptions.

A Durable Subscription Example
The DurableSubscriberExample.java program in the directory <INSTALL>/

j2eetutorial14/examples/jms/advanced/src/ shows how durable subscrip-
tions work. It demonstrates that a durable subscription is active even when the

../examples/jms/advanced/src/DurableSubscriberExample.java
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subscriber is not active. The program contains a DurableSubscriber class, a
MultiplePublisher class, a main method, and a method that instantiates the
classes and calls their methods in sequence.

The program begins like any publish/subscribe program: The subscriber starts,
the publisher publishes some messages, and the subscriber receives them. At this
point, the subscriber closes itself. The publisher then publishes some messages
while the subscriber is not active. The subscriber then restarts and receives the
messages.

Before you run this program, compile the source file and create a connection fac-
tory with a client ID. If you did not already do so in A Message Acknowledg-
ment Example (page 1017), perform the following steps:

1. Compile the source code as follows:

asant build

2. Create a connection factory with the name jms/DurableTopicConnec-

tionFactory and type javax.jms.TopicConnectionFactory. Add the
property ClientId with the value MyID.

To package the program, perform the following steps:

1. If you did not do so before, start deploytool.

2. Choose File→New→Application Client to start the Application Client
Wizard.

3. Select the radio button labeled Create New Stand-Alone AppClient Mod-
ule.

4. Click Browse next to the AppClient Location field and navigate to the
<INSTALL>/j2eetutorial14/examples/jms/advanced/ directory.

5. Type DurableSubscriberExample in the File Name field and click
Choose Module File.

6. Verify that DurableSubscriberExample appears in the AppClient Name
field.

7. Click the Edit button next to the Contents text area.

8. In the dialog box, locate the build directory. Select the five classes whose
names begin with DurableSubscriberExample from the Available Files
tree and click Add.

9. Select the two classes whose names begin with SampleUtilities from
the Available Files tree and click Add, then OK.

10.Click Next.
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11.In the General screen, select DurableSubscriberExample in the Main
Class combo box.

12.Click Next.

13.Click Finish.

Use the following command to run the program. The destination is jms/Topic:

appclient -client DurableSubscriberExample.jar

The output looks something like this:

Connection factory without client ID is jms/
TopicConnectionFactory
Connection factory with client ID is jms/
DurableTopicConnectionFactory
Topic name is jms/Topic
Starting subscriber
PUBLISHER: Publishing message: Here is a message 1
SUBSCRIBER: Reading message: Here is a message 1
PUBLISHER: Publishing message: Here is a message 2
SUBSCRIBER: Reading message: Here is a message 2
PUBLISHER: Publishing message: Here is a message 3
SUBSCRIBER: Reading message: Here is a message 3
Closing subscriber
PUBLISHER: Publishing message: Here is a message 4
PUBLISHER: Publishing message: Here is a message 5
PUBLISHER: Publishing message: Here is a message 6
Starting subscriber
SUBSCRIBER: Reading message: Here is a message 4
SUBSCRIBER: Reading message: Here is a message 5
SUBSCRIBER: Reading message: Here is a message 6
Closing subscriber
Unsubscribing from durable subscription

Using JMS API Local Transactions
You can group a series of operations together into an atomic unit of work called
a transaction. If any one of the operations fails, the transaction can be rolled
back, and the operations can be attempted again from the beginning. If all the
operations succeed, the transaction can be committed.

In a JMS client, you can use local transactions to group message sends and
receives. The JMS API Session interface provides commit and rollback meth-
ods that you can use in a JMS client. A transaction commit means that all pro-
duced messages are sent and all consumed messages are acknowledged. A
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transaction rollback means that all produced messages are destroyed and all con-
sumed messages are recovered and redelivered unless they have expired (see
Allowing Messages to Expire, page 1021).

A transacted session is always involved in a transaction. As soon as the commit

or the rollback method is called, one transaction ends and another transaction
begins. Closing a transacted session rolls back its transaction in progress, includ-
ing any pending sends and receives.

In an Enterprise JavaBeans component, you cannot use the Session.commit and
Session.rollback methods. Instead, you use distributed transactions, which
are described in Using the JMS API in a J2EE Application (page 1035).

You can combine several sends and receives in a single JMS API local transac-
tion. If you do so, you need to be careful about the order of the operations. You
will have no problems if the transaction consists of all sends or all receives or if
the receives come before the sends. But if you try to use a request-reply mecha-
nism, whereby you send a message and then try to receive a reply to the sent
message in the same transaction, the program will hang, because the send cannot
take place until the transaction is committed. The following code fragment illus-
trates the problem:

// Don’t do this!
outMsg.setJMSReplyTo(replyQueue);
producer.send(outQueue, outMsg);
consumer = session.createConsumer(replyQueue);
inMsg = consumer.receive();
session.commit();

Because a message sent during a transaction is not actually sent until the transac-
tion is committed, the transaction cannot contain any receives that depend on
that message’s having been sent.

In addition, the production and the consumption of a message cannot both be
part of the same transaction. The reason is that the transactions take place
between the clients and the JMS provider, which intervenes between the produc-
tion and the consumption of the message. Figure 29–8 illustrates this interaction.
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Figure 29–8 Using JMS API Local Transactions

The sending of one or more messages to one or more destinations by Client 1
can form a single transaction, because it forms a single set of interactions with
the JMS provider using a single session. Similarly, the receiving of one or more
messages from one or more destinations by Client 2 also forms a single transac-
tion using a single session. But because the two clients have no direct interaction
and are using two different sessions, no transactions can take place between
them.

Another way of putting this is that the act of producing and/or consuming mes-
sages in a session can be transactional, but the act of producing and consuming a
specific message across different sessions cannot be transactional.

This is the fundamental difference between messaging and synchronized pro-
cessing. Instead of tightly coupling the sending and receiving of data, message
producers and consumers use an alternative approach to reliability, one that is
built on a JMS provider’s ability to supply a once-and-only-once message deliv-
ery guarantee.

When you create a session, you specify whether it is transacted. The first argu-
ment to the createSession method is a boolean value. A value of true means
that the session is transacted; a value of false means that it is not transacted.
The second argument to this method is the acknowledgment mode, which is rel-
evant only to nontransacted sessions (see Controlling Message
Acknowledgment, page 1016). If the session is transacted, the second argument
is ignored, so it is a good idea to specify 0 to make the meaning of your code
clear. For example:

session = connection.createSession(true, 0);

The commit and the rollback methods for local transactions are associated with
the session. You can combine queue and topic operations in a single transaction
if you use the same session to perform the operations. For instance, you can use
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the same session to receive a message from a queue and send a message to a
topic in the same transaction.

You can pass a client program’s session to a message listener’s constructor func-
tion and use it to create a message producer, so that you can use the same session
for receives and sends in asynchronous message consumers.

The next section provides an example of the use of JMS API local transactions.

A Local Transaction Example
The TransactedExample.java program in the directory <INSTALL>/

j2eetutorial14/examples/jms/advanced/src/ demonstrates the use of
transactions in a JMS client application. This example shows how to use a queue
and a topic in a single transaction as well as how to pass a session to a message
listener’s constructor function. The program represents a highly simplified e-
Commerce application, in which the following things happen.

1. A retailer sends a MapMessage to the vendor order queue, ordering a quan-
tity of computers, and waits for the vendor’s reply:
producer =

session.createProducer(vendorOrderQueue);
outMessage = session.createMapMessage();
outMessage.setString("Item", "Computer(s)");
outMessage.setInt("Quantity", quantity);
outMessage.setJMSReplyTo(retailerConfirmQueue);
producer.send(outMessage);
System.out.println("Retailer: ordered " +

quantity + " computer(s)");

orderConfirmReceiver =
session.createConsumer(retailerConfirmQueue);

connection.start();

2. The vendor receives the retailer’s order message and sends an order mes-
sage to the supplier order topic in one transaction. This JMS transaction
uses a single session, so we can combine a receive from a queue with a
send to a topic. Here is the code that uses the same session to create a con-
sumer for a queue and a producer for a topic:
vendorOrderReceiver =

session.createConsumer(vendorOrderQueue);
supplierOrderProducer =

session.createProducer(supplierOrderTopic);

../examples/jms/advanced/src/TransactedExample.java
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The following code receives the incoming message, sends an outgoing
message, and commits the session. The message processing has been
removed to keep the sequence simple:

inMessage = vendorOrderReceiver.receive();
// Process the incoming message and format the outgoing mes-
sage
...
supplierOrderProducer.send(orderMessage);
...
session.commit();

3. Each supplier receives the order from the order topic, checks its inventory,
then sends the items ordered to the queue named in the order message’s
JMSReplyTo field. If it does not have enough in stock, the supplier sends
what it has. The synchronous receive from the topic and the send to the
queue take place in one JMS transaction.
receiver = session.createConsumer(orderTopic);
...
inMessage = receiver.receive();
if (inMessage instanceof MapMessage) {

orderMessage = (MapMessage) inMessage;
// Process message

MessageProducer producer =
session.createProducer((Queue)

orderMessage.getJMSReplyTo());
outMessage = session.createMapMessage();
// Add content to message
producer.send(outMessage);
// Display message contents
session.commit();

4. The vendor receives the replies from the suppliers from its confirmation
queue and updates the state of the order. Messages are processed by an
asynchronous message listener; this step shows the use of JMS transac-
tions with a message listener.
MapMessage component = (MapMessage) message;
...
orderNumber =

component.getInt("VendorOrderNumber");
Order order =

Order.getOrder(orderNumber).processSubOrder(component);
session.commit();

5. When all outstanding replies are processed for a given order, the vendor
message listener sends a message notifying the retailer whether it can ful-
fill the order.



1032 THE JAVA MESSAGE SERVICE API
Queue replyQueue =
(Queue) order.order.getJMSReplyTo();

MessageProducer producer =
session.createProducer(replyQueue);

MapMessage retailerConfirmMessage =
session.createMapMessage();

// Format the message
producer.send(retailerConfirmMessage);
session.commit();

6. The retailer receives the message from the vendor:

inMessage =
(MapMessage) orderConfirmReceiver.receive();

Figure 29–9 illustrates these steps.

Figure 29–9 Transactions: JMS Client Example

The program contains five classes: Retailer, Vendor, GenericSupplier,
VendorMessageListener, and Order. The program also contains a main method
and a method that runs the threads of the Retail, Vendor, and two supplier
classes.
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All the messages use the MapMessage message type. Synchronous receives are
used for all message reception except for the case of the vendor processing the
replies of the suppliers. These replies are processed asynchronously and demon-
strate how to use transactions within a message listener.

At random intervals, the Vendor class throws an exception to simulate a database
problem and cause a rollback.

All classes except Retailer use transacted sessions.

The program uses three queues named AQueue, BQueue, and CQueue, and one
topic named OTopic. Before you run the program,

1. Compile the program if you did not do so previously:
asant build

2. In the Admin Console, create three physical destinations of type queue

named AQueueP, BQueueP, and CQueueP.

3. Create a physical destination of type topic named OTopicP.

4. Create three destination resources with the names AQueue, BQueue, and
CQueue, all of type javax.jms.Queue. For each, add the property Name

with the value AQueueP, BQueueP, or CQueueP, respectively.

5. Create a destination resource with the name OTopic of type
javax.jms.Topic. Add the property Name with the value OTopicP.

To package the program, perform the following steps:

1. If you did not do so before, start deploytool.

2. Choose File→New→Application Client to start the Application Client
Wizard.

3. Select the radio button labeled Create New Stand-Alone AppClient Mod-
ule.

4. Click Browse next to the AppClient Location field and navigate to the
<INSTALL>/j2eetutorial14/examples/jms/advanced/ directory.

5. Type TransactedExample in the File Name field and click Choose Module
File.

6. Verify that TransactedExample appears in the AppClient Name field.

7. Click the Edit button next to the Contents text area.

8. In the dialog box, locate the build directory. Select the six classes whose
names begin with TransactedExample from the Available Files tree and
click Add.
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9. Select the two classes whose names begin with SampleUtilities from
the Available Files tree and click Add, then OK.

10.Click Next.

11.In the General screen, select TransactedExample in the Main Class
combo box.

12.Click Next.

13.Click Finish.

Run the program, specifying the number of computers to be ordered. To order
three computers, use the following command:

appclient -client TransactedExample.jar 3

The output looks something like this:

Quantity to be ordered is 3
Retailer: ordered 3 computer(s)
Vendor: Retailer ordered 3 Computer(s)
Vendor: ordered 3 monitor(s) and hard drive(s)
Monitor Supplier: Vendor ordered 3 Monitor(s)
Monitor Supplier: sent 3 Monitor(s)
  Monitor Supplier: committed transaction
  Vendor: committed transaction 1
Hard Drive Supplier: Vendor ordered 3 Hard Drive(s)
Hard Drive Supplier: sent 1 Hard Drive(s)
Vendor: Completed processing for order 1
  Hard Drive Supplier: committed transaction
Vendor: unable to send 3 computer(s)
  Vendor: committed transaction 2
Retailer: Order not filled
Retailer: placing another order
Retailer: ordered 6 computer(s)
Vendor: JMSException occurred: javax.jms.JMSException:
Simulated database concurrent access exception
javax.jms.JMSException: Simulated database concurrent access
exception
        at TransactedExample$Vendor.run(Unknown Source)
  Vendor: rolled back transaction 1
Vendor: Retailer ordered 6 Computer(s)
Vendor: ordered 6 monitor(s) and hard drive(s)
Monitor Supplier: Vendor ordered 6 Monitor(s)
Hard Drive Supplier: Vendor ordered 6 Hard Drive(s)
Monitor Supplier: sent 6 Monitor(s)
  Monitor Supplier: committed transaction
Hard Drive Supplier: sent 6 Hard Drive(s)
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  Hard Drive Supplier: committed transaction
  Vendor: committed transaction 1
Vendor: Completed processing for order 2
Vendor: sent 6 computer(s)
Retailer: Order filled
  Vendor: committed transaction 2

When you have finished with this sample application, use the Admin Console to
delete the physical destinations AQueueP, BQueueP, CQueueP, and OTopicP, and
the destination resources AQueue, BQueue, CQueue, and OTopic.

Use the following command to remove the class files:

asant clean

If you wish, you can manually remove the client JAR files.

The build.xml file in the directory <INSTALL>/j2eetutorial14/examples/

jms/advanced contains asant targets for creating and deleting all the adminis-
tered objects used in this chapter. If you want to run the examples again, you can
recreate the objects quickly with the add-objects target. Use the command
asant -projecthelp to obtain a list of the targets.

Using the JMS API in a J2EE Application
This section describes the ways in which using the JMS API in a J2EE applica-
tion differs from using it in a standalone client application:

• Using session and entity beans to produce and to synchronously receive
messages

• Using message-driven beans to receive messages asynchronously

• Managing distributed transactions

• Using application clients and Web components

• Specifying deployment descriptors

A general rule new at J2EE version 1.4 applies to all J2EE components that use
EJB or Web containers:

Any component within an EJB or Web container must have no more than
one JMS session per JMS connection.

This rule does not apply to application clients.
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Using Session and Entity Beans to
Produce and to Synchronously Receive
Messages
A J2EE application that produces messages or synchronously receives them may
use either a session bean or an entity bean to perform these operations. The
example in A J2EE Application that Uses the JMS API with a Session
Bean (page 1052) uses a stateless session bean to publish messages to a topic.

Because a blocking synchronous receive ties up server resources, it is not a good
programming practice to use such a receive call in an enterprise bean. Instead,
use a timed synchronous receive, or use a message-driven bean to receive mes-
sages asynchronously. For details about blocking and timed synchronous
receives, see Writing the Client Programs (page 999).

Using the JMS API in a J2EE application is in many ways similar to using it in a
standalone client. The main differences are in administered objects, resource
management, and transactions.

Administered Objects
The J2EE Platform Specification recommends that you use java:comp/env/jms

as the environment subcontext for JNDI lookups of connection factories and des-
tinations. With the J2EE Application Server, you use deploytool to specify
JNDI names that correspond to those in your source code.

Instead of looking up a JMS API connection factory or destination each time it is
used in a method, it is recommended that you look up these instances once in the
enterprise bean’s ejbCreate method and cache them for the lifetime of the
enterprise bean.

Resource Management
JMS API resources are a JMS API connection and a JMS API session. In gen-
eral, it is important to release JMS resources when they are no longer being used.
Here are some useful practices to follow.

• If you wish to maintain a JMS API resource only for the life span of a busi-
ness method, it is a good idea to close the resource in a finally block
within the method.
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• If you would like to maintain a JMS API resource for the life span of an
enterprise bean instance, it is a good idea to use the component’s ejb-

Create method to create the resource and to use the component’s ejb-

Remove method to close the resource. If you use a stateful session bean or
an entity bean and you wish to maintain the JMS API resource in a cached
state, you must close the resource in the ejbPassivate method and set its
value to null, and you must create it again in the ejbActivate method.

Transactions
Instead of using local transactions, you use deploytool to specify container-
managed transactions for bean methods that perform sends or receives, allowing
the EJB container to handle transaction demarcation.

You can use bean-managed transactions and the javax.transaction.User-

Transaction interface’s transaction demarcation methods, but you should do so
only if your application has special requirements and you are an expert in using
transactions. Usually, container-managed transactions produce the most efficient
and correct behavior. This tutorial does not provide any examples of bean-man-
aged transactions.

Using Message-Driven Beans
As we noted in What Is a Message-Driven Bean? (page 674) and How Does the
JMS API Work with the J2EE Platform? (page 980), the J2EE platform supports
a special kind of enterprise bean, the message-driven bean, which allows J2EE
applications to process JMS messages asynchronously. Session beans and entity
beans allow you to send messages and to receive them synchronously but not
asynchronously.

A message-driven bean is a message listener that can reliably consume messages
from a queue or a durable subscription. The messages may be sent by any J2EE
component—from an application client, another enterprise bean, or a Web com-
ponent—or from an application or a system that does not use J2EE technology.

Like a message listener in a standalone JMS client, a message-driven bean con-
tains an onMessage method that is called automatically when a message arrives.
Like a message listener, a message-driven bean class may implement helper
methods invoked by the onMessage method to aid in message processing.
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A message-driven bean differs from a standalone client’s message listener in the
following ways, however:

• Setup tasks performed by the EJB container

• Interfaces and methods the bean class must implement

The EJB container automatically performs several setup tasks that a standalone
client has to do:

• Creating a message consumer to receive the messages. IInstead of creating
a message consumer in your source code, you associate the message-
driven bean with a destination and a connection factory at deployment
time. If you want to specify a durable subscription or use a message selec-
tor, you do this at deployment time also.

• Registering the message listener. You must not call setMessageListener.

• Specifying a message acknowledgment mode. (For details, see Managing
Distributed Transactions, page 1040.)

If JMS is integrated with the application server using a resource adapter, the JMS
resource adapter handles these tasks for the EJB container. It creates a connec-
tion factory for the message-driven bean to use. You use an activation configura-
tion specification to specify properties for the connection factory, such as a
durable subscription, a message selector, or an acknowledgment mode. See
Specifying Activation Configuration Properties for Message-Driven
Beans (page 1048) for details. The examples in Chapter 30 show how the JMS
resource adapter works in the J2EE 1.4 Application Server.

Your message-driven bean class must implement the following, in addition to the
onMessage method:

• The javax.ejb.MessageDrivenBean and the javax.jms.Message-

Listener interfaces

• The ejbCreate method, which has the following signature:
public void ejbCreate() {}

If your message-driven bean produces messages or does synchronous
receives from another destination, you use its ejbCreate method to look
up JMS API connection factories and destinations and to create the JMS
API connection.

• The ejbRemove method, which has the following signature:
public void ejbRemove() {}
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If you used the message-driven bean’s ejbCreate method to create the
JMS API connection, you ordinarily use the ejbRemove method to close
the connection.

• The setMessageDrivenContext method. A MessageDrivenContext

object provides some additional methods that you can use for transaction
management. The method has the following signature:
public void setMessageDrivenContext(MessageDrivenContext

mdc) {}

The main difference between a message-driven bean and other enterprise beans
is that a message-driven bean has no home or remote interface. Instead, it has
only a bean class.

A message-driven bean is similar in some ways to a stateless session bean: its
instances are relatively short-lived and retain no state for a specific client. The
instance variables of the message-driven bean instance can contain some state
across the handling of client messages: for example, a JMS API connection, an
open database connection, or an object reference to an enterprise bean object.

Like a stateless session bean, a message-driven bean can have many interchange-
able instances running at the same time. The container can pool these instances
to allow streams of messages to be processed concurrently. The container
attempts to deliver messages in chronological order when this does not impair
the concurrency of message processing, but no guarantees are made as to the
exact order in which messages are delivered to the instances of the message-
driven bean class. Because concurrency can affect the order in which messages
are delivered, you should write your applications to handle messages that arrive
out of sequence.

For example, your application could manage “conversations” with application-
level sequence numbers. An application-level conversation control mechanism
with a persistent conversation state could cache later messages until earlier mes-
sages have been processed.

Another way to ensure order is to have each message or message group in a con-
versation require a confirmation message that the sender blocks on receipt of.
This forces the responsibility for order back on the sender and more tightly cou-
ples senders to the progress of message-driven beans.

To create a new instance of a message-driven bean, the container instantiates the
bean and then

• Calls the setMessageDrivenContext method to pass the context object to
the instance
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• Calls the instance’s ejbCreate method

Figure 29–10 shows the life cycle of a message-driven bean.

Figure 29–10 Life Cycle of a Message-Driven Bean

Managing Distributed Transactions
JMS client applications use JMS API local transactions, described in Using JMS
API Local Transactions (page 1027), which allow the grouping of sends and
receives within a specific JMS session. J2EE applications commonly use distrib-
uted transactions in order to ensure the integrity of accesses to external
resources. For example, distributed transactions allow multiple applications to
perform atomic updates on the same database, and they allow a single applica-
tion to perform atomic updates on multiple databases.

In a J2EE application that uses the JMS API, you can use transactions to combine
message sends or receives with database updates and other resource manager oper-
ations. You can access resources from multiple application components within a
single transaction. For example, a servlet may start a transaction, access multiple
databases, invoke an enterprise bean that sends a JMS message, invoke another
enterprise bean that modifies an EIS system using the Connector architecture,
and finally commit the transaction. Your application cannot, however, both send
a JMS message and receive a reply to it within the same transaction; the restric-
tion described in Using JMS API Local Transactions (page 1027) still applies.
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Distributed transactions can be either of two kinds:

• Container-managed transactions. The EJB container controls the integrity
of your transactions without your having to call commit or rollback.
Container-managed transactions are recommended for J2EE applications
that use the JMS API. You can specify appropriate transaction attributes
for your enterprise bean methods.

Use the Required transaction attribute to ensure that a method is always
part of a transaction. If a transaction is in progress when the method is
called, the method will be part of that transaction; if not, a new transaction
will be started before the method is called and will be committed when
the method returns.

• Bean-managed transactions. You can use these in conjunction with the
javax.transaction.UserTransaction interface, which provides its own
commit and rollback methods that you can use to delimit transaction
boundaries. Bean-managed transactions are recommended only for those
experienced in programming transactions.

You can use either container-managed transactions or bean-managed transac-
tions with message-driven beans.

To ensure that all messages are received and handled within the context of a
transaction, use container-managed transactions and specify the Required trans-
action attribute for the onMessage method. This means that if there is no transac-
tion in progress, a new transaction will be started before the method is called and
will be committed when the method returns.

When you use container-managed transactions, you can call the following
MessageDrivenContext methods:

• setRollbackOnly. Use this method for error handling. If an exception
occurs, setRollbackOnly marks the current transaction so that the only
possible outcome of the transaction is a rollback.

• getRollbackOnly. Use this method to test whether the current transaction
has been marked for rollback.

If you use bean-managed transactions, the delivery of a message to the
onMessage method takes place outside of the distributed transaction context. The
transaction begins when you call the UserTransaction.begin method within
the onMessage method and ends when you call UserTransaction.commit. Any
call to the Connection.createSession method must take place within the
transaction. If you call UserTransaction.rollback, the message is not redeliv-
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ered, whereas calling setRollbackOnly for container-managed transactions
does cause a message to be redelivered.

Neither the JMS API Specification nor the Enterprise JavaBeans Specification
(available from http://java.sun.com/products/ejb/) specifies how to han-
dle calls to JMS API methods outside transaction boundaries. The Enterprise
JavaBeans Specification does state that the EJB container is responsible for
acknowledging a message that is successfully processed by the onMessage

method of a message-driven bean that uses bean-managed transactions. Using
bean-managed transactions allows you to process the message by using more
than one transaction or to have some parts of the message processing take place
outside a transaction context. In most cases, however, container-managed trans-
actions provide greater reliability and are therefore preferable.

When you create a session in an enterprise bean, the container ignores the argu-
ments you specify, because it manages all transactional properties for enterprise
beans. It is still a good idea to specify arguments of true and 0 to the create-

Session method to make this situation clear:

session = connection.createSession(true, 0);

When you use container-managed transactions, you usually specify the
Required transaction attribute for your enterprise bean’s business methods.

You do not specify a message acknowledgment mode when you create a mes-
sage-driven bean that uses container-managed transactions. The container
acknowledges the message automatically when it commits the transaction.

If a message-driven bean uses bean-managed transactions, the message receipt
cannot be part of the bean-managed transaction, so the container acknowledges
the message outside of the transaction. When you package a message-driven
bean using deploytool, you use activation configuration properties to specify
the acknowledgment mode. See Table 29–6 on page 1048 for details.

If the onMessage method throws a RuntimeException, the container does not
acknowledge processing the message. In that case, the JMS provider will rede-
liver the unacknowledged message in the future.

http://java.sun.com/products/ejb/
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Using the JMS API with Application
Clients and Web Components
An application client can use the JMS API in much the same way a standalone
client program does. It can produce messages, and it can consume messages by
using either synchronous receives or message listeners. See Chapter 23 for an
example of an application client that produces messages; see A J2EE Applica-
tion that Uses the JMS API with an Entity Bean (page 1061) and An Application
Example that Deploys a Message-Driven Bean on Two J2EE
Servers (page 1075) for examples of using application clients to produce and to
consume messages.

The J2EE Platform Specification does not impose strict constraints on how Web
components should use the JMS API. In the J2EE 1.4 Application Server, a Web
component—one that uses either the Java Servlet API or JavaServerPages (JSP)
technology—may send messages and consume them synchronously but may not
consume them asynchronously.

Because a blocking synchronous receive ties up server resources, it is not a good
programming practice to use such a receive call in a Web component. Instead,
use a timed synchronous receive. For details about blocking and timed synchro-
nous receives, see Writing the Client Programs (page 999).

Specifying Deployment Descriptors
When you package a J2EE application, you provide deployment descriptors for
the application and its modules. This section describes the deployment descrip-
tor elements specific to an application that uses the JMS API and message-driven
beans. At release 1.4 of the J2EE platform, message-driven beans can be config-
ured to consume messages from other messaging sources in addition to JMS pro-
viders.

At release 1.4 of the J2EE platform, application servers must be able to support
both DTDs and XML schemas. The order in which you specify elements in
deployment descriptors is not significant when you use DTDs, but it is signifi-
cant when you use XML schemas. Therefore, it is a good idea to use deploy-

tool to create the deployment descriptors for you.
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This section covers the following topics:

• Deployment descriptor elements for connection factories and destinations

• Deployment descriptor elements for message-driven beans

• Deployment descriptor elements specified at run time

• Specifying activation configuration properties for message-driven beans

Deployment Descriptor Elements for
Connection Factories and Destinations
Modules that send messages or receive messages synchronously use the ele-
ments listed in Table 29–3. These elements describe the JMS resources refer-
enced in module source code: connection factories and destinations. The XML
Schema files used by the J2EE Application Server are in the directory
<J2EE_HOME>/lib/schemas/.You use these elements in deployment descriptors
for application clients, enterprise beans, and Web components.

Table 29–3 Deployment Descriptor Elements for Connection Factories and
Destinations

Element Name Description

<resource-ref>

Contains a declaration of the enterprise bean’s reference to an
external resource, such as a JMS API connection factory. Con-
tains the elements <res-ref-name>, <res-type>, and
<res-auth>.

<res-ref-name>
Specifies the coded name of a resource manager connection
factory reference, such as jms/MyConnectionFactory.

<res-type>

Specifies the type of the data source. The type is specified by
the Java interface expected to be implemented by the connec-
tion factory. For JMS connection factories, the allowed inter-
faces are javax.jms.ConnectionFactory,
javax.jms.QueueConnectionFactory, and
javax.jms.TopicConnectionFactory.

<res-auth>

Specifies whether the enterprise bean code signs on program-
matically to the resource manager (Application) or whether
the Container will sign on to the resource manager on behalf of
the bean. In the latter case, the Container uses information that
is supplied by the Deployer. Normally, the value is Container.
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<res-sharing-scope>
Specifies whether connections obtained through the given
resource manager connection factory reference can be shared.
Normally, the value is Shareable.

<message-destination-
ref>

Specifies a reference to a message destination associated with a
resource in the module’s environment. Contains the elements
<message-destination-ref-name>, <message-desti-
nation-type>, <message-destination-usage>, and
<message-destination-link>. It is recommended that the
<message-destination-ref> and <message-destina-
tion> elements be used instead of the <resource-env-ref>
element that was introduced at release 1.3 of the J2EE plat-
form.

<message-destination-
ref-name>

Specifies the coded name of a message destination reference.
The name is a JNDI name relative to the java:comp/env con-
text, such as jms/NewHireTopic.

<message-destination-
type>

Specifies the type of the destination. The type is specified by
the Java interface expected to be implemented by the destina-
tion. For JMS destinations, the allowed interfaces are
javax.jms.Topic and javax.jms.Queue.

<message-destination-
usage>

Specifies the use of the message destination indicated by the
reference. Must be one of the following: Consumes, Pro-
duces, or ConsumesProduces.

<message-destination-
link>

Links a message destination reference or message-driven bean
to a message destination. For example, if the <message-des-
tination> element has the <message-destination-
name> value PhysicalTopic, specify PhysicalTopic as the
value of the <message-destination-link> element.

<message-destination>

Specifies a message destination. The logical destination
described by this element is mapped to a physical destination
by the Deployer. Contains a <message-destination-name>
element. In the J2EE Application Server, the name you specify
here is the name of the destination you created with the asad-
min create-jmsdest command.

<message-destination-
name>

Specifies a name for a message destination.

Table 29–3 Deployment Descriptor Elements for Connection Factories and
Destinations

Element Name Description
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Deployment Descriptor Elements for
Message-Driven Beans
The deployment descriptor for a message-driven bean is similar to the deploy-
ment descriptor for a session or entity bean in many respects. It includes the
messaging-specific elements listed in Table 29–4. The XML Schema files used
by the J2EE Application Server are in the directory <J2EE_HOME>/lib/sche-

mas/.

Table 29–4 Deployment Descriptor Elements for Message-Driven Beans

Element Name Description

<message-driven>
Declares a message-driven bean within an <enterprise-
beans> element.

<messaging-type>
Specifies the message listener interface of the message-
driven bean. If the <messaging-type> element is not spec-
ified, it is assumed to be javax.jms.MessageListener.

<message-destination-
type>

Specifies the type of the destination. The type is specified by
the Java interface expected to be implemented by the desti-
nation, such as javax.jms.Topic.

<message-destination-
link>

Links a message destination reference or message-driven
bean to a message destination.

<activation-config>

Defines information about the expected configuration prop-
erties of the message-driven bean in its operational environ-
ment. This may include information about message
acknowledgement, message selector, expected destination
type, and so on. For details, see Specifying Activation Con-
figuration Properties for Message-Driven
Beans (page 1048). Contains a set of <activation-con-
fig-property> elements.

<activation-config-
property>

Contains an <activation-config-property-name>
and <activation-config-property-value> pair for a
message-driven bean.

<activation-config-
property-name>

Contains the name for an activation configuration property
of a message-driven bean.

<activation-config-
property-value>

Contains the value for an activation configuration property
of a message-driven bean.



SPECIFYING DEPLOYMENT DESCRIPTORS 1047
Deployment Descriptor Elements Specified at
Runtime
The runtime deployment descriptors for an application specify the runtime link-
ages between the connection factories and destinations specified in source code
and the actual resources in the JNDI namespace. Runtime deployment descrip-
tors vary from one application server to another. This section describes the ele-
ments used in the J2EE Application Server runtime deployment descriptors,
which are named sun-application.xml, sun-application-client.xml, sun-
ejb-jar.xml, and so on. The Document Type Definitions (DTDs) for these
deployment descriptors are in the directory <J2EE_HOME>/lib/dtds/.

Table 29–5 lists these elements.

Table 29–5 Runtime Deployment Descriptor Elements

Element Name Description

<mdb-connection-factory>
Specifies the connection factory associated
with the message-driven bean.

<jms-durable-subscription-name>

Specifies the name of a durable subscription
associated with a message-driven bean’s des-
tination.  Required for a Topic destination if
the subscriptionDurability activation
configuration property is set to Durable.

<resource-ref>

Specifies the runtime bindings of a resource
reference. Contains the elements <res-ref-
name> and <jndi-name> and, optionally,
<default-resource-principal>.

<res-ref-name>
Specifies the coded name of a JMS connec-
tion factory, such as jms/MyConnection-
Factory.

<default-resource-principal>
Specifies the username and password to be
used to access the connection factory, using
the <name> and <password> elements.

<message-destination>

Specifies the name and JNDI name of a logi-
cal message destination. Contains the ele-
ments <message-destination-name> and
<jndi-name>.
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Specifying Activation Configuration Properties
for Message-Driven Beans
Activation configuration properties are needed to configure message-driven
beans at release 1.4 of the J2EE platform if the JMS API is integrated using a
J2EE Connector Architecture resource adapter. This section describes the prop-
erties you may specify for message-driven beans that consume JMS messages.

You may specify these properties either in the enterprise bean deployment
descriptor or in the runtime deployment descriptor, or both. Any properties spec-
ified in the runtime deployment descriptor override the properties specified in the
enterprise bean deployment descriptor.

Table 29–6 lists these properties.

<message-destination-name>

Specifies the name of a logical message desti-
nation. This logical name, which was also
specified by the module deployment descrip-
tor (see Table 29–3), is now linked to the
JNDI name of the destination.

<jndi-name>

The JNDI name of a JMS resource, which
may be either a connection factory or a desti-
nation. This is the name you specified when
you created the resource administratively.

Table 29–6 Activation Configuration Property Names and Values

Property Name Description and Values

destinationType
The interface type of the destination, either
javax.jms.Topic or javax.jms.Queue.

messageSelector A message selector.

Table 29–5 Runtime Deployment Descriptor Elements

Element Name Description
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Further Information
For more information about JMS, see the following:

• Java Message Service website:
http://java.sun.com/products/jms/index.html

• Java Message Service specification, version 1.1, available from:
http://java.sun.com/products/jms/docs.html

subscriptionDurability

A value of Durable indicates that the mes-
sage-driven bean is a durable subscriber to a
topic. If the value is Durable, then the cli-
entId and subscriptionName properties
must also be specified.
A value of NonDurable specifies that the
bean is not using a durable subscription. If
omitted, the bean is assumed to be a nondura-
ble subscriber if the destinationType
value is javax.jms.Topic.

acknowledgeMode

The acknowledgment mode of the bean,
either Auto-acknowledge or Dups-ok-
acknowledge. If not specified, assumed to
be Auto-acknowledge.

Table 29–6 Activation Configuration Property Names and Values

Property Name Description and Values

http://java.sun.com/products/jms/index.html
http://java.sun.com/products/jms/docs.html
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J2EE Examples Using
the JMS API

This chapter provides examples that show how to use the JMS API within a
J2EE application in the following ways:

• Using a session bean to send messages that are consumed by a message-
driven bean using a message selector and a durable subscription

• Using an application client to send messages that are consumed by two
message-driven beans; the information from them is stored in an entity
bean

• Using an application client to send messages that are consumed by a mes-
sage-driven bean on a remote server

• Using an application client to send messages that are consumed by mes-
sage-driven beans on two different servers

The examples are in the following directory:

 <INSTALL>/j2eetutorial14/examples/jms/

To build and run the examples, you will do the following:

1. Use the asant tool to create resources and compile the example

2. Use the Admin Console to create resources
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3. Use the deploytool to package and deploy the example

4. Use the appclient command to run the client

Each example has a build.xml file that refers to a targets.xml file and a
build.properties file in the following directory:

<INSTALL>/j2eetutorial14/examples/jms/common/

The following directory contains built versions of each application:

<INSTALL>/j2eetutorial14/examples/jms/provided-ears

If you run into difficulty at any time, you can open the appropriate EAR file in
deploytool and compare that file to your own version.

See Chapter 23 for a simpler example of a J2EE application that uses the JMS
API.

A J2EE Application that Uses the JMS
API with a Session Bean

This section explains how to write, compile, package, deploy, and run a J2EE
application that uses the JMS API in conjunction with a session bean. The appli-
cation contains the following components:

• An application client that invokes an enterprise bean

• A session bean that publishes several messages to a topic

• A message-driven bean that receives and processes the messages, using a
durable topic subscriber and a message selector

The section covers the following topics:

• Writing the Application Components

• Creating and Packaging the Application

• Deploying the Application

• Running the Application Client

You will find the source files for this section in the directory <INSTALL>/

j2eetutorial14/examples/jms/clientsessionmdb/. Path names in this sec-
tion are relative to this directory.
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Writing the Application Components
This application demonstrates how to send messages from an enterprise bean—
in this case, a session bean—rather than from an application client, as in the
example in Chapter 23. Figure 30–1 illustrates the structure of this application.

Figure 30–1 A J2EE Application: Client to Session Bean to Message-Driven Bean

The Publisher enterprise bean in this example is the enterprise-application equiv-
alent of a wire-service news feed that categorizes news events into six news cate-
gories. The message-driven bean could represent a newsroom, where the Sports
desk, for example, would set up a subscription for all news events pertaining to
sports.

The application client in the example obtains a handle to the Publisher enterprise
bean’s remote home interface and calls the enterprise bean’s business method.
The enterprise bean creates 18 text messages. For each message, it sets a String

property randomly to one of six values representing the news categories and then
publishes the message to a topic. The message-driven bean uses a message selec-
tor for the property to limit which of the published messages it receives.

Writing the components of the application involves

• Coding the Application Client: MyAppClient.java

• Coding the Publisher Session Bean

• Coding the Message-Driven Bean: MessageBean.java
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Coding the Application Client:
MyAppClient.java
The application client program, src/MyAppClient.java, performs no JMS API
operations and so is simpler than the client program in Chapter 23. The program
obtains a handle to the Publisher enterprise bean’s remote home interface, using
the JNDI naming context java:comp/env. The program then creates an instance
of the bean and calls the bean’s business method twice.

Coding the Publisher Session Bean
The Publisher bean is a stateless session bean with one create method and one
business method. The Publisher bean uses remote interfaces rather than local
interfaces because it is accessed from outside the EJB container.

The remote home interface source file is src/PublisherHome.java.

The remote interface, src/PublisherRemote.java, declares a single business
method, publishNews.

The bean class, src/PublisherBean.java, implements the publishNews

method and its helper method chooseType. The bean class also implements the
required methods ejbCreate, setSessionContext, ejbRemove, ejbActivate,
and ejbPassivate.

The ejbCreate method of the bean class allocates resources—in this case, by
looking up the ConnectionFactory and the topic and creating the Connection.
The business method publishNews creates a Session and a MessageProducer

and publishes the messages.

The ejbRemove method must deallocate the resources that were allocated by the
ejbCreate method. In this case, the ejbRemove method closes the Connection.

Coding the Message-Driven Bean:
MessageBean.java
The message-driven bean class, src/MessageBean.java, is identical to the one
in Chapter 23. However, the deployment descriptor will be different, because the
bean is using a topic with a durable subscription, instead of a queue.

../examples/jms/clientsessionmdb/src/MyAppClient.java
../examples/jms/clientsessionmdb/src/PublisherHome.java
../examples/jms/clientsessionmdb/src/PublisherRemote.java
../examples/jms/clientsessionmdb/src/PublisherBean.java
../examples/jms/clientsessionmdb/src/MessageBean.java
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Creating and Packaging the Application
This example uses the topic named jms/Topic and the connection factory jms/

TopicConnectionFactory, which you created in Creating JMS Administered
Objects (page 1002). It also uses the connection factory jms/DurableTopicCon-

nectionFactory, which you created in A Message Acknowledgment
Example (page 1017) and A Durable Subscription Example (page 1025). If you
deleted any of these objects, create them again.

Creating and packaging this application involve several steps:

1. Compiling the Source Files and Starting the J2EE Application Server

2. Starting deploytool and Creating the Application

3. Packaging the Session Bean

4. Packaging the Message-Driven Bean

5. Packaging the Application Client

6. Updating the JNDI Names

Compiling the Source Files and Starting the
J2EE Application Server

1. In the directory <INSTALL>/j2eetutorial14/examples/jms/client-

sessionmdb, use the build target to compile the source files:

asant build

2. Start the J2EE Application Server, if it is not already running.

Starting deploytool and Creating the
Application

1. Start deploytool.

2. Choose File→New→Application.

3. Click Browse next to the Application File Name field and use the file
chooser to locate the directory clientsessionmdb.

4. In the File Name field, type ClientSessionMDBApp.

5. Click New Application.

6. Click OK.
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Packaging the Session Bean
To package the session bean, perform the following steps:

1. Choose File→New→Enterprise Bean to start the Enterprise Bean Wizard.

2. In the EJB JAR screen:

a. Select Create New JAR Module in Application and verify that the appli-
cation is ClientSessionMDBApp. In the JAR Name field, type EBJAR.

b. Click the Edit button next to the Contents text area.

c. In the dialog box, locate the build/sb/ directory. Select Publisher-
Bean.class, PublisherHome.class, and PublisherRemote.class

from the Available Files tree and click Add, then OK.

3. In the General screen:

a. From the Enterprise Bean Class menu, choose sb.PublisherBean.

b. Verify that the Enterprise Bean Name is PublisherBean and the Enter-
prise Bean Type is Stateless Session.

c. In the Remote Interfaces area, choose sb.PublisherHome from the
Remote Home Interface menu and sb.PublisherRemote from the
Remote Interface menu.

After you finish the wizard, perform the following steps:

1. Click the PublisherBean node, then click the Msg Dest Refs tab. In the
inspector pane:

a. Click Add. A dialog box opens.

b. Type jms/TopicName in the Coded Name field.

c. Choose javax.jms.Topic from the Destination Type menu.

d. Choose Produces from the Usage menu.

e. Type PhysicalTopic in the Destination Name field.

2. Click the PublisherBean node, then click the Resource Refs tab. In the
inspector pane:

a. Click Add.

b. Type jms/MyConnectionFactory in the Coded Name field.

c. Choose javax.jms.ConnectionFactory from the Type menu.

d. Type jms/TopicConnectionFactory in the JNDI name field, and type
j2ee in both the User Name and Password fields.
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3. Click the PublisherBean node, then click the Transactions tab. In the
inspector pane, select the Container-Managed radio button.

4. Click the EBJAR node, then click the Message Destinations tab. In the
inspector pane:

a. Click Add.

b. Type PhysicalTopic in the Destination Name field. When you press
Enter, this name appears in the Display Name field, and PublisherBean

appears in the Producers area.

c. Type jms/Topic in the JNDI Name field.

Packaging the Message-Driven Bean
You will package the message-driven bean in the same JAR file as the session
bean, for greater efficiency.

To package the message-driven bean, perform the following steps:

1. Choose File→New→Enterprise Bean to start the Enterprise Bean Wizard,
then click Next.

2. In the EJB JAR screen:

a. Select the Add to Existing JAR Module radio button and verify that the
module is EBJAR (ClientSessionMDBApp).

b. Click the Edit button next to the Contents text area.

c. In the dialog box, locate the build/mdb/ directory. Select Message-
Bean.class from the Available Files tree and click Add, then OK.

3. In the General screen:

a. From the Enterprise Bean Class menu, choose mdb.MessageBean.

b. In the Enterprise Bean Name field, accept the default value, Message-
Bean.

c. Verify that the Enterprise Bean Type is Message-Driven.

4. In the Message-Driven Bean Settings screen:

a. For the Messaging Service, accept the default, JMS.

b. Choose javax.jms.Topic from the Destination Type menu.

c. Choose PhysicalTopic from the Target Destination Name menu.

d. Select the Durable Subscription checkbox. In the Subscription Name
field, type MySub.
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e. In the Message Selector field, type the following:
NewsType = ’Sports’ OR NewsType = ’Opinion’

f. In the Connection Factory JNDI Name (Sun-specific Setting) field, type
jms/DurableTopicConnectionFactory.

After you finish the wizard, perform the following steps:

1. Click the MessageBean node, then click the Transactions tab. In the inspec-
tor pane, select the Container-Managed radio button.

2. Click the EBJAR node, then click the Message Destinations tab and select
PhysicalTopic. You will see that MessageBean now appears in the Con-
sumers area.

Packaging the Application Client
To package the application client, perform the following steps:

1. Choose File→New→Application Client to start the Application Client
Wizard.

2. In the JAR File Contents screen:

a. Verify that Create New AppClient Module in Application is selected
and that the application is ClientSessionMDBApp.

b. In the AppClient Name field, type MyAppClient.

c. Click the Edit button next to the Contents text area.

d. In the dialog box, locate the build/client/ directory. Select MyApp-
Client.class from the Available Files tree and click Add, then OK.

3. In the General screen, choose client.MyAppClient in the Main Class
combo box.

After you finish the wizard, click the EJB Refs tab, then click Add in the inspec-
tor pane. In the dialog box:

1. Type ejb/remote/Publisher in the Coded Name field.

2. Choose Session from the EJB Type menu.

3. Choose Remote from the Interfaces menu.

4. Type sb.PublisherHome in the Home Interface field.

5. Type sb.PublisherRemote in the Local/Remote Interface field.

When you return to the EJB Refs inspector pane, select the bean. In the Sun-spe-
cific Settings area, select JNDI Name and type PublisherBean in the text field.
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Updating the JNDI Names
You need to update the JNDI name for the message-driven bean so that it speci-
fies the destination it receives messages from, not the bean name.

1. Select ClientSessionMDBApp and click the JNDI Names tab.

2. Type jms/Topic in the JNDI Name field for the MessageBean component.

Verify that the JNDI names for the application components are correct. They
should appear as shown in Table 30–1 and Table 30–2.

Deploying the Application
1. Choose File→Save to save the application.

2. Choose Tools→Deploy.

3. In the dialog box, type your administrative user name and password (if
they are not already filled in).

4. In the Application Client Stub Directory area, select the Return Client Jar
checkbox. If you wish to run the client in a directory other than the default,
click Browse and use the file chooser to specify it.

5. Click OK.

Table 30–1 Application Pane for ClientSessionMDBApp

Component Type Component JNDI Name

EJB MessageBean jms/Topic

EJB PublisherBean PublisherBean

Table 30–2 References Pane for ClientSessionMDBApp

Ref. Type Referenced By Reference Name JNDI Name

EJB Ref MyAppClient ejb/remote/Publisher Publisher

Resource PublisherBean
jms/MyConnection-
Factory

jms/TopicConnection-
Factory
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6. In the Distribute Module dialog box, click Close when the process com-
pletes. You will find a file named ClientSessionMDBAppClient.jar in
the specified directory.

Running the Application Client
To run the client, use the following command:

appclient -client ClientSessionMDBAppClient.jar

The program output in the terminal window looks something like this:

Looking up EJB reference
Looked up home
Narrowed home
Got the EJB

The output from the enterprise beans appears in the server log (<J2EE_HOME>/
domains/domain1/logs/server.log). The Publisher session bean sends two
sets of 18 messages numbered 0 through 17. Because of the message selector,
the message-driven bean receives only the messages whose NewsType property is
Sports or Opinion.

Suppose that the last few messages from the Publisher session bean look like
this:

PUBLISHER: Setting message text to: Item 12: Business
PUBLISHER: Setting message text to: Item 13: Opinion
PUBLISHER: Setting message text to: Item 14: Living/Arts
PUBLISHER: Setting message text to: Item 15: Sports
PUBLISHER: Setting message text to: Item 16: Living/Arts
PUBLISHER: Setting message text to: Item 17: Living/Arts

Because of the message selector, the last messages received by the message-
driven bean will be the following:

MESSAGE BEAN: Message received: Item 13: Opinion
MESSAGE BEAN: Message received: Item 15: Sports

If you like, you can rewrite the message selector to receive different messages.
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A J2EE Application that Uses the JMS
API with an Entity Bean

This section explains how to write, compile, package, deploy, and run a J2EE
application that uses the JMS API with an entity bean. The application uses the
following components:

• An application client that both sends and receives messages

• Two message-driven beans

• An entity bean that uses container-managed persistence

The section covers the following topics:

• Overview of the Human Resources Application

• Writing the Application Components

• Creating and Packaging the Application

• Deploying the Application

• Running the Application Client

You will find the source files for this section in the directory <INSTALL>/

j2eetutorial14/examples/jms/clientmdbentity/. Path names in this sec-
tion are relative to this directory.

Overview of the Human Resources
Application
This application simulates, in a simplified way, the work flow of a company’s
human resources (HR) department when it processes a new hire. This applica-
tion also demonstrates how to use the J2EE platform to accomplish a task that
many JMS client applications perform.

A JMS client must often wait for several messages from various sources. It then
uses the information in all these messages to assemble a message that it then
sends to another destination. The common term for this process is joining mes-
sages. Such a task must be transactional, with all the receives and the send as a
single transaction. If all the messages are not received successfully, the transac-
tion can be rolled back. For a client example that illustrates this task, see A Local
Transaction Example (page 1030).
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A message-driven bean can process only one message at a time in a transaction.
To provide the ability to join messages, a J2EE application can have the mes-
sage-driven bean store the interim information in an entity bean. The entity bean
can then determine whether all the information has been received; when it has,
the entity bean can create and send the message to the other destination. Once it
has completed its task, the entity bean can remove itself.

The basic steps of the application are as follows.

1. The HR department’s application client generates an employee ID for each
new hire and then publishes a message containing the new hire’s name and
employee ID. The client then creates a temporary queue with a message
listener that waits for a reply to the message. (See Creating Temporary
Destinations, page 1022, for more information.)

2. Two message-driven beans process each message: One bean assigns the
new hire’s office number, and one bean assigns the new hire’s equipment.
The first bean to process the message creates an entity bean to store the
information it has generated. The second bean locates the existing entity
bean and adds its information.

3. When both the office and the equipment have been assigned, the entity
bean sends to the reply queue a message describing the assignments, then
removes itself. The application client’s message listener retrieves the infor-
mation.

Figure 30–2 illustrates the structure of this application. An actual HR application
would have more components, of course; other beans could set up payroll and
benefits records, schedule orientation, and so on.
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Figure 30–2 A J2EE Application: Client to Message-Driven Beans to Entity Bean

Writing the Application Components
Writing the components of the application involves

• Coding the Application Client: HumanResourceClient.java

• Coding the Message-Driven Beans

• Coding the Entity Bean

Coding the Application Client:
HumanResourceClient.java
The application client program, src/HumanResourceClient.java, performs the
following steps:

1. Uses the JNDI naming context java:comp/env to look up a Connection-

Factory and a topic

HR
Client

NewHire
Topic

Reply
Queue

Office
MDB

SetupOffice
Entity Bean

Equipment
MDB

CallsM1

M3M3

M1

CallsM1

Message Passing

Method Invocation

../examples/jms/clientmdbentity/src/HumanResourceClient.java
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2. Creates a TemporaryQueue to receive notification of processing that
occurs, based on new-hire events it has published

3. Creates a MessageConsumer for the TemporaryQueue, sets the Message-

Consumer’s message listener, and starts the connection

4. Creates a MessageProducer and a MapMessage

5. Creates five new employees with randomly generated names, positions,
and ID numbers (in sequence) and publishes five messages containing this
information

The message listener, HRListener, waits for messages that contain the assigned
office and equipment for each employee. When a message arrives, the message
listener displays the information received and determines whether all five mes-
sages have arrived yet. When they have, the message listener notifies the main
program, which then exits.

Coding the Message-Driven Beans
This example uses two message-driven beans, src/ReserveEquipmentMsg-

Bean.java and src/ReserveOfficeMsgBean.java. The beans take the follow-
ing steps.

1. The ejbCreate method gets a handle to the local home interface of the
entity bean.

2. The onMessage method retrieves the information in the message. The
ReserveEquipmentMsgBean’s onMessage method chooses equipment,
based on the new hire’s position; the ReserveOfficeMsgBean’s
onMessage method randomly generates an office number.

3. After a slight delay to simulate real-world processing hitches, the
onMessage method calls a helper method, compose.

4. The compose method either creates or finds, by primary key, the Setup-

Office entity bean and uses it to store the equipment or the office informa-
tion in the database.

Coding the Entity Bean
The SetupOffice bean is an entity bean that uses a local interface. The local
interface allows the entity bean and the message-driven beans to be packaged in

../examples/jms/clientmdbentity/src/ReserveEquipmentMsgBean.java
../examples/jms/clientmdbentity/src/ReserveEquipmentMsgBean.java
../examples/jms/clientmdbentity/src/ReserveOfficeMsgBean.java
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the same EJB JAR file for maximum efficiency. The entity bean has these com-
ponents:

• The local home interface, SetupOfficeLocalHome.java

• The local interface, SetupOfficeLocal.java

• The bean class, SetupOfficeBean.java

The local home interface source file is src/SetupOfficeLocalHome.java. It
declares the create method, called createLocal for a bean that uses a local inter-
face, and one finder method, findByPrimaryKey.

The local interface, src/SetupOfficeLocal.java, declares several business
methods that get and manipulate new-hire data.

The bean class, src/SetupOfficeBean.java, implements the business methods
and their helper method, checkIfSetupComplete. The bean class also imple-
ments the required methods ejbCreateLocal, ejbPostCreateLocal, setEnti-
tyContext, unsetEntityContext, ejbRemove, ejbActivate, ejbPassivate,
ejbLoad, and ejbStore. The ejbFindByPrimaryKey method is generated auto-
matically.

The only methods called by the message-driven beans are the business methods
declared in the local interface, the findByPrimaryKey method, and the create-

Local method. The entity bean uses container-managed persistence, so all data-
base calls are generated automatically.

Creating and Packaging the Application
This example uses a connection factory named jms/TopicConnectionFactory

and a topic named jms/Topic, both of which you created in the previous chapter.
(See Creating JMS Administered Objects, page 1002, for instructions.) It also
uses a JDBC resource named jdbc/PointBase, which is enabled by default
when you run the Application Server.

Creating and packaging this application involve several steps:

1. Starting the PointBase server

2. Compiling the source files

3. Creating the application

4. Packaging the entity bean

5. Packaging the message-driven beans

6. Packaging the application client

../examples/jms/clientmdbentity/src/SetupOfficeLocalHome.java
../examples/jms/clientmdbentity/src/SetupOfficeLocal.java
../examples/jms/clientmdbentity/src/SetupOfficeBean.java
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7. Updating the JNDI names

You may package the application yourself as an exercise. Use the asant build

target to compile the source files.

This section will use the prepackaged EAR file to show how to create and pack-
age the application.

Examining the Application
1. In deploytool, open the ClientMDBEntityApp.ear file, which resides in

the directory <INSTALL>/j2eetutorial14/examples/jms/provided-

ears.

2. Expand the EBJAR node and select the entity bean, SetupOffice.

a. In the General tab, notice that the bean uses local interfaces.

b. Click the Entity tab. The bean uses container-managed persistence.

c. In the Entity screen, click the Sun-specific CMP Settings tab. The appli-
cation uses the preconfigured jdbc/PointBase JDBC resource.

d. Click the Resource Refs tab. The bean uses the connection factory jms/

TopicConnectionFactory to send reply messages to the application
client. The bean does not specify any message destination references,
however, because it uses a temporary destination for the reply messages.
Notice that it uses a TopicConnectionFactory object, even though it is
using the connection to send messages to a temporary queue.

3. Select either of the message-driven beans, EquipmentMDB and OfficeMDB.
They are configured identically.

a. Click the Message-Driven tab. The beans use the PhysicalTopic target
destination and the connection factory jms/TopicConnectionFactory.

b. Click the EJB Refs tab. Both beans reference the entity bean using local
references.

4. Select the HumanResourceClient node.

a. Click the Resource Refs tab. The client uses the connection factory jms/

TopicConnectionFactory both to send messages to a topic and to
receive messages from a temporary queue. The application looks up the
coded name jms/MyConnectionFactory and casts the object to an
object of type javax.jms.ConnectionFactory.

b. Click the Msg Dest Refs tab. The coded name jms/NewHireTopic

refers to the target destination PhysicalTopic.
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c. Click the Message Destinations tab, then click PhysicalTopic. The cli-
ent appears in the Producers area, and the message-driven beans appear
in the Consumers area. All of them refer to the JNDI name jms/Topic.

5. Notice that for all the components, the Transactions tab is set to Container-
Managed.

6. Select the ClientMDBEntityApp node and click the JNDI Names tab. The
JNDI name for the message-driven beans is the topic destination resource,
jms/Topic.

Verify that the JNDI names for the application components are correct. They
should appear as shown in Table 30–3 and Table 30–4.

Deploying the Application
1. Start the PointBase server. For instructions, see Starting the PointBase

Database Server (page 110).

2. Save the application.

3. Deploy the application. Select the Return Client Jar checkbox.

Table 30–3 Application Pane for ClientMDBEntityApp

Component Type Component JNDI Name

EJB EquipmentMDB jms/Topic

EJB OfficeMDB jms/Topic

EJB SetupOffice SetupOffice

Table 30–4 References Pane for ClientMDBEntityApp

Ref. Type Referenced By Reference Name JNDI Name

Resource HumanResourceClient
jms/MyConnection-
Factory

jms/TopicConnection-
Factory

Resource SetupOffice
jms/MyConnection-
Factory

jms/TopicConnection-
Factory
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You will find a file named ClientMDBEntityAppClient.jar in the provided-

ears directory.

Running the Application Client
To run the client, use the following command:

appclient -client ClientMDBEntityAppClient.jar

The program output in the terminal window looks something like this:

INFO: Binding name:‘java:comp/env/jms/NewHireTopic‘
PUBLISHER: Setting hire ID to 25, name Gertrude Bourbon,
position Senior Programmer
PUBLISHER: Setting hire ID to 26, name Jack Verdon, position
Manager
PUBLISHER: Setting hire ID to 27, name Fred Tudor, position
Manager
PUBLISHER: Setting hire ID to 28, name Fred Martin, position
Programmer
PUBLISHER: Setting hire ID to 29, name Mary Stuart, position
Manager
Waiting for 5 message(s)
New hire event processed:
  Employee ID: 25
  Name: Gertrude Bourbon
  Equipment: Laptop
  Office number: 183
Waiting for 4 message(s)
New hire event processed:
  Employee ID: 26
  Name: Jack Verdon
  Equipment: Pager
  Office number: 20
Waiting for 3 message(s)
New hire event processed:
  Employee ID: 27
  Name: Fred Tudor
  Equipment: Pager
  Office number: 51
Waiting for 2 message(s)
New hire event processed:
  Employee ID: 28
  Name: Fred Martin
  Equipment: Desktop System
  Office number: 141
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Waiting for 1 message(s)
New hire event processed:
  Employee ID: 29
  Name: Mary Stuart
  Equipment: Pager
  Office number: 238

The output from the enterprise beans appears in the server log. For each
employee, the application first creates the entity bean, then finds it. You may see
runtime errors in the server log about transactions and primary keys, and transac-
tion rollbacks may occur. The fact that the client runs correctly in spite of these
errors is one of the advantages of container-managed transactions.

An Application Example that
Consumes Messages from a Remote
J2EE Server

This section and the following section both explain how to write, compile, pack-
age, deploy, and run a pair of J2EE applications that use the JMS API and run on
two J2EE servers. A common practice is to deploy different components of an
enterprise application on different systems within a company, and these exam-
ples illustrate on a small scale how to do this for an application that uses the JMS
API.

However, the two examples work in slightly different ways. In this first example,
the deployment information for a message-driven bean specifies the remote
server from which it will consume messages. In the next example, the same bean
is deployed on two different servers, so it is the client application that specifies
the servers (one local, one remote) to which it is sending messages.

This first example divides the example in Chapter 23 into two applications, one
containing the application client and the other containing the message-driven
bean.

The section covers the following topics:

• Overview of the Applications

• Writing the Application Components

• Creating and Packaging the Applications
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• Deploying the Applications

• Running the Application Client

You will find the source files for this section in <INSTALL>/j2eetutorial14/

examples/jms/consumeremote/. Path names in this section are relative to this
directory.

Overview of the Applications
Except for the fact that it is packaged as two separate applications, this example
is very similar to the one in Chapter 23:

• One application contains the application client, which runs on the remote
server and sends three messages to a queue.

• The other application contains the message-driven bean, which consumes
the messages from the queue on the remote server.

The basic steps of the applications are as follows.

1. The administrator starts two J2EE servers, one on each system.

2. On the remote server, the administrator deploys the client application,
which sends three messages to a queue.

3. On the local server, the administrator deploys the message-driven bean
application, which specifies the URL of the remote server where the client
is deployed.

4. The message-driven bean consumes the messages.

Figure 30–3 illustrates the structure of this application. You can see that it is
almost identical to Figure 23–1 except that there are two J2EE servers. The
queue is not associated with either server; it must exist on both servers.

Figure 30–3 A J2EE Application that Consumes Messages from a Remote Server
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Writing the Application Components
Writing the components of the applications involves

• Coding the application client

• Coding the message-driven bean

The application client, earthclient/src/SimpleClient.java, is almost iden-
tical to the one in The J2EE Application Client (page 826).

Similarly, the message-driven bean, marsmdb/src/MessageBean.java, is
almost identical to the one in The Message-Driven Bean Class (page 827).

The only major difference is that the client and bean are packaged in two sepa-
rate applications.

Creating and Packaging the
Applications
For this example, the message-driven bean uses the connection factory named
jms/EarthQueueConnectionFactory, which you created in Creating Adminis-
tered Objects for Multiple Systems (page 1012). The application client can use
any connection factory that exists on the remote server; since you created jms/

EarthQueueConnectionFactory on that server, you can use that. Both compo-
nents use the queue named jms/Queue, which you created in Creating JMS
Administered Objects (page 1002).

We’ll suppose, as we did in Running JMS Client Programs on Multiple
Systems (page 1011), that the two servers are named earth and mars.

Creating and packaging this application involve several steps:

1. Compiling the source files

2. Creating the application

3. Packaging the application client

4. Packaging the message-driven bean

5. Verifying the JNDI names

You may package the applications yourself as an exercise. Use the asant build

targets in the earthclient and marsmdb directories to compile the source files.

This section will use the prepackaged EAR files to show how to create and pack-
age the applications.

../examples/jms/consumeremote/earthclient/src/SimpleClient.java
../examples/jms/consumeremote/marsmdb/src/MessageBean.java
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Which system you use to package and deploy the applications and which system
you use to run the client depends on your network configuration—which file sys-
tem you can access remotely. These instructions assume that you can access the
file system of earth from mars, but cannot access the file system of mars from
earth. (You can use the same systems for earth and mars that you used in Run-
ning JMS Client Programs on Multiple Systems, page 1011.)

The J2EE Application Server must be running on both systems.

You package and deploy the applications from mars. The only action you per-
form on earth is running the client application.

Examining the Applications
1. In deploytool, on mars, open the two EAR files EarthClientApp.ear

and MarsMDBApp.ear, which reside in the directory <INSTALL>/

j2eetutorial14/jms/provided-ears.

2. In EarthClientApp.ear, select the application client node, SimpleCli-
ent.

a. Click the Resource Refs tab. The client uses the connection factory jms/

QueueConnectionFactory to send messages to a queue. The applica-
tion looks up the coded name jms/MyConnectionFactory and casts the
object to an object of type javax.jms.ConnectionFactory.

b. Click the Msg Dest Refs tab. The coded name jms/QueueName refers to
the target destination PhysicalQueue.

c. Click the Message Destinations tab, then click PhysicalQueue. The cli-
ent appears in the Producers area. It refers to the JNDI name jms/Queue.

3. In MarsMDBApp.ear, expand the MDBJAR node and select MessageBean.

a. Click the Message-Driven tab. The bean uses the PhysicalQueue target
destination and the connection factory jms/EarthQueueConnection-

Factory.

b. Click the Transactions tab. The bean uses container-managed transac-
tions.

4. Select the MDBJAR node, click the Message Destinations tab, then click
PhysicalQueue. The message-driven bean appears in the Consumers area.
It refers to the JNDI name jms/Queue.

5. Select the MarsMDBApp node and click the JNDI Names tab. The JNDI
name for the message-driven bean is the queue destination resource, jms/
Queue.
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The JNDI name for the MarsMDBApp application should appear as shown in Table
30–5. Only the Application Pane has any content.

The JNDI name for the EarthClientApp application should appear as shown in
Table 30–6. Only the References Pane has any content.

Deploying the Applications
Before you can deploy the applications, you must add the remote server. On
mars, perform the following steps:

1. Choose File→Add Server.

2. Type the name of the remote system in the Server Name field and click OK.

3. The server appears in the tree under Servers. Select it.

4. In the dialog box that appears, type the administrative user name and pass-
word for the server in the Connection Settings area and click OK.

To deploy the EarthClientApp application and save the client JAR file, perform
the following steps:

1. Save the application.

2. Choose Tools→Deploy.

3. In the dialog box, choose the URI for the remote system (earth) from the
Server menu:

Table 30–5 Application Pane for MarsMDBApp

Component Type Component JNDI Name

EJB MessageBean jms/Queue

Table 30–6 References Pane for EarthClientApp

Ref. Type Referenced By Reference Name JNDI Name

Resource SimpleClient
jms/MyConnection-
Factory

jms/QueueConnection-
Factory
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system-name:4848

4. Type your administrative user name and password (if they are not already
filled in).

5. In the Application Client Stub Directory area, select the Return Client Jar
checkbox.

6. Choose Browse to navigate to the directory on the remote system (earth)
from which you will run the client. When you reach the directory, click
Select, then click OK.

7. Click OK.

8. In the Distribute Module dialog box, click Close when the process com-
pletes. You will find a file named EarthClientAppClient.jar in the
specified directory.

To deploy the MarsMDBApp application, perform the following steps:

1. Save the application.

2. Choose Tools→Deploy.

3. In the dialog box, choose the URI for localhost from the Server menu.

4. Type your administrative user name and password (if they are not already
filled in) and click OK.

5. In the Distribute Module dialog box, click Close when the process com-
pletes.

Running the Application Client
To run the client, perform the following steps:

1. Go to the directory on the remote system (earth) where you created the
client JAR file.

2. Use the following command:

appclient -client EarthClientAppClient.jar

On earth, the output of the appclient command looks like this:

Sending message: This is message 1
Sending message: This is message 2
Sending message: This is message 3
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On mars, the output in the server log looks like this:

In MessageBean.MessageBean()
In MessageBean.setMessageDrivenContext()
In MessageBean.ejbCreate()
MESSAGE BEAN: Message received: This is message 1
MESSAGE BEAN: Message received: This is message 2
MESSAGE BEAN: Message received: This is message 3

An Application Example that Deploys
a Message-Driven Bean on Two J2EE
Servers

This section, like the previous one, explains how to write, compile, package,
deploy, and run a pair of J2EE applications that use the JMS API and run on two
J2EE servers. The applications are slightly more complex than the ones in the
first example.

The applications use the following components:

• An application client that uses two connection factories—one ordinary one
and one that is configured to communicate with the remote server—to cre-
ate two publishers and two subscribers and to publish and to consume mes-
sages

• A message-driven bean that is deployed twice—once on the local server
and once on the remote one—to process the messages and to send replies

In this section, the term local server means the server on which both the applica-
tion client and the message-driven bean are deployed (mars in the previous
example). The term remote server means the server on which only the message-
driven bean is deployed (earth in the previous example).

The section covers the following topics:

• Overview of the Applications

• Writing the Application Components

• Creating and Packaging the Applications

• Deploying the Applications

• Running the Application Client
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You will find the source files for this section in <INSTALL>/j2eetutorial14/

examples/jms/sendremote/. Path names in this section are relative to this
directory.

Overview of the Applications
This pair of applications is somewhat similar to the applications in An Applica-
tion Example that Consumes Messages from a Remote J2EE Server (page 1069)
in that the only components are a client and a message-driven bean. However,
the applications here use these components in more complex ways. One applica-
tion consists of the application client. The other application contains only the
message-driven bean and is deployed twice, once on each server.

The basic steps of the applications are as follows.

1. You start two J2EE servers, one on each system.

2. On the local server (mars), you create a connection factory to communi-
cate with the remote server (earth). On the remote server, you create a
connection factory with the same name.

3. The application client uses two connection factories—an ordinary one and
the one that communicates with the remote server—to create two connec-
tions, sessions, publishers, and subscribers. Each publisher publishes five
messages.

4. The local and the remote message-driven beans each receive five messages
and send replies.

5. The client’s message listener consumes the replies.

Figure 30–4 illustrates the structure of this application.
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Figure 30–4 A J2EE Application that Sends Messages to Two Servers

Writing the Application Components
Writing the components of the applications involves

• Coding the Application Client: MultiAppServerClient.java

• Coding the Message-Driven Bean: ReplyMsgBean.java

Coding the Application Client:
MultiAppServerClient.java
The application client class, multiclient/src/MultiAppServerClient.java,
does the following.

1. It uses the JNDI naming context java:comp/env to look up two connec-
tion factories and a topic.

2. For each connection factory, it creates a connection, a publisher session, a
publisher, a subscriber session, a subscriber, and a temporary topic for
replies.

../examples/jms/sendremote/multiclient/src/MultiAppServerClient.java
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3. Each subscriber sets its message listener, ReplyListener, and starts the
connection.

4. Each publisher publishes five messages and creates a list of the messages
the listener should expect.

5. When each reply arrives, the message listener displays its contents and
removes it from the list of expected messages.

6. When all the messages have arrived, the client exits.

Coding the Message-Driven Bean:
ReplyMsgBean.java
The onMessage method of the message-driven bean class, replybean/src/

ReplyMsgBean.java, does the following:

1. Casts the incoming message to a TextMessage and displays the text

2. Creates a connection, session, and publisher for the reply message

3. Publishes the message to the reply topic

4. Closes the connection

On both servers, the bean will consume messages from the topic jms/Topic.

Creating and Packaging the
Applications
This example uses the connection factory named jms/TopicConnection-

Factory and the topic named jms/Topic. These objects must exist on both the
local and remote servers. If you need to, you can create the objects there using
the Admin Console, as described in Creating JMS Administered
Objects (page 1002).

This example uses an additional connection factory, jms/EarthQueueConnec-
tionFactory, that communicates with the remote system; you created it in Cre-
ating Administered Objects for Multiple Systems (page 1012). Because
connection factories are not specific to a domain unless you are using a durable
subscriber) you can use a QueueConnectionFactory object when you are send-
ing messages to a topic. This connection factory needs to exist on the local
server only.

../examples/jms/sendremote/replybean/src/ReplyMsgBean.java
../examples/jms/sendremote/replybean/src/ReplyMsgBean.java
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Creating and packaging this application involve several steps:

1. Creating the connection factories

2. Compiling the source files

3. Creating the applications

4. Packaging the application client

5. Packaging the message-driven bean

6. Updating the JNDI names

You may package the applications yourself as an exercise. Use the asant build

targets in the multiclient and replybean directories to compile the source
files.

This section will use the prepackaged EAR files to show how to create and pack-
age the applications. You can use the systems mars and earth for the local and
remote systems.

The J2EE Application Server must be running on both systems. You package,
deploy, and run the application from the local system.

Examining the Applications
1. In deploytool, on the local system, open the two EAR files MultiClien-

tApp.ear and ReplyBeanApp.ear, which reside in the directory
<INSTALL>/j2eetutorial14/jms/provided-ears.

2. In MultiClientApp.ear, select the application client node, MultiApp-
ServerClient.

a. Click the Resource Refs tab. The client looks up two connection facto-
ries and casts them to objects of type javax.jms.ConnectionFactory.
The coded name jms/ConnectionFactory1 refers to jms/Topic-

ConnectionFactory, while the coded name jms/ConnectionFactory2
refers to jms/EarthQueueConnectionFactory.

b. Click the Msg Dest Refs tab. The coded name jms/TopicName refers to
the target destination PhysicalTopic.

c. Click the Message Destinations tab, then click PhysicalTopic. The cli-
ent appears in the Producers area. It refers to the JNDI name jms/Topic.
This is the destination where messages are sent. Replies will come to a
temporary destination.
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3. In ReplyBeanApp.ear, expand the MDBJAR node and select ReplyMsgBean.

a. Click the Message-Driven tab. The bean uses the PhysicalTopic target
destination and the connection factory jms/TopicConnectionFactory.

b. Click the Resource Refs tab. The bean uses the connection factory jms/

TopicConnectionFactory to send reply messages. The bean looks up
the coded name jms/MyConnectionFactory and casts the object to an
object of type javax.jms.ConnectionFactory. The bean does not
look up a topic for the reply messages; instead, it uses the temporary
topic specified in the incoming message’s JMSReplyTo header field.

c. Click the Transactions tab. The bean uses container-managed transac-
tions.

4. Select the MDBJAR node, click the Message Destinations tab, then click
PhysicalTopic. The message-driven bean appears in the Consumers area.
It refers to the JNDI name jms/Topic.

5. Select the ReplyBeanApp node and click the JNDI Names tab. The JNDI
name for the message-driven bean is the topic destination resource, jms/
Topic.

Verify that the JNDI names for the applications are correct.

The Application Pane for ReplyBeanApp should appear as shown in Table 30–7.

The References Pane for ReplyBeanApp should appear as shown in Table 30–8.

Table 30–7 Application Pane for ReplyBeanApp

Component Type Component JNDI Name

EJB ReplyMsgBean jms/Topic

Table 30–8 References Pane for ReplyBeanApp

Ref. Type Referenced By Reference Name JNDI Name

Resource ReplyMsgBean
jms/MyConnection-
Factory

jms/TopicConnection-
Factory
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Select the MultiClientApp application and click the JNDI Names tab.

The JNDI names for the application should appear as shown in Table 30–9. Only
the References Pane has any content.

Deploying the Applications
To deploy the MultiClientApp application and the ReplyBeanApp application
on the local server, perform the following steps for each application:

1. Save the application.

2. Choose Tools→Deploy.

3. In the dialog box, choose the URI for localhost from the menu:
localhost:4848

4. Type your administrative user name and password (if they are not already
filled in).

5. For the MultiClientApp application, select the Return Client Jar check-
box in the Application Client Stub Directory area. If you wish to run the
client in a directory other than the default, click Browse and use the file
chooser to specify it.

6. Click OK.

7. In the Distribute Module dialog box, click Close when the process com-
pletes. For the MultiClientApp application, you will find a file named
MultiClientAppClient.jar in the specified directory.

Before you can deploy the ReplyBeanApp application on the remote server, you
must add the remote server. If you did not do so before, perform the following
steps:

1. Choose File→Add Server.

Table 30–9 References Pane for MultiClientApp

Ref. Type Referenced By Reference Name JNDI Name

Resource
MultiAppServer-
Client

jms/ConnectionFactory1
jms/TopicConnection-
Factory

Resource
MultiAppServer-
Client

jms/ConnectionFactory2
jms/EarthQueueConnec-
tionFactory
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2. Type the name of the server in the Server Name field and click OK.

3. The server appears in the tree under Servers. Select it.

4. In the dialog box that appears, type the administrative user name and pass-
word for the server in the Connection Settings area and click OK.

To deploy the ReplyBeanApp application on the remote server, perform the fol-
lowing steps:

1. Save the application.

2. Choose Tools→Deploy.

3. In the dialog box, choose the URI with the name of the remote system from
the menu.

4. Type your administrative user name and password (if they are not already
filled in) and click OK.

5. In the Distribute Module dialog box, click Close when the process com-
pletes.

Running the Application Client
To run the client, use the following command:

appclient -client MultiClientAppClient.jar

On the local system, the output of the appclient command looks something like
this:

Binding name:‘java:comp/env/jms/TopicName‘
Sent message: text: id=1 to local app server
Sent message: text: id=2 to remote app server
ReplyListener: Received message: id=1, text=ReplyMsgBean
processed message: text: id=1 to local app server
Sent message: text: id=3 to local app server
ReplyListener: Received message: id=3, text=ReplyMsgBean
processed message: text: id=3 to local app server
ReplyListener: Received message: id=2, text=ReplyMsgBean
processed message: text: id=2 to remote app server
Sent message: text: id=4 to remote app server
ReplyListener: Received message: id=4, text=ReplyMsgBean
processed message: text: id=4 to remote app server
Sent message: text: id=5 to local app server
ReplyListener: Received message: id=5, text=ReplyMsgBean
processed message: text: id=5 to local app server
Sent message: text: id=6 to remote app server
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ReplyListener: Received message: id=6, text=ReplyMsgBean
processed message: text: id=6 to remote app server
Sent message: text: id=7 to local app server
ReplyListener: Received message: id=7, text=ReplyMsgBean
processed message: text: id=7 to local app server
Sent message: text: id=8 to remote app server
ReplyListener: Received message: id=8, text=ReplyMsgBean
processed message: text: id=8 to remote app server
Sent message: text: id=9 to local app server
ReplyListener: Received message: id=9, text=ReplyMsgBean
processed message: text: id=9 to local app server
Sent message: text: id=10 to remote app server
ReplyListener: Received message: id=10, text=ReplyMsgBean
processed message: text: id=10 to remote app server
Waiting for 0 message(s) from local app server
Waiting for 0 message(s) from remote app server
Finished
Closing connection 1
Closing connection 2

On the local system, where the message-driven bean receives the odd-numbered
messages, the output in the server log looks like this:

In ReplyMsgBean.ReplyMsgBean()
In ReplyMsgBean.setMessageDrivenContext()
In ReplyMsgBean.ejbCreate()
ReplyMsgBean: Received message: text: id=1 to local app server
ReplyMsgBean: Received message: text: id=3 to local app server
ReplyMsgBean: Received message: text: id=5 to local app server
ReplyMsgBean: Received message: text: id=7 to local app server
ReplyMsgBean: Received message: text: id=9 to local app server

On the remote system, where the bean receives the even-numbered messages, the
output in the server log looks like this:

In ReplyMsgBean.ReplyMsgBean()
In ReplyMsgBean.setMessageDrivenContext()
In ReplyMsgBean.ejbCreate()
ReplyMsgBean: Received message: text: id=2 to remote app server
ReplyMsgBean: Received message: text: id=4 to remote app server
ReplyMsgBean: Received message: text: id=6 to remote app server
ReplyMsgBean: Received message: text: id=8 to remote app server
ReplyMsgBean: Received message: text: id=10 to remote app server
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1085
The Coffee Break
Application

This chapter describes the Coffee Break Application, a set of Web applications
that demonstrate how to use several of the Java Web services APIs together. The
Coffee Break sells coffee on the Internet. Customers communicate with the Cof-
fee Break server to order coffee online. The server consists of Java Servlets, JSP
pages, and JavaBeans components. A customer enters the quantity of each coffee
to order and clicks the “Submit” button to send the order.

The Coffee Break does not maintain any inventory. It handles customer and
order management and billing. Each order is filled by forwarding suborders to
one or more coffee distributors. This process is depicted in Figure 31–1.
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Figure 31–1 Coffee Break Application Flow

The Coffee Break server obtains the coffee varieties it sells and their prices by
querying distributors at startup and on demand.

1. The Coffee Break server uses SAAJ messaging to communicate with one
of its distributors. It has been dealing with this distributor for some time
and has previously made the necessary arrangements for doing request-
response SAAJ messaging. The two parties have agreed to exchange four
kinds of XML messages and have set up the DTDs those messages will fol-
low.

2. The Coffee Break server uses JAXR to send a query searching for coffee
distributors that support JAX-RPC to the Java WSDP Registry Server.

3. The Coffee Break server requests price lists from each of the coffee distrib-
utors. The server makes the appropriate remote procedure calls and waits
for the response, which is a JavaBeans component representing a price list.
The SAAJ distributor returns price lists as XML documents.

4. Upon receiving the responses, the Coffee Break server processes the price
lists from the JavaBeans components returned by calls to the distributors.

5. The Coffee Break Server creates a local database of distributors.

6. When an order is placed, suborders are sent to one or more distributors
using the distributor’s preferred protocol.
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Common Code
The Coffee Break server and JAX-RPC and SAAJ services share a number of
JavaBeans components. The source code for these components resides in the
<INSTALL>/j2eetutorial14/examples/cb/common/src/com/sun/cb/ direc-
tory:

• AddressBean—shipping information for customer

• ConfirmationBean—order id and ship date

• CustomerBean—customer contact information

• LineItemBean—order item

• OrderBean—order id, customer, address, list of line items, total price

• PriceItemBean—price list entry (coffee name and wholesale price)

• PriceListBean—price list.

In addition, the common directory contains the CoffeeBreak.properties file,
which contains the URLs exposed by the Registry Server and the JAX-RPC and
SAAJ distributors, the URLHelper class, which is used by the server and client
classes to retrieve the URLs, and the DateHelper utility class.

JAX-RPC Distributor Service
The Coffee Break server is a client of the JAX-RPC distributor service. The ser-
vice code consists of the service interface, service implementation class, and
several JavaBeans components that are used for method parameters and return
types.

Service Interface
The service interface, SupplierIF, defines the methods that can be called by
remote clients. The parameters and return types of these methods are the Java-
Beans components listed in the previous section.

../examples/cb/jaxrpc/src/server/com/sun/cb/SupplierIF.java
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The source code for the SupplierIF interface, which follows, resides in the
<INSTALL>/j2eetutorial14/examples/cb/jaxrpc/src/ directory.

package com.sun.cb;

import java.rmi.Remote;
import java.rmi.RemoteException;

public interface SupplierIF extends Remote {

public ConfirmationBean placeOrder(OrderBean order)
throws RemoteException;

public PriceListBean getPriceList() throws RemoteException;
}

Service Implementation
The SupplierImpl class implements the placeOrder and getPriceList meth-
ods, which are defined by the SupplierIF interface. So that you can focus on the
code related to JAX-RPC, these methods are short and simplistic. In a real-world
application, these methods would access databases and interact with other ser-
vices, such as shipping, accounting, and inventory.

The placeOrder method accepts as input a coffee order and returns a confirma-
tion for the order. To keep things simple, the placeOrder method confirms every
order and sets the ship date in the confirmation to the next day. The source code
for the placeOrder method follows:

public ConfirmationBean placeOrder(OrderBean order) {

Date tomorrow = DateHelper.addDays(new Date(), 1);
ConfirmationBean confirmation =

new ConfirmationBean(order.getId(),
DateHelper.dateToCalendar(tomorrow));

return confirmation;
}

The getPriceList method returns a PriceListBean object, which lists the
name and price of each type of coffee that can be ordered from this service. The
getPriceList method creates the PriceListBean object by invoking a private
method named loadPrices. In a production application, the loadPrices

method would fetch the prices from a database. However, our loadPrices

../examples/cb/jaxrpc/src/server/com/sun/cb/SupplierImpl.java
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method takes a shortcut by getting the prices from the SupplierPrices.prop-

erties file. Here are the getPriceList and loadPrices methods:

public PriceListBean getPriceList() {

PriceListBean priceList = loadPrices();
return priceList;

}

private PriceListBean loadPrices() {

String propsName = "com.sun.cb.SupplierPrices";
Date today = new Date();
Date endDate = DateHelper.addDays(today, 30);

PriceItemBean[] priceItems =
PriceLoader.loadItems(propsName);

PriceListBean priceList =
new PriceListBean(DateHelper.dateToCalendar(today),

DateHelper.dateToCalendar(endDate), priceItems);

return priceList;
}

Publishing the Service in the Registry
Because we want customers to find our service, we publish it in a registry. When
the JAX-RPC Web application is started and stopped, the context listener object
ContextListener publishes and removes the service in the contextInitial-

ized and contextDestroyed methods respectively.

The contextInitialized method begins by loading String values from the
URLHelper class and CoffeeRegistry.properties file. Next, the program
instantiates a utility class named JAXRPublisher. The contextInitialized

method connects to the registry by invoking the makeConnection method of
JAXRPublisher. To publish the service, the contextInitialized method

invokes the executePublish method, which accepts as input username, pass-
word, and endpoint. The username and password values are required by the
Registry Server. The endpoint value is the URL that remote clients will use to
contact our JAX-RPC service. The executePublish method of JAXRPublisher
returns a key that uniquely identifies the service in the registry. The contextIni-
tialized method saves this key in a text file named orgkey.txt. The context-
Destroyed method reads the key from orgkey.txt so that it can delete the
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service. See Deleting the Service From the Registry, page 1093. The source code
for the contextInitialized method follows.

public void contextInitialized(ServletContextEvent event) {
String queryURL = URLHelper.getQueryURL();
String publishURL = URLHelper.getPublishURL();
String endpoint = URLHelper.getEndpointURL();

ResourceBundle registryBundle = ResourceBundle.getBundle("
com.sun.cb.CoffeeRegistry");

String username =
registryBundle.getString("registry.username");

String password =
registryBundle.getString("registry.password");

String keyFile = registryBundle.getString("key.file");

JAXRPublisher publisher = new JAXRPublisher();
publisher.makeConnection(queryURL, publishURL);
String key = publisher.executePublish(username,

password, endpoint);
try {

FileWriter out = new FileWriter(keyFile);
out.write(key);
out.flush();
out.close();

} catch (IOException ex) {
System.out.println(ex.getMessage());

}
}

The JAXRPublisher class is almost identical to the sample program JAXRPub-

lish.java, which is described in Managing Registry Data (page 422).

First, the makeConnection method creates a connection to the Registry Server.
See Establishing a Connection (page 412) for more information. To do this, it
first specifies a set of connection properties using the query and publish URLs
retrieved from URLHelper. For the Registry Server, the query and publish URLs
are actually the same.

Properties props = new Properties();
props.setProperty("javax.xml.registry.queryManagerURL",

queryUrl);
props.setProperty("javax.xml.registry.lifeCycleManagerURL",

publishUrl);

../examples/cb/jaxrpc/src/registry/com/sun/cb/JAXRPublisher.java
../examples/jaxr/simple/src/JAXRPublish.java
../examples/jaxr/simple/src/JAXRPublish.java
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Next, the makeConnection method creates the connection using a connection
factory it looks up using JNDI, using the connection properties:

context = new InitialContext();
factory = (ConnectionFactory)

context.lookup("java:comp/env/eis/JAXR");
factory.setProperties(props);
connection = factory.createConnection();

The executePublish method takes three arguments: a username, a password,
and an endpoint. It begins by obtaining a RegistryService object, then a Busi-

nessQueryManager object and a BusinessLifeCycleManager object, which
enable it to perform queries and manage data:

rs = connection.getRegistryService();
blcm = rs.getBusinessLifeCycleManager();
bqm = rs.getBusinessQueryManager();

Because it needs password authentication in order to publish data, it then uses
the username and password arguments to establish its security credentials:

PasswordAuthentication passwdAuth =
new PasswordAuthentication(username,

password.toCharArray());
Set creds = new HashSet();
creds.add(passwdAuth);
connection.setCredentials(creds);

It then creates an Organization object with the name “JAXRPCCoffeeDistribu-
tor,” then a User object that will serve as the primary contact. This code is almost
identical to the code in the JAXR examples.

ResourceBundle bundle =
ResourceBundle.getBundle("com.sun.cb.CoffeeRegistry");

// Create organization name and description
Organization org =

blcm.createOrganization(bundle.getString("org.name"));
InternationalString s =

blcm.createInternationalString
(bundle.getString("org.description"));

org.setDescription(s);

// Create primary contact, set name
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User primaryContact = blcm.createUser();
PersonName pName =

blcm.createPersonName(bundle.getString("person.name"));
primaryContact.setPersonName(pName);

It adds a telephone number and email address for the user, then makes the user
the primary contact:

org.setPrimaryContact(primaryContact);

It gives JAXRPCCoffeeDistributor a classification using the North American
Industry Classification System (NAICS). In this case it uses the classification
“Other Grocery and Related Products Wholesalers”.

Classification classification = (Classification)
blcm.createClassification(cScheme,

bundle.getString("classification.name"),
bundle.getString("classification.value"));

Collection classifications = new ArrayList();
classifications.add(classification);
org.addClassifications(classifications);

Next, it adds the JAX-RPC service, called “JAXRPCCoffee Service,” and its ser-
vice binding. The access URI for the service binding contains the endpoint URL
that remote clients will use to contact our service:

http://localhost:8080/jaxrpc-coffee-supplier/jaxrpc

Collection services = new ArrayList();
Service service =

blcm.createService(bundle.getString("service.name"));
InternationalString is =

blcm.createInternationalString
(bundle.getString("service.description"));

service.setDescription(is);

// Create service bindings
Collection serviceBindings = new ArrayList();
ServiceBinding binding = blcm.createServiceBinding();
is = blcm.createInternationalString

(bundle.getString("service.binding"));
binding.setDescription(is);
binding.setValidateURI(false);
binding.setAccessURI(endpoint);
serviceBindings.add(binding);
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// Add service bindings to service
service.addServiceBindings(serviceBindings);

// Add service to services, then add services to organization
services.add(service);
org.addServices(services);

Then it saves the organization to the registry:

Collection orgs = new ArrayList();
orgs.add(org);
BulkResponse response = blcm.saveOrganizations(orgs);

The BulkResponse object returned by saveOrganizations includes the Key

object containing the unique key value for the organization. The executePub-

lish method first checks to make sure the saveOrganizations call succeeded.

If the call succeeded, the method extracts the value from the Key object and dis-
plays it:

Collection keys = response.getCollection();
Iterator keyIter = keys.iterator();
if (keyIter.hasNext()) {

javax.xml.registry.infomodel.Key orgKey =
(javax.xml.registry.infomodel.Key) keyIter.next();

id = orgKey.getId();
System.out.println("Organization key is " + id);

}

Finally, the method returns the string id so that the OrgPublisher program can
save it in a file for use by the OrgRemover program.

Deleting the Service From the Registry
The contextDestroyed method deletes the service from the Registry Server.
Like the contextInitialized method, the contextDestroyed method starts by
fetching URLs from URLHelper and other values from the CoffeeRegis-

try.properties file. One these values, keyFile, is the name of the file that
contains the key that uniquely identifies the service. The contextDestroyed

method reads the key from the file, connects to the Registry Server by invoking

../examples/cb/jaxrpc/src/registry/com/sun/cb/OrgRemover.java
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makeConnection, and then deletes the service from the registry by calling exe-

cuteRemove. Here is the source code for the contextDestroyed method:

public void contextDestroyed(ServletContextEvent event) {
String keyStr = null;

String queryURL = URLHelper.getQueryURL();
String publishURL = URLHelper.getPublishURL();

ResourceBundle registryBundle =
            ResourceBundle.getBundle(

"com.sun.cb.CoffeeRegistry");

String username =
registryBundle.getString("registry.username");
String password =

registryBundle.getString("registry.password");
String keyFile = registryBundle.getString("key.file");

try {
FileReader in = new FileReader(keyFile);
char[] buf = new char[512];
while (in.read(buf, 0, 512) >= 0) { }
in.close();
keyStr = new String(buf).trim();

} catch (IOException ex) {
System.out.println(ex.getMessage());

}

JAXRRemover remover = new JAXRRemover();
remover.makeConnection(queryURL, publishURL);
javax.xml.registry.infomodel.Key modelKey = null;
modelKey = remover.createOrgKey(keyStr);
remover.executeRemove(modelKey, username, password);

}

Instantiated by the contextDestroyed method, the JAXRRemover class contains
the makeConnection, createOrgKey, and executeRemove methods. It is almost
identical to the sample program JAXRDelete.java, which is described in
Removing Data from the Registry (page 429).

The makeConnection method is identical to the JAXRPublisher method of the
same name.

The createOrgKey method is a utility method that takes one argument, the string
value extracted from the key file. It obtains the RegistryService object and the

../examples/cb/jaxrpc/src/registry/com/sun/cb/JAXRRemover.java
../examples/jaxr/simple/src/JAXRDelete.java
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BusinessLifeCycleManager object, then creates a Key object from the string
value.

The executeRemove method takes three arguments: a username, a password, and
the Key object returned by the createOrgKey method. It uses the username and
password arguments to establish its security credentials with the Registry Server,
just as the executePublish method does.

The method then wraps the Key object in a Collection and uses the Business-

LifeCycleManager object’s deleteOrganizations method to delete the organi-
zation.

Collection keys = new ArrayList();
keys.add(key);
BulkResponse response = blcm.deleteOrganizations(keys);

The deleteOrganizations method returns the keys of the organizations it
deleted, so the executeRemove method then verifies that the correct operation
was performed and displays the key for the deleted organization.

Collection retKeys = response.getCollection();
Iterator keyIter = retKeys.iterator();
javax.xml.registry.infomodel.Key orgKey = null;
if (keyIter.hasNext()) {

orgKey = (javax.xml.registry.infomodel.Key) keyIter.next();
id = orgKey.getId();
System.out.println("Organization key was " + id);

}

SAAJ Distributor Service
In contrast to the JAX-RPC service, the SAAJ distributor service does not regis-
ter in a publicly accessible registry. It simply implements the arrangements that
the distributor and the Coffee Break have made regarding their exchange of
XML documents. These arrangements include what kinds of messages they will
send, the form of those messages, and what kind of messaging they will do. They
have agreed to do request-response messaging using the SAAJ API (the
javax.xml.soap package).

The Coffee Break server sends two kinds of messages:

• Requests for current wholesale coffee prices

• Customer orders for coffee
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The SAAJ coffee supplier responds with two kinds of messages:

• Current price lists

• Order confirmations

All of the messages they send conform to an agreed-upon XML structure, which
is specified in a DTD for each kind of message. This allows them to exchange
messages even though they use different document formats internally.

The four kinds of messages exchanged by the Coffee Break server and the SAAJ
distributor are specified by the following DTDs:

• request-prices.dtd

• price-list.dtd

• coffee-order.dtd

• confirm.dtd

These DTDs may be found at <INSTALL>/j2eetutorial14/examples/cb/

saaj/dtds/. The dtds directory also contains a sample of what the XML docu-
ments specified in the DTDs might look like. The corresponding XML files for
each of the DTDs are as follows:

• request-prices.xml

• price-list.xml

• coffee-order.xml

• confirm.xml

Because of the DTDs, both parties know ahead of time what to expect in a par-
ticular kind of message and can therefore extract its content using the SAAJ API.

Code for the client and server applications is in the directory:

<INSTALL>/j2eetutorial14/examples/cb/saaj/src/

SAAJ Client
The Coffee Break server, which is the SAAJ client in this scenario, sends
requests to its SAAJ distributor. The SAAJ client application uses the SOAPCon-

nection method call to send messages.

SOAPMessage response = con.call(request, endpoint);

Accordingly, the client code has two major tasks. The first is to create and send
the request; the second is to extract the content from the response. These tasks
are handled by the classes PriceListRequest and OrderRequest.

../examples/cb/saaj/src/com/sun/cb/PriceListRequest.java
../examples/cb/saaj/src/com/sun/cb/OrderRequest.java
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Sending the Request
This section covers the code for creating and sending the request for an updated
price list. This is done in the getPriceList method of PriceListRequest,
which follows the DTD price-list.dtd.

The getPriceList method begins by creating the connection that will be used
to send the request. Then it gets the default MessageFactory object so that it can
create the SOAPMessage object msg.

SOAPConnectionFactory scf =
SOAPConnectionFactory.newInstance();

SOAPConnection con = scf.createConnection();

MessageFactory mf = MessageFactory.newInstance();
SOAPMessage msg = mf.createMessage();

The next step is to access the message’s SOAPEnvelope object, which will be
used to create a Name object for each new element that is created. The SOAPEnve-
lope object is also used to access the SOAPBody object, to which the message’s
content will be added.

SOAPPart part = msg.getSOAPPart();
SOAPEnvelope envelope = part.getEnvelope();
SOAPBody body = envelope.getBody();

The file price-list.dtd specifies that the top-most element inside the body is
request-prices and that it contains the element request. The text node added
to request is the text of the request being sent. Every new element that is added
to the message must have a Name object to identify it, which is created by the
Envelope method createName. The following lines of code create the top-level
element in the SOAPBody object body. The first element created in a SOAPBody

object is always a SOAPBodyElement object.

Name bodyName = envelope.createName("request-prices",
"RequestPrices", "http://sonata.coffeebreak.com");

SOAPBodyElement requestPrices =
body.addBodyElement(bodyName);

In the next few lines, the code adds the element request to the element
request-prices (represented by the SOAPBodyElement requestPrices). Then
the code adds a text node containing the text of the request. Next, because there
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are no other elements in the request, the code calls the method saveChanges on
the message to save what has been done.

Name requestName = envelope.createName("request");
SOAPElement request =

requestPrices.addChildElement(requestName);
request.addTextNode("Send updated price list.");

msg.saveChanges();

With the creation of the request message completed, the code sends the message
to the SAAJ coffee supplier. The message being sent is the SOAPMessage object
msg, to which the elements created in the previous code snippets were added.
The endpoint is the URI for the SAAJ coffee supplier, http://

localhost:8080/saaj-coffee-supplier/getPriceList. The SOAPConnec-

tion object con is used to send the message, and because it is no longer needed,
it is closed.

URL endpoint = new URL(url);
SOAPMessage response = con.call(msg, endpoint);
con.close();

When the call method is executed, the J2EE server executes the servlet
PriceListServlet. This servlet creates and returns a SOAPMessage object
whose content is the SAAJ distributor’s price list. (PriceListServlet is dis-
cussed in Returning the Price List, page 1104.) The J2EE server knows to exe-
cute PriceListServlet because we map the given endpoint to that servlet.

Extracting the Price List
This section demonstrates (1) retrieving the price list that is contained in
response, the SOAPMessage object returned by the method call, and (2) return-
ing the price list as a PriceListBean.

The code creates an empty Vector object that will hold the coffee-name and
price elements that are extracted from response. Then the code uses response
to access its SOAPBody object, which holds the message’s content. Notice that the
SOAPEnvelope object is not accessed separately because it is not needed for cre-
ating Name objects, as it was in the previous section.

Vector list = new Vector();

SOAPBody responseBody =
response.getSOAPPart().getEnvelope().getBody();
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The next step is to retrieve the SOAPBodyElement object. The method getCh-

ildElements returns an Iterator object that contains all of the child elements
of the element on which it is called, so in the following lines of code, it1 con-
tains the SOAPBodyElement object bodyEl, which represents the price-list

element.

Iterator it1 = responseBody.getChildElements();
while (it1.hasNext()) {

SOAPBodyElement bodyEl = (SOAPBodyElement)it1.next();

The Iterator object it2 holds the child elements of bodyEl, which represent
coffee elements. Calling the method next on it2 retrieves the first coffee ele-
ment in bodyEl. As long as it2 has another element, the method next will
return the next coffee element.

Iterator it2 = bodyEl.getChildElements();
while (it2.hasNext()) {

SOAPElement child2 = (SOAPElement)it2.next();

The next lines of code drill down another level to retrieve the coffee-name and
price elements contained in it3. Then the message getValue retrieves the text
(a coffee name or a price) that the SAAJ coffee distributor added to the coffee-

name and price elements when it gave content to response. The final line in the
following code fragment adds the coffee name or price to the Vector object
list. Note that because of the nested while loops, for each coffee element that
the code retrieves, both of its child elements (the coffee-name and price ele-
ments) are retrieved.

Iterator it3 = child2.getChildElements();
while (it3.hasNext()) {

SOAPElement child3 = (SOAPElement)it3.next();
String value = child3.getValue();
list.addElement(value);

}
}

}
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The last code fragment adds the coffee names and their prices (as a PriceLis-

tItem) to the ArrayList priceItems, and prints each pair on a separate line.
Finally it constructs and returns a PriceListBean.

ArrayList priceItems = new ArrayList();
for (int i = 0; i < list.size(); i = i + 2) {

priceItems.add(
new PriceItemBean(list.elementAt(i).toString(),
new BigDecimal(list.elementAt(i + 1).toString())));

System.out.print(list.elementAt(i) + "        ");
System.out.println(list.elementAt(i + 1));

}

Date today = new Date();
Date endDate = DateHelper.addDays(today, 30);
Calendar todayCal = new GregorianCalendar();
todayCal.setTime(today);
Calendar cal = new GregorianCalendar();
cal.setTime(endDate);
plb = new PriceListBean();
plb.setStartDate(todayCal);
plb.setPriceItems(priceItems);
plb.setEndDate(cal);

Ordering Coffee
The other kind of message that the Coffee Break server can send to the SAAJ
distributor is an order for coffee. This is done in the placeOrder method of
OrderRequest, which follows the DTD coffee-order.dtd.

Creating the Order
As with the client code for requesting a price list, the placeOrder method starts
out by creating a SOAPConnection object, creating a SOAPMessage object, and
accessing the message’s SOAPEnvelope and SOAPBody objects.

SOAPConnectionFactory scf =
SOAPConnectionFactory.newInstance();

SOAPConnection con = scf.createConnection();

MessageFactory mf = MessageFactory.newInstance();
SOAPMessage msg = mf.createMessage();
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SOAPPart part = msg.getSOAPPart();
SOAPEnvelope envelope = part.getEnvelope();
SOAPBody body = envelope.getBody();

Next the code creates and adds XML elements to form the order. As is required,
the first element is a SOAPBodyElement, which in this case is coffee-order.

Name bodyName = envelope.createName("coffee-order", "PO",
"http://sonata.coffeebreak.com");

SOAPBodyElement order = body.addBodyElement(bodyName);

The application then adds the next level of elements, the first of these being
orderID. The value given to orderID is extracted from the OrderBean object
passed to the OrderRequest.placeOrder method.

Name orderIDName = envelope.createName("orderID");
SOAPElement orderID = order.addChildElement(orderIDName);
orderID.addTextNode(orderBean.getId());

The next element, customer, has several child elements that give information
about the customer. This information is also extracted from the Customer com-
ponent of OrderBean.

Name childName = envelope.createName("customer");
SOAPElement customer = order.addChildElement(childName);

childName = envelope.createName("last-name");
SOAPElement lastName = customer.addChildElement(childName);
lastName.addTextNode(orderBean.getCustomer().getLastName());

childName = envelope.createName("first-name");
SOAPElement firstName = customer.addChildElement(childName);
firstName.addTextNode(orderBean.getCustomer().getFirstName());

childName = envelope.createName("phone-number");
SOAPElement phoneNumber = customer.addChildElement(childName);
phoneNumber.addTextNode(

orderBean.getCustomer().getPhoneNumber());

childName = envelope.createName("email-address");
SOAPElement emailAddress =

customer.addChildElement(childName);
emailAddress.addTextNode(

orderBean.getCustomer().getEmailAddress());
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The address element, added next, has child elements for the street, city, state,
and zip code. This information is extracted from the Address component of
OrderBean.

childName = envelope.createName("address");
SOAPElement address = order.addChildElement(childName);

childName = envelope.createName("street");
SOAPElement street = address.addChildElement(childName);
street.addTextNode(orderBean.getAddress().getStreet());

childName = envelope.createName("city");
SOAPElement city = address.addChildElement(childName);
city.addTextNode(orderBean.getAddress().getCity());

childName = envelope.createName("state");
SOAPElement state = address.addChildElement(childName);
state.addTextNode(orderBean.getAddress().getState());

childName = envelope.createName("zip");
SOAPElement zip = address.addChildElement(childName);
zip.addTextNode(orderBean.getAddress().getZip());

The element line-item has three child elements: coffeeName, pounds, and
price. This information is extracted from the LineItems list contained in
OrderBean.

for (Iterator it = orderBean.getLineItems().iterator();
it.hasNext(); ) {

LineItemBean lib = (LineItemBean)it.next();

childName = envelope.createName("line-item");
SOAPElement lineItem = order.addChildElement(childName);

childName = envelope.createName("coffeeName");
SOAPElement coffeeName =

lineItem.addChildElement(childName);
coffeeName.addTextNode(lib.getCoffeeName());

childName = envelope.createName("pounds");
SOAPElement pounds = lineItem.addChildElement(childName);
pounds.addTextNode(lib.getPounds().toString());

childName = envelope.createName("price");
SOAPElement price = lineItem.addChildElement(childName);
price.addTextNode(lib.getPrice().toString());

}
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// total
childName = envelope.createName("total");
SOAPElement total = order.addChildElement(childName);
total.addTextNode(orderBean.getTotal().toString());

With the order complete, the application sends the message to the endpoint
http://localhost:8080/saaj-coffee-supplier/orderCoffee and closes
the connection.

URL endpoint = new URL(url);
SOAPMessage reply = con.call(msg, endpoint);
con.close();

Because we map the given endpoint to ConfirmationServlet, the J2EE server
executes that servlet (discussed in Returning the Order
Confirmation, page 1109) to create and return the SOAPMessage object reply.

Retrieving the Order Confirmation
The rest of the placeOrder method retrieves the information returned in reply.
The client knows what elements are in it because they are specified in con-

firm.dtd. After accessing the SOAPBody object, the code retrieves the
confirmation element and gets the text of the orderID and ship-date ele-
ments. Finally, it constructs and returns a ConfirmationBean with this informa-
tion.

SOAPBody sBody = reply.getSOAPPart().getEnvelope().getBody();
Iterator bodyIt = sBody.getChildElements();
SOAPBodyElement sbEl = (SOAPBodyElement)bodyIt.next();
Iterator bodyIt2 = sbEl.getChildElements();

SOAPElement ID = (SOAPElement)bodyIt2.next();
String id = ID.getValue();

SOAPElement sDate = (SOAPElement)bodyIt2.next();
String shippingDate = sDate.getValue();

SimpleDateFormat df =
new SimpleDateFormat("EEE MMM dd HH:mm:ss z yyyy");

Date date = df.parse(shippingDate);
Calendar cal = new GregorianCalendar();
cal.setTime(date);
cb = new ConfirmationBean(id, cal);
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SAAJ Service
The SAAJ coffee distributor, the SAAJ server in this scenario, provides the
response part of the request-response paradigm. When SAAJ messaging is being
used, the server code is a servlet. The core part of each servlet is made up of
three javax.servlet.HttpServlet methods: init, doPost, and onMessage.
The init and doPost methods set up the response message, and the onMessage

method gives the message its content.

Returning the Price List
This section takes you through the servlet PriceListServlet. This servlet cre-
ates the message with the current price list that is returned to the method call,
invoked in PriceListRequest.

Any servlet extends a javax.servlet class. Being part of a Web application,
this servlet extends HttpServlet. It first creates a static MessageFactory object
that will be used later to create the SOAPMessage object that is returned.

public class PriceListServlet extends HttpServlet {
static MessageFactory fac = null;

static {
try {

fac = MessageFactory.newInstance();
} catch (Exception ex) {

ex.printStackTrace();
}

};

Every servlet has an init method. This init method initializes the servlet with
the configuration information that the J2EE server passed to it.

public void init(ServletConfig servletConfig)
throws ServletException {

super.init(servletConfig);
}

The next method defined in PriceListServlet is doPost, which does the real
work of the servlet by calling the onMessage method. (The onMessage method is
discussed later in this section.) The J2EE server passes the doPost method two
arguments. The first argument, the HttpServletRequest object req, holds the
content of the message sent in PriceListRequest. The doPost method gets the

../examples/cb/saaj/src/com/sun/cb/PriceListServlet.java
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content from req and puts it in the SOAPMessage object msg so that it can pass it
to the onMessage method. The second argument, the HttpServletResponse

object resp, will hold the message generated by executing the method onMes-

sage.

In the following code fragment, doPost calls the methods getHeaders and put-

Headers, defined immediately after doPost, to read and write the headers in req.
It then gets the content of req as a stream and passes the headers and the input
stream to the method MessageFactory.createMessage. The result is that the
SOAPMessage object msg contains the request for a price list. Note that in this
case, msg does not have any headers because the message sent in PriceListRe-

quest did not have any headers.

public void doPost(HttpServletRequest req,
HttpServletResponse resp)
throws ServletException, IOException {

try {
// Get all the headers from the HTTP request
MimeHeaders headers = getHeaders(req);

// Get the body of the HTTP request
InputStream is = req.getInputStream();

// Now internalize the contents of the HTTP request
// and create a SOAPMessage
SOAPMessage msg = fac.createMessage(headers, is);

Next, the code declares the SOAPMessage object reply and populates it by call-
ing the method onMessage.

SOAPMessage reply = null;
reply = onMessage(msg);

If reply has anything in it, its contents are saved, the status of resp is set to OK,
and the headers and content of reply are written to resp. If reply is empty, the
status of resp is set to indicate that there is no content.

if (reply != null) {

/*
 * Need to call saveChanges because we’re
 * going to use the MimeHeaders to set HTTP
 * response information. These MimeHeaders
 * are generated as part of the save.
 */
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if (reply.saveRequired()) {
reply.saveChanges();

}

resp.setStatus(HttpServletResponse.SC_OK);
putHeaders(reply.getMimeHeaders(), resp);

// Write out the message on the response stream
OutputStream os = resp.getOutputStream();
reply.writeTo(os);
os.flush();

} else {
resp.setStatus(

HttpServletResponse.SC_NO_CONTENT);
}

} catch (Exception ex) {
throw new ServletException( "SAAJ POST failed: " +

ex.getMessage());
}

}

The methods getHeaders and putHeaders are not standard methods in a servlet
the way init, doPost, and onMessage are. The method doPost calls getHead-

ers and passes it the HttpServletRequest object req that the J2EE server
passed to it. It returns a MimeHeaders object populated with the headers from
req.

static MimeHeaders getHeaders(HttpServletRequest req) {

Enumeration enum = req.getHeaderNames();
MimeHeaders headers = new MimeHeaders();

while (enum.hasMoreElements()) {
String headerName = (String)enum.nextElement();
String headerValue = req.getHeader(headerName);

StringTokenizer values =
new StringTokenizer(headerValue, ",");

while (values.hasMoreTokens()) {
headers.addHeader(headerName,

values.nextToken().trim());
}

}
return headers;

}
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The doPost method calls putHeaders and passes it the MimeHeaders object
headers, which was returned by the method getHeaders. The method putHead-

ers writes the headers in headers to res, the second argument passed to it. The
result is that res, the response that the J2EE server will return to the method
call, now contains the headers that were in the original request.

static void putHeaders(MimeHeaders headers,
HttpServletResponse res) {

Iterator it = headers.getAllHeaders();
while (it.hasNext()) {

MimeHeader header = (MimeHeader)it.next();

String[] values = headers.getHeader(header.getName());
if (values.length == 1)

res.setHeader(header.getName(), header.getValue());
else {

StringBuffer concat = new StringBuffer();
int i = 0;
while (i < values.length) {

if (i != 0) {
concat.append(',');

}
concat.append(values[i++]);

}
res.setHeader(header.getName(), concat.toString());

}
}

}

The method onMessage is the application code for responding to the message
sent by PriceListRequest and internalized into msg. It uses the static Message-

Factory object fac to create the SOAPMessage object message and then popu-
lates it with the distributor’s current coffee prices.

The method doPost invokes onMessage and passes it msg. In this case, onMes-
sage does not need to use msg because it simply creates a message containing
the distributor’s price list. The onMessage method in ConfirmationServlet

(Returning the Order Confirmation, page 1109), on the other hand, uses the
message passed to it to get the order ID.

public SOAPMessage onMessage(SOAPMessage msg) {
SOAPMessage message = null;

try {
message = fac.createMessage();
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SOAPPart part = message.getSOAPPart();
SOAPEnvelope envelope = part.getEnvelope();
SOAPBody body = envelope.getBody();

Name bodyName = envelope.createName("price-list",
"PriceList", "http://sonata.coffeebreak.com");

SOAPBodyElement list = body.addBodyElement(bodyName);

Name coffeeN = envelope.createName("coffee");
SOAPElement coffee = list.addChildElement(coffeeN);

Name coffeeNm1 = envelope.createName("coffee-name");
SOAPElement coffeeName =

coffee.addChildElement(coffeeNm1);
coffeeName.addTextNode("Arabica");

Name priceName1 = envelope.createName("price");
SOAPElement price1 = coffee.addChildElement(priceName1);
price1.addTextNode("4.50");

Name coffeeNm2 = envelope.createName("coffee-name");
SOAPElement coffeeName2 =

coffee.addChildElement(coffeeNm2);
coffeeName2.addTextNode("Espresso");

Name priceName2 = envelope.createName("price");
SOAPElement price2 = coffee.addChildElement(priceName2);
price2.addTextNode("5.00");

Name coffeeNm3 = envelope.createName("coffee-name");
SOAPElement coffeeName3 =

coffee.addChildElement(coffeeNm3);
coffeeName3.addTextNode("Dorada");

Name priceName3 = envelope.createName("price");
SOAPElement price3 = coffee.addChildElement(priceName3);
price3.addTextNode("6.00");

Name coffeeNm4 = envelope.createName("coffee-name");
SOAPElement coffeeName4 =

coffee.addChildElement(coffeeNm4);
coffeeName4.addTextNode("House Blend");

Name priceName4 = envelope.createName("price");
SOAPElement price4 = coffee.addChildElement(priceName4);
price4.addTextNode("5.00");
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message.saveChanges();

} catch(Exception e) {
e.printStackTrace();

}
return message;

}

Returning the Order Confirmation
ConfirmationServlet creates the confirmation message that is returned to the
call method that is invoked in OrderRequest. It is very similar to the code in
PriceListServlet except that instead of building a price list, its onMessage

method builds a confirmation with the order number and shipping date.

The onMessage method for this servlet uses the SOAPMessage object passed to it
by the doPost method to get the order number sent in OrderRequest. Then it
builds a confirmation message with the order ID and shipping date. The shipping
date is calculated as today’s date plus two days.

public SOAPMessage onMessage(SOAPMessage message) {

SOAPMessage confirmation = null;

try {

// Retrieve orderID from message received
SOAPBody sentSB =

message.getSOAPPart().getEnvelope().getBody();
Iterator sentIt = sentSB.getChildElements();
SOAPBodyElement sentSBE = (SOAPBodyElement)sentIt.next();
Iterator sentIt2 = sentSBE.getChildElements();
SOAPElement sentSE = (SOAPElement)sentIt2.next();

// Get the orderID test to put in confirmation
String sentID = sentSE.getValue();

// Create the confirmation message
confirmation = fac.createMessage();
SOAPPart sp = confirmation.getSOAPPart();
SOAPEnvelope env = sp.getEnvelope();
SOAPBody sb = env.getBody();

Name newBodyName = env.createName("confirmation",
"Confirm", "http://sonata.coffeebreak.com");

SOAPBodyElement confirm = sb.addBodyElement(newBodyName);

../examples/cb/saaj/src/com/sun/cb/ConfirmationServlet.java
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// Create the orderID element for confirmation
Name newOrderIDName = env.createName("orderId");
SOAPElement newOrderNo =

confirm.addChildElement(newOrderIDName);
newOrderNo.addTextNode(sentID);

// Create ship-date element
Name shipDateName = env.createName("ship-date");
SOAPElement shipDate =

confirm.addChildElement(shipDateName);

// Create the shipping date
Date today = new Date();
long msPerDay = 1000 * 60 * 60 * 24;
long msTarget = today.getTime();
long msSum = msTarget + (msPerDay * 2);
Date result = new Date();
result.setTime(msSum);
String sd = result.toString();
shipDate.addTextNode(sd);

confirmation.saveChanges();

} catch (Exception ex) {
ex.printStackTrace();

}
return confirmation;

}

Coffee Break Server
The Coffee Break Server uses servlets, JSP pages, and JavaBeans components to
dynamically construct HTML pages for consumption by a Web browser client.
The JSP pages use the template tag library discussed in A Template Tag
Library (page 636) to achieve a common look and feel among the HTML pages,
and many of the JSTL custom tags discussed in Chapter .

The Coffee Break Server implementation is organized along the Model-View-
Controller design pattern. The Dispatcher servlet is the controller. It examines
the request URL, creates and initializes model JavaBeans components, and dis-
patches requests to view JSP pages. The JavaBeans components contain the
business logic for the application—they call the Web services and perform com-
putations on the data returned from the services. The JSP pages format the data
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stored in the JavaBeans components. The mapping between JavaBeans compo-
nents and pages is summarized in Table 31–1.

JSP Pages

orderForm
orderForm displays the current contents of the shopping cart. The first time the
page is requested, the quantities of all the coffees are 0. Each time the customer
changes the coffee amounts and clicks the Update button, the request is posted
back to orderForm. The Dispatcher servlet updates the values in the shopping
cart, which are then redisplayed by orderForm. When the order is complete, the
customer proceeds to the checkoutForm page by clicking the Checkout link.

checkoutForm
checkoutForm is used to collect delivery and billing information for the cus-
tomer. When the Submit button is clicked, the request is posted to the check-

outAck page. However, the request is first handled by the Dispatcher, which
invokes the validate method of checkoutFormBean. If the validation does not
succeed, the requested page is reset to checkoutForm, with error notifications in
each invalid field. If the validation succeeds, checkoutFormBean submits subor-
ders to each distributor and stores the result in the request-scoped OrderConfir-

mations JavaBeans component and control is passed to checkoutAck.

Table 31–1 Model and View Components

Function JSP Page JavaBeans Component

Update order data orderForm ShoppingCart

Update delivery and billing data checkoutForm CheckoutFormBean

Display order confirmation checkoutAck OrderConfirmations

../examples/cb/server/web/orderForm.txt
../examples/cb/server/web/checkoutForm.txt
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checkoutAck
checkoutAck simply displays the contents of the OrderConfirmations Java-
Beans component, which is a list of the suborders comprising an order and the
ship dates of each suborder.

JavaBeans Components

RetailPriceList
RetailPriceList is a list of retail price items. A retail price item contains a cof-
fee name, a wholesale price per pound, a retail price per pound, and a distributor.
This data is used for two purposes: it contains the price list presented to the end
user and is used by CheckoutFormBean when it constructs the suborders dis-
patched to coffee distributors.

It first performs a JAXR lookup to determine the JAX-RPC service endpoints. It
then queries each JAX-RPC service for a coffee price list. Finally it queries the
SAAJ service for a price list. The two price lists are combined and a retail price
per pound is determined by adding a markup of 35% to the wholesale prices.

Discovering the JAX-RPC Service
Instantiated by RetailPriceList, JAXRQueryByName connects to the registry
server and searches for coffee distributors registered with the name JAXRPCCof-

feeDistributor in the executeQuery method. The method returns a collection
of organizations which contain services. Each service is accessible via a service
binding or URI. RetailPriceList makes a JAX-RPC call to each URI.

ShoppingCart
ShoppingCart is a list of shopping cart items. A ShoppingCartItem contains a
retail price item, the number of pounds of that item, and the total price for that
item.

../examples/cb/server/web/checkoutAck.txt
../examples/cb/server/src/com/sun/cb/RetailPriceList.java
../examples/cb/server/src/com/sun/cb/JAXRQueryByName.java
../examples/cb/server/src/com/sun/cb/ShoppingCart.java
../examples/cb/server/src/com/sun/cb/ShoppingCartItem.java
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OrderConfirmations
OrderConfirmations is a list of order confirmation objects. An OrderConfir-

mation contains order and confirmation objects, already discussed in Service
Interface (page 1087).

CheckoutFormBean
CheckoutFormBean checks the completeness of information entered into check-

outForm. If the information is incomplete, the bean populates error messages,
and Dispatcher redisplays checkoutForm with the error messages. If the infor-
mation is complete, order requests are constructed from the shopping cart and
the information supplied to checkoutForm and are sent to each distributor. As
each confirmation is received, an order confirmation is created and added to
OrderConfirmations.

if (allOk) {
String orderId = CCNumber;

AddressBean address =
new AddressBean(street, city, state, zip);

CustomerBean customer =
new CustomerBean(firstName, lastName,

"(" + areaCode + ") " + phoneNumber, email);

for (Iterator d = rpl.getDistributors().iterator();
d.hasNext(); ) {

String distributor = (String)d.next();
System.out.println(distributor);
ArrayList lis = new ArrayList();
BigDecimal price = new BigDecimal("0.00");
BigDecimal total = new BigDecimal("0.00");
for (Iterator c = cart.getItems().iterator();

c.hasNext(); ) {
ShoppingCartItem sci = (ShoppingCartItem) c.next();
if ((sci.getItem().getDistributor()).

equals(distributor) &&
sci.getPounds().floatValue() > 0) {

price = sci.getItem().getWholesalePricePerPound().
multiply(sci.getPounds());

total = total.add(price);
LineItemBean li = new LineItemBean(

sci.getItem().getCoffeeName(), sci.getPounds(),
sci.getItem().getWholesalePricePerPound());

lis.add(li);

../examples/cb/server/src/com/sun/cb/OrderConfirmations.java
../examples/cb/server/src/com/sun/cb/OrderConfirmation.java
../examples/cb/server/src/com/sun/cb/OrderConfirmation.java
../examples/cb/server/src/com/sun/cb/CheckoutFormBean.java
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}
}

if (!lis.isEmpty()) {
OrderBean order = new OrderBean(address, customer,

orderId, lis, total);

String SAAJOrderURL =
URLHelper.getSaajURL() + "/orderCoffee";

if (distributor.equals(SAAJOrderURL)) {
OrderRequest or = new OrderRequest(SAAJOrderURL);
confirmation = or.placeOrder(order);

} else {
OrderCaller ocaller = new OrderCaller(distributor);
confirmation = ocaller.placeOrder(order);

}
OrderConfirmation oc =

new OrderConfirmation(order, confirmation);
ocs.add(oc);

}
}

}

RetailPriceListServlet
The RetailPriceListServlet responds to requests to reload the price list via
the URL /loadPriceList. It simply creates a new RetailPriceList and a new
ShoppingCart.

Since this servlet would be used by administrators of the Coffee Break Server, it
is a protected Web resource. In order to load the price list, a user must authenti-
cate (using basic authentication) and the authenticated user must be in the admin

role.

Building, Packaging, Deploying, and
Running the Application

The source code for the Coffee Break application is located in the directory
<INSTALL>/j2eetutorial14/examples/cb/. Within the cb directory are subdi-
rectories for each Web application—saaj, jaxrpc, server—and a directory,
common, for classes shared by the Web applications. Each subdirectory contains a
build.xml and build.properties file. The Web application subdirectories in

../examples/cb/server/src/com/sun/cb/RetailPriceListServlet.java
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turn contain a src subdirectory for Java classes and a web subdirectory for Web
resources.

Setting Up the Registry Server
The Coffee Break server relies on a registry server to obtain information about
the JAX-RPC endpoint. Since the J2EE 1.4 Application Server does not include
a registry server, you must obtain one before you can run the application.

We recommend that you use the registry server provided with the Java Web Ser-
vices Developer Pack (Java WSDP) 1.3, which you can download from http://

java.sun.com/webservices/download.html.

The Registry Server application is automatically loaded when you start the Java
WSDP Tomcat server. You may need to modify the port that Tomcat runs on
because the default port for both the J2EE 1.4 Application Server and Tomcat is
8080. To change the port for Tomcat and the Registry Server database to 8082:

1. Edit the port attribute of the Connector element of the Java Web Services
Developer Pack Service in the file <JWSDP_HOME>/conf/server.xml as
follows:
<Service name="Java Web Services Developer Pack">

<Connector className="org.apache.coyote.tomcat5.Coyote-
Connector" port="8082" minProcessors="5" maxProcessors="100"
...

2. Remove the comment around and set the Xindice host and port system
properties in the file <JWSDP_HOME>/jwsdp-shared/bin/launcher.xml

as follows:
<sysproperty key="org.apache.xindice.host" value="localhost"/>
<sysproperty key="org.apache.xindice.port" value="8082"/>

Then, start the Registry Server:

• On the Unix platform, type the following at a terminal window:
<JWSDP_HOME>/bin/startup.sh

• On the Microsoft Windows platform, start Tomcat from the Start menu
by selecting: Start→Programs→Java Web Services Developer Pack
1.3→ Start Tomcat.

http://java.sun.com/webservices/download.html
http://java.sun.com/webservices/download.html
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Finally, set the port of the Registry Server in the Coffee Break properties file
<INSTALL>/j2eetutorial14/examples/cb/common/src/com/sun/cb/Cof-

feeBreak.properties:

query.url=http://localhost:8082/RegistryServer/
publish.url=http://localhost:8082/RegistryServer/

The instructions that follow for packaging and deploying the Coffee Break Web
applications assume that you are familiar with the deploytool procedures for
packaging Web services and presentation-oriented Web applications described in
previous chapters of the tutorial. If after following these procedures you have
trouble deploying or running the application, you can use the WARs provided in
<INSTALL>/j2eetutorial14/examples/cb/provided-wars/ to run the exam-
ple. The provided WARs require that you run the J2EE 1.4 Application Server on
port 8080 and the Registry Server (Tomcat) on port 8082.

Building the Common Classes
The Coffee Break applications share a number of common utility classes. To
build the common classes:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/cb/

common/.

2. Run asant build.

Building, Packaging, and Deploying the
JAX-RPC Service
To build the JAX-RPC service and client library and package and deploy the
JAX-RPC service:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/cb/

jaxrpc/.

2. Run asant build-registry and asant build-service. These tasks cre-
ate the JAR file containing the JAXR routines and run wscompile and com-
pile the source files of the JAX-RPC service.

If you get an error, make sure you edited the file <INSTALL>/

j2eetutorial14/examples/common/build.properties as described in
Building the Examples (page xxx).
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3. Start the J2EE application server.

4. Start deploytool.

5. Create a standalone Web module named jaxrpc-coffee-supplier in

<INSTALL>/j2eetutorial14/examples/cb/jaxrpc/.

6. Set the context root to /jaxrpc-coffee-supplier.

7. Add the content to the service.

a. Add the com package, Supplier.wsdl, and mapping.xml under
<INSTALL>/j2eetutorial14/examples/cb/jaxrpc/build/server/

to the module.

b. Navigate to <INSTALL>/j2eetutorial14/examples/cb/jaxrpc/

build/registry/dist/ and add registry-org.jar.

c. In the Web module contents editor, drag the com directory (containing
sun/cb/SupplierPrices.properties) from the context root to WEB-

INF/classes/.

8. Specify Web Services Endpoint as the component type.

9. Choose Service dialog box (Define New Service).

a. In the WSDL File combo box, select WEB-INF/wsdl/Supplier.wsdl.

b. In the Mapping File combo box, select mapping.xml.

10.Component General Properties dialog box

a. In the Service Endpoint Implementation combo box, select
com.sun.cb.SupplierImpl.

b. Click Next.

11.Web Service Endpoint dialog box

a. In the Service Endpoint Interface combo box, select com.sun.cb.Sup-
plierIF.

b. In the Namespace combo box, select urn:Foo.

c. In the Local Part combo box, select SupplierIFPort.

d. Click Next.

12.Add the alias /jaxrpc to the SupplierImpl Web component.

13.Select the Endpoint tab, then select jaxrpc for the Endpoint Address in
the Sun-specific Settings frame.

14.Add an Event Listener that references the listener class com.sun.cb.Con-
textListener.
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15.Add a resource reference of type javax.xml.registry.ConnectionFac-
tory named eis/JAXR mapped to the JAXR connection factory eis/JAXR.
If you have not already created the connection factory, follow the instruc-
tions in Creating JAXR Resources (page 447).

16.Save the module.

17.Deploy the module.

18.Run asant build-client. This task creates the JAR file that contains the
classes needed by JAX-RPC clients. The build-client task runs wscom-
pile to generate the stubs and JavaBeans components.

19.Test that the JAX-RPC service has been deployed correctly by running the
test programs asant run-test-order and asant run-test-price

Here is what you should see when you run asant run-test-price:

run-test-price:
run-test-client:

[java] 07/21/03 08/20/03
[java] Kona 6.50
[java] French Roast 5.00
[java] Wake Up Call 5.50
[java] Mocca 4.00

Building, Packaging, and Deploying the
SAAJ Service
To build the SAAJ service and client library and package and deploy the SAAJ
service:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/cb/

saaj/.

2. Run asant build. This task creates the client library and compiles the
server classes.

3. Make sure the J2EE application server is started.

4. Start deploytool.

5. Create a standalone Web module called saaj-coffee-supplier in

<INSTALL>/j2eetutorial14/examples/cb/saaj/.

6. Set the context root to /saaj-coffee-supplier.

7. Add the com directory under <INSTALL>/j2eetutorial14/examples/

cb/saaj/build/server/ to the module.
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8. Add the ConfirmationServlet Web component. Choose the Servlet com-
ponent type.

9. Add the alias /orderCoffee to the ConfirmationServlet Web compo-
nent.

10.Add the PriceListServlet Web component to the existing saaj-cof-

fee-supplier WAR.

11.Add the alias /getPriceList to the PriceListServlet Web component.

12.Save the module.

13.Deploy the module.

14.Test that the SAAJ service has been deployed correctly by running one or
both of the test programs asant run-test-price and asant run-test-

order.

Building, Packaging, and Deploying the
Coffee Break Server
To build, package, and deploy the Coffee Break server:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/cb/

server/.

2. Run asant build. This task compiles the server classes and copies the
classes, JSP pages, and tag libraries into the correct location for packaging.

3. Make sure the J2EE server is started.

4. Start deploytool.

5. Create a standalone Web module called cbserver in <INSTALL>/

j2eetutorial14/examples/cb/server/.

6. Set the context root to /cbserver.

7. Add the content to the Web module.

a. Add all the JSP pages, tutorial-template.tld, and the template and
com directories under <INSTALL>/j2eetutorial14/examples/cb/

server/build/ to the module.

b. In the Web module contents editor, drag the com directory (containing
sun/cb/CoffeeBreak.properties) from the context root to WEB-INF/

classes.

c. Add the JAX-RPC client library in <INSTALL>/j2eetutorial14/

examples/cb/jaxrpc/dist/jaxrpc-client.jar to the module.
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d. Add the SAAJ client library in <INSTALL>/j2eetutorial14/

examples/cb/saaj/dist/saaj-client.jar to the module.

8. Create a Dispatcher Web component. Choose the Servlet component
type.

9. Add the aliases /orderForm., /checkoutForm and /checkoutAck to the
Dispatcher component.

10.Add the RetailPriceListServlet Web component to the existing
cbserver WAR.

11.Add the alias /loadPriceList to the RetailPriceListServlet compo-
nent.

12.Add a resource reference of type javax.xml.registry.ConnectionFac-
tory named eis/JAXRmapped to the JAXR connection factory eis/JAXR.

13.Add a JSP property group named cbserver. The property group applies
to the URL pattern *.jsp. Add the include prelude /template/pre-

lude.jspf.

14.Add a context parameter named javax.servlet.jsp.jstl.fmt.local-

izationContext and value com.sun.cb.messages.CBMessages.

15.Specify a security constraint for RetailPriceListServlet.

a. Select Basic as the User Authentication Method.

b. Add a security constraint and a web resource collection. Use the default
names provided by deploytool.

c. Add com.sun.cb.RetailPriceListServlet to the web resource col-
lection.

d. Select the GET HTTP method.

e. Add the security role admin.

16.Map the admin role to the admin user.

17.Save the module.

18.Deploy the module.

Running the Coffee Break Client
After you have installed all the Web applications, check that all the applications
are running in deploytool or the Admin Console. You should see cbserver,
jaxrpc-coffee-supplier, and saaj-coffee-supplier in the list of applica-
tions.
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Then, to run the Coffee Break client, open the Coffee Break server URL in a
Web browser:

http://localhost:8080/cbserver/orderForm

You should see a page something like the one shown in Figure 31–2.

Figure 31–2 Order Form

After you have gone through the application screens, you will get an order con-
firmation that looks like the one shown in Figure 31–3.
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Figure 31–3 Order Confirmation

Removing the Coffee Break Application
To remove the Coffee Break application, perform the following steps:

1. Undeploy the JAX-RPC and SAAJ services and the Coffee Break server
using deploytool or the Admin Console.

2. Stop the J2EE application server.

If you want to remove the build and dist directories, run ant clean in each
directory, including <INSTALL>/j2eetutorial14/examples/cb/common/.
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The Duke’s Bank
Application

THIS chapter describes the Duke’s Bank application, an online banking appli-
cation. Duke’s Bank has two clients: a J2EE application client used by adminis-
trators to manage customers and accounts, and a Web client used by customers
to access account histories and perform transactions. The clients access the cus-
tomer, account, and transaction information maintained in a database through
enterprise beans. The Duke’s Bank application demonstrates how all the compo-
nent technologies—enterprise beans, J2EE application clients, and Web compo-
nents—presented in this tutorial are applied to provide a simple but functional
application.

Figure 32–1 gives a high-level view of how the components interact. This chap-
ter looks at each of the component types in detail and concludes with a discus-
sion of how to build, deploy, and run the application.
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Figure 32–1 Duke’s Bank Application

Enterprise Beans
Figure 32–2 takes a closer look at the access paths between the clients, enter-
prise beans, and database tables. As you can see, the end-user clients (Web and
J2EE application clients) access only the session beans. Within the enterprise
bean tier, the session beans are clients of the entity beans. On the back end of the
application, the entity beans access the database tables that store the entity states.

The source code for these enterprise beans is in the <INSTALL>/

j2eetutorial14/examples/bank/src/com/sun/ebank/ejb/ directory.
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Figure 32–2 Enterprise Beans

Session Beans
The Duke’s Bank application has three session beans: AccountControllerBean,
CustomerControllerBean, and TxControllerBean. (Tx stands for a business
transaction, such as transferring funds.) These session beans provide a client’s
view of the application’s business logic. Hidden from the clients are the server-
side routines that implement the business logic, access databases, manage rela-
tionships, and perform error checking.

AccountControllerBean
The business methods of the AccountControllerBean session bean perform
tasks that fall into the following categories: creating and removing entity beans,
managing the account-customer relationship, and getting the account informa-
tion.
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The following methods create and remove entity beans:

• createAccount

• removeAccount

These methods of the AccountControllerBean session bean call the create

and remove methods of the AccountBean entity bean. The createAccount and
removeAccount methods throw application exceptions to indicate invalid
method arguments. The createAccount method throws an IllegalAccount-

TypeException if the type argument is neither Checking, Savings, Credit, nor
Money Market. The createAccount method also verifies that the specified cus-
tomer exists by invoking the findByPrimaryKey method of the CustomerBean

entity bean. If the result of this verification is false, the createAccount method
throws a CustomerNotFoundException.

The following methods manage the account-customer relationship:

• addCustomerToAccount

• removeCustomerFromAccount

The AccountBean and CustomerBean entity beans have a many-to-many rela-
tionship. A bank account may be jointly held by more than one customer, and a
customer may have multiple accounts. Because the entity beans use bean-man-
aged persistence, there are several ways to manage this relationship. For more
information, see Mapping Table Relationships for Bean-Managed
Persistence (page 757).

In the Duke’s Bank application, the addCustomerToAccount and removeCus-

tomerFromAccount methods of the AccountControllerBean session bean man-
age the account-customer relationship. The addCustomerToAccount method, for
example, starts by verifying that the customer exists. To create the relationship,
the addCustomerToAccount method inserts a row into the
customer_account_xref database table. In this cross-reference table, each row
contains the customerId and accountId of the related entities. To remove a
relationship, the removeCustomerFromAccount method deletes a row from the
customer_account_xref table. If a client calls the removeAccount method,
then all rows for the specified accountId are removed from the
customer_account_xref table.

The following methods get the account information:

• getAccountsOfCustomer

• getDetails

The AccountControllerBean session bean has two get methods. The getAc-

countsOfCustomer method returns all of the accounts of a given customer by
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invoking the findByCustomer method of the AccountBean entity bean. Instead
of implementing a get method for every instance variable, the AccountCon-

trollerBean has a getDetails method that returns an object (AccountDe-
tails) that encapsulates the entire state of an AccountBean bean. Because it can
invoke a single method to retrieve the entire state, the client avoids the overhead
associated with multiple remote calls.

CustomerControllerBean
Because it is the AccountControllerBean enterprise bean that manages the cus-
tomer-account relationship, CustomerControllerBean is the simpler of these
two session beans. A client creates a CustomerBean entity bean by invoking the
createCustomer method of the CustomerControllerBean session bean. To
remove a customer, the client calls the removeCustomer method, which not only
invokes the remove method of CustomerBean, but also deletes from the
customer_account_xref table all rows that identify the customer.

The CustomerControllerBean session bean has two methods that return multi-
ple customers: getCustomersOfAccount and getCustomersOfLastName. These
methods call the corresponding finder methods—findbyAccountId and find-

ByLastName—of CustomerBean.

TxControllerBean
The TxControllerBean session bean handles bank transactions. In addition to
its get methods, getTxsOfAccount and getDetails, the TxControllerBean

bean has several methods that change the balances of the bank accounts:

• withdraw

• deposit

• makeCharge

• makePayment

• transferFunds

These methods access an AccountBean entity bean to verify the account type
and to set the new balance. The withdraw and deposit methods are for standard
accounts, whereas the makeCharge and makePayment methods are for accounts
that include a line of credit. If the type method argument does not match the
account, these methods throw an IllegalAccountTypeException. If a with-
drawal were to result in a negative balance, the withdraw method throws an
InsufficientFundsException. If a credit charge attempts to exceed the
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account’s credit line, the makeCharge method throws an InsufficientCredi-

tException.

The transferFunds method also checks the account type and new balance; if
necessary, it throws the same exceptions as the withdraw and makeCharge meth-
ods. The transferFunds method subtracts from the balance of one Account-

Bean instance and adds the same amount to another instance. Because both of
these steps must complete, the transferFunds method has a Required transac-
tion attribute. If either step fails, the entire operation is rolled back and the bal-
ances remain unchanged.

Entity Beans
For each business entity represented in our simple bank, the Duke’s Bank appli-
cation has a matching entity bean:

• AccountBean

• CustomerBean

• TxBean

The purpose of these beans is to provide an object view of these database tables:
account, customer, and tx. For each column in a table, the corresponding entity
bean has an instance variable. Because they use bean-managed persistence, the
entity beans contain the SQL statements that access the tables. For example, the
create method of the CustomerBean entity bean calls the SQL INSERT com-
mand.

Unlike the session beans, the entity beans do not validate method parameters
(except for the primary key parameter of ejbCreate). During the design phase,
we decided that the session beans would check the parameters and throw the
application exceptions, such as CustomerNotInAccountException and Illega-

lAccountTypeException. Consequently, if some other application were to
include these entity beans, its session beans would also have to validate the
method parameters.

Because the entity beans always run in the same Java VM as their clients the ses-
sion beans, for improved performance, the entity beans are coded with local
interfaces.
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Helper Classes
The EJB JAR files include several helper classes that are used by the enterprise
beans. The source code for these classes is in the <INSTALL>/j2eetutorial14/

examples/bank/src/com/sun/ebank/util/ directory. Table 32–3 briefly
describes the helper classes.

Table 32–3 Helper Classes for the Application’s Enterprise Beans

Class Name Description

AccountDetails
Encapsulates the state of an AccountBean instance. Returned by the
getDetails methods of AccountControllerBean and Account-
Bean.

CodedNames
Defines the strings that are the logical names in the calls of the lookup
method. (For example: java:comp/env/ejb/account). The EJB-
Getter class references these strings.

CustomerDetails
Encapsulates the state of a CustomerBean instance. Returned by the
getDetails methods of CustomerControllerBean and Custom-
erBean.

DBHelper
Provides methods that generate the next primary keys (for example,
getNextAccountId).

Debug

Has simple methods for printing a debugging message from an enter-
prise bean. These messages appear on the standard output of the J2EE
1.4 Application Server when it’s run with the --verbose option and in
the server log.

DomainUtil
Contains validation methods: getAccountTypes, checkAccount-
Type, and isCreditAccount.

EJBGetter
Has methods that locate (by invoking lookup) and return home inter-
faces (for example, getAccountControllerHome).

TxDetails
Encapsulates the state of a TxBean instance. Returned by the getDe-
tails methods of TxControllerBean and TxBean.
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Database Tables
A database table of the Duke’s Bank application may be categorized by its pur-
pose: representing business entities and holding the next primary key.

Tables Representing Business Entities
Figure 32–4 shows relationships between the database tables. The customer and
account tables have a many-to-many relationship: A customer may have several
bank accounts, and each account may be owned by more than one customer. This
many-to-many relationship is implemented by the cross–reference table named
customer_account_xref. The account and tx tables have a one-to-many rela-
tionship: A bank account may have many transactions, but each transaction
refers to a single account.

Figure 32–4 Database Tables

Figure 32–4 makes use of several abbreviations. PK stands for primary key, the
value that uniquely identifies a row in a table. FK is an abbreviation for foreign
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key, which is the primary key of the related table. Tx is short for transaction,
such as a deposit or withdrawal.

Tables That Hold the Next Primary Key
These tables have the following names:

• next_account_id

• next_customer_id

• next_tx_id

Each of these tables has a single column named id. The value of id is the next
primary key that is passed to the create method of an entity bean. For example,
before it creates a new AccountBean entity bean, the AccountControllerBean

session bean must obtain a unique key by invoking the getNextAccountId

method of the DBHelper class. The getNextAccountId method reads the id

from the next_account_id table, increments the id value in the table, and then
returns the id.

Protecting the Enterprise Beans
In the J2EE platform, you protect an enterprise bean by specifying the security
roles that can access its methods. In the Duke’s Bank application, you define two
roles—bankCustomer and bankAdmin—because two categories of operations
are defined by the enterprise beans.

A user in the bankAdmin role will be allowed to perform administrative func-
tions: creating or removing an account, adding a customer to or removing a cus-
tomer from an account, setting a credit line, and setting an initial balance. A user
in the bankCustomer role will be allowed to deposit, withdraw, transfer funds,
make charges and payments, and list the account’s transactions. Notice that there
is no overlap in functions that users in either role can perform.

Access to these functions is restricted to the appropriate role by setting method
permissions on selected methods of the CustomerControllerBean, Account-
ControllerBean, and TxControllerBean enterprise beans. For example, by
allowing only users in the bankAdmin role to access the createAccount method
in the AccountControllerBean enterprise bean, you deny users in the bankCus-
tomer role or any other role permission to create bank accounts.
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Application Client
Sometimes, enterprise applications use a stand-alone client application for han-
dling tasks such as system or application administration. For example, the
Duke’s Bank application uses a J2EE application client to administer customers
and accounts. This capability is useful in the event the site becomes inaccessible
for any reason or a customer prefers to communicate things such as changes to
account information by phone.

A J2EE application client is a standalone program launched from the command
line or desktop; it accesses enterprise beans running on the J2EE application
server.

The application client shown in Figure 32–5 handles basic customer and account
administration for the banking application through a Swing user interface. The
bank administrator can perform any of the following functions by making menu
selections.

Figure 32–5 Application Client

Customer Administration

• View customer information

• Add a new customer to the database

• Update customer information

• Find customer ID
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Account Administration

• Create a new account

• Add a new customer to an existing account

• View account information

• Remove an account from the database

Error and informational messages appear in the left pane under Application

message watch:, and data is entered and displayed in the right pane.

The Classes and Their Relationships
The source code for the application client is in the <INSTALL>/

j2eetutorial14/examples/bank/src/com/sun/ebank/appclient/ direc-
tory. The J2EE application client is divided into three classes: BankAdmin,
EventHandle, and DataModel; the relationships among the classes are depicted
in Figure 32–6.
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Figure 32–6 Relationships among Classes

BankAdmin builds the initial user interface, creates the EventHandle object, and
provides methods for the EventHandle and DataModel objects to call to update
the user interface.

EventHandle listens for button clicks by the user, takes action based on which
button the user clicks, creates the DataModel object, calls methods in the Data-

Model object to write data to and read data from the enterprise beans, and calls
methods in the BankAdmin object to update the user interface when actions com-
plete.

DataModel retrieves data from the user interface, performs data checks, writes
valid data to and reads stored data from the underlying database, and calls meth-
ods in the BankAdmin object to update the user interface based on the success of
the database read or write operation.
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BankAdmin Class
The BankAdmin class, which creates the user interface, is the class with the main

method, and provides protected methods for the other BankAdmin application
classes to call.

main Method
The main method creates instances of the BankAdmin and EventHandle classes.
Arguments passed to the main method are used to initialize a locale, which is
passed to the BankAdmin constructor.

public static void main(String args[]) {
String language, country;
if(args.length == 1) {

language = new String(args[0]);
currentLocale = new Locale(language, "");

} else if(args.length == 2) {
language = new String(args[0]);
country = new String(args[1]);
currentLocale = new Locale(language, country);

} else
currentLocale = Locale.getDefault();
frame = new BankAdmin(currentLocale);
frame.setTitle(messages.getString(
"CustAndAccountAdmin"));
WindowListener l = new WindowAdapter() {

public void windowClosing(WindowEvent e) {
System.exit(0);

}
};
frame.addWindowListener(l);
frame.pack();
frame.setVisible(true);
ehandle = new EventHandle(frame, messages);
System.exit(0);
}

}

Constructor
The BankAdmin constructor creates the initial user interface, which consists of a
menu bar and two panels. The menu bar contains the customer and account

../bank/src/com/sun/ebank/appclient/BankAdmin.java
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menus, the left panel contains a message area, and the right panel is a data dis-
play or update area.

Class Methods
The BankAdmin class provides methods that other objects call when they need to
update the user interface. These methods are as follows:

• clearMessages: Clears the application messages that appear in the left
panel

• resetPanelTwo: Resets the right panel when the user selects OK to signal
the end of a data view or update operation

• createPanelTwoActLabels: Creates labels for account fields when
account information is either viewed or updated

• createActFields: Creates account fields when account information is
either viewed or updated

• createPanelTwoCustLabels: Creates labels for customer fields when
customer information is either viewed or updated

• createCustFields: Creates customer fields when customer information
is either viewed or updated

• addCustToActFields: Creates labels and fields for when an add customer
to account operation is invoked

• makeRadioButtons: Makes radio buttons for selecting the account type
when a new account is created

• getDescription: Makes the radio button labels that describe each avail-
able account type

EventHandle Class
The EventHandle class implements the ActionListener interface, which pro-
vides a method interface for handling action events. Like all other interfaces in
the Java programming language, ActionListener defines a set of methods, but
does not implement their behavior. Instead, you provide the implementations
because they take application-specific actions.

../bank/src/com/sun/ebank/appclient/EventHandle.java
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Constructor
The constructor receives an instance of the ResourceBundle and BankAdmin

classes and assigns them to its private instance variable so that the EventHandle

object has access to the application client’s localized text and can update the user
interface as needed. Lastly, the constructor calls the hookupEvents method to
create the inner classes to listen for and handle action events.

public EventHandle(BankAdmin frame, ResourceBundle messages) {
 this.frame = frame;
 this.messages = messages;
 this.dataModel = new DataModel(frame, messages);
 //Hook up action events
 hookupEvents();

}

actionPerformed Method
The ActionListener interface has only one method, the actionPerformed

method. This method handles action events generated by the BankAdmin user
interface when users create a new account. Specifically, it sets the account
description when a bank administrator selects an account type radio button and
sets the current balance to the beginning balance for new accounts when a bank
administrator presses the Return key in the Beginning Balance field.

hookupEvents Method
The hookupEvents method uses inner classes to handle menu and button press
events. An inner class is a class nested or defined inside another class. Using
inner classes in this way modularizes the code, making it easier to read and
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maintain. EventHandle inner classes manage the following application client
operations:

• View customer information

• Create new customer

• Update customer information

• Find customer ID by last name

• View account information

• Create new account

• Add customer to account

• Remove account

• Clear data on Cancel button press

• Process data on OK button press

DataModel Class
The DataModel class provides methods for reading data from the database, writ-
ing data to the database, retrieving data from the user interface, and checking
that data before it is written to the database.

Constructor
The constructor receives an instance of the BankAdmin class and assigns it to its
private instance variable so that the DataModel object can display error messages
in the user interface when its checkActData, checkCustData, or writeData

method detects errors. It also receives an instance of the ResourceBundle class
and assigns it to its private instance variable so that the DataModel object has
access to the application client’s localized text.

Because the DataModel class interacts with the database, the constructor also has
the code to establish connections with the remote interfaces for the Customer-

Controller and AccountController enterprise beans, and to use their remote
interfaces to create instances of the CustomerController and AccountCon-

troller enterprise beans.

//Constructor
public DataModel(BankAdmin frame, ResourceBundle messages) {

this.frame = frame;
this.messages = messages;

../bank/src/com/sun/ebank/appclient/DataModel.java
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//Look up and create CustomerController bean
try {

CustomerControllerHome customerControllerHome =
EJBGetter.getCustomerControllerHome();

customer = customerControllerHome.create();
} catch (Exception namingException) {

namingException.printStackTrace();
}

//Look up and create AccountController bean
try {

AccountControllerHome accountControllerHome =
EJBGetter.getAccountControllerHome();

account = accountControllerHome.create();
} catch (Exception namingException) {

namingException.printStackTrace();
}

}

Methods
The getData method retrieves data from the user interface text fields and uses
the String.trim method to remove extra control characters such as spaces and
returns. Its one parameter is a JTextfield so that any instance of the JText-

field class can be passed in for processing.

private String getData(JTextField component) {
 String text, trimmed;
 if(component.getText().length() > 0) {

text = component.getText();
trimmed = text.trim();
return trimmed;

} else {
text = null;
return text;

}
}

The checkCustData method stores customer data retrieved by the getData

method, but first checks the data to be sure all required fields have data, the mid-
dle initial is no longer than one character, and the state is no longer than two
characters. If everything checks out, the writeData method is called. If there are
errors, they are printed to the user interface in the BankAdmin object. The check-

ActData method uses a similar model to check and store account data.
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The createCustInf and createActInf methods are called by the EventHandle

class to refresh the Panel 2 display in the event of a view, update, or add action
event.

Create Customer Information

• For a view or update event, the createCustInf method gets the customer
information for the specified customer from the database and passes it to
the createCustFields method in the BankAdmin class. A Boolean vari-
able is used to determine whether the createCustFields method should
create read-only fields for a view event or writable fields for an update
event.

• For a create event, the createCustInf method calls the createCust-

Fields method in the BankAdmin class with null data and a Boolean vari-
able to create empty editable fields for the user to enter customer data.

Create Account Information

• For a view or update event, the createActInf method gets the account
information for the specified account from the database and passes it to the
createActFields method in the BankAdmin class. A Boolean variable is
used to determine whether the createActFields method should create
read-only fields for a view event or writable fields for an update event.

• For a create event, the createActInf method calls the createActFields

method in the BankAdmin class with null data and a Boolean variable to
create empty editable fields for the user to enter customer data.

• Adding a customer to an account or removing an account events operate
directly on the database without creating any user interface components.

Web Client
In the Duke’s Bank application, the Web client is used by customers to access
account information and perform operations on accounts. Table 32–7 lists the
functions the client supports, the URLs used to access the functions, and the
components that implement the functions. Figure 32–8 shows an account history
screen.
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The source code for the web client is in the <INSTALL>/j2eetutorial14/

examples/bank/src/com/sun/ebank/web/ and <INSTALL>/j2eetutorial14/

examples/bank/web/ directories.

Table 32–7 Web Client

Function URL Aliases JSP Pages
JavaBeans
Components

Home page /main main.jsp

Log on or off the
application

/logon
/logonError
/logoff

logon.jsp
logonError.jsp
logoff.jsp

List accounts /accountList accountList.jsp

List the history of
an account

/accountHist accountHist.jsp
AccountHistory-
Bean

Transfer funds
between accounts

/transferFunds
/transferAck

transferFunds.jsp
transferAck.jsp

TransferBean

Withdraw and
deposit funds

/atm
/atmAck

atm.jsp
atmAck.jsp

ATMBean

Error handling /error error.jsp
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Figure 32–8 Account History

Design Strategies
The main job of the JSP pages in the Duke’s Bank application is presentation. In
order to achieve this, most dynamic processing tasks are delegated to enterprise
beans, custom tags, and JavaBeans components.

In the Duke’s Bank application, the JSP pages use enterprise beans to handle
interactions with the database. In addition, the JSP pages rely on JavaBeans
components for interactions with the enterprise beans. In the Duke’s Bookstore
application, presented in chapters 11 to 15, the BookDB JavaBeans component
acted as a front end to a database or as a facade to the interface provided by an
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enterprise bean. In the Duke’s Bank application, TransferBean plays the same
role. However, the other JavaBeans components have much richer functionality.
ATMBean invokes enterprise bean methods and sets acknowledgement strings
according to customer input, and AccountHistoryBean massages the data
returned from the enterprise beans in order to present the view of the data
required by the customer.

The Web client uses a template mechanism implemented by custom tags (dis-
cussed in A Template Tag Library, page 636) to maintain a common look across
all the JSP pages. The template mechanism consists of three components:

• template.jsp determines the structure of each screen. It uses the insert

tag to compose a screen from subcomponents.

• screendefinitions.jspf defines the subcomponents used by each
screen. All screens have the same banner, but different title and body con-
tent (specified by the JSP Pages column in Table 32–7).

• Dispatcher, a servlet, processes requests and forwards to template.jsp.

Finally, the Web client uses logic tags from the JSTL core tag library to perform
flow control and the JSTL fmt tag library to localize messages and format cur-
rency.

Web Client Life Cycle

Initializing the Client Components
Responsibility for managing the enterprise beans used by the Web client rests
with the BeanManager class. It creates customer, account, and transaction con-
troller enterprise beans and provides methods for retrieving the beans.

When instantiated, BeanManager retrieves the home interface for each bean from
the helper class EJBGetter and creates an instance by calling the create method
of the home interface. This is a session-level function: BeanManager is created
and stored as a session attribute.

public class BeanManager {
private CustomerController custctl;
private AccountController acctctl;
private TxController txctl;
public BeanManager() {

if (custctl == null) {
try {

../bank/src/com/sun/ebank/web/TransferBean.java
../bank/src/com/sun/ebank/web/ATMBean.java
../bank/src/com/sun/ebank/web/AccountHistoryBean.java
../bank/web/template/template.txt
../bank/web/template/screendefinitions.txt
../bank/src/com/sun/ebank/web/Dispatcher.java
../bank/src/com/sun/ebank/web/BeanManager.java
../bank/src/com/sun/ebank/util/EJBGetter.java
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CustomerControllerHome home =
EJBGetter.getCustomerControllerHome();

custctl = home.create();
} catch (RemoteException ex) {

Debug.print("Couldn’t create customer bean."  +
ex.getMessage());

} catch (CreateException ex) {
Debug.print("Couldn’t create customer bean."  +

ex.getMessage());
} catch (NamingException ex) {

Debug.print("Unable to lookup home: " +
CodedNames.CUSTOMER_CONTROLLER_EJBHOME  +
ex.getMessage());

}
}
public CustomerController getCustomerController() {

return custctl;
}
...

}

Request Processing
All requests for the URLs listed in Table 32–7 are mapped to the dispatcher

Web component, which is implemented by the Dispatcher servlet:

public class Dispatcher extends HttpServlet {
public void doPost(HttpServletRequest request,

HttpServletResponse response) {
...
String selectedScreen = request.getServletPath();
...
if (selectedScreen.equals("/accountHist")) {

...
} else if (selectedScreen.equals("/transferAck")) {

String fromAccountId =
request.getParameter("fromAccountId");

String toAccountId =
request.getParameter("toAccountId");

if ( (fromAccountId == null) || (toAccountId == null)) {
request.setAttribute("errorMessage",

messages.getString("AccountError"));
try {

request.getRequestDispatcher(
"/error.jsp").forward(request, response);

} catch(Exception ex) {
}
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} else {
TransferBean transferBean = new TransferBean();
request.setAttribute("transferBean",

transferBean);
try {

transferBean.setMessages(messages);
transferBean.setFromAccountId(fromAccountId);
transferBean.setToAccountId(toAccountId);
transferBean.setBeanManager(beanManager);
transferBean.setTransferAmount(new

BigDecimal(request.
getParameter("transferAmount")));

String errorMessage = transferBean.doTx();
if (errorMessage != null) {

request.setAttribute("errorMessage",
errorMessage);

try {
request.getRequestDispatcher(

"/error.jsp").forward(request, response);
} catch(Exception ex) {
}

}
} catch (NumberFormatException e) {

request.setAttribute("errorMessage",
messages.getString("AmountError"));

try {
request.getRequestDispatcher(

"/error.jsp").forward(request, response);
} catch(Exception ex) {
}

}
}
...
try {

request.getRequestDispatcher(
"/template/template.jsp").forward(request, response);

} catch(Exception e) {
}

}
}

When a request is delivered, Dispatcher does the following:

1. Retrieves and saves the incoming request URL in the request attribute
selectedScreen. This is done because the URL will be modified when the
request is later forwarded to the application’s template page.

2. Creates a JavaBeans component and stores the bean as a request attribute.
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3. Parses and validates the request parameters. If a parameter is invalid, Dis-
patcher may reset the request alias to an error page. Otherwise, it initial-
izes the JavaBeans component.

4. Calls the doTx method of the JavaBeans component. This method retrieves
data from the enterprise beans and processes the data according to options
specified by the customer.

5. Forwards the request to template.jsp.

As mentioned earlier, template.jsp generates the response by including the
responses from subcomponents. If the request is a GET, the body subcomponent
usually retrieves data from the enterprise bean directly; otherwise it retrieves
data from the JavaBeans component initialized by Dispatcher.

Figure 32–9 depicts the interaction between these components.

Figure 32–9 Web Component Interaction
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Protecting the Web Resources
In the J2EE platform, a Web resource is protected from anonymous access by
specifying which security roles can access the resource. The Web container
guarantees that only certain users acting in those roles can access the resource. In
order for the Web container to enforce the security constraint, the application
must specify a means for users to identify themselves and the Web container
must support mapping a role to a user.

In the Duke’s Bank Web client, you restrict all of the URLs listed in Table 32–7
to the security role bankCustomer. The application requires users to identify
themselves via the form-based login mechanism. When a customer tries to
access a Web client URL, and has not been authenticated, the Web container dis-
plays the JSP page logon.jsp. This page contains a form that requires a cus-
tomer to enter an identifier and password.

<form action="j_security_check" method=post>
<table>
<tr>

<td align="center" >
<table border="0">
<tr>
<td><b><fmt:message key="CustomerId"/></b></td>
<td>

<input type="text" size="15" name="j_username">
</td>
</tr>
<tr>
<td><b><fmt:message key="Password"/></b></td>
<td>

<input type="password" size="15" name="j_password">
</td>
...

</form>

Note that the action invoked by the form, j_security_check, is specified by the
Java Servlet specification, as are the request parameters j_username and
j_password. The Web container retrieves this information, maps it to a security
role, and verifies that the role matches that specified in the security constraint.
Note that in order for the Web container to check the validity of the authentica-
tion information and perform the mapping, you must perform these two steps
when you deploy the application:

1. Add the customer’s group, ID, and password to the default realm of the
container using the Admin Console.

../bank/web/logon.txt
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2. Map the bankCustomer role to the customer or customer’s group in
deploytool.

Once the customer has been authenticated, the identifier provided by the cus-
tomer is used as a key to identify the customer’s accounts. The identifier is
retrieved from the request using the following expression:

${pageContext.request.userPrincipal.name}

Internationalization
The J2EE application client and Web client distributed with the Duke’s Bank
application are internationalized. All strings that appear in the user interfaces are
retrieved from resource bundles. The administration client uses resource bundles
named AdminMessages_*.properties. The Web client uses resource bundles
named WebMessages_*.properties. Both clients are distributed with English
and Spanish resource bundles.

The application client retrieves locale information from the command line. For
example, to use the Spanish resource bundle, invoke the application like this:

appclient -client DukesBankAppClient.jar es

The administration client class BankAdmin creates a ResourceBundle with a
locale created from the command-line arguments:

//Constructor
public BankAdmin(Locale currentLocale) {

//Internationalization setup
messages = ResourceBundle.getBundle("AdminMessages",

currentLocale);

The Web client Dispatcher component retrieves the locale (set by a browser
language preference) from the request, opens the resource bundle, and then saves
the bundle as a session attribute:

ResourceBundle messages = (ResourceBundle)session.
getAttribute("messages");
if (messages == null) {

Locale locale=request.getLocale();
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messages = ResourceBundle.getBundle("WebMessages",
locale);

session.setAttribute("messages", messages);
}

The Web client’s JavaBeans components access localized messages using
messages.getString(“key”);.

The Web client’s JSP pages use the JSTL fmt:message tags to retrieve localized
messages. You set the localization context of the JSTL fmt tag library as a con-
text parameter when you package the Web client with deploytool.

For example, here is how accountHist.jsp generates the headings for the trans-
actions table:

<td><center><b><fmt:message
key="TxDate"/></b></center></td>

<td><center><b><fmt:message
key="TxDescription"/></center></b></td>

<td><center><b><fmt:message
key="TxAmount"/></b></center></td>

<td><center><b><fmt:message
key="TxRunningBalance"/></b></center></td>

Building, Packaging, Deploying, and
Running the Application

To build the Duke’s Bank application, you must have downloaded and unzipped
the tutorial bundle as described in About the Examples (page xxix). When you
install the bundle, the Duke’s Bank application files are located in the
<INSTALL>/j2eetutorial14/examples/bank/ directory:

/bank

/provided-jars - packaged Web client and J2EE application
containing the enterprise beans and application client

/sql - database scripts
/src

/com - component classes
/sun/ebank/appclient

/sun/ebank/ejb

/sun/ebank/util

../bank/web/accountHist.txt
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/sun/ebank/web

/web - JSP pages, images

After you compile the source code, the resulting files will reside in the
<INSTALL>/j2eetutorial14/examples/bank/build/ directory.

Setting Up the Servers
Before you can package, deploy, and run the example, you must first set up the
PointBase database server with customer and account data, and add some
resources to the J2EE 1.4 Application Server.

Creating the Bank Database
You create and enter data into the appropriate tables so that the enterprise beans
have something to read from and write to the database. To create and populate
the database tables:

1. Start the PointBase database server.

2. In a terminal window or command prompt, go to the <INSTALL>/

j2eetutorial14/examples/bank/ directory and execute the command
asant create-db_common. This task invokes the PointBase console tool
library to execute the SQL contained in <INSTALL>/j2eetutorial14/

examples/bank/sql/bank.sql. The SQL statements in this file delete
any existing tables, create new tables, and insert data. The first time the
script is run the tables don’t exist, so you will see SQL errors. You can just
ignore them.

Creating the JDBC Data Source
The Duke’s Bank enterprise beans reference the database with the JNDI name
jdbc/BankDB. That JNDI name must be mapped to a JDBC data source in the
J2EE 1.4 Application Server. You create the data source with the Admin Console
following the procedures described in Defining a Data Source in the J2EE Appli-
cation Server (page 901). When you create the JDBC data source, name it jdbc/
BankDB and map it to PointBasePool.
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Adding Users and Groups to the File Realm
To enable the J2EE 1.4 Application Server to determine which users can access
enterprise bean methods and resources in the Web client, add users and groups to
the server’s file security realm with the Admin Console following the procedures
described in Managing Users (page 913). Add the users and groups listed in
Table 32–10.

Compiling the Duke’s Bank Application
Code
To compile the enterprise beans, application client, and Web client, go to the
<INSTALL>/j2eetutorial14/examples/bank/ directory of the tutorial distri-
bution and execute the command asant compile.

Packaging and Deploying the Duke’s
Bank Application
The instructions that follow for packaging and deploying Duke’s Bank assume
that you are familiar with the deploytool procedures for packaging enterprise
beans, application clients, and Web applications described in previous chapters
of the tutorial. If after following these procedures you have trouble deploying or
running the application, you can use the EAR and WAR provided in <INSTALL>/

j2eetutorial14/examples/bank/provided-jars/ to run the example.

Table 32–10 Duke’s Bank Users and Groups

User Password Group

200 j2ee bankCustomer

bankadmin j2ee bankAdmin
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Packaging the Enterprise Beans
1. Invoke the Enterprise Bean wizard for each entity bean in Table 32–11. For

each bean, select java.lang.String as the Primary Key Class.

The first time you invoke the wizard, create an EJB JAR module named
DukesBankEJBJAR in <INSTALL>/j2eetutorial14/examples/bank/

and add the ejb and util packages under <INSTALL>/j2eetutorial14/
examples/bank/build/com/sun/ebank/ to the JAR.

2. For each entity bean, add a resource reference to a data source with Coded
Name jdbc/BankDB. Set the Sun-specific JNDI name to jdbc/BankDB.
Since you have already added the JDBC resource to the application server,
you should select the name from the drop-down menu.

3. For each entity bean, set the transaction attributes for all methods to
Required, except for the methods listed in Table 32–12, which should be
set to Not Supported:

Table 32–11 Entity Beans

Entity Bean
Home
Interface

Local
Interface Implementation Class

AccountBean AccountHome Account AccountBean

CustomerBean CustomerHome Customer CustomerBean

TxBean TxHome Tx TxBean

Table 32–12 Transaction Attribute Settings

Entity Bean Tx Not Supported Methods

AccountBean
getCreditLine
findByCustomerId
findByPrimaryKey

CustomerBean
remove
findByLastName
findByPrimaryKey
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4. Invoke the Enterprise Bean Wizard for each of the stateful session beans in
Table 32–14.

5. For each session bean, add a resource reference to a data source with
Coded Name jdbc/BankDB. Set the Sun-specific JNDI name to jdbc/

BankDB. Since you have already added the JDBC resource to the applica-
tion server, you should select the name from the drop-down menu.

6. Add EJB references from the session beans to the entity beans listed in
Table 32–14.

TxBean
remove
findByAccountId
findByPrimaryKey

Table 32–13 Stateful Session Beans

Session Bean Home Interface
Remote
Interface Implementation Class

AccountCon-
trollerBean

AccountCon-
trollerHome

AccountCon-
troller

AccountController-
Bean

CustomerCon-
trollerBean

CustomerCon-
trollerHome

CustomerCon-
troller

CustomerController-
Bean

TxController-
Bean

TxController-
Home

TxController TxBean

Table 32–14 EJB References to Entity Beans

Session Bean Coded Name JNDI Name of Entity Bean

AccountControllerBean
ejb/account
ejb/customer

AccountBean
CustomerBean

CustomerControllerBean ejb/customer CustomerBean

Table 32–12 Transaction Attribute Settings (Continued)

Entity Bean Tx Not Supported Methods
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7. Add the security settings.

a. DukesBankEJBJAR - In the Security tab, add the roles bankAdmin and
bankCustomer.

b. AccountControllerBean - In the Security tab, restrict access to users
in the bankAdmin security role for the methods setBalance, remove-
Customer, setCreditLine, setDescription, removeAccount, cre-

ateAccount, addCustomerToAccount, setBeginBalance, and
setType. In the General tab, select Sun-specific Settings→IOR. In the
As Context frame, set Required to true.

c. CustomerControllerBean - In the Security tab, restrict access to users
in the bankAdmin security role for the methods getCustomersOfAc-

count, createCustomer, getCustomersOfLastName, setName,
removeCustomer, and setAddress. In the General tab, select Sun-spe-
cific Settings→IOR. In the As Context frame, set Required to true.

d. TxControllerBean - In the Security tab, restrict access to users in the
bankCustomer security role for the methods getTxsOfAccount, make-
Charge, deposit, transferFunds, withdraw, and makePayment.

8. Save the module.

Packaging the Application Client
1. Invoke the Application Client wizard.

a. Create an application client module named DukesBankACJAR in
<INSTALL>/j2eetutorial14/examples/bank/.

b. Add the appclient, util, and ejb/exception packages and the ejb/

*/*Controller* home and local or remote interfaces (AccountCon-
troller, AccountControllerHome, CustomerController, Customer-
ControllerHome, TxController, TxControllerHome) under
<INSTALL>/j2eetutorial14/examples/bank/build/com/sun/

ebank to the JAR.

c. Select appclient.BankAdmin as the application client main class.

TxControllerBean
ejb/account
ejb/tx

AccountBean
TxBean

Table 32–14 EJB References to Entity Beans (Continued)

Session Bean Coded Name JNDI Name of Entity Bean
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2. Add EJB references to thse session beans listed in Table 32–15.

3. Save the module.

Packaging and Deploying the Web Client
1. Create a Dispatcher servlet Web component using the Web Component

wizard. Create a new Web module containing the component DukesBank-
WAR in <INSTALL>/j2eetutorial14/examples/bank/.

2. Add content to the Web module.

a. Add the web, util, and ejb/exception packages and the ejb/*/*Con-
troller* home and local or remote interfaces (AccountController,
AccountControllerHome, CustomerController, CustomerControl-
lerHome, TxController, TxControllerHome) under <INSTALL>/

j2eetutorial14/examples/bank/build/com/sun/ebank to the mod-
ule.

b. Add the template directory, all the JSP pages, the WebMessages*.pro-
properties files and tutorial-template.tld under <INSTALL>/

j2eetutorial14/examples/bank/build/ to the module.

c. In the Web module contents editor, drag the files WebMessages*.prop-
erties from the context root to WEB-INF/classes.

3. Set the context root to /bank.

4. Add the /accountHist, /accountList, /atm, /atmAck, /main, /trans-
ferAck, /transferFunds, and /logoff aliases to the Dispatcher compo-
nent.

Table 32–15 EJB References to Session Beans

Coded Name JNDI Name of Session Bean

ejb/accountController AccountControllerBean

ejb/customerController CustomerControllerBean
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5. Add EJB references to the session beans listed in Table 32–16:

6. Add a JSP property group named bank. The property group applies to the
URL pattern *.jsp. Add the include prelude /template/prelude.jspf.

7. Add a context parameter named javax.servlet.jsp.jstl.fmt.local-

izationContext and value WebMessages.

8. Add a security constraint.

a. Select Form Based as the User Authentication Method. The authentica-
tion settings are file for the Realm Name, /logon.jsp for the Login
Page, and /logonError.jsp for the Error Page.

b. Add a security constraint and a web resource collection. Use the default
names provided by deploytool.

c. Add the URL Patterns /main, /accountList, /accountHist, /atm, /
atmAck, /transferAck, and /transferFunds to the web resource col-
lection.

d. Select the GET and POST HTTP methods.

e. Add the security role bankCustomer.

9. Map the bankCustomer role to the bankCustomer group.

10.Save the module.

11.Deploy the module.

Packaging and Deploying the Application
1. Create a J2EE application named DukesBankApp in <INSTALL>/

j2eetutorial14/examples/bank/.

2. Add the DukesBankACJAR application client module to DukesBankApp.

Table 32–16 EJB References to Session Beans

Coded Name JNDI Name of Session Bean

ejb/accountController AccountControllerBean

ejb/customerController CustomerControllerBean

ejb/txController TxControllerBean
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3. Add the DukesBankEJBJAR EJB module to DukesBankApp.

4. Map the bankCustomer role to the bankCustomer group.

5. Map the bankAdmin role to the bankAdmin group.

6. Save the application.

7. Deploy the application. In the Deploy DukesBankApp dialog, select the
Return Client Jar checkbox.

After you have packaged all the modules, deploytool should look like
Figure 32–17.

Figure 32–17 Duke’s Bank Modules and Components
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Reviewing JNDI Names
With DukesBankApp selected, click the JNDI Names tab. The JNDI Name col-
umn is shown in Figure 32–18. The order may be a little different in your own
environment.

Figure 32–18 Duke’s Bank JNDI Names
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A JNDI name is the name the J2EE server uses to look up enterprise beans and
resources. When you look up an enterprise bean, you supply statements similar
to those shown in the following code.

try {
customerControllerHome =

EJBGetter.getCustomerControllerHome();
customer = customerControllerHome.create();

} catch (Exception namingException) {
namingException.printStackTrace();

}

public static CustomerControllerHome
getCustomerControllerHome() throws NamingException {
InitialContext initial = new InitialContext();
Object objref = initial.lookup(

CodedNames.CUSTOMER_CONTROLLER_EJBHOME);

The lookup takes place in the third line of code, in which the getCustomerCon-

trollerHome method of com.sun.ebank.utilEJBGetter is called. EJBGetter
is a utility class that retrieves a coded JNDI name from
com.sun.ebank.util.CodedNames.

In this example, the application client is looking up the coded name for the Cus-

tomerController remote interface. BankAdmin (the display name for the main
class of the application client) references ejb/customerController, which is
the coded name defined in CodedNames for the CustomerController remote
interface.

The JNDI name is stored in the J2EE application deployment descriptor, and the
J2EE server uses it to look up the CustomerControllerBean bean. In
Figure 32–18 you see that CustomerControllerBean is mapped to the same
JNDI name as is ejb/customerController. It does not matter what the JNDI
name is, as long as it is the same name for the remote interface lookup as you use
for its corresponding bean. So, looking at the table, you can say that the applica-
tion client (BankAdmin) looks up the CustomerController remote interface,
which uses the JNDI name of CustomerControllerBean, and the J2EE server
uses the CustomerControllerBean JNDI name to find the corresponding Cus-

tomerControllerBean object.

The other rows in the table have the mappings for the other enterprise beans. All
of these beans are stored in the JAR file you added to the J2EE application dur-
ing assembly. Their implementations have coded names for looking up either
other enterprise beans or the database driver.
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Running the Clients

Running the J2EE Application Client
To run the J2EE application client:

1. In a terminal window, go to <INSTALL>/j2eetutorial14/examples/

bank/.

2. To run the English version of the client, execute the following command:
appclient -client DukesBankAppClient.jar

The DukesBankAppClient.jar parameter is the name of the J2EE appli-
cation client JAR file returned when you deployed DukesBankApp.

3. To run the Spanish version, include the es language code:
appclient -client DukesBankAppClient.jar es

4. At the login prompts, type in bankadmin for the user name and j2ee for
the password. The next thing you should see is the application shown in
Figure 32–19.

Figure 32–19 BankAdmin Application Client
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Running the Web Client
To run the Web client:

1. Open the bank URL, http://localhost:8080/bank/main, in a Web
browser. To see the Spanish version of the application, set your browser
language preference to any Spanish dialect.

2. The application will display the login page. Enter 200 for the customer ID
and j2ee for the password. Click Submit.

3. Select an application function: Account List, Transfer Funds, ATM, or
Logoff. Once you have a list of accounts, you can get an account history
by selecting an account link.

Note: The first time you select a new page, particularly a complicated page like an
account history, it takes some time to display because the J2EE Application Server
must translate the page into a servlet class and compile and load the class.

If you select Account List, you will see the screen shown in Figure 32–20.

Figure 32–20 Account List
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Java Encoding
Schemes

This appendix describes the character-encoding schemes that are supported by
the Java platform.

US-ASCII
US-ASCII is a 7-bit encoding scheme that covers the English-language
alphabet. It is not large enough to cover the characters used in other lan-
guages, however, so it is not very useful for internationalization.

ISO-8859-1
This is the character set for Western European languages. It’s an 8-bit encod-
ing scheme in which every encoded character takes exactly 8-bits. (With the
remaining character sets, on the other hand, some codes are reserved to sig-
nal the start of a multi-byte character.)

UTF-8
UTF-8 is an 8-bit encoding scheme. Characters from the English-language
alphabet are all encoded using an 8-bit bytes. Characters for other languages
are encoded using 2, 3 or even 4 bytes. UTF-8 therefore produces compact
documents for the English language, but for other languages, documents
tend to be half again as large as they would be if they used UTF-16. If the
majority of a document’s text is in a Western European language, then UTF-
8 is generally a good choice because it allows for internationalization while
still minimizing the space required for encoding.
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UTF-16
UTF-16 is a 16-bit encoding scheme. It is large enough to encode all the
characters from all the alphabets in the world. It uses 16-bits for most char-
acters, but includes 32-bit characters for ideogram-based languages like Chi-
nese. A Western European-language document that uses UTF-16 will be
twice as large as the same document encoded using UTF-8. But documents
written in far Eastern languages will be far smaller using UTF-16.

Note: UTF-16 depends on the system’s byte-ordering conventions. Although in
most systems, high-order bytes follow low-order bytes in a 16-bit or 32-bit “word”,
some systems use the reverse order. UTF-16 documents cannot be interchanged
between such systems without a conversion.

Further Information
The character set and encoding names recognized by Internet authorities are
listed in the IANA charset registry:

http://www.iana.org/assignments/character-sets

The Java programming language represents characters internally using the Uni-
code character set, which provides support for most languages. For storage and
transmission over networks, however, many other character encodings are used.
The Java 2 platform therefore also supports character conversion to and from
other character encodings. Any Java runtime must support the Unicode transfor-
mations UTF-8, UTF-16BE, and UTF-16LE as well as the ISO-8859-1 character
encoding, but most implementations support many more. For a complete list of
the encodings that can be supported by the Java 2 platform, see:

http://java.sun.com/j2se/1.4/docs/guide/intl/encoding.doc.html

http://java.sun.com/j2se/1.4/docs/guide/intl/encoding.doc.html
http://www.iana.org/assignments/character-sets
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HTTP Overview

MOST Web clients use the HTTP protocol to communicate with a J2EE
server. HTTP defines the requests that a client can send to a server and responses
that the server can send in reply. Each request contains a URL, which is a string
that identifies a Web component or a static object such as an HTML page or
image file.

The J2EE server converts an HTTP request to an HTTP request object and deliv-
ers it to the Web component identified by the request URL. The Web component
fills in an HTTP response object, which the server converts to an HTTP response
and sends to the client.

This appendix provides some introductory material on the HTTP protocol. For
further information on this protocol, see the Internet RFCs: HTTP/1.0 - RFC
1945, HTTP/1.1 - RFC 2616, which can be downloaded from

http://www.rfc-editor.org/rfc.html

ftp://ftp.isi.edu/in-notes/rfc1945.txt
ftp://ftp.isi.edu/in-notes/rfc1945.txt
ftp://ftp.isi.edu/in-notes/rfc2616.txt
http://www.rfc-editor.org/rfc.html
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HTTP Requests
An HTTP request consists of a request method, a request URL, header fields,
and a body. HTTP 1.1 defines the following request methods:

• GET - retrieves the resource identified by the request URL.

• HEAD - returns the headers identified by the request URL.

• POST - sends data of unlimited length to the Web server.

• PUT - stores a resource under the request URL.

• DELETE - removes the resource identified by the request URL.

• OPTIONS - returns the HTTP methods the server supports.

• TRACE - returns the header fields sent with the TRACE request.

HTTP 1.0 includes only the GET, HEAD, and POST methods. Although J2EE
servers are only required to support HTTP 1.0, in practice many servers, includ-
ing the Java WSDP, support HTTP 1.1.

HTTP Responses
An HTTP response contains a result code, header fields, and a body.

The HTTP protocol expects the result code and all header fields to be returned
before any body content.

Some commonly used status codes include:

• 404 - indicates that the requested resource is not available.

• 401 - indicates that the request requires HTTP authentication.

• 500 - indicates an error inside the HTTP server which prevented it from
fulfilling the request.

• 503 - indicates that the HTTP server is temporarily overloaded, and unable
to handle the request.
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abstract schema
The part of an entity bean’s deployment descriptor that defines the bean’s
persistent fields and relationships.

abstract schema name
A logical name that is referenced in Enterprise JavaBeans Query Language
queries.

access control
The methods by which interactions with resources are limited to collections
of users or programs for the purpose of enforcing integrity, confidentiality,
or availability constraints.

ACID
The acronym for the four properties guaranteed by transactions: atomicity,
consistency, isolation, and durability.

activation
The process of transferring an enterprise bean from secondary storage to
memory. (See passivation.)

admintool
A tool used to manipulate the J2EE server while it is running.

anonymous access
Accessing a resource without authentication.

Ant
A Java-based, and thus cross-platform, build tool that can be extended using
Java classes. The configuration files are XML-based, calling out a target tree
where various tasks get executed.

applet
A component that typically executes in a Web browser, but can execute in a
variety of other applications or devices that support the applet programming
model.

applet container
A container that includes support for the applet programming model.
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application assembler
A person that combines components and modules into deployable applica-
tion units.

application client
A first-tier client component that executes in its own Java virtual machine.
Application clients have access to some (JNDI, JDBC, RMI-IIOP, JMS)
J2EE platform APIs.

application client container
A container that supports application client components.

application client module
A software unit that consists of one or more classes and an application client
deployment descriptor.

application component provider
A vendor that provides the Java classes that implement components’ meth-
ods, JSP page definitions, and any required deployment descriptors.

archiving
Saving the state of an object and restoring it.

attribute
A qualifier on an XML tag that provides additional information.

authentication
The process that verifies the identity of a user, device, or other entity in a
computer system, usually as a prerequisite to allowing access to resources in
a system. The J2EE platform Servlet specification requires three types of
authentication: basic, form-based, and mutual, and supports digest authenti-
cation.

authorization
The process by which access to a method or resource is determined. Autho-
rization depends upon the determination of whether the principal associated
with a request through authentication is in a given security role. A security
role is a logical grouping of users defined by the person who assembles the
application. A deployer maps security roles to security identities. Security
identities may be principals or groups in the operational environment.

authorization constraint
An authorization rule that determines who is permitted to access a Web
resource collection.

B2B
Business-to-business.
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basic authentication
An authentication mechanism in which a Web server authenticates an entity
with a user name and password obtained using the Web application’s built-in
authentication mechanism.

bean-managed persistence
Data transfer between an entity bean’s variables and a resource manager
managed by the entity bean.

bean-managed transaction
A transaction whose boundaries are defined by an enterprise bean.

binary entity
See unparsed entity.

binding
Construction of the code needed to process a well-defined bit of XML data.

build file
The XML file that contains one project that contains one or more targets. A
target is a set of tasks you want to be executed. When starting Ant, you can
select which target(s) you want to have executed. When no target is given,
the project’s default is used.

business logic
The code that implements the functionality of an application. In the Enter-
prise JavaBeans model, this logic is implemented by the methods of an
enterprise bean.

business method
A method of an enterprise bean that implements the business logic or rules
of an application.

callback methods
Component methods called by the container to notify the component of
important events in its life cycle.

caller
Same as caller principal.

caller principal
The principal that identifies the invoker of the enterprise bean method.

cascade delete
A deletion that triggers another deletion. A cascade delete may be specified
for an entity bean with container-managed persistence.

CDATA
A predefined XML tag for Character DATA that means don't interpret these
characters, as opposed to Parsed Character Data (PCDATA), in which the
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normal rules of XML syntax apply (for example, angle brackets demarcate
XML tags, tags define XML elements, etc.). CDATA sections are typically
used to show examples of XML syntax.

certificate authority
A trusted organization that issues public key certificates and provides identi-
fication to the bearer.

client certificate authentication
An authentication mechanism that uses HTTP over SSL, in which the server
and, optionally, the client authenticate each other with a public key certifi-
cate that conforms to a standard that is defined by X.509 Public Key Infra-
structure (PKI).

comment
Text in an XML document that is ignored, unless the parser is specifically
told to recognize it.

content
The part of an XML document that occurs after the prolog, including the
root element and everything it contains.

commit
The point in a transaction when all updates to any resources involved in the
transaction are made permanent.

component
An application-level software unit supported by a container. Components
are configurable at deployment time. The J2EE platform defines four types
of components: enterprise beans, Web components, applets, and application
clients.

component contract
The contract between a component and its container. The contract includes:
life cycle management of the component, a context interface that the
instance uses to obtain various information and services from its container,
and a list of services that every container must provide for its components.

component-managed sign-on
Security information needed for signing on to the resource to the getCon-

nection() method is provided by an application component.

connection
See resource manager connection.

connection factory
See resource manager connection factory.
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connector
A standard extension mechanism for containers to provide connectivity to
enterprise information systems. A connector is specific to an enterprise
information system and consists of a resource adapter and application devel-
opment tools for enterprise information system connectivity. The resource
adapter is plugged in to a container through its support for system-level con-
tracts defined in the Connector architecture.

Connector architecture
An architecture for integration of J2EE products with enterprise information
systems. There are two parts to this architecture: a resource adapter provided
by an enterprise information system vendor and the J2EE product that allows
this resource adapter to plug in. This architecture defines a set of contracts
that a resource adapter has to support to plug in to a J2EE product, for exam-
ple, transactions, security, and resource management.

container
An entity that provides life cycle management, security, deployment, and
runtime services to components. Each type of container (EJB, Web, JSP,
servlet, applet, and application client) also provides component-specific ser-
vices.

container-managed persistence
Data transfer between an entity bean’s variables and a resource manager
managed by the entity bean’s container.

container-managed sign-on
Security information needed for signing on to the resource to the getCon-

nection() method is supplied by the container.

container-managed transaction
A transaction whose boundaries are defined by an EJB container. An entity
bean must use container-managed transactions.

context attribute
An object bound into the context associated with a servlet.

context root
A name that gets mapped to the document root of a Web application.

conversational state
The field values of a session bean plus the transitive closure of the objects
reachable from the bean’s fields. The transitive closure of a bean is defined
in terms of the serialization protocol for the Java programming language,
that is, the fields that would be stored by serializing the bean instance.
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CORBA
Common Object Request Broker Architecture. A language-independent dis-
tributed object model specified by the Object Management Group (OMG).

create method
A method defined in the home interface and invoked by a client to create an
enterprise bean.

credentials
The information describing the security attributes of a principal.

CSS
Cascading Style Sheet. A stylesheet used with HTML and XML documents
to add a style to all elements marked with a particular tag, for the direction
of browsers or other presentation mechanisms.

CTS
Compatibility Test Suite. A suite of compatibility tests for verifying that a
J2EE product complies with the J2EE platform specification.

data
The contents of an element, generally used when the element does not con-
tain any subelements. When it does, the more general term content is gener-
ally used. When the only text in an XML structure is contained in simple
elements, and elements that have subelements have little or no data mixed in,
then that structure is often thought of as XML data, as opposed to an XML
document.

DDP
Document-Driven Programming. The use of XML to define applications.

declaration
The very first thing in an XML document, which declares it as XML. The
minimal declaration is <?xml version="1.0"?>. The declaration is part of the
document prolog.

declarative security
Mechanisms used in an application that are expressed in a declarative syntax
in a deployment descriptor.

delegation
An act whereby one principal authorizes another principal to use its identity
or privileges with some restrictions.

deployer
A person who installs modules and J2EE applications into an operational
environment.



1173
deployment
The process whereby software is installed into an operational environment.

deployment descriptor
An XML file provided with each module and application that describes how
they should be deployed. The deployment descriptor directs a deployment
tool to deploy a module or application with specific container options and
describes specific configuration requirements that a deployer must resolve.

destination
A JMS administered object that encapsulates the identity of a JMS queue or
topic. See point-to-point messaging system, publish/subscribe messaging
system.

digest authentication
An authentication mechanism in which a Web application authenticates to a
Web server by sending the server a message digest along with its HTTP
request message. The digest is computed by employing a one-way hash
algorithm to a concatenation of the HTTP request message and the client’s
password. The digest is typically much smaller than the HTTP request, and
doesn’t contain the password.

distributed application
An application made up of distinct components running in separate runtime
environments, usually on different platforms connected via a network. Typi-
cal distributed applications are two-tier (client-server), three-tier (client-
middleware-server), and multitier (client-multiple middleware-multiple
servers).

document
In general, an XML structure in which one or more elements contains text
intermixed with subelements. See also data.

document root
The top-level directory of a WAR. The document root is where JSP pages,
client-side classes and archives, and static Web resources are stored.

DOM
The Document Object Model. An API for accessing and manipulating XML
documents as tree structures. DOM provides platform-neutral, language-
neutral interfaces that enables programs and scripts to dynamically access
and modify content and structure in XML documents.

DTD
Document Type Definition. An optional part of the document prolog, as
specified by the XML standard. The DTD specifies constraints on the valid
tags and tag sequences that can be in the document. The DTD has a number
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of shortcomings however, which has led to various schema proposals. For
example, the DTD entry <!ELEMENT username (#PCDATA)> says that the
XML element called username contains Parsed Character DATA— that is,
text alone, with no other structural elements under it. The DTD includes
both the local subset, defined in the current file, and the external subset,
which consists of the definitions contained in external .dtd files that are ref-
erenced in the local subset using a parameter entity.

durable subscription
In a JMS publish/subscribe messaging system, a subscription that continues
to exist whether or not there is a current active subscriber object. If there is
no active subscriber, JMS retains the subscription’s messages until they are
received by the subscription or until they expire.

EAR file
Enterprise Archive file. A JAR archive that contains a J2EE application.

ebXML
Electronic Business XML. A group of specifications designed to enable
enterprises to conduct business through the exchange of XML-based mes-
sages. It is sponsored by OASIS and the United Nations Centre for the Facil-
itation of Procedures and Practices in Administration, Commerce and
Transport (U.N./CEFACT).

EJB
See Enterprise JavaBeans.

EJB container
A container that implements the EJB component contract of the J2EE archi-
tecture. This contract specifies a runtime environment for enterprise beans
that includes security, concurrency, life cycle management, transactions,
deployment, naming, and other services. An EJB container is provided by an
EJB or J2EE server.

EJB container provider
A vendor that supplies an EJB container.

EJB context
An object that allows an enterprise bean to invoke services provided by the
container and to obtain the information about the caller of a client-invoked
method.

EJB home object
An object that provides the life cycle operations (create, remove, find) for an
enterprise bean. The class for the EJB home object is generated by the con-
tainer’s deployment tools. The EJB home object implements the enterprise
bean’s home interface. The client references an EJB home object to perform
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life-cycle operations on an EJB object. The client uses JNDI to locate an
EJB home object.

EJB JAR file
A JAR archive that contains an EJB module.

EJB module
A software unit that consists of one or more enterprise beans and an EJB
deployment descriptor.

EJB object
An object whose class implements the enterprise bean’s remote interface. A
client never references an enterprise bean instance directly; a client always
references an EJB object. The class of an EJB object is generated by a con-
tainer’s deployment tools.

EJB server
Software that provides services to an EJB container. For example, an EJB
container typically relies on a transaction manager that is part of the EJB
server to perform the two-phase commit across all the participating resource
managers. The J2EE architecture assumes that an EJB container is hosted by
an EJB server from the same vendor, so it does not specify the contract
between these two entities. An EJB server may host one or more EJB con-
tainers.

EJB server provider
A vendor that supplies an EJB server.

element
A unit of XML data, delimited by tags. An XML element can enclose other
elements.

empty tag
A tag that does not enclose any content.

enterprise bean
A component that implements a business task or business entity and resides
in an EJB container; either an entity bean, session bean, or message-driven
bean.

enterprise bean provider
An application programmer who produces enterprise bean classes, remote
and home interfaces, and deployment descriptor files, and packages them in
an EJB JAR file.

enterprise information system
The applications that comprise an enterprise’s existing system for handling
company-wide information. These applications provide an information
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infrastructure for an enterprise. An enterprise information system offers a
well-defined set of services to its clients. These services are exposed to cli-
ents as local or remote interfaces or both. Examples of enterprise informa-
tion systems include: enterprise resource planning systems, mainframe
transaction processing systems, and legacy database systems.

enterprise information system resource
An entity that provides enterprise information system-specific functionality
to its clients. Examples are: a record or set of records in a database system, a
business object in an enterprise resource planning system, and a transaction
program in a transaction processing system.

Enterprise JavaBeans™ (EJB™)
A component architecture for the development and deployment of object-
oriented, distributed, enterprise-level applications. Applications written
using the Enterprise JavaBeans architecture are scalable, transactional, and
secure.

Enterprise JavaBeans Query Language (“EJB QL”)
Defines the queries for the finder and select methods of an entity bean with
container-managed persistence. A subset of SQL92, EJB QL has extensions
that allow navigation over the relationships defined in an entity bean’s
abstract schema.

entity
A distinct, individual item that can be included in an XML document by ref-
erencing it. Such an entity reference can name an entity as small as a charac-
ter (for example, "&lt;", which references the less-than symbol, or left-angle
bracket (<). An entity reference can also reference an entire document, or
external entity, or a collection of DTD definitions (a parameter entity).

entity bean
An enterprise bean that represents persistent data maintained in a database.
An entity bean can manage its own persistence or can delegate this function
to its container. An entity bean is identified by a primary key. If the container
in which an entity bean is hosted crashes, the entity bean, its primary key,
and any remote references survive the crash.

entity reference
A reference to an entity that is substituted for the reference when the XML
document is parsed. It may reference a predefined entity like &lt; or it may
reference one that is defined in the DTD. In the XML data, the reference
could be to an entity that is defined in the local subset of the DTD or to an
external XML file (an external entity). The DTD can also carve out a seg-
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ment of DTD specifications and give it a name so that it can be reused
(included) at multiple points in the DTD by defining a parameter entity.

error
A SAX parsing error is generally a validation error—in other words, it
occurs when an XML document is not valid, although it can also occur if the
declaration specifies an XML version that the parser cannot handle. See also:
fatal error, warning.

Extensible Markup Language
A markup language that makes data portable.

external entity
An entity that exists as an external XML file, which is included in the XML
document using an entity reference.

external subset
That part of the DTD that is defined by references to external .dtd files.

fatal error
A fatal error occurs in the SAX parser when a document is not well formed,
or otherwise cannot be processed. See also: error, warning.

filter
An object that can transform the header or content or both of a request or
response. Filters differ from Web components in that they usually do not
themselves create responses but rather modify or adapt the requests for a
resource, and modify or adapt responses from a resource. A filter should not
have any dependencies on a Web resource for which it is acting as a filter so
that it can be composable with more than one type of Web resource.

filter chain
A concatenation of XSLT transformations in which the output of one trans-
formation becomes the input of the next.

finder method
A method defined in the home interface and invoked by a client to locate an
entity bean.

form-based authentication
An authentication mechanism in which a Web container provides an applica-
tion-specific form for logging in. This form of authentication uses Base64
encoding and can expose user names and passwords unless all connections
are over SSL.
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general entity
An entity that is referenced as part of an XML document's content, as dis-
tinct from a parameter entity, which is referenced in the DTD. A general
entity can be a parsed entity or an unparsed entity.

group
An authenticated set of users classified by common traits such as job title or
customer profile. Groups are also associated with a set of roles, and every
user that is a member of a group inherits all of the roles assigned to that
group.

handle
An object that identifies an enterprise bean. A client may serialize the han-
dle, and then later deserialize it to obtain a reference to the enterprise bean.

home handle
An object that can be used to obtain a reference of the home interface. A
home handle can be serialized and written to stable storage and deserialized
to obtain the reference.

home interface
One of two interfaces for an enterprise bean. The home interface defines
zero or more methods for managing an enterprise bean. The home interface
of a session bean defines create and remove methods, while the home inter-
face of an entity bean defines create, finder, and remove methods.

HTML
Hypertext Markup Language. A markup language for hypertext documents
on the Internet. HTML enables the embedding of images, sounds, video
streams, form fields, references to other objects with URLs, and basic text
formatting.

HTTP
Hypertext Transfer Protocol. The Internet protocol used to fetch hypertext
objects from remote hosts. HTTP messages consist of requests from client to
server and responses from server to client.

HTTPS
HTTP layered over the SSL protocol.

IDL
Interface Definition Language. A language used to define interfaces to
remote CORBA objects. The interfaces are independent of operating sys-
tems and programming languages.

IIOP
Internet Inter-ORB Protocol. A protocol used for communication between
CORBA object request brokers.
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impersonation
An act whereby one entity assumes the identity and privileges of another
entity without restrictions and without any indication visible to the recipients
of the impersonator’s calls that delegation has taken place. Impersonation is
a case of simple delegation.

initialization parameter
A parameter that initializes the context associated with a servlet.

ISO 3166
The international standard for country codes maintained by the International
Organization for Standardization (ISO).

ISV
Independent Software Vendor.

J2EE™
See Java 2 Platform, Enterprise Edition.

J2ME™
See Java 2 Platform, Micro Edition.

J2SE™
See Java 2 Platform, Standard Edition.

J2EE application
Any deployable unit of J2EE functionality. This can be a single module or a
group of modules packaged into an EAR file with a J2EE application
deployment descriptor. J2EE applications are typically engineered to be dis-
tributed across multiple computing tiers.

J2EE product
An implementation that conforms to the J2EE platform specification.

J2EE product provider
A vendor that supplies a J2EE product.

J2EE server
The runtime portion of a J2EE product. A J2EE server provides EJB or Web
containers or both.

JAR
Java ARchive. A platform-independent file format that permits many files to
be aggregated into one file.

Java™ 2 Platform, Enterprise Edition (J2EE)
An environment for developing and deploying enterprise applications. The
J2EE platform consists of a set of services, application programming inter-
faces (APIs), and protocols that provide the functionality for developing
multitiered, Web-based applications.
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Java 2 Platform, Micro Edition (J2ME)
A highly optimized Java runtime environment targeting a wide range of con-
sumer products, including pagers, cellular phones, screenphones, digital set-
top boxes, and car navigation systems.

Java 2 Platform, Standard Edition (J2SE)
The core Java technology platform.

Java API for XML Processing (JAXP)
An API for processing XML documents. JAXP leverages the parser stan-
dards SAX and DOM so that you can choose to parse your data as a stream
of events or to build a tree-structured representation of it. The latest versions
of JAXP also support the XSLT (XML Stylesheet Language Transforma-
tions) standard, giving you control over the presentation of the data and
enabling you to convert the data to other XML documents or to other for-
mats, such as HTML. JAXP also provides namespace support, allowing you
to work with schema that might otherwise have naming conflicts.

Java API for XML Registries (JAXR)
An API for accessing different kinds of XML registries.

Java API for XML-based RPC (JAX-RPC)
An API for building Web services and clients that use remote procedure calls
(RPC) and XML.

Java IDL
A technology that provides CORBA interoperability and connectivity capa-
bilities for the J2EE platform. These capabilities enable J2EE applications to
invoke operations on remote network services using the Object Management
Group IDL and IIOP.

Java Message Service (JMS)
An API for using enterprise messaging systems such as IBM MQ Series,
TIBCO Rendezvous, and so on.

Java Naming and Directory Interface™ (JNDI)
An API that provides naming and directory functionality.

Java™ Secure Socket Extension (JSSE)
A set of packages that enable secure Internet communications.

Java™ Transaction API (JTA)
An API that allows applications and J2EE servers to access transactions.

Java Transaction Service (JTS)
Specifies the implementation of a transaction manager which supports JTA
and implements the Java mapping of the Object Management Group Object
Transaction Service (OTS) 1.1 specification at the level below the API.
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JavaBeans™ component
A Java class that can be manipulated in a visual builder tool and composed
into applications. A JavaBeans component must adhere to certain property
and event interface conventions.

JavaMail™
An API for sending and receiving e-mail.

JavaServer Pages™ (JSP™)
An extensible Web technology that uses template data, custom elements,
scripting languages, and server-side Java objects to return dynamic content
to a client. Typically the template data is HTML or XML elements, and in
many cases the client is a Web browser.

JavaServer Pages Standard Tag Library (JSTL)
A tag library that encapsulates core functionality common to many JSP
applications. JSTL has support for common, structural tasks such as iteration
and conditionals, tags for manipulating XML documents, internationaliza-
tion and locale-specific formatting tags, and SQL tags. It also introduces a
new expression language to simplify page development, and provides an
API for developers to simplify the configuration of JSTL tags and the devel-
opment of custom tags that conform to JSTL conventions.

JAXR client
A client program that uses the JAXR API to access a business registry via a
JAXR provider.

JAXR provider
An implementation of the JAXR API that provides access to a specific regis-
try provider or to a class of registry providers that are based on a common
specification.

JDBC™
An API for database-independent connectivity between the J2EE platform
anda wide range of data sources.

JMS
See Java Message Service.

JMS administered object
A preconfigured JMS object (a resource manager connection factory or a
destination) created by an administrator for the use of JMS clients and
placed in a JNDI namespace.

JMS application
One or more JMS clients that exchange messages.
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JMS client
A Java language program that sends or receives messages.

JMS provider
A messaging system that implements the Java Message Service as well as
other administrative and control functionality needed in a full-featured mes-
saging product.

JMS session
A single-threaded context for sending and receiving JMS messages. A JMS
session can be non transacted, locally transacted, or participating in a distrib-
uted transaction.

JNDI
See Java Naming and Directory Interface.

JSP
See JavaServer Pages.

JSP action
A JSP element that can act on implicit objects and other server-side objects
or can define new scripting variables. Actions follow the XML syntax for
elements with a start tag, a body, and an end tag; if the body is empty it can
also use the empty tag syntax. The tag must use a prefix.

JSP action, custom
An action described in a portable manner by a tag library descriptor and a
collection of Java classes and imported into a JSP page by a taglib direc-
tive. A custom action is invoked when a JSP page uses a custom tag.

JSP action, standard
An action that is defined in the JSP specification and is always available to a
JSP file without being imported.

JSP application
A stand-alone Web application, written using the JavaServer Pages technol-
ogy, that can contain JSP pages, servlets, HTML files, images, applets, and
JavaBeans components.

JSP container
A container that provides the same services as a servlet container and an
engine that interprets and processes JSP pages into a servlet.

JSP container, distributed
A JSP container that can run a Web application that is tagged as distributable
and is spread across multiple Java virtual machines that might be running on
different hosts.
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JSP declaration
A JSP scripting element that declares methods, variables, or both in a JSP
file.

JSP directive
A JSP element that gives an instruction to the JSP container and is inter-
preted at translation time.

JSP element
A portion of a JSP page that is recognized by a JSP translator. An element
can be a directive, an action, or a scripting element.

JSP expression
A scripting element that contains a valid scripting language expression that
is evaluated, converted to a String, and placed into the implicit out object.

JSP file
A file that contains a JSP page. In the Servlet 2.2 specification, a JSP file
must have a .jsp extension.

JSP page
A text-based document using fixed template data and JSP elements that
describes how to process a request to create a response.

JSP scripting element
A JSP declaration, scriptlet, or expression, whose tag syntax is defined by
the JSP specification, and whose content is written according to the scripting
language used in the JSP page. The JSP specification describes the syntax
and semantics for the case where the language page attribute is "java".

JSP scriptlet
A JSP scripting element containing any code fragment that is valid in the
scripting language used in the JSP page. The JSP specification describes
what is a valid scriptlet for the case where the language page attribute is
"java".

JSP tag
A piece of text between a left angle bracket and a right angle bracket that is
used in a JSP file as part of a JSP element. The tag is distinguishable as
markup, as opposed to data, because it is surrounded by angle brackets.

JSP tag library
A collection of custom tags identifying custom actions described via a tag
library descriptor and Java classes.

JTA
See Java Transaction API.
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JTS
See Java Transaction Service.

life cycle
The framework events of a component’s existence. Each type of component
has defining events which mark its transition into states where it has varying
availability for use. For example, a servlet is created and has its init method
called by its container prior to invocation of its service method by clients or
other servlets that require its functionality. After the call of its init method
it has the data and readiness for its intended use. The servlet’s destroy

method is called by its container prior to the ending of its existence so that
processing associated with winding up may be done, and resources may be
released. The init and destroy methods in this example are callback meth-
ods. Similar considerations apply to all J2EE component types: enterprise
beans, Web components (servlets or JSP pages), applets, and application cli-
ents.

local subset
That part of the DTD that is defined within the current XML file.

message
In the Java Message Service, an asynchronous request, report, or event that
is created, sent, and consumed by an enterprise application, not by a human.
It contains vital information needed to coordinate enterprise applications, in
the form of precisely formatted data that describes specific business actions.

message-driven bean
An enterprise bean that is an asynchronous message consumer. A message-
driven bean has no state for a specific client, but its instance variables may
contain state across the handling of client messages, including an open data-
base connection and an object reference to an EJB object. A client accesses a
message-driven bean by sending messages to the destination for which the
bean is a message listener.

mixed-content model
A DTD specification that defines an element as containing a mixture of text
and one more other elements. The specification must start with #PCDATA, fol-
lowed by alternate elements, and must end with the "zero-or-more" asterisk
symbol (*).

MessageConsumer
An object created by a JMS session that is used for receiving messages sent
to a destination.
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MessageProducer
An object created by a JMS session that is used for sending messages to a
destination.

method permission
An authorization rule that determines who is permitted to execute one or
more enterprise bean methods.

module
A software unit that consists of one or more J2EE components of the same
container type and one deployment descriptor of that type. There are three
types of modules: EJB, Web, and application client. Modules can be
deployed as stand-alone units or assembled into an application.

mutual authentication
An authentication mechanism employed by two parties for the purpose of
proving each other’s identity to one another.

namespace
A standard that lets you specify a unique label to the set of element names
defined by a DTD. A document using that DTD can be included in any other
document without having a conflict between element names. The elements
defined in your DTD are then uniquely identified so that, for example, the
parser can tell when an element called <name> should be interpreted accord-
ing to your DTD, rather than using the definition for an element called name

in a different DTD.

naming context
A set of associations between unique, atomic, people-friendly identifiers and
objects.

naming environment
A mechanism that allows a component to be customized without the need to
access or change the component’s source code. A container implements the
component’s naming environment, and provides it to the component as a
JNDI naming context. Each component names and accesses its environment
entries using the java:comp/env JNDI context. The environment entries are
declaratively specified in the component’s deployment descriptor.

non-JMS client
A messaging client program that uses a message system’s native client API
instead of the Java Message Service.

normalization
The process of removing redundancy by modularizing, as with subroutines,
and of removing superfluous differences by reducing them to a common
denominator. For example, line endings from different systems are normal-
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ized by reducing them to a single NL, and multiple whitespace characters
are normalized to one space.

North American Industry Classification System (NAICS)
A system for classifying business establishments based on the processes they
use to produce goods or services.

notation
A mechanism for defining a data format for a non-XML document refer-
enced as an unparsed entity. This is a holdover from SGML that creaks a bit.
The newer standard is to use MIME data types and namespaces to prevent
naming conflicts.

OASIS
Organization for the Advancement of Structured Information Standards.
Their home site is http://www.oasis-open.org/. The DTD repository
they sponsor is at http://www.XML.org.

one-way messaging
A method of transmitting messages without having to block until a response
is received.

ORB
Object request broker. A library that enables CORBA objects to locate and
communicate with one another.

OS principal
A principal native to the operating system (OS) on which the J2EE platform
is executing.

OTS
Object Transaction Service. A definition of the interfaces that permit
CORBA objects to participate in transactions.

parameter entity
An entity that consists of DTD specifications, as distinct from a general
entity. A parameter entity defined in the DTD can then be referenced at other
points, in order to prevent having to recode the definition at each location it
is used.

parsed entity
A general entity that contains XML, and which is therefore parsed when
inserted into the XML document, as opposed to an unparsed entity.

parser
A module that reads in XML data from an input source and breaks it up into
chunks so that your program knows when it is working with a tag, an
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attribute, or element data. A nonvalidating parser ensures that the XML data
is well formed, but does not verify that it is valid. See also: validating parser.

passivation
The process of transferring an enterprise bean from memory to secondary
storage. (See activation.)

persistence
The protocol for transferring the state of an entity bean between its instance
variables and an underlying database.

persistent field
A virtual field of an entity bean with container-managed persistence; it is
stored in a database.

POA
Portable Object Adapter. A CORBA standard for building server-side appli-
cations that are portable across heterogeneous ORBs.

point-to-point messaging system
A messaging system built around the concept of message queues. Each mes-
sage is addressed to a specific queue; clients extract messages from the
queue(s) established to hold their messages.

primary key
An object that uniquely identifies an entity bean within a home.

principal
The identity assigned to a user as a result of authentication.

privilege
A security attribute that does not have the property of uniqueness and that
may be shared by many principals.

processing instruction
Information contained in an XML structure that is intended to be interpreted
by a specific application.

programmatic security
Security decisions that are made by security-aware applications. Program-
matic security is useful when declarative security alone is not sufficient to
express the security model of a application.

prolog
The part of an XML document that precedes the XML data. The prolog
includes the declaration and an optional DTD.

public key certificate
Used in client-certificate authentication to enable the server, and optionally
the client, to authenticate each other. The public key certificate is a digital
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equivalent of a passport. It is issued by a trusted organization, called a certif-
icate authority (CA), and provides identification for the bearer.

publish/subscribe messaging system
A messaging system in which clients address messages to a specific node in
a content hierarchy. Publishers and subscribers are generally anonymous and
may dynamically publish or subscribe to the content hierarchy. The system
takes care of distributing the messages arriving from a node’s multiple pub-
lishers to its multiple subscribers.

queue
See point-to-point messaging system.

RAR
Resource Adapter Archive. A JAR archive that contains a resource adapter.

realm
See security policy domain. Also, a string, passed as part of an HTTP
request during basic authentication, that defines a protection space. The pro-
tected resources on a server can be partitioned into a set of protection spaces,
each with its own authentication scheme or authorization database or both.

In the J2EE server authentication service, a realm is a complete database of
roles, users, and groups that identify valid users of a Web application or a set
of Web applications.

RDF
Resource Description Framework. A standard for defining the kind of data
that an XML file contains. Such information could help ensure semantic
integrity, for example by helping to make sure that a date is treated as a date,
rather than simply as text.

RDF schema
A standard for specifying consistency rules that apply to the specifications
contained in an RDF.

re-entrant entity bean
An entity bean that can handle multiple simultaneous, interleaved, or nested
invocations which will not interfere with each other.

reference
See entity reference

registry
An infrastructure that enables the building, deployment and discovery of
Web services. It is a neutral third party that facilitates dynamic and loosely
coupled business-to-business (B2B) interactions.
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registry provider
An implementation of a business registry that conforms to a specification for
XML registries.

relationship field
A virtual field of an entity bean with container-managed persistence; it iden-
tifies a related entity bean.

remote interface
One of two interfaces for an enterprise bean. The remote interface defines
the business methods callable by a client.

remove method
Method defined in the home interface and invoked by a client to destroy an
enterprise bean.

request-response messaging
A method of messaging that includes blocking until a response is received.

resource adapter
A system-level software driver that is used by an EJB container or an appli-
cation client to connect to an enterprise information system. A resource
adapter is typically specific to an enterprise information system. It is avail-
able as a library and is used within the address space of the server or client
using it. A resource adapter plugs into a container. The application compo-
nents deployed on the container then use the client API (exposed by the
adapter) or tool-generated high-level abstractions to access the underlying
enterprise information system. The resource adapter and EJB container col-
laborate to provide the underlying mechanisms—transactions, security, and
connection pooling—for connectivity to the enterprise information system.

resource manager
Provides access to a set of shared resources. A resource manager participates
in transactions that are externally controlled and coordinated by a transac-
tion manager. A resource manager is typically in a different address space or
on a different machine from the clients that access it. Note: An enterprise
information system is referred to as a resource manager when it is mentioned
in the context of resource and transaction management.

resource manager connection
An object that represents a session with a resource manager.

resource manager connection factory
An object used for creating a resource manager connection.RMI

Remote Method Invocation. A technology that allows an object running in
one Java virtual machine to invoke methods on an object running in a differ-
ent Java virtual machine.
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RMI-IIOP
A version of RMI implemented to use the CORBA IIOP protocol. RMI over
IIOP provides interoperability with CORBA objects implemented in any
language if all the remote interfaces are originally defined as RMI interfaces.

role (development)

The function performed by a party in the development and deployment
phases of an application developed using J2EE technology. The roles are:
application component provider, application assembler, deployer, J2EE
product provider, EJB container provider, EJB server provider, Web con-
tainer provider, Web server provider, tool provider, and system administra-
tor.

role (security)
An abstract logical grouping of users that is defined by the application
assembler. When an application is deployed, the roles are mapped to security
identities, such as principals or groups, in the operational environment.

In the J2EE server authentication service, a role is an abstract name for per-
mission to access a particular set of resources. A role can be compared to a
key that can open a lock. Many people might have a copy of the key, and the
lock doesn’t care who you are, only that you have the right key.

role mapping
The process of associating the groups or principals or both, recognized by
the container to security roles specified in the deployment descriptor. Secu-
rity roles have to be mapped by the deployer before a component is installed
in the server.

rollback
The point in a transaction when all updates to any resources involved in the
transaction are reversed.

root
The outermost element in an XML document. The element that contains all
other elements.

SAX
Simple API for XML. An event-driven interface in which the parser invokes
one of several methods supplied by the caller when a parsing event occurs.
Events include recognizing an XML tag, finding an error, encountering a ref-
erence to an external entity, or processing a DTD specification.

schema
A database-inspired method for specifying constraints on XML documents
using an XML-based language. Schemas address deficiencies in DTDs, such
as the inability to put constraints on the kinds of data that can occur in a par-
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ticular field. Since schemas are founded on XML, they are hierarchical, so it
is easier to create an unambiguous specification, and possible to determine
the scope over which a comment is meant to apply.

Secure Socket Layer (SSL)
A technology that allows Web browsers and Web servers to communicate
over a secured connection.

security attributes
A set of properties associated with a principal. Security attributes can be
associated with a principal by an authentication protocol or by a J2EE prod-
uct provider or both.

security constraint
A declarative way to annotate the intended protection of Web content. A
security constraint consists of a Web resource collection, an authorization
constraint, and a user data constraint.

security context
An object that encapsulates the shared state information regarding security
between two entities.

security permission
A mechanism, defined by J2SE, used by the J2EE platform to express the
programming restrictions imposed on application component developers.

security permission set
The minimum set of security permissions that a J2EE product provider must
provide for the execution of each component type.

security policy domain
A scope over which security policies are defined and enforced by a security
administrator. A security policy domain has a collection of users (or princi-
pals), uses a well defined authentication protocol or protocols for authenti-
cating users (or principals), and may have groups to simplify setting of
security policies.

security role
See role (security).

security technology domain
A scope over which the same security mechanism is used to enforce a secu-
rity policy. Multiple security policy domains can exist within a single tech-
nology domain.

security view
The set of security roles defined by the application assembler.
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server certificate
Used with HTTPS protocol to authenticate Web applications.The certificate
can be self-signed or approved by a Certificate Authority (CA). The HTTPS
service of the J2EEserver will not run unless a server certificate has been
installed.

server principal
The OS principal that the server is executing as.

service element
A representation of the combination of one or more Connector components
that share a single engine component for processing incoming requests.

servlet
A Java program that extends the functionality of a Web server, generating
dynamic content and interacting with Web applications using a request-
response paradigm.

servlet container
A container that provides the network services over which requests and
responses are sent, decodes requests, and formats responses. All servlet con-
tainers must support HTTP as a protocol for requests and responses, but may
also support additional request-response protocols, such as HTTPS.

servlet container, distributed
A servlet container that can run a Web application that is tagged as distribut-
able and that executes across multiple Java virtual machines running on the
same host or on different hosts.

servlet context
An object that contains a servlet’s view of the Web application within which
the servlet is running. Using the context, a servlet can log events, obtain
URL references to resources, and set and store attributes that other servlets
in the context can use.

servlet mapping
Defines an association between a URL pattern and a servlet. The mapping is
used to map requests to servlets.

session
An object used by a servlet to track a user’s interaction with a Web applica-
tion across multiple HTTP requests.

session bean
An enterprise bean that is created by a client and that usually exists only for
the duration of a single client-server session. A session bean performs opera-
tions, such as calculations or accessing a database, for the client. Although a
session bean may be transactional, it is not recoverable should a system
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crash occur. Session bean objects can be either stateless or can maintain con-
versational state across methods and transactions. If a session bean main-
tains state, then the EJB container manages this state if the object must be
removed from memory. However, the session bean object itself must manage
its own persistent data.

SGML
Standard Generalized Markup Language. The parent of both HTML and
XML. However, while HTML shares SGML’s propensity for embedding
presentation information in the markup, XML is a standard that allows infor-
mation content to be totally separated from the mechanisms for rendering
that content.

SOAP
Simple Object Access Protocol

SOAP with Attachments API for Java (SAAJ)
The basic package for SOAP messaging which contains the API for creating
and populating a SOAP message.

SSL
Secure Socket Layer. A security protocol that provides privacy over the
Internet. The protocol allows client-server applications to communicate in a
way that cannot be eavesdropped or tampered with. Servers are always
authenticated and clients are optionally authenticated.

SQL
Structured Query Language. The standardized relational database language
for defining database objects and manipulating data.

SQL/J
A set of standards that includes specifications for embedding SQL state-
ments in methods in the Java programming language and specifications for
calling Java static methods as SQL stored procedures and user-defined func-
tions. An SQL checker can detect errors in static SQL statements at program
development time, rather than at execution time as with a JDBC driver.

SSL
Secure Socket Layer. A security protocol that provides privacy over the
Internet. The protocol allows client-server applications to communicate in a
way that cannot be eavesdropped upon or tampered with. Servers are always
authenticated and clients are optionally authenticated.

standalone client
A client that does not use a messaging provider and does not run in a con-
tainer.



1194
stateful session bean
A session bean with a conversational state.

stateless session bean
A session bean with no conversational state. All instances of a stateless ses-
sion bean are identical.

system administrator
The person responsible for configuring and administering the enterprise’s
computers, networks, and software systems.

tag
A piece of text that describes a unit of data, or element, in XML. The tag is
distinguishable as markup, as opposed to data, because it is surrounded by
angle brackets (< and >). To treat such markup syntax as data, you use an
entity reference or a CDATA section.

template
A set of formatting instructions that apply to the nodes selected by an
XPATH expression.

tool provider
An organization or software vendor that provides tools used for the develop-
ment, packaging, and deployment of J2EE applications.

topic
See publish-subscribe messaging system.

transaction
An atomic unit of work that modifies data. A transaction encloses one or
more program statements, all of which either complete or roll back. Transac-
tions enable multiple users to access the same data concurrently.

transaction attribute
A value specified in an enterprise bean’s deployment descriptor that is used
by the EJB container to control the transaction scope when the enterprise
bean’s methods are invoked. A transaction attribute can have the following
values: Required, RequiresNew, Supports, NotSupported, Mandatory, or
Never.

transaction isolation level
The degree to which the intermediate state of the data being modified by a
transaction is visible to other concurrent transactions and data being modi-
fied by other transactions is visible to it.
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transaction manager
Provides the services and management functions required to support transac-
tion demarcation, transactional resource management, synchronization, and
transaction context propagation.

Unicode
A standard defined by the Unicode Consortium that uses a 16-bit code page
which maps digits to characters in languages around the world. Because 16
bits covers 32,768 codes, Unicode is large enough to include all the world's
languages, with the exception of ideographic languages that have a different
character for every concept, like Chinese. For more info, see http://www.uni-
code.org/.

Universal Description, Discovery, and Integration (UDDI) project
An industry initiative to create a platform-independent, open framework for
describing services, discovering businesses, and integrating business ser-
vices using the Internet, as well as a registry. It is being developed by a ven-
dor consortium.

Universal Standard Products and Services Classification (UNSPSC)
A schema that classifies and identifies commodities. It is used in sell side
and buy side catalogs and as a standardized account code in analyzing
expenditure.

unparsed entity
A general entity that contains something other than XML. By its nature, an
unparsed entity contains binary data.

URI
Uniform Resource Identifier. A globally unique identifier for an abstract or
physical resource. A URL is a kind of URI that specifies the retrieval proto-
col (http or https for Web applications) and physical location of a resource
(host name and host-relative path). A URN is another type of URI.

URL
Uniform Resource Locator. A standard for writing a textual reference to an
arbitrary piece of data in the World Wide Web. A URL looks like: proto-
col://host/localinfo where protocol specifies a protocol for fetching
the object (such as HTTP or FTP), host specifies the Internet name of the
targeted host, and localinfo is a string (often a file name) passed to the pro-
tocol handler on the remote host.
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URL path
The part of a URL passed by an HTTP request to invoke a servlet. A URL
path consists of the Context Path + Servlet Path + Path Info, where

• Context Path is the path prefix associated with a servlet context of which
the servlet is a part. If this context is the default context rooted at the base
of the Web server’s URL namespace, the path prefix will be an empty
string. Otherwise, the path prefix starts with a / character but does not end
with a / character.

• Servlet Path is the path section that directly corresponds to the mapping
that activated this request. This path starts with a / character.

• Path Info is the part of the request path that is not part of the Context Path
or the Servlet Path.

URN
Uniform Resource Name. A unique identifier that identifies an entity, but
doesn’t tell where it is located. A system can use a URN to look up an entity
locally before trying to find it on the Web. It also allows the Web location to
change, while still allowing the entity to be found.

user (security)
An individual (or application program) identity that has been authenticated.
A user can have a set of roles associated with that identity, which entitles
them to access all resources protected by those roles.

user data constraint
Indicates how data between a client and a Web container should be pro-
tected. The protection can be the prevention of tampering with the data or
prevention of eavesdropping on the data.

valid
A valid XML document, in addition to being well formed, conforms to all
the constraints imposed by a DTD. It does not contain any tags that are not
permitted by the DTD, and the order of the tags conforms to the DTD's spec-
ifications.

validating parser
A parser that ensures that an XML document is valid, as well as well-
formed. See also: parser.

virtual host
Multiple “hosts + domain names” mapped to a single IP address.

W3C
World Wide Web Consortium. The international body that governs Internet
standards.
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WAR file
Web application archive file. A JAR archive that contains a Web module.

warning
A SAX parser warning is generated when the document's DTD contains
duplicate definitions, and similar situations that are not necessarily an error,
but which the document author might like to know about, since they could
be. See also: fatal error, error.

Web application
An application written for the Internet, including those built with Java tech-
nologies such as JavaServer Pages and servlets, as well as those built with
non-Java technologies such as CGI and Perl.

Web Application Archive (WAR)
A hierarchy of directories and files in a standard Web application format,
contained in a packed file with an extension .war.

Web application, distributable
A Web application that uses J2EE technology written so that it can be
deployed in a Web container distributed across multiple Java virtual
machines running on the same host or different hosts. The deployment
descriptor for such an application uses the distributable element.

Web component
A component that provides services in response to requests; either a servlet
or a JSP page.

Web container
A container that implements the Web component contract of the J2EE archi-
tecture. This contract specifies a runtime environment for Web components
that includes security, concurrency, life-cycle management, transaction,
deployment, and other services. A Web container provides the same services
as a JSP containeras well as a federated view of the J2EE platform APIs. A
Web container is provided by a Webor J2EE server.

Web container, distributed
A Web container that can run a Web application that is tagged as distribut-
able and that executes across multiple Java virtual machines running on the
same host or on different hosts.

Web container provider
A vendor that supplies a Web container.

Web module
A unit that consists of one or more Web components, other resources, and a
Web deployment descriptor.
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Web resource
A static or dynamic object contained in a Web application archive that can
be referenced by a URL.

Web resource collection
A list of URL patterns and HTTP methods that describe a set of resources to
be protected.

Web server
Software that provides services to access the Internet, an intranet, or an
extranet. A Web server hosts Web sites, provides support for HTTP and
other protocols, and executes server-side programs (such as CGI scripts or
servlets) that perform certain functions. In the J2EE architecture, a Web
server provides services to a Web container. For example, a Web container
typically relies on a Web server to provide HTTP message handling. The
J2EE architecture assumes that a Web container is hosted by a Web server
from the same vendor, so does not specify the contract between these two
entities. A Web server may host one or more Web containers.

Web server provider
A vendor that supplies a Web server.

Web service
An application that exists in a distributed environment, such as the Internet.
A Web service accepts a request, performs its function based on the request,
and returns a response. The request and the response can be part of the same
operation, or they can occur separately, in which case the consumer does not
need to wait for a response. Both the request and the response usually take
the form of XML, a portable data-interchange format, and are delivered over
a wire protocol, such as HTTP.

well-formed
An XML document that is syntactically correct. It does not have any angle
brackets that are not part of tags, all tags have an ending tag or are them-
selves self-ending, and all tags are fully nested. Knowing that a document is
well formed makes it possible to process it. A well-formed document may
not be valid however. To determine that, you need a validating parser and a
DTD.

Xalan
An interpreting version of XSLT.

XHTML
An XML look-a-like for HTML defined by one of several XHTML DTDs.
To use XHTML for everything would of course defeat the purpose of XML,
since the idea of XML is to identify information content, not just tell how to



1199
display it. You can reference it in a DTD, which allows you to say, for exam-
ple, that the text in an element can contain <em> and <b> tags, rather than
being limited to plain text.

XLink
The part of the XLL specification that is concerned with specifying links
between documents.

XLL
The XML Link Language specification, consisting of XLink and XPointer.

XML
Extensible Markup Language. A markup language that allows you to define
the tags (markup) needed to identify the content, data, and text, in XML doc-
uments. It differs from HTML, the markup language most often used to
present information on the internet. HTML has fixed tags that deal mainly
with style or presentation. An XML document must undergo a transforma-
tion into a language with style tags under the control of a stylesheet before it
can be presented by a browser or other presentation mechanism. Two types
of style sheets used with XML are CSS and XSL. Typically, XML is trans-
formed into HTML for presentation. Although tags may be defined as
needed in the generation of an XML document, a document type definition
(DTD) may be used to define the elements allowed in a particular type of
document. A document may be compared with the rules in the DTD to deter-
mine its validity and to locate particular elements in the document. Web ser-
vices application’s J2EE deployment descriptors are expressed in XML with
schemas defining allowed elements. Programs for processing XML docu-
ments use SAX or DOM APIs.

XML registry
See registry.

XML Schema
The W3C schema specification for XML documents.

XPath
See XSL.

XPointer
The part of the XLL specification that is concerned with identifying sections
of documents so that they can referenced in links or included in other docu-
ments.

XSL
Extensible Stylesheet Language. Extensible Stylesheet Language. An
important standard that achieves several goals. XSL lets you:
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a.Specify an addressing mechanism, so you can identify the parts of an XML
file that a transformation applies to. (XPath)

b.Specify tag conversions, so you convert XML data into a different formats.
(XSLT)

c.Specify display characteristics, such page sizes, margins, and font heights
and widths, as well as the flow objects on each page. Information fills in one
area of a page and then automatically flows to the next object when that area
fills up. That allows you to wrap text around pictures, for example, or to con-
tinue a newsletter article on a different page. (XML-FO)

XSL-FO
A subcomponent of XSL used for describing font sizes, page layouts, and
how information “flows” from one page to another.

XSLT
XSL Transformation. An XML file that controls the transformation of an
XML document into another XML document or HTML. The target docu-
ment often will have presentation-related tags dictating how it will be ren-
dered by a browser or other presentation mechanism. XSLT was formerly
part of XSL, which also included a tag language of style flow objects.

XSLTC
A compiling version of XSLT.
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createService method 426
createServiceBinding method
426
custom tags

attributes
validation 626

bodies 596
cooperating 597
examples 634, 636
scripting variables

defining 597
providing information

about 622, 631,
632

tag handlers 587
defining scripting vari-
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ables 629
methods 650
simple tag 625
with attributes 626
with bodies 628, 652

tag library descriptors
See tag library descriptors

tutorial-template tag library
589

cxml 44

D
data 188

element 61
encryption 921, 950
normalizing 81
processing 31
structure

arbitrary 281
types

CDATA 237
element 236
entity reference 236
text 236

data integrity 867
databases

bean-managed persistence
741, 752

business methods 749
clients 4, 666, 676
connections 684, 714, 738,

890
creating tables 742, 756, 797,

818
data recovery 867
deleting rows 745
Duke’s Bank tables 1130

EIS tier 2
entity beans and tables 669
exceptions 738
foreign keys 673, 758
inserting rows 743
isolation levels 892
message-driven beans and 675
multiple 885, 893
persistent fields 672
portable beans 671
primary keys 758, 773
read-only data 669
referential constraints 758
relationships for bean-man-

aged persistence 757
See also persistence
synchronizing with entity

beans 746
table relationships

many-to-many 770
one-to-many 761
one-to-one 758

transactions
See transactions

DDP
declaration 27, 46
DefaultHandler method

overriding 158
defining text 58
deleteOrganizations method 429
delivery modes

JMSDeliveryMode message
header field 994

delivery modes, JMS
introduction 1020

DeliveryMode interface 1020
deployer role 16
deployment descriptors 11
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abstract schema 671
container-managed persis-

tence 780
creating 681
EJB QL 837
enterprise bean 681
enterprise beans 682
JMS applications 1043
primary key class 773
transaction attributes 871
web application 86

deploytool

bean-managed persistence 776
components that send messag-

es 833
container-managed persis-

tence 810, 822
message-driven beans 831,

1057
redeploy operation 707
starting 92

Destination interface 988
destinations, JMS

creating 829, 1002
deployment descriptor ele-

ments 1044
introduction 988
JMSDestination message

header field 994
looking up 826, 988
temporary 1022, 1063, 1077

destroy 489
detachNode method (Node inter-
face) 364
Detail interface 385
DetailEntry interface 385
development roles 14
DII 345

distributed transactions, JMS 1040
doAfterBody 653
DocType node 221, 237
document

element 61
events 134
fragment 237
node 237
type 295

Document class 196
DocumentBuilderFactory 227, 255

configuring 254
Document-Driven Programming

See DDP
documents 188
doFilter 475, 476, 481
doGet 468
doInitBody 653
DOM 35, 128

constructing 194
displaying a hierarchy 201
displaying ub a JTree 207
nodes 189
normalizing 248
SAAJ and 360, 374, 398
structure 192
tree structure 187
versus SAX 127
writing out a subtree 279
writing out as an XML file 274

dom4j 35, 129, 190
doPost 468
doStartTag 625
downloading

J2EE SDK xxx
tutorial xxix

DrawML 43
DTD 27, 36, 38
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defining attributes 62
defining entities 64
defining namespaces 76
factoring out 83
industry-standard 79
limitations 59
normalizing 83
parsing the parameterized 175
warnings 176

DTDHandler API 184
Duke’s Bank 1123

building 1149
database tables 1130
enterprise beans 1124–1131
J2EE application client 1132–

1140
running 1160

JNDI names 1158, 1159
Web client 1140–1149

component interaction
1146

running 1161
DUPS_OK_ACKNOWLEDGE mode (Ses-
sion interface field) 1016
durable subscriptions, JMS 1023

examples 1025, 1052
dynamic attribute 595
dynamic invocation interface

See DII
dynamic proxies 342

E
EAR files 11

EJB JAR files 682
ebXML 44

registries 408, 409
EIS 8, 969, 974, 975

EJB
Web service endpoint inter-

face 680
Web services 666, 668, 676,

679, 721
EJB components

See enterprise beans
EJB containers 10

bean-managed persistence 743
container-managed persis-

tence 670
container-managed transac-

tions 868
EJB QL 671
generating primary keys 821
instance contexts 728
instantiating enterprise beans

683, 712
JMS API and 981
message-driven beans 1037
onMessage method, invoking

827
persistence 777
persistent fields 781
relationships 670, 777
services 665

EJB JAR files
container-managed relation-

ships 678
EJB QL 837, 850
examples 693
portability 681

EJB QL 837
abstract schemas 838, 851, 863
arithmetic functions 859
boolean logic 861
case sensitivity 849
cmp_field 852
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cmr_field 852
collection member declara-

tions 851
collections 851, 859
comments 866
compared to SQL 837, 841,

849
conditional expressions 854,

855
delimiters 852
deployment descriptors 671
deploytool 817, 823
domain of query 837, 848, 850
examples 839
finder methods 671, 795
identification variables 839,

848, 850
input parameters 855
multiple declarations 850
navigation 841, 851, 854
navigation operator 841, 852
null values 858, 860
operators 856
parameters 840
path expressions 838, 852
range variables 851
relationship direction 674
scope 837
select methods 782
string functions 859
syntax diagram 845
types 853, 861, 863

ejbActivate method 684, 685, 686
EJBContext 872, 879, 891
ejbCreate

bean-managed persistence 743
compared to create 715
container-managed persis-

tence 783
examples 712, 743, 763, 783,

787
primary keys 774, 821
requirements 713

ejbCreate method
JMS administered object look-

ups 1036
life cycles 683, 685, 687
message-driven beans 829,

1038
primary keys 686
session beans using JMS 1054

ejbFindByPrimaryKey 747, 775
EJBHome 714
ejbLoad 746, 767, 770, 784, 873
EJBObject 716
ejbPassivate method 683, 685,
687
ejbPostCreate 744, 783
ejbPostCreate method 685
ejbRemove

bean-managed persistence
745, 771

container-managed persis-
tence 784

examples 745
ejbRemove method

life cycles 684, 685, 688
message-driven beans 829,

1038
ejbStore 746, 784
element 47, 236, 246

content 235
empty 49, 166
events 135
nested 48
node 264
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qualifiers 57
root 46

eliminating redundancies 81
EMPTY 60
encoding 27
endDocument method 131
endElement method 131
enterprise beans 6, 665, 690, 692

accessing 676
business methods

See business methods 692
compiling 692
contents 681
defined 665
deployment 682
development role 15
distribution 679
Duke’s Bank 1124–1131

protecting 1131
entity beans

See entity beans
environment entries 726
home interfaces

See home interfaces
interfaces 676, 681
life cycles 677, 683
local access 678
local home interfaces

See local home interfaces
local interfaces

See local interfaces
lookups 695
mapping references to JNDI

names 703
message-driven beans. See

message-driven beans
method permissions

See method permissions

packaging 693
performance 678, 679, 681
persistence

See persistence
propagating security identity

966
protecting 959
references 696, 699, 702
remote access 677
remote interfaces

See remote interfaces
sending e-mail 903
session beans

See session beans
state 673
transactions 891
types 7, 666
URL connections 905

Enterprise Information Systems
See EIS

Enterprise JavaBeans Query Lan-
guage

See EJB QL
EnterpriseBean 712
entities 27, 237

defining in DTD 64
external 82
included "in line" 29
parameter 71
parsed 68, 167
predefined 53
reference 82, 191, 236
reference node 225
references 226
referencing binary 68
referencing external 66
unparsed 68, 167
useful 66
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entity beans 669
bean-managed persistence

See bean-managed persis-
tence

collections 851
container-managed persis-

tence
See container-managed

persistence 670
container-managed versus

bean-managed 779
Duke’s Bank 1128
equality 728
finder methods 678
garbage collection 687
isolation levels 893
persistent state 674
primary keys

See primary keys
sample JMS application 1061
transactions 872, 873, 879,

891
EntityBean 743
EntityContext 728, 744
EntityResolver 259

API 185
environment entries 726
errors

generating 302
handling 170, 196

in the validating parser 174
nonfatal 157
validation 172, 200

events
character 136
content 134
document 134
element 135

lexical 177
examples

classpath 693
downloading xxix
location xxix

exception handling, JMS 997
exceptions

business methods 714
create 715, 753
ejbCreate 713, 744
ejbFindByPrimaryKey 748
ejbRemove 745
enterprise beans 738
javax.ejb 739
mapping to web resources 107
ParserConfigurationExcep-

tion 156
rolling back transactions 738,

872, 873, 880, 886
SAXException 154
SAXParseException 153
SQL 873
transactions 870, 871
web components 107

expiration of JMS messages 1021
JMSExpiration message head-

er field 994

F
factory

configuring 199
false function 272
Filter 475
filter chains 320, 475, 481
filters 474

defining 475
mapping to Web components
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479
mapping to Web resources

479, 480, 481
overriding request methods

477
overriding response methods

477
response wrapper 477

findByPrimaryKey 768, 787, 790
findClassificationSchemeByName

method 424, 431
findConcepts method 420
finder methods

bean-managed persistence 747
compared to select methods

782
container-managed persis-

tence 779
deploytool 817
EJB QL 839
examples 747, 759, 794, 863
home interfaces 754
local home interfaces 784
returning collections 765
transactions 872

findOrganization method 418
floor function 272
for-each loops 318
forward 484
fully qualified names 365
functions

boolean 272
boolean 273
ceiling 272
concat 271
contains 271
conversion 273
count 271

false 272
floor 272
lang 272
last 271
local-name 273
name 273
namespace 273
namespace-uri 273
node-set 270
normalize-space 272
not 272
number 273
numeric 272
position 271
positional 271
round 273
starts-with 271
string 271
string 273
string-length 271
substring 271
substring-after 271
substring-before 271
sum 272
translate 272
true 272
XPath 270

G
garbage collection 687, 688
GenericServlet 456
getAttachments method (SOAPMes-
sage class) 377
getBody method (SOAPEnvelope in-
terface) 364
getCallerPrincipal 962
getEJBObject 744
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getEnvelope method (SOAPPart
class) 364
getHeader method (SOAPEnvelope
interface) 364
getObject 728
getParameter 469
getParser method 133
getPrimaryKey 744, 775
getRemoteUser method 931
getRequestDispatcher 482
getRollbackOnly method 1041
getServletContext 485
getSession 486
getSOAPBody method (SOAPMessage
class) 364
getSOAPHeader method (SOAPMes-
sage class) 364
getSOAPPart method (SOAPMessage
class) 364
getters

See access methods
Getting 85
getUserPrincipal method 931
getValue method (Node interface)
369
groups 911

H
helper classes 681, 716, 762

Duke’s Bank 1129
hierarchy

collapsed 240
home interfaces 714, 753

defined 677
examples 691, 715, 753
home methods 751
locating 695, 700

home methods 750, 754
HTML 24
HTTP 329, 330, 950

over SSL 921, 950
setting proxies 416

HTTP protocol 1165
HTTP requests 469, 1166

methods 1166
query strings 470
See also requests
URLs 469

HTTP responses 471, 1166
See also responses
status codes 107, 1166

mapping to web resources
107

HTTPS 934, 939
HttpServlet 456
HttpServletRequest 469
HttpServletRequest interface 931
HttpServletResponse 471
HttpSession 486

I
ICE 44
identification 910
ignored 158
include 482, 529
information model

JAXR 408, 409
init 468
inline tags 312
instructions

processing 28, 50, 150
interfaces

ContentHandler 131
httpServletRequest 931
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javax.xml.transform.Source

373
LexicalHandler 177
XmlReader 290

internationalization
J2EE application clients

Duke’s Bank 1148
Web clients

Duke’s Bank 1148
Internationalizing 657
invalidate 488
isCallerInRole 962
isIdentical 728
ISO 3166 country codes 418
isolation levels 892
isThreadSafe 510
isUserInRole method 931

J
J2EE application clients 4, 694

containers 10
Duke’s Bank 1132–1140

classes 1133
running 1160

examples 349, 697, 826, 1135
JAR files 694
packaging 350, 698

J2EE applications 2
assembler role 16
deploying 705, 720, 725, 736
iterative development 707
JAXR example 445
JMS examples 1052, 1061,

1069, 1075
running on more than one sys-

tem 1069, 1075
See also Duke’s Bank 1123

tiers 2
J2EE clients 4

application clients 4
See also J2EE application

clients
Web clients 4

See also Web clients
web clients 85

See also web clients
Web clients versus J2EE appli-

cation clients 5
J2EE components

defined 3
types 3

J2EE Connector technology 969
architecture version 21
CCI 974
resource adapters

See resource adapters
J2EE group 911, 912
J2EE modules 11
J2EE platform 1, 2

JMS API and 980
J2EE SDK

downloading xxx
J2EE security architecture 910
J2EE server 10

starting and stopping 91
J2EE Technology in Practice 22
J2SE SDK 330
JAAS 22
JAF 19
JAR files

j2ee.jar 693
See also

EJB JAR files
Java API for XML Processing

See JAXP
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Java Authentication and Authori-
zation Service

See JAAS
Java Message Service

See JMS
Java Message Service (JMS) API

achieving reliability and per-
formance 1014

architecture 982
basic concepts 981
client applications 997
definition 978
introduction 977
J2EE examples 825, 1052,

1061, 1069, 1075
J2EE platform 980, 1035
message-driven beans. See

message-driven beans
messaging domains 982
programming model 986

Java Naming and Directory Inter-
face

See JNDI
Java Servlet technology 17

See also servlets
Java Transaction API

See JTA
JavaBeans Activation Framework

See JAF
JavaBeans components 5, 332

creating in JSP pages 521
design conventions 519
Duke’s Bank 1142
in WAR files 93
methods 519
properties 519

retrieving in JSP pages 524
setting in JSP pages 522

using in JSP pages 521
JavaMail API 19
JavaServer Pages (JSP) technolo-
gy 18

See also JSP pages
javax.activation.DataHandler

class 375, 376
javax.servlet 456
javax.servlet.http 456
javax.servlet.jsp.tagext 624,
650
javax.xml.registry package 409
javax.xml.registry.infomodel

package 409
javax.xml.registry.lifeCycleM-

anagerURL connection property
415
javax.xml.registry.postalAd-

dressScheme connection property
415, 434
javax.xml.registry.queryMan-

agerURL connection property 415
javax.xml.registry.securi-

ty.authenticationMethod connec-
tion property 415
javax.xml.registry.seman-

ticEquivalences connection prop-
erty 415, 434
javax.xml.registry.ud-

di.maxRows connection property
415
javax.xml.soap package 355
javax.xml.transform.Source in-
terface 373
JAXM

specification 355
JAXP 20
JAXP 1.2 188
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JAXR 407
adding

classifications 424
service bindings 425
services 425

architecture 409
capability levels 408
clients 409

implementing 411
submitting data to a regis-

try 422
connections, creating 413
defining taxonomies 430
definition 408
establishing security creden-

tials 423
finding classification schemes

424
information model 408
J2EE application 445
organizations

creating 423
publishing 426
removing 429

overview 407
provider 409
querying a registry 417
specification 408
specification concepts

publishing 427
specifying postal addresses

433
submitting data to a registry

422
WSDL documents

publishing 427
JAX-RPC

clients 339

defined 329
JavaBeans components 332
specification 353
supported types 330

JDBC API 17
transactions

See transactions, JDBC
JDOM 35, 129, 190
JEditorPane class 202, 238
JEditPane class 205
JMS 18
JMSCorrelationID message header
field 995
JMSDeliveryMode message header
field 994
JMSDestination message header
field 994
JMSException class 997
JMSExpiration message header
field 994
JMSMessageID message header
field 994
JMSPriority message header field
994
JMSRedelivered message header
field 995
JMSReplyTo message header field
995, 1080
JMSTimestamp message header
field 994
JMSType message header field 995
JNDI 18, 695

deploytool 703, 812
looking up JMS administered

objects 987
lookup 696, 903
mail sessions 903
names
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Duke’s Bank 1158, 1159
naming context 695, 1036

JPanel class 203
JScrollPane class 205
JSP declarations 646
JSP expressions 648
JSP fragment 594
JSP pages 493

compilation 505
errors 506

compiling 701
creating and using objects 510,

643
creating dynamic content 509
creating static content 508
declarations

See JSP declarations
Duke’s Bank 1140
error page 507
examples 88, 496, 497, 559,

588, 699
execution 506
expressions

See JSP expressions
finalization 647
forwarding to an error page

507
forwarding to other Web com-

ponents 530
implicit objects 510
importing classes and packag-

es 645
importing tag libraries 525
including applets or JavaBeans

components 531
including other Web resources

529
initialization 646

JavaBeans components
creating 521
retrieving properties 524
setting properties 522

from constants 522
from request parame-

ters 522
from runtime expres-

sions 523
using 521

life cycle 505
scripting elements

See JSP scripting elements
scriptlets

See JSP scriptlets
setting buffer size 507
shared objects 510
specifying scripting language

645
translation 505

enforcing constraints for
custom tag at-
tributes 626

errors 506
URLs for running 706

JSP scripting elements 643
JSP scriptlets 647
jsp:fallback 531
jsp:forward 530
jsp:getProperty 524
jsp:include 529
jsp:param 530, 531
jsp:plugin 531
jsp:setProperty 522
jspDestroy 647
jspInit 647
JSplitPane class 202, 206
JTA 19
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See also
transactions, JTA

JTree

displaying content 238
JTree class 201, 238
JTreeModel class 201
JTS API 885

K
keystore 935
keytool 934

L
lang function 272
last function 271
lexical

controls 226
events 177

LexicalHandler interface 177
linking

XML 40
listener classes 461

defining 462
examples 462

listener interfaces 462
local home interfaces 784

defined 678
local interfaces 785

defined 678
examples 784, 785, 788
requirements 755

local name 371
local transactions, JMS 1027
local-name function 273
locator 148
Locator object 154

lookup

See JNDI, lookup

M
mail sessions 903
MapMessage interface 996
MathML 43
message

integrity 921, 950
message acknowledgment

bean-managed transactions
1042

message-driven beans 1038
message acknowledgment, JMS

introduction 1016
message bodies, JMS 995
message consumers, JMS 991
message consumption, JMS

asynchronous 985, 1006
introduction 985
synchronous 985, 998

message headers, JMS 994
message IDs

JMSMessageID message header
field 994

Message interface 996
message listeners, JMS 674

examples 1008, 1063, 1077
introduction 992

message producers, JMS 990
message properties, JMS 995
message selectors, JMS

introduction 993
specifying for message-driven

beans 1058
MessageConsumer interface 991
message-driven beans 674
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accessing 675
coding 827, 1054, 1064, 1078
defined 674
deployment descriptor ele-

ments 1046
examples 825, 1052, 1061,

1069, 1075
garbage collection 688
introduction 1037
onMessage method 675, 827
requirements 827
transactions 868, 872, 879,

880, 892
MessageDrivenContext interface
1039
MessageFactory class 363
MessageListener interface 992
MessageProducer interface 990
messages, JMS

body formats 995
delivery modes 1020
expiration 1021
headers 994
introduction 993
persistence 1020
priority levels 1021
properties 995

messages, SAAJ
accessing elements 363
adding body content 364
attachments 358
creating 363
getting the content 369
overview 356

messaging domains, JMS 982
common interfaces 985
point-to-point 983
publish/subscribe 984

messaging, definition 978
method permissions

Duke’s Bank 1131
specifying 960

methods
addClassifications 425
addExternalLink 432
addServiceBindings 426
addServices 426
characters 131
createClassification 425,

431
createClassificationScheme

431
createExternalLink 431
createOrganization 424
createPostalAddress 435
createService 426
createServiceBinding 426
deleteOrganizations 429
endDocument 131
endElement 131
findClassificationScheme-

ByName 424, 431
findConcepts 420
findOrganization 418
getParser 133
getRemoteUser 931
getUserPrincipal 931
isUserInRole 931
notationDecl 185
parse 287
saveConcepts 427
saveOrganizations 426
setCoalescing 227
setExpandEntityReferences

227
setIgnoringComments 227
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setIgnoringElementContent-

Whitespace 227
setPostalAddresses 435
startCDATA 182
startDocument 131, 134
startDTD 182
startElement 131, 135, 138
startEntity 182
text 190
unparsedEntityDecl 185

MIME
data 68
header 359

mixed-content model 58, 189
mode-based templates 318
modes

content 189
Text 219

mutual authentication 940

N
NAICS 441

using to find organizations 419
name function 273
Name interface 364
name, local 371
names

fully qualified 365, 367, 371
namespaces 37, 365

defining a prefix 77
defining in DTD 76
functions 273
node 264
prefix 366
referencing 77
target 259
using 75

validating with multiple 256
namespace-uri function 273
nested elements 58
Node interface

detachNode method 364
getValue method 369

node() 268
nodes 189

Attribute 219
attribute 237, 264
CDATA 226
changing 253
Comment 219
comment 237, 264
constants 234
content 251
controlling visibility 230
DocType 221, 237
document 237
document fragment 237
element 246, 264
entity 237
entity reference 225
inserting 253
namespace 264
navigating to 192
notation 237
processing instruction 222,

237, 264
removing 253
root 246, 264
SAAJ and 357
searching 250
text 246, 249, 264
traversing 250
types 209, 264
value 189

node-set functions 270
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NON_PERSISTENT delivery mode
1020
nonvalidating parser 151
non-XSL tags 300
normalize-space function 272
normalizing

data 81
DTDs 83

not clause 316
not function 272
notation nodes 237
notationDecl method 185
number function 273
numbers

formatting 318
generating 318

numeric functions 272

O
OASIS 79
ObjectMessage interface 996
objects

Locator 154
Parser 133

objects, administered (JMS) 987
onMessage method (MessageLis-
tener interface)

introduction 992
message-driven beans 675,

827, 1037
operators

XPath 269
Organization interface 423
organizations

creating with JAXR 423
finding

by classification 419, 441

by name 418, 440
using WSDL documents

444
keys 423, 429
primary contacts 423
publishing with JAXR 426,

440, 441, 443
removing with JAXR 429, 441

P
parameter entity 71
parse method 287
parsed

character data 58
entity 68, 167

parser
implementation 168
modifying to generate SAX

events 285
nonvalidating 151
SAX properties 170
using as a SAXSource 292
validating 168

error handling 174
Parser object 133
ParserConfigurationException

156
parsing parameterized DTDs 175
password 944
pattern 263
PCDATA 58

versus CDATA 58
persistence

bean-managed
See bean-managed persis-

tence
container-managed



1224 INDEX
See container-managed
persistence

entity beans 669
session beans 667
types 669

persistence, for JMS messages
1020
PERSISTENT delivery mode 1020
persistent fields 672

deploytool 816
EJB QL 838, 852
examples 781

physical schemas 671
point-to-point connection, SAAJ
368
point-to-point messaging domain
983
position function 271
positional functions 271
postal addresses

retrieving with JAXR 435, 441
specifying with JAXR 433,

441
prerequisites xxix
primary keys

automatically generating 821
bean-managed persistence 773
composite 773, 819
container-managed persis-

tence 819
defined 670
examples 773, 820
methods for setting 686
returned by create 743
See also ejbFindByPrimaryKey

printing the tutorial xxxii
PrintWriter 471
priority levels, for JMS messages

1021
priority levels, for messages

JMSPriority message header
field 994

processing
command line argument 130
data 31
instruction nodes 222, 237,

264
instructions 28, 50, 150, 191

processingInstruction 151
programming model, JMS API
986
provider

JAXR 409
proxies 329, 339

HTTP, setting 416
public key certificates 921, 950
publish/subscribe messaging do-
main

durable subscriptions 1023
introduction 984

Q
QName 342
Queue interface 988
queues

creating 988, 1002
introduction 988
looking up 826, 988
temporary 1022, 1063

R
RAR files 969
RDF 42

schema 42
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realm 911
realms 911

certificate 911
default

Duke’s Bank
adding groups and us-

ers 1151
recover method (Session inter-
face) 1017
redelivery of messages

JMSRedelivered message
header field 995

registries
definition 407
ebXML 408, 409
getting access to public UDDI

registries 412
private 408
querying with JAXR 417
submitting data with JAXR

422
UDDI 408
using public and private 438

registry objects
retrieving with JAXR 444

registry objects, JAXR 409
RegistryObject interface 409
RegistryService interface 410,
417
relationship fields

defined 673
deploytool 814
direction 673
EJB QL 838, 852
examples 781
modifying by local clients 792

relationships
bean-managed persistence 670

container-managed
See container-managed re-

lationships
multiplicities 673

RELAX NG 39
release 653
reliability, JMS

advanced mechanisms 1023
basic mechanisms 1015
durable subscriptions 1023
local transactions 1027
message acknowledgment

1016
message expiration 1021
message persistence 1020
message priority levels 1021
temporary destinations 1022
transactions 1027

remote interfaces
defined 677
example 691
examples 716, 755
requirements 716

Remote Method Invocation
(RMI), and messaging 978
remote procedure calls 329
remove

bean-managed persistence 745
transactions 872

remove method
life cycles 684, 685

request/reply mechanism
JMSCorrelationID message

header field 995
JMSReplyTo message header

field 995
temporary destinations and

1022
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RequestDispatcher 482
request-response messaging 1104
requests 469

appending parameters 530
customizing 477
getting information from 469
retrieving a locale 659
See also HTTP requests

required software xxix
Required transaction attribute
1042
resource adapter, JAXR 411

creating resources 447
resource adapter, JMS

activation configuration prop-
erties 1048

resource adapters 969
archive files

See RAR files
CCI 974
security 965

resource bundles 658
resource connections 897
resources, JMS API 1036
responses 471

buffering output 471
customizing 477
See also HTTP responses
setting headers 469

roles 911
development

See development roles
security

See security roles
rollback 868, 879, 880, 885, 891
rollback method (Session inter-
face) 1027
rollbacks

See transactions, rollbacks
root

element 46
node 246, 264

round function 273
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